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Regulatory Requirements

Conformance Standards

The following classifications are in accordance with the IEC/
EN 60601-1:6.8.1: 

• According to 2017/745 EU Medical Device Regulations, this 
is Class IIa Medical Device.

• According to IEC/EN 60601-1, 

• Equipment is Class I, Type B with BF or CF Applied 
Parts.

• According to CISPR 11, 

• Equipment is Group 1, Class A ISM Equipment.

This product complies with the regulatory requirement of the 
following:

• The LOGIQ Fortis console and related probes are an Active 
Diagnostic Medical Product belonging to Class IIa according 
to the MDR - REGULATION (EU) 2017/745 for use on 
human patients. 

• Medical Device Regulation (EU) 2017/745: the CE label 
affixed to the product testifies compliance to the Regulation.

The location of the CE marking is shown in the Safety 
chapter of this manual.

Authorized EU Representative

European registered place of business:

GE Medical Systems SCS

283 rue de la Minière 

78530 BUC, France
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Conformance Standards  (continued)

• International Electrotechnical Commission (IEC).

• IEC/EN 60601-1 Medical Electrical Equipment, Part 1 
General Requirements for Safety.

• IEC/EN 60601-1-2 Electromagnetic disturbances - 
Requirements and tests.

• IEC 60601-1-6 (Usability), EN 1041 (Information 
supplied with medical devices)

• IEC 60601-2-37 Medical electrical equipment. Particular 
requirements for the safety of ultrasonic medical 
diagnostic and monitoring equipment.

• International Organization of Standards (ISO)

• ISO 10993-1 Biological evaluation of medical devices.

• Underwriters’ Laboratories, Inc. (UL), an independent 
testing laboratory.

• UL 60601-1 Medical Electrical Equipment, Part 1 
General Requirements for Safety.

• ANSI/AAMI ES60601-1:2005/(R)2012 Medical electrical 
equipment -Part 1: General requirements for basic safety 
and essential performance

• Canadian Standards Association (CSA).

• CSA 22.2, 60601-1 Medical Electrical Equipment, Part 1 
General Requirements for Safety.

• Medical Device Good Manufacturing Practice Manual 
issued by the FDA (Food and Drug Administration, 
Department of Health, USA).

• EN/ISO 15223-1 Medical devices -- Symbols to be used 
with medical device labels, labelling and information to be 
supplied -- Part 1: General requirements
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Certifications

• General Electric Medical Systems is ISO 13485 certified. 

Original Documentation

• The original document was written in English. 

Importer Information

• Turkey
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Chapter 1

Introduction

This chapter consists of information concerning 

indications for use/contraindications, contact 

information and how this documentation is organized. 
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System Overview

Attention

This manual contains necessary and sufficient information to 
operate the system safely. Advanced equipment training may be 
provided by a factory trained Applications Specialist for the 
agreed-upon time period. 

Read and understand all instructions in this manual before 
attempting to use the LOGIQ Fortis system.

Keep this manual with the equipment at all times. Periodically 
review the procedures for operation and safety precautions. 

Disregarding information on safety is considered abnormal use.

Not all features, products, probes, or peripherals described in 
this document may be available or cleared for sale in all 
markets. Please contact your local GE Ultrasound 
representative to get the latest information.

NOTE: Please note that orders are based on the individually agreed 
upon specifications and may not contain all features listed in this 
manual.

NOTE: All references to standards / regulations and their revisions are 
valid at the time of publication of the user manual.
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Documentation

Safety instructions must be reviewed before operating the 
system. 

The LOGIQ Fortis manuals are written for users who are familiar 
with basic ultrasound principles and techniques. They do not 
include sonographic training or detailed clinical procedures.

Documentation is provided in the following ways:

• Online Help on the system

• Electronic Media viewable on a Windows PC

• On the internet at the GE Customer Documentation Portal

• Paper copies (orderable via H-Cat)

NOTE: The Basic Service Manual referenced in this manual is part 
number 5874373.

Table 1-1:  Documentation

Publication Translated

Available 

via F1

Available 

via Media in 

the eIFU Kit

Available 

on Paper (if 

purchased 

via H-Cat)

Basic User Manual

Provides information needed by 

the user to operate the system 

safely. 

Yes (all 

required 

languages)

Yes Yes Yes

Release Notes

Provides precautions and 

instructions that supplement the 

Basic User Manual

Yes No Yes Yes

Advanced Reference Manual

Provides Acoustic Output Data and 

System Measurement and 

Analysis Tables and Formulas. 

English and 

French

No Yes Yes

Privacy and Security Manual

Describes Privacy and Security 

considerations and capabilities, 

and how they may be configured 

and used appropriately on the 

system.

Yes (all 

required 

languages)

No No No

Basic Service Manual

Supplies block diagrams, spare 

parts, adjustments, instructions to 

help qualified technical personnel 

repair the system.

No No No Yes
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Documentation  (continued)

NOTE: An AIUM Booklet is shipped with systems shipped in the United 
States and Canada. 

NOTE: Dates on screenshots are represented in MM/DD/YYYY format 
throughout the manual. Information on how to change the 
system’s date can be found in Customizing Your System. 

NOTE: The screen graphics in this manual are only for illustrational 
purposes. Actual screen output may differ.

Online Help

Online Help is available on the system by pressing the F1 key or 
via the eIFU icon on the second Utility Page. The Help screen is 
divided into three sections: navigational tools on the top, the left 
portion of the screen (Hide, Back, Forward), the help book 
navigational tools on the left portion of the screen (Contents, 
Index, Search, Favorites), and the content portion on the right 
side of the screen, where help topics are displayed. 

Figure 1-1. Opening Help Screen
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Navigating through the Help Book

Online Help is organized like a manual, with individual chapters, 
sections, and pages. Click on the plus (+) sign next to MANUAL 
to open up the book. Click on the plus sign next to the chapter 
you want to view to open up that chapter. Click on the plus sign 
next to the chapter you want to view to open up that section. 
Open up the page to view that page’s information. 

The blue, underlined text links you to related topics. Click on the 
link to move to the new topic. 

Links

After you click on a blue, underlined portion of text, the screen 
updates with this link’s content. To go back to the previous 
screen, press Back. To return to the link, press Forward. 

Searching for a Topic

To search for a specific topic, click on the Search tab in the left 
portion of the screen. Type in the topic name in the Type in the 
keyword to find: field. Topics with the word or phrase you typed 
appear in the Select Topic to display: area. Either double click 
on the topic you want to view or highlight the topic and press the 
Display button to view this topics. 

Saving Favorite Topics

You may find that there are topics you need to refer to often. In 
this case, it’s a good idea to save these topics as Favorites. To 
save a topic as a favorite, press the Favorites tab, highlight the 
topic in the Topics window, and press the Add button. You can 
view this topic quickly by going to the Favorites help tab. 

Using the Index

Or, you can look for topics by using the Index. Press the Index 
tab, then use the scroll bar to look up a topic. 
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Other Help Features

To hide the left side of the screen, press the Hide icon at the 
upper, left-hand portion of the screen. To view the left side of the 
screen again, press the Show icon at the upper, left-hand 
portion of the screen. 

To size the Help window, position and hold down the cursor at 
the corner of the screen while moving the Trackball. 

To move the Help window to the Touch Panel display, position 
and hold down the cursor at the very top of the Help window 
while moving the Trackball to the Touch Panel display. 

Exiting Online Help

To exit Online Help, press the ‘X’ in the upper, right-hand corner 
of the Online Help window. 

Electronic Media

Accessing Documentation Via a Windows PC

To view user documentation on a Windows PC, 

1. Insert the media into the media drive. 

2. Open the media drive on your desktop. 

3. Double click on the ‘LOGIQ Fortis.html’ document. 

4. Select the item you want to view (click on the blue, 
underlined link in the File Name column). 

To close the window, click on the ‘X’ in the upper, right-hand 
corner of the browser window. 

NOTE: If your PC does not have Adobe Reader, a free download is 
available on the Adobe website at http://www.adobe.com. 
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Updating Documentation on the Ultrasound Scanner Via the USB

The latest version of the Online Help is located on the USB flash 
drive. To update to the latest version: 

1. Power down the LOGIQ Fortis and insert the eIFU USB 
flash drive into a rear USB port. 

NOTE: Ensure that the system is USB Device Enabled (check 
setting on System Admin Utility Page). 

2. Power on the LOGIQ Fortis and follow the screen prompts.   

a. Select Install SW ... on the Start Application screen.

b. Select OK on the first StartLoader screen.

c. Select the package and then select Install on the 
second StartLoader screen; software installation begins. 
After “Installation has completed” message appears and 
system restarts, remove USB flash drive.

d. As you verify each feature works correctly, select 
“Passed.” If all features work correctly and “Passed” is 
selected for all features, the signature field is enabled at 
the bottom of the New Software Verification Checklist. 
Type your signature (minimum of three characters) and 
press OK. The system is now ready for use.

NOTE: You can search through a document, use hyperlinks in the Table 
of Contents and Index to locate topics, and navigate via 
bookmarks. 

NOTE: In addition to viewing documentation on the Ultrasound system, 
the Documentation media can be read on any PC. 

To exit, press the ‘X’ in the upper, right-hand corner of the 
documentation window. 

Viewing Online Help in a Language Different from the System Language

On the Utility--> System--> Online Help Language page, select 
the language you wish to view Online Help. 

If the translated Online Help is not available, you will be directed 
to select a different language. 

Translated Online Help files can be updated via the eIFU USB 
Flash Drive. Please contact your Applications/Field Service 
Representative to order an updated eIFU Kit. 
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Online Customer Documentation Portal

Documentation is available in the Customer Documentation 
Portal on the internet at the GE Healthcare Support 
Documentation Library at:

https://www.gehealthcare.com/support/documentation

Navigate to the Customer Documentation Portal on the website 
and enter the following information to search for the desired 
manual:

• Document Number

OR

• Modality

• Product(s)

• Document Type

• Keyword

You can download the desired manual from the website or copy 
the manual url to share the link. 

Paper Documentation

Paper manuals can be ordered via H-Cat.
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Principles of Operation

Medical ultrasound images are created by computer and digital 
memory from the transmission and reception of mechanical 
high-frequency waves applied through a transducer. The 
mechanical ultrasound waves spread through the body, 
producing an echo where density changes occur. For example, 
in the case of human tissue, an echo is created where a signal 
passes from an adipose tissue (fat) region to a muscular tissue 
region. The echoes return to the transducer where they are 
converted back into electrical signals.

These echo signals are highly amplified and processed by 
several analog and digital circuits having filters with many 
frequency and time response options, transforming the 
high-frequency electrical signals into a series of digital image 
signals which are stored in memory. Once in memory, the image 
can be displayed in real-time on the image monitor. All signal 
transmission, reception and processing characteristics are 
controlled by the main computer. By selection from the system 
control panel, the user can alter the characteristics and features 
of the system, allowing a wide range of uses, from obstetrics to 
peripheral vascular examinations.

Transducers are accurate, solid-state devices, providing multiple 
image formats. The digital design and use of solid-state 
components provides highly stable and consistent imaging 
performance with minimal required maintenance. Sophisticated 
design with computer control offers a system with extensive 
features and functions which is user-friendly and easy to use.
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Indications for Use 

The LOGIQ Fortis is intended to be used in a hospital or medical 
clinic.

US Indications for Use Statement

The LOGIQ Fortis is a general purpose diagnostic ultrasound 
system intended for use by qualified and trained healthcare 
professionals for ultrasound imaging, measurement, display and 
analysis of the human body and fluid. LOGIQ Fortis clinical 
applications include : Fetal / Obstetrics; Abdominal (including 
Renal, Gynecology/Pelvic); Pediatric; Small Organ (Breast, 
Testes, Thyroid); Neonatal Cephalic; Adult Cephalic; Cardiac 
(Adult and Pediatric); Peripheral Vascular; Musculo-skeletal 
Conventional and Superficial; Urology (including Prostate); 
Transrectal; Transvaginal; Transesophageal and Intraoperative 
(Vascular).

Modes of operation include: B, M, PW Doppler, CW Doppler, 
Color Doppler, Color M Doppler, Power Doppler, Harmonic 
Imaging, Coded Pulse, 3D/4D Imaging mode, Elastography, 
Shear Wave Elastography, Attenuation Imaging and Combined 
modes: B/M, B/Color, B/PWD, B/Color/PWD, B/Power/PWD.

Operator Profile

• Qualified and trained physicians or sonographers with at 
least basic ultrasound knowledge.

• The operator must have read and understood the user 
manual.

NOTE: Only qualified physicians or sonographers should perform 
ultrasound scanning on human subjects for medical diagnostic 
reasons. Request training, if needed.

Frequency of Use

Daily (Typically 8 hours)
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Contraindication 

The LOGIQ Fortis ultrasound system is not intended for 
ophthalmic use or any use causing the acoustic beam to pass 
through the eye.

Prescription Device

CAUTION: United States law restricts this device to sale or use 
by, or on the order of a physician.

Clinical Benefit 

The clinical benefit of a diagnostic ultrasound device is to help 
healthcare professionals provide accurate diagnostic 
information (visualize human tissue/internal structure) that 
enhances the diagnostic and treatment care pathways of the 
patient for a variety of diseases and conditions.

Patient Population

• Age: all ages (including embryos and fetuses)

• Location: worldwide

• Sex: male and female

• Weight: all weight categories

• Height: no limitations

WARNING Do not cross-use the ultrasound system between human and 
veterinary/animal use.
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Contact Information

Contacting GE Ultrasound

For additional information or assistance, please contact your 
local distributor or the appropriate support resource listed on the 
following pages:

INTERNET http://www.gehealthcare.com

https://cleaning.gehealthcare.com

Clinical Questions For information in the United States, Canada, Mexico and parts 
of the Caribbean, call the Customer Answer Center. 
TEL: (1) 800-682-5327 or (1) 262-524-5698

In other locations, contact your local Applications, Sales, or 
Service Representative. 

Service Questions For service in the United States, call GE CARES. 

TEL: (1) 800-437-1171

In other locations, contact your local Service Representative.

Information 

Requests

To request technical product information in the United States, 
call GE. 

TEL: (1) 800-643-6439

In other locations, contact your local Applications, Sales, or 
Service Representative.

Placing an Order To order accessories, supplies, or service parts in the United 
States, call the GE Technologies Contact Center.

TEL: (1) 800-558-5102

In other locations, contact your local Applications, Sales, or 
Service Representative.
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Contacting GE Ultrasound  (continued)

Table 1-2:  Americas

ARGENTINA TEL: (+54) 11-5298-2200

BRAZIL TEL: 

3004 2525 (Capitals and 

Metropolitan Regions)

08000 165 799 (Other 

Locations)

CANADA TEL: (1) 800-668-0732

Customer Answer Center 

TEL: (1) 262-524-5698

LATIN & SOUTH 

AMERICA

TEL: (1) 262-524-5300

Customer Answer Center 

TEL: (1) 262-524-5698

MEXICO TEL: (5) 228-9600

FAX: (5) 211-4631

USA TEL: (1) 800-437-1171

FAX: (1) 414-721-3865

Table 1-3:  Asia

ASIA PACIFIC 

JAPAN

TEL:  +81 42 585 5111

AUSTRALIA    TEL: 1800 659 465

CHINA TEL: (8610) 5806 8888

FAX: (8610) 6787 1162

Service: 4008128188 

(24h)

INDIA TEL: +(91) 

1-800-425-8025
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KOREA TEL: +82 2 6201 3114

NEW ZEALAND TEL: 0800 659 465

SINGAPORE TEL:  +65 6291 8528 

FAX: +65 6291 7006

Table 1-4:  Africa

EGYPT TEL: +20 2 25354200

FAX: +20 2 25370031

KENYA TEL: +254 719 093 044

NIGERIA TEL: +234 (01) 4607101

TEL: +234 (01) 4607102

KINGDOM OF SAUDI 

ARABIA

TEL: +966 (11) 494 5779

FAX: +966 (11) 207 3946

SOUTH AFRICA TEL: +270100725000

FAX: +27 0862958385

Table 1-5:  Europe

AUSTRIA TEL: (+43) 1 97272 0

FAX: (+43) 1 97272 2222

BELGIUM & 

LUXEMBURG

TEL: (+32) 2 719 7204

FAX: (+32) 2 719 7205

Table 1-3:  Asia (Continued)
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CZECH REPUBLIC TEL: (+420) 224 446 162

FAX: (+420) 224 446 161

DENMARK TEL: (+45) 43 295 400

FAX: (+45) 43 295 399

ESTONIA & 

FINLAND

TEL: (+358) 10 39 48 220

FAX: (+358) 10 39 48 221

FRANCE TEL: (+33) 1 34 49 52 70

FAX: (+33) 13 44 95 202

GERMANY TEL: (+49) 212-28 02-0

FAX: (+49) 212-28 

02-380

GREECE TEL: (+30) 210 8930600

FAX: (+30) 210 9625931

HUNGARY TEL: (+36) 23 410 314

FAX: (+36) 23 410 390

IRELAND NORTHERN IRELAND

REPUBLIC OF IRELAND

TEL: (+44) 028 90229900

TEL: 1800 460 550 

FAX: (+353) 1 686 5327

ITALY TEL: (+39) 02 2600 1111

FAX: (+39) 02 2600 1417

KAZAKHSTAN T +7 727 3560020

LUXEMBORG See Belgium.

NETHERLANDS TEL: (+31) 33 254 1290

FAX: (+31) 33 254 1292

Table 1-5:  Europe (Continued)
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NORWAY TEL: (+47) 23 18 50 50

FAX: (+47) 23 18 60 35

TEL: (+47) 33 02 11 16

POLAND TEL: (+48) 22 330 83 00

FAX: (+48) 22 330 83 83

PORTUGAL TEL: (+351) 21 425 1300

FAX: (+351) 21 425 1343

RUSSIA TEL: (+7) 4957 396931

FAX: (+7) 4957 396932

SPAIN TEL: (+34) 91 663 2500

FAX: (+34) 91 663 2501

SWEDEN TEL: (+46) 08 559 500 10

FAX: (+46) 08 559 500 15

Service Center (+46) 

020-120 14 36

SWITZERLAND TEL: (+41) 1 809 92 92

FAX: (+41) 1 809 92 22

TURKEY TEL: +90 212 398 07 00

FAX: +90 212 284 67 00

UNITED ARAB 

EMIRATES (UAE)

TEL: (+971) 4 429 6101 

or  4 429 6161

FAX: (+971) 4 429 6201

UNITED KINGDOM TEL: (+44) 1494 544000

FAX: (+44) 1707 289742

For all other European countries not listed, please contact your local GE distributor or the appropriate 

support resource listed on www.gehealthcare.com.

Table 1-5:  Europe (Continued)
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Manufacturer

GE Ultrasound Korea, Ltd.
9, Sunhwan-ro 214beon-gil, Jungwon-gu, Seongnam-si,
Gyeonggi-do,
KOREA
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Chapter 2

Safety

Describes the safety and regulatory information 

pertinent for operating this ultrasound system. 
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Owner Responsibility

Owner requirements

It is the responsibility of the owner to ensure that anyone 
operating the system reads and understands this section of the 
manual. However, there is no representation that the act of 
reading this manual renders the reader qualified to operate, 
inspect, test, align, calibrate, troubleshoot, repair or modify the 
system. The owner should make certain that only properly 
trained, fully-qualified service personnel undertake the 
installation, maintenance, troubleshooting, calibration and repair 
of the equipment.

The owner of the ultrasound unit should ensure that only 
properly trained, fully qualified personnel are authorized to 
operate the system. Before authorizing anyone to operate the 
system, it should be verified that the person has read, and fully 
understands, the operating instructions contained in this 
manual. It is advisable to maintain a list of authorized operators.

Should the system fail to operate correctly, or if the unit does not 
respond to the commands described in this manual, the 
operator should contact the nearest field GE Ultrasound Service 
Office.

For information about specific requirements and regulations 
applicable to the use of electronic medical equipment, consult 
the local, state and federal agencies.

For USA only Federal law restricts this device to use by, or on the orders of, a 
physician.

Notice against user modification

Never modify this product, including system components, 
software, cables, and so on. User modification may cause safety 
hazards and degradation in system performance. All 
modification must be done by a GE qualified person.
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Reporting

In the case of a serious incident occuring in relation to LOGIQ 
Fortis ultrasound products, the incident should be reported to 
GE Healthcare and the competent Authority. 
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Safety Precautions

Precaution Levels

Icon description

Various levels of safety precautions may be found on the 
equipment and different levels of concern are identified by one 
of the following flag words and icons which precede the 
precautionary statement.

NOTE: Substantial property damage is defined as system requires 
service to function.

NOTE: Indicates precautions or recommendations that should be used 
in the operation of the ultrasound system, specifically:

• Maintaining an optimum system environment

• Using this Manual

• Notes to emphasize or clarify a point.

DANGER
 

Indicates that a specific hazard is known to exist which through 
inappropriate conditions or actions will cause:

• Severe or fatal personal injury

WARNING Indicates that a specific hazard is known to exist which through 
inappropriate conditions or actions may cause:

• Minor personal injury

• Substantial property damage

CAUTION Indicates that a potential hazard may exist which through 
inappropriate conditions or actions will or can cause: 

• Property damage



Safety Precautions

LOGIQ Fortis – Basic User Manual 2-5
5855997-1EN Rev. 3

Hazard Symbols

Icon Description

Potential hazards are indicated by the following icons:

Table 2-1:  Potential Hazards

Icon Potential Hazard Usage

Biological Hazard

Describes precautions necessary to prevent the risk of 

disease transmission or infections.

• Patient/user infection due to contaminated equipment.

• Cleaning and care 

instructions

• Sheath and glove 

guidelines

Electrical Hazard

Describes precautions necessary to prevent the risk of 

injury through electric hazards.

• Electrical micro-shock to patient, e.g., ventricular

• Probes

• ECG, if applicable

• Connections to back 

panel

Moving Hazard

Describes precautions necessary to prevent the risk of 

injury through moving or tipping hazard!

• Console, accessories or optional storage devices that 

can fall on patient, user, or others.

• Collision with persons or objects may result in injury 

while maneuvering or during system transport.

• Injury to user from moving the console.

• Moving

• Using brakes

• Transporting

Acoustic Output Hazard

• Patient injury or tissue damage from ultrasound 

radiation.

• ALARA, the use of 

Power Output following 

the ‘as low as 

reasonably achievable’ 

principle

Explosion Hazard

Describes precautions necessary to prevent the risk of 

injury through explosion hazard!

• Risk of explosion if used in the presence of flammable 

anesthetics.

• Flammable anesthetic

Fire and Smoke Hazard

• Patient/user injury or adverse reaction from fire or 

smoke.

• Patient/user injury from explosion and fire.

• Replacing fuses

• Outlet guidelines
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Important Safety Considerations

The following topic headings (Patient Safety, and Equipment 
and Personnel Safety) are intended to make the equipment user 
aware of particular hazards associated with the use of this 
equipment and the extent to which injury can occur if 
precautions are not observed. Additional precautions may be 
provided throughout the manual. 

DANGER
 

Improper use can result in serious injury. The use of the system 
outside the described conditions or intended use, and 
disregarding safety related information is considered abnormal 
use. The user must be thoroughly familiar with the instructions 
and potential hazards involving ultrasound examination before 
attempting to use the device. Training assistance is available 
from GE if needed.

Disregarding information on safety is considered abnormal use.

Following are potential risks inherent to technology:

• Ultrasonic energy delivered to non-targeted tissue with the 
use of Ultrasound devices, and the interaction of sound 
energy with tissue at sufficiently high levels can produce 
biological effects.

• Monitoring the Mechanical Index (MI) can be a tool to help 
monitor the probability that cavitation could occur. 
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Patient Safety

Related Hazards

Patient identification

Always include proper identification with all patient data and 
verify the accuracy of the patient's name and ID numbers when 
entering such data. Make sure correct patient ID is provided on 
all recorded data and hard copy prints. Identification errors could 
result in an incorrect diagnosis.

The ultrasound system is not meant to be long term storage for 
patient data or images. The customers are responsible for the 
data on the system and a regular backup is highly 
recommended. 

It is advisable to back up system data prior to any service 
repairs to the hard drive. It is always possible during system 
failure and repair to lose patient data. GE will not be held 
responsible for the loss of this data.

WARNING The concerns listed can affect the safety of patients undergoing 
a diagnostic ultrasound examination.
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Diagnostic information

The images and calculations provided by the system are 
intended for use by competent users, as a diagnostic tool. They 
are explicitly not to be regarded as the sole, irrefutable basis for 
clinical diagnosis. Users are encouraged to study the literature 
and reach their own professional conclusions regarding the 
clinical utility of the system.

The user should be aware of the product specifications and of 
the system accuracy and stability limitations. These limitations 
must be considered before making any decision based on 
quantitative values. If in doubt, the nearest GE Ultrasound 
Service Office should be consulted.

Equipment malfunction or incorrect settings can result in 
measurement errors or failure to detect details within the image. 
The equipment user must become thoroughly familiar with the 
equipment operation in order to optimize its performance and 
recognize possible malfunctions. Applications training is 
available through the local GE representative. Added 
confidence in the equipment operation can be gained by 
establishing a quality assurance program.

WARNING The system provides calculations (e.g estimated fetal weight) 
and charts based on published scientific literature. The 
selection of the appropriate chart and clinical interpretation of 
calculations and charts is the sole responsibility of the user. 
The authorized user should consider proper indications for the 
use of a calculation or chart as described in the scientific 
literature. The diagnosis, decision for further examination, and 
medical treatment must be performed by qualified personnel 
following good clinical practice.

CAUTION Features that facilitate measurements such as VOCAL or 
SonoNT must be used with extreme care. The measurement 
results are a suggestion of the system, if in doubt verify with 
manual measurement methods.

The user is responsible for the diagnostic interpretation of the 
measurement results.
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Mechanical hazards

The use of damaged probes or improper use and manipulation 
of intracavity probes can result in injury or increased risk of 
infection. Inspect probes often for sharp, pointed, or rough 
surface damage that could cause injury or tear protective 
barriers.

The use of damaged probes can result in injury or increased risk 
of infection. Inspect probes often for sharp, pointed, or rough 
surface damage that could cause injury or tear protective 
barriers. 

Electrical
Hazard

A damaged probe can also increase the risk of electric shock if 
conductive solutions come in contact with internal live parts. 
Inspect probes often for cracks or openings in the housing and 
holes in and around the acoustic lens or other damage that 
could allow liquid entry. Become familiar with the probe's use 
and care precautions outlined in Probes and Biopsy.

DANGER
 

Ultrasound transducers are sensitive instruments which can 
easily be damaged by rough handling. Take extra care not to 
drop transducers and avoid contact with sharp or abrasive 
surfaces. A damaged housing, lens or cable can result in 
patient injury or serious impairment or operation. 
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ALARA

Training

It is recommended that all users receive proper training in 
applications before performing them in a clinical setting. Please 
contact the local GE representative for training assistance.

ALARA training is provided in the Medical Ultrasound Safety 
booklet shipped in the eDOCs kit. The ALARA education 
program for the clinical end-user covers basic ultrasound 
principles, possible biological effects, the derivation and 
meaning of the indices, ALARA principles, and examples of 
specific applications of the ALARA principle.

DANGER
 

Ultrasound can produce harmful effects in tissue and 
potentially result in patient injury. Always minimize exposure 
time and keep ultrasound levels low when there is no medical 
benefit. Use the principle of ALARA (As Low As Reasonably 
Achievable), increasing output only when needed to obtain 
diagnostic image quality. Observe the acoustic output display 
and be familiar with all controls affecting the output level. See 
the Bioeffects section of the Acoustic Output chapter in the 
Advanced Reference Manual for more information.
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Equipment and Personnel Safety

The concerns listed in the Related Hazards section can 
seriously affect the safety of equipment and personnel during a 
diagnostic ultrasound examination. 

Related Hazards 

DANGER
 

This equipment contains dangerous voltages that are capable 
of serious injury or death.

If any defects are observed or malfunctions occur, stop 
operating the equipment and perform the proper action for the 
patient. Inform a qualified service person and contact a Service 
Representative for information.

There are no user serviceable components inside the console. 
Refer all servicing to qualified service personnel only.

Ensure that unauthorized personnel do not tamper with the 
unit. 

Electrical
Hazard

To avoid injury:

• Do not remove protective covers. No user serviceable 
parts are inside. Refer servicing to qualified service 
personnel.

• To assure adequate grounding, connect the attachment 
plug to a reliable (hospital grade) grounding outlet (having 
equalization conductor ).

• Never use any adaptor or converter of a 
three-prong-to-two-prong type to connect with a mains 
power plug. The protective earth connection will loosen.

• Do not place liquids on or above the console. Spilled liquid 
may contact live parts and increase the risk of shock.

• In North America, a 220-240V installation requires the use 
of a center-tapped AC power source. 
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Related Hazards  (continued)

DANGER
 

The concerns listed below can seriously affect the safety of 
equipment and personnel during a diagnostic ultrasound 
examination.

Explosion
Hazard

Risk of explosion if used in the presence of flammable 
anesthetics.

Never operate the equipment in the presence of flammable or 
explosive liquids, vapors or gases. Malfunctions in the unit, or 
sparks generated by fan motors, can electrically ignite these 
substances. Operators should be aware of the following points 
to prevent such explosion hazards.

• If flammable substances are detected in the environment, 
do not plug in or turn on the system.

• If flammable substances are detected after the system has 
been turned on, do not attempt to turn off the unit, or to 
unplug it.

• If flammable substances are detected, evacuate and 
ventilate the area before turning off the unit.

Smoke &
Fire Hazard

The system must be supplied from an adequately rated 
electrical circuit. The capacity of the supply circuit must be as 
specified.

DANGER
 

Biological Hazard

For patient and personnel safety, be aware of biological 
hazards while performing invasive procedures. To avoid the 
risk of disease transmission:

• Use protective barriers (gloves and probe sheaths) 
whenever possible. Follow sterile procedures when 
appropriate.

• Thoroughly clean probes and reusable accessories after 
each patient examination and disinfect or sterilize as 
needed. Refer to Probes and Biopsy for probe use and 
care instructions.

• Follow all infection control policies established by your 
office, department or institution as they apply to personnel, 
equipment and accessories.
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Related Hazards  (continued)

DANGER
 

Do not unpack the LOGIQ Fortis. This must be performed by 
qualified service personnel only. Improper unpacking could 
lead to injury.

DANGER
 

GE recommends dedicated probes for use on humans only or 
animals only. Mark probes dedicated for animals with special 
labels.

Observe any country specific rules and regulations for handling 
equipment used on both animals and humans. Such national 
restrictions may prohibit transfer of probes used on animals to 
humans and vice-versa.

Failure to follow these instructions could lead to exposure to 
infectious agents.

WARNING • Make sure to verify the media after writing data, such as 
EZBackup, SaveAs or Export.     

• Before deleting a patient or image from the patient screen, 
make sure you have saved the data by EZBackup/Backup 
or Export and verify that the media data transfer was 
successful. Not following the instructions could result in the 
loss of data requiring a rescan.

WARNING When you move the Control Panel up/down with the monitor, 
place BOTH hands on the Control Panel. Touching other 
moving parts other than the Control Panel may cause personal 
injury.

WARNING Contact with natural rubber latex may cause a severe 
anaphylactic reaction in persons sensitive to the natural latex 
protein. Sensitive users and patients must avoid contact with 
these items. 

WARNING The LOGIQ Fortis is not intended to be used as a data storage 
device; backup of the Patient and Image Database is your 
institution’s responsibility. GE is NOT responsible for any lost 
patient information or for lost images. Loss of image data may 
require a rescan. 
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Related Hazards  (continued)

WARNING To minimize accidental loss of data, perform EZBackup and 
Backup on a regular basis.

1. First, perform EZBackup to save the images.

2. Next, perform Backup at Utility -> Backup/Restore. Enable 
the following checkboxes under Backup:

• User defined configuration

• Service

CAUTION Only approved and recommended peripherals and accessories 
should be used. 

All peripherals and accessories must be securely mounted to 
the LOGIQ Fortis. Failure to follow these instructions could lead 
to unexpected diagnostic performance.

CAUTION Non-supported peripheral devices that use their own AC power 
source CANNOT be attached to the LOGIQ Fortis. DO NOT 
connect the peripheral device’s power cord into the LOGIQ 
Fortis system. Only peripheral devices purchased from GE with 
the purpose of being used with the LOGIQ Fortis system 
should be used. 

Use a USB printer cable that is less than 3 meters in length.

Failure to follow these instructions could lead to unexpected 
diagnostic performance.

CAUTION Do not use this equipment if a safety problem is known to exist. 
Have the unit repaired and performance verified by qualified 
service personnel before returning to use.
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Related Hazards  (continued)

Material Safe Data

Rubber part

Material: EPDM

Where Used: Probe holder/Gel holder/Keyboard bumper/Front 
and Rear Foot Pedal/System bumper at the four corners.

CAUTION To avoid injury or system damage, NEVER place any object or 
liquid on the operator panel.
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Related Hazards (Monitor)

NOTE: Bright light could impact readability of screen.

Related Hazards (Volume Navigation)

WARNING • DO NOT place a finger, hand or any object on the joint of 
the monitor or monitor arm to avoid injury when moving the 
monitor and monitor arm.

• To avoid result of injury or system damage, NEVER place 
any object or liquid on the monitor, whether in the home or 
flip down/transport position.

• DO NOT scratch or press on the panel with any sharp 
objects, such as a pencil or pen, as this may result in 
damage to the panel.

• To avoid injury or damage, make sure nothing is within the 
range of motion before moving the monitor and monitor 
arm. This includes both objects and people.

• Pay attention to the monitor arm position to avoid hitting it 
against anyone or anything.

• Before moving the system to another location, be sure to 
lock the monitor arm in the transport position. 

• The monitor screen may have defective pixels. These 
pixels may appear as a slightly light or dark area on the 
screen. This is due to the characteristics of the panel itself, 
and not the product. 

• The backlight of the monitor has a fixed life span. When the 
screen becomes dark or begins to flicker, contact a 
qualified Service Representative for information. 

DANGER
 

DO NOT use the Volume Navigation feature on any patient 
relying on life-sustaining electronic equipment, such as a 
pacemaker or defibrillator. Failure to follow this instruction 
could lead to interference with patient electronic device(s).
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Related Hazards (Specific modes and features)

CAUTION • Be aware that diagnostic conclusions must not be drawn 
from a specific mode, such as Render Mode or 
LOGIQView Mode. Always check with other diagnostic 
procedures.

• The accuracy of measurements in specific modes such as 
Render Mode, LOGIQView, STIC or VOCAL is limited and 
can be lower than measurements in B-images.

• Do not diagnose based on 3D/4D Acquisition Mode. 
Always check and confirm diagnostic findings in B-Mode.
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Classifications

Type of protection against electric shock

Class I Equipment (*1)

Degree of protection against electric shock

Type BF Applied part (*2) (for Probes marked with BF symbol)

Type CF Applied part (*3) (for ECG, PCG, AUX, eTRAX needle marked 

with CF symbol)

Continuous Operation

System is Ordinary Equipment (IPX0)

Footswitch is IPX8; Probes are IPX6 or greater

NOTE: Probe connector is not waterproof.

*1. Class I Equipment

EQUIPMENT in which protection against electric shock does not 
rely on BASIC INSULATION only, but includes an earth ground. 
This additional safety precaution prevents exposed metal parts 
from becoming LIVE in the event of an insulation failure.

*2. Type BF Applied Part

TYPE BF APPLIED PART providing a specified degree of 
protection against electric shock, with particular regard to 
allowable LEAKAGE CURRENT.

*3. Type CF Applied Part

TYPE CF APPLIED PART providing a degree of protection 
higher than that for Type BF Applied Part against electric shock 
particularly regarding allowable LEAKAGE CURRENTS.

Table 2-2:  Type BF Equipment

Normal Mode Single fault condition

Patient leakage current Less than 100 microA Less than 500 microA

Table 2-3:  Type CF Equipment

Normal Mode Single fault condition

Patient leakage current Less than 10 microA Less than 50 microA
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EMC (Electromagnetic Compatibility)

NOTE: This equipment generates, uses and can radiate radio 
frequency energy. The equipment may cause radio frequency 
interference to other medical and non-medical devices and radio 
communications. To provide reasonable protection against such 
interference, this product complies with emissions limits for a 
Group 1, Class A Medical Devices Directive as stated in EN 
60601-1-2. However, there is no guarantee that interference will 
not occur in a particular installation.

NOTE: If this equipment is found to cause interference (which may be 
determined by turning the equipment on and off), the user (or 
qualified service personnel) should attempt to correct the 
problem by one or more of the following measure(s):

• reorient or relocate the affected device(s)

• increase the separation between the equipment and the 
affected device

• power the equipment from a source different from that of the 
affected device

• consult the point of purchase or service representative for 
further suggestions.

NOTE: The manufacturer is not responsible for any interference caused 
by using other than recommended interconnect cables or by 
unauthorized changes or modifications to this equipment. 
Unauthorized changes or modifications could void the users’ 
authority to operate the equipment.

NOTE: To comply with the regulations on electromagnetic interference 
for a Class A FCC Device, all interconnect cables to peripheral 
devices must be shielded and properly grounded. Use of cables 
not properly shielded and grounded may result in the equipment 
causing radio frequency interference in violation of the FCC 
regulations.

CAUTION Unexpected diagnostic system performance or failure from 
interference broadcasted by device due to electromagnetic 
incompatibility with cauterizing knife causing obvious 
deterioration of image quality. 
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EMC (Electromagnetic Compatibility)  (continued)

NOTE: Do not use devices which intentionally transmit RF Signals 
(cellular phones, transceivers, or radio controlled products), 
other than those supplied by GE, in the vicinity of the equipment, 
as it may cause performance outside the published 
specifications. Keep the power to these type devices turned off 
when near this equipment.

The medical staff in charge of this equipment is required to 
instruct technicians, patients, and other people who maybe 
around this equipment to fully comply with the above 
requirement.

CAUTION Portable RF communications equipment (including peripherals 
such as antenna cables and external antennas) at frequencies 
noted in Table 2-4 on page 2-23 should be used no closer than 
30cm (12 inches) to any part of the LOGIQ Fortis, including 
cables specified by GE.

Otherwise, degradation of the performance of this equipment 
could result.
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EMC Performance

All types of electronic equipment may characteristically cause 
electromagnetic interference with other equipment, either 
transmitted through air or connecting cables. The term EMC 
(Electromagnetic Compatibility) indicates the capability of 
equipment to curb electromagnetic influence from other 
equipment and at the same time not affect other equipment with 
similar electromagnetic radiation from itself.

Proper installation following the service manual is required in 
order to achieve the full EMC performance of the product.

The product must be installed as stipulated in 4.2, Notice upon 
Installation of Product.

In case of issues related to EMC, please call your service 
personnel.

The manufacturer is not responsible for any interference caused 
by using other than recommended interconnect cables or by 
unauthorized changes or modifications to this equipment. 
Unauthorized changes or modifications could void the users’ 
authority to operate the equipment. 

CAUTION Use of this equipment adjacent to or stacked with other 
equipment should be avoided because it could result in 
improper operation. If such use is necessary, this equipment 
and the other equipment should be observed to verify that they 
are operating normally. Failure to follow these instruction could 
lead to unexpected diagnostic performance. 
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EMC Performance  (continued)

Portable and mobile radio communications equipment (e.g. 
two-way radio, cellular/cordless telephones, wireless computer 
networks) should be used no closer to any part of this system, 
including cables, than determined according to the following 
method: 

WARNING Do not use devices which intentionally transmit RF signals 
(cellular phones, transceivers, or radio controlled products), 
other than those supplied by GE (wireless microphone, 
broadband over power lines, for example) unless intended for 
use with this system, in the vicinity of this equipment as it may 
cause performance outside the published specifications.

Keep power to these devices turned off when near this 
equipment.

Medical staff in charge of this equipment is required to instruct 
technicians, patients and other people who may be around this 
equipment to fully comply with the above regulation.
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EMC Performance  (continued)

Table 2-4:  Recommended separation distances between portable and mobile RF 
communications equipment and this system 

This system is intended for use in an electromagnetic environment in which radiated RF 

disturbances are controlled. The customer or the user of this system can help prevent 

electromagnetic Interference by maintaining a minimum distance between portable and mobile RF 

communications equipment (transmitters) and this system as recommended below, according to the 

maximum output power of the communications equipment. 

Rated Maximum Output 

Power (P) of 

Transmitter Watts (W)

Separation distance according to transmitter frequency

150 kHz - 80 MHz

d=[3.5/3] square root of 

P

80 MHz - 800 MHz

d = [3.5/3] square root 

of P

800 MHz - 2.5 GHz

d = [7/3] square root of 

P

Where: d= separation distance in meters, P = rated power of the transmitter. 

The separation distance in meters should be

0.01 0.12 0.12 0.23

0.1 0.37 0.37 0.74

1 1.17 1.17 2.33

10 3.69 3.69 7.38

100 11.7 11.7 23.3

For transmitters rated at a maximum output power not listed above, the separation distance can be 

estimated using the equation in the corresponding column, where P is the maximum output power rating of 

the transmitter in watts (W) according to the transmitter manufacturer.

NOTE: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 

reflection from structures, objects, and people.
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Notice upon Installation of Product

Separation distance and effect from fixed radio communications 
equipment: field strengths from fixed transmitters, such as base 
stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast, and TV 
broadcast transmitter cannot be predicted theoretically with 
accuracy. To assess the electromagnetic environment due to 
fixed RF transmitters, an electromagnetic site survey should be 
considered. If the measured field strength in the location in 
which the ultrasound system is used exceeds the applicable RF 
compliance level as stated in the immunity declaration, the 
ultrasound system should be observed to verify normal 
operation. If abnormal operation is observed, additional 
measures may be necessary, such as re-orienting or relocating 
the ultrasound system or using an RF shielded examination 
room may be necessary.

1. Use either power supply cords provided by GE Healthcare 
or ones designated by GE Healthcare. Products equipped 
with a power source plug should be plugged into the fixed 
power socket which has the protective grounding conductor. 
Never use any adaptor or converter to connect with a power 
source plug (e.g. three-prong-to-two-prong converter).

2. Locate the equipment as far away as possible from other 
electronic equipment.

3. Be sure to use only the cables provided by or designated by 
GE Healthcare. Connect these cables following the 
installation procedures (e.g. wire power cables separately 
from signal cables).

4. Lay out the main equipment and other peripherals following 
the installation procedures described in the Option 
Installation manuals.
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General Notice

Probe cables

WARNING Use of accessories, transducers and cables other than those 
specified or provided by GE of this equipment could result in 
increased electromagnetic emissions or decreased 
electromagnetic immunity of this equipment and result in 
improper operation.

Table 2-5:  Probe cables

Probe Length (m) CableType

L2-9VN-D

L2-9-D

L3-12-D

ML6-15-D

L6-24-D

L8-18i-D

M5Sc-D

6S-D

BE9CS-D

C1-6-D

C1-6VN-D

C2-7-D

C2-7VN-D

C2-9-D

C2-9VN-D

C3-10-D

IC5-9-D

6Tc-RS

RAB6-D

RIC5-9-D

P2D

P6D

2.4

2.4

2.2

2.2

3.0

3.0

2.2

2.2

2.2

2.2

2.2

2.2

2.2

2.2

2.2

2.0

2.5

2.1

2.5

2.2

2.0

2.0

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded
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General Notice  (continued)

Other cables

Table 2-6:  Other cables

Model name Length (m) Cable Type

Power cable

ECG cable

ECG lead wire

V-Nav transmitter

V-Nav Dual 10mm sensor

V-Nav Needle Sensor

V-Nav OmniTrax sensor

Footswitch

4.0

3.6

0.7

3.3

2.5

2.5

2.5

2.9

Non-Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded

Shielded
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General Notice  (continued)

1. Designation of Peripheral Equipment Connectable to This 
Product.

The equipment indicated in the Supplies/Accessories 
section can be hooked up to the product without 
compromising its EMC performance.

Avoid using equipment not designated in the list. Failure to 
comply with this instruction may result in poor EMC 
performance of the product.

2. Notice against User Modification

The user should never modify this product. User 
modifications may cause degradation in EMC performance.

Modification of the product includes changes in:

a. Cables (length, material, wiring, etc.)

b. System installation/layout

c. System configuration/components

d. Securing system parts (cover open/close, cover 
screwing)

3. Operate the system with all covers closed. If a cover is 
opened for some reason, be sure to shut it before starting/
resuming operation.

4. Operating the system with any cover open may affect EMC 
performance.
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Peripheral Update for EC countries

The following is intended to provide the users in EC countries 
with updated information concerning the connection of the 
LOGIQ Fortis to image recording and other devices or 
communication networks.

Peripherals used in the patient environment

The LOGIQ Fortis has been verified for overall safety, 
compatibility and compliance with the following image recording 
devices:

• Sony UP-D898DC Digital Printer

• Sony UP-D25 Digital Printer

• Sony UP-DR80MD Color Printer

• Drive Bay (for Tru3D and Volume Navigation) 

• USB 2.0/3.0 Flash Drive 

• USB Hard Disk Drive

NOTE: The LOGIQ Fortis supports the USB 3.0 standard (on the 
Operator Panel and Peripheral/Accessory Connector Panel) and 
the USB 2.0 standard on the Monitor. 

The LOGIQ Fortis has also been verified for compatibility, and 
compliance for connection to a local area network (LAN) via the 
rear panel Ethernet connection, provided the LAN components 
are IEC/EN 60950 and IEC/EN 62368 compliant. 

A Wireless LAN option is available. See ‘Configuring the 
Wireless Network’ on page 13-480 for more information. 
Conforms to IEEE 802.11 ac/a/b/g/n WiFi with Bluetooth 4.0 
Standard. 

The LOGIQ Fortis may also be used safely while connected to 
devices other than those recommended above if the devices 
and their specifications, installation, and interconnection with the 
system conform to the requirements of IEC/EN 60601-1.
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Peripherals used in the patient environment  (continued)

Accessory equipment connected to the analog and digital 
interfaces must be certified according to the respective IEC 
standards (i.e., IEC60950 for data processing equipment and 
IEC60601-1 for medical equipment). Furthermore, all complete 
configurations shall comply with the valid version of the system 
standard IEC60601-1. Everyone who connects additional 
equipment to the signal input part or signal output part of the 
LOGIQ Fortis system configures a medical system, and is 
therefore responsible to ensure that the system complies with 
the requirements of the valid version of IEC60601-1. If in doubt, 
consult the technical service department or your local GE 
representative. 

General precautions for installing an alternate on-board device 
would include:

1. The added device must have appropriate safety standard 
conformance and CE Marking.

2. The total power consumption of the added devices, which 
connect to the LOGIQ Fortis and are used simultaneously, 
must be less than or equal to the rated supply of the LOGIQ 
Fortis.

3. There must be adequate heat dissipation and ventilation to 
prevent overheating of the device.

4. There must be adequate mechanical mounting of the device 
and stability of the combination.

5. Risk and leakage current of the combination must comply 
with IEC/EN 60601-1.

6. Electromagnetic emissions and immunity of the combination 
must conform to IEC/EN 60601-1-2.
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Peripherals used in the patient environment  (continued)

General precautions for installing an alternate off-board, remote 
device or a network would include:

1. The added device(s) must have appropriate safety standard 
conformance and CE Marking.

2. The added device(s) must be used for their intended 
purpose having a compatible interface.

3. Signal or mains isolation devices and additional protective 
earth may be needed to assure compliance with IEC/
EN 60601-1. 
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Declaration of Emissions

This system is suitable for use in the following environment. The 
user must assure that it is used only in the electromagnetic 
environment as specified. 

Table 2-7:  Declaration of Emissions

Guidance and manufacturer’s declaration - electromagnetic emissions

The system is intended for use in the electromagnetic environment specified below. The 

user of the system should assure that it is used in such an environment.

Emission Type Compliance Electromagnetic Environment

RF Emissions

CISPR 11

Group 1 This system uses RF energy only for its internal function. 

Therefore, its RF emissions are very low and are not likely to 

cause any interference in nearby electronic equipment. 

RF Emissions

CISPR 11

Class A This system is suitable for use in all establishments, other than 

domestic establishments and those directly connected to the 

public low-voltage power supply network that supplies buildings 

used for domestic purposes, provided the following warning is 

heeded:

WARNING: The EMISSIONS characteristics of this equipment 

make it suitable for use in industrial areas and hospitals (CISPR 

11 class A). If it is used in a residential environment (for which 

CISPR 11 class B is normally required) this equipment might not 

offer adequate protection to radio-frequency communication 

services. The user might need to take mitigation measures, such 

as relocating or reorienting the equipment. 

Harmonic  

Emissions

IEC 61000-3-2

Class A

Voltage 

Fluctuations/Flicker 

Emissions

IEC 61000-3-3

Complies
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Declaration of Immunity

This system is suitable for use in the following environment. The 
user must ensure that the system is used according to the 
specified guidance and only in the electromagnetic environment 
listed.

Table 2-8:  Declaration of Immunity Compliance Statement Supporting 

Guidance and manufacturer's declaration - electromagnetic immunity

This system is intended for use in the electromagnetic environment specified below. The 

customer or the user of this system should assure that it is used in such an environment.

Environments 

of INTENDED 

USE Professional healthcare facility environment

Immunity Type

IEC 60601-1-2 test 

level

IEC 60601-1-2 

Compliance Level

Electromagnetic 

Environment Guidance

IEC 61000-4-2

Static discharge 

(ESD) 

± 8 kV contact

± 15 kV air

Edition 4 series

± 8 kV air

± 15 kV contact

Floors should be wood, 

concrete, or ceramic tile. If 

floors are covered with 

synthetic material, the 

relative humidity should be 

at least 30%.

IEC 61000-4-4

Electrical fast

transient/burst

±2 kV for power supply 

lines 100 kHz rate

± 1 kV for input/output 

lines 100 kHz rate

Edition 4 series

± 2 kV for power supply 

lines 100 kHz rate

± 1 kV for input/output 

lines 100 kHz rate

Mains power quality should 

be that of a typical 

commercial and/or hospital 

environment.

IEC 61000-4-5

Surge Immunity

± 1 kV line-line

± 2 kV line-earth

Edition 4 series

± 1 kV line-line

± 2 kV line-earth

Mains power quality should 

be that of a typical 

commercial and/or hospital 

environment.

IEC 61000-4-11

Voltage dips and 

short interruptions 

and voltage 

variations on 

power supply input 

lines

0 % UT; 0.5cycle, 

Phase: 

0,45,90,135,180,225,27

0,315°

0 % UT; 1cycle, Phase: 

0°

70 % UT; 25/30cycle,  

Phase: 0°

0 % UT; 250/300 cycle

Note: Apply IEC 

60601-2-37 (202.6.2.7)

Edition 4 series

0 % UT; 0.5cycle, 

Phase: 

0,45,90,135,180,225,27

0, 315°

0 % UT; 1cycle, Phase: 

0°

70 % UT; 25/30cycle,  

Phase: 0°

0 % UT; 250/300 cycle

Note: Apply IEC 

60601-2-37 (202.6.2.7)

Mains power quality should 

be that of a typical 

commercial and/or hospital 

environment. If the user 

requires continued operation 

during power mains 

interruptions, it is 

recommended that the 

system be powered from a 

UPS or a battery option.
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IEC 61000-4-8

Power frequency 

(50/60 Hz) 

magnetic field

30 A/m Edition 4 series

30 A/m

Power frequency magnetic 

fields should be at levels 

characteristic of a typical 

location in a typical 

commercial and/or hospital 

environment.

NOTE: UT is the AC mains voltage prior to application of the test level. 

Table 2-8:  Declaration of Immunity Compliance Statement Supporting  (Continued)

Guidance and manufacturer's declaration - electromagnetic immunity

This system is intended for use in the electromagnetic environment specified below. The 

customer or the user of this system should assure that it is used in such an environment.

Environments 

of INTENDED 

USE Professional healthcare facility environment

Immunity Type

IEC 60601-1-2 test 

level

IEC 60601-1-2 

Compliance Level

Electromagnetic 

Environment Guidance
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IEC 61000-4-6

Conducted RF

3 Vrms

150kHz to 80MHz

6 Vrms in ISM bands 

between 150 kHz to 

80MHz

Edition 4 series

3 Vrms

150kHz to 80MHz

6 Vrms in ISM bands 

between 150 kHz to 

80MHz

Portable and mobile RF 

communications equipment 

should be used no closer to 

any part of this system, 

including cables, than the 

recommended separation 

distance calculated from the 

equation appropriate for the 

frequency of the transmitter.

Recommended Separation 

Distance (see Table 2-4)

(80 MHz to 800 MHz (see 

Table 2-4)

(800 MHz to 2.7 GHz (see 

Table 2-4)

where P is the maximum 

output power rating of the 

transmitter in watts (W) 

according to the transmitter 

manufacturer and d is the 

recommended separation 

distance in meters (m). 

Field strengths from fixed RF 

transmitters, as determined 

by an electromagnetic site 

survey, a should be less than 

the compliance level in each 

frequency range b. 

Interference may occur in 

the vicinity of equipment 

marked with the symbol: 

IEC 61000-4-3

Radiated RF EM 

fields

3 V/m

80 MHz - 2.7 GHz

80% AM 1 kHz

3 V/m

80 MHz - 2.7 GHz

80% AM 1 kHz

Table 2-8:  Declaration of Immunity Compliance Statement Supporting  (Continued)

Guidance and manufacturer's declaration - electromagnetic immunity

This system is intended for use in the electromagnetic environment specified below. The 

customer or the user of this system should assure that it is used in such an environment.

Environments 

of INTENDED 

USE Professional healthcare facility environment

Immunity Type

IEC 60601-1-2 test 

level

IEC 60601-1-2 

Compliance Level

Electromagnetic 

Environment Guidance
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IEC 61000-4-3

Proximity fields 

from RF wireless 

communications 

equipment

9 V/m to 28 V/m

spot frequencies

385 MHz: 27 V/m

450 MHz: 28 V/m

710 MHz: 9 V/m

745 MHz: 9 V/m

780 MHz: 9 V/m

810 MHz: 28 V/m

870 MHz: 28 V/m

930 MHz: 28 V/m

1720 MHz: 28 V/m

1845 MHz: 28 V/m

1970 MHz: 28 V/m

2450 MHz: 28 V/m

5240 MHz: 9 V/m

5500 MHz: 9 V/m

5785 MHz: 9 V/m

PM 18 Hz or 217 Hz 

(50% duty cycle)

9 V/m to 28 V/m

spot frequencies

385 MHz: 27 V/m

450 MHz: 28 V/m

710 MHz: 9 V/m

745 MHz: 9 V/m

780 MHz: 9 V/m

810 MHz: 28 V/m

870 MHz: 28 V/m

930 MHz: 28 V/m

1720 MHz: 28 V/m

1845 MHz: 28 V/m

1970 MHz: 28 V/m

2450 MHz: 28 V/m

5240 MHz: 9 V/m

5500 MHz: 9 V/m

5785 MHz: 9 V/m

PM 18 Hz or 217 Hz 

(50% duty cycle)

Minimum separation 

distances for higher 

IMMUNITY TEST LEVELS 

shall be calculated using the 

following equation:

Where P is the maximum 

power in W, d is the 

minimum separation 

distance in m, and E is the 

IMMUNITY TEST LEVEL in 

V/m.

a. Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and 

land mobile radios, amateur radio, AM and FM radio broadcast, and TV broadcast cannot be predicted 

theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an 

electromagnetic site survey should be considered. If the measured field strength in the location in which this 

system is used exceeds the applicable RF compliance level above, this system should be observed to verify 

normal operation. If abnormal performance is observed, additional measures may be necessary, such as 

reorienting or relocating this system.

b. Over the frequency range 150 kHz to 80 MHz field strengths should be less than 3 V/m.

c. As an alternative to FM modulation, 50 % pulse modulation at 18 Hz may be used because while it does 

not represent actual modulation, it would be worst case.

NOTE: These guidelines may not apply in all situations. Electromagnetic propagation is affected by 

absorption and reflection from structures, objects, and people. 

Table 2-8:  Declaration of Immunity Compliance Statement Supporting  (Continued)

Guidance and manufacturer's declaration - electromagnetic immunity

This system is intended for use in the electromagnetic environment specified below. The 

customer or the user of this system should assure that it is used in such an environment.

Environments 

of INTENDED 

USE Professional healthcare facility environment

Immunity Type

IEC 60601-1-2 test 

level

IEC 60601-1-2 

Compliance Level

Electromagnetic 

Environment Guidance
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Declaration of Immunity  (continued)

Table 2-9:  Spot Frequencies for IEC 61000-4-3 Proximity fields from RF wireless 
communications equipment

Test 

Frequency 

(MHz)

Band 

(MHz) Service Modulation

Maximum 

Power 

(W)

Distance 

(m)

Immunity 

Test Level 

(V/m)

385 380 - 390 TETRA 400 Pulse modulation 

18 Hz

1.8 0.3 27

450 430 - 470 GMRS 460, 

FRS 460

FM ± 5 kHz 

deviation   

1 kH sine

2 0.3 28

710 704 - 787 LTE Band 

13, 17

Pulse modulation 

217 Hz

0.2 0.3 9

745

780

810 800 - 960 GSM 800/

900

TETRA 800

iDEN 820

CDMA 850

LTE Band 5

Pulse modulation 

18 Hz

2 0.3 28

870

930

1720 1700 - 

1990

GSM 1800; 

CDMA 1900; 

GSM 1900; 

DECT; LTE 

Band 1, 3, 4, 

25; UMTS

Pulse modulation 

217 Hz

2 0.3 28

1845

1970

2450 2400 - 

2570

Bluetooth, W 

LAN, 802.11 

b/g/n, RFID 

2450, LTE 

Band 7

Pulse modulation 

217 Hz

2 0.3 28

5240 5100 - 

5800

WLAN 

802.11 a/n

Pulse modulation 

217 Hz

0.2 0.3 9

5500

5785
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Essential performance

The essential performance of the ultrasound unit is:

• The ability to display B-mode image as input for diagnosis.

• The ability to display M-mode image as input for diagnosis.

• The ability to display Doppler-mode image as input for 
diagnosis.

• The ability to display Color Flow-mode image as input for 
diagnosis. 

• The display of acoustic power indexes as an aid for safe use 
of ultrasound diagnostic (MI,TIS,TIB,TIC).
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Patient Environmental Devices

 Figure 2-1. Patient Environmental Devices

1. USB port

2. Front Panel

3. Gel warmer

4. Peripheral Devices

DVD Multi Drive (CD, DVD, DVR), Black/White 

Printer, Patient I/O (ECG), VNav Connectors 

5. Network/Disk Indicators

6. Probe Ports (4)

Probe Ports with CW Option

7. Probe Storage

8. Power In/Out

Power Line (AC~)

Ground Line

Power Cable with Protective Earth

9. Signals I/O Port (USB 3.0 Port, Ethernet 

Connector, HDMI Connector, S-Video Option 

Connector)
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Acceptable Devices

The Patient Environmental devices shown on the previous page 
are specified to be suitable for use within the PATIENT 
ENVIRONMENT.

Unapproved Devices

Accessories, Options, Supplies 

CAUTION DO NOT connect any probes or accessories without approval 
by GE within the PATIENT ENVIRONMENT.

See ‘Peripheral Update for EC countries’ on page 2-28 for 
more information.

Any device connected to the LOGIQ Fortis must conform to 
one or more of the requirements listed below:

1. IEC standard or equivalent standards appropriate to 
devices.

2. The devices shall be connected to PROTECTIVE EARTH 
(GROUND).

DANGER
 

DO NOT use unapproved devices. 

If devices are connected without the approval of GE, the 
warranty will be INVALID.

Any device connected to the Ultrasound System must conform 
to one or more of the requirements listed below:

1. IEC standard or equivalent standards appropriate to 
devices.

2. The devices shall be connected to PROTECTIVE EARTH 
(GROUND).

CAUTION Unsafe operation or malfunction may result. Use only the 
accessories, options and supplies approved or recommended 
in these instructions for use.
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Acoustic Output

When the “Auto Freeze Time (probe selection required)” preset 
is selected on the Utility -> System -> System Imaging screen, 
the system auto freezes after the time specified (10 or 30 
minutes, 1 hour, or Never) of scanning if it detects no change in 
the image.

Located on the upper right section of the system display monitor, 
the acoustic output display provides the operator with real-time 
indication of acoustic levels being generated by the system. See 
the Acoustic Output chapter in the Advanced Reference Manual 
for more information. 

Acoustic Output Display Specifications

The display consists of three parts: Thermal Index (TI), 
Mechanical Index (MI), and a relative Acoustic Output (AO) 
value. 

The TI and MI are displayed at all times. The TI display starts at 
a value of 0.0, increments in steps of 0.1 and accuracy is ±50%. 
For MI display values between 0 and 0.4, the display increments 
in steps of 0.01 and for values greater than 0.4, increments in 
steps of 0.1. The MI accuracy is ±25%.

The AO percentage (AO%) value informs the user of where the 
system is operating within the range of available output. 
Accuracy of the AO% is ±10%. 
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Acoustic Output Display Specifications  (continued)

Thermal Index

Depending on the examination and type of tissue involved, the 
TI parameter will be one of three types:

• Soft Tissue Thermal Index (TIS). Used when imaging soft 
tissue only, it provides an estimate of potential temperature 
increase in soft tissue.

• Bone Thermal Index (TIB). Used when bone is near the 
focus of the image as in the third trimester OB examination, 
it provides an estimate of potential temperature increase in 
the bone or adjacent soft tissue.

• Cranial Bone Thermal Index (TIC). Used when bone is 
near the skin surface as in transcranial examination, it 
provides an estimate of potential temperature increase in 
the bone or adjacent soft tissue.

Mechanical Index

MI recognizes the importance of non-thermal processes, 
cavitation in particular. The Index is a relative indicator of the 
likelihood of mechanical bioeffect within the tissue. 

Changing the Thermal Index Type

You can select the displayed TI type on Utility -> Imaging ->  
B-Mode. This preset is application dependent so each 
application could specify a different TI type.

Controls Affecting Acoustic Output

The potential for producing mechanical bioeffects (MI) or 
thermal bioeffects (TI) can be influenced by certain controls. 

Direct. The Power Output control has the most significant effect 
on Acoustic Output. 

Indirect. Indirect effects may occur when adjusting controls. 
Controls that can influence MI and TI are detailed under the 
Bioeffects portion of each control in the Optimizing the Image 
sections. 

Always observe the Acoustic Output display for possible effects. 
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Best practices while scanning

NOTE: Refer to the Optimizing the Image sections for a complete 
discussion of each control. 

HINTS Raise the Acoustic Output only after attempting image 
optimization with controls that have no effect on Acoustic 
Output, such as Gain and TGC. 

DANGER
 

Be sure to have read and understood control explanations for 
each mode used before attempting to adjust the Acoustic 
Output control or any control that can affect Acoustic Output. 
During a screening and diagnostic ultrasound examination, 
high frequency sound penetrates and interacts with tissue in 
and around the area of anatomy to be imaged. Only a small 
portion of this sound energy is reflected back to the transducer 
for use in constructing the image, while the remainder is 
dissipated within the tissue. The interaction of sound energy 
with tissue at sufficiently high levels can produce biological 
effects (aka bioeffects) of either a mechanical or thermal 
nature. Although the generation of bioeffect is intentional with 
therapeutic ultrasound, it is generally undesired in screening 
and diagnostic applications and may be harmful in some 
conditions.

Acoustic
Output
Hazard

Use the minimum necessary acoustic output to get the best 
diagnostic image or measurement during an examination. 
Begin the exam with the probe that provides an optimum focal 
depth and penetration. 
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Acoustic Output Default Levels

In order to assure that an exam does not start at a high output 
level, the LOGIQ Fortis initiates scanning at a reduced default 
output level. This reduced level is preset programmable and 
depends upon the exam category and probe selected. It takes 
effect when the system is powered on or New Patient is 
selected.

To modify acoustic output, adjust the Power Output level on the 
Touch Panel.

Figure 2-2. Location of Power Output control

Acoustic Output on Pleural Preset

The U.S. Food and Drug Administration (FDA) recommends that 
MI levels should be lower than 1.4 when scanning lungs.  

Select the Pleural preset when performing a lung exam. The 
displayed MI will not exceed 0.8 with Pleural preset selected. 
Differences in MI values are a result of probe to probe variation 
as well as the calculation accuracy of the displayed MI value.
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RoHS LOGIQ Fortis Hazardous Substances

The following product pollution control information is provided 
according to SJ/T11364-2014 Marking for Control of Pollution 
caused by Electronic Information Products. 

This symbol indicates the product contains hazardous materials 
in excess of the limits established by the Chinese standard GB/T 
26572 Requirements for Concentration Limits for Certain 
Hazardous Substances in Electronic Information Products. The 
number in the symbol is the Environment-friendly Use Period 
(EFUP), which indicates the period during which the hazardous 
substances or elements contained in electrical and electronic 
products will not leak or mutate under normal operating 
conditions so that the use of such electrical and electronic 
products will not result in any severe environmental pollution, 
any bodily injury or damage to any assets. The unit of the period 
is “Year.”

In order to maintain the declared EFUP, the product shall be 
operated normally according to the instructions and 
environmental conditions as defined in the product manual, and 
periodic maintenance schedules specified in Product 
Maintenance Procedures shall be followed strictly. 
Consumables or certain parts may have their own label with an 
EFUP value less than the product. Periodic replacement of 
those consumables or parts to maintain the declared EFUP shall 
be done in accordance with the Product Maintenance 
Procedures. 

This product must not be disposed of as unsorted municipal 
waste, and must be collected separately and handled properly 
after decommissioning. 
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Name and Concentration of Hazardous Substances

Table 2-10:  Table of hazardous substances' name and concentration for LOGIQ Fortis

Component Name

Hazardous substances' name

Pb Hg Cd Cr (VI) PBB PBDE

HDU Display O O O O O O

LCD Display O O O O O O

Circuit Boards O O O O O O

Touch Panel O O O O O O

Ultrasound Probes O O O O O O

Console Cabinet O O O O O O

Operator Panel O O O O O O

Console Frame (Base 

Casting, Castings, Card 

Rack)

O O O O O O

System Covers O O O O O O

System Cables O O O O O O

This table is prepared according to SJ/T 11364.

O: Indicates that this hazardous substance contained in all of the homogeneous materials for this part is 

below the limit requirement in GB/T 26572.

X: Indicates that this hazardous substance contained in at least one of the homogeneous materials used for 

this part is above the limit requirement in GB/T 26572.

• Data listed in the table represents best information available at the time of publication.

• Applications of hazardous substances in this medical device are required to achieve its intended clinical 

uses, and/or to provide better protection to human beings and/or to environment, due to lack of reasonably 

(economically or technically) available substitutes

Note: Options may not be present on every system. 
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WEEE Passport

The WEEE (Waste Electrical and Electronic Equipment) 
Passport describes product recycling information. To access the 
WEEE passport for GE Healthcare products:  

1. Go to the GE Healthcare Support Documentation Library at:

https://www.gehealthcare.com/support/documentation

2. Select the modality "Ultrasound (UL)."

3. Enter the document name or the keyword "WEEE."

4. Press “Search.” 

5. Select the desired WEEE passport.

Safe Product and Packaging Disposal

This product and package should be disposed of according to 
hospital disposal practices, and local environmental and waste 
disposal regulations. Components and accessories of the 
LOGIQ Fortis which have come into direct or indirect contact 
with the patient may be biohazardous, and should be disposed 
of according to facility guidelines for biohazardous material. The 
waste of electrical and electronic equipment must not be 
disposed as unsorted municipal waste and must be collected 
separately. Please contact an authorized representative of the 
manufacturer for information concerning the disposal/
decommissioning of equipment.
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Device Labels

Label Icon Description

The following tables describes the purpose and location of 
safety labels and other important information provided on the 
equipment.

NOTE: This machine should be used in compliance with law. Some 
jurisdictions restrict certain uses, such as gender determination 
(shown for country specific label). 

 Figure 2-3. Rear Panel Label Location
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Label Icon Description  (continued)

Table 2-11:  Label Icons (Rear of Console)

No. Label/Icon Purpose/Meaning

1. Monitor Label: 

GE created

DO NOT place a finger, hand or any object on the joint of the 

monitor or monitor arm to avoid injury when moving the monitor 

and monitor arm.

1. and 3. Follow instruction for use.

IEC 60601-1:2005+A1:2012 Annex D.1 and ISO 7010-M002

1. and 3. RoHS Label–China 

systems only (shown for 

country specific label)

Indicates the presence of hazardous substance(s) above the 

maximum concentration value. Maximum concentration values 

for electronic information products, as set by the People’s 

Republic of China Electronic Industry Standard SJ/

T11364-2006, include the hazardous substances of lead, 

mercury, hexavalent chromium, cadmium, polybrominated 

biphenyl (PBB), and polybrominated diphenyl ether (PBDE). 

“20” indicates the number of years during which the hazardous 

substance(s) will not leak or mutate so that the use of this 

product will not result in any severe environmental pollution, 

bodily injury, or damage to any assets. 

China Electronic Industry Standard SJ/T11364-2014

1 and 3. This WEEE symbol indicates that waste electrical and electronic 

equipment must not be disposed of as unsorted municipal waste 

and must be collected separately. Please contact an authorized 

representative of the manufacturer for information concerning 

the decommissioning of your equipment. Standard: EN 50419. 

WEEE Directive 2012/19/EU 

1. and 3. “General Warning Sign” 

Possible shock hazard. Do not remove covers or panels. No 

user serviceable parts are inside. Refer servicing to qualified 

service personnel. Standard: ISO 7010-W001. 
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2.

The system contains the following wireless module: INTEL 

9260NGW.

Non-Ionizing Electromagnetic Radiation

IEC 60417-5140

IEC TR 60878-5140

Federal Communications Commission Identification label - on 

LOGIQ Fortis equipped with Wireless LAN

Canada Certification label - on LOGIQ Fortis equipped with 

Wireless LAN

Malaysian Communications and Multimedia Commission 

symbol. Number correspond to GE importing company (GEHC) 

- on LOGIQ Fortis equipped with Wireless LAN

ANATEL Certification label for Brazil - on LOGIQ Fortis 

equipped with Wireless LAN

Infocomm Development Authority of Singapore (IDA) standard - 

on LOGIQ Fortis equipped with Wireless LAN

3. The CE Mark of Conformity indicates this equipment conforms 

with the European Medical Device Regulation 2017/745

European Medical Device Regulation 2017/745

Table 2-11:  Label Icons (Rear of Console) (Continued)

No. Label/Icon Purpose/Meaning
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3. Do not use the following devices near this equipment: cellular 

phone, radio receiver, mobile radio transmitter, radio controlled 

toy, broadband power lines, etc. Use of these devices near this 

equipment could cause this equipment to perform outside the 

published specifications. Keep power to these devices turned off 

when near this equipment.

ISO 7010-P013

3. DO NOT push the system. Use the handle to push/pull the 

system, e.g., DO NOT use the monitor. Failure to do so may 

cause serious injury or system damage. 

IEC 60601-1:2005+A1:2012 Annex D.2 and ISO 7010-P017

3. United States only

Prescription Device label

21 CFR 801.109 and Alternative to Certain Prescription Device 

Labeling Requirements Guidance to Industry 1/2/2000 U.S. 

Food&Drug Administration modified by General Electric for 

clarity that this is for the USA

3. Type BF Applied Part (man in the box) symbol is in accordance 

with IEC 60417-5333.

3. Symbol indicating that the Instructions for Use are supplied in 

electronic form. 

ISO 7000-3500

3. UL conformity mark according to ANSI/AAMI ES60601-1:2005/

(R)2012, CAN/CSA-C22.2 No. 60601-1:14.

N/A- by certification body

3. Use two people to transport system on inclines. This label also 

indicates the system weight.

To avoid possible injury and equipment damage when 

transporting from one area of use to another:

• Be sure the pathway is clear.

• Limit movement to a slow careful walk.

• Use two or more persons to move the equipment on inclines or 

long distance.

GE created

3. This product is a medical device.

Table 2-11:  Label Icons (Rear of Console) (Continued)

No. Label/Icon Purpose/Meaning
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3. Unlock/Lock the monitor arm

GE created

4. Possible shock hazard. Do not remove covers or panels. No 

user serviceable parts are inside. Refer servicing to qualified 

service personnel.

• USB 3.0 Ports

• Ethernet Connection

• S-Video Connector

• HDMI Connector

“Equipotentiality” indicates the terminal to be used for 

connecting equipotential conductors when interconnecting 

(grounding) with other equipment.

Connection of additional protective earth conductors or potential 

equalization conductors is not necessary in most cases and is 

only recommended for situations involving multiple equipment in 

a high-risk patient environment to provide assurance that all 

equipment is at the same potential and operates within 

acceptable leakage current limits. An example of a high-risk 

patient would be a special procedure where the patient has an 

accessible conductive path to the heart such as exposed 

cardiac pacing leads. IEC60417-5021

IEC 60601-1:2005+A1:2012 Annex D.1 and IEC 60417-5021

Mains OFF: indicates the power off position of the mains power 

breaker.

IEC 60601-1:2005+A1:2012 Annex D.1 and IEC 60417-5008

Mains ON: indicates the power on position of the mains power 

breaker. 

IEC 60601-1:2005+A1:2012 Annex D.1 and IEC 60417-5007

Table 2-11:  Label Icons (Rear of Console) (Continued)

No. Label/Icon Purpose/Meaning
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5. Every system has a unique marking for identification, the Unique 

Device Identification (UDI) Label. The UDI label consists of a 

series of alpha-numeric characters and barcode which uniquely 

identify the LOGIQ Fortis system as a medical device 

manufactured by General Electric. Scan or enter the UDI 

information into the patient health record as required by 

country-specific laws. 

UDI Human Readable Label Text: Global Trade Item Number, 

GTIN, Manufacturing Date, Serial Number

UDI Symbol and Data Matrix

5. System Voltage (~100-240VAC)

Frequency

Power Rating

Alternating Current symbol is in accordance with IEC 

60417-5032

Catalog/Model Number. Standard: ISO 7000-2493. 

Serial Number. Standard: ISO 7000-2498. 

Legal Manufacturer’s name and address. Standard: ISO 

7000-3082. 

Date of manufacture YYYY-MM. Standard: ISO 7000-2497. 

Eurasian Conformity mark; the single conformity mark for 

circulation of products on the markets of member-states of the 

Customs Union. This product passed all conformity assessment 

(approval) procedures that correspond to the requirements of 

applicable technical regulations of the Customs Union.

National standards of the Russian Federation and CIS countries

Table 2-11:  Label Icons (Rear of Console) (Continued)

No. Label/Icon Purpose/Meaning
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6. This system has Power Assistant option, 

GE created

This system has Scan on Battery option, 

GE created

7. Gender Caution (only for India, China, Korea)

8. GE Cares Label (US/Canada systems only)

10. 9. Country-Specific Labels Example:

INMETRO Certification: TUV Rheinland Brazil

Rating label for Japan

Rating label for Korea

11. Authorized European Representative address

ECG eTRAX needle, PCG, AUX

Type CF Applied Part (heart in the box) symbol is in accordance 

with IEC 60417-5335.

ECG ECG

Type CF Defib-Proof Applied Part (heart in the box with paddle) 

symbol is in accordance with IEC 60417-5336.

Table 2-11:  Label Icons (Rear of Console) (Continued)

No. Label/Icon Purpose/Meaning
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Monitor 

Arm

DO NOT place a finger, hand or any object on the joint of the 

monitor or monitor arm to avoid injury when moving the monitor 

and monitor arm.

GE created

V-Nav ISO 7010 - P007

Volume Navigation Pacemaker Warning

Op 

Panel

Power On/Off. 

Standard: IEC 60417-5010

Op 

Panel

To avoid injury, DO NOT place a finger, hand or any object 

below the operator panel when it is lowered.

Foot 

Pedal 

and 

Battery 

Pack

The product has been tested and approved in UL Laboratories, 

based on UL and CSA standards, through mutual approval 

activities.

Battery 

Pack

Battery Pack if contains Pb/Cd/Hg

The separate collection symbol is affixed to a battery, or its 

packaging, to advise you that the battery must be recycled or 

disposed of in accordance with local or country laws. The letters 

below the separate collection symbol indicate whether certain 

elements (Pb=Lead, Cd=Cadmium, Hg=Mercury) are contained 

in the battery. To minimize potential effects on the environment 

and human health, it is important that all marked batteries that 

you remove from the product are properly recycled or disposed. 

For information on how the battery may be safely removed from 

the device, please consult the service manual or equipment 

instructions. Information on the potential effects on the 

environment and human health of the substances used in 

batteries is available at this url: http://www.gehealthcare.com/

euen/weee-recycling/index.html.

WEEE Directive 2012/19/EU 

Table 2-11:  Label Icons (Rear of Console) (Continued)

No. Label/Icon Purpose/Meaning
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Probe Labeling

Each probe is labeled with the following information:

• Seller's name and manufacturer

• Operating frequency (not shown on all probes)

• GE part number

• Probe serial number

• Month and year of manufacture

• Probe designation-provided on the probe grip and the top of 
the connector housing, so it is easily read when mounted on 
the system and is also automatically displayed on the 
screen when the probe is selected.

• UDI Symbol and Data Matrix 

• DI Human Readable LabelText: Global Trade Item Number, 
GTIN

The following information appears on all probe labels, 
regardless of the connector type, except for “IPX7,” “CE Mark,”  
and “XDclearTM” which only appears on applicable probes. 

 Figure 2-4. Probe Label

NOTE: Non-GE probes will also have a UDI symbol and equivalent 
information. 

1. GE Logo

2. Probe Model (Name)

3. UDI Symbol and Data Matrix

4. UDI Human Readable LabelText: Global Trade 

Item Number, GTIN, (01), Manufacturing Date 

(11), Serial Number (21)

5. Type BF/CF Applied Part

6. Caution: Consult the Manual.  

7. WEEE Waste Symbol 

8. Chinese RoHS Hazardous Substance Symbol

9. CE Mark and Notified Body Number

10. REF: Catalog/model number

11. Serial Number

12. Manufacturer’s site country of origin

13. Legal Manufacturer’s Name and Address

14. Date of Manufacture, as YYYY-MM

15. Product Marketing Indicator information may 

appear here. 

16. IP Classification

17. Symbol indicates the item is a medical device.
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Chapter 3

Preparing the System for Use

Describes the site requirements, console overview, 

system positioning/transporting, powering on the 

system, adjusting the display monitor, probes and 

operator controls.
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Site Requirements

Introduction

Only qualified physicians or sonographers should perform 
ultrasound scanning on human subjects for medical diagnostic 
reasons. Request training, if needed.

Do not attempt to set up the system alone. General Electric, 
Affiliate, or Distributor Field Engineers and Application 
Specialists will install and setup the system. See ‘Contact 
Information’ on page 1-12 for more information.

The LOGIQ Fortis does not contain any operator serviceable 
internal components. Ensure that unauthorized personnel do not 
tamper with the unit.

Perform regular preventive maintenance. See ‘System Care and 
Maintenance’ on page 12-32 for more information.

Maintain a clean environment. Turn off, and if possible, 
disconnect the system before cleaning the unit. See ‘Cleaning 
and Disinfecting the System’ on page 12-34 for more 
information.

Never set liquids on the unit to ensure that liquid does not drip 
into the control panel or unit.
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Before the system arrives

NOTICE This medical equipment is approved, in terms of the prevention 
of radio wave interference, to be used in hospitals, clinics and 
other institutions which are environmentally qualified. The use of 
this equipment in an inappropriate environment may cause 
some electronic interference to radios and televisions around 
the equipment.

Ensure that the following is provided for the new system: 

• A separate power outlet with a 15 amp circuit breaker for 
120 VAC for 120 V area, 7.5 amp circuit breaker for 220-240 
VAC for 220/240 V area or 15 amp circuit breaker for 100 
VAC for Japan.

• Take precautions to ensure that the console is protected 
from electromagnetic interference.

Precautions include: 

• Operate the console at least 5 meters (15 feet) away 
from motors, typewriters, elevators, and other sources 
of strong electromagnetic radiation (non-medical grade 
UPS must be at least 2 meters (6 feet) away from 
console).

• Operation in an enclosed area (wood, plaster or 
concrete walls, floors and ceilings) helps prevent 
electromagnetic interference.

• Special shielding may be required if the console is to be 
operated in the vicinity of radio broadcast equipment.
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Environmental Requirements

LOGIQ Fortis

The system should be operated, stored, or transported within 
the parameters outlined below. Either its operational 
environment must be constantly maintained or the unit must be 
turned off.

NOTE: You may get an overheating message with regard to fan speed. 
Ensure adequate system/room ventilation.

Probe

Table 3-1:  System Environmental Requirements

Operational Storage Transport (<16hrs.)

Temperature 10° - 35°C

50° - 95°F

-10° - 50°C

14° - 122°F

-10° - 50°C

14° - 122°F

Humidity 30 - 80% non-condensing 30 - 80% non-condensing 30 - 80% non-condensing

Pressure 70 - 106kPa 70 - 106kPa 70 - 106kPa

CAUTION Note that the environmental conditions of the ultrasound 
system and the probe may differ.

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

CAUTION Check the room temperature before you use the 4D probe. 
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Probe  (continued)

Probes should be operated, stored, or transported within the 
parameters outlined below.

NOTE: See provided TEE probe user manual for the environmental 
requirements of the TEE probe.

Table 3-2:  2D Probe Environmental Requirements

Operational Storage Transport

Temperature 10 to 35 degrees C

50 to 95 degrees F

0 to 50 degrees C

32 to 122 degrees F

0 to 50 degrees C

32 to 122 degrees F

Humidity 30 - 85%

non-condensing

30 - 85%

non-condensing

30 - 85%

non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

Table 3-3:  L2-9-D and L2-9VN-D Probe Environmental Requirements

Operational Storage Transport

Temperature 5 to 40 degrees C

41 to 104 degrees F

-40 to 55 degrees C

-40 to 131 degrees F

-40 to 55 degrees C

-40 to 131 degrees F

Humidity 10 - 90%

non-condensing

5 - 95%

non-condensing

5 - 95%

non-condensing

Pressure 700 - 1060hPa 500 - 1060hPa 500 - 1060hPa

Table 3-4:  4D Probe Environmental Requirements

Operational Storage Transport

Temperature 18 to 30 degrees C

64 to 86 degrees F

-10 to 50 degrees C

14 to 122 degrees F

-10 to 50 degrees C

-40 to 122 degrees F

Humidity Max 75%

non-condensing

Max 90%

non-condensing

Max 90%

non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa
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Console Overview

Console Graphics

The following are illustrations of the console:

 Figure 3-1. LOGIQ Fortis System  

1. Monitor

2. Operator Panel with power on/off button, probe 

holders, gel warmer

3. Touch Panel with USB 3.0 Ports 

4. Control panel swivel lever

5. Control panel up/down lever

6. Probe Cable Management Hooks (underneath 

Operator Panel)

7. Probe Holder and Gel warmer

8. DVD Drive, Blind cover, B/W printer, V-Nav 

controller, ECG connector

9. Audio speaker

10. Storage bin (Option)

11. Probe Ports (4)

12. Parking probe port (1)

13. CW Probe Port

14. Rear Handle

15. Power Cord Wrap Hook

16. Peripheral USB 3.0 Ports, Ethernet Connector, 

S-Video Connector, HDMI Port

17. Breaker, Ground and Power Cord

18. Air Filter (Inside the front cover)

19. Wheel Brake (with each caster)

20. External battery (Option)

21. Physical A/N keyboard (Option)
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Console Graphics  (continued)

DANGER
 

DO NOT touch the patient and any of the connectors on the 
ultrasound unit simultaneously, including ultrasound probe 
connectors. DO NOT touch the conducting parts of the USB, 
Ethernet, Video or Audio cables when connecting equipment to 
the unit. Failure to follow these instruction could lead to 
electrical shock.

CAUTION For compatibility reasons, use only GE approved probes, 
peripherals or accessories.

DO NOT connect any probes or accessories without approval 
by GE. Failure to follow these instructions could lead to 
unexpected diagnostic performance.
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Console Graphics  (continued)

Type of cabinet

Table 3-5:  Cabinet type

Low cabinet Mid cabinet

1. DVD Drive 1. DVD Drive

2. Blind cover, ECG, V Nav controller or , B/W 

printer

High cabinet Side cabinet

1. DVD Drive

2. Blind cover, ECG, V Nav controller

3. B/W Printer 

1. V-Nav or ECG

2. B/W Printer

Only install with Low cabinet or Mid cabinet.
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External drives (CD/DVD Multi Drive, USB Flash Drive, USB HDD) 

The external DVD-R/CD-R drive (Standard) is located below the 
keyboard. Approved USB Hard Disk and USB Flash Drives may 
also be used for Save As, MPEGVue, and Backup/Restore in 
the powered system USB ports. 

You can use these to perform software upgrades, image 
archiving, and service diagnostics.

You can use the following media for the multi-drive: DVD-R or 
CD-R. 

USB Drives are an ESD-sensitive device. Only use USB 2.0/3.0 
Drives recommended by GE. 

NOTE: When ejecting a CD-R/DVD-R, you are prompted if you wish to 
finalize the disk. If you do not finalize the disk, you can add files 
to the CD-R/DVD-R at a later time. However, you may not be 
able to view the files stored on this disk with a standard PC. 
Finalizing a CD-R/DVD-R, allows you to view these files using 
most standard PCs.

CAUTION The system ONLY supports CD-R/DVD-R and DOES NOT 
support CD-RW/DVD+R/DVD-RW/DVD+RW or DVD-RAM 
media. DO NOT use or attempt to format CD-RWs, DVD+R, 
DVD-RAM, or DVD-RWs.

CAUTION Make sure that the CD/DVD Multi Drive Disk tray is securely 
retracted during system operation. Mechanical damage may 
occur if other objects hit the tray.

CAUTION When you put media into the DVD drive, please make sure the 
media is placed in the right position. If the media is not placed 
in the right position, the media may be damaged.
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Speakers

Audio is provided via internal speakers. 

NOTE: You make volume adjustments on the Utility Touch Panel 
(Master Volume, Effects Volume).

• Audio Doppler operation 

• Audio playback of recorded scan sessions

• Audio error notification.

Storage areas

Storage areas are available and can be used to store gel, 
options, probe cables, accessories, etc.

Figure 3-2. Storage area

1. Small tray

2. Probe Holder
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Install the TVTR Probe holder (Option)

Push the TVTR Probe holder into the left-side probe holder until 
it clicks as below graphic. 

Figure 3-3. Install TVTR Probe holder

Figure 3-4. TVTR Probe Holder

When you remove the TVTR Probe holder form the system, pull 
the craw and pull out the probe holder.

Figure 3-5. Pull the claw to remove
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Peripheral/Accessory Connection

Peripheral/Accessory Connector Panel

LOGIQ Fortis peripherals CAN ONLY BE properly connected 
using the Peripheral/Accessory Connector Panel. Available 
connectors are two USB 3.0 ports, an HDMI Port, and S-Video 
and Ethernet connectors. 

DANGER
 

The connection of equipment or transmission networks other 
than as specified in these instructions can result in electric 
shock hazard. Alternate connections will require verification of 
compatibility and conformity to IEC/EN 60601-1 by the installer.  
Equipment modifications and possible resulting malfunctions 
and electromagnetic interference are the responsibility of the 
owner.

CAUTION For compatibility reasons, use only GE-approved probes, 
peripherals, or accessories.

DO NOT connect any probes or accessories without approval 
by GE. Failure to follow these instructions could lead to 
unexpected diagnostic performance.

Table 3-6:  Peripheral/Accessory Connector Panel

1. USB 3.0 Port

2. RJ-45 Modular, 8-pin 

Ethernet

3. S-Video Option

4. HDMI Port
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LAN protection cable (Option)

To prevent claw breakage of LAN cable, use LAN protection 
cable as below. 

If LAN cable is pulled away from the console, the connection 
(Figure 3-6 1) will be unplugged first preventing damage to the 
LAN connector in the unit.

Figure 3-6. LAN protection cable

Figure 3-7. LAN cable with protection cable (example)
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Scan Converter Option (S-Video) 

The LOGIQ Fortis Scan Converter Option enables the ability for 
the console to view or record scanning via an S-Video Cable. 

NOTE: The S-video image displays a portion of the main display that 
includes the probe image in both single and dual probe display 
modes. To provide increased resolution and maintain the proper 
aspect ratio on the S-video display, the entire main display 
image is not projected on the S-video monitor. The S-video crop 
area was selected to optimize the probe image so when the 
console is not in an imaging mode the S-video will continue to 
display a cropped portion of the screen which may appear 
incorrect.
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External Monitor

An external monitor can be connected to the LOGIQ Fortis via 
the HDMI port, under the following guidelines: 

• The display resolution must be set to (1080i) 1920x1080 on 
the external monitor, matching the main system display. 
Other resolutions are not supported.

• An isolation transformer must be used to power the external 
monitor to prevent adverse effects on the ultrasound 
scanner.

• It is the customer’s responsibility to ensure leakage current 
and grounding is tested and complies with electrical leakage 
standards.

Figure 3-8. Connect HDMI Cable to back of LOGIQ Fortis and 
External Monitor
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Front Panel Connections and Indicators

There are three sets of connector/indicators on the Front Panel: 
Hard Disk Drive and Network Status Indicators, CW Probe, 
Patient Cardiac/ECG Connections, and Volume Navigation (V 
Nav) Connections/Indicators

Network Status Indicators

There are three front-panel status indicators:

Table 3-7:  Local Drive and Network Status

1. Local Drive Activity 

Status

2. Network Activity status

3. Network Activity status
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Network and Spooler Status Icons

The following icons identify network and spooler statuses. 
These appear on the display monitor.  

NOTE: The Mobile icons are used for the Smart Device Apps (Tablet 
and Mobile Phone). 

Table 3-8:  Network and Spooler Status Icons

Ethernet Active Ethernet Error Ethernet Active 

Spooler Active

Ethernet Active 

Spooler Error

Mobile

Mobile Error Mobile Bluetooth Mobile Wifi Spooler Active Spooler Active 

Error

Spooler Inactive Spooler Inactive 

Error

Wifi 1 Bar Wifi 2 Bars Wifi 3 Bars

Wifi 4 Bars Wifi Alert Wifi Spooler Active Wifi Spooler Error Wifi Error
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ECG Connections 

See ‘ECG’ on page 13-256 for more information. 

Volume Navigation Connections/Indicator 

Table 3-9:  ECG connection

1. Auxiliary Connector 

2. ECG Connector

3. PCG Connector

Table 3-10:  ECG Lead Placement

Lead

Patient Cable Marking

Position on PatientAHA IEC

I RA (White) R (Red) Right Arm

II LA (Black) L (Yellow) Left Arm

III LL (Red) F (Green) Left Leg

Table 3-11:  Volume Navigation Connections

1. Non-V Nav Inside Probe V Nav Receiver 

Connector (2 cables)

2. V Nav Needle Tip Tracker/Virtual Tracker 

Sensor Connector

3. V Nav Active Tracker Connector

4. V Nav Transmitter Indicator

5. V Nav Transmitter Connector 
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Powering the System

Connecting the System

DANGER
 

Under no circumstances should the AC power plug be altered, 
changed, or adapted to a configuration rated less than 
specified. Never use an extension cord or adapter plug.

To help assure grounding reliability, connect to a “hospital 
grade” or “hospital only” grounded power outlet.

DANGER
 

Use the appropriate power cord provided by or designated by 
GE. Failure to follow these instructions could lead to exposure 
to electrical shock.

WARNING Use caution to ensure that the power cable does not 
disconnect during system use.

If the system is accidentally unplugged, data may be lost.

WARNING To avoid leakage current above safety limits as prescribed by 
IEC 60601-1 and to ensure continuity of protective earth, DO 
NOT connect LOGIQ Fortis and mains-operated accessories to 
a single or multiple socket extension cord or power strip. 
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Connecting the System  (continued)

To connect the system to the electrical supply:

1. Ensure that the wall outlet is of the appropriate type.

2. Ensure that the power switch is turned off.

3. Unwrap the power cable. Make sure to allow sufficient slack 
in the cable so that the plug is not pulled out of the wall if the 
system is moved slightly.

4. Attach the power plug to the system (Figure 3-9 b).

5. Push the power plug securely into the wall outlet.

NOTE: Do not use an extension cord or adapter plug except for GE 
approved UPS. 

6. Ensure the circuit breaker is on (Figure 3-9 a). See ‘Circuit 
breaker’ on page 3-21 for more information. 

Figure 3-9. Circuit Breaker (a) and Power Plug (b)
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Circuit breaker

The Circuit Breaker is located at the rear panel of the system. 
On supplies main power to all internal systems. Off removes 
main power from all internal systems. The circuit breaker 
automatically shuts off power to the system in case of a power 
overload.

If a power overload occurs:

1. Turn off all peripheral devices.

2. Reactivate the Circuit Breaker switch.

The Circuit Breaker switch should stay in the On position (“I”); 
DO NOT hold the switch in the On position. If the Circuit Breaker 
switch remains On, follow the Power On procedure.

NOTE: If the Circuit Breaker switch does not remain in the On position 
or trips again:

1. Disconnect the Power Cable.

2. Call Service immediately.

DO NOT attempt to use the system.



Preparing the System for Use

3-22 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Power On 

Press the Power On/Off switch to turn the power on. The circuit 
breaker must also be in the on position. See ‘Circuit breaker’ on 
page 3-21 for more information.

To turn on the system

1. Ensure that the unit is properly plugged into an AC outlet of 
sufficient capacity (120V/10A or 240V/5A). 

2. Turn on the breaker at the back of the system (refer to 
Figure 3-9 on page 3-20). At this point, the On/Off switch 
should be turned off. 

3. Momentarily press the On/Off switch. The switch turns on a 
light. (refer to Figure 3-10 on page 3-22 ).

4. The system should now go through its boot-up process with 
no further user intervention (approximately 1 to 2 minutes).

Figure 3-10. Power On/Off Switch Location
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Power Up Sequence 

The system is initialized. During this time:

• The system boots up and the status is reflected on the 
monitor.

• Probes are initialized for immediate operation.

NOTE: If no probe is connected, the system goes into freeze mode.

• Peripheral devices are activated on power up.

After initialization is complete, controls on the Control Panel 
backlight and the default B-Mode screen is displayed on the 
monitor (if a probe is connected).
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Password Protection

Login

At login, you are notified that “You are accessing a diagnostic 
medical device that is provided by authorized usage only. Data 
stored on this device may be subject to various regulations 
including but not limited to regulations which govern disclosure 
and privacy of this data. By using this device you are 
acknowledging that you are authorized to do so and are trained 
in appropriate use and regulatory guidelines.”

NOTE: You can change the wording that appears on the Login screen. 
See ‘Logon Banner’ on page 10-120 for more information.

1. Operator: Enter the Operator ID.

2. Password: Enter Operator’s password (optional).

3. Logon or Cancel.

• OK: Proceed with the logon

• Emergency: Data stored only for the duration of the 
current exam (EUSR).

4. Change Password: Change password, as specified by the 
Password Policy.
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Initial Login to the LOGIQ Fortis

When first logging in to the LOGIQ Fortis:

1. The Administrator should log in, typing “ADM” as the 
Operator Login. 

NOTE: No password is needed for the initial administrator log in.

NOTE: The Touch Keyboard displays when a field is selected.  Use 
the keyboard to enter the Operator ID and Password. 

Figure 3-11. First Admin Login to the LOGIQ Fortis
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Initial Login to the LOGIQ Fortis  (continued)

2. Upon ADM Login, specify the institution’s Default Security 
Level for the LOGIQ Fortis: Lowest, Medium, High 
(Recommended), or Highest), then select Apply Change. 

NOTE: You may choose Skip For Now up to 20 times total to 
postpone choosing the Security Level. After 20 skips the 
system will require a Security Level to be chosen.

 Figure 3-12. Default Security Level

Table 3-12:  Security Levels 

Security Level Complexity Rules

Skip For Now Best for users not responsible for system security setup (manufacturing, 

vendors or new users browsing the system). Prompt will re-appear at each 

logon until security level is set for use. This skip can be chosen 20 total times 

before the system will require a security level to be chosen.

Lowest Autologon enabled. No password complexity rules. 

Medium Autologon disabled. Minimum Password Requirements: 

• 8 characters.

• Include at least two of the following: one upper case character, one lower case 

character, one number and/or one special character. 

• One or more changed character(s) in successive passwords.

• No more than four repeated characters.

• No more than four sequential characters.

• Cannot contain username. 

• Cannot use the last 10 passwords. 
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High (Recommended) Autologon disabled. Minimum Password Requirements: 

• 10 characters. 

• One lower case character.

• One upper case character.

• One special character.

• One number.

• Two or more changed characters in successive passwords.

• No more than four repeated characters.

• No more than four sequential characters.

• Cannot contain username. 

• Cannot use last 15 passwords. 

• May not be found in a dictionary of common passwords.

Highest Autologon disabled. Minimum Password Requirements: 

• 14 characters. 

• One lower case character.

• One upper case character.

• One special character.

• One number.

• Four or more changed characters in successive passwords.

• No more than two repeated characters.

• No more than two sequential characters.

• Cannot contain username. 

• Cannot use last 25 passwords. 

• May not be found in a dictionary of common passwords.

• Require logon at system startup.

Table 3-12:  Security Levels  (Continued)

Security Level Complexity Rules
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Initial Login to the LOGIQ Fortis  (continued)

3. If a Security Level is chosen, the Confirm Change screen 
appears.

If Lowest or Medium Security Level was chosen, you will be 
prompted to acknowledge that the security setting is lower 
than GE Healthcare recommends to secure the system. You 
will not be able to Confirm Change unless the “I Agree” box 
is selected.

If Medium, High or Highest Security Level was chosen, you 
can choose to change your password immediately and/or to 
force all users to change their password at next login.

Figure 3-13. Confirm Change Screen
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Initial Login to the LOGIQ Fortis  (continued)

4. You will be prompted to set up the ADM password, based on 
the selected Security Level. 

NOTE: If the password you type doesn’t meet the selected Security 
Level’s password complexity rules, the screen will prompt 
you (in red) to correct the password, as shown below. 

Figure 3-14. Change Password
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Initial Login to the LOGIQ Fortis  (continued)

5. After logging in, complete the system encryption setup. 
Navigate to the Disk Encryption Utility, Utility--> Admin--> 
Disk Encryption page. The system encrypts patient data by 
default (Encryption On. Disks are unlocked automatically). If 
you wish to change the default encryption setting, select the 
desired Encryption Policy, then press Accept. 

Figure 3-15. Initialize System Encryption

NOTE: If you (or the Field Service Engineer) reloads system 
software, you will need to press “Initialize System 
Encryption” to encrypt the system and reset System 
Encryption password and preferences.
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Initial Login to the LOGIQ Fortis  (continued)

NOTE: If you choose to dismiss this dialog, this dialog will be 
offered to you again at the next logon.   

Table 3-13:  Encryption Policy Selections 

Encryption Policy Description

Encryption OFF Patient Data will not be encrypted. Selecting “OFF” will unencrypt the drive. 

System drive and recovery partition will remain encrypted. 

Encryption ON. Disks are 

unlocked automatically

System Default. Patient data is encrypted and unlocked at system boot-up. 

Recovery Key and Password tied to the hard drive. 

Encryption ON. Require 

Pre-Boot PIN/Password 

before unlocking system 

drives

The system will not boot until the Pre-Boot PIN or Password has been 

entered. Unlike other manual key entry configurations, no system 

functionality is available without the PIN/Password. This encryption policy 

is intended for high security environments or customers with specific 

needs.

Encryption ON. Key is stored 

on USB/password is entered 

manually

The system will request the encryption password or recovery key at system 

startup. The system is not accessible until this password or a disk recovery 

key is provided. Requiring a password to access the patient archive may 

prevent emergency usage of the system. 
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Initial Login to the LOGIQ Fortis  (continued)

6. You must set the Encryption Password and record the 
Recovery Key in order to ensure access to your institution’s 
patient data (required if replacing the system drive, ECB 
Board, or reformatting the C:\ Drive). 

Recovery Keys are not backed up by the system; you must 
record / archive the Recovery Key in order to retrieve patient 
data. 

a. Reset the Encryption Password by pressing “Change 
password”. 

Reply “No” to this Question, “Password is already set on 
a disk. Do you want to reuse it? Press “No” to delete 
existing password. 

You can now update the encryption password, then 
press OK. 
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Initial Login to the LOGIQ Fortis  (continued)

b. Record the Recovery Key by pressing “Show recovery 
key”, then printing it to a local printer or PACS. Or, save 
the Recovery Key to a USB Flash Drive by pressing 
“Save recovery keys”. 

You can Show or Hide the Encryption key. Store the 
Recovery Key in a secure location, accessible to the 
ADM user as necessary. 

Encryption Notes

The system is usable while it is being encrypted. Encryption can 
take between 20 minutes and several hours, depending upon 
system configuration; a status bar tracks encryption progress. It 
is a background task. You can scan while the system is being 
encrypted. You can also power the system down and back on 
while the disk is being encrypted; disk encryption will pick up 
where it left off in the encryption process. 
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Changing Your Password

The System Administrator manages system groups, users, and 
permissions. After you have been added as a valid user, the 
System Administrator will assign you a temporary password. 
When you log into the system for the first time, you will be 
prompted to change your password. 

You can change your password at any time when first logging 
onto the system. To change your password 

1. Type your name in the Operator field. 

2. Press the Change Password button. The Change Password 
pop-up appears. 

Figure 3-16. Password Change

3. Type the following: 

• Password: Type your current password. 

• New Password: Type your new password. 

• Confirm Password: Retype your new password. 

NOTE: If you do not wish to set a password, or to change your 
password, select OK to continue. 
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Emergency User

If an Emergency User has been enabled by the Administrator 
via Utility--> Admin--> Logon, they need to login as “EUSR.”  

Figure 3-17. Emergency User

User Rights for the Emergency User are set by the Administrator 
via Utility--> Admin--> Groups. Emergency Users do not have 
access to your institution’s patient data, as shown in the 
example below. 

Figure 3-18. Patient Information Not Accessible
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Logoff

To logoff, press the Power On/Off switch momentarily and a 
SYSTEM-EXIT window appears.

Figure 3-19. System Exit Window
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Power Off

For optimum system operation, we recommend that you restart 
the system at least once every 24-hour period. If you shut down 
the system at the end of the day, no other action is needed. 

To power off the system:

1. Set the brake and use the operator panel movement 
controls to lock the control panel in place.

2. When you shutdown the system, enter the scan screen and 
lightly press the Power On/Off switch at the front of the 
system once. The System-Exit window is displayed.

NOTE: DO NOT press and hold down the Power On/Off switch to 
shutdown the system. Instead, lightly press the Power On/
Off switch and select Shutdown.

WARNING To avoid losing patient data, ensure that you have properly 
ended the patient’s exam and transferred all exam data / 
images / clips.

HINTS If the Park Lock does not engage when you attempt to dock the 
Operator Panel in place, reset the Park Brake by selecting 
“Park Brake Reset” in the Miscellaneous section on the Utility 
-> System -> General page.
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Power Off  (continued)

3. Using the Trackball, select Shutdown.

The shutdown process may take up to two (2) minutes and 
is completed when the control panel illumination shuts 
down.

NOTE: If a system shutdown is initiated while the system is still 
processing an incoming or outgoing DICOM job, a dialog 
box appears, notifying the user to confirm shutdown, check 
the spooler status or cancel the shutdown (see Figure 3-20). 

Figure 3-20. Confirm Shutdown

4. Disconnect the probes.

Clean or disinfect all probes as necessary. Store them in 
their shipping cases or another appropriate probe storage 
system to avoid damage.

NOTE: When the Power Assistant is installed, Power Assistant battery 
replacement may be necessary if the circuit breaker is turned off 
for long periods of time (3 to 6 months).

WARNING DO NOT turn off the circuit breaker before the Power On/Off 
switch LED is white.

Data may be lost or system software damaged if the circuit 
breaker is turned off before the Power On LED is white.
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Crash Recovery Instructions

In case of a system crash, power cycle the system. Upon 
boot-up, all images and measurements, except for generic 
worksheets, are preserved in the system. When the system 
returns, the system alerts you that unsaved images are still in 
the system from the previous patient. Respond to the prompt to 
continue the current patient. Check that all images and 
measurements have been preserved in the system. Then 
resume the exam. 

If the system fails to respond to your commands within a typical 
period of time, you need to manually reset the system. Simply 
hold down the power switch to initiate a normal power down 
sequence. After the system has completely shut down (power 
switch white), restart the system using the standard power-up 
sequence. All images and measurements, except for generic 
worksheets, are preserved in the system. When the system has 
fully powered up, the system alerts you that unsaved images are 
still in the system from the previous patient. Respond to the 
prompt to continue the current patient. Check that all images 
and measurements have been preserved in the system. If you 
do not have any images on the clipboard, the patient must be 
retrieved from the database. Then resume the exam. 
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System Language Configuration

Select the System Language and Date/Time Format

The default operating system language and keyboard may be 
changed from the Utility > System > General page. 

Figure 3-21. Utility System General Screen

1. Select the desired system language from the Language 
dropdown menu (1). Then select Save at the bottom left of 
the screen. Do NOT restart yet.

2. Select Regional Options (2) to open the Regional Options 
Dialogue Box
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Select the System Language and Date/Time Format  (continued)

Figure 3-22. Regional Options Dialogue Box

3. Select the following Regional Options:

• Current OS Language - Select the language from the 
dropdown menu (3) to match the system language 
selected in Step 1.

• Keyboard - Select the keyboard language preference 
from the dropdown menu (4).

• Current Format - Select the date and time format 
preference from the dropdown menu (5).

4. After making changes to the Regional Options, select OK; 
when prompted to restart, choose OK again to restart 
system.

NOTE: For the United Kingdom, it is recommended to use ENG 
Language (1), English (United States) OS Language (3), 
and modify "Current Format" time/date settings to English 
(United Kingdom) (4) (see Figure 3-22 on page 3-41).

Change the Keyboard Language (Temporary)

To temporarily change the keyboard language, press the left 
Alt+Shift keys on the keyboard to toggle through all available 
keyboard languages until you reach the desired language.

NOTE: When the system is restarted, the keyboard language will return 
to the keyboard language last set in Regional Options.
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English (International) Keyboard

When the system language is set to English (United States), 
pressing the Ctrl+Shift on the keyboard toggles between the 
English (United States) keyboard and the English (International) 
keyboard.

Apostrophe/Quotation Marks

To type an apostrophe or quotation marks while using the 
English (International) keyboard, you must press the space key 
after the apostrophe or quotation mark to display the character.

Special Accented Characters on the English (International) Keyboard

To type special accented characters, from the English (United 
States) keyboard, press Ctr+Shift to change to the English 
(International) keyboard, then press the AltGr+appropriate 
keyboard key listed below. 

• [AltGr]+[Q] to type ä

• [AltGr]+[W] to type å

• [AltGr]+[E] to type é

• [AltGr]+[Y] to type ü

• [AltGr]+[I] to type í

• [AltGr]+[P] to type ö

• [AltGr]+[A] to type á

• [AltGr] + [Function Key] + [,] to type ç

• [Shift] + [6] + [a] to type â

• [Shift] + [6] + [e] to type ê

• [Shift] + [6] + [i] to type î

• [Shift] + [6] + [o] to type ô

• [Shift] + [~] + [a] to type ã

• [Shift] + [~] + [n] to type ñ

• [Shift] + [“] + [a] to ä

• [Shift] + [“] + [e] to ë

• [Shift] + [“] + [i] to ï

• [Shift] + [“] + [o] to ö
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Connecting the Probe

Connecting the Probe

Probes can be connected at any time, regardless of whether the 
console is powered on or off. To ensure that the ports are not 
active, place the system in the image freeze condition.

To connect a probe:

1. Place the probe's carrying case on a stable surface and 
open the case.

2. Carefully remove the probe and unwrap the probe cord.

3. DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage. Use the 
integrated cable management hook to wrap the cord.

DANGER
 

Fault conditions can result in electric shock hazard to user/
patient. Do not touch the surface of probe connectors which 
are exposed when the probe is removed. Do not touch the 
patient when connecting or disconnecting a probe.

CAUTION Inspect the probe before and after each use for damage or 
degradation to the housing, strain relief, lens, seal, cable and 
connector. DO NOT use a transducer which appears damaged 
until functional and safe performance is verified. A thorough 
inspection should be conducted during the cleaning process.
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Connecting the Probe  (continued)

4. Prior to inserting the probe, ensure that the connector 
locking handle is positioned to the left.

5. Align the connector with the probe port and carefully push 
into place.

NOTE: When connecting the probe, DO NOT turn the locking lever 
if resistance is felt. If this is the case, remove the probe 
connector and check for misaligned or damaged pins. 
Probes with damaged connector pins should be taken out of 
service immediately. 

6. Turn the connector locking handle to the right to secure the 
probe connector.

7. Carefully position the probe cord so it is free to move and is 
not resting on the floor.

Figure 3-23. Probe port

1. Active probe port

2. Parking probe port (Extra probe can be stored by connecting to this port.) 

3. Pencil probe port
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Probe port illuminator

The LOGIQ Fortis has Probe port illumination to indicate the 
Probe port location in the Dark Room.

Brightness of illumination can be controlled on the Touch Panel 
and in Utility page.

Figure 3-24. Probe port with illumination

Figure 3-25. Touch panel control
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Cable Handling 

Take the following precautions with probe cables:

• Keep free from wheels. Use the cable hooks located below 
the operator panel. 

• Do not bend the cable acutely

• Avoid crossing cables between probes.
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Selecting probes

To activate the probe, select the appropriate probe from the 
probe indicators on the Touch Panel.

1. Select the probe that provides optimum focal depths and 
penetration for the patient size and exam.

2. Select the exam application. 

3. Select the application preset. 

4. Begin the scan session using the default Power Output 
setting for the probe and exam.

Figure 3-26. Probe Application/Preset Touch Panel

The probe's default settings for the mode and selected exam are 
used automatically.

NOTE: Selecting a new probe unfreezes the image.
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Deactivating the Probe

When deactivating the probe, the probe is automatically placed 
in freeze mode.

To deactivate a probe:

1. Ensure the selected probe is deselected or the LOGIQ 
Fortis is in freeze mode. If necessary, press the Freeze key.

2. Gently wipe the excess gel from the face of the probe.

3. Carefully slide the probe around the right side of the 
keyboard, toward the probe holder. Ensure that the probe is 
placed gently in the probe holder.

Disconnecting the Probe

Probes can be disconnected at any time. However, the probe 
should not be active when disconnecting the probe.

1. Ensure the probe is deactivated. Deactivate by selecting 
another probe or pressing Freeze.

2. Move the probe locking handle to the left.

3. Pull the probe connector straight out of the probe port 
carefully.

4. Carefully slide the probe and connector away from the 
probe port and around the right side of the keyboard.

5. Ensure the cable is free.

6. Be sure that the probe head is clean before placing the 
probe in its storage box or wall hanging unit.

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage. Use the 
integrated cable management hook to wrap the cord.
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Storing the Probe

It is recommended that all probes be stored in the provided 
carrying case or in the wall rack designed for probe storage.

Carrying case:

• First place the probe connector into the carrying case.

• Carefully wind the cable into the carrying case.

• Carefully place the probe head into the carrying case. DO 
NOT use excessive force or impact the probe head.

Storage/Transportation

Each probe should be supported in its own probe holder on the 
console. If a carrying case is provided with the probe, always 
use the carrying case to transport the probe from one site to 
another. 

Secure the probe in its holder for moving short distances. 

When transporting a probe a long distance, store it in its carrying 
case.

If possible, use a rigid container with a lid that secures the 
probe’s connector in place so as not to damage the probe head 
or lens. Place a soft cloth in the bottom of the container to 
prevent movement during transport. 

DANGER
 

Placing a dirty or contaminated probe in a carrying case or 
shipping carton will contaminate the foam insert. Failure to 
follow proper cleaning guidelines could lead to patient 
exposure to contaminant. 
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Operator Controls

Control Panel Map 

Controls are grouped together by function for ease of use. 

 Figure 3-27. Control Panel

1. Probe Holder and Cable Management 

2. Touch Panel and Joystick controls

3. On Screen Keyboard (not display in this 

graphic)

4. User Defined Keys

5. Mode/Gain/XYZ (3D) Controls

6. Trackball, Trackball Keys, Pointer, Measure, 

Comment, Body Pattern, Clear, Zoom, 

Programmable Keys

7. L/R, Start/Stop, Freeze, Simultaneous

8. Steer/Width/Depth/Reverse

9. Auto, CF/PW Auto Positioning

10. P1, P2
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Control panel adjustment

To raise/lower the control panel

1. Hold the front handle in two hands.

2. Push and hold down the Up/Down button next to the right 
front handle.

3. Raise or lower the control panel.

4. Release the Up/Down button at the desired height.

Figure 3-28. Up/Down control button

CAUTION To avoid injury or damage, make sure nothing is within the 
range of motion before moving the control panel. This includes 
both objects and people. 

Ensure that the hands of the patient are away from the Control 
panel arm when moving the Control panel.
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To swivel the control panel

1. Hold the front handle in two hands.

2. Push and hold down the swivel button next to the left front 
handle.

3. Move the control panel to the left or the right.

4. Release the swivel button at the desired position.

Figure 3-29. Swivel control button
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Keyboard

On Screen Keyboard

You can use "On Screen Keyboard" on touchscreen. Keyboard 
will show up when you press "Keyboard" User Defined key. And 
you can hide it with "Exit" button on Keyboard or Keyboard UD 
key.

Figure 3-30. On Screen Keyboard

Figure 3-31. Keyboard User Defined key
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Physical A/N keyboard (Option)

Physical A/N keyboard is under the control panel.

Figure 3-32. Physical A/N keyboard

Push the keyboard to project forward.

Figure 3-33. Push the keyboard
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Functional keys

The standard alpha-numeric keyboard has some special 
functions.

If you encounter a problem and cannot collect the logs 
immediately:

Once the logs are collected, the engineering team would be able 
to see the marker you added which will help engineering to 
troubleshoot the problem.

Table 3-14:  Special key function

Keyboard key Function

Esc Exit current display screen.

F1 Help

Access Online help/user manual.

F2 Arrow

Annotation Arrow.

F3 Eject

Eject media.

F4 Spooler

Activates DICOM Job Spooler screen.

F5 Creates a Fast Key.

F6 Plays a Fast Key.

F7 Home/Set Home

Move annotation cursor to home position; shift+key to set current annotation 

cursor position as the new home position.

F8 Text1/Text2

Switch between user text annotation overlays.

F9 Grab Last

Activate the last selected data for edit.

F10 Word delete

Erase word associated with comment cursor.

Table 3-15:  Key for collecting the log

Keyboard key Function

Alt+1 or Alt+2 Place a marker in the log.

Alt+D Collect the logs.
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Touch Panel

The Touch Panel contains exam function and mode/function 
specific controls.

Exam Function Controls

 Figure 3-34. Exam Function Controls

NOTE: Different menus are displayed depending on which Touch Panel 
Tab is selected.

At the bottom of the Touch Panel, there are six combination 
rotary dials/push buttons. The functionality of these rotaries 
changes, depending upon the currently-displayed menu. Press 
the button to switch between controls, or rotate the dial to adjust 
the value, or move the control left/right or up/down to adjust the 
value.

1. Patient: Enters Patient screen

2. Scan: Enters scanning mode screen

3. Reports: Activates default report and Touch 

Panel of report choices.

4. End Exam: Activates Image Management and 

Touch Panel with end of exam options.

5. Utility: Activates system configuration menus.

6. Probe Indicator: Indicates and selects the probes.

7. TGC Control: Activates TGC function. 

8. Indicates the number of pages for this mode. To 

move to the next page, touch the “dot” or swish 

your hand from right to left/left to right. 

9. To view all/fewer of the controls for this Touch 

Panel, press this Research/Clinical button. 
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Mode/Function Specific Controls

In general, the key name is indicated at the top of the key. There 
are different types of Touch Panel keys as illustrated below:

 Figure 3-35. Mode/Function Specific Controls

1. Press to toggle control on/off. 

2. Progress/Select keys are used for controls that 

have three or more choices.

3. Progression keys are used to assess the impact 

of the control on the image progressively.

4. 3-way functionality knobs (below the Touch 

Panel): Adjust controls by pressing (dot 

symbol), rotate (circled arrow symbol), move 

up/down (vertical line with arrows) or left/right 

(horizontal line with arrows).
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Mode, Display and Print

This group of controls provides various functions relating to the 
display mode, display orientation, image recording/saving, 
freeze, gain and Cine scroll.

The Mode Controls select the desired display mode or 
combinations of display modes.

• During dual display modes the L and R keys activate the 
Left or Right displayed image. See ‘Split Screen’ on 
page 6-18 for more information.

• Auto is used to:

• initiate auto optimize

• turn off auto optimize.

• Depth controls the image display depth.

• The Reverse key (via Depth key if preset) toggles the left/
right orientation of the scan image.

• Print keys are used to activate/print the designated 
recording device.

• The Freeze key is used to stop the acquisition of ultrasound 
data and freeze the image in system memory. Pressing 
Freeze a second time continues live image data acquisition. 

• To activate a specific mode, press the appropriate mode 
key. 

Each mode has its own gain control via the larger gray knob 
surrounding the mode key.
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Measurement and Annotation

This group of controls performs various functions related to 
making measurements, annotating and adjusting the image 
information.

• The Comment key enables the image text editor and 
displays the annotation library Touch Panel.

• The Clear key is generally used to erase functions, such as 
annotations/comments, body patterns and measurements. 
Pressing the Clear key again exits the selected function. 

• The Body Pattern/Ellipse control has a dual purpose:

• Press the Body Pattern/Ellipse control, it enables the 
Body Pattern Touch Panel and displays the default 
pattern on the screen. When body patterns are active, 
the knob rotates the probe position indicator. 

• Rotate the Body Pattern/Ellipse control, it activates the 
ellipse measurement function after the first distance 
measurement has been set and the second caliper is 
activated.

Press Set to fix the measurement after the ellipse 
adjustment is complete. The measurement is then 
displayed in the measurement result window.

• The Measure key is used in all types of basic 
measurements. When the Measure key is pressed, the 
measurement Touch Panel is displayed. 

• The Set key, located on the Trackball on-screen controls, is 
used for various functions, but is generally used to fix or 
finish an operation (e.g. to fix a measurement caliper).

• The Trackball is used with almost every key function in this 
group. Trackball control depends on the last key function 
pressed.
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Monitor

Adjusting the Monitor Position

CAUTION DO NOT apply force to the monitor surface by finger or other 
hard object.

The monitor surface may be damaged and permanently 
discolored.

• LCD Display

• HDU Display
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Adjusting the Monitor Position  (continued)

Grab the frame of the monitor with both hands when you adjust 
the position of the monitor and monitor arm.

CAUTION If any defects or damages are observed on the display screen 
or monitor itself, do not operate the equipment but inform a 
qualified service person.

Contact a Service Representative for information.

Table 3-16:  How to grab

LCD Display

Up/Down/Left/RIght

Flip down/Flip up

HDU Display
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Up/Down/Left/RIght

Flip down/Flip up

Table 3-16:  How to grab
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Locking/unlocking the Monitor

1. Turn the release knob clockwise to unlock the monitor. The 
monitor can be moved freely in all directions (Figure 3-36 1). 

2. Turn the release knob clockwise to raise the lock and move 
the monitor into the parked position, then turn the lock 
counterclockwise to lock. (Figure 3-36 2).

Figure 3-36. Unlock/Lock the monitor arm

1. Unlocked

2. Locked
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Adjusting the Monitor

You make adjustments to all monitors via the second Utility 
Menu page. To view the monitor while making these 
adjustments 

1. Press Utility--> select the second page. 

2. Press Scan Screen. The scan screen displays on the main 
display while the Utility Touch Panel is active so you can see 
the affect your adjustments are making to the monitor. 

Table 3-17:  Monitor Adjustments

Monitor Adjustments Parameters Affect on the Monitor

Room Profile: 

Monitor luminance varies, 

depending on the room’s profile 

(light, dark, semi-dark). Adjusting 

this control helps to adapt the 

monitor to different room lighting 

conditions. 

Set the Room Profile to match 

the room: 

Brightness/Contrast Equivalent: 

LCD display

Dark 50/85

Semi-Dark 70/85

Light 90/85

HDU display

Dark 50/40

Semi-Dark 50/65

Light 50/100

User Defined If you select User Defined, adjust 

the Brightness/Contrast control at 

the bottom of the Touch Panel.

Note: Brightness/Contrast setting is changeable when the Room 

Profile setting is available and set to “User Defined”.

Color Profile: 

Color Profile controls color 

temperature, or overall tint of the 

monitor. 

0 6500K

1 9000K (LCD display) / 9300K 

(HDU display)

2 11000K

3 13000K
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Gamma Setting: 

With Grayscale Standard Display 

Function (GSDF) enabled, the 

gamma button on the Touch 

Panel affects the image, 

emulating the appearance of that 

gamma. The system gamma is 

adjusted to match the GSDF 

gamma compensation to the new 

monitor gamma. 

Set the Gamma to 2.2 or 2.4 Note: With GSDF disabled, the 

monitor still uses a gamma curve 

that may be selected on the 

Touch Panel (for backwards 

compatibility with sites that are 

happy with their PACS or may 

have a mix of older systems). 

Return to Default settings. Press “Reset Monitor”, then restart the system. 

Table 3-17:  Monitor Adjustments (Continued)

Monitor Adjustments Parameters Affect on the Monitor
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Wide Screen Monitor Display Settings

Further clarification on three settings on the Utility--> System--> 
System Display configuration page is provided below: 

• Image Size (Default, Large)

• Image Display Area (Default, Large, Extra Large)

• Use Wide Screen For... (On, Off, Auto)

Table 3-18:  Wide Screen Monitor Display Settings

Preset 

Setting Description Choices

Image 

Size: 

The parameter “Image Size” changes the size of the ultrasound image 

without changing the screen image, which includes the title bar and the 

image parameter window. It also does not change the size of comments, 

measurement cursors and lines, or the measurement result box.

With all other settings the same, increasing Image Size from Default to 

Large creates a larger ultrasound image both on the LOGIQ Fortis display 

and on PACS’ displays. It will not affect the appearance of screen image 

items like the title bar and the image parameter window.

• Default

• Large

Image Size = Default (Left) and Image Size = Large (Right)

Hint: If you select and save “Last Used” on this page, the system starts with last used Room Profile setting 

every time.
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Image 

Display 

Area

“Image Display Area” changes the size of the screen image. 

On the LOGIQ Fortis display, this parameter changes the size of the 

ultrasound image. It also changes the arrangement of the items like the 

title bar and image parameter window, but not their individual size. 

Comments, measurement cursors and lines, and the measurement result 

box also do not change.

This parameter also changes the pixel count of the image. Many PACS 

software packages scale all images of the same aspect ratio to the same 

viewing size, regardless of their pixel count. Because the ultrasound 

image displayed is enlarged as the pixel count is increased, the PACS 

display size of the ultrasound image does not change. However, items 

like the title bar, image parameter window, comments, and measurements 

do not get larger as the pixel count is increased, so they appear smaller 

on PACS. If text appears too small on PACS, change the Image Display 

Area to Default (decreasing the screen image pixel count).

• Default

• Large

• Extra Large

Ultrasound System Image Display Area: Left = Default, Right = Large

PACS Image Display Area: Left = Default, Right = Large

Table 3-18:  Wide Screen Monitor Display Settings (Continued)

Preset 

Setting Description Choices
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Use Wide 

Screen 

For...

“Use Wide Screen for…” determines when the system will use a wide 

screen aspect ratio (16:9) as opposed to a “standard” aspect ratio (4:3). If 

“Single Image” under this heading is set to On, then the 16:9 aspect ratio 

is always used. 

A third aspect ratio is used if Extra Large is selected under Image Display 

Area. In this case the Wide Screen display options are not used and a 

16:10 aspect ratio is used for all images. The 16:10 aspect ratio will be 

only modestly different than the 16:9 aspect ratio.

Note: PACS display the top and bottom of the image as black bars, just 

like watching a wide-format movie on a non-wide screen TV. 

• On

• Off

• Auto

Ultrasound System Left&Right: Image Size=Large, Image Display Area=Default; Right: Wide Screen=On

PACS Left&Right: Image Size=Large, Image Display Area=Default;     Right: Wide Screen=On

Table 3-18:  Wide Screen Monitor Display Settings (Continued)

Preset 

Setting Description Choices
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Image Display Area Preset Setting Notes

The following table shows pixel counts (columns × rows) for 
saved images for all combinations of Image Display Area and 
Wide Screen on/off. 

NOTE: Note the different pixel counts for single frames and cine clips. 
This is because saved cine clips cut off the title bar and image 
parameter window.

Use Wide Screen For... Preset Setting Notes

The following table shows the aspect ratio for saved images for 
all combinations of Image Display Area and Wide Screen on/off. 
For comparison, it also includes data for the image display on 
19” monitors. For CINE clips, the aspect ratios will not be exactly 
the same as for single frames, but they will be very close.

Table 3-19:  Wide Screen Single Image and CINE Clip Pixel Count

Image 

Display 

Area Setting

Single 

Image

Single 

Image CINE Clip* CINE Clip*

Stress ClipOn Off On* Off*

Default 1456 x 819 1092 x 819 1346 x 748 982 x 748 1092 x 819

Large 1552 x 873 1164 x 873 1442 x 802 1054 x 802 1164 x 873

Extra Large 1552 x 970 1552 x 970 1442 x 899 1442 x 899 1552 x 970

*Under CINE Clip, “On” and “Off” mean Wide Screen Single Image On/Off, NOT CINE Clip On/Off. 

Table 3-20:  Wide Screen Aspect Ratio, Single Image

Image Display 

Area Setting On Off

Default 16:9 4:3

Large 16:9 4:3

Extra Large 16:10 16:10
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Test Patterns

The LOGIQ Fortis monitors follow the DICOM Gray Scale 
Display Function (GSDF) standard* which uses a GSDF curve 
to evaluate the health and effectiveness of the monitor. The 
GSDF standard is what is commonly used for calibrating PACS’ 
monitors. This setting may help to make the image appearance 
more uniform between the LOGIQ Fortis and PACS. 

NOTE: The monitor is GSDF-compliant with all contrast settings, but not 
all brightness settings. 

There is a GSDF on/off switch, “Enable DICOM grayscale 
display mode (GSDF)” via the Utility--> System--> System 
Display page that allows you to adjust the monitor you are using 
to the PACS. 

Table 3-21:  Test Patterns

Test 

Pattern Description Screen Example

Gray Bars Confirm that you can clearly see all of the different 

gradations of the grayscale in each gray cell. 

Color Bars Confirm that you can clearly see all of the different colors in 

each colored cell. 

Resolution Confirm that this image is clear and crisp, without jagged 

edges or lines.
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Brightness 

Contrast

Before making any adjustments, record the settings for 

contrast and brightness. In a dimly lit room, adjust the 

monitor to Brightness 50 & Contrast 40. Increase the 

contrast until the left most block in the second row from the 

bottom is just visible. All the remaining blocks in the last 2 

rows of the image should now be visible. Reset the contrast 

and brightness to the recorded levels. 

LN1 to LN18 Luminance for different grayscale levels. Usually, the 

facility’s Biomed Engineer tests each gray level map on the 

monitor from LN-1 to LN-18 with a light meter and then 

graphs these on a scale to ensure that the curve falls within 

the GSDF’s standard. Generally, this is performed yearly. 

LN-1

LN-18

QC Quality Control. Confirm that this image is clear and crisp, 

without jagged edges or lines. 

CT Contrast. Confirm that you can you detect the circles within 

the square grayscale boxes.  

*"Assessment of Display Performance for Medical Imaging Systems." Report of the American Association of 

Physicists in Medicine (AAPM) Task Group 18, Medical Physics Publishing, Madison, WI, AAPM On-Line 

Report No. 03, April 2005, Samei E, Badano A, Chakraborty D, Compton K, Cornelius C, Corrigan K, Flynn 

MJ, Hemminger B, Hangiandreou N, Johnson J, Moxley M, Pavlicek W, Roehrig H, Rutz L, Shepard J, 

Uzenoff R, Wang J, Willis C.

*Also see https://www.aapm.org/pubs/reports/OR_03.pdf, section 4.3. 

Table 3-21:  Test Patterns (Continued)

Test 

Pattern Description Screen Example
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Monitor Display

Monitor Display

 Figure 3-37. Monitor Display Tour
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Monitor Display  (continued)

Live/Freeze Indicator

Live/Freeze Indicator shows active image scan status with 
Single/Dual/Quad format and has four choices (Live/Not Live/
Update/B Pause). 

Live/Freeze Indicator display (on/off) is configurable on Utility -> 
System -> System Display menu. 

1. System Date and Time (Note: The date on the 

monitor may truncate the century when using 

the YYYY-MM-DD date format.)

2. Caps Lock

3. Network Connection Indicators (Wireless LAN, 

Wired, Mobile Bluetooth), Battery Status

4. DVR Status

5. InSite Indicator

6. Image Clipboard

7. Image Preview

8. Worksheet/Direct Report

9. Gray/Color Bar

10. Institution/Hospital Name, Date, Time

11. Operator Identification, Patient Name

12. Probe Orientation Marker

13. Measurement Calipers and System Message 

Bar

14. Color Window

15. Power Output Readout

16. Probe Identifier, Exam Preset

17. Live/Freeze Indicator

18. Imaging Parameters by Mode, Speed of Sound 

(SoS) Indicator (if applicable)

19. Focus Indicator and Color Flow Focal Zone 

Marker

20. Depth Scale

21. Image Management Icons and LOGIQ Apps 

Icon (not shown)

22. Body Pattern

23. CINE Gauge

24. Trackball Controls and Status

25. 6Tc-RS Probe temperature display

26. 6Tc-RS Probe angle display

Table 3-22:  Live/Freeze Indicator

Live Update

Not Live B Pause



Preparing the System for Use

3-74 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Monitor Display Layout

Monitor Display Layout is configurable on Utility -> System -> 
System Display menu.

See ‘System/System Display Preset Menu’ on page 10-12 for 
more information.

 Figure 3-38. Default Image Format (4:3)

1. Title bar

2. Information window 1

3. Information window 2

4. Scan Area

5. Control Window

6. Preview window/User Label

7. Clipboard

8. Trackball mapping and Set keys

9. Status area
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Information Window

Measurement Summary, Side Clipboard, Scan Assistant Guide, 
and My Desktop are displayed options for Info1 or Info2 window.

Figure 3-39. Information Window - Example

1. Measurement Summary

2. Side Clipboard

3. Scan Assistant Guide

4. My Desktop

My Desktop

The user can import graphics (jpeg) and write a caption for that 
graphic to display on My Desktop in Utility -> User Specific.

Table 3-23:  User Specific

Preset Parameter Description

My Desktop Title Free text

Picture 1 and 2 Browse to load jpeg and type the caption.

Background Color Select Color: Select the background color.

Default Color: Reset the background color to factory default.

Import Import the graphic.
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User Label

In Utility -> Application -> Settings -> Label Area, you can enter 
User Label which displays in the Preview Window as a brief 
note.

For example, P1 - Stills only, P2 - Stills, Clips (3 sec.), P3 - 
Volume, P4 Screen Capture.

Figure 3-40. Application Settings Preset Menu

Table 3-24:  Label Area

Preset Parameter Description

Show labels If selected, the system displays the User Label in the Preview Window at the 

left-bottom of the monitor.

Label 1 - 8 User labels have eight text lines. Each User Label is limited to 50 characters.
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Change the Display Image Area

You can change the screen format layout by pressing the lower, 
right-hand corner of the Display Image Area icon on the display: 

Table 3-25:  Display Image Area Selections

Display Image 

Area icons

Click Image Display Area icon to toggle current display 

area and extra large area.

Default Layout

• (4:3 Layout) Standard

• (16:9 Layout) Full Wide 

Large Image Layout

• (4:3 Layout) Standard

• (16:9 Layout) Full Wide 

Extra Large Layout

• (16:10 Layout) Partial Wide

Table 3-26:  Display Image Area Examples

Default Layout Standard

Default Layout Full Wide
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NOTE: Even If there are buttons on the rear cover of the monitor, DO 
NOT use those buttons for adjustment. The LOGIQ Fortis 
system will override the parameter(s) and the monitor does not 
have capability to retain parameters. 

Large Image Layout Standard

Large Image Layout Full Wide

Extra Large Layout Partial Wide

Table 3-26:  Display Image Area Examples (Continued)
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Using the Monitor Display Controls to Manage Images

Image Management Icons

You can manage images from the display via these on-display 
controls.

Table 3-27:  Image Management Icons

Image Display Area

Press Image Display Area to select Image Display Area - Default/Large/Extra large.

See ‘Change the Display Image Area’ on page 3-77 for more information.

Worksheet

Activate the Worksheet.

Active Images

Press Active Images to go to the Patient Active Images page.

Compare Assistant

Press to activate Compare Assistant. 

Activate Save As Menu - Note: Save As Menu icon is displayed only when an image is 

recalled or scan state is frozen/CINE Loop. 

Delete Recalled Image/Delete Last Image - Delete Recalled Image is displayed only when 

one image is recalled. / Delete last image icon is displayed only when the image is not 

recalled and there are non-stored images. You can use this to delete an image from the 

clipboard. Place the cursor on the clipboard image you want to delete, then press Set to 

select the image. Then place the cursor on the Delete icon and press Set.  

Next/Previous Image(s) and Clipboard Slide Show

Press the left arrow to move to the previous image; press the right arrow to move to the 

next image. 

Clipboard Slide Show

The Clipboard Slide Show plays all images on the clipboard and wraps around the ends. To 

activate, press and hold [Ctrl] + [Previous Arrow] or [Ctrl] + [Next Arrow]. 

• Each image recalls for three seconds, or the length of the loop, whichever is longer. 

• You can manually skip to a new image during the slide show by recalling it, as usual. 

• To end the slide show manually, press [Ctrl] + [Previous]/[Next] again. 

• Slide Show ends when you go to live scanning, or if the clipboard is not shown when it’s 

time for the next image to load. 
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System Positioning/Transporting

Moving the System

When moving or transporting the system, follow the precautions 
below to ensure the maximum safety for personnel, the system, 
and other equipment. 

CAUTION This equipment is not to be used during transportation (e.g. 
ambulance cars, aircraft).

CAUTION Handle carefully. A drop of more than 5 cm can cause 
mechanical damages.

Moving
Hazard

Never move the system with locked wheels.
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Before moving the system

1. Press the Power On/Off switch to power off the system. 
See ‘Power Off’ on page 3-37 for more information.

2. Unplug the power cord. 

3. Wind the power cable around the neck of rear handle.

4. All cables from off-board peripheral devices (external Color 
Digital/Report printer, etc.) and the ethernet connection 
must be disconnected from the console.

5. Ensure that no loose items are left on the console.

6. Connect all probes to be used while off site. Ensure that 
probe cables are out of the way from the wheels and not 
protruding beyond the console. Use the probe management 
hooks located below the Operator Panel to further secure 
the probe cables

NOTE: If more than four (4) probes are intended to be used, store 
the additional probes securely.

7. Store all other probes in their original cases or in soft cloth 
or foam to prevent damage. In addition, on-board storage 
bins are available as a system option. 

DANGER
 

LOOSELY (not twisting tightly) wrap the Power Cord 
around the neck of rear handle. Occasionally wrap the 
Power Cord around the neck of rear handle in the opposite 
direction. 

NEVER allow the Power Cord to drag on the floor. 

NEVER roll over the Power Cord with the wheels.

Failure to follow these instructions could lead to exposure 
to electrical shock.
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Before moving the system  (continued)

8. Store sufficient gel and other essential accessories in the 
provided space.

9. Adjust the monitor and control panel to their lowest positions 
by using the up/down switch on the front of the operator 
panel. Make sure the operator panel is locked in place. 

Figure 3-41. Flip down the monitor and lock the monitor arm

10. Unlock the wheels.

CAUTION To prevent system damage while not in use AND/OR 
before moving the system, flip down the monitor and lock 
the monitor arm and operator panel firmly in place.
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When moving the system

1. Always use the rear handle grips to move the system.

2. Take extra care when moving the system long distances and 
on inclines. Ask for help if necessary.

Avoid ramps that are steeper than ten degrees to avoid 
tipping over the system. Utilize additional care and 
personnel when moving on a steep incline (>5 degrees) or 
loading the system into a vehicle for transport. 

NOTE: Wheel chair ramps are usually less than five degrees. 

3. Use the foot brake (pedal), located on the bottom of the 
system in the front, when necessary.

4. Do not let the system strike walls or door frames.

5. Use extra care when crossing door or elevator thresholds.

6. Once the destination is reached, lock the wheels. 

CAUTION • DO NOT attempt to move the console using any cables or 
fixtures, such as the probe connectors.

• DO NOT attempt to move the system with the monitor by 
pulling cables or belts placed around the monitor and/or 
monitor arm.

• DO NOT restrain the LOGIQ Fortis at the monitor or the 
monitor neck using a belt. Always secure the monitor at the 
body part of the console.

WARNING To avoid possible injury and equipment damage:

• Be sure the pathway is clear.

• Limit movement to a slow careful walk.

• Use two or more persons to move the system on inclines or 
long distances.

Failure to follow instructions could lead to possible injury and/or 
equipment damage.
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Wheels

Examine the wheels frequently for any obvious defects that 
could cause them to break or bind. Each wheel has an 
independent brake pedal. A left rear wheel also has a swivel 
lock.

 Figure 3-42. Wheel lock and Swivel lock

1. Brake pedal 2. Swivel lock

CAUTION If you park the system on a slippery slope, you MUST use the 
brakes on the wheel.
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Brake pedal

Figure 3-43. Front and right-rear caster

1. Step on Lower side pedal to activate Brake

2. Step on Upper side pedal to release Brake

Figure 3-44. Left-rear caster

1. Step on to activate Brake

2. Raise up to release Brake
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Swivel lock

Figure 3-45. Rear-left with Swivel lock

1. Step on Lower side pedal to activate Swivel Lock with 
clicking sound

2. Step on Lower side pedal to De-activate Swivel Lock

NOTE: Wheel needs to be straight when you activate Swivel Lock. 

Figure 3-46. Caster position for Swivel lock
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Transporting the System

Use extra care when transporting the system using vehicles. In 
addition to the instructions used when moving the system (see 
‘Before moving the system’ on page 3-81 for more information), 
also perform the following:

1. Before transporting, place the system in its special storage 
case.

2. Only use vehicles that are designed for transport of the 
LOGIQ Fortis system.

3. Load and unload the system to a vehicle parked on a level 
surface.

4. Ensure that the transporting vehicle can handle the weight 
of the system plus the passengers.

5. Ensure that the load capacity of the lift (a minimum of 85 kg 
[187 lbs] is recommended) is capable of handling the weight 
of the system and any other items on the lift at the same 
time.

6. Ensure that the lift is in good working order.

7. Secure the system while it is on the lift so that it cannot roll. 
Use either wood chocks, restraining straps, or other similar 
types of constraints. Do not attempt to hold it in place by 
hand. 

NOTE: Strap the system below its handle so that the system does 
not break loose.

8. Employ two to three persons to load and unload safely from 
a vehicle. 

9. Load the unit aboard the vehicle carefully and over its center 
of gravity. Keep the unit still and upright. 

NOTE: Do not lay the unit down on its side. 

10. Ensure that the system is firmly secured while inside the 
vehicle. Any movement, coupled with the weight of the 
system, could cause it to break loose. 

11. Secure system with straps or as directed otherwise to 
prevent motion during transport. 

12. Prevent vibration damage by driving cautiously. Avoid 
unpaved roads, excessive speeds, and erratic stops or 
starts.
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Acclimation Time

After being transported, the unit requires one hour for each 2.5 
degree increment when its temperature is below 10 degree C or 
above 40 degree C before powering on.

Table 3-28:  System Acclimation Time Chart

Degree C 60 55 50 45 40 35 30 25 20 15 10

Degree F 140 131 122 113 104 95 86 77 68 59 50

hours 8 6 4 2 0 0 0 0 0 0 0

Degree C 5 0 -5 -10 -15 -20 -25 -30 -35 -40

Degree F 41 32 23 14 5 -4 -13 -22 -31 -40

hours 2 4 6 8 10 12 14 16 18 20
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Chapter 4

Preparing for an Exam

Describes how to begin an exam.
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Beginning an Exam

Introduction

Begin an exam by entering new patient information.

The operator should enter as much information as possible, 
such as:

• Dataflow

• Exam category

• Patient ID

• Patient name

• Exam Information

The patient's name and ID number is retained with each 
patient's image and transferred with each image during 
archiving or hard copy printing. 
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Patient Screen

Press Patient on the Touch Panel to display the Patient Screen 
on the monitor. 

• Enter Patient Data with the alphanumeric keyboard.

• To navigate through the Patient Entry menu, use the Tab 
key or Trackball and Set to move and fix the cursor.

 Figure 4-1. Patient Screen (Example: Category ABD)

Table 4-1:  Patient Screen

No. Function Description

1. Image Management • Patient–Provides a search and creation of patient. (currently 

selected)

• Image History–Provides a list of images per exam for the 

currently selected patient.

• Active Images–Provides preview of the currently selected exam 

and Compare Assistant.

• Data Transfer–Provides an interface to handle patient data from 

a remote device.
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2. Function Selection • New Patient–Used to clear patient entry screen in order to input 

a new patient’s data into the database. 

• Register–Used to enter new patient information into the 

database prior to the exam. 

If you are using the auto-generate Patient ID feature, do not 

select Register. It is always a good practice to Register all 

patients. 

• Details–Select the Details box to activate/deactivate the exam 

details.

The Exam Description pull-down selection is used as the DICOM 

identifier.

3. Query This Patient Allows for One Click Q/R for the current patient.

4. Logoff Used to logoff system.

5. EZBackup One-step method to backup patient images to an external media.

6. Dataflow Selection Select archive and other pre-defined services.

If you use a DVD-R, select DICOM CD Read in Dataflow.

If you place the cursor on the icon, the pop-up menu displays disk 

capacity.

7. Save and Exit Used to save all changes and exit the Patient Menu.

8. Patient Information • Patient ID Number

• Alternate (Other, Second) Patient ID Name and Number. The 

system allows you to enter a second identification number for the 

same patient, which may be required in certain countries. This is 

only displayed if enabled on the Connectivity -> Miscellaneous 

screen.

• Patient Name–Last, First and Middle

• DOB (Birthdate)

• Age (automatically calculated when birthdate is input)

• Sex

9. Category Selection Select from 8 exam application categories.

When a category is selected, the measurement and category 

presets are displayed.

10. Exam Information Shows the Current/Active Exam information. Information pertinent 

to the selected exam category appears in the window. All possible 

information needs to be entered.

• Images-Displays the selected exam's images in the middle of 

screen.

• Clear–Clears existing data.

• Past Exam (only for OB)–Input past exam data (register the 

patient before using).

11. Scan Assistant Program The Scan Assistant Program is either selected automatically or 

manually, depending on the preset as configured on the Utility--> 

System--> General page. 

12. Patient View/Exam View Display either patient or examination list. Refer to ‘Patient View/

Exam View’ on page 4-5 for details.

Table 4-1:  Patient Screen (Continued)

No. Function Description
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Patient View/Exam View

 Figure 4-2. Patient View and Exam View

Table 4-2:  Patient View/Exam View

No. Function Description

1. Patient View Lists the patients in the database.

When you double-click a patient on the patient list using the Set key, 

the Review screen or New Exam entry screen displays depending 

upon how the “Double click on patient list to start” preset is set at 

Utility -> Connectivity -> Miscellaneous.

2. Exam View Displays the list of all the exams for the Current Patient. 

The system can display the Detail Mode instead of Exam View when 

you select a patient on the patient list and press Review or Register 

(to Register, enter a patient ID and select). If the Detail Mode preset 

on Utility -> Connectivity -> Miscellaneous menu is selected, the 

Detail Mode displays.

3. Search Select a search criteria.

Note: Criteria “Img. Archived” means that the exam was backed up 

to external media by EZBackup or Export.

4. String Enter appropriate information for search criteria.

Note: If you select Locked (Y, N) or Archived (Y, N) for the Search 

key, enter Y (Yes) or N (No).

5. Clear Clears the entered string.

6. Hide Hide the patient view.
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NOTE: Refer to ‘Change Patient ID of the existing patient (Edit & Copy)’ 
on page 4-18 and ‘Anonymize the patient’ on page 13-407 for 
more information about Edit&Copy and Anonymize.

7. Review Highlight the patient and press Review. Exam view is displayed.

Note: If the selected patient has a Current Exam or the selected 

exam is the Current Exam, the Review button changes to "Resume 

Exam" on Patient List.

8. New Exam Creates a new exam for the current patient.

9. Resume Exam Continues the exam for that patient if you select the last exam of the 

day.

10. Delete Delete one or more patient record from Patient View.

Note: “Delete” is only displayed when you login as Administrator.

11. Detail The detail information for the selected category displays.

12. Lock/Unlock Locks the exam/patient. Prevents move and delete functions.

If you select the patient, all exams are locked. If you select one 

exam, the selected exam is locked and the lock icon displays in the 

patient ID cell.

13. Listing xx/xx Displays the quantity of patients that match the search criteria in the 

search window or the quantity of patients in the database.

14. Images Display images of the selected exam in the middle of the monitor.

15. Clear Exam Clear exam (located on the Touch Panel).

16. Delete Exam Delete one or more exams from Exam View.

Note: “Delete” is only displayed when you login as Administrator.

17. Disk Displays the disk name on which you saved the exam’s image data. 

If “+” displays behind the disk name, the data is saved on two or 

more disks.

18. Send To Send the images to the DICOM Device. 

19. Print Print the search list to a standard printer.

Highlight the patient and press left Set key. Select Print from the 

pop-up and press the right Set key.

Table 4-2:  Patient View/Exam View (Continued)

No. Function Description
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OB Exam

Exam Preparation

Prior to an ultrasound examination, the patient should be 
informed of the clinical indication, specific benefits, potential 
risks, and alternatives, if any. In addition, if the patient requests 
information about the exposure time and intensity, it should be 
provided. Patient access to educational materials regarding 
ultrasound is strongly encouraged to supplement the information 
communicated directly to the patient. Furthermore, these 
examinations should be conducted in a manner and take place 
in a setting which assures patient dignity and privacy.

• Prior material knowledge and approval of the presence of 
nonessential personnel with the number of such personnel 
kept to a minimum.

• An intent to share with the parents per the physician’s 
judgement, either during the examination or shortly 
thereafter, the information derived. 

• An offer of choice about viewing the fetus.

• An offer of choice about learning the sex of the fetus, if such 
information becomes available.

Ultrasound examinations performed solely to satisfy the family's 
desire to know the fetal sex, to view the fetus, or to obtain a 
picture of the fetus should be discouraged.
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Acoustic Output Considerations

Concerns surrounding fetal exposure

Always be aware of the acoustic output level by observing the 
Acoustic Output Display. In addition, become thoroughly familiar 
with the Acoustic Output Display and equipment controls 
affecting output.

Training

It is recommended that all users receive proper training in fetal 
Doppler applications before performing them in a clinical setting. 
Please contact a local sales representative for training 
assistance.

DANGER
 

The Ultrasound system is a multi-use device which is capable 
of exceeding FDA Pre-enactment acoustic output (spatial 
peak-temporal average) intensity limits for fetal applications. 
The interaction of sound energy with tissue at sufficiently high 
levels and/or longer duration can produce biological effects 
(aka bioeffects) of either a mechanical or thermal nature.

DANGER
 

It is prudent to conduct an exam with the minimum amount and 
duration of acoustic output necessary to optimize the image's 
diagnostic value. The interaction of sound energy with tissue at 
sufficiently high levels can produce biological effects (aka 
bioeffects) of either a mechanical or thermal nature.
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To Start an Obstetrics Exam

NOTE: Calculation formulas are listed in the Advanced Reference 
Manual.

To begin an Obstetrics exam, you have to enter the OB-specific 
information. Obstetric patient fields are listed in the following 
table. 

NOTE: To fill in the following information, move the Trackball to 
highlight the Detail button and press Set.

Table 4-3:  Obstetric fields

Field Description

LMP Last Menstrual Period; enter the date that the patient started her last menstrual 

period. 

You must enter 4 digits for the year. When you type the month and day, the 

system fills in the slash (/). The Date Format preset chosen in Utility -> System -> 

General determines the required format. 

BBT Basal Body Temperature.

EDD by LMP Estimated Delivery Date by LMP; the system fills in the date after you enter the 

LMP. 

GA by LMP Gestational Age by LMP; the system fills in the age after you enter the LMP. 

Gravida Number of pregnancies.

Para Number of births.

AB Number of abortions.

Ectopic Number of ectopic pregnancies.

Fetus # Number of fetuses; default is 1. Can be 1-4.

Accession # Exam number used with hospital information system (DICOM). This is a tracking 

number from the worklist.

Exam Description Describe the type of exam.

Perf Physician The physician who performs the exam. Choose from the list or type the name.

Ref. Physician The physician who requested the exam. Choose from the list or type the name.

Operator The person (not a physician) who performs the scan. Choose from the list.

Table 4-4:  Obstetric fields: Detail

Field Description

Indications  Why the patient needs the ultrasound exam.

Comments Comments about the exam.
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Starting an examination

Cautions and Warnings

WARNING Imaging functions may be lost without warning. Develop 
emergency procedures to prepare for such an occurrence. 
Failure to prepare for unexpected loss of functionality could 
lead to patient injury. 

WARNING Always ensure you have selected a dataflow. If No Archive is 
selected, no patient data is saved and a rescan may be 
required. A Ø appears next to Dataflow if No Archive is 
selected.

WARNING To avoid patient identification errors, always verify the 
identification with the patient. Make sure the correct patient 
identification appears on all screens and hard copy prints.

CAUTION Always use the minimum power required to obtain acceptable 
images in accordance with applicable guidelines and policies.

CAUTION Always use the system on a flat surface in the patient 
environment.
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Cautions and Warnings  (continued)

CAUTION Ensure that the hands of the patient are away from the system 
during the exam.

The position of the operator and the patient vary by scan 
region.

In most cases, the operator sits/stands straight in front of the 
operator console and the patient lies on the bed on the right (or 
left) side of the system.
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Creating a new patient record 

When starting a new patient’s exam, ensure you do the 
following: 

1. Press Patient on the Touch Panel. 

2. Press New Patient on the Touch Panel or the monitor. 

3. Fill in patient information. 

NOTE: Press Tab or Enter on A/N keyboard to move the cursor to 
next field.

NOTE: Do not use the following characters when filling in patient 
information:

“ ‘ \ / : ; . , * < > | + = [ ] &

4. Choose the exam category. 

Enter the required information for the selected exam 
category.

Figure 4-3. Exam category

5. Verify the dataflow. 

NOTE: DO NOT use the removable media dataflows on the New 
Patient menu. 

NOTE: The system can display a warning dialog when the patient is 
registered to “No Archive”. If the “Warn register to No 
Archive” preset is selected in the Utility -> Connectivity -> 
Miscellaneous menu, a warning displays. A different 
dataflow for permanent storage of patient data should be 
selected.

6. Select Register.

7. Select the probe to start scanning (or select Save and Exit, 
Esc, Scan, or Freeze).
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Perform an exam

1. Select the probe, exam category, and application. 

Figure 4-4. OB Preset - example

NOTE: See ‘Imaging Preset Manager’ on page 10-145 if you want 
create/edit user defined preset.

2. Perform an exam. 

3. Store the raw data to the clipboard.

To store the still image, press Freeze and run the cineloop 
using the Trackball. Select the frame and press P1 (or the 
assigned Print key).

To store the cineloop, press Print key without freezing or 
press Freeze and run the cineloop using the Trackball. 
Select the start/end frame and run the selected loop. Press 
P1 (or the assigned Print key).

1. Probe

2. Exam category

3. Application preset
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Ending an exam

1. When you have completed the study, press End Exam on 
the Touch Panel. 

2. The image management screen displays. Select the images 
(still frame or cineloop) you want to store or select Select 

All to store all images. Select Permanent Store to store the 
images permanently. 

NOTE: Return to the patient screen automatically from the scan screen 
when you select OK from the “ID is not unique” warning 
message.

Scanning without entering any patient data

To scan a patient without entering any patient data until the end 
of the exam:

1. Press Scan.

2. When you scan the patient and save images to clipboard 
without a patient, you will receive a warning that states, “A 
patient must be selected for permanent storage of image.” 
Press OK. 

3. Press Patient to display the Patient Search screen.

4. Enter the Patient ID.

NOTE: If you have images or measurements that are not attached 
to a Patient ID, the message “Unsaved images, 
measurements or fetus number will be linked to the current 
patient information, continue?” appears when the patient ID 
is registered.

5. Enter patient data and exam information as necessary.

6. Press Active Images.

7. Press Permanent Store.

WARNING To ensure correct storage of measurements, verify that the 
measurement result window is updated before you send or 
save the image. 
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Starting a new exam on an existing patient

1. Press Patient. 

2. Press New Patient on the Touch Panel or the monitor. 

3. Enter Patient ID or Last name, etc. in the patient information 
to display the target patient in Patient View.

For example, if you type “v” in Patient ID, only display 
patients begins with patient ID “v”.

or select Search key and enter a string to search a patient.

4. Highlight the target patient and double click the right Set 
key. Selected patient information displays.

5. Choose the exam category for new exam. 

6. Select New Exam. A new exam is created in Exam View.

7. Select the probe to start scanning (or select Exit, Esc, Scan, 
or Freeze).
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Retrieve Patient/Exam Information from Worklist

NOTE: Before you retrieve data from the Worklist server, make sure 
that Network LAN is connected correctly. If the worklist is not 
displayed, reboot the system. 

1. Press Patient and select Data Transfer. The Data Transfer 
screen displays.

2. Click on a radio button of Worklist. The patient/exam list 
displays in the Transfer To section.

Figure 4-5. Data Transfer 

3. The Worklist used last time is displayed on the monitor 
display. Press Refresh to refresh the list or select another 
Worklist server from the Transfer From pull-down menu.

4. Select the patient(s) or the exam(s) from the list.

5. Press Transfer. The progress bar displays during the 
transfer.

6. Enter the required items and start an exam. 

1. Worklist

2. Worklist radio button

3. Transfer button

4. Worklist server
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Sending Multiple Exams and Patients with Single Click to PACS

In the Patient View window, select 1 or multiple patients -- you 
can select by whole exam or whole patient -- to send to PACS. 
Select multiple items by using the Shift+Trackball Set Key. 

Figure 4-6. Multiple Patient/Exam Send To

Change Patient Information except Patient ID and scan 

1. Perform Step 1 to 6 in ‘Starting a new exam on an existing 
patient’ on page 4-15.

2. You can change Patient information except Patient ID.

Figure 4-7. Change Patient Information

3. Select the probe to start scanning (or select Exit, Esc, Scan, 
or Freeze).
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Change Patient ID of the existing patient (Edit & Copy)

1. Ensure that you are logged in as an Administrator on the 
system. 

2. Change the dataflow to Local Archive. 

3. Select the patient from the Patient View list and left click to 
bring up the “Edit & Copy” pop-up menu.

NOTE: If you do not see the Edit and Copy ID option on the pop up 
menu, make sure the top half of the patient screen is blank.

Figure 4-8. Select an Exam to Copy and Edit

4. A confirmation dialog displays. Select OK.

Figure 4-9. Copy Patient Pop-Up Confirmation
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Change Patient ID of the existing patient (Edit & Copy)  (continued)

5. The “Edit and Copy Patient” dialog displays. All the fields 
inherit the values from the original patient’s exam, except for 
Patient ID.

Figure 4-10. Edit and Copy Patient Dialogue

• Generate Patient ID generates a patient ID.

• Clear All clears all fields except for Patient ID and Other 
ID.

• Cancel button cancels the “Edit and Copy Patient” 
function.

6. Fill in the Patient information fields, then press OK. 

NOTE: If the newly entered Patient ID is not unique in the database, 
the Patient ID turns to red and an error message displays on 
the status bar.

Figure 4-11. Copy Status Bar

7. When the copy is done, the patient list is refreshed.

Make sure that the patient record with new Patient ID is 
created.

NOTE: If you want delete Patient record with old Patient ID, click 
Delete on the Touch Panel.
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Tips

The “Edit and Copy Patient” function:

• Copies data of a registered patient from the local archive to 
a newly-created patient in the local archive. The newly- 
created patient would have a new identification: patient ID, 
other ID, patient name, and sex etc.

• Assigns a new identification: new UIDs to the copied exam 
data. The newly-copied patient would have the same 
medical data as the patient being copied but with a different 
identification.

NOTE: “Edit and Copy Patient” will only copy patient data, images 
inside the local archive; it will not allow patient data or images 
from outside of the local archive. This includes the following 
types of images: exported, MPEGvue, SaveAs, DICOM Store, 
or (DICOM) print.

NOTE: “Edit and Copy Patient” does not copy the patient’s report.

NOTE: “Edit and Copy Patient” does not deal with patient information 
already burned in image pixels.

NOTE: The image and title bar, including patient information, is copied 
as is.

NOTE: The “Edit & Copy” function does not display for a current patient.

NOTE: The “Edit & Copy” function does not display when multiple 
patients are selected.

WARNING Confirm the patient identification prior to deleting/entering/
importing any patient data. The user is responsible for patient 
data, diagnostic information or any other patient-related 
information entered in the database. Failure to follow 
instructions could lead to loss of or incorrect patient data.
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Retrieving and editing archived

information

Searching for an existing patient

1. Press Patient to display the Patient Screen.

2. Select the search key (Patient ID, First Name, Last Name, 
etc.). Type the search string.

When default configured, the system automatically 
searches to see if the patient is already in the archive. The 
result of this search is displayed in the Patients list.

NOTE: When the number of patients on a hard disk is in the 
hundreds, it takes time to search for a patient or switch to 
another screen. In this case, do one of the following:

• Uncheck the “Auto search for patient” preset, found 
under Patient/Exam Menu Options in Utility -> 
Connectivity -> Miscellaneous.

• Delete unnecessary patient data.

3. Highlight the patient in the Patients list.

Select the Exam View tab to display a list of examinations 
instead of the patient records.
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Searching for an existing patient  (continued)

Figure 4-12. Patient Search Screen

NOTE: “Delete” is only displayed when you login as Administrator.

1. Select Review to review the exam history of this patient.

If the study was performed on the same day, Resume Exam will 

populate in place of Review to continue the exam

2. Select New Exam to create a new exam for this patient.

3. Select Delete to delete this patient.

4. Lock/Unlock. Use to lock/unlock the exam/patient. 
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Pop-up menu

If you select the patient and press the left Set key, the pop-up 
menu displays.

Figure 4-13. Archived Patient

If the study was performed on the same day, Resume Exam will 
populate to continue the exam.

Figure 4-14. Patient of the Day

NOTE: The preset “Double click on patient list to start”, located on the 
Utility -> Connectivity -> Miscellaneous screen, allows you to 
display either the Review or New Exam screen by double 
clicking the Set key on the patient name.
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Changing Patient Information or an Exam

If patient information needs to be edited, pressing Patient 
enables the Patient Screen for modifying information.

If the patient is still active, you can go to the New Patient page to 
change any field as well as select a different category. The exam 
changes in the Exam View area.

If the exam category needs to be changed, pressing New Exam 
allows modification of the Patient Screen without erasing 
accumulated patient images, measurements, annotations, 
calculations and worksheets.

1. Display the Patient screen by pressing Patient.

2. Select patient from the Patient list. The system automatically 
searches to see if the patient is already in the database.

• Select Search key (Patient Data: ID, First Name, Last 
Name, Birthdate, Sex or Exam Date.

• Enter search string (for example, initial letter of Patient 
Name)

3. The appropriate patient is displayed.

If patient information needs to be edited or the exam 
category changed, use the New Exam feature. Pressing 
New Exam allows modification of the Patient Screen 
without erasing accumulated patient images, 
measurements, annotations, calculations and worksheets.

NOTE: Patient identification information cannot be modified.
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Changing Patient Information or an Exam  (continued)

4. To have the database shown in its entirety, Backspace on 
the Search string and all patient names appear.

5. Select Register to register the new exam.

A new exam is automatically created on that patient unless 
an exam already exists on that day for that patient.

6. To display the patient information on the title bar, press the 
Esc key, the B-Mode key or Register. 

Select the Model and appropriate probe Touch Panel keys, if 
necessary.

Deleting the existing patient/exam/image

Deleting the existing patient

1. Search and select the patient in the patient list with the Ctrl 
or Shift keys.

2. Select Delete. The confirmation dialog box displays.

OR

Press the left Set key. A pop-up menu displays. Select 
Delete. The confirmation dialog box displays.

Figure 4-15. Select the patient in the patient list

3. Select Yes to delete or No to cancel.

WARNING Before deleting a patient or image from the Patient Screen, 
make sure you have already saved the data with EZBackup, 
Backup, or Export. Verify the media before deletion. Failure to 
follow instruction could lead to loss of patient data.
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Deleting the existing patient/exam/image  (continued)

Delete multiple patients from the patient list 

1. Select the multiple patients to be deleted from the patient 
list.

2. Select Delete. The confirmation dialog box displays.

OR

Press the left Set key. A pop-up menu displays. Select 
Delete. The confirmation dialog box displays.

3. Select Yes to delete or No to cancel.

Deleting the existing exam

1. Search and select the patient in the patient list.

2. Select Review.

3. The patient exam screen displays. Select the exam to be 
deleted.

4. Select Delete. The confirmation dialog box displays.

5. Select Yes to delete or No to cancel.

Deleting the existing image

1. Search and select the patient in the patient list.

2. Select Review. The patient exam screen displays. 

3. Select the exam which contains the image to be deleted.

4. Select Active Images to display the image list.

5. Select the image to delete and select Delete. The 
confirmation dialog box displays.

6. Select Yes to delete or No to cancel.
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MyPreset

Overview

MyPreset allows you to configure the specific-presets according 
to the probe.

You can arrange and edit the presets on the Touch Panel in 
Utility. See  ‘Arranging MyPreset Tab’ on page 4-29 for more 
information.

Activating MyPreset

1. Check Default MyPreset in Utility > System > System 
Imaging > Control to start MyPreset.

2. From the Touch Panel, select the active probe icon. 
MyPreset exam tab displays on the Touch Panel. 

Figure 4-16. MyPreset Tab

NOTE: Select MyPreset (star icon) on the Touch Panel. 
Conventional exam tab displays.
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Activating MyPreset  (continued)

Figure 4-17. Conventional Exam Tab
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Arranging MyPreset Tab

You can update MyPreset Configuration for each probe if 
desired. Need for each probe separately.

Figure 4-18. Imaging Preset Manager

1. Select MyPreset.

2. Select desired Probe.

3. Select presets from Available Imaging Presets column to be 
displayed on MyPreset tab. Use the up/down arrow to move 
the preset to a position.
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Chapter 5

Optimizing the Image

Describes how to adjust the image. This chapter is 

broken into the following sections: B-Mode, M-Mode, 

Color Flow Mode, M Color Flow, Doppler Mode, and 3D 

Mode. 
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Optimizing B-Mode

Intended Uses

B-Mode is intended to provide two-dimensional images and 
measurement capabilities concerning the anatomical structure 
of soft tissue. 

Typical B-Mode Exam Protocol

A typical examination using B-Mode might proceed as follows: 

1. Record exam-related patient information. Verify system 
setup (probes and presets). 

2. Position the patient and the console for optimum operator 
and patient comfort. Perform the scan. 

3. Complete the study by collecting all the data. 
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B-Mode Scanning Hints

HINTS These B-Mode controls produce the following results: 

Auto Optimize. Automatically improves the contrast resolution 
of the image by changing the gray scale to match the image 
data. Available in B-Mode and Doppler Mode. 

Coded Harmonics. Improves image clarity and tissue contrast 
by reducing clutter and artifacts.

B-Flow. Provides a more intuitive representation of 
non-quantitative hemodynamics in vascular structures. 

Frequency. Changes system parameters to best optimize for a 
particular patient type. 

Gray Map. Affects the presentation of B-Mode information. 
Choose the gray map prior to making other adjustments. There 
is an interdependency between gray maps, gain, and dynamic 
range. If you change a map, revisit gain and dynamic range 
settings. 

Dynamic Range. Changes the amount of gray scale 
information displayed. A higher dynamic range shows more 
gray scale information displayed, while a lower dynamic range 
displays less gray scale information onto the same display 
scale. If you increase the gain, you may want to decrease the 
Dynamic Range. 

Frame Average. Smooths the image by averaging frames. 
Reduces noise in the image.

TGC. Adjust TGC to adjust Gain in specific areas. 

Width. Sizes region of interest. Adjust the Width to the smallest 
reasonable size to maximize frame rate. 
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B-Mode Controls

Table 5-1:  B-Mode Controls

Control

Adjusts 

Acoustic 

Output Description/Benefit

Depth Yes To increase/decrease, adjust Depth. 

Depth controls the distance over which the B-Mode images anatomy. 

To visualize deeper structures, increase the depth. If there is a large 

part of the display which is unused at the bottom, decrease the 

depth.

Gain No To decrease/increase, rotate Gain (Mode key). 

B-Mode Gain increases or decreases the amount of echo 

information displayed in an image. It may have the effect of 

brightening or darkening the image if sufficient echo information is 

generated.

Note: Always optimize gain before increasing the Power Output.

Focus Yes In B-Mode, 4D and Contrast (Reference and Contrast) mode, the 

Focus is applied uniformly across the entire field of view, as 

indicated by the Focus indicator overlaid on the Depth indicator (see 

example 1 on the left). 

In Contrast MVI, CF/PDI/MVI, the Focus position is focused in the 

Region of Interest, as indicated by the “Dot” indicator overlaid on the 

Depth indicator (see example 2 on the left). The focus position is 

assigned to a rotary on the Contrast MVI, CF/PDI/MVI tab.

Auto Optimize No See ‘Auto Optimize’ on page 5-8 for more information.

ACE No Use ACE (Adaptive Contrast Enhancement) to emphasize echoes 

from real structures while reducing noise/haze. This results in 

enhanced signal-to-noise ratio. A sub-selection of ACE allows you to 

adjust how much ACE is applied, including a setting showing the 

coherence factor. Values are Light, Medium, or High filtering, or 

None (no filtering). 

Mode Cursor No Displays the M/D-Mode cursor on the B-Mode image.

To activate/deactivate the M/D-Mode cursor, press Mode Cursor 

(left Set key). Trackball to position the M/D-Mode cursor. Adjust the 

Angle and SV Length as necessary. 

SRI-HD No See ‘SRI-HD (High Detection Speckle Reduction Imaging)’ on 

page 5-10 for more information.
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CrossXBeam No CrossXBeam Angle adjusts maximum steering angle of 

CrossXBeam. Higher values correspond to larger angles. 

See ‘CrossXBeam’ on page 5-13 for more information.

Coded Harmonic 

Imaging (CHI)

Yes To activate Coded Harmonic imaging, press CHI on the control 

panel.

Coded Harmonics enhances near field resolution, diminishes low 

frequency high amplitude noise and improves imaging technically 

difficult patients. Coded Harmonics may be especially beneficial 

when imaging isoechoic lesions in shallow-depth anatomy in the 

breast, liver, and hard-to-visualize fetal anatomy. 

Frequency Yes Adjust Frequency until the desired frequency is selected.

Multi Frequency mode lets you downshift to the probe's next lower 

frequency or shift up to a higher frequency. 

Steer Yes To slant the linear image to the left/right, select Steer.

You can slant the B-Mode or Color Flow linear image left or right to 

get more information without moving the probe. The angle steer 

function only applies to linear probes.

Linear probes can be steered left, center, or right up to a maximum 

of 15 degrees, depending on the probe.

Virtual Convex Yes To activate/deactivate Virtual Convex, select Virtual Convex. 

On Linear and Sector probes, Virtual Convex provides a larger field 

of view in the far field. Virtual Convex is defaulted as active with 

Sector probes. 

Max Angle Yes With IC5-9-D and RIC9-5-D probes, the Virtual Convex control 

becomes Max Angle. Max Angle toggles the field of view to 179 

degrees.

TGC No TGC amplifies returning signals to correct for the attenuation caused 

by tissues at increasing depths. TGC slide pots are spaced 

proportionately to the depth. The area each pot amplifies varies as 

well. A TGC curve may appear on the display (if preset), matching 

the controls that you have set (except during zoom). You can choose 

to deactivate the TGC curve on the image. 

Width Yes To narrow/widen the sector width, rotate the Width control (located 

on the Depth control).   

You can widen or narrow the size of the sector angle to maximize the 

image's region of interest (ROI). 

Table 5-1:  B-Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Tilt Yes Tilt is available on the Trackball and/or the Rotary control, allowing 

sector angle adjustment to obtain more information without moving 

the probe. 

Trackball Control: When shown as available on the Trackball 

controls on the display, use the Trackball key and the Trackball to tilt 

the angle to the left/right.   

Rotary Control: Rotate the Rotary control to tilt the angle to the left/

right. Pressing the control resets Tilt to center. 

Tilt is not available on Linear probes.

Tilt is not available while in CrossXBeam. 

Dynamic Range No To increase/decrease, adjust Dynamic Range. 

Dynamic Range controls how echo intensities are converted to 

shades of gray, thereby increasing the adjustable range of contrast. 

Dynamic Range is useful for optimizing tissue texture for different 

anatomy. Dynamic Range should be adjusted so that the highest 

amplitude edges appear as white while lowest levels (such as blood) 

are just visible. 

Reverse (if Preset) No To flip the image 180 degrees, press the Reverse key.

Flips the image 180 degrees left/right. 

WARNING: When reading a reverse image, be careful to observe 

the probe orientation to avoid possible confusion over scan direction 

or left/right image reversal. Failure to follow instructions could result 

in misinterpretation. 

Maps No To select a map, press the Gray Map on the Touch Panel. A map 

window displays. The image reflects the map as you go through the 

selections.

The system supplies B, M, and Doppler Mode system maps.

Maps are preset-specific and are arranged in order from the softest 

map on the top of the menu to the map with the most contrast on the 

bottom of the menu. 

The only exception is Map J, which is a very soft map. 

Frame Average No Temporal filter that averages frames together, thereby using more 

information to make up one image. This has the effect of smoothing 

the image and reducing apparent noise. 

Colorize No 1. Select Colorize on the Touch Panel. 

2. Trackball to cycle through available maps. 

3. Press Set to select. 

Colorize is the colorization of a conventional B-Mode image or 

Doppler Spectrum to enhance the user's ability to discern B, M, and 

Doppler Mode intensity valuations. 

NOTE: You can colorize realtime or CINE images or Timeline CINE, 

but not DVR images. 

Colorizes the gray scale image to enhance the eye's discrimination 

capability.

The gray bar displays while Colorize is activated. 

To deselect, select a gray map. 

Table 5-1:  B-Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Rotation No Rotates the image 180 degrees. 

Beneficial in transvaginal and transrectal scanning.

WARNING: When reading a rotated image, be careful to observe the 

probe orientation to avoid possible confusion over scan direction or 

left/right image reversal. Failure to follow instructions could result in 

misinterpretation. 

Frame Rate Yes Optimizes frame rate or spatial resolution for the best possible 

image. High Frame Rate is useful in fetal heartbeat, adult cardiac 

applications, and clinical radiology applications which require 

significantly higher frame rates. Low Frame Rate (high resolution) is 

useful in situations where very small vessels are being imaged, e.g., 

thyroid, testicles.   

Rejection No Selects a level below which echoes will not be amplified (an echo 

must have a certain minimum amplitude before it will be processed).

Allows for the elimination from the display of low level echoes 

caused by noise.

Suppression No Suppresses the noise in the image. 

Speed of Sound No See ‘Speed of Sound (SoS) Tissue Imaging’ on page 5-23 for more 

information.

Table 5-1:  B-Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Auto Optimize 

Description Auto Optimize (Auto) lets you optimize the image based upon a 
the actual B Mode image data (Auto Tissue Optimize, ATO). The 
preset levels (Low, Medium, and High) allow you to pick a 
preference for the contrast enhancement in the resulting image. 
Low does the least amount of contrast enhancement, high does 
the most. 

Auto is available in single or multi image, on live, frozen or CINE 
images (in B-Mode only), and while in zoom.

Auto in PW Doppler Mode (ASO: Auto Spectral Optimization) 
optimizes the spectral data. Auto adjusts the Velocity Scale/PRF 
(live imaging only), baseline shift, dynamic range, and invert (if 
preset). “Running Auto Spectral Optimization” appears at the 
bottom of the monitor upon activation. Upon deactivation, the 
spectrum is still optimized. 

Benefit Auto can reduce optimization time and create a more consistent 
process. 

Adjusting To activate, press Right Auto key. 

Press Left Auto key to turn off Auto.

Preset To set up ATO (Auto Tissue Optimize), preset via Utility --> 
Imaging --> B-Mode --> Auto Optimize Mode. Specify the ATO 
Level: Low, Medium, or High. 

Values Auto is active until you deactivate it or when you change the 
following: Probe, Exam Category, Exam Calcs, or New Patient.

Affect on other 

controls

You may need to adjust the Gain. 
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Continuous Tissue Optimization (CTO)

Description CTO is intended to optimize the spatial continuous gain 
adjustment on B-Mode images instead of, or in combination 
with, ATO. 

NOTE: The probe orientation mark color is turquoise with an over and 
under line.

Preset You can select Auto Optimize Mode via Utility--> Imaging--> 
B--> Auto Optimize Mode. When CTO is selected, CTO works 
instead of ATO. When Both are selected, both ATO and CTO 
work. 

Adjusting To activate CTO, press the right Auto control. 

To deactivate CTO, press the left Auto control. 

To adjust the overall CTO Gain, use “CTO Gain” on the Touch 
Panel or B-Mode Gain. This can be set via Utility--> Imaging--> 
B--> CTO Gain. 

Benefit CTO can reduce optimization time and create a more consistent 
process. 

Availability For the BE9CS-D, C1-6-D, C1-6VN-D, C2-7-D, C2-7VN-D, 
C2-9-D, C2-9VN-D, IC5-9-D, L8-18i-D, L2-9-D, L2-9VN-D, 
L3-12-D, ML6-15-D, M5Sc-D, and RIC5-9-D probes in certain 
applications. 
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SRI-HD (High Detection Speckle Reduction Imaging)

Description SRI-HD (High Detection Speckle Reduction Imaging) is an 
adaptive algorithm to reduce the unwanted effects of speckle in 
the ultrasound image. Image speckle usually appears as a 
grainy texture in otherwise uniform areas of tissue. Its 
appearance is related to image system characteristics, rather 
than tissue characteristics, so that changes in system settings, 
such as probe type, frequency, depth, and others, can change 
the appearance of the speckle. Too much speckle can impair 
image quality and make it difficult to see the desired detail in the 
image. Likewise, too much filtering of speckle can mask or 
obscure desired image detail. Extra care must be taken to select 
the optimal SRI-HD level. 

SRI-HD SRI-HD is available in B-Mode imaging and may be used with 
any transducer or clinical application when image speckle 
appears to interfere with the desired image detail. 

Advanced SRI 

Type 1

Advanced SRI Type 1 is available in B-Mode for select 
applications, to produce images with clear borders and reduced 
speckle while maintaining natural image texture.

Advanced SRI 

Type 2

Advanced SRI Type 2 is available in B-Mode for OB/GYN 
applications (as a purchasable option), to produce smoother, 
cleaner images with enhanced border delineation. 

SRI-HD Type 2 is available for the probes and applications listed 
in Table 5-2.   

NOTE: When available per probe and application, the SRI Type can be 
chosen on the B-Mode tab, page 2.

Table 5-2:  Advanced SRI Type 2 OB/GYN Probes and Applications

Probe OB1 OB23 FetalEcho NT GYN Follicle

C1-6-D/C1-6VN-D X X X X X X

C2-9-D/C2-9VN-D X X X X X X

RAB6-D X X X X X X

L2-9-D/L2-9VN-D X X X X X X

L3-12-D X X X X

IC5-9-D X X X X X

RIC5-9-D X X X X X
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SRI-HD (High Detection Speckle Reduction Imaging)  (continued)

Adjusting Adjust SRI-HD levels on the Touch Panel. You can also set 
presets via Utility--> Imaging--> B-Mode. 

NOTE: We recommend selecting the SRI-HD level by observing the 
enhanced image in side-by-side dual image comparison with the 
original, unprocessed image. Dual display mode is activated by 
pressing the L and R keys simultaneously.

Figure 5-1. SRI-HD Adjustment 

Values Level values vary, depending upon the probe. 0 = Minimal 
Filtering. Increasing the level value increases the amount of SRI 
filtering and will result in smoother images. 

Benefits SRI-HD smooths the image when image speckle interferes with 
the desired image detail. 
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SRI-HD (High Detection Speckle Reduction Imaging)  (continued)

Tips and Notes When selecting the SRI-HD level, observe the effect of SRI-HD 
in the desired region of interest and make a real-time 
comparison with the original image. The optimal level depends 
on the clinical situation. Observing the original and 
SRI-HD-processed images together helps to determine whether 
too much or too little SRI-HD has been applied. 

Dual image mode for SRI-HD can also be activated on a stored 
CINE Loop. This allows you to always see the original, 
unprocessed or enhanced image by going into the Dual display 
mode and to change the SRI-HD settings when reviewing the 
CINE Loop. 

SRI-HD is available on 3D/4D (sectional image and render 
image).

• You cannot change SRI-HD after the scan starts.

• The effects for the rendered image are less than the 
2D-image.
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CrossXBeam

Description CrossXBeam is the process of combining three or more frames 
from different steering angles into a single frame. CrossXBeam 
is available on Convex and Linear probes. 

CrossXBeam combines multiple co-planar images from different 
view angles into a single image at real-time frame rates. 

CrossXBeam Angle adjusts maximum steering angle of 
CrossXBeam. Higher values correspond to larger angles. 

Adjusting To activate CrossXBeam, press the CrossXBeam key on the 
Touch Panel; an “X” appears on the display next to “CHI” or “B.” 

You can also adjust the CrossXBeam Angle and CrossXBeam 

Type (Mean/Hybrid/Max/MotionCorrection) on the Touch Panel. 
Max detects maximum values; Mean detects averaged values; 
Hybrid detects a mix of both average and maximum values; 
MotionCorrection suppresses bluriness and/or artifacts caused 
by lateral motion. 

Values All linear and convex probes are supported. B-Mode 
CrossXBeam is available while in B-Mode, Color Flow, or PW 
Doppler Mode. Steering is optimized by probe. 

Benefits The combined single image has the benefits of: 

• reduced speckle noise,

• reduced clutter, and

• continuity of specular reflectors. 

Therefore, this technique can improve: 

• contrast resolution with increased conspicuity of low 
contrast lesions, 

• better detection of calcifications, 

• biopsy needle visualization, and

• cystic boundary definition.
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B-Flow

Description B-Flow is intended to provide a more intuitive representation of 
non-quantitative hemodynamics in vascular structures.

B-Flow is digitally-encoded Ultrasound, using digital codes to 
enhance weak signals from small particulate reflectors (blood 
flow) and suppress signals from strong reflectors (tissue). Flow 
and tissue are displayed simultaneously without threshold 
decision and overlay. 

All B-Mode measurements are available with B-Flow active: 
depth, distance along a straight line, % stenosis, volume, trace, 
circumference, and enclosed area. 

Presetting Preset the default B Flow Mode via Utility--> Imaging--> 
General--> BF button. 

Activating To activate/deactivate B-Flow, press B-Flow on the control 
panel. The preset default B Flow Mode appears. PW Doppler 
Mode is available while in B-Flow; however, M-Mode and Color 
Flow/PDI Modes are not available.

Using B-Flow To optimize the image:

Adjust the frequency, display depth, and focal zone location 
based on the patient body type and anatomy of interest. Adjust 
Sensitivity/PRI and Background setting as needed (see below).

Adjust the remaining Imaging parameters and presets as 
needed; functionally is the same as B-Mode when in B-Flow 
mode.

Scanning Hints B-Flow provides an intuitive view of blood flow, acute 
thrombosis, soft plaque, small vessel perfusion, and high grade 
stenosis. Compared to Color Doppler, it does not display 
bleeding, blooming, or aliasing artifacts.

To view high speed jets only for stenosis, use a PRI value of 10 
or lower. Use the Background control to display an appropriate 
amount of tissue background including plaque.

To view slow flow, use a large PRI value while avoiding a PRI 
value that introduces a bar artifact.
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B-Flow  (continued)

Benefits Compared to Color Doppler mode, B-Flow provides better 
spatial and temporal resolution, displays blood flow in the entire 
image, i.e. NO ROI, and is not angle dependent as it does not 
use the Doppler Principle. B-Flow is therefore a more realistic 
(intuitive) representation of flow information, allowing you to 
view both high and low velocity flow at the same time.

Affect on other 

controls

When you activate B-Flow, the system remembers the imaging 
parameters set while in B-Mode. When you optimize the frame 
rate via Line Density, you compromise the resolution and when 
you optimize the resolution, you compromise the frame rate. 
B-Flow is not available in 3DView; but is available in Easy 3D. 

Bioeffects Using B-Flow Frequency, Focus Position/Number, Sensitivity/
PRI, Line Density, Visualization and Power Output may change 
the TI and/or MI. Observe the output display for possible effects.

Background

Description Background and Tissue controls work together to display the 
amount of background shown on the B-Flow image. Background 
provides a large change in the amount of tissue displayed; 
Tissue provides fine tuning to the amount of tissue displayed.

Adjusts the amount of tissue displayed on the B-Flow image. 
Works along with the Tissue control. 

Value 0, 1, 2, 3

• 0 = Least amount of tissue displayed. 

• 3 = Most tissue displayed. 

NOTE: Not available for Frozen images or in CINE.

Accumulation

Description Accumulation enhances the flow in an image; ideal to capture 
dynamic flow in a still picture. 

Values Off - Infinite. Infinite provides the same result as applying CINE 
Capture to a B-Flow CINE clip. 

Benefit Accumulation detects the maximum signal and holds it 
(accumulates it) for the level specified (Off - Infinite). 
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B-Flow  (continued)

Capture

Description B-Flow Capture provides users the ability to create an 
accumulated image in B-Flow Live. Maximum intensity 
projection algorithm to detect the strongest signal between the 
frames and display the results. 

Capture allows the user to represent the dynamic flow situation 
in the vasculature with a single still image. Adjustments can be 
made to modify the start and end frames used in the process. 
Select from the Touch Panel, a “C” will appear in the image 
parameter list in place of frame average.

NOTE: B-Flow Capture is assigned to the right Trackball key. You can 
operate B-Flow Capture from the Touch Panel or the right 
Trackball key. B-Flow Capture is available only while in 
Research mode.

NOTE: When turning on Live Capture, the cine buffer is cleared of prior 
data.

Sensitivity/PRI

Description Sensitivity/PRI (Pulse Repetition Interval) is proportional to the 
time interval between the pulses sent to develop the B-Flow 
image. 

In general, a larger value is recommended for slow flow as slow 
flow detection requires more time separation between pulses so 
the system can detect the difference in flow profile. However, a 
larger value could cause bar artifacts on the image. Therefore, it 
is suggested to not increase the PRI value more than needed. A 
small value of PRI should be used when the interest is in fast 
flow only, e.g. viewing a jet in a stenosis case, where the jet is of 
interest.

NOTE: Sensitivity/PRI is Probe and Exam Category dependent. 

Bioeffects Using B-Flow Sensitivity/PRI may change the TI and/or MI. 
Observe the output display for possible effects.
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B-Flow  (continued)

Visualization

Description Define the display technique.

Values • B-Flow. Displays only B-Flow image. 

• Dual. Displays B-Mode and B-Flow images simultaneously 
using dual screen. 

• Hybrid. Displays the B-Flow image over the B-Mode image 
using Hybrid Map. 

NOTE: Press L and R at the same time to switch between Visualization 
values. The switch sequence can be selected in Utility -> 
Imaging -> BF -> “L/R Button Sequence”. 

NOTE: Available for L2-9-D, L2-9VN-D, ML6-15-D, L8-18i-D, C2-9-D, 
C2-9VN-D, L6-24-D and C1-6-D, C1-6VN-D probes.
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LOGIQView

Description LOGIQView provides the ability to construct and view a static 2D 
image which is wider than the field of view of a given transducer. 
This feature allows viewing and measurements of anatomy that 
is larger than what would fit in a single image. Examples include 
scanning of vascular structures and connective tissues in the 
arms and legs. 

LOGIQView constructs the extended image from individual 
image frames as the operator slides the transducer along the 
surface of the skin in the direction of the scan plane. The quality 
of the resulting image is somewhat user-dependent and requires 
some additional skill and practice to develop proper technique 
and become fully proficient. 

LOGIQView is not available for the following: 

• Multi Image

• Timeline Modes

• B-Flow Mode

• Color Flow Mode

• PDI Mode

Benefits The user can look at a larger region of interest within one field of 
view that is wider than any given probe would normally provide. 

Clinical Use LOGIQView is intended for scanning areas too large to fit on one 
image. 

Using LOGIQView To perform an exam using LOGIQView, 

1. Perform a detailed examination of the anatomy/pathology. 
Optimize parameters for tissue texture and visible window 
PRIOR TO activating LOGIQView. 

2. Press the LOGIQView key on the Control Panel. 

3. To start acquiring the image, press Start (Trackball key). 

HINTS When you scan, start with a strong, quick sweep in the 
direction of the acquisition and then complete the LOGIQView 
image with a slow steady sweep. LOGIQView acquires images 
via leading edge vectors (and does not acquire slices, as in 
CINE). The image is being stored as you perform the scan and 
you can watch the LOGIQView as it is being acquired. 
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LOGIQView  (continued)

4. To restart the scan, press Start again. You can back up the 
probe, realign it, then go forward to redo a portion of the 
scan. 

5. To complete the scan, press End or Freeze (or allow the 
scan to auto complete. The LOGIQView is then displayed, 
scaled to fit entirely on the screen. 

6. Perform measurements and record images. 

7. Select Frame Review to move through the LOGIQView one 
frame at a time. Use the Trackball to scroll. 

NOTE: Measurement error is within 5% of the distance you 
measured for all linear probes. 

Uniform Motion The quality and usefulness of LOGIQView images is affected by 
transducer motion. Incorrect technique can contribute to image 
distortion. 

Guidance and precautions for uniform motion: 

• Continuous contact is required throughout the length of the 
extended image. DO NOT lift the transducer from the skin 
surface. 

• Always keep the transducer perpendicular to the skin 
surface. DO NOT rock the transducer. 

• Keep the motion within the same scan plane, if possible. DO 
NOT slide the transducer laterally. 

• Lateral turning (change in direction to follow anatomical 
structure) can be accommodated with slower motion. DO 
NOT make abrupt changes in direction. 

• The system accommodates a reasonable range of motion 
velocity. DO NOT make abrupt changes in speed of motion. 
Deeper scans generally require reduced speed. 

Bioeffects Activating LOGIQView has no affect upon Acoustic Output 
values. 
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B Steer+ 

Description B Steer+ helps to enhance biopsy needle visibility without 
slanting the entire B-Mode image. B Steer+ functionality is only 
available with linear probes.

Preset To enable/disable B Steer+: Set the “Enable B Steer+” preset via 
the Utility --> Imaging --> General page. 

To set the B Steer+ Angle and Needle Gain: Set via the presets 
on the Utility --> Imaging --> B Tab.

Adjustment To activate B Steer+, adjust the Steer/Width/Depth/Reverse 
Joystick to the left or right. The B Steer+ symbol and border line 
display on the image (at the opposite side of product logo).

NOTE: Make the biopsy and beam angle as perpendicular as possible.

Needle gain and angle adjustments are available using the:

• Touch Panel controls (B Steer+ Angles and Needle Gain). 
Select the appropriate beam angle or needle gain via the 
Touch Panel control. 

• Steer/Width/Depth/Reverse Joystick (Needle Gain). Rotate 
the Steer/Width/Depth/Reverse Joystick left/right to adjust 
the gain. 

• Auto (B Steer+ Angle). Press Auto left/right to adjust the B 
Steer+ Angle. 

Find the best needle visibility by changing the needle gain and 
needle angle.

Values B Steer+ angle (beam steering angle for needle visualization) is 
selectable from 15 to 40 degrees. Needle Gain is adjustable 
from 0 to 100.

B Steer values (including enable/disable, B Steer+ angle, and 
Needle Gain) are returned to factory or user preset values when 
you change: Probe, Exam Category, Exam Calcs, or New 
Patient.

Benefits Provides better biopsy needle visualization than normal B-Mode 
with steered beam angle and post processing.

Bioeffects Activating B Steer+ may change the TI and/or MI. Observe the 
output display for possible effects.
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Touch TGC 

Description TGC amplifies returning signals to correct for the attenuation 
caused by tissues at increasing depths. TGC slide pots are 
spaced proportionately to the depth. A TGC curve may appear 
on the display (if preset), matching the controls that you have 
set (except during zoom). 

NOTE: TGC adjusts the image automatically when using zoom.

Values When you change the depth, TGC is rescaled across the new 
depth range. Each pot is proportionately scaled across the 
depth. 

User-Defined 

Preset

There are 4 presets located on and selected via the Touch 
Panel. The right-most preset is locked and cannot be changed. 

TGC Display On/Off -- preset via Utility --> System --> System 
Display. 

Benefits TGC balances the image so that the density of echoes is the 
same throughout the image. 

Adjusting Touch TGC with B-Mode Image Overlay

You can adjust the TGC by overlaying the TGC slidepots over 
the B-Mode image on the Touch Panel (1), or via the Touch 
Panel TGC slide pots (2). 

 Figure 5-2. Adjusting the TGC
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Touch TGC  (continued)

Adjusting TGC with the B-Mode Image Overlay

To adjust the TGC interactively with the B-Mode image overlay, 

1. Press the TGC control, located in the upper, right-hand 
corner of the B-Mode Touch Panel. TGC “slidepots” appear 
over the B-Mode image. 

Pressing the bottom, right rotary or bottom, right corner of 
the Touch Panel also enters Touch TGC and adjusts the 
image. 

2. Adjust these slidepots by sliding each slidepot on the Touch 
Panel with your finger. 

3. To save this TGC setting as a preset, press and hold the box 
on the right until the box displays a blue outline. This TGC 
setting now appears in the “Custom” window.

4. To reset to the default setting, touch the TGC Presets preset 
at the bottom of the TGC display on the Touch Panel. 

NOTE: Timeout for TGC display can be set in Utilities --> System 
==> General. 

Adjusting TGC using the Touch Panel

You can also adjust the TGC or select a TGC preset directly on 
the Touch Panel. 

1. Adjust these slidepots by sliding each slidepot on the Touch 
Panel with your finger; or select TGC preset. 

2. To save a TGC setting as a preset, press and hold an 
available TGC preset box on the bottom of the Touch Panel 
until the box displays a blue outline. 

HINTS To hold the B-Mode image while adjusting the TGC, select the 
Hold Image lock located in the upper left-hand corner of the 
Touch Panel. The Hold Image lock overrides the Utility screen 
Auto Hide delay timer and hides the TGC slidepots, allowing 
unobstructed view of the image on the Touch Panel.

When Hold Image is active (or the Auto Hide delay timer is set 
to Off on the Utility screen), the Full Image button appears. 
Select the Full Image button to toggle between active B-Mode 
and the full image area.

NOTE: Though the B-Mode image is locked, you can still adjust 
the TGC curve while the image lock is active. 
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Speed of Sound (SoS) Tissue Imaging

Speed of Sound is available on all probes for the following 
applications: Abdomen, Abdomen 2, Renal, Bowel, and Breast. 
The Speed of Sound control is displayed only for these 
applications and are hidden in all other applications, even when 
research mode is enabled.    

NOTE: Speed of Sound displays on the monitor display as “SoS” with 
the speed following, “SoS 1500” (when the speed of sound is 
not equal to 1540). 

A control has been added on the Touch Panel to change the 
transmitted speed of sound for various breast tissue types: 

To activate Speed of Sound for Breast, for example, 

1. Select Probe --> Small Parts--> Breast--> B-Mode--> Speed 
of Sound. 

2. Press Speed of Sound on the Touch Panel. Speed of Sound 
selections appear at the bottom of the Touch Panel in place 
of the Focus Position control. 

3. Adjust the Speed of Sound control up/down to achieve the 
desired image. The system displays the Speed of Sound 
(SoS) on the Touch Panel in the upper, right-hand corner of 
the display as “SoS ####”. 

SoS settings are returned to the default for an SoS of 1540 (or 
when the SoS is not displayed on the display). 
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Minimizing Grating Lobe/Side Lobe Artifacts

Overview

Grating lobes/side lobes often create a spurious structure or 
clouding within an ultrasound image. Such artifacts are not 
uncommon in gray scale 2D imaging mode. They are caused by 
an undesired off-axis ultrasound beam contaminating the main 
beam. 

The ultrasound system presumes that the reflections returning 
to the transducer always come from the steered direction. 
However, when these (weaker) off-axis beams encounter a 
strong specular reflector, the returning reflected energy will be 
received and "added" to the main beam. 

Grating lobe/side lobe artifacts can be especially noticeable 
within anechoic regions (i.e. fluid, cysts, heart chamber, large 
blood vessels, etc.).

Corrective Adjustments

On the LOGIQ Fortis, if grating lobe/side lobe artifacts are 
suspected during the scan, adjustments can be made to reduce 
such artifacts.

1. Adjust scan window

2. Reduce CrossXBeam Angle

3. Decrease AO

For example, on C3-10-D probe, at default setting for NeoHead, 
grating lobe/side lobe artifacts are present in Figure 5-3.  

Figure 5-3. Image with Grating Lobe Artifact
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Corrective Adjustments  (continued)

To correct, reduce the CrossXBeam Angle and decrease the AO 
from 100% to 90%. The grating lobe/side lobe artifacts are 
removed as shown in Figure 5-4.

Figure 5-4. Image with Grating Lobe Artifact Removed
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Optimizing M-Mode

Intended Use

M-Mode is intended to provide a display format and 
measurement capability that represents tissue displacement 
(motion) occurring over time along a single vector. 

Introduction

M-Mode is used to determine patterns of motion for objects 
within the ultrasound beam. The most common use is for 
viewing motion patterns of the heart. 

LOGIQ Fortis has three types of M-Mode:

• Conventional M-Mode: displays a distance/time plot of a 
cursor line in the axial plane of the 2D-image. Conventional 
M-Mode can be combined with Color Mode.

• Anatomical M-Mode (AMM)

• Curved Anatomical M-Mode (CAMM)

M-Mode Display

Figure 5-5. M-Mode Display
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Typical exam protocol

A typical examination using M-Mode might proceed as follows:

1. Get a good B-Mode image. Survey the anatomy and place 
the area of interest near the center of the B-Mode image. 

2. Press Mode Cursor. 

3. Trackball to position the mode cursor over the area that you 
want to display in M-Mode. 

4. Press M-Mode. 

5. Adjust the Sweep Speed, TGC, Gain, Power Output, as 
needed. 

6. Press Freeze to stop the M trace. 

7. Record the trace to disk or to the hard copy device. 

8. Press Freeze to continue imaging. 

9. To exit, press M-Mode. 

M-Mode Controls

NOTE: You can set default value of each parameter by probe and 
application on the Utility --> Imaging page. See ‘Imaging 
Presets’ on page 10-30 for more information. 

Table 5-3:  M-Mode Controls

Control

Adjusts 

Acoustic 

Output Description/Benefit

Sweep Speed No To increase/decrease, select Sweep Speed. 

Changes the speed at which the timeline is swept. 

Available in M-Mode, Doppler Mode and M Color Flow Mode.

You can speed up or slow down the timeline to see more or fewer 

occurrences over time. 
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Anatomical M-Mode (AMM) and Anatomical Color M-Mode (ACMM)

Description Anatomical M-Mode gives you the ability to manipulate the 
cursor at different angles and positions. The M-Mode display 
changes according to the position of the cursor.

Anatomical M-Mode displays a distance/time plot from a cursor 
line, which is independent from the axial plane. AMM is available 
in B, Color and TVI.

NOTE: To set up AMM, go to Utility--> Imaging--> AMM. Select the 
specific probe and parameters. 

NOTE: Turn off CrossXBeam before activating AMM/CAMM.

Figure 5-6. Anatomical M Mode

Activating To activate Anatomical M-Mode, while in M-Mode, press the  
Anatomical M Touch Panel control. 

NOTE: AMM is not available on Linear probes.

NOTE: Anatomical M-Mode can also be used with previously acquired 
digitally stored 2D images. More than one heart cycle should be 
stored if performing M-Mode in post processing.

To activate Anatomical Color M-Mode, after accessing 
Anatomical M-Mode, activate Color Flow (CF). 

Adjusting Use Touch Panel Trackball to position the M cursor over the 
required area of the B-Mode image.

1. Use the trackball (assigned function: Pos) to position the M 
cursor over the required area of the image.

2. Press the top Trackball key to allow free rotation of the solid 
arrow line throughout the 2D image (trackball assigned 
function: Angle).

NOTE: Rotate the Touch Panel control to angle the M cursor at a 
given angle.
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Anatomical M-Mode (AMM) and Anatomical Color M-Mode (ACMM)  

(continued)

Benefits Color Flow Mode and Color M-Mode are Doppler Modes 
intended to add color-coded qualitative information concerning 
the relative velocity and direction of fluid motion within the 
B-Mode or M-Mode image.

Bioeffects Changing the Packet Size, Scale, and ROI size may change the 
TI and/or MI. Observe the output display for possible effects. 

Curved Anatomical M-Mode (CAMM)

Curved Anatomical M-Mode (CAMM) displays a distance/time 
plot from a free-drawn cursor line. CAMM is available in B, CF 
and TVI.

1. Select Curved AMM on the Touch Panel.

2. Use the Trackball to position the start point of the time 
motion curve in the B-Mode image.

3. Press Set to fix the start point.

4. Use the Trackball to position the next point.

The time motion curve is drawn by the green line.

5. Press Set to fix the point.

6. Repeat step 4 and 5 to draw a complete time motion curve.

NOTE: The time motion curve can be edited by following the curve 
back to the desired point and redrawn as desired. Following 
the curve back to the starting point will delete the time 
motion curve.

7. Press Set twice to complete.

NOTE: Move the cursor to the desired anchor point and press Set. 
Move the point to the desired position and press Set.

8. The arrow cursor appears on the M-Mode image and the 
red bar appears on the time motion curve.

The red bar indicates the position of the time motion curve 
relative to the arrow cursor on the CAMM image. They move 
relative to one another. 

NOTE: Press Set to clear a cursor line.

NOTE: Curved Anatomical M-Mode can also be used with previously 
acquired digitally stored B-Mode images.

NOTE: CAMM is not available on Linear probes.
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Optimizing Color Flow

Intended Use

Color Flow Mode is a Doppler Mode intended to add 
color-coded qualitative information concerning the relative 
velocity and direction of fluid motion within the B-Mode image.

Introduction

A typical examination using Color Flow Mode, 

1. Follow the same procedure as described under B-Mode to 
locate the anatomical area of interest. 

2. After optimizing the B-Mode image, add Color Flow. 

NOTE: Use all noise reduction controls with care. Excessive 
application may obscure low level diagnostic information.

3. Move the color flow area of interest as close to the center of 
the image as possible. 

4. Optimize the color flow parameters so that a high frame rate 
can be achieved and appropriate flow velocities are 
visualized. 

5. Press Freeze to hold the image in memory. 

6. Record color flow images as necessary. 

7. If more definitive information is needed about flow, utilize the 
procedures described under Doppler Mode.

8. To exit Color Flow, press CF-Mode or B-Mode.

NOTE: Most parameters are user presettable by probe and application 
in the preset menu (Utility -> Imaging -> CF). 

WARNING Color Flow Doppler is intended for qualitative studies only.



Optimizing Color Flow

LOGIQ Fortis – Basic User Manual 5-31
5855997-1EN Rev. 3

Activating Color Flow

Color Flow is useful to see flow in a broad area. Color Flow 
allows visualization of flow in the CF ROI, whereas Doppler 
Mode provides spectral information in a smaller area. 

Color Flow is also sometimes used as a stepping stone to 
Doppler. You use Color Flow to locate flow and vessels prior to 
activating Doppler. 

Color Flow Mode Controls

Color Flow Mode and Color M-Mode are Doppler Modes 
intended to add color-coded qualitative information concerning 
the relative velocity and direction of fluid motion within the 
B-Mode or M-Mode image. 

Table 5-4:  Color Flow Mode Controls

Control

Adjusts 

Acoustic 

Output Description/Benefit

Flow Selection No In the Lower Extremity Vein (LEV) and Abdominal applications, you 

can quickly select the flow state via a shortcut on the Color Flow 

Mode Touch Panel menu.

Gain No Gain amplifies the overall strength of echoes processed in the Color 

Flow window or spectral Doppler timeline.

Allows you to control the amount of color within a vessel or to fill in or 

clean out spectral information. 

Scale (Velocity 

Scale)

Yes To raise/lower the velocity scale, adjust Scale. 

Increases/decreases the Scale on the color bar. 

Imaging of higher velocity flow requires increased scale values to 

avoid aliasing. 

Wall Filter No Filters out low flow velocity signals. It helps get rid of motion artifacts 

caused from breathing and other patient motion. 

Gets rid of excess, unnecessary low frequency signals caused by 

motion. 

Size/Position of the 

color window

No Adjust size and position of the color window.

To adjust the size, press the top trackball key to select Size then 

move the Trackball left/right, up/down. To adjust the position, press 

the top trackball key to select Pos then move the Trackball to 

position the color window. 

Increase the color window to see a larger area; decrease the color 

window to improve frame rate and spatial resolution.

Invert (Color Invert) No To reverse the color flow, press Invert (Color Invert). 

Lets you view blood flow from a different perspective, e.g., red away 

(negative velocities) and blue toward (positive velocities). You can 

invert a real-time or frozen image. 

NOTE: Invert reverses the color map, NOT the color Scale. 
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Baseline No To adjust the baseline, adjust Baseline up/down, as necessary. 

Changes the Color Flow or Doppler spectrum baseline to 

accommodate higher velocity blood flow. Minimizes aliasing by 

displaying a greater range of forward flow with respect to reverse 

flow, or vice versa. 

Baseline adjusts the alias point. The default baseline is at the 

midpoint of the color display and at the midpoint of the color bar 

reference display. 

Angle Steer Yes To slant the linear image to the left/right, adjust Angle Steer. 

You can slant the ROI of the Color Flow linear image left or right to 

get more information without moving the probe. The Angle Steer 

function only applies to linear probes. 

Provides a Doppler cursor angle suitable for linear probe orientation. 

Beneficial in Peripheral Vascular to image carotids.

Accumulation No Accumulation enhances the flow in an image.

Accumulation detects the maximum signal and holds it for the level 

specified. 

Note: If Accumulation is turned off, then Frame Averaging is used. 

Color Flow Line 

Density

Yes Optimizes the Color Flow frame rate or spatial resolution for the best 

possible color image. 

Low line density is useful in fetal heartbeat, adult cardiac 

applications, and clinical Radiology applications which require 

significantly higher frame rates. High resolution is useful in situations 

where very small vessels are being imaged, e.g., thyroid, testicles. 

Map No Allows you to select a specific color map. After you have made your 

selection, the color bar displays the resultant map.

Shows the direction of the flow and highlights the higher velocity 

flows.

Velocity Maps (V). Flow shown as blue away/red toward the probe.

Velocity Variance Maps (VV). Provides a measure of turbulence 

(stenosis). Adds green to velocity maps.

Map Compress No When you increase the value, high velocity elements in the map are 

compressed so that the map darkens. When you decrease the 

value, low velocity elements in the map are compressed so that the 

map lightens. The effect is visible in the color bar. 

Radiantflow No Radiantflow provides an easy, fast visualization of tiny vessels, 

displaying as a 3D effect. 

Threshold No Threshold assigns the gray scale level at which color information 

stops. 

Limits color flow overlay to low level echoes inside vessel walls. 

Helps minimize color `bleeding' outside vessel walls. 

Frame Average No Averages color frames. 

Higher frame averaging keeps the color displayed longer for 

increased flow visualization while lower frame averaging provides 

greater flow dynamics. 

Table 5-4:  Color Flow Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Transparency Map No Brings out the tissue behind the color map. 

Helps demonstrate the tissues behind the color. 

Spatial Filter No Smooths out the color, makes it look less pixelated.

Flash Suppression No Activates/deactivates Flash Suppression, a motion artifact 

elimination process. 

Beneficial to suppress flash. 

Packet Size Yes Controls the number of samples gathered for a single color flow 

vector. 

Allows you to improve the color sensitivity and accuracy of color 

averaging (increase packet size) or frame rate (decrease packet 

size), as needed. 

Power Doppler 

Imaging (PDI)

No See ‘Power Doppler Imaging (PDI)’ on page 5-38 for more 

information. 

Table 5-4:  Color Flow Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Radiantflow

Radiantflow is a rendering technique for Color Flow and Power 
Doppler Imaging, available on all probes. Radiantflow provides 
an easy, fast visualization of tiny vessels, displaying as a 3D 
effect. Press Radiantflow on the Color Flow Touch Panel and 
select the amount of power signal gradient. 

• Off. - Normal Color Flow/Power Doppler Imaging. 

• Min. - Less gradient. 

• Mid. - More gradient. 

• Max. - Most gradient. 

Figure 5-7. Radiantflow Map

CAUTION Radiantflow is a display method which uses the amplitude of 
the Color flow signal. Note that this may alter the appearance 
of the Ultrasound information displayed. For diagnostic 
purposes, this must be taken into account or the Region of 
Interest must be checked without Radiantflow.
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Flow Model Shortcuts 

Flow Model Shortcuts values vary by application. You can 
configure these Shortcuts on the Utility--> Imaging--> CF. Below 
is an example of the Renal Flow Model Shortcuts and the 
following table lists all the following Flow Model Shortcuts by 
application. 

Figure 5-8. Application Flow Model Shortcuts
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Flow Model Shortcuts  (continued)

Table 5-5:  Flow Model Shortcuts 

Application Flow Model Shortcuts

ABD, ABD Biopsy Aorta Slow Flow (Renal) Fast Flow (Renal Art) Penetration

Renal Aorta Twinkle Fast Flow (Renal Art) Penetration

OB1, OB23 Fetal Echo Ovary

PedAbd Slow Flow 

(Renal)

Twinkle Penetration

NeoHead Slow Flow Penetration

NeoAbd Slow Flow 

(Renal)

Penetration

Cardiac (Adult, 

Pediatric)

Fast Frame Rate Penetration Slow Flow

Scrotal Slow Flow

Thyroid Slow Flow Med Flow Carotid

Breast, MskGen Slow Flow Med Flow Fast Flow Penetration

MskSup Slow Flow Med Flow Fast Flow Rheuma

LEV Slow Flow Fast Flow

UEV Slow Flow

Carotid Vascular 

Surgery

Vertebral Arterial 

(Vert.Art.)

UEA Vascular 

Surgery

Slow Flow

GYN Ovary
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Editing Flow Model Shortcuts

1. Via Utility--> Imaging--> CF, highlight the Flow Model line 
you want to add/update. 

Figure 5-9. Setting up Flow Models

2. Type the Flow Model name in the Name field. The Flow 
Model is updated as you type. 

3. Update Delta Gain (increases/decreases Displayed Gain by 
the dB selected here), Velocity, Line Density, CF/PDI 
Frequency for this Flow Model. 

4. Set Default Flow Model. 

5. Press Save, then Exit. 

The updated Flow Model is located in the designed position on 
the Color Flow Touch Panel. 

NOTE: Users can free type custom flow shortcuts into the Scan 
Assistant Creator to use them within Scan Assistant. 
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Power Doppler Imaging (PDI) 

Description Power Doppler Imaging (PDI) is a color flow mapping technique 
used to map the strength of the Doppler signal coming from the 
flow rather than the frequency shift of the signal. Using this 
technique, the ultrasound system plots color flow based on the 
number of reflectors that are moving, regardless of their velocity. 
PDI does not map velocity, therefore it is not subject to aliasing. 
A sub-mode of PDI has been optimized for visualization of small 
slow flow vessels, called Micro Vascular Imaging (MVI). 

Adjusting Press PDI. The color flow window appears over the B-Mode 
image. Move the Trackball to move the CF window. To exit, 
press PDI or select a new mode. 

NOTE: Most parameters are user presettable by probe and application 
in the preset menu (Utility -> Imaging -> PDI). 

Values On/Off. 

Twelve power and four directional PDI maps are available.

Benefits Since PDI does not display velocity, it does not alias. 

Affect on other 

controls

When PDI is activated, the following controls are adjusted: Color 
Map is set to a power map. Line Density is adjusted. Threshold 
is set to 100%. Frame Averaging is adjusted. Packet Size is 
adjusted.

NOTE: These controls are reset to their previous values upon exiting 
PDI. 

HINTS When changing maps, higher gain settings may be needed. 
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Power Doppler Imaging (PDI)  (continued)

Presets

You can set the default PDI imaging mode via Utility -> Imaging 
-> General -> Default PDI: 

 Figure 5-10. Set Default PDI

Table 5-6:  Power Doppler Imaging Controls

Control

Adjusts 

Acoustic 

Output

Description/

Benefit

Map No Allows you to select a specific color map. After you have made your 

selection, the color bar displays the resultant map. Shows the 

direction of the flow and highlights the higher velocity flows.

Power Maps. Assortment of Black/White, Pink, Blue, Yellow, Red, or 

B-Flow Maps. 

Directional Maps. Directional Power Doppler Maps from PDI. Note: If 

the image is aliasing while in Directional MVI Maps, increase the 

Scale. 

You can set the default map by probe via Utility -> Imaging -> MVI -> 

Default Map. 

Background No Displays the amount of background image shown on the MVI image. 

Use the Background control to display an appropriate amount of 

tissue background including plaque. 

• 0=Least amount of image displayed

• 6=Most amount of image displayed
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Micro Vascular Imaging (MVI)

Smaller vessels can be imaged using Micro Vascular Imaging 
(MVI), which is a sub-mode of PDI optimized for visualization of 
small, slow flow vessels. MVI is available under the Power 
Doppler Imaging (PDI) Touch Panel. It’s available on the 
C1-6-D, C1-6VN-D, L8-18i-D, L2-9-D, L2-9VN-D, L3-12-D, 
ML6-15-D and L6-24-D probes. MVI is used to detect and 
visualize micro-vasculature by providing higher sensitivity and 
higher spatial resolution. 

Activating MVI

Access PDI on the Operator Panel, then select MVI on the 
Touch Panel. 

Figure 5-11. Access MVI from the PDI Touch Panel
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Directional Power Doppler

You can select the DPO 0, 1, 2, and 3 Directional Power Doppler 
maps while in PDI. 

NOTE: If you store a PDI image and recall it, you can still switch to the 
Directional Power Doppler map and vice versa. However, an 
image stored as non-directional then switched to directional just 
adds direction to a non-directional map and vice versa. 

HINTS If the image is aliasing while in Directional Power Doppler, 
increase the Scale. 
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Optimizing M Color Flow

M Color Flow Mode

Description M Color Flow is used for cardiac applications. There is a cursor 
on the B-Mode image that determines the extent of the Color.

The Color Flow maps available in M-Mode are the same as in 
Color Flow Mode. The size and position of the Color Flow 
window in B-Mode determines the size and position of the Color 
Flow window in M-Mode. 

All M-Mode measurements are available with M Color Flow 
active: depth, distance along a straight line, % stenosis, volume, 
trace, circumference, enclosed area, distance, time, slope, and 
heart rate. 

Activating To activate M Color Flow Mode, press M (M-Mode). Then press 
CF (Color Flow) - or - press CF, then press M. 

To toggle between M Color Flow controls and Color Flow 
controls, press the appropriate Touch Panel Mode tab. 

Benefits Color Flow Mode and Color M-Mode are Doppler Modes 
intended to add color-coded qualitative information concerning 
the relative velocity and direction of fluid motion within the 
B-Mode or M-Mode image. 

Bioeffects Changing the Sweep Speed, Packet Size, Frame Rate/
Resolution, Zoom, PRF, and ROI size may change the TI and/or 
MI. Observe the output display for possible effects. 
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Optimizing Spectral Doppler

Intended Use

Doppler is intended to provide measurement data concerning 
the velocity of moving tissues and fluids. PW Doppler lets you 
examine blood flow data selectively from a small region called 
the sample volume. 

Typical Use - PW Doppler

In Pulsed Wave Doppler (PW) Mode, energy is transmitted from 
the ultrasound probe into the patient, as in B-Mode. However, 
the received echoes are processed to extract the difference in 
frequency between the transmitted and received signals. 
Differences in frequencies can be caused by moving objects in 
the path of the ultrasound signal, such as moving blood cells. 
The resultant signals are presented audibly through the system 
speakers and graphically on the system display. The X axis of 
the graph represents time while the Y axis represents the shift in 
frequency. The Y axis can also be calibrated to represent 
velocity in either a forward or reverse direction. 

PW Doppler is typically used for displaying the speed, direction, 
and spectral content of blood flow at selected anatomical sites. 
PW Doppler operates in two different modes: conventional PW 
and High Pulse Repetition Frequency (HPRF). 

PW Doppler can be combined with B-Mode for rapidly selecting 
the anatomical site for PW Doppler examination. The site where 
PW Doppler data is derived appears graphically on the B-Mode 
image (Sample Volume Gate). The sample volume gate can be 
moved anywhere within the B-Mode image. 
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Typical exam protocol

A typical examination using PW Doppler Mode might proceed as 
follows: 

1. Locate the anatomy to be examined. Get a good B Mode 
image. Press CF to help locate the vessel you wish to 
examine. 

2. Press Mode Cursor to display the sample volume cursor 
and gate. 

or

Press PW. The PW Doppler spectrum appears and the 
system operates in combined B+Doppler Mode. Adjust 
Volume to adjust Doppler audio. The Doppler signal is 
heard through the speakers. 

3. Position the sample volume cursor by moving the Trackball 
left and right. Position the sample volume gate by moving 
the Trackball up and down. Size the gate by clicking SV 

Length. 

4. Optimize the PW Doppler spectrum, as necessary. Refer to 
the Doppler Optimization section of this chapter for more 
information. 

5. Press Update to toggle between real time B-Mode with 
Doppler Mode (with audio).

6. Sample along the whole length of the vessel. Make sure that 
the probe is parallel to flow. Listen, then look, when 
positioning the sample volume cursor. 

7. Press Freeze to hold the trace in memory and stop imaging. 
Activate CINE Timeline, as necessary. See ‘Using CINE’ on 
page 6-3 for more information.

8. Perform measurements and calculations, as necessary. 
Refer to the Measurements and Calculations chapter for 
more information. 

9. Record results by pressing the appropriate print key, 
depending on the setup of your recording devices. 

10. Press Freeze to resume imaging. 

11. Repeat the above procedure until all relevant flow sites have 
been examined. 
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Spectral Doppler Display

Time zero (the start of the trace) appears on the left side of the 
graph. As time progresses, the trace moves to the right. The 
baseline of the graph (representing zero velocity, zero frequency 
shift, or no detected flow), appears as a solid line running 
horizontally across the display. By convention, movement 
toward the probe is positive and movement away from the probe 
is negative. Positive frequencies or velocities appear above the 
baseline. Negative frequencies or velocities appear below the 
baseline. 

Typically, blood flow is not uniform but is composed of a mix of 
blood cells moving at different velocities and in different 
directions. Thus, the display is composed of a spectrum as gray 
scale values. Strong signals are displayed as bright while weak 
signals are displayed as varying shades of gray. 

HPRF (High Pulse Repetition Frequency) is invoked when you 
are operating in PW Doppler Mode and conditions activate 
HPRF (when the velocity scale factor or sample volume gate 
depth exceeds certain limits). When HPRF is active, multiple 
sample volume gates appear along the Doppler mode cursor. 
Doppler information can be received from any of the multiple 
sample volume gates. The Doppler signals from all the gates are 
added together and displayed in one spectrum. 

Information about the PW Doppler display is automatically 
written on the screen and updated when scanning parameters 
are changed. 

This chapter includes: 

• A discussion of PW Doppler. 

• Activating Pulsed Wave Doppler. 

• Optimizing the Doppler spectrum. 
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PW Doppler Mode Display

Figure 5-12. PW Doppler Mode Display

Table 5-7:  Doppler Mode Display Explanations

Doppler Display Description, Format, Values

Scale Velocity Scale, displayed as PRF in kHz. 

Wall Filter Wall filter size, displayed as WF in Hz. 

Doppler Gain* Displays as GN in decibels (dB). 

Sample Volume Depth Displays (in Cm) when Doppler cursor is present. 

Doppler Angle

 (AC ##)

Indicates angle in degrees between the Doppler mode cursor and the angle 

correction indicator. Displays when Doppler cursor is present. The Doppler 

Angle displays in red when the angle exceeds 60°. Velocities obtained when 

the angle is greater than 80° are displayed as asterisks (***). 

Spectral Invert INVERT appears when the spectral trace is inverted and the plus/minus 

signs (+/-) are reversed. 

HPRF HPRF mode is used when detected velocities exceed the processing 

capabilities of the currently selected PW Doppler scale or when the selected 

anatomical site is too deep for the selected PW Doppler scale. 

Time Scale Each selection represents a different sweep time. 

Angle Correct Indicates flow direction. 

Sample Volume Gate Indicates sample volume box. Each probe defaults to a specific range gate. 

Doppler Velocity Scale Flow direction has a positive and negative indicator, noted in centimeters per 

second (cm/sec). When the velocity scale is less than 10 cm/s, it is displayed 

to the first decimal point (4.6 rather than 5 cm/s). The Doppler velocity scale 

adjust as you adjust the Scale.
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Doppler Mode Controls

NOTE: You can set the default value of each parameter by probe and 
application on the Utility --> Imaging page. See ‘Imaging 
Presets’ on page 10-29 for more information. 

Table 5-8:  Doppler Mode Controls

Control

Adjusts 

Acoustic 

Output Description/Benefit

Doppler Sample 

Volume Gate 

Position (Trackball)

Yes To move sample volume gate position, press the top trackball key to 

select Pos, move Trackball up or down until positioned inside the 

vessel. 

Moves the sample volume gate on the B-Mode's Doppler Mode 

cursor. The gate is positioned over a specific position within the 

vessel.

Positions the sample volume gate to sample blood flow.

Doppler sample 

volume length (SV 

Length)

Yes To increase/decrease the gate size, adjust SV Length on the Touch 

Panel. Hold down key to continuously size gate. 

Sizes the sample volume gate.

A smaller gate produces accurate sampling results because it is 

more sensitive. You can also enlarge the gate for sampling large 

vessels or areas. 

Angle Correct/Auto 

Angle

No To adjust the angle relative to the probe face, adjust Angle Correct 

to the left/right. The velocity scale changes when you adjust angle 

correct. 

Press Angle Correct to access Auto Angle. 

Estimates the flow velocity in a direction at an angle to the Doppler 

vector by computing the angle between the Doppler vector and the 

flow to be measured. 

Optimizes the accuracy of the flow velocity. This is especially useful 

in vascular applications where you need to measure velocity. 

NOTE: When the Doppler Mode Cursor and angle correct indicator 

are aligned (the angle is O), you cannot see the angle correct 

indicator.

Quick Angle No Quickly adjusts the angle by 60 degrees. 

Press Quick Angle to toggle between Off, Right and Left. 

Steer and Fine Steer Yes To slant the linear image to the left/right, adjust Steer to the left or 

right. 

Press Steer to access Fine Steer. 

You can slant the ROI of the Color Flow linear image left or right to 

get more information without moving the probe. The angle steer 

function only applies to linear probes.

Provides a Doppler cursor angle suitable for linear probe orientation. 

Beneficial in Vascular applications. 

Audio Volume No Controls audio output.

An audio representation of the flow within a vessel can be used to 

evaluate proper probe angle and position. 

Cycles to Average No The average value over a number of cycles (from 1-5).
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Display Format No Changes the horizontal/vertical layout between B-Mode and 

M-Mode, or timeline only. 

Update Yes To activate, press Update to toggle between simultaneous and 

update. Doppler Mode does not restart each time the image is 

updated; however, a black bar may appear with a lightning bolt 

signaling a break in the timeline. 

Toggles between simultaneous and update presentation while 

viewing the timeline. 

Update increases the Spectral Doppler display quality. 

Simultaneous 

(Duplex/Triplex)

Yes Duplex allows two modes to be active at the same time; Triplex 

allows three modes to be active at the same time. 

• B + PW or B + CW or B + CF (Duplex)

• B + PW + CF or B + CW + CF (Triplex)

Update pauses the image while keeping the CW / PW timeline 

active. 

When Duplex/Triplex is OFF, either the image or timeline is active. 

Update then switches the active side between the image and the 

timeline. 

Baseline No Adjusts the baseline to accommodate faster or slower blood flows to 

eliminate aliasing. 

Compression No Compression controls how echo intensities are converted to shades 

of gray, thereby increasing the range of contrast you can adjust.

Optimizes the image's texture and smoothness by increasing or 

decreasing the amount of gray scale.

Invert No Vertically inverts the spectral trace without affecting the baseline 

position. 

The plus (+) and minus (-) signs on the velocity scale reverse when 

the spectrum is inverted. 

If you change the probe angle to accommodate anatomy, blood flow 

still moves in the same direction, but the Doppler information will be 

reversed. It is easier in cases like this to invert the spectrum instead 

of reversing the probe orientation. 

Scale (Velocity 

Scale)

Yes To view signal detail, adjust Scale to enlarge the vertical spectral 

Doppler trace. Velocity range directly controls the pulse repetition 

frequency, which is responsible for the setting of the Nyquist limit 

(the ability to detect maximum velocity without aliasing). 

If the sample volume gate range exceeds single gate Scale 

capability, the system automatically switches to high PRF mode. 

Multiple gates appear, and HPRF is indicated on the display. 

Trace Method 

(Spectral Trace)

No To get a peak trace, click MAX. A green trace displays on the 

spectrum. 

To get a mean trace, click MEAN. A blue trace displays on the 

spectrum. 

Traces the average mean and peak velocities in realtime or frozen 

images.

Lets you trace the cardiac cycle. 

Table 5-8:  Doppler Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Trace Sensitivity No Adjust the trace to follow the waveform for signal strength.

If the signal is very faint, increasing the Trace Sensitivity will allow 

the system to trace that signal strength. 

Trace Direction No Specifies trace direction. 

You can select where on the waveform to perform the trace, above, 

below, or both (above and below). 

Cursor Moving No On Utility--> Imaging, specify No Action, Update 2D/CF-Long, 

Medium, or Short, or Update Doppler-Slow, Medium, or Fast. 

Cursor Moving lets you ‘walk’ Doppler through a vessel while the 

Doppler gate is moving. Updates are more frequent on Fast vs. 

Medium vs. Slow. If you set the preset to Update 2/D/CF, this causes 

the B Mode/Color Flow image to go live while you move the Doppler 

cursor. 

Time resolution No Adjusts image appearance so that if you select a lower setting, the 

image appears smoother; if you select a higher setting, the image 

appears sharper.

Wall Filter No To increase/decrease, select Wall Filter on the Touch Panel. 

Insulates the Doppler signal from excessive noise caused from 

vessel movement. 

Gets rid of excess, unnecessary information. Cleans out low level 

noise above and below the baseline so you don't see or hear it on 

the spectrum. 

Auto (Auto Optimize) No To activate, press Right Auto key. 

Press Left Auto key to turn off Auto.

Auto in PW Doppler Mode (ASO: Auto Spectral Optimization) 

optimizes the spectral data. Auto adjusts the Velocity Scale/PRF 

(live imaging only), baseline shift, dynamic range, and invert (if 

preset). “Running Auto Spectral Optimization” appears at the bottom 

of the monitor upon activation. Upon deactivation, the spectrum is 

still optimized. 

See ‘Auto Optimize’ on page 5-8 for more information.

Mode Cursor No Displays the Doppler Mode cursor on the B-Mode image. 

To activate/deactivate the Doppler Mode cursor, press Mode Cursor. 

Trackball to position sample volume graphic.   

Modify Auto Calcs No Activates the menu to select which calculations are automatically 

calculated. 

Auto Calcs No Activates the calculation automatically which you select in the Modify 

Auto Calculation when the system is in a state of freeze or live. 

• Live: Auto calculation activates when the system in a state of live.

• Freeze: Auto calculation activates when you press Freeze.

• Off

Table 5-8:  Doppler Mode Controls (Continued)

Control

Adjusts 

Acoustic 

Output Description/Benefit
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Auto Doppler Assist

Auto Doppler Assist automatically positions and steers Color 
Flow ROI and PW Cursor. This to feature is available on all 
linear probes. Available in Color Flow, Color Flow + PW (Triplex 
and non-Triplex). 

To use Auto Doppler Assist, position the cursor in the Color Flow 
ROI (the Color Flow ROI has to include the vessel of interest, or 
part of it). Press the appropriate Touch Panel Auto control 
(shown below) or press the Auto control to the left for Color Flow 
or to the right for Pulsed Wave. Manual map the “Auto” controls 
via Utility--> User Configurable Key.   

Figure 5-13. Auto Doppler Assist

Upon pressing the Auto Doppler Assist button, the system will 
automatically: 

• Pick the artery or vein (depending on the selected 
application). 

• Center the Color Flow ROI on the vessel of interest. 

• Steer with the direction of the vessel. 

• Keeps the Sample Volume in the middle of the ROI. 

• Steers the PW Cursor (if existing) to maintain the angle 
correct set by the operator under Auto Correct on the Utility 
--> Imaging --> PW --> Angle Correct. 

NOTE: If the angle is set to zero, then the system uses 60 degrees. 
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Using 3D

Overview

Easy 3D is compatible with every 2D transducer using a 
freehand acquisition to generate a volume dataset.

3D Volume datasets are allowing the navigation in the 3D cube 
itself and providing access to the 3 different main planes – axial, 
sagittal and coronal.

There are three 3D Packages: 

DANGER
 

DO NOT use the Volume Navigation feature on any patient 
relying on life-sustaining electronic equipment, such as a 
pacemaker or defibrillator. Failure to follow this instruction 
could lead to interference with patient electronic device(s).

Table 5-9:  3D Package Options

3D Type Description Sensor/No Sensor

Easy 3D Designed for rendering B Mode 

and Color Flow Mode images, 

e.g., Baby Face scans.

No sensor

Advanced 3D Designed for rendering B Mode 

and Color Flow Mode images, 

e.g., vessel trees. 

No sensor

Tru3D Designed for rendering B Mode 

and Color Flow Mode images, 

e.g., vessel trees. 

Sensor
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3D Acquisition

Acquiring a 3D Scan

To acquire a 3D scan, 

1. Optimize the B-Mode image. Ensure even gel coverage.

2. Press the 3D/4D control panel key. Two screens appear. 

3. Set appropriate values for Acq Mode and Scan Plane. Also, 
set the scan distance before scanning. 

• Acquisition mode

Sensorless Parallel is for all acquisitions done with the 
linear probes and on regular shapes, where you can 
move the probe parallel on the skin.

Sensorless Sweep is for the sweep acquisition using the 
curved probe (i.e. intercostal liverscan or kidney).

• Scan Distance

The Scan Distance is an indicator for the size of the 
Volume: Have you acquired longer distance than 6 cm, 
increase the Scan distance. Have you acquired a 
shorter distance than 6 cm, decrease the Scan 
distance. For sweep acquisition 6 means a transducer 
angulation of around 60°.

4. To start acquiring the image, press Start (Trackball key). 

5. To perform a parallel scan, scan evenly. To perform a sweep 
(fan) scan, rock the probe once. Note the distance of the 
scan. 

6. The 3D volume of interest (VOI) is dynamically assembled 
on the right side of the screen.

NOTE: If the image stops before you’re done scanning, start 
acquiring the 3D volume of interest again. 

7. To complete the 3D scan, press End (Trackball key). 

NOTE: You can also press Freeze, but then you need to also press 
the 3D key to obtain the final render. 
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Acquiring a 3D Scan  (continued)

3D Notes

• Adjust the 3D dataset brightness with B-Mode or Color Flow 
Mode Gain. 

• Use Colorize to change the color of the active dataset. 

• Use Zoom to increase the zoom factor of the active dataset. 

• Vertical lines may be seen in a resliced image. This usually 
happens when you scan too fast or if the scan distance is 
set to a high value.

Scan more slowly, adjust the frame rate for a faster rate or 
adjust the scan distance.
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3D Acquisition Parameter Description

Figure 5-14. 3D Acquisition 

Table 5-10:  3D Acquisition Description and Instructions for Use

3D Parameter Description

App (Application) Presets Selections: None, OB - Baby Face, Vascular, User 1, User 2, User 3

None. No application preset applied. 

OB - Baby Face. After having scanned in this mode, certain rendering 

parameters are set automatically. The gray surface mode is activated and the 

texture mode is switched off. The gray surface mode values for opacity and 

threshold are set automatically according to the datasets histogram. 

Vascular. Available only with Advanced 3D or Tru 3D package. After having 

scanned in this mode, certain rendering parameters are set automatically. 

The color image is rendered in the texture mode. The values for opacity and 

threshold of the texture mode are set automatically according to the datasets 

histogram. The B-Mode image is rendered in the gray surface mode. Opacity 

and threshold values are defined according to the histogram. 

Delete Active User Preset Select to delete a user preset (User 1, User 2, or User 3).
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NOTE: The selection of user presets is effective only while 3D mode is 
active. Exiting 3D mode and activating 3D mode again resets 
the 3D presets to the default setting, regardless if Patient or 
application changes.

NOTE: Changing the tab between [Easy] and [Adv3D] changes some 
parameters that are not common between those tabs.

NOTE: When a 3D image is recalled, no 3D presets are active and 
parameters are recalled from the image file.

NOTE: Default Scan Distance, Opacity and Threshold may not be 
consistent and may change per scan. After the User Preset is 
saved and recalled, Opacity and Threshold are consistent.

Acquisition Mode Selections: Sensorless Parallel, Sensorless Sweep

Sensorless Parallel. In this mode the probe must be moved during 3D data 

acquisition without angling it. You should scan the object you want to render 

in 2-4 seconds. The speed at which you scan should be constant. No sensor 

is mounted on the probe. 

• Since the time for post-processing depends on the acquired number of 

frames, it is recommended that you check the frame rate. Low frame rates 

result in fewer acquired frames for the 3D dataset which results in intensive 

post-processing (interpolation). Therefore, low frame rate = long 

post-processing. 

Sensorless Sweep. In this mode the probe must be moved to a position 

where you can clearly see a middle cut of the object you want to scan and 

render. Tilt the probe to about 30 degrees until the object you want to scan 

disappears. Start the acquisition and tilt the probe over a distance of around 

60 degrees until the object disappears again. The entire scan time should be 

around 2-4 seconds. During the sweep, the probe may not be moved parallel, 

just tilted. No sensor is mounted on the probe. 

Before starting an acquisition, take care that the transmitter is positioned 

correctly during data acquisition and that the transmitter cannot move. 

Scan Plane Selections: Front to Back, Side to Side

Front to Back. After having scanned in this mode, the rendered dataset is 

shown in a frontal view. For acquiring a fetal face in sagittal cuts, use this 

mode. 

Side to Side. After having scanned in this mode, the rendered dataset is 

shown from a side view. For acquiring a fetal face in coronal cuts, use this 

mode. 

Display Format 50/50 Only 

2D

50/50. Display in Dual Image (2D and 3D). 

Only 2D. Display in Single Image.

3D Starts the rendering process. 

Scan Distance Adjusts the distance covered during the scan. Depending on the real width of 

a scan acquired during a sensorless 3D acquisition, the volume of interest’s 

width can be enlarged or reduced. You can adapt the form of a fetal face if 

the baby’s head looks oval instead of round. The assumed default width of a 

parallel scan is 6 cm; or a fan scan 60 degrees. 

Table 5-10:  3D Acquisition Description and Instructions for Use (Continued)

3D Parameter Description
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Manipulating the Volume of Interest

Imagine you are able to manipulate the 3D volume of interest 
(VOI) in your hand. The 3D VOI is a tangible anatomical object 
that you can see and manipulate easily using the Trackball and 
Set control panel keys. 

Practice positioning the pointer at different places within the 3D 
VOI. Highlight different colors (white, red, yellow, or green). 
Press Set to select a VOI for manipulation. Use the hand to 
manipulate the 3D VOI. 

Table 5-11:  Manipulating the Volume of Interest

Procedure Example

Rotating the 3D VOI Left/Right or Forward/Backward

You can rotate it left to right or right to left. You can rotate it 

forward/backward. Press right Set key when the white pointer 

finger is positioned on the white box. Move the closed white 

hand to manipulate the 3D VOI. 

Moving Through the 3D VOI

You can move through the 3D VOI using the red hand. Press 

Set when the red pointer finger is positioned on the red box. 

Move the closed red hand to move through the 3D VOI. 

Note: Any plane in the volume can be made active (highlighted 

with red box) by clicking on it. 
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Viewing Specific Portions of the Anatomy

You can pull back tissue to view specific portions of anatomy 

using the yellow hand. Press Set when the yellow pointer finger 

is positioned on the yellow box. Move the closed yellow hand to 

manipulate the 3D VOI. 

Note: This actually moves an edge. A yellow hand appears only 

when the pointer is on an edge of the VOI. 

Pulling Back a Corner of the VOI to View Specific Anatomy

You can pull back a corner to view specific portions of anatomy 

using the green hand. Press Set when the green pointer finger 

is positioned on the green box. Move the closed green hand to 

manipulate the 3D VOI.

Table 5-11:  Manipulating the Volume of Interest (Continued)

Procedure Example
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Easy 3D

Figure 5-15. Easy 3D 

Descriptions and instructions for using Easy 3D follow: 

Table 5-12:  Easy 3D Description and Instructions for Use

3D Parameter Description

Reset Resets the 3D volume of interest back to its original orientation. 

Utilities Select Average Off, Average Light, Average Medium, or Average Strong. 

Use smoothed volume for rending the 3D volume. 

Strong = Most Smoothing.

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees 

left and right around the actual image position (either the default position 

after acquisition or the position that was manually defined by manipulating 

the 3D volume of interest) is shown. For this 60 degree rotation, eleven 

images in steps of 6 degrees are calculated.

Save Preset Save as a user preset (User 1, 2, or 3).

Undo Undoes any manipulation you have done to your 3D dataset. 

Scalpel Structures, for example a part of the placenta hiding the view to a fetal face, 

can be cut out in a rendered image. All visible structures can be cut out.

The option of ‘erase inside’ deletes all structures inside the marked region. 

The option of ‘erase outside’ deletes all structures outside the marked region. 

The region in the rendered image is marked with the right Set key. To define 

the contour of the region, press the right Set key for each vertex. To close the 

contour, double click the right Set key. As long as a contour is not closed, it 

can be traced back with the left Set key. The cut out process can be undone 

by the Undo Last function. 

As soon as the Apply button is pressed, a new dataset is generated. 

Gray Surface Activates the gray surface rendering mode. It leads to a transparent 

appearance of the object, generated by displaying only a surrounding shell of 

structures. 
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Texture Activates the texture or photorealistic rendering mode. It creates a 

photorealistic appearance of the object. The shading depends on the 

orientation of the surface of the object. 

If both Texture and Gray Surface mode are switched on, the mixture 

percentage of both modes can be defined. 

Render Changes between the rendered image view and the view of a volume of 

interest. The volume of interest shows the acquired ultrasound images 

transformed into an isotropic rectangular coordinate system. The volume of 

interest can be manipulated as described above. 

Orientation Marker You can now specify/define, then add the following orientation markers while 

in 3D via the Orientation Marker key:

• TRV Sup to Inf

• TRV Inf to Sup

• SAG Lt to Rt

• SAG Rt to Lft

• Defined

• None

Threshold/Opacity Threshold defines which gray values are used for rendering and which are 

considered noise. Opacity defines how strict Threshold is used for 

discrimination. A low opacity value creates a firmer appearance of the 

surface. A high opacity value leads to a transparent appearance of the 

rendered image. 

Scan Distance Adjusts the distance covered during the scan. Depending on the real width of 

a scan acquired during a sensorless 3D acquisition, the volume of interest’s 

width can be enlarged or reduced. You can adapt the form of a fetal face if 

the baby’s head looks oval instead of round. The assumed default width of a 

parallel scan is 6 cm; or a fan scan 60 degrees. 

Colorize/Contrast Colorizes the 3D render or adds contrast to the 3D rendered image. 

Table 5-12:  Easy 3D Description and Instructions for Use (Continued)

3D Parameter Description
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Advanced 3D

Figure 5-16. Advanced 3D 

Descriptions and instructions for using Advanced 3D follow: 

Table 5-13:  Advanced 3D Description and Instructions for Use

3D Parameter Description

Tile The display can be divided into 1, 2, 4, or 6 windows. Switching to a lower 

number of windows keeps the images from left to right. 

3D Landscape Shows a combination of 2D slices and a 3D rendered image. After a color 

acquisition you can combine the 2D B-Mode image slices with a 3D rendered 

color image. This mode allows stepping through the B-Mode images along a 

vessel structure. 

The 2D slice can be moved with the right Set key. The Trackball symbol has 

to be positioned inside the 2D plane. 

Active Data Manipulations of rendering parameters only have an effect on the data 

defined as Active Data. After having selected Active Data, a list of data is 

displayed, Gray Data or Inversion. Choose the data to be manipulated.

Active Data is only available when you select both Inversion and Gray Data 

in Visible Data.

NOTE: Inversion Mode is only available for Black-and-White mode. 

Visible Data After selecting Visible Data, a list of data is displayed, Gray Data or 

Inversion. Choose the data you want to display. For example, if only 

Inversion is chosen, the B-Mode image is switched off in the rendered image 

and only inversion mode is displayed. 

Define Axis For certain display and measurement modes (Angular Plane Mode, Angular 

Volume Measurement Mode), an axis in the volume of interest is required. To 

define the axis, set the start point by using the Trackball to position one end 

of the axis and pressing the right Set key, then positioning the other end of 

the axis and pressing the right Set key. 
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Group Planes Selections: Off, Main, Parallel, Angular

Off. A VOI or a rendered image is displayed. The Render button changes 

between the rendered image view and the view of the VOI. The VOI shows 

the acquired Ultrasound images transformed into an isotropic rectangular 

coordinate system. 

Main. Three orthogonal cuts (with colored frames) of the acquired VOI are 

displayed after pressing Main. The VOI shows the acquired ultrasound 

images transformed into an isotropic rectangular coordinate system. 

On the left top of the image a complete VOI is displayed. It shows the 

position of the three orthogonal planes in the VOI. A green point displayed in 

each plane defines the point of intersection of the three planes. This point 

can be set to different positions in the planes by double clicking the right Set 

key. A plane can be moved parallel in the VOI by pressing the right Set key 

on the position of the green point and moving the Trackball up and down 

inside the plane. 

Parallel. In this mode all displayed VOIs get the orientation of the last 

modified volume. Normally four VOIs are displayed. It is possible to display 

six VOIs by increasing the number of displayed volumes in the Tile area. 

Between the first and the last VOI, the selected planes are parallel and 

equidistant. A modification on the plane in one VOI results in a parallel 

modification of the planes in all other VOIs. 

Angular. Before starting the Long Axis Rotation Mode, make sure that a long 

axis has correctly been defined in the VOI (see Define Axis above). The 

function starts in the long axis display mode. In the upper, left-hand corner a 

short axis cut is shown which gives an overview of the orientation of the long 

axis planes. 

To move these planes, press and hold down the right Set key while moving 

the Trackball. 

Type 1/2 Defines the rendering modes. Selections: Gray Surface, Texture, Maximum 

Intensity, Minimum Intensity, Average Intensity, and None. If both Type 1 and 

Type 2 rendering modes are switched on, the mixture of both modes can be 

defined.

Gray Surface. Activates the gray surface rendering mode. It leads to a 

opaque appearance of the object, generated by displaying only a 

surrounding shell of anatomical structures. Adjust Threshold and Opacity as 

well. 

Texture. Activates the texture of photorealistic rendering mode. It creates a 

photorealistic appearance of the object. The shading depends on the 

orientation of the surface of the object. Adjust Threshold and Opacity as well. 

Maximum Intensity. Transparent appearance of the object. Generated by 

displaying the maximum gray values in the VOI. 

Minimum Intensity. The rendered image is generated by displaying the 

lowest gray values in the VOI that exceed the defined threshold. Dark 

anatomical structures, like cysts, can be shown in this mode. 

Average Intensity. Transparent appearance of the object. Generated by a 

summation of the gray values. 

None for Type 2. No second rendering mode is used in addition to the Type 

1 rendering mode. 

Render Changes between the rendered image view and the view of a volume of 

interest. The volume of interest shows the acquired ultrasound images 

transformed into an isotropic rectangular coordinate system. The volume of 

interest can be manipulated as described above. 

Table 5-13:  Advanced 3D Description and Instructions for Use (Continued)

3D Parameter Description
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Reslice Cube. The VOI shows the acquired ultrasound images transformed into an 

isotropic rectangular coordinate system. This mode allows you to work 

simultaneously with six cut planes. 

Virtual Rescan. The marked cut planes under Reslice Cube (red border) is 

displayed without any perspective distortions, e.g., parallel to the screen. 

This allows you to move through the volume one slice at a time in any 

direction.

Cubic Plane. Only one cut plane view is shown in a perspective displayed 

VOI. The cut plane can be moved freely without any limitations. 

Table 5-13:  Advanced 3D Description and Instructions for Use (Continued)

3D Parameter Description
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Movie 3D

Figure 5-17. Movie 3D 

Descriptions and instructions for using Movie 3D follow

Table 5-14:  Movie 3D Descriptions and Instructions for Use

3D Parameter Description

Manual

Define Start/End

An animated rotation of the rendered image can be calculated and displayed 

by this function. Using this function, you first need to define the start and end 

position of the rotation. To define this, move the VOI to the start position, the 

press Define Start. Move the VOI to the end position and press Define End. 

Movie 360 Degrees The calculation and display of a complete rotation around the axis, defined by 

the Axis button, starts in steps of 15 degrees. 

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees 

left and right around the actual image position (either the default position after 

acquisition or the position that was manually defined by manipulating the 3D 

volume of interest) is shown. For this 60 degree rotation, eleven images in 

steps of 6 degrees are calculated.

Axis All rotations (Auto Move and Movie 360) are calculated as rotations around 

the specified axis (X, Y, or Z). 

Movie Speed You can adjust the speed of any 3D rotation. 

Pause Stops and restarts the rotation. As soon as Pause is pressed, the different 

rotation steps can be displayed by moving the Trackball. 
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Tru3D and Volume Measurement 

Figure 5-18. Tru3D 

Descriptions and instructions for using Tru3D are the same as 
noted in the Advanced 3D section. See Table 5-13 on page 5-60 
for a description of these controls.

Performing a Sensor Scan

To perform a sensor scan, 

1. Attach the sensor cables to the front of the Ultrasound 
system. 

2. Attach the probe bracket to the probe, unless using a VNav 
Inside (VN) probe. 

Insert the receiver into the bracket on the probe. 

3. Position the magnet near the patient, within 18 inches of the 
probe, next to the patient on the bed. 

4. On the Touch Panel, select With Sensor.

5. Acquire the 3D scan. 
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Tru3D

Table 5-15:  Tru3D Descriptions and Instructions for Use

3D Parameter Description

Acquisition Mode With Sensor. Only available if you are using the Tru 3D package. In this 

mode the probe can be moved in different ways over the object you want to 

render. The probe can be moved parallel and angled during the same 3D 

acquisition. The sensor system registers any movement. It is recommended 

not to move in one direction and back again during one scan. It is also not 

recommended to turn the probe around its axis. The scanning speed does 

not have to be constant, but you should not change the velocity too much. In 

this mode the sensor has to be mounted on the probe. 

Before starting an acquisition, take care that the transmitter is positioned 

correctly during data acquisition and that the transmitter cannot move. 

The transmitter has to be placed in such an orientation that the probe with the 

receiver attached is always in the forward hemisphere of the transmitter 

during scanning. 

The patient MAY NOT move during the acquisition. 

The sensor device consists of an electromagnetic field transmitter and a field 

receiver. The field transmitter generates an alternating spheric 

electromagnetic field in a strength of up to five times the earth’s magnetic 

field, depending on the distance between the transmitter and the receiver. 

For 3D data acquisition, the probe with the attached position sensor can be 

moved freely in an area of 70 cm around the transmitter. 

During data acquisition, the electromagnetic sensor device generates with a 

frequency of about 100 Hz a set of three translation and three angle values. 

These values describe the position of the ultrasound probe in space. 
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Magnetic field range from the transmitter

Figure 5-19. Magnetic field range from the transmitter

NOTE: Remove the metal product from the region of the magnetic field 
to increase accuracy of position detection.

From the center of the transmitter,

1. 30cm above and below

2. 28cm left and right

3. 20 - 66cm forward
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Volume Measurement

The average measurement error for distance measurements is 
5% and for volume measurements is 10%.

Workflow example

NOTE: If you print out a Volume Measurement image with a B/W printer 
or store it onto the Clipboard, change the following presets 
before performing the Volume Measurement. On the Utility -> 
Connectivity -> Button preset menu in the Volumes section, 
choose Volume File Format* = 2 - Standard DICOM with Raw 
Data and in the Still Images section, choose Format = 
Secondary Capture Image.

1. Scan in 2D-mode. Select Auto Sweep. Acquire and store 
the image.

2. Recall Image. Activate 3D/4D.

3. Select Vol. Meas Tab. Select Angular Method.

Figure 5-20. 3D Volume Measurement

NOTE: Angular method is intended for spherical objects. Serial 
method is intended for rectangular objects.
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Volume Measurement  (continued)

4. Define the axis and press Enter.

5. Six cut planes are displayed. You measure the volume by 
marking the contour of the anatomy.

6. When all traces are completed, the system displays the 
volume in the Results Window.

Measurement examples are shown below: 

Figure 5-21. 2D Measurement (Example)

Figure 5-22. Example of Segment Method

Figure 5-23. Example of Angular Method
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Volume Measurement  (continued)

Table 5-16:  Volume Measurement Descriptions and Instructions for Use

3D Parameter Description

2D Type of 2D measurement: Distance, Angle, Circumference, Area

Distance. Set the start and end distance using the right Set key. 

Angle. An angle is measured by marking two lines. Press the right Set key 

once marks the beginning of the first line. Press the right Set key again to 

mark the end of the first line and simultaneously the beginning of the second 

line (the intersection of two lines). Press the right Set key a third time to close 

the angle measurement. 

Circumference. The circumference of an area is measured by marking the 

contour of the anatomy by a polygon contour. Each point of the polygon is 

marked by pressing the right Set key. A double click of the right Set key 

closes the circumference. As long as the contour is not finished, each point 

can be deleted by a single press of the left Set key. 

Area. An area is measured by marking the contour of the anatomy by a 

polygon contour. The area of an area is measured by marking the contour of 

the anatomy by a polygon contour. Each point of the polygon is marked by 

pressing the right Set key. A freehand contour can be drawn by pressing and 

holding down the right Set key and moving the Trackball. Double click the 

right Set key to complete the area. As long as the contour is not finished, 

each point can be deleted by a single press of the left Set key. 

Angular Method This function allows you to mark any volume of interest in the dataset to 

measure its volume or to perform a segmentation of the object. 

The volume of a 3D object is determined by drawing the contour in several 

planes, which are rotated around an axis defined by the user. The contours 

are used to calculate the volume of the object. 

To determine the volume of an object based on the multiplanar Simpson rule, 

you need to define the rotation axis via Define Axis. 

When you press Angular Method, six cut planes are displayed. The Long 

Axis is marked in blue. You measure the volume by marking the contour of 

the anatomy. The contour can be marked in different ways: Polygon, Spline, 

Ellipse, Rectangle, or Rotate. 

Polygon. Each point of the polygon is marked with a single press of the right 

Set key. A freehand contour can be drawn by pressing and holding down the 

right Set key and moving the Trackball. Double click the right Set key to 

complete the area. As long as the contour is not finished, each point can be 

deleted by a single press of the left Set key. 

Curve. An area can be marked by single points positioned by pressing the 

right Set key. A double click on the right Set key closes the spline. The 

position of the points defining the contour can be changed by clicking on the 

point and moving it by pressing the right Set key and using the Trackball. As 

long as the contour is not finished, each point can be deleted by a single 

press of the left Set key. 
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Angular Method Ellipse. When you select this mode, a circle is displayed. You can move the 

circle by pressing and holding down the right Set key while moving the circle 

with the Trackball. Press the right Set key to set the chosen position. To 

manipulate the shape of the circle, move the edges of the circle while 

pressing the right Set key. 

Rectangle. When you select this mode, a rectangle is displayed. You can 

move the rectangle by pressing and holding down the right Set key while 

moving the rectangle with the Trackball. Press the right Set key to set the 

chosen position. To manipulate the shape of the rectangle, move the edges 

of the circle while pressing the right Set key.

Rotate. Using the rotate function, you can rotate an area around the Z axis. 

When you select this function, the Trackball symbol changes as soon as it is 

positioned to an edge of a region. The region can then be rotated by pressing 

and holding down the right Set key. 

A region can be selected and deleted by pressing the Clear key.

To save a measurement, press Save Segment, Save to Report, or Cancel. 

Serial Method The Serial Method allows you to mark any volume of interest in the dataset to 

measure its volume or perform a segmentation of the object. 

A volume definition is done by defining areas at different depths. 

Before starting the volume measurement, you need to select a plane showing 

a cut in which the object can be clearly defined. When you press Serial 

Method, the display window shows two different views. The left side displays 

the active plane as a single plane. The VOI on the right side is displayed in 

cubic mode. 

In the right VOI select the cut plane position where the measurement process 

should start. In the left plane, mark the object of interest by designating one of 

the area definition modes (Curve, Ellipse, Rectangle, Polygon, Rotate). 

After you have completed defining the first area, the depth of the VOI should 

be changed on the right side. To change the depth, position the Trackball 

symbol inside the plane to be moved. press and hold down the right Set key 

while moving the Trackball backwards. By defining the contour of an object at 

different depths, its volume can be calculated by summing up the defined 

slices.

To save a measurement, press Save Segment, Save to Report, or Cancel. 

Define Axis For certain display and measurement modes (Angular Plane Mode, Angular 

Volume Measurement Mode), an axis in the volume of interest is required. To 

define the axis, set the start point by using the Trackball to position one end 

of the axis and pressing the right Set key, then positioning the other end of 

the axis and pressing the right Set key. 

Save Segment After measuring a volume, you can use the defined volume for segmentation 

by pressing Save Segment. Segmentation means that a new dataset is 

created with voxel information based on the defined volume. A dataset 

containing only voxels inside the measured volume is created. The original 

dataset is saved additionally to the segmented data. The segmented data 

can be chosen in the Active Data or Visible Data list. 

Save to Report After measuring a volume, press Save to Report to register the measurement 

result in a database that is used for report generation. 

Table 5-16:  Volume Measurement Descriptions and Instructions for Use (Continued)

3D Parameter Description
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Chapter 6

Scanning/Display Functions

Describes additional ways in which to adjust the image. 
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Freezing an Image

Introduction

Freezing a real-time image stops all movement and allows you 
to measure and print the image.

NOTE: While the image is frozen, all Power Output is suspended. 

Freezing an image

To freeze an image, 

1. Press Freeze. The Freeze key backlight turns blue. 

If you are in a mixed mode, both screen formats stop 
immediately. Deactivating Freeze restarts both modes and 
places a black bar on the trace to indicate the time discontinuity. 

To reactivate the image, 

1. Press Freeze again. 

NOTE: Selecting a new probe unfreezes the image

NOTE: Deactivating Freeze erases all measurements and calculations 
from the display (but not from the worksheet). 

 Use the Trackball to start CINE after pressing Freeze. 
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Using CINE

Introduction

CINE images are constantly being stored by the system and are 
available for playback or manual review via CINE. 

You can view CINE as a continuous loop via CINE Loop or 
manually review CINE images frame by frame via the Trackball. 

Data in CINE is available until new data is acquired. CINE is 
stored on the system's memory and can be archived as well. 

CINE is useful for focusing on images during a specific part of 
the heart cycle or to view short segments of a scan session. 

Cine gauge

Figure 6-1. Cine gauge

1. Loop speed

2. Cine gauge

3. Current frame number/total frame number

The cine gauge indicates which frame you are viewing of the whole loop. 

4. Current number of seconds/total number of seconds

The cine gauge indicates which frame you are viewing of the whole loop. 

5. Start frame

6. End frame
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Touch Panel

The following Touch Panel appears: 

Figure 6-2. Cine Touch Panel

Table 6-1:  Cine Touch Panel description

Parameter Description

Select All Select all frames of the cineloop.

Sync Mode Phase synchronizes multiple cineloops.

Num Cycles Control the number of heart cycles to be included in the cineloop.

First Move to the first frame of cineloop.

Last Move to the last frame of cineloop.

Run/Stop Start/Stop the cineloop review.

Loop Speed Adjust the cineloop playback speed.

Cycle Select Select the heart cycle to review.

Start Frame Rotate the rotary to select the start frame and push to set the frame.

End Frame Rotate the rotary to select the end frame and push to set the frame.

Frame by Frame Review the cine image frame by frame manually.

Capture Searches through all images between the start frame and end frame and 

displays each peak or the highest velocity/tissue power.

Capture Recon. Capture Recon. reconstructs small blood vessels in the cine mode.

Enhancement Execute the enhancement to the Cine capture image. Select Off, Shade FW, 

Shade Rv, Enhance1, Enhance2 or Enhance3.

Motion Correction Motion correction compensates each frame and cancels the motion.
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Using CINE

NOTE: Preset the parameters as necessary.

1. Press Freeze.

2. Move the Trackball to activate Cine.

3. Use the trackball or Frame by Frame to scroll through the 
acquisition and find the sequence of interest.

4. Press Start Frame or End Frame to set the corresponding 
cineloop boundary to the current frame as necessary.

Rotate Start Frame and End Frame to trim or expand the 
cineloop boundaries.

5. Adjust Cycle Select to move from heart beat to heart beat 
and select the heart cycle of interest.

6. Adjust Num cycles to select the number of heart beats to 
play back.

7. Press Run/Stop to run the cineloop and then press the print 
key to store the cineloop.

Cine loops stored on the clipboard are indicated with a 
movie strip icon.

8. Press Run/Stop again to stop the cine loop. 

9. Press Freeze to return to live scanning.

NOTE: If you don’t need edit, only press Run/Stop to run the cineloop 
and print key to store. 

NOTE: Cineloop storage can be configured to store heart cycles with 
additional time before and after the R-wave and to display a 
preview before storage.See ‘Print Controls’ on page 10-48 for 
more information.

Adjust the cine loop speed

Rotate Loop Speed to set the speed of the cineloop playback.

The speed factor (%) is displayed above the cine gauge.

To view a cineloop frame by frame

In freeze, use the trackball or Frame by Frame to scroll through 
the cineloop frame by frame.
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Synchronize cine loops

1. Recall stored cine loop to right side of dual screen.

2. Recall same cine loop to left side of dual screen.

3. Change visualization of left side image

4. Select Sync mode to start the synchronization.

NOTE: This is useful for Hybrid Contrast to display and check Contrast 
and Hybrid Contrast for example. 

Recalling a cine loop

To recall a cine loop, double click on the cine loop on the 
clipboard. 

NOTE: CINE Loops stored on the Clipboard are indicated with a movie 
strip icon.

Cine Mode Selection

To scroll the B-Mode cine loop only, toggle the top Trackball key 
and select Scroll B.

To scroll the Timeline cine loop only, toggle the top Trackball key 
and select Scroll D.

Velocity Scale with B-Mode Only

If you review the B-Mode cine loop while in Doppler Mode with 
the Timeline using Scroll B, the Velocity Scale displayed with the 
Timeline is for the time phase of the currently-displayed B-Mode 
image, NOT for the time phase of the acquired Doppler 
Spectrum. 

Check the velocity value with the measurement function if you 
review the cine loop using Scroll B. Note that there may be a 
discrepancy between the velocity scale displayed and the 
velocity measured using the measurement function. 
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Mark CINE

Preset

1. Check Enable Mark Cine Control via Utility -> 
Application -> Print Controls. 

Figure 6-3. Mark Cine on Print Control

2. Press Save.

How to use

1. Press Mark Cine to specify the starting point for loop storing 
or cine review.

When you press Mark Cine, the current image frame is 
noted as a start frame.

2. Press the appropriate print key while continuing to live scan 
to store the cine loop.

NOTE: The Mark CINE control on the Trackball key is available while 
live scanning in non-timeline modes (B-Mode, B-Flow and Color 
Flow Mode). 

NOTE: Selecting Mark CINE when a Mark CINE already exists causes 
the new Mark CINE to replace the previous one. 

NOTE: Changing modes or other actions that flush CINE memory 
causes the Mark CINE to be removed and the image data will 
not be saved. 

NOTE: A Print button can be configured to store a Single Image during 
Mark Cine, without stopping the Cine loop. 

Table 6-2:  Mark Cine

Preset Parameter Description

Enable Mark Cine Control Lets you mark where you want the CINE Loop to start (prospective CINE).

Preview Loop Longer 

than...(s)

When selected, allows you to review cine loops before storage for loops 

longer than selected time frame (in seconds).
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Preview

Loop Preview can be enabled independently for Time-Based 
Store, ECG-Based Store, and Mark CINE. This is useful for 
setting preview preferences based on the application. 

NOTE: The Contrast Time Span setting overrides the Time Span when 
in Contrast Mode. 

Background Store

Live Clips are stored in the background to allow you to continue 
scanning. This works for both Raw Data and for DICOM Loops 
(with Direct Store On or Off). Image Ordering is preserved with 
Background Store. 

The benefit of Background Store is that clips are stored with 
minimal interruption to live scanning. 

NOTE: Background Store IS NOT supported with V Nav, 4D, or with 
previously-acquired CINE Loops. 

NOTE: The system may stop acquisition while storing if CINE memory 
is at least 80% full. Monitor CINE memory while storing CINE 
loops to ensure continuous live scanning.

NOTE: DICOM loops take significantly longer to store. Storage time 
may approach or exceed loop time. Allow extra space in CINE 
memory when saving DICOM loops. 

NOTE: The CINE gauge turns purple to indicate the section of CINE 
memory that is being stored in the background. 
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Image Storage Hints

HINTS Setup Tips

• Print Button Setup is Application specific. When you 
access Application--> Print Controls, the current 
Application is the default Application. 

• To apply the same Print Control Settings for all 
Applications, select All Applications as the preset on the 
Print Controls Menu. Be sure to re-enter values if the field 
is green. 

• Print button setup for the file format and destinations are 
still configured via the Connectivity Menus. 

HINTS Usage Tips

• If you select Mark CINE, the next time you press Print 
completes the Mark CINE Loop Store, independent of its 
configuration. 

• The CINE gauge turns green when a Prospective CINE 
Clip is pending. 

• You can cancel Prospective Store by pressing Freeze/
Unfreeze or by changing Modes. 
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Cine Capture 

Selecting Capture searches through all images between the 
start frame and end frame and displays each peak or the highest 
velocity/tissue power. Adjust the start frame and end frame 
points to limit the image frames used in the process.

1. Display the CINE loop which is in memory or recalled from 
archive.

NOTE: Cine Capture applies only to 2D images (B, B Flow, CF, PDI, 
Contrast, etc.).

NOTE: On 2D duplex modes (B/CF, B/PDI, etc.), Cine Capture is 
not applied to the background B-Mode image, even if the 
CF/PDI display is turned off.

2. Run the cineloop.

3. Select Capture on the Touch Panel to display the captured 
image.

A character 'C' displays on the screen instead of the frame 
average level.

4. If necessary, save the captured image.

5. Press Capture again to turn Cine Capture off.

NOTE: Cine Capture can be used on exported files by using the Save 
As function. You can save the still image (jpeg) and cine loop 
(avi) by using Save As.

NOTE: Cine Capture does not effect TIC Analysis.
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Capture Recon. 

Description Capture Recon. reconstructs small blood vessels in the CINE 
mode.

It is available in B-Flow, Contrast, CF, PDI, and B-Mode without 
CrossXBeam.

Capture Recon. shows smaller blood flow information than 
conventional B-Flow image, which expected for the 
characterization of tumor, chronic liver disease, vascular 
abnormality, etc.

Procedure 1. Scan B-Flow mode in the ordinary way, except:

Sensitivity can be larger (20 (default) to 30 or more).

2. Acquire a short clip, then freeze.

• Combination of Capture helps to imagine resulting 
image.

• 3-dimensional sweep may be efficient to visualize many 
vessels.

3. Press Capture Recon on the CINE Touch Panel. Adjust 
threshold as necessary.

4. The order of the frames is rearranged by order of smaller 
artifact. The frame which has motion artifact is rejected. 
Move the Trackball or assigned rotary to review the image 
Frame by Frame.

NOTE: While the Capture Recon, is activated, the color of CINE gauge 
turns pink.
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Enhancement

Enhancement executes the enhancement process to cine 
capture images.

1. Display the cine capture image using Capture.

NOTE: Enhancement applies only to Cine Capture images.

2. Select Enhancement. A character 'C' displays on the 
screen instead of the frame average level.

• Shade Fw/Shade Rv

Select Fw (Forward) that brings start frame or Rv 
(Reverse) that brings last frame of cine to the front. The 
system has two thresholds for the Shade process. 
Comparison will be made frame by frame after the 
thresholds have been met. If the two thresholds are 
satisfied, no comparison will be made with the rest of 
the frame.

Using Shade Fw/RV, lower intensity echoes in the near 
frame will be masked by higher intensity echoes in the 
far frame. ShadeFw/Rv makes it possible to show lower 
intensity echoes in the near frame despite the fact that 
there may be a higher echo projection in the far frame. 
Therefore, the anteroposterior position of the blood 
vessel is clearly displayed.

• Enhance1/Enhance2/Enhance3

The part corresponding to the data of the selected frame 
is enhanced and superimposed on the entire cine 
capture images. This allows you to visualize the spatial 
relationships with the B-Mode image and the flow 
appearance.

Figure 6-4. Enhancement image example

3. If necessary, save the enhanced image.

NOTE: You can save the still image (JPEG) and cine loop (WMV) 
by using Save As.
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Motion Correction

Understanding of the vascular structure is important, for 
example, with liver cancer. Though, the captured image distorts 
or blurs due to the patient’s breathing. Motion correction 
compensates each frame and cancels the motion.

NOTE: Motion Correction is activated only for B, CHI, Contrast and 
B-Flow.

1. Displays the cine capture image using Capture.

2. Select Motion Correction. The system generates the 
captured image with motion correction.

The user can store the cine clip with the state of motion 
correction kept in the raw data.

The user can store the still image as the single frame 
DICOM image without the raw data.
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Image Zoom

Overview

There are three kinds of zoom on the system: Pan Zoom, HD 
Zoom and Magnification Zoom.

• HD Zoom only acquires the image data within the ROI, 
increasing the density of the image in the ROI. Image 
adjustments can only be performed during live scanning.

• Pan Zoom magnifies the display of the data within the ROI 
without making any changes to the ultrasound image data 
acquired. The entire image is acquired and the ROI can be 
adjusted (moved and resized).

• Magnification Zoom magnifies the entire image on the 
screen (non-ROI zoom).

Location of Zoom Control

Figure 6-5. Zoom Control Knob
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HD Zoom

In HD Zoom, the Ultrasound line density and/or sampling 
frequency increases, resulting in higher resolution. HD Zoom 
can be performed on live images. 

1. To activate HD Zoom, push the Zoom control knob inward 
while scanning live.

NOTE: If already in Magnification Zoom, push the Zoom control 
knob inward to first turn off Magnification Zoom, then push 
again to activate HD Zoom.

Press the top trackball key to select Size for change ROI 
size or Pos for change ROI position. 

Use the trackball to position the zoom area over the desired 
portion of the image.

2. To exit HD Zoom, push the Zoom control knob inward 
again. 

NOTE: When HD Zoom is on and the image is live, the right 
trackball button toggles from HD Zoom to Pan Zoom.

Bioeffect

HD Zooming an image changes the frame rate which tends to 
change thermal indices. The position of the focal zones may 
also change which may cause the peak intensity to occur at a 
different location in the acoustic field. As a result, the MI (TI) 
may change.

Acoustic
Output
Hazard

Observe the output display for possible effects. 



Scanning/Display Functions

6-16 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Pan Zoom

Pan Zoom can be performed on a live, frozen, CINE or recalled 
raw data image.

1. To activate Pan Zoom (when frozen or in CINE) push the 
Zoom knob inward. 

Press the top trackball key to select Size to change ROI size 
or Pos to change ROI position. Use the trackball to change 
the ROI size or position the zoom area over the desired 
portion of the image.

2. To deactivate Pan Zoom push the Zoom control knob 
inward again.

NOTE: When Pan Zoom is on and the image is live, the right 
trackball button toggles from Pan Zoom to HD Zoom.

Figure 6-6. Zoomed Image Example

1. Zoom Image

2. Reference Image: Reference image is the small un-zoomed image.

3. Zoom ROI: Zoom ROI indicates the region of the image to zoom.

4. Pos/Size: Use the top trackball key to change position and size of ROI.
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Magnification Zoom

Magnification Zoom magnifies the entire image on the screen 
(non-ROI zoom). 

1. To activate Magnification Zoom, rotate the Zoom control 
knob clockwise.

2. There are three ways to deactivate Magnification Zoom:    

• Press Mag Zoom Rest on the trackball button.

• Rotate the Zoom control value to 0.

• Activate B-Mode (push the B-Mode button on the Front 
Panel).

Panning in Magnification Zoom

While in Magnification Zoom, you can pan the image across the 
screen. 

1. Press the Top Trackball button to highlight the Position 
Indicator “Pos.”

Figure 6-7. Position Indicator

2. Move the Trackball to pan the image across the screen.
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Split Screen

Overview

LOGIQ Fortis supports the following multiple image format:

• Dual (split the window area into 2 areas)

• Wide Dual (split the window area into 2 areas, but wider 
than the normal dual)

• Quad (split the window area into 4 small areas)

This is useful, for example, when measuring AFI of OB. 

• Simultaneous (Dual) (split the module window into 2 areas, 
with both panes live and active)

NOTE: Recalled dual/quad images can be edited.

Dual screen

1. Press L to activate a dual screen. The single image is 
placed on the left side.

NOTE: When you activate the dual screen by pressing L, the single 
image is placed on the left side; when you activate by 
pressing R, the single image is placed on the right side.

2. Press R. The left side image is freezed and the image 
displays in the right side. 

3. Press Freeze to freeze the image of the right side.

4. Press Freeze again to unfreeze the active image which has 
the gray bar under the image.

To switch between active images, press L or R.

5. Press B-mode key to return to the single screen.

NOTE: To put a copy of the image on the opposite side when entering 
dual split screen, use the “When Entering Dual Image” preset 
found on Utility --> Application --> Settings preset page. 



Split Screen

LOGIQ Fortis – Basic User Manual 6-19
5855997-1EN Rev. 3

Quad screen

1. Press and hold down L to activate a quad screen. The 
single image is placed on the upper left.

NOTE: When you activate the dual screen by pressing L, the single 
image is placed on the left side; when you activate by 
pressing R, the single image is placed on the right side.

2. Press R. The left side image is freezed and the image 
displays in the upper right. 

3. Press Freeze.

4. Press Freeze again to unfreeze the image which has the 
gray bar under the image.

Press L or R to move the gray bar to the image of the left 
side or the right side.

5. Press B-mode key to return to the single screen.

Simultaneous mode

While using CFM or PDI, press L and R keys simultaneously to 
display B and B+CFM, or B and B+PDI in real-time on the left 
and right side.

It is useful to observe the ROI in B-Mode.

NOTE: Simultaneous mode can also be used within B-Mode to view 
with (Right) and without CrossXBeam (Left) if CrossXBeam is 
turned on. 

Dual Caliper

In split screen, you can draw a caliper, area, ellipse, or spline 
trace on both the left and right image at the same time. 
Whichever side of the screen that you annotate is called the 
“Original” graphic. The copy is called the “Shadow” graphic. 

This feature is available in the following modes: 

• B-Mode:B-Mode

• Color Flow Mode:Color Flow Mode

• B-Mode:Color Flow Mode

• Simultaneous Mode. 

• Contrast

• Elastography

• Volume Navigation
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Dual Caliper  (continued)

NOTE: Dual Caliper IS NOT available in B-Mode: B/PW Mode or in 
B-Mode:B/M Mode, or with different probes. 

Figure 6-8. Original (Left), Shadow (Right)

NOTE: Only the Original graphic contains the graphic numbering. In this 
way you can always distinguish between the Original and the 
Shadow graphic. 

NOTE: You can only edit the Original graphic; however, when you do 
edit the Original graphic, the Shadow graphic is also edited at 
the same time. 

NOTE: If you delete either graphic, both are deleted. 

NOTE: When a measurement is selected without Dual B-Mode images 
or with different probe images, a warning message is displayed 
on the status bar and the selected measurement is cancelled. 

NOTE: If the first point of the Original graphic is out of the Shadow 
image area, then a warning message displays on the status bar 
and the Shadow graphic is not drawn. 

NOTE: The Trackball move area is limited to the narrow area of both 
images. 

NOTE: You cannot take a measurement across dual images. 

NOTE: The 2D Dual measurement tool cannot be copied. 
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Dual caliper for 2D image

2D Dual Caliper / 2D Dual Area / 2D Dual Ellipse / 2D Dual 
Spline Trace / 2D Dual Circle are not available through the 
factory default. To enable these measurements, add a new 
measurement using “2D Dual Caliper”, “2D Dual Area”, 2D Dual 
Ellipse”, “2D Dual Spline Trace” or “2D Dual Circle” tool in the 
Utility--> Measure--> M&A preset menu. 

1. Select Blank from Add measurement.

Figure 6-9. Add Measurement

2. Select appropriate dual caliper tool from Tool drop-down 
menu.

Figure 6-10. Drop-down menu

3. Type the measurement and parameter name as you like.

4. Add the created measurement to the Touch Panel.

5. Display the dual image and press Measure.

6. Select an added measurement from the Touch Panel to 
enable the appropriate measurement. A caliper displays.

NOTE: When the measurement is selected without dual B images 
or with different probe images, a warning message displays 
on the status bar and the selected measurement is 
cancelled.
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Dual caliper for 2D image  (continued)

7. To position the caliper at the start point, move the Trackball.

You can use both images as an original image.

NOTE: If the first point of the original graphic is out of the shadow 
image area, then the warning message displays on the 
status bar and the shadow graphic is not drawn.

8. To fix the start point, press Set. The caliper changes to an 
active caliper. 

NOTE: Only original graphic has graphic numbering to distinguish 
between original image and shadow image.

NOTE: The trackball move area is limited to the narrow area of both 
images.

NOTE: Only the original graphic can be edited. When the original 
graphic is edited, the shadow graphic is also updated.

9. To complete the measurement, press Set. The system 
displays the measurement result in the Results Window.

Dual Caliper for V Nav

1. Check Dual Caliper on VNav in Utility -> System -> System 
Measure. Only available distance, area, trace and angle 
measurement for V-Nav.

NOTE: You cannot measure on the recalled image.

NOTE: Measure is available on the cine image shortly after freezing 
the image; however, you cannot measure on recalled 
images. 

2. Select the measurement via the Trackball key for a live scan 
image. Select the measurement from the Measurement 
Type table for Volume data.   

NOTE: Numbers are only displayed on the live scan image.

3. If you want to measure live scan and volume data 
separately, select Off for Dual Caliper using the Touch Panel 
key. 

NOTE: After the Dual caliper measurement, graphics and measurement 
results are removed from the Volume dataset when you press 
Measure. 

NOTE: If you use Zoom after the Dual caliper measurement, graphics 
and measurement results are removed. 
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Annotating an Image

Introduction

The comment function provides the capability to type the 
comments of free text and/or insert the pre-defined comments 
from the comment library. It also provides the user with arrow 
markers to point to parts of the image.

Pressing the Comment key or any keys on the alphanumeric 
keyboard initiates the comment mode. This assigns the 
Trackball function to controlling the cursor and displays the 
comment library on the Touch Panel menu.

Figure 6-11. Comment Key on the Front Panel

In comment mode, text can be added by using the comment 
library or by typing from the alphanumeric keyboard.

Comments can be erased by powering down, when you press 
Clear or New Patient, or when preset via Utility -> Comments. 
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Introduction  (continued)

In addition, the display’s home position can be changed 
(preferred comment area) for each display so that all 
subsequent comments begin in the same spot.

To return to the user specified position or factory default 
position, press the F7 (Cursor Home) key or the Home control 
on the Annotation Touch Panel (see Figure 6-13 on page 6-29).

To establish a new cursor home position, place the cursor in the 
desired position and press Shift+F7 or press and hold the Home 
control on the Annotation Touch Panel.

Comment Mode is activated by pressing the Comment key. 
Comment Mode can also be automatically activated by typing 
from the alphanumeric keyboard.

NOTE: In this case, the cursor begins at the same location where the 
comment mode was exited.

After activating the comment mode, a vertical bar type cursor 
appears on the screen. Use the Trackball to move the cursor.

The factory default color for comments is yellow. The color 
selection can be changed to any of the colors available on the 
system. The choices are white, yellow, bright red, orange, etc.

NOTE: The user cannot change the Font Family. 

To indicate a specific comment or text group is selected, the 
color turns to blue. Once the comment is set or fixed, the color 
returns to yellow or to the user selected color.

On the Touch Panel annotations have been color-coded for easy 
replacement or to easily add annotations. See Annotation 
Groupings below. 

To delete comments by character, press the Backspace key.

To delete all comments and arrow marks, press the Clear key 
twice immediately after entering the comment mode. 

To exit the Comment/Library Comment function, press the next 
function you wish to do. 

To move by words or by text group, press the Tab key.
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Adding Comments to an Image

Comment Retention

Comments from the B-Mode images are retained and carried 
over when switching to multi-image format or duplex mode.

The position of the comments is adjusted so that it is at the 
same relative position with respect to the display window in the 
new format as it was in the single image format.

NOTE: Comments may not be retained when the image is switched to 
M-Mode image format depending on the preset. 

Arrow Pointers

Arrow pointers can be used by activating the F2 (Arrow) key on 
the keyboard or by selecting the Arrow control on the 
Annotation Touch Panel (see Figure 6-13 on page 6-29). When 
the pointer comes up, it is a blue color, indicating it is active and 
can be moved.

• Move the pointer using the Trackball to any place on the 
screen. The pointer head direction can be controlled by 
movement of the Trackball or Arrow Rotate control.

• To readjust the length and thickness of the pointer, use the 
Arrow Resize rotary control. The default for the pointer size 
can be preset.

• Press Set to fix the place of the pointer and direction of the 
pointer head. The blue color turns to yellow (or the default 
color if changed).

• To delete the arrow marks, press the Clear key right after 
pressing the F2 (Arrow) key or press and hold the Arrow 
control on the Annotation Touch Panel.

NOTE: To prevent the Trackball from changing the arrow angle, select 
the “Keep arrow angles” preset at Utility -> Annotation -> 
Comments.



Scanning/Display Functions

6-26 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Text Overlays

There are 2 layers of the text in comments, which can be 
selected by toggling the F8 (Text1/Text2) key on the keyboard 
or by selecting the Comment Layer Switch control on the 
Annotation Touch Panel (see Figure 6-12). Text1 is the default 
choice.

Figure 6-12. Comment Layer Switch Control

By using this function, users can perform a HIDE TEXT/SHOW 
TEXT, allowing the users to save or print an image without 
clearing the typed text.

You can specify to display text 1, text 2, or both. This allows you 
to have some comments that do not change during the exam 
while allowing you to change the other comment. Toggle the F8 
key or Comment Layer Switch control to cycle through the 
three Text 1/Text 2 states: 

1. Text 1 Only -- Only Text 1 comments displayed and editable. 

2. Text 2 Only -- Only Text 2 comments displayed and editable.

3. Text 1 and Text 2 -- Both displayed; only Text 2 comments 
editable. Only Text 2 comments erased by Clear key. Word 
Delete only deletes Text 2 comment. Both Text 1 and Text 2 
comments erased with new patient, new exam, or probe 
change. 

To preset the Text Overlay Sequence, go to Utility -> 

Comment -> Comment and select either Text 1 and Both or 
Text 1 and Text 2 and Both. 
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Text Overlays  (continued)

The font color for the Text1 and Text2 overlays can be set 
separately. Go to Utility -> Comment -> Comment and specify 
the text color for Text 1 Color and Text 2 Color.

NOTE: If you check “Erase when image is unfrozen” in the Utility menu, 
only the editable text plane erases when you unfreeze the 
image. 
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Annotating an Image Using the Library

To reduce the amount of time spent annotating an image, store 
frequently-used comments in the Comment Library. As many as 
6 libraries are available per study. One of the selected libraries is 
designated as the default and its entries shall be displayed on 
the Touch Panel when the comment mode is activated for that 
study.

Press Comment and move the comment cursor location using 
the Trackball.

Select the desired comment from the Touch Panel.

Each Touch Panel key can also be configured to hold a small list 
of up to 3 comments. The first word in the list is displayed on the 
Touch Panel and the others can be accessed by toggling the key 
or pop-up menu. To show the presence of a small list stored 
under a particular key, a small indicator (>) is placed on the key.

To program your system with specific comments, see 
‘Comments Libraries Presets’ on page 10-32 for more 
information.
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Annotating an Image by Comment Groupings

Comments can be grouped together for ease of annotating. For 
example, in the figure below there are blue, yellow, and green 
groups. 

Figure 6-13. Annotation Touch Panel

When you select comments with a different color, the selected 
comment is added to the existing comment. In the example 
below, Right was selected from the blue group of comments. 
Trans was selected from the yellow group, so it was added to 
the first comment. Bowel was selected from the green group, so 
it was also added.   

 Figure 6-14. Added Comments (Different Color Groups)
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Annotating an Image by Comment Groupings  (continued)

When you select comments with the same color, the selected 
comment is overwritten with the new comment. In the example 
below, Bowel was selected from the green group of comments, 
but then Appendix was selected from the same green group, so 
it replaced Bowel. 

 Figure 6-15. Replaced Annotation (Same Color Group)
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Annotating an Image by Comment Groupings  (continued)

You can configure these Comment color groupings via Utility--> 
Comments--> Libraries (up to 5 groups). Groups are organized 
by color. Position the cursor over the rectangular region to the 
left of the annotation to display the group drop-down selection 
menu, then select the color that matches your grouping. 

NOTE: You can also group annotations by dots (: and .). Dots are for 
color blindness recognition in groupings.  

Figure 6-16. Tagging a Group Color to an Annotation

The configured comments are displayed on the Touch Panel. 

Figure 6-17. Color-Tagged Annotation Touch Panel
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Rearranging Touch Panel Comments

You can easily move comments to a new location by selecting 
the annotation and moving it to the new, empty location. 

NOTE: You cannot move a comment to a location with a comment. The 
new location must be empty. 

Table 6-3:  Moving Touch Panel Annotations

Step Example

1. Position the cursor 

over the annotation 

you want to move. In 

the example, we are 

going to move “Left” to 

a cell to the right. 

2. Hold and drag the 

“Left” annotation to the 

new cell; in this case 

the empty cell to the 

right. 

3.  Release the cursor 

when you have the 

annotation positioned 

in the new cell 

location. Then Save 

and Exit the Utility 

Page. 
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Annotating an Image with Typed Words

• Press Comment and type the comments where the cursor 
is currently located (the display's home position) and use 
the Trackball to further place the comment cursor in the 
desired location.

• Press Enter to move to the next line.

NOTE: Comments wrap to the next line when they are within one 
character of the right margin if Word Wrapping is selected in the 
Text Boundary preset. See ‘Comments Libraries/Comments 
Preset Menu’ on page 10-35 for more information.

The word wrap starts one line below the start of that comment.

Comments appear on all prints, photos, DVR or CINE loops.

Figure 6-18. Next Line Word Wrap

If the cursor appears at the right edge of the lowest line, or a 
word cannot be completed in the lower right corner, word wrap 
cannot be executed.

NOTE: The same word wrap principles apply for library scripts as typed 
comments.

1. Before 2. After

1 2

WORD WRAP WORD

WRAP
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Moving Text

You have the ability to move comments already on the screen 
and place them in different locations.

• Place the cursor on the desired text or text group and press 
Set.

• The selected text color turns to green.

• Use the Trackball to move the selected text and press Set.

Editing While Annotating

Backspace over any error(s) made. Blank spaces take the place 
of the letter(s) that were there. Continue typing the comment 
after backspacing over all incorrect letters.

To delete previous character(s):

• Press Backspace as many times as necessary to make the 
deletion. 

• Once all texts within the selected text group are deleted, 
then the cursor will find another text group to delete to the 
upper left direction. 

• If there is no more text to delete, the cursor will be located at 
home position.

• To delete all comments and arrow marks, press the Clear 
key twice immediately after entering the comment mode.

To move through the text a word at a time:

• Press Tab to move to the right by text group (Preset 
Keyboard Tab = Word)

NOTE: Press Shift + Tab to move to the left.

To activate the last text group typed or selected from the Library:

• Press F9 (Grab Word) key. The selected comment will be 
highlighted.

• To increase/decrease the area of the highlighted selection 
use HIGHLIGHT rotary.

NOTE: Once the text is highlighted, typing comments or choosing 
them from the library replaces the highlighted text. 

NOTE: To select all text groups, Press Shift + F9 (Grab Word) key.

To cancel the last action:

• Press Undo key.
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Body Patterns

An additional way to annotate the image display is with body 
patterns. Body patterns are a simple graphic of a portion of the 
anatomy that is frequently scanned. The body pattern and probe 
marker can serve as a reference for a patient and probe 
positioning when images are archived or scanned.

1. Press Bodypattern/Ellipse. Body patterns specific to the 
current application are displayed.

Figure 6-19. Body Pattern/Ellipse Control

2. Touch the body pattern to insert. The selected body pattern 
with a probe marker is displayed on the scanning screen.

3. Using the trackball, adjust the position of the probe marker.

4. Rotate Body Pattern/Ellipse to set the probe marker 
orientation.

5. To move the body pattern:

• Press Move Pattern.

• Move the bodymark to a new location with the trackball.

• Press Set to anchor the bodypattern to the new location.

6. Press Set on the keyboard or Scan on the Touch Panel to 
exit without erasing the body pattern.

7. To clear the body pattern, press the Body Pattern/Ellipse 
control to activate body patterns and then press the Clear 
key. 

The body pattern packages may be customized to 
accommodate user preference. Up to 30 individual body 
patterns in the packages can be changed. See ‘Body Pattern 
Libraries/Applications Preset Menu’ on page 10-44 for more 
information.
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Body Patterns  (continued)

Figure 6-20. Touch Panel displays of Body Pattern - example

To select the active side in dual B-Mode, use the Active Side 
rotary control at the bottom of the Touch Panel.

You can use the Zoom control to select the body pattern. If you 
want to assign the select function to the Zoom control, see See 
‘Body Pattern Libraries/Libraries Preset Menu’ on page 10-41 
for more information.. 

Table 6-4:  Control Touch Panel

No. Function Description

1. Move Pattern Each Touch panel key can also be configured to hold a small list of up to 3 

comments. The first word in the list is displayed on the Touch Panel and 

the others can be accessed by toggling the key.

To program your system with specific comments, see ‘Creating a small list’ 

on page 10-37 for more information.

2. Save Position Move the body pattern to the desired location and press the Save 

Position. Current position of Body Pattern is saved as a Home Position of 

current display format. 

Hold down Save Position to reset the home position to factory default. 

3. Save Probe Position Rotate the arrow. 

You can also rotate the arrow by Trackball.

4. Probe Type The probe mark type is selectable by rotating the Probe Type control on 

the Touch Panel. There are different choices available with one being a 

blank selection.
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Notes for Body Pattern (Probe mark)

• Probe Type is the type of probe mark displayed on the body 
pattern. It can be saved only for each body pattern on the 
Touch Panel while body pattern is activated, but not in the 
Utility preset menu. Therefore, Probe Type cannot be saved 
as an Application or System Preset.

To save the Probe Type, 

a. Activate the Body Pattern.

b. Select a Body Pattern on the Touch Panel.

c. Select a type of probe mark with the Probe Type Touch 
Panel key.

d. Place the probe mark at the proper location.

e. Select the Save Probe Position Touch Panel key.

NOTE: “Save Probe Position” saves both the Probe Mark position 
and Probe Type.

• When a Body Pattern is selected and no Probe Mark has 
been saved on it, the latest used Probe Mark is carried over 
to the Body Pattern. 



Scanning/Display Functions

6-38 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Notes for Body Pattern (Probe mark)  (continued)

• Check the Body Pattern on the Touch Panel if the Probe 
Mark does not appear on the monitor.

Figure 6-21. Body Pattern Touch Panel

1. When the Probe Mark is saved for the Body Pattern, the Probe Mark is 

displayed in yellow on the Touch Panel and should also be shown on the 

monitor. 

2. When the Probe Mark is saved with “Probe Type - None”, the Probe Mark 

is displayed in gray on the Touch Panel and is not shown on the monitor. 

Reselect an appropriate Probe Type and save as necessary.

3. When the Probe Mark is not saved, no Probe Mark is displayed either on 

the Touch Panel or the monitor. Select an appropriate Probe Type and 

save as necessary.
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Body Patterns  (continued)

 Figure 6-22. Body Patterns Available

1. abdo 1

2. abdo 2

3. abdo 3

4. abdo 4

5. aorta

6. arm 1

7. arm 2

8. arm 3

9. arm 4

10. arm 5

11. arm 6

12. arm 7

13. arm 8

14. arm 9

15. arm 10

16. body 1

17. body 2

18. body 3

19. body 4

20. body 5

21. body 6

22. body 7-Lt

23. body 7-Rt

24. body 8-Lt

25. body 8-Rt

26. body 9

27. body 10

28. body 11-Lt

29. body 11-Rt

30. body 12

31. breast 1

32. breast 2

33. breast 3

34. breast 4-Lt

35. breast 4-Rt

36. breast 5-Lt

37. breast 5-Rt

38. breast 6-Lt

39. breast 6-Rt

40. breast 7-Lt

41. breast 7-Rt

42. breast 8-Lt

43. breast 8-Rt

44. breast 9-Lt

45. breast 9-Rt

46. carotid 1

47. carotid 2

48. carotid 3-Lt

49. carotid 3-Rt

50. carotid 4

51. carotid 4-Lt

52. carotid 4-Rt

53. carotid 5

54. chest 1

55. fetus 1

56. fetus 2

57. fetus 3

58. fetus 4

59. fetus 5

60. fetus 6
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Body Patterns  (continued)

 Figure 6-23. Body Patterns Available (continued)

61. fetus 7

62. fetus 8

63. fetus 9

64. fetus 10

65. fetus 11

66. fetus 12

67. fetus 13

68. fetus 14

69. fetus 15

70. fetus 16

71. foot 1-Lt

72. foot 1-Rt

73. foot 2-Lt

74. foot 2-Rt

75. foot 3-Lt

76. foot 3-Rt

77. foot 4-Lt

78. foot 4-Rt

79. foot 5-Lt

80. foot 5-Rt

81. foot 6-Lt

82. foot 6-Rt

83. foot 7-Lt

84. foot 7-Rt

85. foot 8-Lt

86. foot 8-Rt

87. foot 9-Lt

88. foot 9-Rt

89. hand 1

90. hand 2

91. hand 3-Lt

92. hand 3-Rt

93. hand 4-Lt

94. hand 4-Rt

95. hand 5-Lt

96. hand 5-Rt

97. hand 6-Lt

98. hand 6-Rt

99. hand 7-Lt

100. hand 7-Rt

101. head 1

102. head 2

103. head 3

104. head 4

105. head 5

106. heart 1

107. heart 2

108. heart 3

109. heart 4

110. heart 5

111. heart 6

112. heart 7

113. heart 8

114. heart 9

115. heart 10

116. heart 11

117. legs 1

118. legs 2

119. legs 3

120. legs 4
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Body Patterns  (continued)

 Figure 6-24. Body Patterns Available (continued)

121. legs 5

122. legs 6

123. legs 7

124. legs 8

125. legs 9

126. legs 10

127. legs 11

128. legs 12

129. legs 13-a-Lt

130. legs 13-a-Rt

131. legs 13-Lt

132. legs 13-Rt

133. liver

134. neck 1

135. neck 2

136. neck 3

137. neck 4

138. neck 5

139. ob 1

140. ob 2

141. ob 3

142. ob 4

143. ob 5

144. ob 6

145. organ 1

146. organ 2

147. organ 3

148. organ 4

149. organ 5

150. organ 6

151. organ 7

152. organ 8

153. organ 9

154. pelvis 1

155. pelvis 2

156. post-breast-bilateral

157. post-breast-Lt

158. post-breast-Rt

159. rheuma

160. shoulder-back-Lt

161. shoulder-back-Rt

162. shoulder-front-Lt

163. shoulder-front-Rt

164. thyroid

165. twin 1

166. twin 2

167. twin 3

168. twin 4

169. twin 5

170. twin 6

171. twin 7

172. twin 8

173. uro 1

174. uro 2

175. uro 3

176. uro 4

177. uro 5

178. uro 6

179. uro 7

180. uro 8
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Body Patterns  (continued)

 Figure 6-25. Body Patterns Available (continued)

181. uro 9 female 

182. uro 9 male

183. uro 10 female-Lt

184. uro 10 female-Rt

185. uro 10 male-Lt

186. uro 10 male-Rt

187. uro 11

188. uro 12

189. uro 13-Lt

190. uro 13-Rt

191. uterus 1

192. uterus 2

193. uterus 3

194. ankle-Lt

195. ankle-Rt

196. ankle lat-Lt

197. ankle lat-Rt

198. ankle post-Lt

199. ankle post-Rt

200. arm-Lt

201. arm-Rt

202. arm post-Lt

203. arm post-Rt

204. elbow-Lt

205. elbow-Rt

206. elbow lat-Lt

207. elbow lat-Rt

208. elbow post-Lt

209. elbow post-Rt

210. foot-Lt

211. foot-Rt

212. foot lat-Lt

213. foot lat-Rt

214. forearm-Lt

215. forearm-Rt

216. forearm post-Lt

217. forearm post-Rt

218. hand-Lt

219. hand-Rt

220. hand post-Lt

221. hand post-Rt

222. head

223. head lat-Lt

224. head lat-Rt

225. head post

226. hip-Lt

227. hip-Rt

228. hip lat-Lt

229. hip lat-Rt

230. hip post-Lt

231. hip post-Rt

232. knee-Lt

233. knee-Rt

234. knee lat-Lt

235. knee lat-Rt

236. knee post-Lt

237. knee post-Rt

238. leg-Lt

239. leg-Rt

240. leg post-Lt
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Body Patterns  (continued)

 Figure 6-26. Body Patterns Available (continued)

241. leg post-Rt

242. shoulder-Lt

243. shoulder-Rt

244. shoulder lat-Lt

245. shoulder lat-Rt

246. shoulder post-Lt

247. shoulder post-Rt

248. thigh-Lt

249. thigh-Rt

250. thigh post-Lt

251. thigh post-Rt

252. wrist-Lt

253. wrist-Rt

254. wrist post-Lt

255. wrist post-Rt

256. new carotid 2

257. carotid2-Lt

258. carotid2-Rt

259. brain1

260. brain2

261. brain3

262. brain4

263. breastSA-Rt

264. breastSA-Lt

265. lung1

266. organ10

267. organ11
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Using the Fast Key

Overview

A keyboard Fast Key is available to record and run a sequence 
of often-run keystrokes.

NOTE: Ensure that you have a patient selected prior to running the Fast 
Key operation. 

Create a Fast Key 

1. Press the F5 key. The “Do you want to create the Fast Key?” 
dialog displays. Select OK to continue.

2. Select a key to assign a Fast Key to (a-z, 0-9).

If you select a Front Panel control, a Touch Panel key or any 
key besides a-z or 0-9, a warning dialog displays and the 
procedure is cancelled.

NOTE: Assign Fast Key Function to Key 0 - 9 in Utility -> System -> 
User Configurable Key before you create a Fast Key.

NOTE: There is no distinction between capital and small letters.

NOTE: The key code is the same in Russian and Greek (a-z, 0-9).

3. If the selected key is already assigned to a Fast Key, a 
warning dialog displays.

Select Yes to continue. The Fast Key file is overwritten.

Select No to cancel the Fast Key setup.

4. Input the key sequence to be assigned.

NOTE: It is impossible to save a power cycle sequence or any input 
from outside of the system.

NOTE: If a warning dialog displays due to the limitations of the 
number of key sequences, press F5 to finish and retry.

5. Press the F5 key to complete a Fast Key setup. The 
information dialog displays. Select OK.



Using the Fast Key

LOGIQ Fortis – Basic User Manual 6-45
5855997-1EN Rev. 3

Start a Fast Key

1. Press the F6 key to start a Fast Key. The message “Select 
the key which the Fast Key is assigned to” displays on the 
status bar.

NOTE: The F6 key is ignored if another dialog displays on the 
system.

NOTE: If you press F5 after F6, the F6 function cancels and the F5 
function is enabled.

2. Press the key assigned to the Fast Key macro. The 
message “Fast Key playback is finished” displays on the 
status bar when the macro is finished.

To stop the Fast Key during the operation, press F6. The 
message “Fast Key playback is cancelled” displays on the 
status bar.

NOTE: Select the running speed in the Run Fast Key Speed preset 
on Utility -> System -> General.

Backup and Restore the Fast Key

You can backup/restore the Fast Key via Utility -> System -> 
Backup/Restore.

To backup, select User Defined Configuration in the Backup 
section.

To restore, select User Defined Configuration in the Restore 
section.
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Chapter 7

General Measurements and
Calculations

Describes how to perform general measurements and 

calculations.
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Introduction

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by system accuracy, but also by the use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

WARNING The system provides calculations (e.g. estimated fetal weight) 
and charts based on published scientific literature. The 
selection of the appropriate chart and clinical interpretation of 
calculations and charts is the sole responsibility of the user. 
The authorized user should consider proper indications for the 
use of a calculation or chart as described in the scientific 
literature. The diagnosis, decision for further examination, and 
medical treatment must be performed by qualified personnel 
following good clinical practice.
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Basic Operation

Measure and Assign

1. Press Measure on the control panel.

2. Select the measurement tool via the upper trackball key. 

3. Perform the measurement. Follow the instructions displayed 
on the message area at the bottom of the screen.

4. To assign a label, select the measurement in the 
Measurement result window and press Set.

Figure 7-1. Label menu

5. Select the required label from the menu. For example, if it is 
a distance measurement, the list includes all distance 
calculations for the current study.

or

Select User Name from the menu. The dialogue window 
displays.

Enter the appropriate name and select OK.

Figure 7-2. Enter Measurement Name
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List of general measurements

The following types of general measurements are available 
when you press Measure but do not choose a specific 
calculation. The type of measurement depends on the current 
scan mode.

After pressing Measure, rotate between various measurement 
types with the upper Trackball keys.

B and CF Modes

• Dist (Caliper)

• Trace

• Spline

• Intensity

• Open Trace

• Open Spline

NOTE: You can preset the sequence of B and CF area measurements 
in the Measure Key Sequence (B/CF) preset in the Utility -> 
Measure -> Advanced screen. See the “M&A Advanced Preset” 
section for more information.

Doppler Mode

• Velocity

• Trace

• Slope

• Time

M-Mode

• Caliper

• Time

• Slope
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Assign and Measure

1. Press Measure on the control panel.

2. Select the measurement on the Touch Panel.

If you select the measurement folder, the sub menu tab is 
displayed. You can select and perform the measurement in 
the tab.

If the folder is configured with auto-sequence measurement, 
the next measurement in the study is pre-selected. To skip a 
pre-selected measurement, select another measurement.

3. Perform the measurement. Follow the instructions displayed 
on the message area at the bottom of the screen.
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Measurement Controls

Figure 7-3. Measurement Controls on the Control panel 

Table 7-1:  Measurement controls

Control Description

1. Cursor Pointer Key. Select to display a pointer on the monitor. 

2. Clear During a measurement sequence, erases the measuring caliper and 

measurement data from the display. When not performing a measurement 

sequence, clears all calipers and measurements from the display. To remove 

all annotations/body markers/arrows, hold down the Clear button. 

3. Annotation Annotations can be added to measurements on the image. 

4. Body Pattern Body patterns can be added to measurements on the image. 

5. Measure Activates a measurement caliper and the calculation package associated with 

the currently selected preset.

6. Zoom Rotary Zoom Rotary controls Pan Zoom, HD Zoom and Magnification Zoom. Pan 

Zoom magnifies the display of the data without making any changes to the 

ultrasound image data that is acquired. HD Zoom only acquires the image 

data within the ROI, and can only be performed during live scanning because 

of the acquisition adjustments that are done. When preset, you can adjust the 

Depth by moving the toggle up and down. If preset, you can scroll through the 

body patterns with the Zoom control. Magnification Zoom magnifies the entire 

image on the screen (non-ROI zoom). 

7. Trackball Moves the measurement calipers, selects the measurement on the Summary 

Window. Trackball also selects items on the Touch Panel with the Pointer and 

Set keys.

8. Trackball keys The functionality of these keys changes (for example, Set, Change Measure, 

etc.) depending on the mode or action. Current functionality is displayed on 

the lower-right corner of the monitor. 
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Touch Panel

B/M/Doppler Mode Select Tab

The B, M, or Doppler mode select tab key allows the user to 
select measurements associated with a particular mode of 
active study.

The system provides a default mode selection.

Figure 7-4. B-Mode - Example
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Exam Calcs Tab

The Exam Calcs Tab is used for selecting calculations from 
other study in the selected Exam Category.

Figure 7-5. Exam Calcs Tab - example

Selecting a measurement in a different application

While scanning a patient, you may find that you want to measure 
an item that is not in the current application. In that case, Exam 
Category allows you to select other calculations without 
changing application.

1. Select Exam Calcs in the measurement mode. 

2. Select Exam Category. 

3. Select the exam category that has the calculation you want 
to make.

4. Select the study and the desired measurement.

5. After you complete the measurement, to return to the 
original application, repeat steps 1–4.

NOTE: This measurement DOES NOT appear on the original 
application worksheet. 
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Options tab

The Options tab allows you to specify the following 
measurement and display options:

Figure 7-6. Measurement and Display Options - Example

Table 7-2:  Measurement and Display Options

No. Description

1. Select Hide Display to hide the Results Window and Summary Window. Hide Display on the Touch 

Panel key is lit.

To re-display them, select Hide Display again.

2. The system displays the following choices:

• 12 x 12

• 9 x 9

3. Select Heart Rate Cycle to change the number of cycles used in the calculation. The system 

displays a list of choices from 1 – 10.

4. You may want to change where the Results Window is positioned on the monitor display. To change 

the location of the Results Window, select Move Res Win. The system displays a list of choices.

5. Select Auto or Manual for Doppler Trace. 

• Auto – the system traces the Doppler waveform from the begin time to the end time. 

• Manual – trace the waveform manually.

6. After you press Set to complete the measurement, the dotted line remains on the display if the 

Show Caliper Line is selected.

If Show Caliper Line is not selected, the system erases the dotted line and only the measurement 

calipers with a number or symbol are displayed. 

Note: The Show Caliper Line on the Options tab takes precedence over the Cursor Line Display 

preset, found on the System -> System Measure screen.
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Push/Rotary button area

At the bottom of the Touch Panel, there are six (6) combination 
rotary dials/push buttons. The functionality of these rotaries 
changes, depending upon the mode, exam category, study, etc.

Side Rt/Lt

The system has measurements for the patient's right and left 
side. To change side, push or rotate the Side rotary button.

Delete

Delete active caliper.

Cursor select

When there are several measurements on the display, to rotate 
through and activate previously fixed calipers, push or rotate the 
Cursor Select rotary button.
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Exam category/Study/Measurement

For each patient, the system organizes information by exam 
category, study, and measurement. The definitions of these 
terms are as follows:

• Exam Category – categories include the following:

• Abdomen

• Obstetrics

• Gynecology

• Cardiology

• Vascular

• Urology 

• Small Parts

• Pediatrics

• Study/Preset – after you choose an exam category, the 
system allows you to select a study. For example, when you 
choose the Obstetrics exam category, you can choose one 
of the following studies:

• Generic

• OB-1

• OB-2/3

• OB-General

• Fetal Heart

• OB/GYN Vessel

• Measurement – the measurements and calculations 
needed to analyze an item of anatomy. For example, a 
femur length is a measurement. A measurement can 
include several pieces of measurement data. For example, 
to calculate the ovarian volume, you need to measure width, 
length, and height.
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General Instructions

General Guidelines

Any measurement can be repeated by selecting that 
measurement again from the Touch Panel.

The system retains all measurements, but the worksheet retains 
only the last six measurements of each type.

Measurement and calculation results

As you take measurements, each measurement is given a 
sequential number on the display and in the Results Window. 
The system can display nine measurements on the screen at 
one time. 

Once the Results Window has nine measurements, if you make 
any further measurements, the system erases the first 
measurement and adds the new measurement ("first in, first 
out").

Measurement graphics are kept while in cine scroll. The 
measurement graphic is redisplayed on the frame where it is 
taken, if preset “Keep Graphics with Cine Scroll” on the 
Advanced M&A page.

Selecting a calculation

When you take measurements, you can select the calculation 
before you take the measurement or after you take it. For 
example, in Obstetrics, if you select the calculation before you 
take the measurement, the estimated fetal age is displayed as 
you take the measurement. If you select the calculation after you 
take the measurement, the estimated fetal age is displayed after 
you complete the measurement.

NOTE: After you take a measurement, if you select a calculation and 
the measurement is not applicable for the calculation, then the 
system assumes you want to start the calculation. The system 
then uses the calculation for the next measurement.
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General Instructions  (continued)

Erasing measurements

These actions erase measurements from the system's memory: 

These actions you can take while performing measurements.

Calculation formulas are available in the Advanced Reference 
Manual.

HINTS • If you adjust the Trackball, unfreeze the image, or press 
Clear, the system erases all completed measurements and 
calculations on the display. Measurements and 
calculations, however, remain on the worksheets.

• If you select New Patient, the system erases all 
measurements and calculations on the display and clears 
the worksheets.

• If you make a new measurement that exceeds the 
maximum number of allowable measurements, the system 
erases the first (oldest) measurement and adds the new 
measurement.

• If the second caliper is active, to erase the second caliper 
and activate the first caliper, press Clear.

HINTS • Before making measurements, to stop the acquisition of 
image data, press Freeze.

• For measurements such as distance, to make fine 
adjustments before completing the measurements, press 
the top Trackball key to toggle between active calipers.

• Before completing the measurement sequence, to erase 
the active measuring caliper and the current data 
measured, press Clear.

• After the sequence is complete, to erase all data that has 
been measured to this point, but not data entered on 
worksheet pages, press Clear.

• When there are several measurements on the display, to 
rotate through and activate previously fixed calipers, adjust 
the Cursor Select knob. After a cursor is activated, you 
can change the measurement. 

NOTE: If you want to change a trace measurement, you 
must erase it and trace again.

• To repeat any measurement, select that measurement 
again from the Touch Panel.
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Measurement Cursor

While you are making a measurement, the measurement cursor 
is either active (open plus sign) or fixed (closed plus sign). An 
active cursor is green and a fixed cursor is yellow.

The system allows you to identify measurements by number or 
by unique symbol. The symbols are used in sequence as listed. 
The first symbol is used for the first measurement, the second 
symbol for the second measurement, and so on.

Figure 7-7. Fixed Caliper Symbols

Measurement graphics are kept while in cine scroll. The 
measurement graphic is redisplayed on the frame where it is 
taken, if preset on the Advanced M&A page.

Cursor preset

You can preset the measurement cursor in Utility -> System -> 
System Measure.

Figure 7-8. System/System Measure Preset Menu

Table 7-3:  Cursor 

Preset Parameter Description

Cursor Type Select whether to mark measurements with numbers or symbols.

Cursor Size Specify 12x12 or 9x9. 

Cursor Line Display If selected, after you press Set to complete a measurement, the cursor line is 

displayed. If not selected, after you press Set to complete a measurement, 

only the cursor number or symbol is displayed.

Cursor Ellipse Cross Line 

Display

Check box to display the cross line in Ellipse. 
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Copy, move and paste measurement tools

You can copy, move and paste the measurement graphic.

NOTE: This function is supported with trace, area trace, spline trace, 
volume trace, ellipse, 3-point ellipse, circle and intensity. The 
Double tools and Dual tools are not supported.

Copy and Paste

1. Measure the trace.

2. If present, clear the active caliper using the Clear key. Press 
the Arrow key to display the green arrow cursor on the 
screen. Move the cursor to the + mark of the measurement 
graphic. The selected graphic color changes from yellow to 
green.

3. Press Set. The pop-up menu displays. Select Copy.

Figure 7-9. Copy and Move Menu

4. Press Set on the outer side of the measurement graphic. 
The pop-up menu displays.

5. Select Paste. The copied graphic displays on top of the 
original graphic in green. Move it to the desired position 
using the Trackball and press Set to fix the location.

NOTE: If the copied graphic is bigger than the pasted area, "Paste"   
fails and "The copied graphic cannot be pasted to this area" 
message displays on the status bar.

D Manual Trace Cross 

Line Display

Check box to display the cross line with the caliper. 

Cursor Position Select 1st Cursor, 2nd Cursor, or Image Center. 

Color When Set (reboot) Select white, yellow, bright red, or orange. 

Cursor is Displayed when 

Trackball is Moved

The active cursor does not display until you move the Trackball. This 

assumes the following presets are set: Repeat Measurement, Repeat, 

Default Measurement, and Cursor. 

Table 7-3:  Cursor  (Continued)

Preset Parameter Description
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Copy and Move

1. Measure the trace.

2. If present, clear the active caliper using the Clear key. Press 
the Arrow key to display the green arrow cursor on the 
screen. Move the cursor to the + mark of the measurement 
graphic. The selected graphic color changes from yellow to 
green.

3. Press Set. The pop-up menu displays. Select Copy&Move.

4. The copied graphic displays on top of the original graphic in 
green. Move it to the desired position using the Trackball 
and press Set to fix the location.

Move

1. Measure the trace.

2. If present, clear the active caliper using the Clear key. Press 
the Arrow key to display the green arrow cursor on the 
screen. Move the cursor to the + mark of the measurement 
graphic. The selected graphic color changes from yellow to 
green.

3. Press Set. The pop-up menu displays. Select Move.

4. Move the selected graphic to the desired position using the 
Trackball and press Set to fix the location.

Performing Measurements on Saved Images

You can perform measurements on recalled images. Select the 
image, then perform the measurement. If the image was not 
saved as a raw DICOM image, you need to calibrate the image 
prior to performing the measurement. 

To calibrate the image,

1. Recall the image.

2. Press Measure. The Measurement Calibration Touch Panel 
appears.

3. Select the mode you need to be in to perform the 
measurement.

4. Press the appropriate mode key on the Touch Panel (2D 

calib for B-Mode, MM calib for M-Mode, or Dop. calib for 
Doppler mode). The specified mode calibration pop-up 
appears.
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Performing Measurements on Saved Images  (continued)

5. The system prompts you, depending on the mode.

B-Mode:

a. Place the first point of the caliper on the ruler. Press 
Set.

b. Position the cursor at the 5 cm point on the ruler. Press 
Set.

c. Type “5” into the 2D-Mode Calibration pop-up window. 
Press OK.

M-Mode or Doppler Mode:

a. Place the cross on zero depth and minimum or zero 
time. 

b. Place the cross on maximum depth and time. 

c. Type the time (in seconds) and velocity (cm/sec) in the 
M-Mode/Doppler Mode calibration pop-up window.
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Generic Measurements

Overview

Each exam category has a Generic study. The Generic studies 
provide you quick access to measurements such as volume, 
angle, A/B ratio, and % stenosis. The particular measurements 
available in each Generic study vary, depending on the exam 
category and the mode. This section describes generic 
measurements, organized by mode.

To access Generic studies:

1. On the Control Panel, press Measure.

2. On the Touch Panel, select Exam Calcs.

3. On the Touch Panel, select the Generic folder.

Calculation formulas are available in the Advanced Reference 
Manual.
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B-Mode Measurements

In B-Mode, the Generic study includes the following 
measurements:

• % Stenosis

• Volume

• Angle

• Velocity

• Stiffness

• V Ratio

• Stiff. Ratio

• A/B Ratio

Figure 7-10. B-Mode Generic Study

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.
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% Stenosis

You can calculate % Stenosis by diameter or by area, depending 
on the mode.

NOTE: The LOGIQ Fortis automatically activates the % Stenosis with 
the default selection. If another method is preferred, select it 
from the Touch Panel.

Diameter

NOTE: When you use diameter to calculate the %stenosis, always take 
the measurement from a cross-sectional view of the vessel.

To calculate percent stenosis by diameter:

1. From the Generic Touch Panel, select % Stenosis. 

2. Select %sten(Diam).

The system displays an active caliper.

3. Make a distance measurement of the inner area of the blood 
vessel. 

The system displays an active caliper for the second 
distance measurement.

4. Make a distance measurement of the outer area of the blood 
vessel. 

The system displays each distance measurement and the  
% Stenosis in the Results Window.

For details on how to make a distance measurement, See 
‘Distance measurement’ on page 7-39 for more information.

NOTE: For the diameter calculation, do NOT take a distance 
measurement from a longitudinal view. This may lead to an 
inaccurate assessment of % stenosis.
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% Stenosis  (continued)

Area

To calculate percent stenosis by area:

1. From the Generic Touch Panel, select % Stenosis. 

2. Select %sten(Area).

The system displays a caliper.

3. Make a trace measurement of the inner area of the blood 
vessel.

NOTE: To erase an open trace, move the Trackball.

4. Press Set.

The system displays a second caliper. 

5. Make a trace measurement of the outer area of the blood 
vessel.

The system displays the two area measurements and 
percent stenosis in the Results Window.

Ellipse + Area

To calculate percent stenosis by ellipse and area:

1. From the Generic Touch Panel, select % Sten[E+A] folder.

2. Ellipse is selected by default.

The system displays a caliper.

NOTE: You can select the trace at this time. 

3. Make an ellipse measurement of the inner area of the blood 
vessel.

4. Press Set.

The system displays a caliper. 

5. Make a trace measurement of the outer area of the blood 
vessel.

The system displays the two area measurements and 
percent stenosis in the Results Window.

NOTE: % Stenosis (E+A) is not available through the factory default. To 
enable %Stenosis (E+A), add “%Steno(E+A)” to the Measure & 
Study list on the Utility -> Measure -> M&A screen.
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Volume

The volume calculation can be made from any of the following 
measurements: 

• One distance

• Two distances

• Three distances

• One ellipse

• One distance and one ellipse

For details on how to make a distance measurement, See 
‘Distance measurement’ on page 7-39 for more information.

For details on how to make an ellipse measurement, See 
‘Circumference and area (ellipse) measurement’ on page 7-41 
for more information.

NOTE: IMPORTANT!! If you want to make a volume calculation using 
one or two distances, you must select Volume BEFORE you 
make the measurements.

NOTE: If you select Fix Caliper by Print Key on the Utility --> System --> 
System Measure, the print key does not function like the Set 
key, but instead ends the measurement sequence and initiates 
the volume calculation based on the number of measurements 
taken so far.

To make a volume calculation using one or two distances: 

1. Select Volume.

2. Make one or two distance measurements.

3. Select Volume.

The system displays the distances and the volume in the 
Results Window.

NOTE: Use the Clear key to erase the green caliper.
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Volume  (continued)

To make a volume calculation using three distances:

1. Make three distance measurements.

NOTE: Three distances can be done in the dual format mode (side 
by side images). One measurement is usually made in the 
sagittal plane and two measurements in the axial plane. To 
use the dual format mode, press the L or R key on front 
panel.

2. Select Volume.

The system displays the distances and the volume in the 
Results Window.

To make a volume calculation using one ellipse: 

1. Make one ellipse measurement.

2. Select Volume.

The system displays the ellipse measurement and the 
volume in the Results Window.

To make a volume calculation using one ellipse and one 
distance: 

1. Make one distance measurement and one ellipse 
measurement.

2. Select Volume.

The system displays the distance and ellipse measurement 
and the volume in the Results Window.

NOTE: If you change the parameters or category during the volume 
measurement, please follow the procedure below before you 
restart the measurement. 

1. Check the number of each measurement in the summary 
window.    

2. If the numbers are not all the same, it shows that you have 
the calculation which is not completed. Open the Worksheet 
and clear that calculation.   

HINTS • Volumes are most accurate when measurements are taken 
in the sagittal and axial scan planes.

• To display sagittal and axial plane images simultaneously, 
use the side-by-side dual format option.
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Volume  (continued)

Figure 7-11. Volume Calculation Examples

1. One distance

2. Two distances

3. Three distances

4. One ellipse

5. One distance and one ellipse

Calculation formulas are available in the Advanced Reference 
Manual.

Table 7-4:  Volume Calculations

Calc Name Input Measurements

Volume (spherical) One distance

Volume (prolate spheroidal) Two distances, d1>d2

Volume (spheroidal) Three distances

Volume (prolate spheroidal) One ellipse: (d1 major axis, d2 minor axis)

Volume (spheroidal) One distance d1, and one ellipse (d2 major axis, d3 minor axis)

1 2 3

4 5
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Volume  (continued)

Post-assignment for General Volume

You can input a unique name for the general volume 
measurement. You can group the general volume 
measurements for each application.

1. Complete the volume measurement.

2. Move the caliper to the measurement result box (with green 
frame) and select Set.

3. The volume name menu appears. Select Name Volume.

Figure 7-12. Volume Name menu

4. The dialog box displays. Enter a new name or choose the 
existing name.

Figure 7-13. Volume Name Dialog box

NOTE: The factory default volume name cannot be changed (for 
example, Renal Volume).
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Angle

This function measures the angle between two intersecting 
planes.

1. From the Generic Touch Panel, select Angle. 

The system displays an active caliper. 

2. To position the caliper at the start point, move the Trackball.

3. To fix the position of the first caliper, press Set.

The system displays a second active caliper.

4. To position the second caliper at the apex of the angle, 
move the Trackball.

5. To fix the position of the second caliper, press Set.

The system displays a third active caliper. 

6. To position the third caliper, move the Trackball. 

7. To complete the angle measurement, press Set.

The system displays the angle in the Results Window.

NOTE: To rotate through and activate previously fixed calipers, adjust 
the Cursor Select control.
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A/B Ratio

In B-Mode, you can calculate A/B ratio by diameter or by area.

NOTE: The LOGIQ Fortis automatically activates the A/B Ratio with the 
default selection. If another method is preferred, select it from 
the Touch Panel.

Diameter

1. From the Generic Touch Panel, select A/B Ratio. 

2. Select ratio(Diam). 

The system displays an active caliper.

3. Make a distance measurement of the first diameter. 

The system displays an active caliper for the second 
distance measurement.

4. Make a distance measurement of the second diameter. 

The system displays each distance measurement and the  
A/B ratio in the Results Window.

NOTE: The first distance is the A diameter. The second distance is the 
B diameter.

For details on how to make a distance measurement, See 
‘Distance measurement’ on page 7-39 for more information.

Area

To calculate A/B ratio by area:

1. From the Generic Touch Panel, select A/B Ratio. 

2. Select ratio(Area). 

The system displays a caliper.

3. Make a trace measurement of the A area.

NOTE: To erase an open trace, move the Trackball.

The system displays a second caliper. 

4. Make a trace measurement of the B area.

The system displays the two area measurements and the  
A/B ratio in the Results Window.

For details on how to make a trace measurement, See 
‘Circumference and area (trace) measurement’ on page 7-42 for 
more information.
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Dual Caliper

If “Dual Caliper on VNav and Simultaneous” is checked in 
Utility--> System--> System Measure menu, then when you 
enter simultaneous view, there is a “Dual Caliper: On/Off” setting 
on the Touch Panel. If the setting is on, dual caliper is enabled in 
simultaneous view. 

Figure 7-14. Dual Caliper

Velocity and Stiffness Ratios

If set to display via configuration settings, these two 
measurements appear. Refer to Elastography Option 
documentation. 
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M-Mode Measurements

In M-Mode, the Generic study includes the following 
measurements:

• % Stenosis

• A/B Ratio

• HR (Heart Rate)

% Stenosis

See ‘% Stenosis’ on page 7-20 for more information.

A/B Ratio

In M-Mode you can measure A/B ratio by diameter, time, or 
velocity. 

NOTE: The LOGIQ Fortis automatically activates the A/B Ratio with the 
default selection. If another method is preferred, select it from 
the Touch Panel.

Diameter

See ‘Diameter’ on page 7-27 for more information.

Time

To calculate A/B ratio by time:

1. Select A/B. 

2. Select ratio(Time). 

The system displays an active caliper.

3. To position the caliper at the A point, move the Trackball.

4. To fix the measure point, press Set.

The system displays a second active caliper.

5. To position the second caliper at the B point, move the 
Trackball.

6. To complete the measurement, press Set.

The system displays the two time measurements and A/B 
ratio in the Results Window. 
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A/B Ratio  (continued)

Velocity

To calculate AB ratio by velocity:

1. Select A/B. 

2. Select ratio(Velocity). 

The system displays an active caliper with vertical and 
horizontal dotted lines.

3. To position the caliper at the A velocity, move the Trackball.

4. To fix the measure point, press Set.

The system displays a second active caliper.

5. To position the second caliper at the B velocity, move the 
Trackball.

6. To complete the measurement, press Set.

The system displays the two velocity measurements and the 
A/B ratio in the Results Window. 
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Heart Rate

To calculate the heart rate from M-Mode:

1. Obtain an image and press Measure. Select HR. 

The system displays an active caliper. 

2. To position the caliper at a recognizable point in the first 
cycle, move the Trackball.

3. To fix the first caliper, press Set.

The system displays a second active caliper.

4. To position the caliper at the identical point in the next cycle 
(depending on preset), you need to move the Trackball.

NOTE: In the message bar at the bottom of the display, the system 
indicates the number of cycles you should measure. 

Figure 7-15. Two Heart Beat Reference (example in Doppler 
mode)

5. To complete the measurement and transfer the calculation 
to the worksheet, press Set.

NOTE: For information about how to specify the number of heart beats 
that the system will use, See ‘Options tab’ on page 7-9 for more 
information.
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Doppler Mode Measurements

In Doppler Mode, the Generic study includes the following 
measurements:

• PI (Pulsatility Index)

• RI (Resistive Index)

• PS/ED Ratio or ED/PS Ratio

• A/B Ratio

• HR (Heart Rate)

NOTE: The following instructions assume that you do the following:

1. In the B-Mode part of the display, scan the anatomy you 
want to measure.

2. Go to the Doppler Mode part of the display.

3. Press Freeze.

Control Assignment

Cancel Transfer 

NOTE: Only for Vascular, Abdomen, OB and GYN.

After the Auto Vascular calculation results are assigned to a 
particular vessel, the user can cancel the assignment and 
assigned parameters are removed from Worksheet and Report 
page.

When Cancel Transfer occurs, a message appears on the 
screen to indicate the value was erased from Worksheet and 
Report page.

Vessel location

If the vessel has a location, you can select one of the following:

• Proximal (Prox)

• Middle (Mid)

• Distal (Dist)

NOTE: If you do not wish to assign a vessel location, press the lit 
location, then no location is assigned. Choose the folder you 
want the value assigned to. 

To select one of the locations, adjust the Touch Panel control.
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Pulsatility Index (PI)

For auto trace:

1. Select PI. 

The system displays a caliper and a vertical dotted line.

2. Position the caliper at the beginning of the waveform.

3. To fix the start point, press Set.

The system displays a second active caliper.

4. Position the caliper at the end of the waveform.

5. To complete the measurement, press Set.

The system displays peak systole, minimum diastole, end 
diastole, TAMAX, and PI in the Results Window. 

For manual trace:

1. Select PI. 

The system displays a caliper and a vertical dotted line.

2. Position the caliper at the beginning of the waveform.

3. To fix the start point, press Set.

The system displays a second active caliper.

4. Manually trace the entire waveform.

5. To complete the measurement, press Set.

The system displays peak systole, minimum diastole, end 
diastole, TAMAX, and PI in the Results Window. 

Resistive Index (RI)

1. From the Doppler Generic Touch Panel, select RI. 

The system displays an active caliper with vertical and 
horizontal dotted lines.

2. To position the caliper at the peak systolic velocity, move the 
Trackball.

3. To fix the measure point, press Set.

The system displays a second active caliper.

4. To position the second caliper at the end diastolic velocity, 
move the Trackball.

5. To complete the measurement, press Set.

The system displays PS, ED, and RI in the Results Window. 
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PS/ED or ED/PS Ratio

To calculate the Peak Systole/End Diastole ratio or End 
Diastole/Peak Systole ratio:

1. Select PS/ED or ED/PS. 

The system displays an active caliper with vertical and 
horizontal dotted lines.

2. To position the caliper at peak systole (PS) or end diastole 
(ED), move the Trackball.

3. To fix the measure point, press Set.

The system displays a second active caliper.

4. To position the second caliper at end diastole (ED) or peak 
systole (PS), move the Trackball.

5. To complete the measurement, press Set.

The system displays the peak systole, end diastole, and PS/
ED or ED/PS ratio in the Results Window. 

Heart Rate

To measure heart rate, See ‘Heart Rate’ on page 7-31 for more 
information. or select any of the following measurements.
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A/B Ratio

In Doppler Mode you can measure A/B ratio by velocity, time, or 
acceleration.

NOTE: The LOGIQ Fortis automatically activates the A/B Ratio with the 
default selection. If another method is preferred, select it from 
the Touch Panel.

Velocity

See ‘Velocity’ on page 7-30 for more information. 

Time

See ‘Time’ on page 7-29 for more information.

Acceleration

To measure A/B ratio by acceleration:

1. Select A/B. 

2. Select ratio(Acc). 

The system displays an active caliper.

3. Make a distance measurement of the A acceleration point. 

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window and displays an active caliper for the second 
distance measurement.

4. To make a distance measurement of the B acceleration 
point, repeat steps a–d. 

The system displays the two acceleration measurements 
and the A/B ratio in the Results Window. 
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Acceleration

1. Select Accel. 

The system displays an active caliper with vertical and 
horizontal dotted lines.

2. To position the caliper at peak systole, move the Trackball.

3. To fix the measure point, press Set.

The system displays a second active caliper.

4. To position the second caliper at end diastole, move the 
Trackball.

5. To complete the measurement, press Set.

The system displays the peak systole, end diastole, 
acceleration time, and acceleration in the Results Window. 

Acceleration Time (AT)

1. Select AT. The system displays an active caliper and a 
vertical dotted line.

2. To position the caliper at the start point, move the Trackball.

3. To fix the first caliper, press Set.

The system displays a second active caliper.

4. To position the caliper at the end point, move the Trackball.

5. To complete the measurement, press Set.

The system displays the acceleration time in the Results 
Window.

Peak Systole (PS), End Diastole (ED), or Minimum Diastole (MD)

To calculate the peak systole, end diastole, or minimum diastole:

1. Select PS, ED, or MD. 

The system displays an active caliper with vertical and 
horizontal dotted lines.

2. To position the caliper at the measurement point, move the 
Trackball.

3. To complete the measurement, press Set.

The system displays the peak systole, end diastole, or 
minimum diastole in the Results Window. 
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Helpful hints

HINTS The following hints can help when making a measurement

• Prior to making measurements, use the Cine function, if 
necessary, to display the best image.

• As you take measurements, each measurement is given a 
sequential number on the display and in the Results 
Window. Nine measurements can be displayed in the 
Results Window at one time.

• Once the Results Window has nine measurements, if you 
make any further measurements, the system erases the 
top (first) measurement and adds the new measurement 
last ("first in, first out").

• While you are taking a measurement, the value in the 
Results Window updates until you complete the 
measurement.
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Mode Measurements

B-Mode Measurements

The following measurements can be made in B-Mode.

• Distance

• Circumference

• Circumference and Area

• Ellipse Method

• Trace Method

• Spline Method

• Intensity (Echo level) Method

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

WARNING DO NOT perform a depth measurement using 4D probes.
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Distance measurement

To make a distance measurement:

1. Press Measure once; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points, if preset 
accordingly.

5. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window.

HINTS • Before you complete a measurement:

• To toggle between active calipers, press the top 
Trackball key.

• To erase the second caliper and the current data 
measured and start the measurement again, press 
Clear once.

• After you complete the measurement:

• To rotate through and activate previously fixed calipers, 
adjust Cursor Select.

• To erase all data that has been measured to this point, 
but not data entered onto worksheets, press Clear.
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Circumference measurement

Open Trace

To trace the circumference of a portion of the anatomy and 
calculate its length: 

NOTE: Set OpenTrace to the Touch Panel in Utility -> Measure before 
perform the measurement. See ‘Display/hide a folder or a 
measurement in the Touch Panel’ on page 7-80 for more 
information. 

1. Press Measure.

2. Select Open Trace from the Touch Panel.

3. Position the caliper at the start point.

4. To fix the trace start point, press Set. The caliper changes to 
an active caliper. 

5. Move the Trackball to trace the measurement area. A 
dotted line shows the traced area.

6. To complete the measurement, press Set. The system 
displays the circumference in the Results Window.
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Circumference and area (ellipse) measurement

You can use an ellipse to measure circumference and area. To 
measure with an ellipse:

1. Press Measure once; an active caliper displays.

2. To position the active caliper, move the Trackball.

3. To fix the start point, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper, move the Trackball.

5. Adjust the Ellipse control; an ellipse with an initial circle 
shape displays.

6. To position the ellipse and to size the measured axes (move 
the calipers), move the Trackball.

7. To increase the size, adjust the Ellipse control in a 
clockwise direction. To decrease the size, adjust the Ellipse 

control in a counterclockwise direction.

8. To toggle between active calipers, press the top Trackball 

key.

9. To complete the measurement, press Set. The system 
displays the circumference and area in the Results Window.

HINTS Before you complete the ellipse measurement:

• To erase the ellipse and the current data measured, press 
Clear once. The original caliper is displayed to restart the 
measurement.

• To exit the measurement function without completing the 
measurement, press Clear a second time.
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Circumference and area (trace) measurement

To trace the circumference of a portion of the anatomy and 
calculate its area: 

1. Press Measure.

2. Press the top Trackball key to select Trace; a caliper 
displays.

3. To position the caliper at the start point, move the Trackball.

4. To fix the trace start point, press Set. The caliper changes to 
an active caliper. 

5. To trace the measurement area, move the Trackball around 
the anatomy. A dotted line shows the traced area.

6. To complete the measurement, press Set. The system 
displays the circumference and the area in the Results 
Window.

HINTS Before you complete the trace measurement:

• To erase the line (bit by bit) back from its current point, 
move the Trackball or adjust the Ellipse control 
counterclockwise.

• To erase the dotted line but not the caliper, press Clear 
once.

• To clear the caliper and the current data measured, press 
Clear twice.
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Circumference and area (spline trace) measurement

To trace the circumference of a portion of the anatomy and 
calculate its area: 

NOTE: Spline trace is not available through the factory default. The 
system defaults to trace. To enable spline trace, modify the 
Measure Key Sequence preset found in Utility -> Measure -> 
Advanced preset menu.

1. Press Measure.

2. Press the top Trackball key to select Spline Trace; a caliper 
displays.

3. To position the first caliper at the start point, move the 
Trackball.

4. To fix the trace start point, press Set. The first caliper turns 
yellow. The second caliper appears at the same position as 
the first caliper and is green. 

NOTE: When pressing the Clear key once, the second caliper 
disappears and the first caliper is activated. 

If Clear is pressed again, the first caliper disappears and the 
Spline trace is cancelled.

5. To position the second caliper, move the Trackball and 
press Set. The third caliper appears at the same position.

NOTE: The Clear key functionality is the same as noted in the 
previous step.

The spline trace requires at least three points to draw the 
trace. Continue setting the points of the trace until the 
desired points are set.

6. Press Set again after the last caliper is fixed to finalize the 
spline trace. All points are removed from the line and the 
spline trace turns yellow.

NOTE: Pressing Set twice finishes the trace measurement.

If Clear is pressed twice when more than 3 points exist on 
the trace, all points are removed and the first caliper again 
displays.
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Circumference and area (spline trace) measurement  (continued)

Edit the spline trace

1. Select Cursor Select. The spline trace changes to green 
and all points appear on the trace as yellow. 

A pick-caliper appears on the center of the image and the 
message “Edit spline trace” displays at the bottom of the 
screen.

NOTE: The pick-caliper is used to select and move the trace points.

Figure 7-16.  Edit spline trace

Select Cursor Select again. The trace is deactivated 
(changes to yellow) and all points, including the pick-caliper, 
are removed. 

If the previous/next fixed caliper exists on the image, it is 
activated.

NOTE: Pressing Clear at this time removes all points and the trace 
graphic.

2. Move the pick-caliper to the desired point and press Set. 
The point is activated and turns green.

3. Move the point to the desired position and press Set. The 
point is fixed and turns yellow. The pick-caliper appears on 
the center of the image.

NOTE: The spline trace is updated at run time.

NOTE: To remove a point, press Clear while moving the point. The 
trace turns green and the remaining points continue to be 
shown as yellow. If there are less than three points, the 
spline trace is removed.

4. Press Set again. All points are removed from the trace and 
the trace is shown as yellow.
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Intensity (Echo level) measurement

To make an echo level measurement:

1. Press Measure.

2. Press the top Trackball key to select Intensity. A caliper 
displays.

3. To position the caliper at the start point, move the Trackball.

4. To fix the trace start point, press Set. The caliper changes to 
an active caliper. 

5. To trace the measurement area, move the Trackball around 
the anatomy. A dotted line shows the traced area.

6. To complete the measurement, press Set. The system 
displays the echo level, as EL __ dB, in the Results Window.

NOTE: The echo level measurement is only available on a frozen 
image, not on a B-paused image.

NOTE: Echo Level is not available through the factory default. To 
enable echo level, modify the Measure Key Sequence preset, 
found in the Utility -> Measure -> Advanced preset.

Doppler Mode Measurements

Four basic measurements can be made in Doppler Mode.

• Velocity

• TAMAX and TAMEAN (Manual or Auto Trace)

• Two Velocities with the Time Interval and Acceleration 
between them

• Time Interval

• Volume Flow

NOTE: The following instructions assume that you do the following:

1. In the B-Mode part of the display, scan the anatomy you 
want to measure.

2. Go to the Doppler Mode part of the display.

3. Press Freeze.
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Velocity

To measure velocity: 

1. Press Measure; an active caliper with a vertical dotted line 
displays.

2. To position the caliper at the desired measurement point, 
move the Trackball.

3. To complete the measurement, press Set. The system 
displays the velocity measurement in the Results Window.

Slope (Velocity, Time Interval and Acceleration)

To measure two velocity values, the time interval (ms), and 
acceleration (m/s2):

1. Press Measure. Press the top Trackball key to select Slope; 
an active caliper with vertical and horizontal dotted lines 
displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the start point, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
displays the two peak end point velocities, the time interval, 
and the acceleration in the Results Window.

Time interval

To measure a horizontal time interval: 

1. Press Measure. Press the top Trackball key to select Time; 
an active caliper with vertical and horizontal dotted lines 
displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
displays the time interval between the two calipers in the 
Results Window.
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TAMAX and TAMEAN

Manual Trace

The value measured depends upon the Vol Flow Method preset. 
The two selections available are: Peak (TAMAX) and Mean 
(TAMEAN). 

To do a manual trace of TAMAX or TAMEAN: 

1. Press Measure. Press the top Trackball key to select Trace; 
a caliper displays. Select Manual on the Touch Panel.

2. To position the caliper at the trace start point, move the 
Trackball.

3. To fix the start point, press Set.

4. To trace the velocity spectrum boundary, move the 
Trackball.

NOTE: To edit the trace line, move the Trackball.

5. To complete the measurement, press Set. The system 
displays the measurement values in the Results Window. 

Auto Trace

The value measured depends upon the Vol Flow Method preset. 
The two selections available are: Peak (TAMAX) and Mean 
(TAMEAN). 

To auto trace TAMAX: 

1. Press Measure. Press the top Trackball key to select Trace; 
an active caliper with a vertical dotted line displays. Select 
Auto on the Touch Panel.

2. To position the caliper at the trace start point in the Doppler 
spectrum, move the Trackball.

3. To fix the start point, press Set.

4. To position the vertical caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
automatically fixes both calipers and traces the maximum 
value between the two points. The system displays this 
value in the Results Window. 

NOTE: When you set the Auto Trace for Both (above and below), 
the system picks up the maximum power of the signal, NOT 
the maximum velocity. If the maximum velocity is not the 
maximum power, the system may not trace accurately. If 
you want to use maximum velocity, select either Above or 
Below.
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Edit Trace

Auto Trace can be edited after taking an Auto Trace 
measurement.

1. After taking an Auto Trace measurement, select the 
measurement result on the result window. The Edit Trace 
(Edit Peak or Edit Mean) menu window appears.

NOTE: If the system cannot take the trace data correctly from the 
image, Edit Trace does not work.

2. Select Edit Trace. The first caliper (manual trace caliper) 
appears on the center of the image. Use the Trackball to 
move the caliper on the trace line to the start point.

NOTE: To cancel Edit Trace at this time, press Clear, Scan, or 
Freeze.

3. Press Set to fix the first caliper. The second caliper appears. 
Edit the trace manually using the second caliper. 

The Ellipse control is used to edit the trace.

NOTE: When pressing the Clear key once at this time, the second 
caliper disappears and the first caliper appears in the center 
of the image.

NOTE: If you press Scan or Freeze at this time, the caliper is 
automatically fixed and the result window updates.

4. Press Set to fix the second caliper. The trace and the result 
window update. The trace data (TAMAX and TAMEAN) are 
updated, though the other points (e.g. PS, ED) are not 
updated by trace. The points can be edited with Cursor 

Select.

NOTE: While in Edit Trace, Cursor Select is disabled.

5. Repeat Edit Trace as needed.
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Doppler Auto Calc Average Cycle

When using Auto Calc, a selection is available to average a 
number of cycles automatically. There is also a preset selection 
in the Utility Imaging PW page for this feature. When using 
average cycle:

• Selected cardiac cycle lines display on the image. Point 
calipers are not displayed.

• When changing the number of cycles from 1 to >1, all the 
data is reacquired from the image, recalculated and 
updated.

• When multiple cycles are selected in AutoCalc, the average 
values calculate and display automatically.

• When selecting Peak Value (PV), average cycle is not 
available.

NOTE: You cannot edit the lines while in Average Cycle. Cursor Select 
is not available at that time.

NOTE: Average Cycle data is acquired from the display image area 
only, for both live and frozen. The average cycle data fails if the 
setting for the number of cycles is larger than the number of 
image cycles.

Figure 7-17. PW Touch Panel
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Volume Flow - Manual Calc

You perform a manual Volume Flow measurement using the 
TAMAX plus a Volume Flow coefficient compensation. 

1. To perform the Volume Flow measurement using the 
TAMAX plus a Volume Flow coefficient compensation, in 
Utility-->Measure-->Advanced, select the following:

• Trace = Manual

• Vol Flow Method = TAMAX [you MUST also select a 
Volume Flow coefficient for use with TAMAX.] 

• Vol Flow Compensation with TAMAX = [select value 
from 0.5 to 1.0]

2. Set Auto Calcs to Off via Doppler Mode-->Modify Auto 
Calcs-->Off. 

3. Select a folder in Doppler Mode-->select a calculation 
folder-->select Show All. 

4. Select Volume Flow. You’ll notice that TAMAX is 
automatically selected. 

NOTE: Ensure that you have placed the caliper in the spectral 
window when selecting the Volume Flow measurement. 

5. Trace the TAMAX. The system prompts you to “Mark the 
first point on the spectral doppler.” Press Set. 

6. The system prompts you to “Trace the velocity spectrum 
boundary.” Press Set. 

NOTE: You can back up while tracing the TAMAX by using the 
Trackball. 

7. Trace the vessel diameter. The system prompts you to 
“Mark first point of vessel diameter for volume flow 
calculation.” Press Set. 

8. The system prompts you to “Mark last point of vessel 
diameter for volume flow calculation.” Press Set. 

9. The Volume Flow is calculated in ml/min. 
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Volume Flow - Auto Calc

You can perform an automatic Volume Flow measurement using 
TAMEAN or using the TAMAX and a Volume Flow coefficient. 

1. To perform the Volume Flow measurement using the 
TAMEAN, in Utility-->Measure-->Advanced, select the 
following: 

• Trace = Auto

• Vol Flow Method = TAMEAN

OR, to perform the Volume Flow measurement using the 
TAMAX plus a Volume Flow coefficient compensation, 
select the following: 

• Trace = Auto

• Vol Flow Method = TAMAX [if you use TAMAX, you 
MUST also select a Volume Flow coefficient for use with 
TAMAX.] 

• Vol Flow Compensation with TAMAX = [select value 
from 0.5 to 1.0]

2. Set Auto Calcs to Live via Doppler Mode-->Modify Auto 
Calcs-->Live. 

3. Perform the scan. 

4. Select Volume Flow via Doppler Mode-->Modify Auto 
Calcs-->VOLUME FLOW. The system prompts you through 
the measurement. 

5. Take vessel diameter for volume flow calculation. Set the 
first cursor. 

6. Mark last point of vessel diameter for volume flow 
calculation. Press Set. 

7. The calculation automatically completes the Volume Flow 
measurements as ml/min. 

NOTE: If you change the TAMAX coefficient, the Volume Flow is 
automatically adjusted when in Auto Calcs (but not in 
Manual Calcs). 



General Measurements and Calculations

7-52 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Flow Volume (FV)

Flow Volume estimates the volume of blood that flows through a 
vessel per unit time. It is derived from a vessel's cross-sectional 
diameter obtained from the B-Mode portion of the image and the 
mean velocity of flow in the vessel obtained from the Doppler 
portion of the image. It is measured in milliliters. When the FV 
measurement is made, FVO is automatically calculated.

To measure flow volume:

1. Select FV from Doppler Touch Panel. 

2. Place the dotted horizontal line caliper at each of the time 
base on the Doppler spectrum.

• If Trace Auto is selected, the waveform is automatically 
traced.

• If Trace Auto is not selected, manually trace the desired 
portion of the waveform.

The caliper moves to the B-Mode area.

3. Use the Ellipse or Trace method to measure the 
circumference and area of the vessel.

The flow volume (FV) is calculated and displayed in 
milliliters. The flow volume output (FVO) is also calculated 
and displayed in milliliters/minute.

Flow Volume Output (FVO)

This measurement is used to measure the flow volume output in 
a vessel on the Doppler spectrum. It is measured in milliliters/
minute. When the FVO measurement is made, FV is 
automatically calculated.
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Auto vs. Manual Calculations

The same calculations can be performed using either manual or 
auto calcs.

Manual Calcs

To perform manual calcs:

1. To turn Auto Calcs off and perform manual measurements, 
choose Auto Calcs -> OFF on the PW tab of the Touch 
Panel.

2. After obtaining a waveform, press Measure. Choose the 
appropriate vessel folder or calculation. The system walks 
you through the measurement.

NOTE: To program which calculations are done under manual calcs 
when using measurement folders for measuring specific 
vessels, press the Utility key. Select Measure -> Doppler and 
program your manual calcs (Auto Calcs OFF). Each vessel must 
be programmed individually and saved after each change.

Auto Calcs

To perform auto calcs:

1. Ensure that the auto calcs function is on by choosing Auto 

Calcs -> Frozen or Live on the Doppler tab of the Touch 
Panel.

• Live: Auto calculation activates when the system is in 
real-time.

• Frozen: Auto calculation activates when you press 
Freeze.

• Off

2. After obtaining a waveform, press Measure. Choose the 
appropriate vessel folder, side and location. The 
measurements that are pre-programmed are performed 
automatically and entered in the worksheet.

To modify auto calcs:

1. Select Modify Auto Calcs on the Touch Panel.

2. Choose the measurements to be performed with this preset. 

3. To save these measurements:

• If this is a temporary change, press Return.

• If this is a permanent change, select Save as default.

The measurements are saved and can be performed with 
the auto calcs function.
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Edit Auto Calcs

Auto Calcs can be edited after taking an Auto Trace 
measurement.

1. After taking an Auto Calc with a trace, select the 
measurement result on the result window. The Edit Trace 
menu window appears.

NOTE: If the system cannot take the trace data correctly from the 
image, Edit Trace does not work.

2. Select Edit Trace. The first caliper (manual trace caliper) 
appears on the center of the image. Use the Trackball to 
move the caliper on the trace line to the start point.

NOTE: To cancel Edit Trace at this time, press Clear, Scan, or 
Freeze.

3. Press Set to fix the first caliper. The second caliper appears. 
Edit the trace manually using the second caliper. 

The Ellipse control is used to edit the trace.

NOTE: When pressing the Clear key once at this time, the second 
caliper disappears and the first caliper appears in the center 
of the image.

NOTE: If you press Scan or Freeze at this time, the caliper is 
automatically fixed and the result window updates.

4. Press Set to fix the second caliper. The trace and the result 
window are updated. The data is retaken from the trace and 
updated.

NOTE: While in Edit Trace, Cursor Select is disabled.

The trace data (TAMAX and TAMEAN) is updated, but the 
other selections (e.g. PS, ED) are not updated by trace. The 
points can be edited using Cursor Select if needed.

5. Repeat Edit Trace as needed.
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Modify Auto Calcs

When you select this key, the Modify Calculation menu is 
displayed as below. In this menu, you select parameters to 
display in the Auto Vascular Calculation window. Only 
parameters that can be used by the calculation are displayed.

Select Save as Default to save the selected parameters as the 
default calculations for this application.

Select Return to return to the previous Touch Panel screen.

If you select PV, all selected parameters are turned off. When 
you deselect PV, the system returns to the previously selected 
calculation.

Figure 7-18. Modify Auto Calculation Menu
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M-Mode Measurements

Basic measurements that can be taken in the M-Mode portion of 
the display are:

• Tissue Depth (Distance)

• Time Interval

• Time Interval and Velocity

NOTE: The following instructions assume that you do the following:

1. In the B-Mode part of the display, scan the anatomy you 
want to measure.

2. Go to the M-Mode part of the display.

3. Press Freeze.

Tissue depth

Tissue depth measurement in M-Mode functions the same as 
distance measurement in B-Mode. It measures the vertical 
distance between calipers.

1. Press Measure once; an active caliper with a vertical and 
horizontal dotted line displays.

2. To position the active caliper at the most anterior point you 
want to measure, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the most posterior point 
you want to measure, move the Trackball.

5. To complete the measurement, press Set.

The system displays the vertical distance between the two 
points in the Results Window.

CAUTION DO NOT perform a depth measurement using 4D probes.
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Time interval

To measure a horizontal time interval and velocity: 

1. Press Measure. Press the top Trackball key to select Time; 
an active caliper with vertical and horizontal dotted lines 
displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the first caliper, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
displays the time interval between the two calipers in the 
Results Window.

Slope (Time interval and Velocity)

To measure time and velocity between two points: 

1. Press Measure. Press the top Trackball key to select Slope; 
an active caliper with vertical and horizontal dotted lines 
displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set.

The system displays time(s) and slope between the two 
points in the Results Window.
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Worksheet

Introduction

The worksheet function enables the user to review, edit, delete 
or print data independently of a report. All measurements and 
calculations taken during the examination can be viewed at any 
time using the worksheet.

As you complete measurements, the system puts measurement 
data in the appropriate worksheets. 

NOTE: Worksheets are not saved if the system crashes.
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To view a worksheet

To view a worksheet, select Worksheet on the Touch Panel.

OR

Select Worksheet on the measurement summary window.

The system displays the worksheet for the current study. 

 Figure 7-19. OB Worksheet

The OB Worksheet has three sections of information:

1. Patient data

2. Measurement information

3. Calculation information

To return to scanning, do one of the following:

• Select Worksheet. 

• Press Esc.

• Select the Exit button.
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To view a worksheet  (continued)

To view a different worksheet, select the worksheet key for the 
desired exam. 

To view worksheet data for a particular mode, select the key for 
that mode. To view a worksheet with data for more than one 
mode, select Expand. When Expand is selected, it defaults to 
view all measurements, noted by mode, on the worksheet.

If a worksheet has more data on a second page, to view the next 
page, adjust the Page Change control.

To edit a worksheet

Change data

1. Select Worksheet from any page of the Vascular 
Calculation Touch Panel.

2. Position the cursor at the field you want to change by 
moving the Trackball.

The cell is highlighted. Press Set. The field backlights.

3. Type the new data in the field and move the cursor to 
another place. Press Set. The new data, displayed in blue 
with an asterisk, is appended to the updated value and 
resultant value to indicate that it was manually entered. 

The average measurements, calculations and ratios are 
automatically updated to reflect the edited values.

NOTE: If the user moves the cursor to the edited value and presses the 
Set key once, the value returns to the original value before the 
edit was made.

HINTS Some fields on the worksheet are view only, and others you 
can change or select. To easily see which fields you can 
change or select, move the Trackball. As the cursor moves 
over a field that you can change or select, the field is 
highlighted.
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To edit a worksheet  (continued)

Exclude data

When the user selects a particular value on the Worksheet and 
selects Exclude Value, this value is excluded from result line 
and resultant value is re-calculated without this value and also 
calculation values using this value is ‘blank’.

1. To position the cursor at the field you want to delete or 
exclude, move the Trackball. The field is highlighted.

2. Do one of the following:

• To exclude the field, select Exclude Value.

The data in the field is not visible and is not included in 
worksheet calculations.

• To include a value that you previously excluded, select 
Exclude Value.

Delete data

1. Select Worksheet from any page of the Vascular 
Calculation Touch Panel Menu.

2. Position the cursor at the field you want to delete or exclude 
by moving the Trackball.

The field is highlighted.

3. Select Delete Value from the Touch Panel.

For Example:

1. If the user measured RI 4 times, the latest 3 sets of RI 
measurements are displayed in the worksheet.

Table 7-5:  Example of Latest Measurements in Worksheet

Result Number #2 #3 #4

PS 0.500 0.600 0.700

ED 0.100 0.200 0.300

RI 0.800 0.667 0.571
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To edit a worksheet  (continued)

2. Then, the user deleted PS value of #3 from the worksheet.

3. Then, if the user deletes the PS value in column #3 from the 
worksheet, the whole set of measurements from column #3 
is deleted from the worksheet and measurements from 
column #1 are shifted and displayed, as below.

Examiner’s comment

To type a comment on a worksheet:

1. Select Examiner’s Comments. The Examiner’s Comments 
window opens.

2. Type comments about the exam.

3. To close the Examiner’s Comments window, select 
Examiner’s Comments.

Figure 7-20. Examiner’s comments field

Table 7-6:  Example of Latest Measurements in Worksheet

Result Number #1 #2 #4

PS 0.500 0.600 0.700

ED 0.100 0.200 0.300

RI 0.800 0.667 0.571
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To edit a worksheet  (continued)

Volume measurement value off

1. Select the method type Off. The value field becomes blank.

To select a method

1. Move the cursor over the value in the method column and 
press Set. 

2. The pull-down menu displays. Move the cursor to select the 
method and press Set. The selected method is displayed in 
the column.

Figure 7-21. Pop-up menu of methods - example

1. Avg.: Average of the measurements taken

2. Max.: Maximum measurement

3. Min.: Minimum measurement

4. Last: Last measurement that was taken 
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Delete All Worksheet Values

You can delete all worksheet values on a worksheet.

1. When the Worksheet is displayed on the monitor, press the 
Clear key; the following warning message appears:

Figure 7-22. Delete All Warning Message

2. Select OK to delete all.

Select Cancel to cancel the deletion.

Recording Worksheet

The worksheet can be saved as you would any ultrasound 
image. Once it is displayed on the screen, it can be recorded on 
the DVR, printed on the B/W printer, stored on media with the 
Image Archive option, or placed on regular paper with a line 
printer.



Worksheet

LOGIQ Fortis – Basic User Manual 7-65
5855997-1EN Rev. 3

OB Worksheet

Patient data

The Patient data section, at the top of the worksheet, lists 
information from the Patient Data Entry screen. 

You can select the following fields:

• FetusNo – if this is a multi-gestational patient, you can 
select the fetus in this field. You can also adjust the Fetus 
selection to change the fetus.

• CUA/AUA – select the ultrasound age calculation method

• Composite Ultrasound Age (CUA) – regression 
calculation

• Average Ultrasound Age (AUA) – an arithmetic average

You can select the method in this field, or adjust the Select 

CUA/AUA control.

NOTE: CUA/AUA is only available when you select USA OB Type in 
the Utility -> System -> System Measure menu.

You can enter information in the following fields:

• FetusPos – type information about the fetus position.

• PLAC – type information about the placenta.
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Calculation information

This section of the worksheet provides calculation choices and 
lists calculation results.

• EFW – lists the parameters used to calculate EFW. This is 
followed by the calculation result. 

To change which parameters are used:

a. Select this field or press Select EFW.

b. Select the desired parameters.

• EFW GP – lists the source used to calculate EFW–GP 
(growth percentile). This is followed by the growth 
percentile.

To change the source:

a. Select this field or press Select GP.

b. Select the desired source.

The remaining calculation information shows ratios for several 
measurements, and the Cephalic Index (CI). 

The worksheet shows if any of the ratios are out of range 
(OOR). Out of range indicates one of the following:

• The measurement is out of the normal range based on the 
gestational age that is calculated from the LMP. The system 
determines OOR from the ultrasound age compared to the 
gestational age. The gestational age is calculated from the 
last menstrual period or the estimated delivery date.

• The measurement is outside of the range for the data used 
in the calculation. That means that the measurement is 
either less than or more than the range of measurements 
used to determine fetal age based on the measurement.

For more information about how to use the worksheet, see 
‘Worksheet’ on page 7-58 for more information.
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Vascular Worksheet

Intravessel ratio

On the Vessel Worksheet page, to calculate the Intravessel 
ratio, you need a measurement of assessing pressure and 
stenotic velocities.

1. Select Intrav. Ratio from the Touch Panel. The Intravessel 
Ratio pop-up window displays in the header section of the 
worksheet.

Figure 7-23. Intravessel Pop-up Window

2. Select the first velocity. The value displays in the window.

The value is displayed in the window.

Figure 7-24. Intravessel ratio one
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Intravessel ratio  (continued)

3. Select the second velocity.

The second value and Result value display in the window.

Figure 7-25. Intravessel ratio two

• To save the Intravessel ratio to the Vessel Summary, move 
the cursor to Save and press Set.

• To clear values, move the cursor to Clear and press Set.

• To cancel and exit Intravessel ratio, move the cursor to 
Cancel and press Set.

NOTE: Intravessel Ratio is only displayed and saved in the Vessel 
Summary as Intra-Ratio.

Vessel Summary

The Vessel Summary is designed to automatically display 
measurements made at specific anatomical sites. Calculated 
ratios are automatically summarized and displayed.

The Vessel Summary can be displayed at any time during the 
exam by selecting Vessel Summary from the Vascular 
Worksheet Touch Panel.

Figure 7-26. Vessel Summary Example
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Vessel Summary  (continued)

1. The first row, indicating Right or Left, is not displayed when 
the side is not defined in the vessel. In the third column on 
the second line, you select the calculations. Move the cursor 
to the third column, and the pop-up menu is displayed. The 
selected parameter is displayed in every third column.

Figure 7-27. Pop-up menu

2. Vessel Name with location information.

3. Check Box. Use to select the vessel velocity for calculating 
the vessel ratio (ex. ICA/CCA). You can only select one 
location (position) in a vessel.

4. Result value column. This value cannot be changed or 
excluded from this page.

5. Calculation name and result. ICA/CCA: The ICA/CCA ratio 
selects the highest systolic ICA and CCA velocities when 
calculating this ratio, and displays the velocities.
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Carotid Study

In the configuration page for ICA/CCA ratio, you can specify 
which portion of the CCA vessel (Prox, mid, distal) is chosen. 
You can override the selections on the Vessel summary.

The ICA/CCA ratio is able to be configured for either systole or 
diastole.

The vertebral vessel also has systole and diastole selections. In 
the summary page, there is a box to select flow reversal for 
vertebral flows. The choices are Ante (Antegrade), Retr 
(Retrograde), and Abs (Absent).

To select the method: 

Move cursor to the box and press Set. After the pop-up menu 
(Blank, Ante, Retr, Abs) is displayed, select from a menu of 
choices. The selected choice is displayed in the column.

The box is independent of Left and Right.

Renal Artery Study

For renal arteries, you can calculate RENAL/AORTIC ratio 
(RAR) based on peak systolic velocities. 

You can combine the two renal summary pages, and have a 
heading to separate the different measurements (main renal, 
intra renal). You can scroll between the measurements. The 
most commonly used, the main renal artery, is the default.

Lower Extremity Artery Study

For the lower extremity artery, you need an intra vessel ratio 
(assessing pre vs. stenotic velocities). You can specify which 
(ratio is stenotic/pre).

The intra-vessel ratio needs to be available for all vascular 
measurements. This appears on the worksheet only if used.

Recording Worksheet

The worksheet can be saved as you would any ultrasound 
image. Once it is displayed on the screen, it can be recorded on 
the DVR, printed on the B/W printer, stored on media with the 
Image Archive option, or placed on regular paper with a line 
printer.

Print All Pages

When there are multiple pages, a “Print All Pages” button is 
displayed on the Touch Panel Default is ON. If Print All Pages is 
set to ON, press the Print button; then all pages are stored/
printed, depending on the how the print button is configured. 
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Anatomical Survey

Overview

The Anatomical Survey page provides a checklist that indicates 
which anatomy was imaged and its appearance.

Figure 7-28. OB Anatomical Survey

Figure 7-29. Abdominal Anatomical Survey

Figure 7-30. GYN Anatomical Survey
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Editing

1. To activate the Anatomical Survey, select Anatomy on the 
Worksheet Touch Panel.

2. Fill the required field.

Table 7-7:  Abdomen Anatomical Survey 

Field Description

ANATOMY Enter the following information for each part of the anatomy imaged:

1. Imaged?: Check the box that you did image this part of the anatomy.

2. Appearance: If you checked the Imaged? box, indicate whether the 

appearance was normal or abnormal.

You can add additional anatomy to this worksheet. Up to 9 additional items can 

be added. 

Move the Trackball to the blank field.

Enter the anatomy name.

COMMENTS Free text

Table 7-8:  OB Anatomical Survey 

Field Description

Fetus Pos Indicate the fetal position within the uterus.

PLAC Identify the location of the placenta.

ANATOMY Enter the following information for each part of the anatomy imaged:

1. Imaged? : Check the box that you did image this part of the anatomy.

2. Appearance : If you checked the Imaged? box, indicate whether the 

appearance was normal or abnormal.

You can add additional anatomy to this worksheet. Up to 9 additional items can 

be added. 

Move the Trackball to the blank field.

Enter the anatomy name.

BIOPHYSICAL The score is _ of 10 possible total points, depending upon the number of 

parameters entered. Enter the following information to assess the fetus’s 

biophysical well-being.

Movement Type 0, 1 or 2

Tone Type 0, 1 or 2

Breathing Type 0, 1 or 2

Fluid Type 0, 1 or 2
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3. Select Exit to return to the Scan screen.

Select Worksheet to return to the Worksheet.

NOTE: The patient specific contents input on the Anatomical Survey 
page are returned to the factory default settings after starting a 
new patient. 

Reactive NST (Reactive 

non-stress test)

Type 0, 1 or 2

COMMENTS Free text

Table 7-9:  GYN Anatomical Survey

Field Description

ANATOMY Enter the following information for each part of the anatomy imaged:

1. Imaged?: Check the box that you did image this part of the anatomy.

2. Appearance: If you checked the Imaged? box, indicate whether the 

appearance was normal or abnormal.

You can add additional anatomy to this worksheet. Up to 9 additional items can 

be added. 

Move the Trackball to the blank field.

Enter the anatomy name.

COMMENTS Free text

Table 7-8:  OB Anatomical Survey  (Continued)

Field Description
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Measurement and Calculation Setup

Measurements and studies are organized for typical work flows. 
If you want, you can change this set up. You can specify which 
studies are in each exam category, and which measurements 
and calculations are in each study. You can change the 
measurements that are available on the Touch Panel. The 
LOGIQ Fortis allows you to quickly and easily set up your 
system so that you can work most efficiently. 

This section describes how to:

• Change a study to include different measurements

• Add a new study or measurement

• Remove a study from an exam category

• Change measurement parameters

• Create a measurement formula to correctly handle unit 
conversions

• Edit user-defined calculations

• Define application-specific measurement parameters

• Specify the default manual calc measurements for a 
selected study or folder
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Starting Study and Measurement Setup 

You can make changes to studies and measurements in the 
Measurement & Analysis screen. To open the screen:

1. On the Touch Panel, select Utility.

2. On the Touch Panel, select Measure.

3. The system displays the Measurement & Analysis screen 
on the monitor display.

Figure 7-31. Measurement & Analysis screen

• Selection menu: select exam category, study, or 

measurement folder/measurement.

• Folder or measurement: define studies and 

measurements. This section changes between 

Folder and Measurement, depending on what you 

select in the Selection menu.• Measurement menu: add and delete studies 

(folders) and measurements; select mode.
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Select the exam category

To select the exam category you want to work with:

1. Move the cursor to the exam category at the top of the 
Selection menu. 

2. Press Set.

The system displays a list of exam categories. 

3. Move the cursor to the desired exam category.

4. Press Set.

Figure 7-32. Select the exam category
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Select the study

1. Move the cursor to the current study in the Selection menu.

Figure 7-33. Select the study

2. Press Set. All study displays.

Figure 7-34. Select the study

3. Move the cursor to the desired study you want to open.

4. Press Set.
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Select a measurement folder or a measurement

1. Move the cursor to the desired measurement folder or the 
desired measurement in the Selection menu. 

2. Press Set.

• If you select a measurement folder, the Folder section 
displays information about the selected folder.

Figure 7-35. Folder - example

• If you select a measurement, the Measurement section 
displays information about the selected measurement.

Figure 7-36. Measurement - example
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Select the measurement mode

In the Measurement menu, select the measurement mode which 
you work with.

• 2D (B-Mode)

• MM (M-Mode)

• Dop (Doppler Mode)

• Plot (Plot Mode—The measurement on the plot graph of the 
TIC/QAnalysis)

Figure 7-37. Measurement menu
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Display/hide a folder or a measurement in the Touch Panel

The Folder section of the Measurement & Analysis screen has 
two lists of folders and measurements. This is where you specify 
which items go in a study or folder.

• Available folders and measurements. The list contains all 
possible folders and measurements for the selected study or 
folder. 

• Measure & Study. The list defines where the folder or 
measurement is located on the Touch Panel. 

To display an item in the Touch Panel:

1. In the Measure & Study list, move the Trackball to highlight 
which folder you want to put the item in, and press Set.

2. Move the Trackball to highlight an item in the Available 
folders and measurements list, and press Set. The selected 
item is assigned to the Touch Panel. 

Figure 7-38. Select the position and an item

Figure 7-39. Measure & Study list: New item added

The selected item is now displayed in the Touch Panel and 
the Summary Window.
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Touch Panel positions

Each Touch Panel has 25 positions, five across and five down. 
The items in the first row across are numbered 1–5, in the 
second row 6-10, and so on. Positions 1-5 are system 
programmed and cannot be edited. 

Figure 7-40. Measure & Study display with Touch Panel 
positions, Page 1
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Touch Panel positions  (continued)

Page 2 of the Touch Panel has 25 positions, five across and five 
down. The items in the first row across are numbered 26-30, in 
the second row 31-35, and so on. Positions 26-30 are system 
programmed and cannot be edited. 

Figure 7-41. Measure & Study display with Touch Panel 
positions, Page 2
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Move, Remove or Hide Touch Panel Items

 Figure 7-42. Move (1), Remove (2) and Hide (3) Icons

Move Touch Panel Items

To move items on the Touch Panel, change the item position in 
the Measure & Study list.

1. Highlight an item in the Measure & Study list.

2. Move the cursor to the Up or Down Arrow Icon and press 
Set (see 1 in Figure 7-42 on page 7-83). 

The item is displayed at the selected position on the Touch 
Panel.

Remove Touch Panel Items

To remove items from the Touch Panel, remove the item from 
the Measure & Study list.

1. Move the Trackball to highlight the item in the Measure & 
Study list and press Set.

2. Select the Trash Icon to the right of the list (see 2 in 
Figure 7-42 on page 7-83). 

The system removes the item from the Measure & Study list 
and from the Touch Panel. The item is still listed in the 
Available folders and measurements list. 
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Hide Touch Panel Items

Modifiers for Stenosis, as well as Prox, Mid, Distal and Origin 
location identifiers, can be hidden on the Touch Panel using the 
Hide command in the Measure & Study list. 

1. Move the Trackball to highlight the item in the Measure & 
Study list and press Set.

2. Select the Hide Icon to the right of the list (see 3 in 
Figure 7-42 on page 7-83).

The system hides the modifier from the Measure & Study list 
and from the Touch Panel. Once a modifier is hidden, 
another measurement can be assigned to the Touch Panel 
location.

To reestablish the hidden modifier, highlight the hidden modifier 
in the Measure & Study list, press Set and select the Hide Icon.

NOTE: If a modifier is hidden in either 2D or Doppler mode, it will be 
hidden in both modes. 
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Setting up an automatic measurement flow

In some cases, related measurements are put in a 
measurement folder. This allows you to logically organize 
measurements. It also allows you to specify that the system 
automatically start each measurement in a folder, one after the 
other. This is the automatic sequence feature. To use this 
feature:

1. In the Selection menu, select the folder that contains the 
measurements you want.

2. In the Folder section, select Auto sequence.

Figure 7-43. Measurement & Analysis screen: Auto sequence
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Change the tool used to make a measurement

You can make changes to some of the measurements. For 
example, Head Circumference can be measured with an ellipse, 
a trace, or two distances. You can select the measurement tool 
you want to use.

1. Select the measurement you want to change in Selection 
menu.

2. In the Measurement section, select the desired tool from the 
Tool list.

NOTE: If the Tool field is gray, it cannot be changed.

Figure 7-44. Change the tool

NOTE: The diagram to the right of the Tool list shows the measurement 
type. In the following example, ellipse is selected and the 
diagram shows an ellipse.
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Adding Folders and Measurements

Adding a folder

When you add a folder, it can be a study, or a measurement 
folder that includes related measurements. 

Figure 7-45. Measurement & Analysis: Add folder

1. In the Selection menu, select the study or folder where you 
want to add the folder.

2. Select the mode in the Measurement menu.
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Adding a folder  (continued)

3. In the Measurement menu section, select Add folder.

• If you select Blank, the system adds a folder with a 
name such as USERDEFS1. It is listed in the Selection 
menu.

NOTE: For Generic study, you can only use Blank.

• If you want to use an existing folder, select Insert, and 
then select a folder from the list.

Figure 7-46. Add folder Window

4. Select the user-defined folder in the Selection menu.

NOTE: You cannot change an existing folder name.

5. Move the Trackball to the Name field and press Set twice.

Type the name.

NOTE: DO NOT use "single quotes" for a parameter name, a 
measurement name, a folder name or an author name.

6. Add a measurement to the folder. 
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Adding a Measurement

You can add a measurement to the folder.

NOTE: DO NOT use “single quotes” for a parameter name, a 
measurement name, a folder name or an author name.

1. In the Selection menu, select the study or folder where you 
want to add the measurement.

2. In the Measurement menu section, select Add 
measurement.

The system displays the Add Measurement window. 

Figure 7-47. Add Measurement window

3. Do one of the following: 

• If you want to create this measurement from a copy of 
an existing measurement, select Use copy of, and then 
select a measurement from the list. The list includes all 
measurements defined for the current exam category 
and selected mode.

NOTE: This only applies to OB and Cardiac. 

• If you want to use an existing formula, select Insert, and 
then select a measurement from the list. The list 
includes all measurements defined for the current exam 
category and selected mode. You cannot edit this 
formula.

• If you want to create a blank new measurement, select 
Blank.

DANGER
 

Please remember that you are responsible for confirming the 
correctness and accuracy of the user input formula that you 
enter or is entered into the system on your behalf. Failure to 
confirm the correctness and accuracy of user defined 
calculations could lead to patient injury.
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Adding a Measurement  (continued)

4. Select OK.

• If you created a blank measurement, the system adds a 
measurement with a name such as USERDEFM3. 

• If you created a measurement from a copy of an existing 
measurement, the system lists the measurement and its 
parameters in the Measurement section.

5. When you create a new measurement, the measurement 
name is automatically highlighted. Type a name for the new 
measurement. You can change the name of a measurement 
you created from a copy.

NOTE: 2D Dual Caliper, 2D Dual Area, 2D Dual Ellipse, and 2D Dual 
Spline Trace are not available through the factory default. To 
enable these measurements, add a new measurement using 
“2D Dual Caliper”, “2D Dual Area”, 2D Dual Ellipse”, or “2D Dual 
Spline Trace” tool. 

Changing measurement parameters

To change a measurement parameter:

1. In the Selection menu, select the measurement.

2. To change the name of the Parameter, move the Trackball 
to the parameter name and press Set twice. Type a name 
for the parameter.

DANGER
 

Please remember that you are responsible for confirming the 
correctness and accuracy of the user input formula that you 
enter or is entered into the system on your behalf. Failure to 
confirm the correctness and accuracy of user defined 
calculations could lead to patient injury.
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Adding measurement parameters

To add a measurement parameter:

1. In the Selection menu, select the measurement.

2. To change the tool used to make a measurement:

In the Measurement section of the Measurement & Analysis 
screen, select the desired tool from the Tool list. Select the 
arrow to display the drop-down list.

NOTE: If the Tool field is gray, it cannot be changed.

3. If necessary, check Fetus (OB only), Location (Loc), or Side:

• Fetus: If this is an OB measurement, check this box. 
(Default ON).

• Location: If this measurement includes a Prox, Mid, or 
Dist location, check this box.

• Side: If this measurement includes a Left or Right side, 
check this box.

4. In the Measurement section, move the Trackball to an 
empty line at the bottom of the Parameter list. Press Set.

The system adds a parameter with a name of (Name).
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Adding measurement parameters  (continued)

5. To change the name of the Parameter, move the Trackball 
to the (Name) and press Set twice. Type a name for the 
parameter.

6. Move the Trackball to the Tool result field, and double click 
the Set key.

The Edit Formula window is displayed.

Figure 7-48. Edit Formula

7. To create a formula:

a. In the Value Type field, select a value.

b. Do one of the following:

• Type a formula in the Formula field.

• Select formula components from the Operators, 
Parameters, and Functions drop-down lists. When you 
select a component, the system displays it in the 
Formula field.

8. To test the formula, select Check.

If there are no problems, the system displays “Syntax OK!”.

If there are any problems with the formula, the system 
displays an Error message in place of the Formula field 
label.

9. When the formula is correct, select OK to save it.

The Edit Formula window closes. The formula is displayed 
in the Tool result field.
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Formula Unit Conversion

When you create a formula, the system changes the calculation 
result into an output unit as defined in the following table.

Table 7-10:  Formula Unit Conversion

Unit

Conversion 

(coefficient value)

Time

s x1

ms x1,000

min x0.0167

h x0.00027778

Ratio

% x100

Frequency

bpm or BPM x1.0

Angle

rad x1.0

deg x57.2958

grad x63.6620

Distance

cm x100

m x1

dm x10

mm x1,000

inch x39.37

feet x3.281

pixels x1

Velocity
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m/s x1

dm/s x10

cm/s x100

mm/s x1,000

inch/s x39.37

Acceleration

m/s2 x1

dm/s2 x10

cm/s2 x100

mm/s2 x1,000

inch/s2 x39.37

Area

m2 or m^2 x1

dm2 x100

cm2 or cm^2 x10,000

mm2 or mm^2 x1,000,000

inch2 x1550

Volume

m3 x1

dm3 x1,000

cm3 x1,000,000

l x1,000

dl x10,000

cl x100,000

ml x1,000,000

gallon x264,178

quart x1056.71

Volume Flow

Table 7-10:  Formula Unit Conversion (Continued)

Unit

Conversion 

(coefficient value)
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m3/s x1

dm3/s x1,000

cm3/s x1,000,000

mm3/s x1,000,000,000

l/s x1,000

dl/s x10,000

cl/s x100,000

ml/s x1,000,000

m3/min x60

dm3/min x60,000

cm3/min x60,000,000

mm3/min x60,000,000,000

l/min or L/min x60,000

dl/min x600,000

cl/min x6,000,000

ml/min x60,000,000

ml/m2 x1,000,000

Pressure

mmHg x1

Pa x133.322

kPa x0.133322

bar x0.00133322

Pressure/Time

mmHg/s x1

Mass

kg x1

g x1,000

ounce x35.273962

pound x2.2046226

Table 7-10:  Formula Unit Conversion (Continued)

Unit

Conversion 

(coefficient value)



General Measurements and Calculations

7-96 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

For example, when a Volume formula is created:

Vol [ml or cm3] = 0.523598*{D1}*{D2}*{D3}

(D1, D2, and D3 indicate a measurement result.)

In this case, the measurement (D1, D2, and D3) is a distance 
measurement, so the measured data is a meter [m] unit 
according to the above table. 

To change into a milliliter, the system multiplies each 
measurement value by 100. As a result, it multiplies a formula 
by 1,000,000.

The standard unit of volume is a cube meter, so the system 
multiplies the result by 1,000,000.

The system multiplies the calculation result by the coefficient 
and converts it. To get a correct result, when you define the 
formula, you must convert the coefficient itself, such as the 
coefficient of 10^.

Others

l/minm2 x60000.0

g/m2 x1000.0

cm/m2 x100.0

cm2/m2 x10000.0

ml/kg/min x60000000.0

Table 7-10:  Formula Unit Conversion (Continued)

Unit

Conversion 

(coefficient value)
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Formula Unit Conversion  (continued)

For example, if you want to define the following formula: 

efg[g] = 
10^(1.5662-0.0108*{P1}+0.0468*{P2}+0.171*{D1}+0.00034*{P1
}*{P1}-0.003685*{P2}*{D1})

D1[cm]: Distance

P1[cm]: Perimeter

P2[cm]: Perimeter

The system defines the standard value of each measurement as 
a meter [m]. If the unit of each measurement value of this 
formula is defined as centimeter [cm], you must define the 
formula as follows:

efw[g] = 10^(1.5662-0.0108*{P1}*100 + 0.0468*{P2}*100 + 
0.171*{D1}*100 + 0.00034*{P1}*{P1}*100*100 - 
0.003685*{P2}*{D1}*100*100)

(This converts each measurement value to a centimeter [cm], 
since the system standard unit is a meter [m].)

The output unit of this formula is a gram. Since the standard unit 
of the system is defined as a kilogram [kg], the system multiplies 
the output by 1,000. 

Because the output of this formula is defined as a gram, it is 
necessary to define the formula as follows.

efw[g] = 10^(1.5662-0.0108*{P1}*100 + 0.0468*{P2}*100 + 
0.171*{D1}*100 + 0.00034*{P1}*{P1}*100*100 - 
0.003685*{P2}*{D1}*100*100)/1,000

As shown, you can obtain an exact calculation result.
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Editing Calculations

To modify user-defined calculations:

1. Select Add Measurement from the Measurement menu. The 
system displays the Add Measurement window. 

2. Select Blank and OK.

3. Type the appropriate name and select “Calculation” from the 
Tool pull-down menu.

Figure 7-49. Measurement window

4. Type the parameter name.

5. Double click on the = Calculated symbol under Tool Result.  
The Edit Formula window displays.

6. Select OK.

7. In the Measurement menu section, select Edit Calc.

Figure 7-50. Edit Calc

The Modify User CALC window displays.
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Editing Calculations  (continued)

8. In the User Defined list, select the calculation that you want 
modified, then select OK.

Figure 7-51. Modify User CALC window

9. The Measure tab for user-defined calculations displays. 
Double click on the equals sign symbol under Tool Result for 
the desired parameter. 

10. Edit the formula as needed and select OK.

Deleting a Folder or Measurement

NOTE: You can only delete user-defined folders or measurements. You 
cannot delete default system folders or measurements.

1. Select the folder or measurement in the Selection menu.

2. In the Measurement menu section, select the Trash icon 
next to Delete measure and study.
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M & A Advanced Preset

The Advanced tab allows you to specify application-specific 
values for certain parameters.

1. On the monitor display, select the Advanced tab. 

Figure 7-52. M&A Advanced Preset Menu

M&A Category: Display and select current exam category. 

Parameter: Lists application specific parameters.

Value: Select the value for a parameter.

2. Select an exam category.

The Parameters list displays parameters for the selected 
category.

3. Select a value for a parameter.

NOTE: The parameters that appear are category dependent.



Measurement and Calculation Setup

LOGIQ Fortis – Basic User Manual 7-101
5855997-1EN Rev. 3

M & A Advanced Preset  (continued)

Table 7-11:  M&A Advanced 

Preset Parameter Description

Absolute Value Displays the absolute value of the Doppler Velocity measurement (On 

or Off)

Default Cursor Position Image Center/Summary Window

Select the display position of the cursor when the measurement key is 

pressed.

Display Angle Correct Value On or Off

Display Sample Volume Depth 

(TCD)

On or Off

Display Summary Window On or Off

Doppler Default Method Avg, Max, Min or Last

Heart Rate Cycle 1, 2, 3, 4, 5, 6, 7, 8, 9, or 10

NOTE: For Cardiac, you can select only “1”.

Keep Graphics with Cine Scroll If you select “On”, the measurement graphics remain while in CINE 

scroll. The measurement graphic redisplays on the frame where the 

measurement was taken in B-Mode.

Start M&A on a Freeze (B) Off: Select measurement manually on Freeze

On: Measurement menu appears automatically on Freeze.

Caliper: Measurement menu and caliper appear automatically on 

Freeze.

Start M&A on a Freeze (M)

Start M&A on a Freeze (D)

Measure Key Sequence (B/CF) 2 Sequences: Dist, Trace; Dist, Spline

2 Sequences: Dist, Open Trace: Dist, Open Spline

3 Sequences: Dist, Trace, Spline; Dist, Spline, Trace; Dist, Spline, 

Intensity; Dist, Trace, Intensity; Dist, Trace, Open Trace; Dist, Spline, 

Open Trace

4 Sequences: Dist, Trace, Spline, Intensity; Dist, Spline, Trace, 

Intensity; Dist, Spline, Trace, Open Trace; Dist, Trace, Open Trace, 

Spline

Show Result Parameters Preview or After Set cursor:

Preview: Displays while taking the measurement.

After Set Cursor: Displays after completing the measurement.

Default Location Off, Prox, Mid or Dist

Default Side Left, Right or Off

PI Calc Method MD or ED

RI Calc Bidirectional Flow On or Off

RI Calc Method MD or ED

Shear Measure Size Sets the Default Diameter size of the shear wave measurement circle. 
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Shear Measure Fixed Size On or Off

Shear Calculation Method Specify Mean or Median

• Mean averages all of the shear wave points within the measurement 

circle. 

• Median sorts, then selects the middle point of all points within the 

measurement circle. 

Shear Units Determine Folder If you have preset shear wave units via the Display Units on the Utility -> 

System -> System Imaging page, then when you specify On, the unit 

specified pre-selects the measurement folder. If m/s is specified as the 

unit, then the Velocity folder is used; if kPa is specified as the unit, then 

the Stiffness folder is used. 

Show Location Select Button Both on B and Doppler, Doppler only or No Display

NOTE1: Only Abdominal, Vascular, Obstetrics and Gynecology have 

this preset. 

NOTE2: For Obstetrics and Gynecology, you can select only Doppler 

only or No Display.

Show BM Folder Name on 

Worksheet

On or Off

Show Measure Name on 

Worksheet

On or Off

Show Point Velocity On or Off

Show Tissue Depth On or Off

Keep Result Window Auto, On or Off

Trace Auto or manual

Length Unit mm, cm, Default

Velocity Unit mm/s, cm/s, m/s, Default

Acceleration Unit mm/s2, cm/s2, m/s2, Default

Area Unit mm2, cm2, Default

Volume Unit cm3, ml, l, Default

Volume Flow Unit cm3, ml, l, Default

Time Unit ms, s, Default

Show Area Value While Tracing On or Off

Vol Flow Method TAMEAN or TAMAX

Vol Flow Compensation with 

TAMAX

If you select TAMAX as the volume flow method, then you MUST 

specify the coefficient to use. Select from 0.5 to 1.0. 

Worksheet Default Display Mode/Expand (Abdominal, Small Parts, Obstetrics, Gynecology, 

Urology and Pediatrics) or Worksheet Summary (Vascular)

Table 7-11:  M&A Advanced  (Continued)

Preset Parameter Description
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Primary Worksheet For Abdominal and Small parts. 

Abdominal: Worksheet or Summary, Small parts: Worksheet or SWE 

summary

Doppler AutoCalc Velocity Unit Velocity, Hz, Both or Auto

Default CCA location for ICA/

CCA ratio

Prox/Mid/Dist/Off

Select the default location of CCA which is used for the ICA/CCA ratio.

MCA/ICA Ratio TAMAX or PS

Default ICA location for MCA/

ICA ratio

Prox/Mid/Dist/Off

Select the default location of CCA which is used for the MCA/ICA ratio.

WMS Freeze Loop at ES On or Off

WMS Segment Model 16 segments or 18 segments

WMS Initial Scoring Undefined or Normal

WMS Scoring Legend ASE, European or Asian

Hip Orientation Cranial-left or Caudal-left

Show area value while tracing On or Off

Measure Assistant BPD Method Outer to Inner, Outer to Outer

Restrict Breast Contour Caliper 

Edit

On or Off

AFI/AutoEF autoprocessing Off, delay 1s, delay 2s, delay 3s or delay 4s

AFI/AutoEF ROI method Auto ROI or 3 Points

AFI/AutoEF YOYO Play or Stop

AFI Default Color Palette Red-Blue, Green-Yellow-Red

AFI segment model 17 segments, 18 segments

AFI PSS/PSI Mode PSS only, PSS&PSI

Auto sequence - Trigger for next 

measurement

Measure or Freeze

Link contents Select to link parameters by cardiac cycle.  

Default value for RAP Blank, 3, 5, 7, 8, 10,15 (system default is 3)

UGAP Print and Unfreeze On or Off

Length unit Default, mm or cm

Velocity unit Default, mm/s cm/s, or m/s

Acceleration unit Default, mm/s2, cm/s2, or m/s2

Table 7-11:  M&A Advanced  (Continued)

Preset Parameter Description
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Area unit Default, mm2, or cm2

Volume unit Default, cm3/s, ml/s, l/s, cm3/min, ml/min, or l/min

Volume Flow unit Default, cm3/s, ml/s, l/s, cm3/min, ml/min, or l/min

Time unit Default, ms, or s

Primary Worksheet Worksheet or Summary

Table 7-11:  M&A Advanced  (Continued)

Preset Parameter Description
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Doppler tab - Modify Calculation

The Doppler tab allows you to preset the parameters for manual 
calculations.

1. On the monitor display, select the Doppler tab. 

2. The following example describes how to configure the 
Carotid Doppler calculations.

Select Vascular next to M&A Categories. The Vascular 
measurement category is displayed.

3. Select Carotid. The available calculations are displayed in 
Modify Calcs.

Figure 7-53. M&A Doppler Preset Menu

4. Check the desired calculations to be performed.
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Application Measurement Preset

The Application Measurement presets allow different calculation 
packages to be available under different application presets.

The presets allow you to configure the Measurement Categories 
and Measurement Exam Calcs. These presets are found on the 
Utility -> Application -> Measurements screen. 

Figure 7-54. Application Measurements Menu
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Chapter 8

Application M&A

Describes how to perform application specific 

measurements and calculations.
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General Information

Overview

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See ‘Beginning an Exam’ on page 4-2 for more 
information.

Any measurement can be repeated by selecting that 
measurement again from the Touch Panel.

The system retains all measurements, but the worksheet retains 
only the last six measurements of each type.
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Abdomen

Overview

Abdominal measurements offer a few different types of 
measurement studies. Select the desired study.

• Generic–Common to all applications. See ‘Generic 
Measurements’ on page 7-18 for more information. 

• Abdomen

• Renal

• Bypass Graft

• Aorta Iliac

• Vascular Renal

• Mesenteric

• Abdomen Vein

Figure 8-1. Abdomen Exam Category Touch Panel
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Small Parts

B-Mode Measurements

The Small Parts exam category includes the following two 
folders:

• Generic–Common to all applications. See ‘Generic 
Measurements’ on page 7-18 for more information. 

• Small Parts, which includes the breast, thyroid and scrotal 
measurement packages.

Figure 8-2. Small Parts Exam Category Touch Panel
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Thyroid

Thyroid Left/Right

Each of these is a standard distance measurement. Length and 
height are typically measured in the sagittal plane. Width is 
measured in the transverse/axial plane.

To measure thyroid length, width, or height:

1. On the Exam Calcs, select Small Parts.

2. Select Thyroid. 

3. Select Lt or Rt Thyroid. Change the orientation (side), if 
necessary.

4. Select Thyroid L, Thyroid W, or Thyroid H.

An active caliper displays.

5. Perform a standard distance measurement.

Isthmus AP

To measure the anterior/posterior isthmus tissue, perform a 
distance measurement.

Scrotal

Scrotal Left/Right

Each of these is a standard distance measurement. Length and 
height are typically measured in the sagittal plane. Width is 
measured in the transverse/axial plane.

To measure scrotal length, width, or height:

1. On the Exam Calcs, select Small Parts.

2. Select Scrotal.

3. Select Lt or Rt Testicle. Change the orientation (side), if 
necessary.

4. Select Testicle L, Testicle W, or Testicle H.

An active caliper displays.

5. Perform a standard distance measurement.

Epididymis

To measure the epididymis structure, perform a distance 
measurement. 
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OB

Introduction

Out of Range – If the system indicates that a measurement is 
out of range (OOR), it means one of the following:

• The measurement is out of the normal range based on the 
gestational age that is calculated from the LMP. The system 
determines OOR from the ultrasound age compared to the 
gestational age. The gestational age is calculated from the 
last menstrual period or the estimated delivery date.

• The measurement is outside of the range for the data used 
in the calculation. That means that the measurement is 
either less than or more than the range of measurements 
used to determine fetal age based on the measurement.

NOTE: Calculation formulas are listed in the Advanced Reference 
Manual.

NOTE: Nuchal Translucency is not available through the factory default. 
To enable Nuchal Translucency, add NT to the measurement 
folder in Utility -> Measure -> M&A -> Add measurement 
(Insert).
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OB Type change

The LOGIQ Fortis system includes measurements for the 
following studies: USA, Europe, Tokyo, Osaka and ASUM.

Select OB Type in Utility -> System -> System Measure.

Figure 8-3. OB Type selection

Figure 8-4. OB Type: Tokyo - example

NOTE: ASUM studies include the following measurements:

• ASUM: AC, BPD, and CRL

• ASUM 2001: AC, BPD, CRL, FL, HC, HL, and OFD
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To Start an Obstetrics Exam

NOTE: Calculation formulas are listed in the Advanced Reference 
Manual.

To begin an Obstetrics exam, you enter patient data or, if the 
patient data from a previous exam is saved in the system, find 
the patient information. 

1. On the control panel, press Patient.

The Patient Data Entry screen is displayed.

2. On the Patient Data Entry screen, select New Patient.

3. To choose an Obstetrics exam, move the Trackball to 
highlight Obstetrics, then press Set.

The obstetric fields are listed in the Exam Information 
section of the Patient Data Entry screen.

4. Do one of the following:

• If the patient data is already stored in the system, 
search for the data. Use the search fields in the bottom 
section of the Patient Data Entry screen. For information 
about how to search for patient data, see ‘Changing 
Patient Information or an Exam’ on page 4-24 for more 
information.

When the correct patient data is listed in the search list, 
move the Trackball to highlight the patient name and 
press Set. The system displays the patient data.

NOTE: To change patient data, use the Trackball to move the 
cursor to the field and press Set. Press Backspace to 
delete the data, and then type the correct data.

• If the patient data is not stored in the system, enter the 
data. To enter data in a field, move the Trackball to 
highlight the field and then press Set. Use the Tab key 
to move between fields. Obstetric patient fields are 
listed in the following table. 

NOTE: For information about entering general patient data such 
as Patient ID and name, see ‘Beginning an Exam’ on 
page 4-2 for more information.
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To Start an Obstetrics Exam  (continued)

NOTE: To fill in the following information, move the Trackball to 
highlight the Detail button and press Set.

Table 8-1:  Obstetric fields

Field Description

LMP Last Menstrual Period; enter the date that the patient started her last menstrual 

period. 

You must enter 4 digits for the year. When you type the month and day, the 

system fills in the /. The Date Format preset chosen in Utility -> System -> 

General determines the required format. 

BBT Basal Body Temperature.

EDD by LMP Estimated Delivery Date by LMP; the system fills in the date after you enter the 

LMP. 

GA by LMP Gestational Age by LMP; the system fills in the age after you enter the LMP. 

Gravida Number of pregnancies.

Para Number of births.

AB Number of abortions.

Ectopic Number of ectopic pregnancies.

Fetus # Number of fetuses; default is 1. Can be 1-4.

Accession # Exam number used with hospital information system (DICOM). This is a tracking 

number from the worklist.

Exam Description Describe the type of exam.

Perf Physician The physician who performs the exam. Choose from the list or type the name.

Ref. Physician The physician who requested the exam. Choose from the list or type the name.

Operator The person (not a physician) who performs the scan. Choose from the list.
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To Start an Obstetrics Exam  (continued)

After you complete the patient information, you can begin the 
scan. 

1. To change from the Patient Data Entry screen to the Scan 
screen, do one of the following:

• On the keyboard, press Esc.

• On the Touch Panel, select Scan.

• On the Control Panel, select Patient or Freeze.

• On the Control Panel, press the B-Mode key.

The system displays the Scan screen.

2. To choose the appropriate probe, select the probe icon on 
the Touch Panel.

3. On the Control Panel, press Measure.

The default Obstetrics study is displayed on the Touch 
Panel. 

Figure 8-5. OB-General Study 

Table 8-2:  Obstetric fields: Detail

Field Description

Indications  Why the patient needs the ultrasound exam.

Comments Comments about the exam.



OB

LOGIQ Fortis – Basic User Manual 8-11
5855997-1EN Rev. 3

To choose a study

1. To change the study on the exam category, select Probe.

The Obstetrics exam category allows you to choose from 
the following studies:

• Generic

• OB-1

• OB-2/3

• OB-General

• Fetal Heart

• OB/GYN Vessel

2. To select a study, select the appropriate study on the Touch 
Panel.

Figure 8-6. OB Study Touch Panel 

NOTE: The folders you see on the Touch Panel may be different if your 
system has been customized. 
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OB Measurements Performed Over Multiple Planes

Gestational Sac

To calculate the gestational sac, you make three distance 
measurements in two scan planes. To display two scan planes, 
press the L or R key. Get an image in each scan plane and 
press Freeze. 

1. Select GS; an active caliper displays. 

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window and displays an active caliper.

2. To make the second and third distance measurement, 
repeat steps a–d. 

After you complete the third distance measurement, the 
system displays the gestational sac measurement in the 
Results Window.

To calculate the gestational sac by a one distance 
measurement:

1. Select GS; an active caliper displays. 

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

After you complete the measurement, the system 
displays the gestational sac measurement in the 
Results Window.
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Amniotic Fluid Index (AFI)

To calculate the amniotic fluid index, you make measurements 
of the four quadrants of the uterine cavity. The system adds 
these four measurements together to calculate the Amniotic 
Fluid Index.

NOTE: The four quadrants can be measured with distance (caliper) or 
circumference (circle) measurements. Press the appropriate AFI 
quadrant Touch Panel key to toggle between caliper and circle.

1. Select AFI. 

The first distance measurement, AFI-Q1, is already 
selected.

2. Make a standard distance measurement for the first 
quadrant:

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window.

3. When the measurement of the first quadrant is completed, 
unfreeze and move to the second quadrant. 

4. After you obtain the image, press Freeze and then 
Measure. 

The system prompts you to continue with the AFI 
measurements. Make sure that the next quadrant has been 
selected.
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Amniotic Fluid Index (AFI)  (continued)

5. Perform a standard distance measurement for the second, 
third, and fourth quadrants (see step 2).

When all four quadrants have been measured, the system 
calculates the AFI total and displays it in the Results 
Window.

HINTS • If you unfreeze the image after doing an AFI measurement, 
the system does not delete the previous measurements. 
Unfreeze and change scan planes as necessary.

• To specify that an unassigned distance measurement be 
used for an AFI measurement:

• Select AFI.

• Press the top Trackball key.

• Move the Trackball to highlight the unassigned 
distance measurement in the Results Window.

• Select the AFI measurement on the Touch Panel.

• If the fluid in a pocket is zero, set the second caliper on top 
of the first one to give it a zero value.

• You can measure an AFI quadrant that is zero (0) by 
pressing Set twice.
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OB Calculation

SonoNT (Nuchal Translucency)

NOTE: This measurement can be adjusted and customized in the 
system setup.

To measure the contour detection of the NT border:

1. Select NT. The measurement cursor appears.

2. Select the fetal position ("Face Up" or "Face Down").

3. Position and fix the first point (P1) of the rectangular ROI.

4. Position and enter the second point (P2) of the rectangular 
ROI. The NT border detection is performed. If a valid result 
is found, the borders are shown in red and the NT distance 
is displayed with two crosses.

5. If the measurement is correct according to the guidelines, 
accept and confirm the result to store in the report. If the 
system cannot detect a result, a warning message appears.

NOTE: To edit the measurement, move the trackball and/or press 
Change to readjust the start and end point before accepting the 
measurement.

NOTE: It is possible to select the calculation method by pressing 
Method: (i-i: inner-inner or i-m: inner-middle).

Figure 8-7. SonoNT

1. SonoNT Measurement 2. Detected NT Border
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SonoNT (Nuchal Translucency)  (continued)

SonoIT (Intracranial Translucency)

SonoIT (Sonography based Intracranial Translucency) is a 
system supported measurement for Intracranial Translucency. 
Starting from the routinely used midsagittal view of the fetal face, 
obtained for assessment of the Nuchal Translucency and nasal 
bone, the ultrasound system uses a semi-automated mode to 
measure the anterior-posterior diameter of the fourth ventricle 
recognizable as intracranial translucency.

The workflow is identical to SonoNT.



OB

LOGIQ Fortis – Basic User Manual 8-17
5855997-1EN Rev. 3

OB Graphs

Overview

OB Graphs allow you to assess fetal growth compared to a 
normal growth curve. When a patient has completed two or 
more ultrasound exams, you can also use the graphs to look at 
fetal trending. For multi-gestational patients you can plot all 
fetuses and compare the growth on the graphs. 

The LOGIQ Fortis provides the following two basic types of 
graphs:

• Fetal Growth Curve graphs – show one measurement per 
graph. These graphs show the normal growth curve, 
positive and negative standard deviations or applicable 
percentiles, and ultrasound age of the fetus using the 
current measurement. For multi-gestational pregnancies, 
you can view all fetuses. If previous exam data is available, 
the graph can show fetal trending.

• Fetal Growth Bar graph – shows the ultrasound age and 
the gestational age based on patient data. Plots all 
measurements on one graph. 

To View OB Graphs

To view OB graphs:

1. Press Measure.

2. Select Graph. 

The system displays the OB Graph keys. 

Figure 8-8. OB Graph keys on Touch Panel
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Fetal Growth Curve Graph

Figure 8-9. Fetal Growth Curve Graph (Single)

The horizontal axis shows the fetal age in weeks. The system 
determines this age from the data on the Patient Data Entry 
screen. The vertical axis shows one of the following:

• For measurements, mm or cm

• For ratios, percent

• For fetal weight, grams

The Fetal Growth Curve Graph shows the following information 
for the selected measurement:

• The normal growth curve

• The standard deviations or relevant percentiles

• The gestational age of the fetus, using patient data (vertical 
dotted line)

• Using the current ultrasound measurement data, where the 
fetus is on the growth curve 
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Fetal Growth Curve Graph  (continued)

To select the measurement

To select which measurement you want to display on the Fetal 
Growth Curve Graph, do one of the following:

• To select a specific measurement:

a. On the graph display, move the Trackball to the 
Measurement Type field and press Set. 

The system displays a list of measurements.

b. Move the Trackball to select the desired measurement 
and press Set.

The system displays the Fetal Growth Curve Graph for 
the selected measurement.

• To scroll through all Fetal Growth Curve Graphs, adjust the 
Graph Change control.
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To select the age to use

To plot the fetus age, the system allows you to use the 
gestational age (GA) from the LMP, or to use the composite 
ultrasound age (CUA). To select, adjust the Select GA control. 
The information in the left column changes between CUA and 
GA(EDD), and the data may change. 

To view a single or four graphs

You can view either a single Fetal Growth Curve Graph or you 
can view four graphs at the same time. To select each view, 
press Single or Quad to view 4 graphs at once. 

Figure 8-10. Fetal Growth Curve Graph: Quad View

The measurement values are displayed at the bottom of the 
graph. 
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To change measurements in quad view 

When you view four graphs simultaneously, you can select 
which four you want to see. To change each graph in quad view:

1. On the graph display, use the Trackball to move the cursor 
to the small box that is upper left of each graph, then press 
Set.

The system displays a list of measurements.

2. Move the Trackball to select the desired measurement and 
press Set.

The system displays the Fetal Growth Curve Graph for the 
selected measurement.

To scroll through all Fetal Growth Curve Graphs, adjust the 
Graph Change control. 

The order of a quad graph view can be saved by selecting Save. 
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Fetal Trending 

When you have ultrasound data for more than one exam for a 
patient, you can use the data to look at fetal trending on the 
Fetal Growth Curve Graphs.

1. Select Graph Display and select the desired Fetal Growth 
Curve Graph.

2. Select Plot Both. 

The system automatically finds the data from previous 
ultrasound exams, and displays it on the graph with the 
present data.

Figure 8-11. Fetal Trending on Fetal Growth Curve Graph

The legend at the bottom of the graph shows the symbols and 
colors that indicate Past and Present data.
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Fetal Trending  (continued)

To manually enter past exam data

If you have data from a previous ultrasound exam that you want 
to use for fetal trending, but it is not in the system, you can 
manually enter the data.

1. After you have registered the patient for this exam, on the 
Patient Data Entry screen, in the Exam Information 
(Obstetrics) section, select Past Exam.

The system displays the Input Past Exam screen. See 
Figure 8-12.

2. Enter the data from previous exams.

3. To enter data on page 2, select Next.

4. After you enter the previous exam data, select Exit to Save.

The system saves the previous exam data. When you view 
the Fetal Growth Curve Graphs, select Plot Both to view 
fetal trending. The system automatically uses the data you 
entered.

Figure 8-12. Input Past Exam screen, page 1
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To edit patient data

When you are working with graphs, you can change or enter the 
following patient data.

• GA(LMP) – this field is computed using the LMP date on the 
Patient Data Entry screen. To change this field:

NOTE: You can only change this field on the Fetal Growth Curve 
Graph in single view.

a. Move the Trackball to the field, which is left of the 
graph. To select the field, press Set.

The system displays a window with the GA weeks and 
days.

b. To select each field, move the Trackball to the field and 
press Set.

c. Type the correct weeks or days.

d. Select OK.

The system makes the following changes:

• GA (LMP) is now GA (GA) and shows the age you 
entered.

• In the Patient Data section, the GA changes.

• In the Patient Data section, The EDD (LMP) changes to 
EDD(GA) and shows an updated date, using the GA 
you entered.

The LMP is erased.

• FetusPos – type information about the fetus position.

• PLAC – type information about the placenta.

To return from a graph to the scan display

After viewing graphs, to return to the scan display, do one of the 
following:

• On the graph display, select Exit.

• On the Touch Panel, select Graph.
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Fetal Growth Bar Graph

The fetal growth bar graph shows current exam measurements 
and the normal growth range based on the gestational age. It 
shows all measurements on one graph.

To view the Fetal Growth Bar Graph: 

1. Press Measure.

2. Select Graph.

3. Select Bar.

Figure 8-13. Fetal Growth Bar Graph

• The horizontal axis shows the gestational weeks. 

• The red vertical line shows the gestational age using the 
patient data. 

• The blue dotted vertical line shows the ultrasound age using 
the current measurements. 

• The yellow x shows the ultrasound age for each 
measurement.

• The green rectangle shows the normal age range for the 
measurement.

You cannot do fetal trending or view multiple gestation data on 
the bar graph.
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OB-Multigestational

Multiple Fetus

LOGIQ Fortis allows you to measure and report multiple fetus 
development. The system can report a maximum of four 
fetuses.

To enter the number of fetuses 

If more than one fetus is imaged during the exam, enter the 
number of fetuses in the Patient Data Entry Menu.

Figure 8-14. Fetus Number

When you start an OB exam, the system automatically fills in the 
Fetus # field with 1. To change the number:

1. Move the cursor to the fetus number and press Set twice.

The number is highlighted.

2. Type the correct number and press Set.

The system displays a message to confirm that you want to 
change the fetus number.

3. Select Yes.
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To identify each fetus

For measurements, calculations, and worksheet displays, the 
system labels each fetus A, B, C, or D. Each fetus is identified 
by a letter and the total number of fetuses. For example, fetus  
A/3 is fetus A from a total of 3.

When scanning, you can enter information about the fetus 
position and placenta location. You can enter the information in 
the Patient Data section of the worksheets and the graphs. You 
can type up to 23 characters in the FetusPos and PLAC fields. 

Figure 8-15. Patient Data section of the OB Worksheet

To select a fetus

During measurements and calculations, to change between 
fetuses, do one of the following: 

• Adjust the Fetus selection.

• Move the Trackball to the Summary Window and select the 
fetus.

 You can change between fetuses at any time during the exam.

NOTE: After you change to the next fetus, any measurements you 
make are recorded and reported to that fetus. If you have any 
active measurement or calculation that is not completed when 
you change the fetus, the system cancels the measurement or 
calculation.

To view multiple fetuses data on graphs

You can view multiple gestation data on fetal growth curve 
graphs. After you have made measurements for each fetus, 
select Graph. 

1. To view the graph for each fetus, do one of the following:

• Adjust the Fetus selection.

• In the Patient Data section, move the Trackball to 
highlight the FetusNo field. In the list of fetuses, move 
the Trackball to select the fetus you want, and press 
Set.

2. To display data for multiple fetuses on the same graph, 
select Fetus Compare.

The legend at the bottom of the graph shows the symbols and 
colors that represent each fetus.
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To compare multiple fetus data on a worksheet

With multiple fetuses, you can list and compare measurements 
of the fetuses on the worksheet. 

Select Worksheet, then select Fetus Compare. 

When you select Fetus Compare, the system lists the 
measurement results for each fetus on the Worksheet.

To Show Fetal Trending for Multiple Fetuses 

When you have data for more than one exam, you can show 
fetal trending and compare fetuses on one graph. 

To view fetal trending for multiple fetuses: 

1. Select Graph.

2. Select Fetus Compare. 

3. Select Plot Both.

NOTE: You can only view fetal trending for multiple fetuses in single 
graph display.

The symbol key for fetal trending and multiple fetuses is shown 
at the bottom of the graph.

OB Table Editor

You can add user programmable OB tables to the system.

OB Table Settings Menu

You add OB Tables in the Measurement & Analysis menu. To 
open the menu:

1. On the Touch Panel, select Utility, then select M&A.

2. Check the Exam Category on the far left of the monitor 
screen. Make sure that Obstetrics is selected.

If it is not selected, select Obstetrics and continue selecting 
the folders until the appropriate area is selected as to where 
this new OB Table will be entered. For example, select 
Obstetrics, then select OB-2/3. If there are further folders 
within OB-2/3, select that appropriate folder.
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OB Table Settings Menu  (continued)

3. On the monitor display, select the OB Table tab.

The system displays the OB Table settings menu. 

Figure 8-16. OB Table settings

4. The OB Table settings menu lists OB Table parameters. 
Specify the following parameter values as appropriate:

• Study: Shows the study to which this measurement 
table belongs.

• New/Edit: To create a new OB table, select New Table. 
To edit an existing user-programmable OB table, select 
Edit Table.

NOTE: You cannot edit the system’s OB Tables.
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OB Table Settings Menu  (continued)

• OB Table Template: To create a new OB table, select 
the Template (1 - 7) which you want to use as the basis 
of the user programmable OB Table. See ‘OB Table 
Templates’ on page 8-31 for more information.

To edit an existing user OB table, select the desired OB 
table to edit.

• Tool Type: Select the type of measurement: Distance or 
Circumference.

• Measure Name: Type the name of measurement that 
will display on the Touch Panel.

• Author Name: Type the author’s name.

• Table Type: If necessary, select the Table Type: Fetal 
Age or Fetal Growth.

• Measure Type: Select a measurement type that can be 
used to calculate EFW, for example BPD. 

NOTE: Measure Type is used only when calculating EFW.

NOTE: The following items are display only: Table Format, Table 
Unit, SD/GP Range, and Graph Range. The system 
determines these values automatically, based on the type of 
OB table you are creating.

5. After specifying all parameter values, move the Trackball to 
Edit Table and press Set.

The system displays the Edit Menu.

NOTE: If any of the OB table parameters are not correct, the Edit 
Menu is not displayed.
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OB Table Templates

Tool Type:

• Distance: 2D Caliper

• Circumference: 2D Ellipse, 2D Trace, 2D Caliper

Template 1

Table 8-3:  Template 1 (based on Hadlock)

Template 1: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Week Week

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

Min [#w#d]

Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Week mm Week

Others are same as above
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Template 2

Table 8-4:  Template 2 (based on Tokyo)

Template 2: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Day Day

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

SD: day(+/-)

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Day mm Day

Others are same as above
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Template 3

Table 8-5:  Template 3 (based on Osaka)

Template 3: SD Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Day mm

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

SD: sd=(mv-pv)/sd

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Day mm mm

Others are same as above
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Template 4   

Table 8-6:  Template 4 (based on several European tables)

Template 4: 5%-95% Table

Fetal Age Table Table Format MEAS MIN MEAN MAX

Table Unit mm WeekDay WeekDay WeekDay

Table Range 5%:95%

Graph Range 5%:95%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, GP is 

not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MIN MEAN MAX

Table Unit WeekDay mm mm mm

Table Range 5%:95%

Graph Range 5%:95%
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Template 5

Table 8-7:  Template 5 (based on several European tables)

Template 5: 5% - 95% Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm WeekDay mm

Table Range 1SD

Graph Range 5%:95%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, 

GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN MAX

Table Unit WeekDay mm mm

Table Range 1SD

Graph Range 5%:95%
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Template 6   

Table 8-8:  Template 6 (based on several European tables)

Template 6: 5%-95% Table

Fetal Age Table Table Format MEAS MIN MEAN MAX

Table Unit mm WeekDay WeekDay WeekDay

Table Range 10%:90%

Graph Range 10%:90%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, GP is 

not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MIN MEAN MAX

Table Unit WeekDay mm mm mm

Table Range 10%:90%

Graph Range 10%:90%
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Template 7

Table 8-9:  Template 7 (Based on several European tables)

Template 7: 10% - 90% Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm WeekDay mm

Table Range 1SD

Graph Range 10%:90%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, 

GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN MAX

Table Unit WeekDay mm mm

Table Range 1SD

Graph Range 10%:90%
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OB Table Edit Menu

The data you enter in the OB Table Edit Menu depends on 
whether the table type is Fetal Age or Fetal Growth.

Fetal Age Table

If you are creating or editing a Fetal Age table, the OB Table Edit 
Menu is as follows:

Figure 8-17. OB Table Edit Menu: Fetal Age Table

Complete the field

1. Input value to Min, Max and Interval of the Parameters field. 

The system automatically fills in the MEAS column.

Input value to the columns of MEAN and SD.

NOTE: To move between the fields in the table, use the up, down, 
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines 
with a blank cell are not saved. 

To save the Table Data, move the Trackball to Exit to Save 
and press Set. If you want cancel this table, move the 
Trackball to Cancel and press Set.
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Fetal Growth Table

If you are creating or editing a Fetal Growth table, the OB Table 
Edit Menu is as follows:

Figure 8-18. OB Table Edit Menu: Fetal Growth Table 

Complete the field

1. Input value to the required columns.

NOTE: To move between the fields in the table, use the up, down, 
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines 
with a blank cell are not saved. 

2. To save the Table Data, move the Trackball to Exit to Save 
and press Set. If you want cancel this table, move the 
Trackball to Cancel and press Set.

After you complete the OB table, it is now available for the 
selected study. To use the measurement, you must assign it to a 
Touch Panel. See ‘Measurement and Calculation Setup’ on 
page 7-74 for more information.
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EFW for OB User Table/Formula Editor

EFW Table Editor

You can edit an EFW Formula at the OB Table Editor. 

1. Select Utility -> Measure -> OB Table.

2. Select the appropriate parameters and press Edit Table.

• New/Edit: Select “New Table”

• OB Table Template: Select appropriate template.

• Tool Type: Select “Weight”

• Measure Name: Enter measurement name.

• Author Name: Enter author’s name.

• Table Type: Select “Fetal Age”

Figure 8-19. OB Table Tab Screen
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EFW Table Editor  (continued)

3. Edit the table data and press Exit To Save.

Figure 8-20. OB Table Editor Screen

EFW Formula Editor

1. Select the M&A tab and select Edit Calc. The Modify User 
CALC window displays.

Select the user table previously added from the User 
Defined pull-down menu and press OK.

2. Select the “Calculated” button for the EFW parameter.

3. The EDIT FORMULA window displays. Edit the formula and 
select OK.

NOTE: When you edit a formula, be careful of the following points.

• If you want to calculate EFW by centimeter, add “ *100 ” to 
the {parameter}.

• If EFW is calculated in grams, add “ /1000 “ to the formula.

or example,

10^(1.56{AC[Hadlock]}*100+0.08*{FL[Hadlock]}*100)/1000
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GYN

Introduction

The Gynecology exam category includes the following three 
studies:

• Generic. This study is common to all exam 
categories.‘Generic Measurements’ on page 7-18. 

• General Gynecology. This study includes uterine, ovarian, 
ovarian follicle, and endometrium measurements.

• OB/GYN Vessel. This study includes the following vessels: 
uterine, ovarian, umbilical, middle cerebral artery, aorta, 
placenta, and descending aorta.

NOTE: The calculation formulas are listed in the Advanced Reference 
Manual.

B-Mode Measurements

In B-Mode, you make the measurements in the General 
Gynecology study. These measurements include: 

• Ovarian follicle

• Endometrium thickness

• Ovarian length, width, and height

• Uterine length, width, and height 

• Cervix

• Fibroid
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Follicle measurements

You can make left and right ovary follicle measurements from 
one, two, or three distances. 

To select the left or right, adjust the Side selection.

Endometrium thickness

To measure the endometrium thickness, make one distance 
measurement.

1. Select Endometrium; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the endometrium thickness in the 
Results Window.
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Ovary length, width, and height 

You can measure the length, width, and height of the left and 
right ovaries. Each measurement is a typical distance 
measurement made in the appropriate scan plane. 

Typically, length and height are measured on the sagittal plane 
while the width is measured on the axial/transverse plane.

To measure ovarian length, width, or height:

1. Scan the patient's right or left ovary in the appropriate plane.

2. To select left or right, adjust the Side selection.

3. Select the OV folder, then select OV L, OV W, or OV H. 

4. Perform a standard distance measurement.

Uterus length, width, and height

Each of these is a standard distance measurement. Typically, 
length and height are measured on the sagittal plane while the 
width is measured on the axial/transverse plane.

To measure uterus length, width, or height:

1. Scan the patient in the appropriate scan plane. 

2. Select the UT folder, then select UT L, UT W, or UT H. 

An active caliper displays.

3. Perform a standard distance measurement.

Cervix measurements

You can make cervix measurements from one distance or spline 
trace. 
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Cardiac

Overview

Cardiology measurements offer two different types of 
measurement studies, Generic and Cardiac. 

• Generic–Common to all applications. See ‘Generic 
Measurements’ on page 7-18 for more information..

• Cardiac – This study includes all cardiac measurements. 

Naming Format for Cardiac Measurements

When you make a measurement, on the Touch Panel you select 
the abbreviation for the measurement. Most abbreviations are 
made using acronyms. The following table lists acronyms used 
for naming cardiac measurements. 

Table 8-10:  Cardiology Abbreviations 

Acronym Name

% STIVS % Interventricular Shortening

A Area

Acc Acceleration

AccT Flow Acceleration Time

ALS Aortic Leaflet Separation

Ann Annulus

Ao Aorta

AR Aortic Regurgitation

Asc Ascending

ASD Atrial Septal Defect

AV Aortic Valve

AV Cusp Aortic Valve Cusp Separation

AVA Aortic Valve Area

AV-A Aortic Valve Area by Continuity Equation
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BSA Body Surface Area 

CI Cardiac Index

CO Cardiac Output

d Diastolic

D Diameter

Dec Deceleration

DecT Deceleration Time

Desc Descending

Dur Duration

EdV End Diastolic Volume

EF Ejection Fraction

EPSS E-Point-to-Septum Separation

EsV End Systolic Volume 

ET Ejection Time

FS Fractional Shortening

FV Flow Volume

FVI Flow Velocity Integral

HR Heart Rate

IVRT IsoVolumetric Relaxation Time

IVS Interventricular Septum

L Length

LA Left Atrium

LAA Left Atrium Area

LAD Left Atrium Diameter

LPA Left Pulmonary Artery

LV Left Ventricle

LVA Left Ventricular Area

LVID Left Ventricle Internal Diameter

LVL Left Ventricle Length

LVM Left Ventricular Mass

Table 8-10:  Cardiology Abbreviations  (Continued)

Acronym Name
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LVPW Left Ventricle Posterior Wall

ML Medial to Lateral

MPA Main Pulmonary Artery

MR Mitral Regurgitation

MV Mitral Valve

MVcf Mean Velocity Circumferential Fiber Shortening

MVO Mitral Valve Orifice

OT Outflow Tract

P Papillary Muscles

PA Pulmonary Artery

PAP Pulmonary Artery Pressure

PDA Patent Ductus Arterosis

PEP Pre-Ejection Period

PFO Patent Foramen Ovale

PG Pressure Gradient 

PHT Pressure Half Time

PI Pulmonary Insufficiency

PISA Proximal Isovelocity Surface Area

PR Pulmonic Regurgitation

PV Pulmonic Valve

PV-A Pulmonic Valve Area by Continuity Equation

PVein Pulmonary Vein

PW Posterior Wall

Qp Pulmonic Flow or CO

Qs Systemic Flow or CO

RA Right Atrium

RAA Right Atrium Area

Rad Radius

RAD Right Atrium Diameter

RPA Right Pulmonary Artery

Table 8-10:  Cardiology Abbreviations  (Continued)

Acronym Name



Application M&A

8-48 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

In this manual, the abbreviation for each measurement is listed 
in parenthesis after the measurement, as follows:

• Aortic Root Diameter (Ao Diam)

• Left Ventricle Posterior Wall Thickness, Diastolic (LVPWd)

For example, to measure the Aortic Root Diameter, you select 
Ao Diam on the Touch Panel.

RV Right Ventricle

RVA Right Ventricle Area

RVAW Right Ventricle Anterior Wall

RVD Right Ventricle Diameter

RVID Right Ventricle Internal Diameter

RVL Right Ventricle Length

RVOT Right Ventricle Outflow Tract

s Systolic

SI Stroke Index

ST Shortening

SV Stroke Volume

SVI Stroke Volume Index

T Time

TA Tricuspid Annulus

TAML Tricuspid Annulus Medial to Lateral

TR Tricuspid Regurgitation

TV Tricuspid Valve

TVA Tricuspid Valve Area

Vcf Velocity Circumferential Fiber Shortening

Vel Velocity

VET Valve Ejection Time

Vmax Maximum Velocity

Vmean Mean Velocity

VSD Ventricular Septal Defect

VTI Velocity Time Integral

Table 8-10:  Cardiology Abbreviations  (Continued)

Acronym Name
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Cardiac Doppler Measurements

E/E’ Ratio

The ratio of early transmitral velocity to early diastolic velocity of 
the mitral annulus (E/E’) is measured in Doppler Mode and TVD 
mode.

1. First, measure MV E/A Velocity to get “E”.

2. Measure E’.

The system calculates E/E’ ratio automatically.
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Vascular

Introduction

Vascular measurements offer several different types of 
measurement studies:

Figure 8-21. Vascular Exam Category Touch Panel

• Generic – Common to all applications. See ‘Generic 
Measurements’ on page 7-18 for more information..

• Carotid

• LEA (Lower Extremity Artery)

• LEV (Lower Extremity Vein)

• TCD (Trans Cranial Doppler)

• UEA (Upper Extremity Artery)

• UEV (Upper Extremity Vein)

• Renal

• Bypass Graft

• UEV (Upper Extremity Vein) Map

• LEV (Lower Extremity Vein) Map
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Introduction  (continued)

A vascular study is a group of particular vessels. You can 
customize the vessel exam calcs in the configuration menu. See 
‘Measurement and Calculation Setup’ on page 7-74 for more 
information..

When you use Auto Vascular calculation, you use the vessel 
keys on the Touch Panel to post-assign vascular calculations. 
When you are not using Auto Vascular calculation, the vessel 
key is used for manual measurement.

Naming format for vessels

When you want to measure a vessel, on the Touch Panel you 
select the folder for the vessel. Many vessel folders are labeled 
with an abbreviation. The following table lists abbreviations used 
for naming vascular vessels. 

Table 8-11:  Vascular Vessel Abbreviations

Acronym Name

ACA Anterior Cerebral Artery

Acc RA Accessory Renal Artery

AComA Anterior Communicating Artery

Anast Anastomosis

ArcA Arcuate Artery

ATA Anterior Tibial Artery

ATV Anterior Tibial Vein

AVF Arteriovenous Fistula

Axill Axillary Artery

Axill V Axillary Vein

BA Basilar Artery or Brachial Artery

Bas V Basilic Vein

BasV Antecub Basilic Vein Antecubital Fossa

BIF IMT F/N Bifurcation Intima Media Thickness Far/Near

Brac V Brachial Vein

CA Celiac Artery

CCA Common Carotid Artery
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Ceph V Cephalic Vein

Ceph V Antecub Cephalic Vein Antecubital

CFA Common Femoral Artery

CFV Common Femoral Vein

CHA Common Hepatic Artery

Com Femoral Common Femoral Artery

CIA Common Iliac Artery

CIV Common Iliac Vein

Com Iliac A Common Iliac Artery

DFA Deep Femoral Artery

DFV Deep Femoral Vein

Dors Pedis Dorsalis Pedis

DPA Dorsalis Pedis Artery

ECA External Carotid Artery

EIA External Iliac Artery

EIV External Iliac Vein

Fr. Branch Frontal Branch

FV Femoral Vein

GBWall Gall Bladder Wall

GDA Gastroduodenal Artery

GR Graft

GSV Greater Saphenous Vein

HA Hepatic Artery

Hilar A Hilar Artery

HV Hepatic Vein

IIA Internal Iliac Artery

IIV Internal Iliac Vein

ICA Internal Carotid Artery (Transcranial Doppler)

ICA Interior Carotid Artery (Carotid Artery)

IJV Internal Jugular Vein

Table 8-11:  Vascular Vessel Abbreviations (Continued)

Acronym Name
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IMA Inferior Mesenteric Artery

IMT Intima Media Thickness

IMV Inferior Mesenteric Vein

Inn Innominate

Int. Lobular A Interlobular Artery

IVC Inferior Vena Cava

LSV Lesser Saphenous Vein

MCA Middle Cerebral Artery

Mcub V Median Cubital Vein

Mid Hep V Middle Hepatic Vein

MPV Main Portal Vein

MRA Main Renal Artery

Par. Branch Parietal Branch

PCA Posterior Cerebral Artery

PComA Posterior Communicating Artery

Peron Peroneal

POP Popliteal

Pseudo False Artery (aneurysm)

PTA Posterior Tibial Artery

PTV Posterior Tibial Vein

PV Portal Vein

RA Renal or Radial Artery

RV Renal or Radial Vein

SA Splenic Artery

Sap Fem Junc Sapheno-Femoral Junction

Seg. A Segmental Artery

SFA Superficial-Femoral Artery

SFJV Sapheno-Femoral Junction Vein

SMA Superior Mesenteric Artery

SMV Superior Mesenteric Vein

Table 8-11:  Vascular Vessel Abbreviations (Continued)

Acronym Name
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SSV Small Saphenous Vein

STA Superficial Temporal Artery

SUBC Subclavian Artery

SUBC V Subclavian Vein

SV Splenic Vein

SV Pop Junc Small Saphenopopliteal Junction

TCD Transcranial Doppler

TIPS Transjugular Intrahepatic PortalSystemic Shunt

UA Ulnar Artery

UV Ulnar Vein

VERT Vertebral Artery

VES Vessel

Table 8-11:  Vascular Vessel Abbreviations (Continued)

Acronym Name
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IMT Measurement

You can measure the average of the intima media thickness for 
use as the index of arterial sclerosis. 

IMT can be measured both on the posterior and the anterior 
walls of the vessel.

NOTE: Due to the physical properties of ultrasound imaging, the 
posterior IMT measurement is generally more accurate than the 
anterior IMT measurement.

IMT Measurement - Auto

Auto IMT automatically measures the thickness of the Intima 
Media on the far and near vessel walls. Near Wall IMT is the 
distance between the trailing edges of the adventitia and intima; 
the Far Wall IMT is the distance between the leading edges of 
the adventitia and intima. 

Set up the parameters you want to record on the worksheet on 
the Utility -> Measure -> M&A page while are in the Carotid 
application. Select CCA/ICA/BIF -> IMT Far/Near -> Parameter 
(Average, Max, Min, Standard Deviation, Points, or Distance). 

Figure 8-22. Configuring Auto IMT
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IMT Measurement - Auto  (continued)

In the Vascular Carotid application, the Auto IMT measurement 
is available. 

Figure 8-23. Auto IMT Touch Panel 

The following controls are available. 

Table 8-12:  Auto IMT Touch Panel Description

Parameter Description

Worksheet Select to view the Worksheet

IMT Far Select to begin the Far Field IMT measurement. 

IMT Near Select to begin the Near Field IMT measurement. 

AP Anterior Posterior

Trans Transverse

Length/Offset Rotary Push to save Length/Offset as a preset. 

-40/+40 Length. At zero, you can freely adjust the length, but only vertically. 

Press key to save value as default.

Offset distance, -20 (Left) / +20 (Right)

Overall / IMT Trace Fit / 

Intima

Adjusts (remeasures) the IMT automatically measured by the system. 

Rt / Lt Side Select Left / Right Side. 

Cursor Select Allows you to update cursor placement. 
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IMT Measurement - Auto  (continued)

To measure the IMT, 

1. In the Carotid application, press Freeze, press Measure. 

2. Position the cursor, then select IMT Far. 

3. Use the Trackball to set the length.

Or

Use the Length / Offset control on the Touch Panel to set 
the length and offset distance. The Offset key controls how 
far away from the vertical line the measurement starts. 
Length is the length of the tool itself. If set to zero, you can 
adjust it anywhere on the image. 

4. Press Set. 

You can either adjust the trace prior to pressing the Print key 
or press the Print key to store the image which also saves 
the measurement to the Worksheet.

To adjust the trace, use the Overall IMT Trace Fit Intima 
control on the Touch Panel. The Trace fit (up/down) adjusts 
the inter luminal line whereas the overall (rotate) adjusts 
both IMT lines.

Figure 8-24. Example of Auto IMT Far Measurement
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IMT Measurement - Auto  (continued)

5. Position the cursor, then select IMT Near. 

6. Use the Trackball to set the length.

Or

Use the Length / Offset control on the Touch Panel to set 
the length and offset distance.

7. Press Set.  “Store image to accept IMT measurement” 
displays in the message area. If the traces fit both layers of 
the wall, approve the measurement by pressing the Print 
key to store the image. 

To adjust the trace prior to pressing the Print key, use the 
IMT Trace Fit control on the Touch Panel. The measurement 
is saved to the Worksheet. 

NOTE: Since the IMT measurements are semi-automatic, the 
operator has to approve the detection by visual inspection 
before storing the results in the worksheet and report.

IMT Measurement - Manual

1. Before you measure the IMT, add the IMT measurement to 
the Carotid folder via the Measurement & Analysis screen 
(by selecting one of the three types of IMT measurements 
under Add Measurement in the M&A screen).  

• IMT: Three vertical lines are parallel. Place the start 
point on the line and place the end point anywhere.

• IMT2: Each vertical line can be rotated with the Ellipse 
control. You must place the start and end points on the 
line.

• 5mm Scale: The horizontal line can be rotated with the 
Ellipse control. A maximum of 20 distance values which 
produce one average value can be taken. The number 
of distance values is specified when adding the 
measurement in the M&A screen.

IMT and IMT2 have three kinds of measurements:

• IMT --+/IMT2 --+: Measure from right to left. 

• IMT -+-/IMT -+-: First measure at the center, then right 
and left are last. 

• IMT+--/IMT2 --+: Measure from left to right. 

2. Acquire a longitudinal scan of the carotid artery and 
optimize the image. Then press Freeze. 

3. Scroll to an end-diastolic frame where the intima layer is 
clearly visible.



Vascular

LOGIQ Fortis – Basic User Manual 8-59
5855997-1EN Rev. 3

IMT Measurement - Manual  (continued)

4. Press Measure, then select IMT1, IMT2 or 5mm scale. An 
active caliper displays. 

Figure 8-25. IMT caliper (Example)

5. Use the Trackball to move the caliper and the Ellipse 
control to adjust the angle. Press Set to fix the caliper. 

NOTE: The interval of the vertical line for IMT1 and IMT2 is 1cm 
and for the 5mm scale is 5mm. 

6. Measure the thickness of three points for IMT1 and IMT2.

OR

Measure the thickness of the specified number of points for 
the 5mm scale.

NOTE: The caliper moves to the next point automatically. 
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IMT Measurement - Manual  (continued)

7. After you complete the measurement, the system calculates 
the average automatically. 

Figure 8-26. IMT Measurement

IMT Measurement - Manual C(10)

1. Before you measure the IMT C10, create the IMT C10 
measurement in the Carotid folder via the Measurement & 
Analysis screen.

• IMT C10: Two vertical lines are parallel. One is the base 
line. Each vertical line can be rotated with the Ellipse 
control. Place the start point on the line and place the 
end point anywhere.

• IMT2 C10: Two vertical lines are parallel. One is the 
base line. Each vertical line can be rotated with the 
Ellipse control. You must place the start and end points 
on the line. 

IMT C10 and IMT2 C10 have two kinds of measurements:

• IMT C10 -+/IMT2 C10 -+: Base vertical line shows right 
side. 

• IMT C10 +-/IMT2 C10 +-: Base vertical line shows left 
side. 
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IMT Measurement - Manual C(10)  (continued)

2. Acquire a longitudinal scan of the carotid artery and 
optimize the image. Then press Freeze. 

3. Scroll to an end-diastolic frame where the intima layer is 
clearly visible.

4. Press Measure, then select IMT C10. An active caliper 
displays.

Figure 8-27. IMT C10 Active Caliper

5. Use the trackball to move the caliper and the Ellipse control 
to adjust the angle. Press Set to fix the caliper. 

NOTE: The interval of the vertical line for IMT1 and IMT2 is 1cm.

6. Measure the thickness for IMT C10. 
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IMT Measurement - Manual C(10)  (continued)

7. After you complete the measurement, the system shows 
base vertical line.

NOTE: The base vertical line length is 1cm.

Figure 8-28. Base Vertical Line
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Plaque Score Tool

1. Before you measure, add Plaque Score to the Carotid folder 
at the Utility -> Measure -> Measurement & Analysis screen 
(by selecting 2D Plaque Score under Add Measurement in 
the M&A screen).

Label the parameters you want measured:

• Distance value (up to 20)

• Sum (greater or equal to 1.1 mm)

• Count (greater or equal to 1.1 mm)

• Maximum value of each area

• Average value

• Average value of each area

2. Scan the carotid artery and press Freeze. Display dual 
images to measure across split screen images.

3. Press Measure and select Plaque Score Tool. An active 
caliper, one horizontal line and five vertical lines display. The 
interval of the vertical lines are 1.5 cm.

Figure 8-29. Plaque score example

4. Use the Trackball to move the caliper and the Ellipse 
control to adjust the angle. Press Set to fix the caliper. 
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Plaque Score Tool  (continued)

5. Measure the thickness (up to twenty times) on any place as 
necessary.

Figure 8-30. Plaque Score Example 2

6. The system displays the measurement result.

Figure 8-31. Plaque Score Example 3

NOTE: Only calculates the value larger than 1.1mm.

7. Double click the Set key to finish the measurement.
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Auto Vascular Calculation

Auto Vascular Calculation enables the LOGIQ Fortis to detect 
and identify a cardiac cycle. It allows you to assign 
measurements and calculations during live timeline imaging, 
while the image is frozen, or in CINE. Peak values are detected 
for venous flow.

During cardiac cycle detection, the system identifies the cardiac 
cycle using calipers, vertical bars, and/or highlighting of timeline 
data. Use of identifiers is based on measurements and 
calculations selected by an operator for the current application. 
The system may place calipers at early systolic peak, peak 
systole, minimum diastole and end diastole. Vertical bars may 
also be placed to indicate the beginning and end of the cardiac 
cycle. The peak and/or mean trace may be highlighted. You can 
edit the cardiac cycle identified by the system or select a 
different cardiac cycle.

You can select the calculations to be displayed in the M&A 
Result window during live scanning or on a frozen image. These 
calculations are displayed at the top of M&A Result Window 
located adjacent to the image. These calculations are 
presettable by application which means you can set up the 
default calculations to be displayed for each application.

Activating Auto Vascular Calculation

To activate Auto Vascular Calculation, select Auto Calc from 
Live (calculations displayed on the real-time image), or Freeze 
(calculations displayed on the frozen image).

To deactivate Auto Vascular calculation, select Off.

Figure 8-32. Auto Calculation Touch Panel key
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Setting up Auto Vascular Calculation Parameters

• Selecting Auto Trace

You can select to have a continuous auto trace of the max or 
mean velocities.

• Select Max or Mean using the Trace Method Touch 
Panel pull-down menu.

• Selecting Trace Direction

Trace Direction lets you use peak timeline data above, 
below, or composite (above and below) the baseline. 

• Select Positive, Negative or Both to set the peak 
timeline data.

• Modify Calculation

a. Select the Modify Calcs Touch Panel key. 

The Modify Calculation menu is displayed. 

b. Select which measurements and calculations are to be 
displayed in the Auto Vascular calculation window.

You can select the following parameter: PS, ED, MD, 
HR, TAMAX, PI, RI, Accel, PS/ED, ED/PS, AT, Volume 
Flow, PV.

Auto Vascular Calculation Exam

1. Preset the system.

2. Perform the scan and press Freeze.

3. Activate Auto Vascular Calculation.

The system performs a calculation automatically.

Figure 8-33. Auto Vascular Calculation
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Auto Vascular Calculation Exam  (continued)

The Auto Vascular calculation is assigned to particular vessel 
measurements.

1. Press Measure to display the Measurement menu.

2. Select the location of the vessel (Prox, Mid, or Dist) and 
Side (Right or Left).

3. Select the desired vessel name from the Touch Panel. 

Selected vessel measurements are automatically assigned 
with the Auto Vascular calculation. The results are then 
displayed in the Results Window.

Figure 8-34. Assigned Vessel

NOTE: When you want to cancel the assignment, you can use the 
Cancel Transfer Touch Panel key. See ‘Cancel Transfer’ on 
page 7-32 for more information..
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Auto Vascular Calculation  (continued)

During the course of an exam, the cardiac cycle may be 
indicated between two yellow bars; the peak trace and the mean 
trace may appear in green; calculation indicators appear on the 
spectral trace as a caliper identifier (these vary, depending on 
the selected calculation in the Results Window). 

The right-most, most complete cycle is typically chosen to be the 
selected cardiac cycle. You can select a different cardiac cycle. 

To select a different cardiac cycle:

• Move through CINE memory with the Trackball until the 
desired cardiac cycle is selected by the system.

NOTE: You need several good cycles in front of the new cardiac 
cycle for this to be successful. Oftentimes, this is 
problematic near a freeze bar.

• Use the Cycle Select control to cycle to a different cardiac 
cycle.

NOTE: You need several good cycles in front of the new cardiac cycle 
for this to be successful. Oftentimes, this is problematic near a 
freeze bar.

To move the systole or diastole position:

• Use the Cursor Select control to move the start systole 
position or the end diastole position.
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Manual Vascular Calculation

You can perform the following calculations manually when Auto 
Doppler Calculation is not activated.

1. Press Measure.

If necessary, you can select another Exam Calc and then 
select parameters from Modify Calculation.

2. Select the location of the vessel (Prox, Mid, or Dist) and 
Side (Right or Left).

3. Select the desired vessel folder.

The Measurement menu is displayed.

Figure 8-35. Measurement Menu Example

4. Make the required measurements according to the system, 
or select your preferred measurements.

To select vascular measurements

Your system is set up to show the measurements that you 
usually make for each vessel. To make a measurement that is 
not shown for the selected vessel:

1. Select the folder for the vessel you want to measure.

2. Select Show All. 

The system displays all possible vessel measurements.

3. Select the desired measurement.

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.
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Intravessel ratio

On the Vessel Worksheet page, to calculate the Intravessel 
ratio, you need a measurement of assessing pressure and 
stenotic velocities.

1. Select Intrav. Ratio from the Touch Panel. The Intravessel 
Ratio pop-up window displays in the header section of the 
worksheet.

Figure 8-36. Intravessel Pop-up Window

2. Select the first velocity. The value displays in the window.

The value is displayed in the window.

Figure 8-37. Intravessel ratio one
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Intravessel ratio  (continued)

3. Select the second velocity.

The second value and Result value display in the window.

Figure 8-38. Intravessel ratio two

• To save the Intravessel ratio to the Vessel Summary, move 
the cursor to Save and press Set.

• To clear values, move the cursor to Clear and press Set.

• To cancel and exit Intravessel ratio, move the cursor to 
Cancel and press Set.

NOTE: Intravessel Ratio is only displayed and saved in the Vessel 
Summary as Intra-Ratio.

Figure 8-39. Vessel Summary Example
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Bypass Graft Anastomosis Graph 

If there aren’t any known Grafts associated with the current 
exam, you can create a Graft by describing its anastomosis 
locations and anastomosis modifiers. 

NOTE: You can always create another new Graft by selecting one from 
the “Choose to Add” table, and then modifying it into what you 
want. 

To graph Bypass Graft anastomosis, 

1. Select Bypass Graft on the Touch Panel. The Add/Edit 
Grafts pop-up appears. 

NOTE: This pop-up appears if there are not any known Grafts. 

Figure 8-40. Add/Edit Graft

2. Use the Trackball to assign graft locations on the Add/Edit 
Grafts pop-up. Press Continue. 

NOTE: You can select a Graft by choosing it in the table of Grafts 
that exist in the current exam. 

NOTE: You can always modify the selected Graft by choosing new 
anastomosis locations and anastomosis modifiers. 

NOTE: The Stent pop-up is nearly identical to the Graft pop-up, 
except that you also have the ability to specify the Stent’s 
laterality. 



Vascular

LOGIQ Fortis – Basic User Manual 8-73
5855997-1EN Rev. 3

Bypass Graft Anastomosis Graph  (continued)

3. Graft assignments now appear on the Touch Panel: This is 
saved on the system and can be edited. Specify the 
Topographic Modifier (location), Stenosis Modifier, and 
Anatomic Modifier for any measurement you would like to 
take. 

Figure 8-41. Graft table update

NOTE: For each measurement within a blood vessel, you can 
choose a Topographic Modifier (i.e., location) and a 
Stenosis Modifier. For Grafts and Stents, you can also 
choose an Anatomic Modifier (i.e., eye, ankle, or liver). 

4. To edit the Bypass Graft Anastomosis, select the “Edit 1/1” 
toggle on the Touch Panel to specify which of the Grafts you 
are measuring within. 

HINTS Very Important: When creating Grafts or Stents, it is always 
recommended to perform the accompanying 
measurements. The measurements folder can be found in 
the lower, right-hand portion of the Touch Panel. 
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Bypass Graft Anastomosis Graph  (continued)

5. On the Doppler Mode M&A Touch Panel, you have the 
option to select the Stenosis Modifiers, Pre-Steno, At-Steno, 
or Post-Steno. 

Figure 8-42. Select the Stenosis Modifier
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Urology

Introduction

Urology measurements offer three different types of 
measurement studies:

• Generic–Common to all applications. See ‘Generic 
Measurements’ on page 7-18 for more information..

• Urology

• Pelvic Floor. See ‘Pelvic Floor Measurements’ on page 8-78 
for more information.

NOTE: Bladder(0.7) Vol, Bladder Vol, Post Void Vol, Prostate Vol, Renal 
Vol, Renal (0.8) Vol and Volume can be displayed on the Touch 
Panel if preset at the Utility -> Measure screen.

Bladder Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 8-43. Bladder Volume Touch Panel
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Renal Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

To select the left or right, adjust the Side selection.

To measure Renal Volume:

Prostate Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 8-44. Prostate Volume Touch Panel
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Prostate Volume  (continued)

PSA Measurement

If you enter the value of PSA (Prostatic Specific Antigen) and 
PPSA Coefficient at the Urology Patient screen, PSAD and 
PPSA are automatically calculated.

The values are displayed on the Worksheet and Report (if set 
appropriately on the Report Designer page).

Figure 8-45. Urology Patient Screen

Figure 8-46. Measurement result window

PSAD: Prostatic Specific Antigen (PSA) Density – defined as: 
PSAD = PSA/Volume

PPSA: Predicted Prostate Specific Antigen – defined as:  PPSA 
= Volume x PPSA Coefficient 



Application M&A

8-78 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Pelvic Floor Measurements

Pelvic floor measurements can be performed in the Pelvic Floor 
study. The measurements are located in the Exam Calc folder in 
the Urology preset. 

Figure 8-47. Pelvic Floor Study Touch Panel

BN (Bladder Neck) Rest

Obtain an image with the patient at rest (relaxed).

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position 
the caliper at the anterior margin of the bladder neck. A 
positive number displays since the caliper is placed below 
the baseline.

3. A distance is calculated in millimeters.

BN (Bladder Neck) Stress

Obtain an image after the patient performs the Valsalva 
maneuver.

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position 
the caliper at the anterior margin of the bladder neck. 

If the bladder neck is below the baseline, the Bladder Neck 
Stress is a positive number. If the bladder neck is above the 
baseline (closer to the transducer face), the number is 
negative.
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Pelvic Floor Measurements  (continued)

BN (Bladder Neck) Descent

The Bladder Neck Descent is a calculation that should be 
calculated after measuring the Bladder Neck Rest and Bladder 
Neck Stress. 

BND = Bladder Neck Rest - Bladder Neck Stress

NOTE: If the Bladder Neck Stress is a negative number, it becomes 
positive and is added to the bladder neck rest measurement.

DWT (Detrusor Wall Thickening)

Three distance measurements of the bladder wall dome are 
calculated into a mean dimension and displayed in millimeters.

UT (Uterine) Descent Max

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position 
of the uterus in a stress image and display in millimeters

Rect Amp Des Max (Rectal Ampulla Descent Max)

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position 
of the rectal ampulla in a stress image and displayed in 
millimeters

Rectocele (Depth and Width)

Two 2-caliper diameter measurements to measure depth and 
width of the rectocele. Displayed in millimeters.
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Pelvic Floor Measurements  (continued)

Lev Hiat Stress (Levator Hiatus Stress)

Two 2-caliper diameter measurements and calculate an area 
displayed as cm squared.

Residual Urine

Two 2-caliper diameter measurements calculate as:

(x) times (y) times 5.9 minus 14.9 equals Residual Volume 
displayed in ml.
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Pediatrics

Overview

Pediatrics measurements offer two different types of 
measurement studies:

• Generic. The Generic Calculations study is common to all 
applications. See ‘Generic Measurements’ on page 7-18 for 
more information..

• Pediatric Hip (PedHip). 

Figure 8-48. Touch Panel - Pediatrics Exam Calcs
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Pediatrics Hip

Figure 8-49. B-Mode Measurement Touch Panel – PedHip

Hip Dysplasia Measurement

The HIP calculation assists in assessing the development of the 
infant hip. In this calculation, three straight lines are 
superimposed on the image and aligned with the anatomical 
features. The two angles are computed, displayed, and can be 
used by the physician in making a diagnosis.

The three lines are:1

1. The baseline connects the osseous acetabulum convexity to 
the point where the joint capsule and the perichondrium 
unite with the iliac bone.

2. The inclination line connects the osseous convexity to 
labrum acetabulare.

3. The Acetabulum roof line connects the lower edge of the 
osilium to the osseous convexity.
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Hip Dysplasia Measurement  (continued)

The α (Alpha) angle is the supplement of the angle between 1 
and 3. It characterizes the osseous convexity. The β (Beta) 
angle is the angle between lines 1 and 2. It characterizes the 
bone supplementing additional roofing by the cartilaginous 
convexity.

Figure 8-50. Hip Dysplasia 

1Source: R GRAF, Journal of Pediatric Orthopedics, 4: 
735-740(1984)

To make a Hip Dysplasia measurement: 

1. From the Touch Panel, select either the right or left side 
(orientation) and then select Beta Alpha HIP. 

A horizontal dotted line displays. 

2. To place the baseline, move the Trackball. Position the 
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

4. To fix the baseline, press Set. 

The system displays a second dotted line at an angle.

Anatomical Landmarks

a. Ilium

b. Iliac Bone

c. Labrum

d. Bony Roof

e. Cartilaginous acetabular roof

f. Femoral Head
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Hip Dysplasia Measurement  (continued)

5. To place the line along the inclination line of the osseous 
convexity to labrum acetabulare, move the Trackball. 

6. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

7. To fix the second measurement line, press Set.

The system displays a third dotted line at an angle.

8. To place the caliper along the acetabular roof line, move the 
Trackball. 

9. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

10. To fix the third measurement line and complete 
measurement, press Set. 

The system displays the hip measurements (α and β) in the 
Results Window.

Alpha HIP

The Alpha HIP measurement measures the angle between the 
iliac baseline and the bony roof line. To make an Alpha HIP 
measurement: 

1. From the Touch Panel, select either the right or left side 
(orientation) and then select Alpha HIP. 

A horizontal dotted line displays. 

2. To place the baseline, move the Trackball. Position the 
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate.

4. To fix the baseline, press Set. 

The system displays a second dotted line at an angle. 

5. To place the caliper along the acetabular roof line, move the 
Trackball.

6. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

7. To fix the second measurement line, press Set. 

The system displays the alpha hip measurement (α) in the 
Results Window.
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d:D Ratio Measurement

The d:D Ratio measurement measures the percentage of the 
femoral head coverage under the bony roof. To make this 
measurement:

1. From the Touch Panel, select either the right or left side 
(orientation) and then select d:D Ratio. 

A horizontal dotted line displays. 

2. Use the Trackball to place the baseline along the ilium. 
Position the crosshairs edge at the osseous convexity of the 
ilium.

3. Use the Ellipse control to adjust or change inclination or Hip 

Rotate. 

4. Press Set to fix the baseline. 

5. The system displays a circle representing the femoral head. 
Use the Trackball to position the circle.

6. Use the Ellipse control to size the femoral head 
circumference.

7. Press Set to fix the femoral head circumference. 

The system displays the d:D ratio for the femoral head in the 
Results Window.
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Chapter 9

Recording images

Describes how to record images. 
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Getting Set Up to Record Images

Overview

A typical workflow for connectivity might be as follows (this setup 
varies by each user setup): 

1. Select the dataflow, worklist for example. 

2. Start a new exam. Select the patient. 

3. Perform the patient scan.

4. Store images as multi-frame CINE Loops and Raw DICOM 
data via the P1 key. 

5. Store secondary capture for DICOM print via P2 key. 

6. Store images to the color printer or B/W printer via P3 key. 

7. Check the DICOM Job Spooler via F4 to verify delivery. 

8. End the exam. 

9. Permanently store images via the Patient menu to 
permanent storage. 

During an examination, the operator stores data, images and 
cineloops for immediate purposes. The LOGIQ Fortis includes 
an integrated patient archiving system for data and image 
storage.

The LOGIQ Fortis enables also storing of data and images to 
external databases (removable media).
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Overview  (continued)

Dataflow combines archive, data, DICOM, and onboard records 
into one coherent workflow. Destination devices are configured 
and assigned to the print keys. You select the appropriate 
dataflow (Portable, etc.) according to your requirements. You 
manage the patient database (local, shared, or via a worklist 
broker). 

• DO NOT use the internal hard drive for long-term image 
storage. Daily backup is recommended. External storage 
media is recommended for image archive.

NOTE: DICOM images are stored to external media storage 
devices separately from patient data, which also needs to be 
backed up to a dedicated database-formatted external 
storage media. 

• If working off-line with a dataflow pointing to a DICOM 
server, the images stored during the examination may have 
to be manually resent in the DICOM spooler when 
reconnecting the unit. Resend all jobs that failed or are on 
hold.

In addition, stored images and cineloops can be saved to a 
removable media in the standard formats JPEG, MPEG, 
WMV, and DICOM.

• You need to set up a process for locating images stored to 
external storage media for easy recall

• GE IS NOT responsible for lost data if you do not follow 
suggested back-up procedures. GE WILL NOT aid in the 
recovery of lost data. 

Refer to the Customizing Your System chapter for instructions 
on setting up your system’s connectivity. 



Recording images

9-4 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Image Management Guide

Save As to View 

on any PC 
Use this to save images in a computer-friendly format so you 
can view it on any PC.

EZBackup Images 

to Archive

Use this to take images off your Ultrasound system onto 
removable media for long-term archive. This is the way to free 
up hard disk space, rather than deleting images. 

Export/Import 

Data/Images 

Between Systems

Use this to copy both patient data and images for specified 
patient(s) from one system to another. 

Media Requirements

The system ONLY supports medical grade CD-R, DVD-R, USB 
Hard Disk Drive, and USB Flash Drive. 

The system DOES NOT support CD-RW / DVD+R / DVD-RW / 
DVD+RW / or DVD-RAM. 

Media Handling Tips

Always finalize the media. This allows you to read them on any 
other PC. 

DO NOT finalize the media if you want to add more images.

To eject the media, always press F3. DO NOT press the eject 
button on the drive: 

1. Press F3. The Eject device menu is displayed. 

2. Select the relevant media.

3. Select USB Drive from the pull-down menu to disconnect 
the USB Drive. Disconnect the USB drive after the success 
dialogue is displayed. 

Remove the USB Drive from the USB port. 

NOTE: If the unsuccessful dialogue is displayed, retry after a while.

NOTE: Verify is NOT available on Flash Drive or Hard Disk Drive 
media.

CAUTION DO NOT use or attempt to format CD-RW, DVD+R, DVD-RW,  
DVD+RW, or DVD-RAM media.
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Adding Devices

To add a destination device (printer, worklist server, etc.) to this 
system, see ‘Device’ on page 10-66.

To verify a DICOM device, see ‘Device’ on page 10-66.

Adding a Dataflow

To add a new dataflow to this system, see ‘Dataflow’ on 
page 10-84.

Adding Devices to a Print Button

To add devices/dataflows to a print button, see ‘Button’ on 
page 10-85.

Formatting Removable Media

To format removable media, see ‘Formatting removable media’ 
on page 10-88.
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Storing Images and Cineloops

Images and cineloops that are stored during a current 
examination are displayed as thumbnails on the clipboard.

When an image is stored, all the additional information that is 
displayed is saved with it (i.e. probe and application selected, 
image setting, annotations or measurements).

See Dataflow in Connectivity for detailed settings related storing 
image/Cine.

Image archive is set by the dataflow selected (See Dataflow in 
Connectivity for more information.)

When you want to print/store an image, P1 is most commonly 
used for the primary destination and internal hard drive.

Storing an image

To store an image, 

1. While scanning, press Freeze. 

2. Scroll through the cine Loop and select the desired image. 

3. Press the appropriate Print key. 

The selected image is stored (per your preset instructions) 
and a thumbnail is displayed on the clipboard. 

NOTE: LOGIQ Fortis numbers the images which are saved in the Local 
Archive (Instance Number). But Instance Number may change 
or get duplicated when adding/deleting images to the exam. So 
for identification, the recommendation is to use Content Date/
Content Time on the DICOM server instead of Instance Number.
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Storing a cine loop

A Cine loop is a sequence of images recorded over a certain 
time frame. The stored cine Loops are displayed chronologically 
on the clipboard. 

Cine loops can be stored at any time during scanning. You can 
choose to preview the cine loop before storage and save the 
cine loop directly, as described below. 

The system can be configured to perform either

• Prospective clip: The system begins storing Cine from when 
you press the Print button, based on the Time Span setting.   

• Retrospective clip: The system stores Cine predetermined 
time before you press the Print button, based on the Time 
Span setting. 

Refer to ‘Retrospective Cine/Prospective Cine’ on page 9-9 
about the setting.

NOTE: LOGIQ Fortis numbers the images which are saved in the Local 
Archive (Instance Number). But Instance Number may change 
or get duplicated when adding/deleting images to the exam. So 
for identification, the recommendation is to use Content Date/
Content Time on the DICOM server instead of Instance Number. 

Previewing and Storing a CINE Loop

1. While scanning, press Freeze. 

2. Move the Trackball to activate Cine.

3. Use the trackball or Frame by Frame to scroll through the 
acquisition and find the sequence of interest.

4. Press Start Frame or End Frame to set the corresponding 
cineloop boundary to the current frame as necessary.

Rotate Start Frame and End Frame to trim or expand the 
cineloop boundaries.

5. Press Run/Stop to run the cineloop and then press the print 
key to store the cineloop.

Cine loops stored on the clipboard are indicated with a 
movie strip icon.

6. Press Run/Stop again to stop the cine loop. 

7. Press Freeze to return to live scanning.

Depending on whether the system has been configured to 
enable or disable “Preview Loop before store” (see ‘Print 
Controls’ on page 10-58), the following procedures enable the 
cine loop to be stored directly. 
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Storing a cine loop without Preview

If “Preview Loop before store” is disabled, 

1. While scanning, press the appropriate print key. 

2. The last valid cine loop is stored in the archive and a movie 
clip thumbnail is displayed on the clipboard. 

3. Scanning resumes immediately.

Storing a cine loop with Preview

If “Preview Loop before store” is enabled, 

1. While scanning, press the appropriate print key. 

2. The last valid cine loop is previewed. 

3. Adjust the cine loop, as necessary. 

4. Press the appropriate print key. 

The movie clip thumbnail is displayed on the clipboard. 

Preview

Loop Preview can now be enabled independently for Time 
-Based Store, ECG-Based Store, and Mark CINE. This is useful 
for setting preview preferences based on the application. 

NOTE: The Contrast Time Span setting overrides the Time Span when 
in Contrast Mode. 
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Retrospective Cine/Prospective Cine

Figure 9-1. Print Control

Retrospective CINE

When you select to store a Cine loop retrospectively, the system 
stores cine for a specified time before you press the Print 
Button.

1. Set Live Store P1 - P4 to “Retrospective Clip” via Utility -> 
Application -> Print controls.

2. Specify the recording time in Time-Based Store or 
ECG-Based Store.

3. Press Save.

NOTE: A Print button can be configured to store a Single Image 
during Retrospective Cine, without stopping the Cine loop.

Prospective CINE

When you select to store a cine loop prospectively, the system 
begins storing cine from when you press the Print button.

1. Set Live Store P1 - P4 to “Prospective Clip”.

2. Specify the recording time in Time-Based Store or 
ECG-Based Store.

3. Press Save.

NOTE: A Print button can be configured to store a Single Image during 
Prospective Cine, without stopping the Cine loop. 

NOTE: The CINE gauge turns green when a Prospective CINE Clip is 
pending. 

NOTE: You can cancel Prospective Store by pressing Freeze/Unfreeze 
or by changing Modes. 
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Review images in archive

There are two ways to access to archived images:

• Review the images from a selected examination.

• Select images from the Active Image screen displaying all 
the images sorted by examination for the actual patient 
record.

Review the patient exam/image

To review the patient exam, 

1. Move the cursor to the patient in the Patient View and 
double-click. Exam View displays.

or

Move the cursor to the patient and select Exam View tab or 
Review. Exam View Displays.

2. Move the cursor to the desired exam and double-click.

3. Active Images screen displays. Move the cursor to the 
image and double click or press Review. 

4. The review screen displays. Select the image from 
clipboard.

NOTE: See ‘Clipboard’ on page 9-16 for more information.
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Active Images

Active Images displays the images of the exam.

NOTE: CINE loops are not played interactively as you view the active 
images on the Patient screen.

Figure 9-2. Active Images Screen 

1. Select the exam which includes the image to review.

2. Select Active Images.

3. Select the image and press Review or double click on the 
image. The image is displayed.

If you select 2 - 4 images and select Review, the archived 
images are displayed in the split screen. 

NOTE: If the size of an image is larger than 2GB, the image does not 
display on the Active Image screen. Take care when you scan a 
long CINE Loop, such as in Contrast. 
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Active Images  (continued)

Analyzing Images

To analyze the archived images, select the image, then select 
Review. The archived images is displayed with the date and 
time of archival. 

To compare the analyzed image to a live image, press L/R. Now 
both the archived and live images appear on the monitor display. 
Unfreeze the live image area. 

Table 9-1:  Active Images

Parameters Description

Delete Images

Delete Selected Images/

Delete All Temp. Images

To delete selected images, select the image in the active screen, then select 

“Delete” on the monitor display or “Delete Selected Images” on the Touch 

Panel. 

To delete all images, select the image, then select “Delete All Temp. 

Images” on the Touch Panel. 

Permanent Store Select the images which you want save to the Local hard disk drive.

Standard Print To print an image, 

1. Select the image you want to print from the Active Images screen. You 

can print one (1) image per sheet or 2x3 images per sheet. 

2. Press Standard Print. 

NOTE: If the printer is not assigned to the button, you will get a message 

telling you to Check Printer Button Configuration. 

NOTE: There is no warning to let you know that the printer is not functioning. 

Check the printer. 

You need to configure the printer to the Standard Print button via Utility --> 

Connectivity --> Button. 

SaveAs Images Refer to ‘’SaveAs’ Images’ on page 9-23 for the detail.

You can select the multiple images collectively in Active Image screen which 

you want save by SaveAs.

NOTE: We suggest that you save the images page by page with ’SaveAs’ 

Images in Active Images. It takes time if you have many images or raw data. 

Select Images/Select All

Unselect All

• To select one or multiple image, place the cursor on the image and press 

Set. 

• To select all images, press Select all on the Touch Panel.

• To deselect images, press Deselect all on the Touch Panel.

Send To See ‘Patient Menu DICOM Functionality’ on page 13-478 for more 

information.

Note: “Send To” button is not displayed in Active Images menu and the 

Touch Panel if the patient is not selected.
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Image Reorder

To reorder the sequence of the images displayed on the Active 
Images screen: 

1. Select Image Reorder on the left side of the screen.

2. Select the image(s) you wish to move with the left and right 
trackball buttons.

Figure 9-3. Select Image(s)

3. There are three ways you can freeze the selection and 
toggle from Choose to Move mode: 

• Press the top trackball button

• Double-click the left or right trackball button

• Drag and drop by holding the left or right trackball button
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Image Reorder  (continued)

4. Move the placement cursor with the trackball to the position 
you want to move the images to.

Figure 9-4. Move/Paste Image(s)

5. Press the top trackball button to paste the image(s) in the 
new location. After pasting, the system switches from Move 
mode to Choose mode.

6. Select Save Reorder to save the new image order, Reset 
Reorder to return to the original order, or Exit Reorder to 
return to the Active Images screen.



Review images in archive

LOGIQ Fortis – Basic User Manual 9-15
5855997-1EN Rev. 3

Image History

Image History displays the images of each exam in 
chronological order of the patient.

1. Select the patient.

2. Select Image History.

3. Select the appropriate button which shows the old exam by 
date and storage location. ‘Active Exam’ is displayed on the 
button.

Figure 9-5. Image History Screen

4. Move the cursor to the required image for review.

5. Select Review. The selected image (maximum of 4 images) 
is displayed.

If the image data is saved on a disk and you do not insert the 
disk when displaying the Image History page, a triangle icon 
displays instead of a thumbnail.

Place the cursor on the icon. The disk name displays under the 
preview window. Insert the appropriate disk.

• Name of the disk displayed under the preview window

• Raw data B-Mode image appears in gray. 

• Raw data Color image appears in color

• Image which does not have raw data (screen capture 
image) appears with a question mark. 

Viewing two different studies from the same patient

To view images side-by-side from two different studies on the 
same patient, 

1. Select the patient. 

2. Go to the Image History page. 

3. Select the first image. 

4. Select the next image from the other exam. 

5. Press Review.
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Clipboard

The clipboard displays thumbnail images of the acquired data 
for the current exam. Images from other exams are not 
displayed on the current patient’s clipboard. 

NOTE: If you have unsaved images in the clipboard and change the 
exam, the dialogue “You have unstored images. They will be 
saved to your current exam” displays. The unsaved images are 
saved to the current exam.

All of the images can be viewed in the Active Images screen or 
in the Image History screen, available from the display or from 
the Patient menu. 

Figure 9-6. Clipboard example
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Clipboard icon

Figure 9-7. Side clipboard icon

1. Number of Images in Exam

The number of images in an exam is tracked on the bottom 
of these Monitor Display Controls. 

2. Thumbnail Size

Place the cursor on one of the Thumbnail size box icons and 
press Set. 

3. Prev/Next Image

4. Save As

5. Delete recalled image / Delete last image

Saving the image /cine to the Clipboard

The active image/cine is stored and placed on the clipboard 
when you press the print key (this assumes that you have 
already set up a print key to do this). The clipboard contains 
preview images with enough resolution to clearly indicate the 
contents of the image. CINE Loops are indicated by a movie clip 
icon. 

The clipboard fills from left to right, starting in the left-hand 
corner. Once the top row is full, the second row starts to fill. 
Once both rows are full, the next image stored starts to fill a 
‘third’ row (the first row disappears from the clipboard display, 
with the second row now becoming the first row, and the third 
row now becoming the second row). 
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Previewing Clipboard Images

1. Select the Pointer key to obtain a cursor arrow.

2. Move the Trackball to position the pointer over the 
clipboard image you want to recall. 

3. An enlarged preview of the image is displayed on the 
left-hand side of the monitor. 

Recalling Images from the Clipboard

To recall images from the clipboard, 

1. Select the Pointer key to obtain a cursor arrow. 

2. Move the Trackball to position the pointer over the 
clipboard image you want to recall. 

3. Press Set to recall the image. 

4. Press the left/right arrow of Menu icon to move to the 
previous/next image.

To delete an image from the clipboard

1. If in images live, press Freeze.

2. Select the Pointer key to obtain a cursor arrow.

3. Place the cursor on the clipboard image you want to delete, 
then press Set to select the image.

4. Place the cursor on the Delete icon and press Set.

A warning message is displayed asking the user to confirm 
the action to perform.

5. Select Yes.
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Save As

Overview

Images and cineloops can be saved to a removable media  
storage to View on a Windows PC in the following standard 
formats:

• Still images: JPEG, DICOM and RawDICOM (Raw data + 
DICOM)

• Cineloops: WMV, DICOM and RawDICOM (Raw data + 
DICOM)

Images can also be stored as MPEG format as described on 
‘MPEGvue’ on page 9-37.

SaveAs

To save images to the media: 

1. Insert the media into the drive or connect the USB drive to 
the system.

NOTE: If you have not formatted the media, the media will be 
formatted when you select Save As. 

2. On the scan screen, press the left Set key. The arrow cursor 
displays. 

3. Place the cursor on the image or CINE Loop in the clipboard 
to be saved and press Set. The image displays on the 
screen. 

4. Select SaveAs in the lower, right-hand corner of the screen. 
The Save As menu appears.

NOTE: If you save the image as an .WMV file, run the CINE Loop 
before you select SaveAs. 

NOTE: You cannot save a 2D cineloop image as a .jpeg file.
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SaveAs  (continued)

5. Select the media from the Save in Archive pull-down menu.

6. Folder name: You can create the folder for the saved file. 

• Default is blank (The folder is not created)

• Max 32 characters

NOTE: You cannot edit the folder name when the folder is opened.

7. File Name: The name of the file is automatically filled in, but 
you can type a file name as well. 

• Max 64 characters

NOTE: DO NOT use the following special characters when saving 
images: !, @, #, $, %, ^, &, *, (, ), |, :, ;, <, >, ?, /, ~, [, ], {, }, 
and Yen sign. 

8. Store: Select Image only or Secondary capture. 

• Image only: Saves only the ultrasound image area

• Secondary capture: Saves the ultrasound image area, 
title bar, and scan information area. Not available for 
DICOM or RawDICOM images.  

NOTE: If you select “WMV” for Save as type, Secondary capture is 
disabled.

9. Compression: Specify Compression. 

• None

• Rle

• Jpeg

• Jpeg2000

• Lossless-Jpeg

NOTE: If you select “WMV” for Save as type, Compression is 
disabled.

10. Quality: Specify image quality (between 10-100). A high 
quality setting gives a lower compression. 

NOTE: If you select “WMV” for Save as type, Quality is disabled.
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SaveAs  (continued)

11. Save as type: Select one of the following. 

• RawDICOM: saves the still image or CINE Loop in both 
GE raw format and DICOM format. 

• DICOM: saves the still image or CINE Loop in pure 
DICOM format. 

• WMV: Saves the CINE Loop in WMV(Windows Media 
Video) format. 

NOTE: Store “Image Only” is available if you select WMV for 
Type.

NOTE: WMV type is only available with CINE loop image.

• JPEG: Saves the still image in jpeg format. 

• JPEG2000: Saves the still image in jpeg2000 format.

NOTE: The Save button is disabled when you select “AllFiles”. 
Select each Save as type when you want to save data.

If you want to see all data saved onto the local drive, select 
“AllFiles(.*)”. All the data names display in the window.

12. For images transferring to USB, press Save. 

The images are saved directly to the USB drives storage 
whenever you press Save.

If saving to a CD/DVD, select “For Transfer to CD/DVD”, the 
image is saved to the local drive buffer.

• If free space of the destination is not enough to save all 
selected images, then warning dialog appears.

• If the same file name exists in the destination, the 
warning dialog displays.

OK: Overwrite file and continue to save selected 
images.

Cancel: Cancel.

13. Repeat steps 4-12 for each additional image to be stored to 
the CD/DVD. 

WARNING Buffer images for transfer to CD/DVD. Images are not 
cleared out of the image buffer after you start a new exam 
or new patient. It is the responsibility of the user to clear the 
image buffer before storing new patient data so that the 
CD/DVD does not contain images from multiple patients.
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SaveAs  (continued)

14. After you have added all of the images/loops you want to 
save and are ready to write to the media, transfer all the 
images at the same time. Press Save As--> Transfer To CD/
DVD. 

A progress bar lets you know that the “Media transfer is in 
progress.” 

If total transfer size is bigger than CD/DVD free space size, 
then only the files that can be copied to CD/DVD are 
transferred. After the copy is finished, a warning dialog 
displays showing the total required file size and transferred 
file size. Press OK, insert a new CD/DVD, and press 
Transfer to CD/DVD again.

15. If you do not want to save the image to CD/DVD, select 
“Delete Files for Transfer” All images are deleted.

16. Press F3 to eject the media. Select CD/DVD Recordable or 
USB drive. Select Yes and Verify files for CD/DVD. This 
compares the expected number of files with the actual 
number of files on the media. The files are also checked to 
ensure that they are readable.

NOTE: The Report Save As feature is somewhat different. As soon as 
you select to save a report, the report is saved. 

NOTE: If you save 3D image as an WMV file, an annotation text 
“COMP” appears at the top of the saved image which represents 
the compressed image.

NOTE: Time line image can be saved as multi frames image with 
SaveAs.

NOTE: Verify the saved image works correctly on the Windows PC. If 
the image does not work, please save it again on the LOGIQ 
Fortis. 

Table 9-2:  Save As Formats

.wmv format MPEGvue in Data Transfer

B, B+CF Multi frames Multi frames

B+Doppler Multi frames Single frame

B+M Multi frames Single frame

3D N/A Single frame
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’SaveAs’ Images

You can select multiple images to save at one time by selecting 
‘SaveAs’ in the Active Image screen.

Features are almost the same as the SaveAs feature. See ‘Save 
As’ on page 9-19 for more information.

NOTE: We suggest that you save the images page by page with 
’SaveAs’ Images in Active Images. It takes time if you have 
many images or raw data. 

NOTE: If the image has a filmstrip icon, this indicates a CINE Loop, 
which gets saved as a .wmv file; single images are saved as a 
jpeg file. 

NOTE: ’SaveAs’ Images function doesn't support images which are 
query/retrieved.

1. In the Active Images screen, place the cursor on the image 
or CINE Loop to be saved and press Set. You can select 
multi images with multi pages.

2. Press ’SaveAs’ Images on the monitor display or the Touch 
Panel. The SaveAs menu appears.

3. Ensure that Jpeg&WMV is selected, then press Save. 

NOTE: If you are saving to USB, images are transferred as soon as 
you press Save; if you are saving via Transfer to CD/DVD, 
you need to save images to the hard drive buffer, select 
‘SaveAs Images’ again and then Transfer to CD/DVD. See 
below. 
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Notes on Transfer to CD/DVD

Transfer to CD/DVD transfers all saved files on the hard drive 
buffer to CD/DVD.

To Transfer saved files to CD/DVD, 

1. After you have added all of the images/loops you want to 
save and are ready to write to the CD/DVD, transfer all the 
images at the same time. Press Save As--> Transfer To CD/
DVD. 

A progress bar lets you know that the “Media transfer is in 
progress.” 

If total transfer size is bigger than CD/DVD free space size, 
then only the files that can be copied to CD/DVD are 
transferred. After the copy is finished, the warning dialog 
displays. Warning dialog shows total required file size and 
transferred file size. Press OK and you need to change CD/
DVD and press Transfer to CD/DVD again.

2. If you do not want to save the image to CD/DVD, select 
“Delete Files for Transfer” All images are deleted.

3. Press F3 to eject.

NOTE: Verify the saved image works correctly on the Windows PC. If 
the image/loop do not work, please repeat the Save operation 
again on the LOGIQ Fortis.

Storing Images with More Resolution

To store images with more resolution than is available with the 
JPEG selection, select Save As and select WMV as the Save As 
Type. You can save single images as .WMV files. 

Table 9-3:  Store Options

Image Type Store as Image Only Store as Secondary Capture

CINE Loop Gives you a loop of just the image (no 

title bar and scan information).

Gives you a single image of the video 

area. DO NOT DO THIS BECAUSE 

YOU DO NOT KNOW WHICH IMAGE 

FROM THE LOOP THAT YOU ARE 

GETTING. 

Still Image Gives you a single image (no title bar 

and scan information). 

Gives you a single image of the video 

area. 
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EZBackup

Overview

EZBackup allows you to manage hard disk space while 
maintaining the patient database on the scanner, as well as to 
back up the patient database and images.

• EZBackup: Copy the data from the local drive to the 
removable media.

When a backup is cancelled the system completes backing up 
the current media and then cancels the operation.

Only cancel the backup in case of an emergency. The system 
completes backing up the current media and then cancels the 
operation.

HINTS PLEASE READ THIS

Ensure that you have established a data management protocol 
for your office/institution. You MUST manage the backup media 
by keeping a log and by creating a media filing system. 

Generally speaking, you should back up the system when you 
have 10 GB of images to back up. 

You should assign the person who is in charge of performing 
the backups. Backups will vary by the volume of your work. You 
need to track how long it takes your office/institution to get to 
10 GB, and set the back-up parameters accordingly. 

Your office/institution needs to determine your backup strategy, 
for instance, backup weekly. It should be an easy strategy to 
perform and to remember. And follow this same strategy/
schedule consistently. 

It’s also useful to keep your more recent information on the 
hard drive since it’s easier to recall that way. 
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Overview  (continued)

WARNING The LOGIQ Fortis is not intended to be used as a storage 
device; backup of the Patient and Image Database is the 
responsibility of the end user. GE is NOT responsible for any 
lost patient information or for lost images. Loss of image data 
may require a rescan. 

WARNING The system crash can cause the SSD corruption. The SSD is 
not considered a permanent storage device. Backup data on a 
regular basis. Loss of image data may require a rescan. 

WARNING When EZBackup requires more space for backup, a message 
appears when the first disk is full. If you select “Cancel” to stop 
the backup procedure and later try EZBackup again, all the 
data may not be backed up.

Select “Full Backup” on the first EZBackup wizard screen if the 
last time you were performing EZBackup you selected 
“Cancel.” Failure to follow these instructions could result in loss 
of patient data.

WARNING DO NOT turn off the power while EZBackup is running. The 
data may be lost. It may take several hours for EZBackup to 
finish, depending on the amount of data being backed up.

The following may give the impression of a lockup, but 
EZBackup is continuing in the background.

• The progress bar does not move.

• The screen may become white.

• The hourglass icon keeps turning.

WARNING EZBackup does not back up the exams which were previously 
backed up once by EZBackup or Export. If you want to back up 
those exams by EZBackup again, select “Full Backup Option” 
on the EZBackup wizard. Failure to follow these instructions 
could result in loss of patient data.  



EZBackup

LOGIQ Fortis – Basic User Manual 9-27
5855997-1EN Rev. 3

Overview  (continued)

Use a USB Hard Drive for EZBackup.  

NOTE: EZBackup saves data as RAW data. If you import data to the 
system, you can modify the image data. 

NOTE: To display exported Raw DICOM images on a PC, you need the 
dedicated viewer.

NOTE: When backing up reports using EZBackup, use the USB HDD.  

NOTE: EZBackup cannot span a single image across two (2) or more 
media. Therefore, if EZBackup encounters an image that is 
greater than the capacity of the media, it skips the oversized 
image. 

NOTE: EZBackup does not store images to media in sequential order. 
Instead it maximizes the most amount of images per media. 

NOTE: If the system locks up during the media auto format process, 
shutdown the system by holding down the power button and 
boot it up again. After the system is up, replace the media to a 
new one and execute EZBackup again. To avoid data loss, do 
not reuse the failed media for any other function.

NOTE: If you try exporting a previously backed-up exam, the message 
“Can’t Find Source file” displays. The image data had already 
been removed from the hard disk drive with EZBackup. 

CAUTION NEVER restore the patient archive from media made previous 
to the last backup. 

CAUTION “Archived” information is saved to each exam during 
EZBackup. When you perform EZBackup, the system backs up 
the exams except for the archived exam.
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Perform EZBackup

Basically, when you perform the EZBackup procedure, you  
connect the USB HDD, if applicable; the system backs up the 
images (or reports) and creates a reference between the patient 
database and the media’s volume. 

NOTE: EZBackup can take up to 20 minutes (or longer, depending on 
the size of the backup). Make sure to schedule this at the same 
time daily, when no patients are scheduled. 

1. Prepare unformatted media or the USB HDD before starting 
EZBackup.

NOTE: BEFORE starting the EZBackup, select “Unlock All” in Utility 
--> Admin --> Logon. 

2. Specify the EZBackup setup on the Utility --> System --> 
Backup/Restore page. 

3. To start the EZBackup procedure, go to the Patient menu 
and select EZBackup. The EZBackup Wizard starts. 

NOTE: If you use the USB HDD, some wizards and the pop-up 
messages DO NOT appear. 

4. Verify the information on the first page of the EZBackup 
Wizard, then press Next. 

Full backup options display on the first page of the 
EZBackup wizard. If you want to backup all of the exams in 
the range (even if the exam was previously backed up, 
check this option). 

If you uncheck this option, the system only backs up exams 
which have not yet been backed up. 

EZBackup does not back up the exams which were 
previously backed up once by EZBackup or Export. 

NOTE: If you update an exam which is already backed up, the 
exam is also backed up. 



EZBackup

LOGIQ Fortis – Basic User Manual 9-29
5855997-1EN Rev. 3

Perform EZBackup  (continued)

5. Verify the information on the EZBackup Wizard, Page 2. The 
backup may span multiple media. This page tells you how 
many media you need to do this backup. After you have 
gathered the media (allow for one extra media, just in case), 
you are ready to begin the backup. Press Next. 

Free Space/Total Size: tells you the size of the data you 
have selected to store/and the total size of the USB Hard 
Drive storage media. If the storage capacity of the USB HD 
is insufficient, you will see the message, “Selected Location 
does not have enough free space.”

NOTE: This message appears if you press Next without inserting 
the backup media: “Please insert a blank media...”. Insert 
the media and continue. 

6. A pop-up message appears that provides you with the 
media label. Label the media, then insert the media. Press 
OK. 

a. Ensure that you label the media with not only the 
volume name indicated on the Insert Media Message, 
but with the name of the LOGIQ Fortis system where 
this backup procedure was done. 

b. Update the EZBackup log with this information the 
volume information and the location of the media. 

c. After the backup has been completed, file the media. 

7. The status menu appears. When the backup has been 
completed, press Next. 

NOTE: When/if you need to insert the next media, a message 
appears providing you with the media label. Label the 
media, then insert the next media and press OK.

Table 9-4:  Typical EZBackup Log

Date

Scanner ID 

Name

Backup Images 

Y/N

Reminder 

Dialog Interval 

Days

Media Label 

(and Scanner 

ID)
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Perform EZBackup  (continued)

8. When the backup is complete, the completed wizard page 
appears. Press Finish. 

9. Do a patient archive after each EZBackup. 

We recommend attaching the patient list to the EZBackup 
media. Insert the media and select DICOM CD Read from 
the Patient Screen for dataflow (if you use a USB drive, 
select DICOM USB Drive Read). Select any patient and 
press the left Set key to print the patient list on the digital 
printer. 

NOTE: Use Import to restore EZBackup images.
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To Review EZBacked Up Images

You can review backed up media via the Patient Menu, Import, 
and the DICOM Read dataflow. 

If you review an EZBacked Up image,

1. Select the patient on the Patient Menu (on the same system 
where the backup was performed). 

2. Insert the media volume indicated on the Patient Menu. 

3. View the exam from the media. 

NOTE: You may need to insert a media volume prior to or after the 
recommended media. 

NOTE: If the patient is split over multiple media, images on the previous 
or next media are displayed as triangles. 

NOTE: To view the whole patient on the system, use Import, from as 
many media as you have for that patient. However, take care not 
to import studies over existing studies; duplicate or missing 
images may result. Delete the existing exam first. 
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Data Transfer

Overview

The user can select and access the Exam Transfer services 
from the Exam Data Transfer screen.

• Import

• Export

• Worklist

• MPEGvue

• Q/R (Query/Retrieve) See ‘Query/Retrieve’ on page 13-268 
for more information.

NOTE: Ensure that all patients are exported or backed up BEFORE 
deleting them.

Export/Import

To move exams from one Ultrasound system to another system 
or to back up/retrieve exam information, you need to export/
import exam information. 

NOTE: Both database information and images are exported. No data is 
deleted from the local archive when exporting data. 

NOTE: Export/Import patient records may take more than ten (10) 
minutes. Please allow sufficient time to export/import patients. 

NOTE: You MUST verify the media you use BEFORE performing 
Export/Import. You must do this once each session. If you 
encounter problems, eject the media and then re-insert the 
media; then try the Export/Import again. 

NOTE: If you try exporting a previously backed-up exam, the message 
“Can't Find Source file” displays. The image data has already 
been removed from the hard disk drive with EZBackup.

NOTE: It is STRONGLY recommended that you verify files on Eject 
when using Export.
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Exporting Data

To export an exam(s) to a compatible Ultrasound system:

1. Format and label the removable media. Answer Yes/OK to 
the messages. 

NOTE: The system formats the unformatted CD-R/DVD-R 
automatically when you select Export on the data transfer 
screen. 

2. Press Patient and select Data Transfer.

3. The Data Transfer screen is displayed. Select Export.

4. “Local Archive-Int.HD” displays on the Transfer From 
pull-down menu and the patient list included in the Local 
Archive displays.

5. Select the destination at the Transfer To pull-down menu.

6. Select the patient(s) to export by using the Transfer From 
search field (the upper field). 

You can use Windows commands to select more than one 
patient. 

To select a consecutive list of patients, click the cursor on 
the first name, move the cursor to the last name, then press 
and hold down the Shift+right Set key to select all the 
names.

To select a non-consecutive list of patients, click the cursor 
at the first name, move the cursor to the next name, then 
press and hold down the Ctrl+right Set key, move the cursor 
to the next name, then press and hold down the Ctrl+right 
Set key again, etc. 

You can also search for patients via the Search key and 
string. 

Or, use Select All to select all patient.

NOTE: You need to use your best judgment when moving patients’ 
images. If there are lots of images or loops, then only move 
a few patients at a time. 

7. Press Transfer. The progress bar displays during the 
transfer.
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Exporting Data  (continued)

8. Press F3 to eject the media. Specify that you want to finalize 
the media. 

After performing an Export, the system reflects that this 
operation was successfully completed; however, it is 
ALWAYS a good idea to verify that there was no corruption 
to the backup/export media during this process. 

To verify that the data was successfully transferred to the 
media, Press F3, then select “Finalize” --> “Yes and Verify 
Files.” If there was any corruption to the media during an 
operation, the message, “An error occurred on the last disk. 
Please discard it and start over.” appears. In this case, 
please redo the operation with new media. 

NOTE: To display exported DICOM or Raw DICOM images on a PC, 
you need the dedicated viewer.
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Importing Data

To import an exam(s) to another Ultrasound system:

1. At the other Ultrasound system, insert the media. 

2. Press Patient and select Data Transfer.

3. The Data Transfer screen displays. Press Import.

4. Select the media from the Transfer From pull-down menu.

5. The Transfer From search field shows the patients available 
for import from the removable media you just loaded onto 
the system. 

6. Select the patient(s) or the exam(s) from the list to be 
imported.

7. Press Transfer. The progress bar displays during the 
transfer.

8. Please wait for the patient information to be copied to this 
Ultrasound system. Informational messages appear while 
the import is taking place. 

9. Press F3 to eject the media.

NOTE: Use Import to restore EZBacked up and images. 

NOTE: You can retrieve from the media to the local drive, playback, or 
process exam information on the system as Raw Data.

DICOM Import

You can import the graphics which has DICOM DIR from CD/
DVD/USB.

CAUTION If the following message displays, there is a possibility that 
Import may not work properly (“Data detected is not LOGIQ 
Fortis. Measurements and RawData will not transfer.”). 
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Worklist (Search and retrieve the Patient/Exam information)

NOTE: Before you retrieve data from the Worklist server, make sure 
that default IP address is input in the Default Gateway field in 
Utility -> Connectivity -> TCP/IP. 

NOTE: You need to select the patient prior to sending images to a 
PACS.

1. Press Patient and select Data Transfer. The Data Transfer 
screen displays.

2. Select Worklist. The patient/exam list in the Local Archive 
displays in the Transfer To section.

NOTE: Only “Local Archive - Int.HD” is enabled for Transfer To.

3. The Worklist used last time is displayed on the monitor 
display. Press Refresh to refresh the list or select another 
Worklist server from the Transfer From pull-down menu.

NOTE: The worklist server is configured in the Utility screen. 
Multiple servers are able to be configured.

NOTE: You can configure whether the auto-refresh worklist has 
been enabled/disabled in the Utility screen. The system 
automatically refreshes the list when the exam data transfer 
accesses the Worklist server or changes the Worklist 
server.

4. Select the patient(s) or the exam(s) from the list.

5. Press Transfer. The progress bar displays during the 
transfer.
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MPEGvue

You can see the exam data on the Windows PC by using 
MPEGvue.

NOTE: If you want to label the removable media, format it before use. 
The system formats the unformatted CD-R/DVD-R automatically 
when you select MPEGvue on the data transfer screen. 

1. Insert the removable media or the USB drive.

2. Select Patient and select Data Transfer. The Data Transfer 
screen displays.

3. Select MPEGvue. The Patient list, which has images in the 
Local Archive, displays in the Transfer From section.

Start the media formatting automatically except USB HDD. 
Label the media with “YYYYMMDD_#”.

NOTE: Only “Local Archive - Int.HD” is enabled for the Transfer 
From.

WARNING DO NOT transfer more than 50 patients at one time.

WARNING DO NOT use lossy compression images, such as JPG or 
MPEG images, for diagnosis. Failure to follow these 
instructions could lead to repeated exam(s).

WARNING MPEGvue function is NOT compatible with other LOGIQ series 
products. Do NOT share the same USB Drive for MPEGvue 
between LOGIQ Fortis and other LOGIQ series products. 
Failure to follow these instructions could lead to repeated 
exam(s).
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MPEGvue  (continued)

4. Select the media from the Transfer To pull-down menu.

NOTE: Select Removable CD Archive if you use CD-R or DVD-R.

5. Select the patient(s) or the exam(s) from the list.

NOTE: If you press Clear in the Transfer From and Transfer To 
section, all the search criteria clears and the list is refreshed 
accordingly.

NOTE: Trying to save 3D loops using MPEGvue, the 3D loops are 
saved as still images. Use “Save As” to save 3D loops. 

6. Press Transfer. The progress bar displays during the 
transfer.

Displays the check mark in the Copi... field of the completed 
patient.

When the message “Not enough free space” displays during 
MPEGvue, 

• CD-R/DVD-R: Please insert new media. 

• USB HDD/USB Flash Drive: Backup the current data in 
the USB device to the other media to make space on 
the USB device. 

If the following dialogue and message displays (“Failed to 
complete MPEGVue”) during MPEGvue, reduce the number 
of exams to gain space, and perform MPEGvue once again 
to new media (CD-R/DVD-R) or USB device.

7. When the transfer is completed, press Exit to return to the 
scan screen and then eject the media.

NOTE: The capacity of media (number of patients) and the writing 
time depends on the data size of each patient. If you try to 
save an image larger than 1GB using MPEGvue, it may take 
a few hours to save the image.

NOTE: Before you read the media on the PC, finalize the media on the 
LOGIQ Fortis.

NOTE: Measurement graphics from the exam performed on the system 
are maintained with the MPEG exam.

CAUTION DO NOT use “Verify” when ejecting the CD/DVD if you 
transferred multiple patients to the media using MPEGVue.
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MPEGvue  (continued)

If you save a Cine Loop by MPEGvue, there is a limitation for the 
length of time (or the number of frames) that can be saved as 
below. 

• Standard B-Mode: About 30 seconds (up to 1000 frames).

• B + Color: About 20 seconds (up to 1000 frames).

Please check the number of seconds or frames on the Cine 
Gauge before MPEGvue.

1. Current displayed frame No.

2. Total number of frames 

3. Current frame time (sec)

4. Total number of seconds

On your PC

An MPEG exam can be read from a PC. Do the following to 
install the MPEGVue Player Software App onto your PC. 

1. Ensure that you are set up to be an Administrator on the PC. 

2. Insert the Media, open up an Explorer window, and navigate 
to the MPEGVuePlayerAutorun application executable. 
Double click on it. 

3. The MPEGVue Player 64-bit Setup wizard opens. Press 
Next. 

4. Accept the suggested Destination Folder by pressing Next. 

5. Press Install to start the installation. 

6. Wait while MPEGVue is being installed. 

7. After the MPEGVue installation has completed, press 
Finish. 

8. From the Windows’ main screen, select and double click on 
the MPEGVue application. 

9. Double click on the patient’s exam. Detailed instructions for 
using MPEGVue can be found in the Using MPEGVue 
section. 
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MPEGvue  (continued)

You can see the exam data on the Windows PC by using 
MPEGvue.

NOTE: Select “MPEG4 Windows Media Format (*.wmv)” when you 
save the Cine image from CD/DVD to the SSD while reviewing it 
on your PC.

NOTE: Measurement graphics from the exam performed on the system 
are maintained with the MPEG exam.

1. To read MPEG exams stored on a CD-R/DVD-R:

• Insert the MPEGVue CD-R/DVD-R in the computer CD 
drive. The MPEGVue Patient list is displayed.

To read MPEGVue exams stored on other media:

• Insert the media containing the MPEG exams and 
double-click on the file Start_MPEGvue.bat. The 
MPEGVue Patient list is displayed.

 Figure 9-8. Patient list

a. Open: Open anywhere on the PC.

b. View Exam: Open the selected exam (or double click on 
the patient name)

c. Open folder: Open a folder of the inserted media which 
contains images (e.g.: 
G:\ESTORE\31_1_2013_20_2_22_917\Images)

2. Select the desired examination date to display the images. 
The MPEGVue screen is displayed.
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MPEGvue  (continued)

 Figure 9-9. MPEGvue screen on the Windows PC

1. Save image as .wmv, .bmp, jpeg, or .WMV

2. Open folder

3. Display full screen

4. Slide Show

5. Brightness/Contrast/Gain

6. Selected image

7. Cineloop

8. Single frame image

9. Play

10. Stop

11. Pause

12. Stop forward/backward

13. Display previous/next image

14. Close

15. Clipboard: select the image to display
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MPEGvue  (continued)

Slide show

You can change the time interval of Slide show in Customize -> 
Options.

Figure 9-10. Slide show setting
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External drives

Intended Use

Removable media can be used for the following purposes:

• Backup of patient database and system configuration 
presets (see ‘System Backup and Restore Preset Menu’ on 
page 10-20)

• Export to copy a set of patient records to a third party 
DICOM review station.

• MPEGVue: review exported images on a Windows 
computer (see ‘MPEGvue’ on page 9-37).

• Copy of system configuration presets between to units using 
the Backup/Restore feature (see ‘Preset Synchronization 
Using Media’ on page 10-155).

• SaveAs: Save images as JPEG, WMV, DICOM and 
RawDICOM for review on a standard Windows computer.

• Privacy and Security Encryption. See Chapter 12 for more 
information. 

Supported removable media

The following removable media are supported:

• USB Flash Drive

• USB external hard disk drive

• CD-R / DVD

If CD/DVD is used, it is recommended to use Archive Grade or 
Medical Grade CD/DVD.

No matter which media is used, it is always highly 
recommended to make a backup of the media, which is the 
responsibility of the customer.

HINTS Keeping your media disc in an original media case or caddy all 
the time will prevent it from becoming dirty or damaged.
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DVD Drive

You can use these media to perform software upgrades, image 
archiving and service diagnostics.

You can use the following media for the multi-drive:

• CD-R (maximum writing speed: 48x)

• DVD-R (maximum writing speed: 16x)

Recommendation concerning CD and DVD handling

To avoid data loss, never touch the recordable surface of a disk. 
Handle the disk only by the outer edge. Do not place it face 
down on a hard surface. Fingerprints or scratches will make the 
disk unusable. Before usage, verify that the disk surface has no 
visible scratches. If there are any scratches, do NOT use the 
disk.

Inserting media

Insert the media with the eject button on the DVD drive. 

CAUTION When you put a media into the DVD drive, please make sure 
the media is placed in the right position. If the media is not 
placed in the right position, the media may be damaged.

CAUTION Make sure that the Disk tray is securely placed in each device 
during system operation. Mechanical damage may occur if 
other objects hit the tray.
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Ejecting media

1. To eject the media, always press F3. DO NOT use the eject 
button on the drive. 

2. The Eject device menu is displayed. Select CD/DVD 

Recordable.

3. When ejecting a media, you are prompted if you wish to 
finalize the disk. If you do not finalize the disk, you can add 
files to the media at a later time. However, you may not be 
able to view the files stored on this disk with a standard PC. 
Finalizing a media, allows you to view these files using most 
standard PCs.

To verify that the data was successfully transferred to the 
media, Press F3, then select “Finalize” --> “Yes and Verify 
Files.” If there was a corruption to the media during an 
operation, the message, “An error occurred on the last disk. 
Please discard it and start over.” appears. In this case, 
please redo the operation with new media.

NOTE: When you press F3 with a blank media inside the DVD 
drive, the finalization menu displays. You can select “Yes” or 
“Yes and Verify Files”, but the system ejects the media 
without doing anything. 
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USB Hard Disk Drive and USB Flash Drive

Cautions and Warnings

NOTE: Connect USB Flash Drives and Hard Disk Drives to the USB 
ports located on the Touch Panel (USB 3.0). Connect peripheral 
devices to the USB ports located at the rear of the system. 
(USB3.0). 

NOTE: Do not insert USB Memory devices (hard drives or flash drives) 
that contain multiple partitions into the scanner. Use single 
partitioned USB Drives.

NOTE: Some USB memory device manufacturers allow for executable 
partitions or ship pre-formatted new USB memory devices with 
multiple partitions pre-configured. BEFORE inserting any 
memory device into the scanner, insert it into a PC or MAC to 
verify that there is only a single partition. If multiple partitions 
exist, contact the USB manufacturer for the steps in reformatting 
the memory to a single partition.

WARNING Before removing the USB drive from the USB port, press Eject 
(F3) and select USB Drive from the pull-down menu. 
Disconnect the USB drive after the success dialogue is 
displayed. If the unsuccessful dialogue is displayed, retry after 
a while. Failure to follow these instructions could result in loss 
of patient data.

WARNING If a problem occurs while exporting to the USB-HDD, such as a 
crash, the export may not have completed. Try again with a 
smaller number of patients.

WARNING DO NOT use “Select All” when you export the patient data to 
the USB-HDD.



External drives

LOGIQ Fortis – Basic User Manual 9-47
5855997-1EN Rev. 3

USB Ports

System USB Ports

Side of Monitor

The two Monitor USB 2.0 Ports SHOULD ONLY BE USED for 
Bus-powered USB Hard Disk Drives and USB Flash Drives. The 
following configurations can be used: 

• One or two USB Flash Drives

• One Flash Drive and One Bus-powered Hard Disk Drive

• One Bus-powered Hard Disk Drive

CAUTION Non-supported peripheral devices that use their own AC power 
source CANNOT be attached to the LOGIQ Fortis. DO NOT 
connect the peripheral device’s power cord into the LOGIQ 
Fortis system. Only peripheral devices purchased from GE with 
the purpose of being used with the LOGIQ Fortis system 
should be used. 

Use a USB printer cable that is less than 3 meters in length.

Failure to follow these instructions could lead to unexpected 
diagnostic performance.

CAUTION DO NOT plug in TWO Bus-powered Hard Disk Drives at the 
same time. 
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Operator Panel and Rear of System

The two USB 3.0 ports on the Touch Panel and at the back of 
the system SHOULD ONLY BE USED for the following devices: 

• Color or Report Printer

NOTE: When connecting an external printer to the LOGIQ Fortis via 
the USB port on the back of the system, you MUST ensure 
that the power supplied to the printer is fed from the same 
power feed as the LOGIQ Fortis. This assures compliance 
to leakage currents. 

• Footswitch

• PC Printer with isolation USB 

• USB Storage (USB-HDD and USB Flash Device)

Ejecting a USB Flash Drive/USB HDD

1. To eject a removable media, always press F3.  

2. The Eject device menu is displayed. Select the relevant 
media.

3. Select USB Drive from the pull-down menu to disconnect 
the USB Drive. Disconnect the USB drive after the success 
dialogue is displayed. 

Remove the USB Drive from the USB port. 

NOTE: If the unsuccessful dialogue is displayed, retry after a while.

NOTE: Verify is NOT available on Flash Drives or Hard Disk Drive 
media.
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MPEGvue (Data Transfer)

To transfer a patient/exam to the USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the USB port. 

2. On the Patient menu, select Data Transfer, then 
MPEGvue. Specify USB Drive in the transfer To: pull-down 
menu. Select the patient/exam you want to transfer. Press 
Transfer. 

3. When the transfer has been completed, press Eject (F3). 

WARNING After transferring images to a USB Drive using MPEGVue, 
verify that the images have actually transferred to the USB 
drive. Failure to follow instructions could result in loss of patient 
data.
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SaveAs

NOTE: See ‘Save As’ on page 9-19 for more information.

To save images to the USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the USB port. 

2. Select the image(s) to be saved. 

3. Select Save As menu in the lower, right-hand corner of the 
screen. Select the USB Drive as the archive media. 

4. Specify: Image only or Secondary Capture, type of 
compression, quality, and image save format (Raw DICOM, 
DICOM, Jpeg, or WMV). 

5. Press Save. When the images have been saved, press 
Eject (F3).

NOTE: If you perform the SaveAs function to the USB drive (:\Export) 
by RawDICOM format and review the data on your PC, the title 
of the data appears as 
“:\GEMS_IMG\2006_Oct\08(date)\xxxxx(PatientID)”.

Direct SaveAs

You can save the image directly to the USB Drive just by 
pressing a Print key. 

1. Insert the USB Drive into the USB port. 

2. Select Save As from the pull-down menu in Utility -> 
Connectivity -> Service. Press Add. 

3. Select Save As in the list. Rename it in the Name field if 
needed. 

4. Select USB Drive in the Destination field.

5. Verify the service. 

6. Press Save.

7. Assign Save As to the appropriate print key in Button tab. 

8. Display the image on the monitor and press the print key. 
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Export/Import 

To export/import exams using the USB Flash Drive or USB 
HDD, 

NOTE: Before you export exams to the USB HDD, check “Export to 
USB HDD: Create DICOMDIR” in Utility -> Connectivity -> 
Miscellaneous. If you uncheck this parameter, you must import 
the data to review.

1. Insert the USB Drive into the USB port. 

2. On the Patient menu, select Data Transfer, then Export/
Import. Specify USB Drive in the transfer To: pull-down 
menu. Select the patient/exam you want to transfer. Press 
Transfer. 

3. When Export/Import has completed, press F3.

EZBackup (USB HDD only)

1. Select “USB Drive” on the Utility -> Backup/Restore -> 
EZBackup -> Media.

2. Follow instructions for EZBackup. See ‘EZBackup’ on 
page 9-25 for more information.

3. When EZBackup has completed, press F3.
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USB Quick Save

USB Quick Save easily sends images to a USB flash drive 
storage.

The images are stored either in .jpg or .WMV format.

USB Quick Save Setup

In Utility -> Connectivity -> Service, select USB Quick Save. 

Figure 9-11. Service USB Quick Save

Assigning USB 
Quick Save to Print 
Keys

The USB Quick Save service can also be assigned to the Print 
keys via the Utility -> Connectivity -> Button preset menu. See 
‘Button’ on page 10-85 for more information.

Figure 9-12. Assigning USB Quick Save to Print Keys
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Printing Options

Setting up Digital Peripherals

Set up digital peripherals from the Utility --> System --> 
Peripherals menu. 

The following printers can be connected to the power outlet 
supplied by the system.

• BW Printer: UP-D898DC

For the UP-DR80MD and UP-D25MD, insert the USB cable into 
the USB port of the rear panel and plug it into a wall socket.

NOTE: Printing using a standard printing service overrides the 
orientation and N-up feature of the printer preferences. Printer 
preferences are set up in the printer folder (via Utility --> System 
--> Peripherals. Select Properties under Standard Printer 
Properties). 
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Digital Printer Setup

There are two steps to do when setting up a digital printer: 
1) follow the procedure below for each printer, then 2) set up 
specific properties for each printer (specific instructions are 
provided for each printer following this section). 

Follow this procedure for each printer:

1. Select Utility--> Connectivity--> Service. Add the Standard 
Print service. Select the printer from the Printer pull-down 
Properties menu. For the UP-D898DC printer, select 
“Portrait” as orientation. 

2. Type the printer name in the Name field. This name is used 
on the Button screen. After you select the printer from the 
Printer pull-down Properties menu again, it turns white. 
Press Save. 

3. Select Button. Select the appropriate print key (Print1, 
Print2...) from the Physical Print Buttons section. Select the 
printer from the MyComputer column and press >> to move 
it to the Printflow View column. Press Save. 

CAUTION • Before powering on the LOGIQ Fortis, connect the printer 
via the USB cable and turn the printer power on. 

• DO NOT remove the cable while the LOGIQ Fortis is 
powered on.
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Sony UP-D25MD Instructions

Follow these steps to set up the paper size of Sony UP-D25MD 
printer. 

1. Press Utility-->System-->Peripherals. Select the UP-D25MD 
from the pull-down menu under Standard Printer Properties. 
Click Properties.

Figure 9-13. Standard Printer Properties

2. Select Properties.

Figure 9-14. Properties

3. Select Printing Preferences. Select Paper Size. Press 
Apply. Press OK. Press Save, then Exit.

Figure 9-15. Printing Preferences
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Notes for Sony UP-DR80MD

CAUTION • Before powering on the LOGIQ Fortis, connect the 
UP-DR80MD and turn the printer power on. 

There is no warning to let you know that the printer is not 
functioning. Check the printer. 

•  DO NOT remove the cable while the LOGIQ Fortis is 
powered on.

• DO NOT plug in a DR80MD while the LOGIQ Fortis is 
turned on.
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UP-D898DC Printer Settings

Preferred printer settings for the UP-D898DC are shown below; 
and instructions follow. 

Setting up the UP-D898DC Printer Settings

1. Select Portrait for Orientation in Utility -> Connectivity -> 
Service--> Standard Print and press Save.

2. Select Utility ->System ->Peripherals.

3. Select the printer to adjust (UP-D898DC) from the pull-down 
menu under Standard Printer Properties. Click Properties.

4. Select Properties from the Printer pull-down menu.

5. Click Printing Preferences at the bottom of Properties 
Window.

6. Select the Layout tab and select:

• Paper: 1920x1280

• Orientation: Landscape

• Interpolation Method: Bilinear

7. Select the Density Adjust tab and select:

• Gamma: TONE2

• Sharpness = 0; Dark = 0; Light = 0; Sharpness = 2

8. To save the adjusted printer settings, click Apply and then 
OK.

9. Close the ‘Printers’ window with the close button.

10. Exit System Setup with Save&Exit.

11. Assign the Printer to the remote keys.

Table 9-5:  Recommended Settings

Recommendations Use These Settings

Recommended Setting • Paper Size: 1920x1280

• Windows Orientation: Landscape

• Utility--> Connectivity--> Service--> Standard Print--> Orientation: 

Landscape

Avoid using WIDE Setting Utility--> System--> System Display--> Use the settings below: 

• Utility--> System--> System Display--> Image Display--> Image Display 

Area: Default or Large

• Utility--> System--> System Display--> Use Wide Screen For... -- turn OFF 

all parameters

Use Large Print Setting • Paper Size: 1920x1280

• Windows Orientation: Landscape

• Utility--> Connectivity--> Service--> Standard Print--> Orientation: Portrait
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Network Printer

A network printer can be added to the system.

NOTE: It is solely the customer’s responsibility to determine printer and 
network settings and configuration to enable and ensure the 
specific network printer usage and functionality.

Add Network Printer

To add a network printer, the user must be logged on to the 
system as an administrator.

1. On the Utility ->System ->Peripherals page, Under “Network 
Printer,” select Add Network Printer.

Figure 9-16. Network Printer

The “Add Printer” Dialog Box appears.
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Add Network Printer  (continued)

2. In the Add Printer dialog box, enter a Printer Name, the IP 
Address of the desired printer, and select the Printer Driver. 
Select “Add Printer.”

Figure 9-17. Add Printer

Adding a printer may take several minutes. A dialog box 
confirming installation displays when the printer has 
installed. Select “OK.” 

NOTE: Printer installation does not guarantee the printer will 
function correctly. The printer may install even if the IP 
address is incorrect or inaccessible.

3. After installing the printer, go to Utility -> Connectivity to add 
a Standard Print Service and a Print Button (see ‘Digital 
Printer Setup’ on page 9-54).

Print a test exam image or report and verify the full image or 
all information has printed. Verify the resolution, aspect 
ratio, clarity and color accuracy of the prints.
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Remove Network Printer

To remove a network printer, the user must be logged on to the 
system as a Network Administrator.

1. On the Utility ->System ->Peripherals page, Under “Network 
Printer,” select Remove Network Printer (Figure 9-16 on 
page 9-58).

2. Select the printer to remove from the drop-down list and 
select “Remove Printer.”

Figure 9-18. Remove Printer

A dialog box confirming printer removal displays when the 
printer has been uninstalled. Select “OK.”
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External Paper Printer

You can connect an external paper printer via the USB 
connection. 

Figure 9-19. Patient Environment

CAUTION ONLY plug in devices to the USB ports located at the rear of 
the system WHILE the LOGIQ Fortis is NOT powered up. If you 
plug in a device while the LOGIQ Fortis is powered on, your 
system may become unusable.

CAUTION DO NOT place an external paper printer inside the patient 
environment. This assures compliance to leakage current. 
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External Paper Printer Setup

NOTE: The printer driver is customized for the LOGIQ Fortis at the 
factory; you do not need to change the settings. 

1. Connect the printer to the USB port. 

2. Select Utility--> Connectivity--> Service. Add the 
Standard Print service. 

Figure 9-20. Connectivity -> Service Screen

3. Select the printer from the Printer pull-down Properties 
menu. 

NOTE: After selecting the printer, the field turns white. 

4. Set the following parameters in Properties: Rows, Columns, 
Orientation, and Right Margin.

• Rows=3

• Columns=2

• Orientation=Portrait

• Right Margin (mm)=10

5. Type the printer name in the Name field. 

NOTE: This name is used on the Button screen. 
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External Paper Printer Setup  (continued)

6. Press Save, then select the Button tab. 

7. Select the appropriate print key (Print1, Print2...) from the 
Physical Print Buttons section. 

8. Select the printer from the MyComputer column and press 
“>>” to move it to the Printflow View column. 

Figure 9-21. Connectivity -> Button Screen

9. If you want to assign this printer to the Standard Print Button 
on the Active Image Screen, select this printer at the Active 
Image Printer section. 

10. Press Save. 

NOTE: Adjust the rows, columns, and margins as necessary to obtain 
the image size and quality that you find acceptable. 
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Setting up the Printer to Print Reports and Patient List Print

To set up the external printer to print reports and Patient List 
Print, 

1. Press Utility--> System--> Peripherals and select Printers 
under Setup. 

2. Select the printer from Default Printer pull-down menu. 

Figure 9-22. Report Printer Setup

3. Press Save. 

4. Press Print on the Report screen to print the report. 
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Portable Exam

Perform a Portable Exam (Using the Worklist) 

To perform a portable exam (using the worklist), 

1. Go to the worklist and get the patient(s) you will need for this 
portable exam(s). 

2. Ensure that images will be saved to the local hard drive. 

3. Press the Power On/Off switch. 

4. Proceed to perform the exam(s). Press Power On/Off. 
Select the patient, do the exam. Store images. Images are 
held in the spooler. 

5. If there are additional patients to scan, repeat steps 4 and 5. 
After you have completed all portable exams, press Power 
On/Off.  

6. When you have returned from performing the portable 
exam(s), reconnect to the network. Press Power On/Off. 

7. Press F4. Send all of the images in the spooler to the 
printer/storage device. 
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Chapter 10

Customizing Your System

Describes how to create system, user, and exam 

presets. 
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Presets

Overview

Preset Menus provide the following functionality: 

Utility, Page 1 Configuration Menus

Figure 10-1. Utility Menu, Page 1

• System presets. View and update general system 
configuration settings, measurement and analysis settings, 
and video settings; backup and restore data and 
configuration files. 

• Imaging presets. View and update exam and imaging 
parameters. 

• Comment library presets. Set up comment libraries by 
application. 

• Body Pattern library presets. Set up body pattern libraries 
by application. 

• Application and User Defined presets. Configure 
application- and user-specific settings. 
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Overview  (continued)

Utility, Page 1 Configuration Menus (continued)

• User Specific. Configure My Desktop. 

• 3D/4D. Real-time 4D and Static 3D scanning. 

• Connectivity Setup. Define connection and communication 
setup, DICOM, Wireless Networking, Tricefy, and includes 
exam dataflow information. 

• Measurement and Analysis presets. Customize exam 
studies, create measurements, set up manual sequencing, 
and create OB Tables. Refer to the “General Measurement 
and Calculations” chapter for more information. 

• Reports Presets. Allows you to edit the report template, 
diagnosis codes, and report comments. Refer to the 
Advanced Features chapter for more information. 

• Administration presets. Perform system administrator 
activities such as setting up user IDs and logon formats. 

• Image Preset Manager. Activates the Image Preset 
Manager to create, edit, import, and export user imaging 
presets. 

• Scan Assistant. Create, import/export, and manage Scan 
Assistant programs. 

• Search. You can search for a parameter on the Utility pages 
(Measure, Reports, and Service pages cannot be 
searched.) 
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Overview  (continued)

Utility, Page 2 Configuration Menus

Figure 10-2. Utility Menu, Page 2

• Electronic Instructions for Use (eIFU) Icon. Activates the 
Online User Manual. 

• Scan Screen. Activate the Scan Screen so that you can 
adjust the monitor’s brightness/contrast via the Room 

Profile control and adjust the monitor’s RGB level/color 
temperature/gamma via the Color Profile control. 

• Room Profile. Change Brightness and Contrast of main 
display when set to User Defined.

• Color Profile. Control RGB level, color temperature, 
gamma, etc.

• Gamma. Set the Gamma at 2.2 or 2.4. 

• Color Space (OLED only). Select ITU 709 Standard for 
High Definition TV, Native 1 for most vivid OLED colors, 
or Native 2 for a setting between ITU 709 and Native 1. 

• Reset Monitor. Resets the monitor to system default 
settings. 

• Test Patterns. Test the Monitor screen’s performance. 

• Service. Activate the Service Browser. 

To access these functions, select the Utility tab on the 
Touch Panel, then select the appropriate Touch Panel key. 
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Overview  (continued)

In addition, you can adjust the following via the rotaries located 
beneath the Touch Panel. 

• Master Volume. Select to adjust the system volume, e.g., 
Doppler volume.

• Effects Volume. Select to adjust the system notifications, 
e.g., Touch Panel pushes, Print sounds, etc.

• Touch Panel Light. Select to adjust the brightness of the 
Touch Panel.

• Kbd/Touch Lock. Select to lock the Keyboard and Touch 
Panel controls in order to clean the system.  

• Brightness/Contrast. Select to adjust the monitor 
brightness/contrast.   

• User-adjustable when Room Profile is set to “User 

Defined.” 

• OPIO backlight. Controls the level of brightness of the 
orange and green backlights on the hard keys.  
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System Presets

Overview

System presets allows you to view or change the following 
parameters

• General – Location, Date/Time, Patient Info, Key Usage, 
and Utility configuration

• System Display - Presets related to the monitor display 
format.

• System Imaging – CINE Loop Store, Cardiac, Biopsy 
Guides, and Image Control and Display configuration

• System Measure – Measurement, Cursor, and Results 
Window configuration

• Backup/Restore – Backup, Media, EZBackup, Detailed 
Restore of User Defined

• Peripherals – DVR, Print and Store Options, and Setup 
configuration

• User Configurable Key -- BT (Breakthrough) Key, 
Keyboard Key

• About – Release information and part numbers for: 
Application Software (including version), Online Help, 
Service Platform, Security Package, Base Image and Base 
Image Update.

• Licenses – Licenses for software used on the LOGIQ 
Fortis. 



System Presets

LOGIQ Fortis – Basic User Manual 10-7
5855997-1EN Rev. 3

Changing system parameters

To change system parameters:

1. On the Touch Panel, select Utility.

2. On the Touch Panel, select System.

The System screen is displayed.

3. On the monitor display, move the Trackball to select the tab 
that has the information you want to change. 

4. Select values for the parameters you want to change.

5. To save the changes, select the Save button. Select Exit to 
return to scanning. In some cases, you may need to reboot 
the system for the change to take effect. 
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System/General Preset Menu

The System/General screen allows you to specify hospital name 
and system date and time.

Table 10-1:  Location

Preset Parameter Description

Hospital Type the institution’s name.

Department Type the institution’s department name.

Machine Description (1&2) Type the machine name.

Preset Region (restart 

needed)

Select region (None, Americas, Asia, Europe or Japan).

Language (restart needed) Select the appropriate language from the drop-down list.

Note: If you select Japanese (JPN), only the warning and status messages 

are displayed in Japanese. You can not type in Japanese. 

Online Help Language Select the language you would prefer to use to read the online user manual. 

Units Select metric or US units of measurement.

Regional Options (restart 

needed)

Select to set up the keyboard. 

Table 10-2:  Date/Time

Preset Parameter Description

Time Format Select the time format: 12 Hr. AM/PM or 24 Hr.

Date Format Select the date format: dd/mm/yyyy, mm/dd/yyyy, or yyyy/mm/dd. 

Default Century Select the default century for the system to use.

Date/Time (restart needed) Select to display the Date/Time Properties window, to specify the system 

date, time, time zone, and to auto adjust for daylight savings time. 

Table 10-3:  General User Interface

Preset Parameter Description

Color Level (restart 

needed)

Select the darkness of the utility pages and any message windows: Brightest, 

Bright, Standard (Dark Text), Standard (Light Text), Dark, Darkest. 
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Table 10-4:  Title Bar

Preset Parameter Description

Hide Patient Data • Always - Patient information is removed from the scanning screen Title bar 

(and while storing images).

• On Store - Patient information is removed only when storing the image.

• Never - Patient information is always displayed. 

NOTE: Upon recall of images with measurements, Dual image and/or  V 

Nav, the DICOM image is recalled. In this case, there is no patient data 

burned into the DICOM image. If you want the data to appear on the image, 

set to Never. 

Hide DateTime • Always - Date and time is removed from the scanning screen Title bar (and 

while storing images).

• On Store - Date and time is removed only when storing the image.

• Never - Date and time is always displayed.  

NOTE: Upon recall of images with measurements, Dual image and/or V Nav, 

the DICOM image is recalled. In this case, the date and time are not burned 

into the DICOM image. If you want the date and time to appear on the image, 

set to Never. 

Font Size (restart needed) Select to display patient information in the title bar using a small or large font 

size. You need to reboot the system for this change to take effect. 

Table 10-5:  Worksheet

Preset Parameter Description

Use Bold Worksheet Fonts 

(Restart Needed)

Select to bold fonts in Worksheets. The setting will take effect when the 

system is restarted.

Table 10-6:  Trackball

Preset Parameter Description

Speed Set how fast you want the Trackball to move while performing actions such 

as tracing the anatomy. peed is used for Menu and Scan Mode.  0=Slow; 

20=Very Fast 

Acceleration Set how fast you want to Trackball to move across the display. Acceleration 

is used for Menu and Scan Mode. 0, 1, and 2 with 0 being the slowest 

acceleration. 

Table 10-7:  Key Usage

Preset Parameter Description

Run Fast Key speed Select the maximum value of the key interval when running Fast Key.

Table 10-8:  Utility

Preset Parameter Description

Prompt for Save on Exit If selected, the system prompts you to save data when you select exit without 

saving.
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Utility Font Size Select the font size you want to use to view the Utility menus: Small, Medium, 

or Large. 

Table 10-9:  Scan Assistant

Preset Parameter Description

Always Use Doppler 

Cursor

Use the Doppler Cursor when you activate Scan Assistant. 

Table 10-10:  Start Assistant

Preset Parameter Description

Use Start Assistant • On: Use Exam Description (default) - Saves exam mapping automatically 

from worklist

• On: Use Scan Assistant only - Exam description is ignored and selection of 

probe and preset is based on Scan Assistant protocol only. Exam Category 

and Scan Assistant program are not automatically selected. Start Assistant 

Editor does not show the Exam description column. Manual entry of an 

Exam Description for table entry is prevented.

• Off

Create/Edit Select to open Start Assistant Mapping Editor.

Table 10-11:  V Nav

Preset Parameter Description

Max.non US images per 

exam on Image History

Specify the number of non-Ultrasound images per exam to appear on the 

Image History page. 

Table 10-12:  Touch TGC

Preset Parameter Description

Delay Time for Auto Hide 

(sec)

Off, 3, 6, 8, 12, 16

Custom Settings Select Application or Category

Include TGC Curve when 

Saving Presets

Check to select. 

Table 10-13:  Miscellaneous 

Preset Parameter Description

Reset Control Panel Park 

Lock 

Press to reset operator panel park lock. 

Table 10-8:  Utility (Continued)

Preset Parameter Description
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Table 10-14:  Touch Keyboard

Preset Parameter Description

Auto Popup Keyboard on 

Patient Screen

Display Touch Keyboard automatically when Patient screen is selected.

Auto Hide Delay Time for 

Touch Keyboard (sec)  

Off, 6, 8, 12, 16, 20, 24, 30

Display Keyboard with 

Comment Button

Display Touch Keyboard automatically when Comment mode is activated.
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System/System Display Preset Menu

The System/System Display screen allows you to specify 
parameters for the Monitor Display. 

Table 10-15:  Image Display

Preset Parameter Description

Image Display Area Select Image Display Area Size: Default, Large, Extra Large

Image size (probe 

selection required)

Select Default or Large.

Magnification Zoom 

Available

Select to enable Magnification Zoom on images (enabled by default).

Table 10-16:  Side Panel Content

Preset Parameter Description

Side Clipboard Display On/Off.

My Desktop

Measurement Summary

Table 10-17:  Clipboard

Preset Parameter Description

Preview Image Display On/Off

Show Zoom Reference 

Image

Bottom Clipboard Display On (Always display)/ Off (Never display)/ Auto (Display whenever 

there is no side clipboard)

Bottom Clipboard Auto 

Dimming

On/Off/Auto

When the windows pointer is moved over the clipboard area, the pointer is 

undimmed.
Side Clipboard Auto 

Dimming

Table 10-18:  Use Wide Screen for...

Preset Parameter Description

Dual Screen Automatically switch to Wide Screen when in Dual Screen. 

DualView (Simultaneous) Automatically switch to Wide Screen when in Simultaneous DualView 

Screen.

Contrast DualView Automatically switch to Wide Screen when in Contrast DualView Screen.

LOGIQView Automatically switch to Wide Screen when in LOGIQView.
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Volume Nav Automatically switch to Wide Screen when in Volume Navigation.

QAnalysis Automatically switch to Wide Screen when in QAnalysis. Side by Side 

Timeline automatically switches to wide screen when in Timeline mode.

Display Format Horizontal 

Timeline

Side by Side Timeline automatically switches to wide screen when in 

Timeline mode.

Single Image On/Off/Auto

Auto turns on wide screen if 2D image exceeds width of non wide screen 

image area.

Table 10-19:  Display

Preset Parameter Description

Horizontal Scale Select to display width markers. 

TGC Display Select to display TGC curve.

PW Velocity Units in cm/s Select to change scale on timeline from centimeters per second to meters 

per second.

Shear Elasto Display Units Select m/s or kPa. 

Shear Stiffness and 

Velocity Measurement

Specify whether to display Shear Wave Stiffness and Velocity 

measurements. 

Shear Elasto Color Map Select Red as Hard or Blue as Hard. 

Strain Elasto Color Map Select Red as Hard or Blue as Hard. 

UGAP DIsplay Units Select dB/cm/Mhz or dB/m

Attenuation Coefficient and 

Rate Measurement

Select to dislay Attenuation Coefficient and Rate Measurement

Image Parameter Size 

(restart needed)

Choose Small, Medium, Large, or Extra Large. Must reboot the system.

Highlight Image Parameter 

Changes

Select if you want the display to indicate which controls you adjusted by 

highlighting the new value on the display. 

Use Thicker V Nav 

Graphics

Select to display thicker V Nav graphics

Overlay Color (single 

visible dataset)

Select Red, Green, Blue or BW (Black/White).

PET Color in V Nav (if 

grayscale-only dataset)

Select Hot Body, Hot Metal, Warm Metal, BW (Black/White).

Hide Multiple Dataset 

Menu When Storing

Select to hide the Multiple Dataset Menu when storing.

Live/Freeze Indicator Display On/Off.

Table 10-18:  Use Wide Screen for... (Continued)

Preset Parameter Description
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Enable DICOM grayscale 

display mode (GSDF)

Enable On/Off.

Adjust Gamma curve on DICOM GSDF.

Note: With GSDF disabled, the monitor still uses a gamma curve that may be 

selected on the Touch Panel (for backwards compatibility with sites that are 

happy with their PACS or may have a mix of older systems). With GSDF 

enabled, the gamma button on the touch panel affects the image, emulating 

the appearance of that gamma, but does not affect the monitor. 

Room Profile Dark, Semi Dark, Light, User Defined, Last Used

Table 10-19:  Display (Continued)

Preset Parameter Description
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System/System Imaging Preset Menu

The System/System Imaging screen allows you to specify 
parameters for key usage and image control and display.

For details on the Compare Assistant presets, see ‘Setting Up 
Compare Assistant’ on page 13-382.

Table 10-20:  Biopsy Guides

Preset Parameter Description

Show Center Line Displays center biopsy guideline. 

Show Outer Lines Displays outer biopsy guidelines. 

Enable 0.5cm markers Activates biopsy depth markers every 0.5cm. 

Show Biopsy Mark on CFM 

Simultaneous Mode

Displays the Biopsy Guideline on the image while in Simultaneous Mode. 

Show Biopsy Mark on Dual 

View Mode

Displays the Biopsy Guideline on the image while in Dual View Mode. 

Show Biopsy Circle Specify whether to display the Biopsy Circle with the Biopsy guideline. 

Table 10-21:  Compare Assistant

Preset Parameter Description

Comparison Image Side Select Left or Right.

Comparison Image Date Select All Dates, Different Date or None.

Copying Settings Select Automatic: Imaging and Annotations, Automatic: Imaging Only, 

Automatic: Annotations Only, Manual: Imaging and Annotations,  Manual: 

Imaging Only, Manual: Annotations Only or Off.

Table 10-22:  Image Label Layout

Preset Parameter Description

Clipboard Select 1-Line Label, 2-Line Label or No Label.

Active Images Select 1-Line Label, 2-Line Label or No Label.

Image History Select 1-Line Label, 2-Line Label or No Label.

Table 10-23:  Image Label Color

Preset Parameter Description

Clipboard Select the color of the Clipboard Image Label.

Active Images Select the color of the Active Image Label.

Image History Select the color of the Image History Image Label.
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Table 10-24:  Controls

Preset Parameter Description

Auto Invert on Linear Steer When selected, automatically inverts the color scale or spectral timeline 

when the Steer function is used.

Auto Invert on ASO Automatically inverts the spectrum with ASO. 

Link Color/Doppler Invert When selected, the Doppler timeline scale inverts along with the color ROI.

Pushing Depth Rotary 

Performs Image Reverse

When selected, you can reverse the image when you push down on the 

Depth rotary. 

Toggling Zoom Rotary 

Performs Depth

When selected, you can adjust the Depth by moving the toggle up and down. 

Audio Volume Adjusts the Doppler audio volume via a drop-down menu (for example, 

0=softer; 20=louder). 

Auto Freeze Time (probe 

selection required)

Automatically freezes the system after 10, 30 minutes, 1 hour of inactivity, or 

never.

Countdown Time For 

Contrast (sec)

Specify time for the Contrast Clock to countdown during a contrast study, 

0 (off), 3, and 5 seconds. 

Reverse Depth Control Changes key direction for the Depth control.

Reverse Steer Controls Changes key direction for the Steer controls.

Turn Off CrossXBeam for 

LOGIQView (non-linear 

probes)

Deactivates CrossXBeam when you activate LOGIQView. 

3D Postprocessing when 

reloading

When selected, the system re-processes the recalled 3D CINE Loop.

Tru 3D/Easy 3D Resolution Set Easy 3D/Tru 3D Resolution: Default, High, or Very High. 

Doppler Scroll Priority Set to 2D, Doppler, or Last Live Mode.

Start Doppler in Update Select to allow the B/CF image to continue live while the PW image is frozen 

in triplex.

Assign PW Sample 

Volume control to rotary

Select to assign PW Sample Volume control to rotary.

CF Knob Changes Shear 

Gain

Enables Shear Wave Elastography gain control via the CF knob on the 

console. Check box to enable Shear gain control with CF knob (Off by 

default).

Default Rotation when 

changing mode

 Sets the default rotation when changing mode.

Default MyPreset Check the box to start MyPreset. Uncheck the box to start ConventionalExam 

tab (Default).
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Table 10-25:  V Nav 3D Marker 

Preset Parameter Description

Inner Alpha 0-100

Margin Alpha 0-100

Color Yellow, Orange, Red, Blue, Purple, Pink, or White

Margin Color Yellow, Orange, Red, Blue, Purple, Pink, or White

Diameter (mm) 1-100

Margin Dist. (mm) 0-15 in 0.5 mm increments

Short Axis 1-100

Long Axis 1-100

Reposition Check to reposition. 

Table 10-26:  EZ Settings 

Preset Parameter Description

EZ Touch Panel Page Check to enable EZ Touch Panel on first page of B and flow mode tabs.

Uncheck disable EZ Touch Panel (default).

MyPreset Shortcuts Select “By Probe (Default)” or “By Category”.

B mode button No function, Colorize, SRI HD, Reverse

Color mode button No function, Map, Radiant Flow, Biopsy Guideline.

PDI mode button No function, Map, Radiant Flow, Biopsy Guideline.

BFlow mode button No function, Visualization, Background

MVI mode button No function, Map, Radiant Flow, Biopsy Guideline.

PW mode button No function, Simultaneous, Colorize, Wall Filter, Modify Auto Calcs, Trace 

Sensitivity, Quick Angle 

CW mode button No function, Simultaneous, Modify Auto Calcs, Trace Sensitivity, Trace 

Method, Map 
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System/System Measure Preset Menu

The System/System Measure screen allows you to specify 
measurement parameters such as the type of default OB 
measurements and calculations. You can also define cursor and 
Results Window default functionality.

Table 10-27:  Measurement

Preset Parameter Description

Repeat Measurement Select Repeat, No, DefaultMeasure

Repeat = After you take a measurement, the system automatically starts the 

same measurement again.

No = After you take a measurement, you have to touch a Touch Panel key or 

Trackball key to start another measurement.

DefaultMeasure = After you take a measurement, the system automatically 

starts a default measurement based on the current scanning mode (B-Mode 

= basic length measurement, M-Mode = basic length measurement, Doppler 

Mode = velocity measurement except after a volume flow calculation).

OB Type Select which OB measurements and calculations studies to use: USA, 

Europe, Tokyo, Osaka, or ASUM.

EFW GP Select the source used to calculate EFW-GP Estimated Fetal Weight-Growth 

Percentile): Hadlock, Williams, Brenner, Kramer (f), Kramer (m), WHO. 

CUA/AUA for Hadlock Select to use CUA (Composite Ultrasound Age) or AUA (Average Ultrasound 

Age) as the default

Hadlock Table Type Select Hadlock 82 or Hadlock 84 tables

EFW Formula (Europe) Select the source used to calculate EFW (Europe) (Estimated Fetal Weight), 

Hadlock, Hansmann, Merz, Rich/Berk, Shep/Wars

EFW Formula (Tokyo) Select the source used to calculate EFW (Tokyo) (Estimated Fetal Weight): 

Tokyo, Tokyo S-1, Tokyo S-2, Tokyo S-3. 

Add 1 week to EDD Select to add additional week to estimated date of delivery

OB Graph Display Select Single or Quad for displaying OB Graphs. 

OB Graph Single Display Select Last Meas or EFW Single OB Graph displayed by default.

Fix Caliper by Print key Select to use the Print key like the Set key. 

NOTE: If you select this during a generic volume measurement, the print key 

does not function like the Set key, but instead ends the measurement 

sequence and initiates the volume calculation based on the number of 

measurements taken so far. 

LV Study using straight line Sets straight line as the default for 2D LV studies. 

Side selections of Rt, Lt 

and Off

Select to use “Rt, Lt and Off” for Side Selection. When not selected, displays 

only “Rt and Lt”.
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Dual Caliper on V Nav and 

Simultaneous.

Select to enable Dual Caliper on Volume Navigation and Simultaneous.

Map Cycle Select to 

Trackball Key

Map "AutoCalc cycle select" to Left/Right Set key.

Use WeekDay format for 

OB GA in DICOM SR

Select to use WeekDay format.

Table 10-28:  Worksheet (USA/ASUM)

Preset Parameter Description

Show Individual Growth 

Percentiles

Check to display individual growth percentiles on the Worksheet. 

OB Range Type Selections: Min-Max, Standard Deviation.

Table 10-29:  Cursor 

Preset Parameter Description

Cursor Type Select whether to mark measurements with numbers or symbols.

Cursor Size Specify 12x12 or 9x9. 

Cursor Line Display If selected, after you press Set to complete a measurement, the cursor line is 

displayed. If not selected, after you press Set to complete a measurement, 

only the cursor number or symbol is displayed.

Cursor Ellipse Cross Line 

Display

Check box to display the cross line in Ellipse. 

D Manual Trace Cross 

Line Display

Check box to display the cross line with the caliper. 

Cursor Position Select 1st Cursor, 2nd Cursor, or Image Center. 

Color When Set (restart 

needed)

Select white, yellow, bright red, or orange. 

Cursor is Displayed when 

Trackball is moved

The active cursor does not display until you move the Trackball. This 

assumes the following presets are set: Repeat Measurement, Repeat, 

Default Measurement, and Cursor. 

Table 10-30:  Results Window

Preset Parameter Description

Result Window Mode 

Depend

Select this if you want the measurement result window to be repositioned, 

depending on the mode. 

Table 10-27:  Measurement (Continued)

Preset Parameter Description
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Result Window Position 

X[0-800]

You can set the coordinates for the measurement result window when you do 

not have the result window set to be mode dependent. This is the X 

coordinate (left/right) 

Result Window Position 

Y[0-600]

You can set the coordinates for the measurement result window when you do 

not have the result window set to be mode dependent. This is the Y 

coordinate (up/down) 

Result Window 

Location-2D

Select the Result Window location on the Monitor Display: Left-Bottom, 

Left-Top, Right-Bottom, Right-Top, Extreme Right-Top, or Extreme 

Right-Bottom.

Result Window 

Location-TimeLine

Select the Result Window location: Left-Bottom, Left-Top, Right-Bottom, 

Right-Top, Extreme Right-Top, or Extreme Right-Bottom.

Result Window Format Select Wide or Narrow. 

Font Color (restart needed) Select White, Off White, Yellow, Bright Red or Orange (reboots the system)

Font Size (restart needed) Select mini, small, medium, large, or extra large (reboots the system)

Table 10-30:  Results Window (Continued)

Preset Parameter Description
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System Backup and Restore Preset Menu

Table 10-31:  Backup

Preset Parameter Description

User Defined Configuration Select to back up the user-defined configuration settings.

Service Select to back up Service (InSite and Network) settings.

For Report templates, use Utility-> Report-> Export

Backup Select to begin the backup.

Table 10-32:  Backup To/Restore From

Preset Parameter Description

Location Select media type to use for Backup, Restore and Detailed Restore. CD/DVD, 

USB Drive F, Local Backup or Cloud.

Table 10-33:  EZBackup

Preset Parameter Description

Reminder Dialog Interval 

days 

Specify the number of days after the last backup that you want the system to 

prompt you to perform an EZBackup procedure (only for moving images). 

Enable Reminder Dialog Select to activate the EZBackup reminder pop-up dialog. 

Media Select media type.

Table 10-34:  Restore 

Preset Parameter Description

User Defined Configuration Select to restore the user-defined configuration settings.

Service Select to restore service InSite and Network settings. 

Restore Select to begin the restore process for the selected configuration files from 

media storage backup.



Customizing Your System

10-22 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

System Backup and Restore Preset Menu  (continued)

The detailed section of this menu allows you to restore one area 
at a time from the user defined configuration. This allows you to 
selectively restore what you want to restore across multiple 
machines. Check the box(es) you want to restore, insert the 
appropriate media, and press Restore.

Table 10-35:  Detailed Restore of User Defined

Preset Parameter Description

Imaging Presets Select to restore imaging presets.

Connectivity Configuration Select to restore connectivity configurations.

Measurement 

Configuration

Select to restore measurement configurations.

Comment/Body Pattern 

Libraries

Select to restore comment and body pattern configurations.

Protocol Templates Select to restore protocol (Scan Assistant) templates. 

Report Templates (Same 

Software Version Only)

Select to restore Report templates. 

3D/4D Select to restore 3D/4D settings. 

Fast Key Select to restore Fast Key. 

Utility-->Application 

Presets

Select to restore Utility--> Application presets. 

Custom Scan Assistant  

Programs

Select to restore Scan Assistant programs. 

All Others Select to restore all other configurations not listed in the Detailed Restore 

section. This includes parameters defined on the System preset menus.

Detailed Restore Select to begin the restore process for the selected configuration files from 

media backup.

Table 10-36:  Local Backup or Local and Cloud Backup 

Preset Parameter Description

Backup Automatically Select to automatically backup user-defined configuration settings to the 

system hard drive after a new setting or configuration is saved on the Utilities 

pages.

Upload for Fleet Upload preset to Cloud for Fleet share. (Device Mgmt must be activated for 

Cloud Backup and Upload for Fleet button to appear.  See ‘Activate Device 

Mgmt’ on page 10-94 for more information.)
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System/Peripherals Preset Menu

The System/Peripherals screen allows you to specify video and 
system setup parameters.

Print and Store Options. Press Print and Store Options to go to 
the Utility --> Connectivity --> Miscellaneous setup page. 

Removable Media. Press Removable Media to go to the Utility 
--> Connectivity --> Removable Media page. 

Table 10-37:  DVR

Preset Parameter Description

Media (restart needed) Select recording media: DVD or USB storage.

DVD Format (restart 

needed)

Select the video format: NTSC or PAL. 

Picture Quality (reboot 

required)

SP, HQ, EP, LP. Extended Play or Long Play. 

DVD Chapter Record 

Interval (sec.)

Select the Interval of automatic chaptering for DVD recording from 15, 30, 60 

and 120 seconds.

USB Playback Skip 

Interval (sec.)

Select the Interval of time skipping for USB playback from 15, 30, 60 and 120 

seconds.

Table 10-38:  S-Video

Preset Parameter Description

S-Video Output Format 

(restart needed):

Select NTSC or PAL. 

Table 10-39:  Standard Printer Properties

Preset Parameter Description

Properties Select to add an additional standard printer via the USB serial port and to 

configure digital printers. This activates the Windows Add Printer wizard. 

NOTE: Most printer drivers are available via Windows; however, newer 

printers may require you to load the manufacturer-supplied print driver (must 

be on CD/DVD). Refer to the Basic Service Manual for more information. 

Table 10-40:  Standard Printer Restore

Preset Parameter Description

Restore Defaults Select to restore the selected printer to default settings.
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Table 10-41:  Network Printer

Preset Parameter Description

Add Network Printer Select to add network printer.

Remove Network Printer Select to remove network printer. 

Table 10-42:  Default Printer

Preset Parameter Description

Default Printer Select to choose default printer. 

Table 10-43:  Setup

Preset Parameter Description

Print Full Screen Select for the standard printer to print the full screen.

Enable Video Invert Select for the standard printer to print black on white rather than white on 

black.
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System/User Configurable Key

The User Configurable Key screen allows you to reconfigure the 
User Configurable Keys and configure Trackball Key 
functionality. 

Figure 10-3. Programmable Operator Panel Controls 

Table 10-44:  User Configurable Keys

Preset Parameter Description

1 User Defined Key Select desired function to each User Defined key.   

2 - User Defined Trackball 

Set Key

Specify which controls you want to be used on the Trackball: 

• B/B-Flow/Contrast: Auto or Frequency

• Color Flow/TVI/PDI: Auto, Steer, or PRF

• PW, CW, TVD: Auto, Baseline, or PRF

• Use Set keys to change BSteer Angle (On or Off)

3 - Replaceable Key caps Replaceable key caps are provided should you choose to reconfigure the 

User Configurable Keys. 

Keyboard Key 0 - 9 (Not 

pictured)

Check “Enable” in Keyboard key menu.Select desired function to each 

Keyboard key. 
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System/User Configurable Key  (continued)

Figure 10-4. User Configurable Key Preset Menu

To reconfigure User Defined key (UD), numeric Keyboard Keys, 
or Trackball Keys, 

1. Press Utility--> System--> User Configurable Key. 

To configure the User Defined Keys, select the function for 
each key (refer to Figure 10-3). There are 10 User Defined 
Keys. 

2. To configure the numeric Keyboard Keys, select the function 
for each Keyboard key (refer to the illustration above). There 
are ten (10) Keyboard keys that are configurable. 

3. To configure the Trackball Keys, select the function for each 
user-defined Trackball Set Keys by mode. 

4. Press Save. 
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Replace User Defined Key caps

To move and replace a User Dfined key cap, 

1. Insert the flat blade of a screwdriver into the hole on the top 
side of the key cap and lift it up to remove it. 

2. Repeat for each key, to match how you have configured the 
User Defined keys. 

3. Replace the key caps by positioning it and pushing down on 
the key cap until it clicks into place.
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System/About Preset Menu

The System/About screen lists information about the system 
software.

Licenses

The Licenses screen lists information about the software 
licensed for use on the LOGIQ Fortis.

Table 10-45:  Installed Software Packages

Preset Parameter Description

Application Software The version, revision and part number of the current software on this system.

Online Help The current version and part number of the Online Help on this system. 

Application Service Patch The current version and part number of the Service Platform on this system. 

Security Package The current version and part number of the Security Package on this system. 

Base Image The current version and part number of the Base Image on this system. 

Base Image Update The current version and part number of the Base Image Update on this 

system. 

Table 10-46:  Copyright

Preset Parameter Description

Copyright Lists the copyright for the system.

Table 10-47:  Patents

Preset Parameter Description

Patents Lists system patent information.

Table 10-48:  Software

Preset Parameter Description

License Titles Scroll to select the License; the license is displayed in the License window. 
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Imaging Presets

Overview

Imaging screens allow you to specify parameters by Preset and 
Probe by Mode. For information about the specific parameters, 
refer to Chapter 5 Optimizing the Image.

• B-Mode (B)

• Color Flow Mode (CF)

• Power Doppler Imaging (PDI)

• Micro Vascular Imaging (MVI)

• Elastography (ELASTO)

• UGAP

• M-Mode (M)

• Anatomical M-Mode (AMM)

• Pulse Wave Mode (PW)

• Continuous Wave Mode (CW)

• Harmonics (HAR)

• B-Flow (BF)

• Contrast Reference (Ref)

• Contrast (CON)

• Tissue Velocity Imaging (TVI)

• Tissue Velocity Doppler (TVD)

• General

 Figure 10-5. Imaging Preset Example

1. Preset/Application-dependent setup parameters. 

2. Probe-dependent setup parameters. 
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Changing imaging presets

To change imaging presets:

1. On the Touch Panel, select Utility.

2. On the Touch Panel, select Imaging. 

The system displays the Imaging screens. 

3. In the row across the top of the screen, select the mode.

The system displays two sets of parameters and settings. 
The left column lists all settings for the exam (for example, 
Abdomen). The right column(s) list settings that apply only 
to the exam and probe combination.

4. In the Preset list, select the exam.

5. In the Probe list, select the probe.

6. To change a parameter, do one of the following:

• Select the value from a list

• Select one value from a choice of two or more buttons

• Select or clear a check box

7. After changing the parameters, to save the changes, select 
the Save button.

NOTE: When you Save changes to imaging parameters, the system 
saves changes to all modes, not just the mode currently 
displayed.

NOTE: If you have problems with imaging, you can return parameters 
back to the original settings. Select the exam, probe, and mode, 
and then select Reload Factory Defaults. The system returns the 
selected parameters to the original settings.

For information about the specific parameters, refer to Chapter 5 
Optimizing the Image.

General

You can specify a default probe per application and a default 
application per probe, EGC Display or Sync Mode.

Default probe per application

1. To specify a default probe per application, select Utility --> 
Imaging --> General.

2. Check the parameter if you want to start it automatically.

3. Select the default probe from the pull-down menu.
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Default mode and application per probe

1. To specify a default application per probe, select Utility --> 
Imaging --> General.

2. Under Probe, specify the desired mode and application from 
the pull-down menu.

Checkmark the following fields when you want the system to 
activate a certain display. Values vary by probe. 

• Simultaneous

• Automatically Retain Field of View

If selected, the system automatically activates the Retain 
Field of View control when a field of view setting is changed. 
If not selected, you can activate the Retain Field of View 
manually from the Probe Touch Panel. 

• Application Default Mode

• B-Mode

• Harmonic

• Enable B Steer +

• Default PDI

• PDI

• MVI

• Default Elasto

• Shear

• Strain

• PDI/TVI button

• PDI

• TVI

• BF/CHI button

• BF

• CHI

• ECG

• ECG Display

• Sync Mode
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Comments Libraries Presets

Overview

Comment screens allow you to specify comment text and 
pointer options, to define comment libraries, and assign 
comment libraries to applications.

Comments Libraries/Libraries Preset Menu

On the comments Libraries tab, you can change and create 
comment libraries. A comment library is a list of comments that 
are associated with a specific application. The comments are 
listed in the library in the order in which they display on the 
Touch Panel. For each library, you can define two Touch Panel 
displays of comments (Page1 and Page2), with 30 comments on 
each Touch Panel. Home and Arrow controls can also be added 
to the Touch Panel displays.

You can configure these comment color groupings via Utility--> 
Comments--> Libraries (up to 5 groups). 

Figure 10-6. Comment Libraries Preset Menu



Comments Libraries Presets

LOGIQ Fortis – Basic User Manual 10-33
5855997-1EN Rev. 3

Comments Libraries/Libraries Preset Menu  (continued)

Defining Comments

1. In the Library field, select the library you want.

The system displays all comments for the library. You can 
have two Touch Panel displays of comments for each 
library. The comments are listed in the order that they are 
shown on the Touch Panel when you use comments.

2. To change or add an comment, select the comment or blank 
location and press Set, then do one of the following:

• Type the comment.

• Select the comment in the Copy from Existing list, and 
press Set. 

3. To save the changes, select the Save button.

Creating a new comments library

1. In the User Defined Library field, type a name for the library, 
then select Create.

The system creates a new library.

2. Enter comments as described in step 2 above.

3. To save the changes, select the Save button.

Table 10-49:  Libraries

Preset Parameter Description

Library The name of the comment library.

Reload Factory Defaults Select to reload factory defaults.

Small List Fields where you define a small list.

User Defined Library The name of a new comment library that you want to create/delete.

Copy from Existing You can add to or delete from the selection of comments.
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Deleting a user defined library

1. Select the library name which you want to delete from the 
pull-down menu. 

2. Press Delete. 

3. Press Save to save the changes. 

Creating a small list

A small list is a list of up to three comments attached to one 
comment location on the Touch Panel. You can use a small list 
to group similar comments, such as those indicating a probe 
location. For example, you can specify that a small list include 
the following comments: Long, Transverse, and Coronal. To 
make comments easier to use, you can define the small list in 
the same location in each comment library.

To define a small list:

1. Move the Trackball to the comment field on Page1 or 
Page2 where you want to create a small list, and press Set. 

2. Move the Trackball to the first field in the Small List section, 
and press Set.

3. To enter comments in the fields in the Small List section, 
select the field and press Set, then do one of the following:

• Type the comment

• Select the comment in the Copy from Existing list, and 
press Set twice.

You can enter up to three comments. When you enter an 
comment in the first field of the Small List section, the 
selected comment field on Page1 or Page2 changes to 
SMALL LIST.

4. To save the changes, select the Save button.

NOTE: The small list can be displayed as a pop-up window or as a 
toggle field. The Small List Operation field on the General 
tab allows you to specify how it is displayed.
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Comments Libraries/Comments Preset Menu

On the Comments tab you can specify text and pointer options.

Table 10-50:  Text

Preset Parameter Description

Text Font Size Specify the font size. The font size increases as the number increases. 

Text color (Text1 and 

Text2)

Select the color for comment Text1 and Text2.

Arrow Color Select the color for comment Arrow.

Text Boundary Select Group Move or Word Wrapping.

Small List Operation Select whether you want small list options to display in a Pop-up window, by 

a Toggle function, or in a Pop-up with replace.

Enable Type Over Mode Select to type over existing comments. Position the cursor over the text to be 

changed, then start typing. 

Reset Small List Select to indicate that small lists should not be reset to the first item. 

Automatically Set Text Sets the comment as you are typing it. 

Replace Mode Select to replace comment. 

Table 10-51:  Arrow

Preset Parameter Description

Arrow Length Select the default pointer length.

Arrow Size Select the default pointer size.

Keep Arrow Angle Keep the angle of arrow pointer head until next change. 

Table 10-52:  General

Preset Parameter Description

Retain while entering or 

leaving timeline mode

If selected, the system keeps the comment(s) on the monitor display when 

you enter or leave timeline mode. 

TextOverlay in Multiple 

Image

When selected, and you select the F8 key to hide or show comments, if you 

are in multiple image, the system hides the text in both images. When 

cleared, the system only hides the text for the active image.

TextOverlay Sequence You can specify to display Text1, Text2, or both. This allows you to have 

some comments that do not change during the exam while allowing you to 

change other comments. Toggle the F8 key to cycle through the 3 Text1/

Text12 states.

Erase when the probe or 

application is changed

Deletes annotations when you change the application or probe.
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After you change comment options, select Save to save the 
changes.

Comments Libraries/Applications Preset Menu

The Comments Libraries/Applications tab is a link to the 
Applications preset menu. The Applications preset screen 
allows you to specify which libraries belong to an application. 
You also specify which is the default library that displays when 
you use comments. 

The Applications/Comments screen can be accessed through 
either the Comments Libraries or Applications Touch Panel key.

Specifying which libraries belong to an application

1. On the Applications tab, in the Application field, select the 
application.

2. In the Library Group Tabs fields, select the libraries for this 
application. You can select up to six libraries.

3. In the Default Library Group field, select the default library 
you want the system to display when you use comments.

NOTE: When you use comments, the default library is displayed. To 
use other libraries for the application, press the tab for the 
library.

4. To save the changes, select the Save button.

Clear Non Active Image 

Comments

Select if you want comments to be removed from the non-active multi image. 

Table 10-52:  General (Continued)

Preset Parameter Description

Table 10-53:  Applications

Preset Parameter Description

Preset The name of the application preset.

Tabs A list of libraries for the application. You can select up to six libraries.

Default Tab The default library that the system displays when you use comments.
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Using comments from a library

To use comments, press the Comment key on the Control 
Panel. Comments are then displayed on the Touch Panel.

To select a comment library, press the appropriate tab (e.g. the 
tabs are OB23 and OB23_1). 

Figure 10-7. OB 2/3 Comments Touch Panel 
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Comments Libraries/Mapping Preset Menu

The system uses the annotation/body pattern information 
associated with the image to automatically assign the segment/
position qualifier of the breast lesion.

On the Mapping tab, you add/delete/reset the user-defined 
mapping for the qualifier.

Figure 10-8. Comment Mapping

After you change Mapping options, select Save to save the 
changes.

Table 10-54:  Mapping preset

Preset Parameter Description

Annotation to Location 

Conversion

Add/Delete/Reset the use-defined mapping annotation for the qualifier for 

Breast.

• Add: Add the use-defined mapping annotation

• Delete: Delete selected user-defined mapping.

• Reset: Reload factory default mappings to the selected qualifier.

Use Auto Positioning Configure a mapping of annotation and body pattern to location (Position and 

Segment) mappings.

Note: This is effective only against the following body pattern: Breast4 Lt/Rt, 

Breast5 Lt/Rt, Breast6 Lt/Rt, Breast7 Lt/Rt, Breast8 Lt/Rt
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Comments Libraries/Mapping Preset Menu  (continued)

For example, 

1. Select Qualifier "12 O'Clock" from the pull-down menu.

2. Type the mapping annotation "12" and press Add. 

3. Check "Use Auto Positioning".

Figure 10-9. Comment Mapping

4. In Utility-> Body Pattern-> Libraries, select SMLP from 
pull-down menu.

5. Select an empty cell of the Library table.

6. Select Breast4_Rt in Copy from Existing to add.

Figure 10-10. Comment Mapping - SMLP 
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Comments Libraries/Mapping Preset Menu  (continued)

7. Press Save and Exit.

8. Scan the patient.

9. Type "Right Breast 12 Zone 1" as Comment on the image. 

10. Activate Breast measurement and select Lesion folder from 
the Touch Panel for add Lesion1.

Position Rotary is set 12 O'Clock, Segment Rotary is set A, 
and "12 O'Clock A" displays as measurement name 
automatically.

Figure 10-11. Comment Mapping - Measurement

NOTE: The system assigns "-" to position qualifier if the value is not 
found in the annotation or body pattern information 
associated with the image.

11. Select the frame for Lesion 2.

12. Select Breast4_Rt as Body pattern on the image and locate 
the probe mark in the appropriate position.

13. Activate Breast measurement and select Lesion folder from 
the Touch Panel.

14. Position Rotary and Segment Rotary is set automatically 
associated with the position and segment of the probe mark.
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Body Patterns Presets

Overview

Body patterns screens allow you to specify body pattern options, 
to define body pattern libraries, and assign body pattern 
libraries.

Body Pattern Libraries/Libraries Preset Menu

On the Body Patterns Libraries tab, you can change and create 
body pattern libraries. A body pattern library is a list of body 
patterns that are associated with a specific application. The 
body patterns are listed in the library in the order in which they 
display on the Touch Panel. For each library, you can define two 
Touch Panel displays of body patterns (Page1 and Page2), with 
15 body patterns on each Touch Panel. 

Figure 10-12. Body Patterns Libraries Preset Menu

Table 10-55:  Body Patterns Libraries

Preset Parameter Description

Library The name of the body pattern application library.

Reload Factory Defaults Select to reload factory defaults.
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Defining body patterns

1. In the Library field, select the application library you want.

The system displays all body patterns for the library. You 
can have two Touch Panel displays of body patterns for 
each library. The body patterns are listed in the order that 
they are shown on the Touch Panel.

2. To change or add a body pattern, select the body pattern or 
blank location and press Set, then do one of the following:

• Type the body pattern name.

• Select the body pattern in the Copy from Existing list, 
and press Set. 

NOTE: When you select a body pattern name in a Touch Panel 
location or in the Copy from Existing list, the system 
displays the pattern in the lower left corner of the 
screen.

3. To save the changes, select the Save button.

Creating a new body pattern library

1. In the User Defined Libraries field, type a name for the 
library, then select Create.

The system creates a new library.

2. Enter body patterns as described in step 2 above.

3. To save the changes, select the Save button.

Body Pattern Image Displays the image of the currently selected body pattern.

User Defined 

Libraries-Create

The name of a new body pattern application library that you want to create.

User Defined 

Libraries-Delete 

Allows the selection of the user defined library to be deleted.

Copy from Existing A list of body patterns you can use to create an application library.

Table 10-55:  Body Patterns Libraries (Continued)

Preset Parameter Description
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Body Pattern Libraries/Body Patterns Preset Menu

After you change body pattern options, select Save to save the 
changes.

Table 10-56:  Body Patterns

Preset Parameter Description

Erase When the probe or 

application is changed

If checked, when you change probes or applications, the system erases the 

body pattern.

Erase When the image is 

unfrozen

If checked, when you unfreeze the image, the system erases the body 

pattern.

Copy to active side in 

multiple image

If checked, when you use dual B-Mode, the system copies the body pattern 

to the active side of the dual image.

Body pattern background Select whether you want the body pattern background to be Transparent or 

Opaque.

Use Zoom Rotary knob to 

select Body pattern

If selected, you can scroll through the body patterns with the Zoom control.

Body Pattern knob Recall 

On

When the image is recalled, Body pattern knob works as below. 

Body Pattern on: Activate Body Pattern by press or move Up/Down/Left/

Right the Body Pattern knob. 

U/D: Body Pattern On, L/R: Prev/Next image: Move Body Pattern knob Up 

and Down to Body Pattern On, Move left recalls previous image, move right 

recalls next image.

Prev/Next image: Move up and left recall previous image, move down and 

right recall next image.

None: Activate Body Pattern by press the Body Pattern knob. 

Body Pattern knob Recall 

Off

When the image is not recalled, Body pattern knob works as below 

• Body Pattern on: Activate Body Pattern by press or move Up/Down/Left/

Right the Body Pattern knob. 

• U/D: Body Pattern On, L/R: Prev/Next image: Move Body Pattern knob Up 

and Down to Body Pattern On, Move left recalls previous image, move right 

recalls next image.

• Prev/Next image: Move up and left recall previous image, move down and 

right recall next image.

• None: Activate Body Pattern by press the Body Pattern knob. 

Body Pattern knob: Scan 

Assistant On

When Scan Assistant is activated, 

• Scan Assistant Control: Navigate Scan Assistant protocol by move Up/

Down the Body Pattern knob. Pause/Resume Scan Assistant by move Left/

Right the Body Pattern Knob.

• None: Activate Body Pattern by press the Body Pattern knob.
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Body Pattern Libraries/Applications Preset Menu

The Body Patterns Library/Applications tab is a link to the 
Applications preset menu. The Body Patterns Applications tab 
allows you to select body pattern application libraries. You also 
specify which is the default library that displays when you use 
body patterns.

The Applications/Body Patterns screen can be accessed 
through either the Body Pattern Libraries or Applications Touch 
Panel keys.

Figure 10-13. Body Patterns Applications Preset Menu

Selecting body pattern application libraries

1. On the Applications tab, in the Application field, select the 
body pattern.

2. In the Library Group Tabs fields, select the application 
libraries for Body Patterns. You can select up to six libraries.

3. In the Default Library Group field, select the default 
application library you want the system to display when you 
use body patterns.

NOTE: When you use body patterns, the default library is displayed. 
To use other application libraries, press the tab for the 
library.

4. To save the changes, select the Save button.

Table 10-57:  Applications

Preset Parameter Description

Preset Defines the Body Pattern option.

Tabs A list of body pattern applications. 

Default Tab The default library that the system displays when you use body patterns.
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Using body pattern application libraries

See the following Body Patterns Small Parts Touch Panel. 

Figure 10-14. Body Patterns Small Parts Touch Panel

To select a body pattern library, select the tabs (for example, 
ABD or OB). 

To select body patterns, use the Ellipse/Body Pattern control 
on the Control Panel.
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Application Presets

Overview

Application Presets allow you to configure the 
application-specific settings (presets). 

Settings

Table 10-58:  Preset 

Preset Parameter Description

Preset Select the application that you want to specify the presets. Along with the 

various applications available on the system, there are four user-defined 

application presets that can be set. 

Table 10-59:  Image Control and Display

Preset Parameter Description

Show kHz scale When selected, displays the kHz scale on the left side of the Doppler 

spectrum.

Show Doppler Rate When selected, displays the Doppler rate (mm/s) below the Doppler 

spectrum. 

Anatomical Angle 

Correction

Select to keep the angle constant with regard to the anatomy. 

Join Dual Image for Linear Select to place linear probe dual images directly next to each other. 

Hide Mode Cursor Key Select to unmap (hide) the Mode Cursor key, which normally appears on the 

left Trackball key during live scanning in B-Mode or Color Flow Modes.

Horizontal Display for 

Biplane

Display of the two planes of the Biplane probe in a top and bottom layout. 

Table 10-60:  Auto Zoom Linear Probe Images at Shallow Depth... 

Preset Parameter Description

Check Desired Setting • Single Screen

• Dual Screen and DualView

• Virtual Convex
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Table 10-61:  When Entering Dual Image...

Preset Parameter Description

Duplicate Frozen Image to 

Opposite Side

When entering Dual Image, duplicate the frozen image to the opposite side. 

Duplicate Live Image to 

Opposite Side

When entering Dual Image, duplicate the live image to the opposite side. 

Table 10-62:  Patient Info

Preset Parameter Description

Titlebar Line 1 Select the patient information to display on the scanning screen Title bar.

Titlebar Line 2 Select the patient information to display on the scanning screen Title bar.

Titlebar Line 3 Select the patient information to display on the scanning screen Title bar.

Table 10-63:  Comments

Preset Parameter Description

Active function at Freeze Select None, Body Pattern, or Comments. If Body Pattern or Comment is 

selected, the Body Pattern or Comment is activated automatically when 

freezing the system.

Erase when the image is 

unfrozen

Select to erase image when system Freeze is deactivated.

Table 10-64:  Footswitch 

Preset Parameter Description

Left, Middle, Right Specify from the following for each footswitch pedal: No Function, Record/

Pause, Freeze, Next Heartcycle, Previous Heartcycle, Print 1,2,3,4, Update, 

Next Step (Scan Assistant), Previous Step (Scan Assistant), Scan Assistant 

Pause/Resume, or Mark Cine. 

Table 10-65:  Protocol

Preset Parameter Description

Show Protocol Tab Check to display the Protocol Tab on the Touch Panel. 

Template Select the default stress echo template: Bicycle Normal, Bicycle Sporty, 

Contrast Pharmacological, Pharmacological 4x4, Pharmacological 8x5, 

Exercise 2x4, Exercise 2x4 B, Pharmacological US 4x4

Table 10-66:  ECG 

Preset Parameter Description

Show ECG Tab Check to display the ECG Tab on the Touch Panel. 
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Print Controls

Press the “Connectivity/Button/Physical Print Buttons” hyperlink 
to go directly to the Connectivity Print Button Setup page.

ECG Lead Specify the number of ECG Leads (1, 2, or 3). 

Resp Lead Specify the number of Respiration Leads (1 or 2). 

Table 10-67:  ELASTO 

Preset Parameter Description

Show Quality Bar Check to display a Quality Bar for Elastography. The more bars, the better 

the quality. As the quality increases, the bars go from red, to yellow, to green. 

Show Quality Graph 

(restart needed)

Check to display a Quality Graph for Elastography. The higher the level, the 

higher the data quality for the frames. This appears when you checkmark 

Utility--> Imaging--> General--> Elasto--> Quality Display. 

Table 10-68:  SHEAR 

Preset Parameter Description

Show Quality Bar Check to display a Quality Bar for Shear. The more bars, the better the 

quality. As the quality increases, the bars go from red, to yellow, to green. 

Table 10-69:  User Label

Preset Parameter Description

Show Label If selected, the system displays the User label in the Preview Window at the 

bottom left portion of the monitor. 

Label 1-8 User Labels have eight (8) text lines. Each User Label is limited to 50 

characters. 

Table 10-70:  Live Store

Preset Parameter Description

P1, P2, P3, P4, 

PrintScreen

Select Retrospective Clip (CINE prior to pressing Print), Prospective Clip 

(CINE after pressing Print), Single Image or None to store from a live image.

Table 10-66:  ECG  (Continued)

Preset Parameter Description

Table 10-71:  Time-Base Store 

Preset Parameter Description

Time span (s) Select the number of seconds of CINE Loop storage. The default is 3 

seconds. 
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3D/4D Time span (s) Select the number of seconds of CINE Loop storage while in 3D/4D. 

Contrast Time span (s) Select the number of seconds of CINE Loop storage while in Contrast. 

Preview clip before store When selected, allows you to review cine loops before storage.

Segment prospective loops 

longer than time span

Specify length of Clip (15, 30, or 45 seconds, Off, or Max). 

Table 10-72:  ECG-Based Store 

Preset Parameter Description

Time before heart cycle 

[ms]

Sets the storage time span before R-wave of the first heart cycle.

Time after heart cycle [ms] Sets the storage time span after R-wave of the last heart cycle.

Number of heart cycles Select the number of heart cycles to store. (Must be de-selected for single 

frame.)

Preview cine clip before 

store

When selected, allows you to review Cine loops before storage.

Table 10-73:  Mark Cine

Preset Parameter Description

Enable Mark Cine Control Lets you mark where you want the Cine Loop to start (prospective CINE). 

Preview Loop Longer 

than... (s)

When selected, allows you to review Cine loops before storage for loops 

longer than selected timeframe (in seconds).

Table 10-71:  Time-Base Store  (Continued)

Preset Parameter Description
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Imaging Controls

You can select which controls you want to be available via the 
Touch Panel during a clinical scan. When you select Preset--> 
Application and Control Mode--> Clinical, deselect the controls 
you DO NOT want to appear while scanning in this clinical 
application. 

NOTE: If you select Research, all controls appear. 

Figure 10-15. Imaging Controls, Research

Clinical vs Research Touch Panel Example. To view all controls 
press the View All/View Less control (circled). 

Figure 10-16. Clinical Control Mode
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Imaging Controls  (continued)

Figure 10-17. Research Control Mode

Comments and Body Patterns

Comments and Body Patterns were described earlier in this 
chapter.

Measurements

You can set the exam category measurement and calculation 
package you want to appear when you select the exam category 
Preset. 
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User Specific

Refer to “Monitor Display” in Chapter 3 for more information.
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Test Patterns

For more information, see Test Patterns in the Wide Monitor 
section of Chapter 3. 
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3D/4D

Overview

3D/4D presets allow you to set up application-specific settings 
(presets) for each 4D image acquisition type. You can define 
different application-specific settings for each probe. Refer to 
Chapter 5 for more information. 

4D Presets

To set up 4D presets:

1. On the Touch Panel, select Utility.

2. On the Touch Panel, select 3D/4D.

The system displays the 4D Presets screen.

3. To select a probe, click on the plus sign (+) that appears 
next to the desired probe.

4. To select the application, click on the plus sign (+) that 
appears next to the desired application.

5. To select the acquisition type, click on the plus sign (+) that 
appears next to the desired application.

6. Double-click the desired application under the acquisition 
type. The Display tab is selected.
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Display Presets Tab

Table 10-74:  Image Display

Preset Parameter Description

Tile Determines the number of display windows. Values include: 1 (Single), 2 

(Dual), and 4 (Quad).

Visualization Determines the method of display for working with images. Selections 

available: Sectional, Render, VOCAL, VCI static and TUI.

3D Orientation (degrees) Determines the orientation of the ROI on the monitor display. Values include: 

0, 90, 180, 270.

Zoom Factor Determines the magnification factor of the zoom. Values include: 0.3 through 

4.0, in .01 increments.

Orientation Help Activate Orientation Help. 

Gain Set the desired Gain. 

Table 10-75:  Pre-mode ROI

Preset Parameter Description

ROI Center (cm) Determines the vertical center of the region of interest. Values vary by probe.

ROI Span (cm) Determines the height of the region of interest. Values vary by probe.

Tilt (degrees) Determines the degree of tilt from the vertical center location of the ROI. 

Values vary by probe. 

Width (degrees) Determines the width of the ROI. Values vary by probe. 

Volume Angle Set the range of the volume sweep. Values vary by probe. Listed in degrees 

for curved probes, cm for linear probes.

Table 10-76:  Quality Setting

Preset Parameter Description

Setting Set quality setting -- balances speed with line density. Selections are Low, 

Mid1, Mid2, Hi1, Hi2, Max. High combines the highest density with the 

slowest speed. Low combines the lowest density with the highest speed. 

CF Setting Set quality setting -- balances speed with line density. Selections are Low, 

Mid1, Mid2, Hi1, Hi2. High combines the highest density with the slowest 

speed. Low combines the lowest density with the highest speed.
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Render Tab

Table 10-77:  Render and Render for VCI Static

Preset Parameter Description

Render Mode 1:Mode2  

(Gray Inversion, and VCI 

Static)

Set render mode values. Surface Smooth, Surface Texture, Transp Max, 

Transp X-Ray, TransMin (Render 1), or HDlive Texture Surface Smooth, 

Light, Gradient Light, Transp Max, Transp X-Ray, Transp Min (Render 2), or 

HDlive Smooth. 

Mix/Mix Inversion/eMixVCI 

Static (% Render Mode 2)

Set mix of Render 1 / Render 2 Mode, 0-100. 

Lower Threshold Set a lower threshold below which weaker echoes are removed, 0-255. 

Transparency/

Transparency (Inversion)

Set the transparence of the image,  10/20-250. The higher the number, the 

more transparent the gray scale information.

Render Direction Set the direction in which the ROI is viewed. 

SonoRenderLive Check to use SonoRenderLive.

SonoRenderLive 

Sensitivity

Set the SonoRenderLive sensitivity from 1-100.

[VCI Static] Slice 

Thickness

Set slice thickness, 2-20. 
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Color / PDI Render tab

VOCAL tab

TUI tab

OmniView tab

Table 10-78:  Color / PDI Render

Preset Parameter Description

Render Mode 1 (Color) / 

Render Mode 2 (Color)

Determine the render mode, selected from Render Mode 1 and Render Mode 

2. 

Mix (Color) Set the percentage of Render Mode 1 to be mixed with Render Mode 2. 

Lower Threshold (Color) Set the lower threshold below which weaker echoes are removed. 

Transparency (Color) Determine the transparency of the image. The higher the number, the more 

transparent the gray scale information. Values: 20 to 255.

Render Gray : Color) Determine the render mode, selected from Render Mode 1 and Render Mode 

2. 

Mix (Gray Color) Set the percentage of Render Mode 1 to be mixed with Render Mode 2.

Table 10-79:  VOCAL

Preset Parameter Description

Vocal Method Set Sphere, Manual, Contour Detect, or Semi-Auto Contour Detect. 

Vocal Semi-Auto-Detect 

type

Set Hypo, Cystic, or Hyper/Iso. 

Vocal Rotation step Set 6, 9, 15, or 30. 

Table 10-80:  TUI 

Preset Parameter Description

Display Format Set 1x1, 1x2, 2x2, or 3x3. 

Total Slices Set 3, 5, 7, 9, 11, 13, 15, 17, or 19. 

Slice Distance (mm) Set 0.5-40 (0.1 step increments). 

Table 10-81:  OmniView

Preset Parameter Description

Show OmniView View 

Direction Marker

Select to view the direction marker in OmniView. 
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Advanced tab

Table 10-82:  Advanced

Preset Parameter Description

Upper Threshold Sets the higher threshold above which weaker echoes are removed. 

Volume Calibration Shift See a Field Service Engineer for information on this parameter.
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Configuring Connectivity

Overview

You use Connectivity functionality to set up the connection and 
communication protocols for the ultrasound system. The 
following page gives an overview of each of the Connectivity 
functions. Each function is described in detail in the following 
pages. 

Connectivity Functions

To set up your institution’s connectivity, you must login with 
administrator privileges. 

1. TCP/IP: allows you to configure the Internet Protocol.

2. Device. allows you to set up devices. 

3. Service: allows you to configure a service (for example, 
DICOM services such as printers, worklist, and other 
services such as video print and standard print) from the list 
of supported services. This means that the user can 
configure a device with the DICOM service(s) that particular 
device supports.

4. Dataflow: allows you to adjust the settings of the selected 
dataflow and associated services. Selecting a dataflow 
customizes the ultrasound system to work according to the 
services associated with the selected dataflow. 

5. Button: allows you to assign a pre-configured output 
service (or a set of output services) to the Print keys on the 
control panel. 

6. Removable Media: enables formatting (DICOM, database, 
or blank formatting) and DICOM verification of removable 
media.
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Connectivity Functions  (continued)

7. Miscellaneous: allows you to set up the patient exam menu 
options, print and store options, and the order of the 
columns in the examination list on the Patient menu. 

8. Tricefy: allows you to archive, collaborate, and share 
patient images via a cloud-based image viewer. 

9. Koios DS. Koios DS is a Breast and Thyroid Lesion 
Analysis Option. Koios DS is integrated with the LOGIQ 
Fortis via DICOM. Koios DS is configured similar to a 
DICOM Service. The user can accept/dismiss analysis 
results. If accepted, these results are included in the DICOM 
Structured Report. (Not available in all countries.) 

Configure these screens from left to right, starting with the TCP/
IP tab first. 

NOTE: The ultrasound system is pre-configured for many services, with 
default settings selected. You can change these services and 
settings as needed.



Configuring Connectivity

LOGIQ Fortis – Basic User Manual 10-61
5855997-1EN Rev. 3

TCP/IP

The left side of the TCP/IP screen displays the Wired Network 
Configuration; the right side of the screen displays the Wireless 
Network Configuration. 

Figure 10-18. TCP/IP Screen

The Wired Network Configuration shows what the LOGIQ 
Fortis local area network settings are configured to, while the 
Wired Connection section shows the actual network 
configuration the system is currently using and has recognized. 
If these two sections do not match, reboot the system and 
recheck the network settings. 

Determine Your Network Settings

Determine the type of network settings you will use and 
configure:

• IPV4 or IPv6: IPv4 is a 32-bit address, IPv6 is a 128-bit 

address. 

• DHCP (Dynamic Host Configuration Protocol): Enables a 
server to automatically configure the network settings.

• Static IP: Manually configured network settings.
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DHCP

To configure DHCP network connectivity:

1. Select the DHCP check box to enable automatic 
configuration of your network settings. 

Figure 10-19. DHCP Network Connectivity Menu

2. To use IPv6, check the IPv6 box. If unchecked, the system 
will use the default IPv4 settings.

3. Press Save at the bottom of the screen to save the 
automated configuration.

4. Restart the system to activate any saved changes. 
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Static IP 

To configure Static IP network connectivity:

1. Uncheck the Enable DHCP box.

2. To use IPv4, leave the IPv6 box unchecked (IPv4 is the 
default Static IP configuration).

To use IPV6, check the IPv6 box.

Figure 10-20. IPv4 and Iv6 Static IP Connectivity Menu

3. Type the name of the Ultrasound system in the Computer 
Name field. 

4. Enter the following information in the designated fields:

• IP-Address (acquire a unique static IP address from the 
network administrator)

• Subnet Mask  

• Default Gateway (if applicable)

• Primary and Secondary DNS addresses (optional)

NOTE: At least one valid DNS address is needed for Insite 
remote service connectivity.

5. Press Save at the bottom of the screen. 
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Static IP  (continued)

6. Restart the system to activate any saved changes. 

NOTE: Per system design, TCP/IP settings do not get restored when 
restoring backups. The LOGIQ Fortis IP address MUST BE 
unique.

TCP/IP Preset Menus

Table 10-83:  Computer Name

Preset Parameter Description

Computer Name Type the unique name for the Ultrasound system (no spaces in name).

Table 10-84:  Wired Network Configuration

Preset Parameter Description

Enable DHCP Select this box to enable dynamic IP Address selection (unless you use 

DICOM). When DHCP is enabled, the IP Address, Subnet Mask, Default 

Gateway, Primary DNS Server and Secondary DNS Server fields are 

disabled. 

IPv6 Select this box to enter IPV6 Static IP settings.

Network Speed Select the network speed (Auto Detect, 10Mbps/Half/Full Duplex, or 100 

Mbps/Half/Full Duplex, and 1000Mbps/Auto-negotiate).

Table 10-85:  Wired Connection

Preset Parameter Description

IP-Address The IP Address of the Ultrasound system. NOTE: IP stands for Internet 

Protocol. Every device on the network has a unique IP address. 

Subnet Mask The Subnet Mask is an IP address filter that eliminates communication/

messages from network devices of no interest to your system. 

Default Gateway The default gateway address (optional).

Primary DNS Server Enter the IP address for the Primary DNS server (optional - - at least one 

valid DNS address is needed for Insite remote service connectivity).

Secondary DNS Server Enter the IP address for the Secondary DNS server (optional). (Do not 

configure Secondary DNS server only; if only one DNS IP address is being 

used, enter it in the Primary DNS Server field.)

MAC Address Unique network card address. 

Speed (Mbps) Actual network speed in Megabits per second.

Connected (min) The number of minutes the system has been connected to the network. 
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Status Current network status. 

• Operational: Network adapter has been disabled, for example because of 

an address conflict.

• Unreachable: Network adapter that is not connected.

• Disconnected: For LAN adapters: network cable disconnected. For WLAN 

adapters: no carrier.

• Connecting: Network adapter that is in the process of connecting.

• Connected: Network adapter that is connected to a remote peer.

Table 10-86:  Wireless Network

Preset Parameter Description

Configuration Press to view or change the Wireless Networking settings. See Chapter 13 

for more information. 

IP-Address The current IP address assigned to the wireless network adapter. 

Subnet Mask The current network mask assigned to the wireless network adapter. 

Default Gateway IP address of the local subnet gateway host.

Primary DNS Server Enter the IP address for the Primary DNS server (optional - - at least one 

valid DNS address is needed for Insite remote service connectivity).

Secondary DNS Server Enter the IP address for the Secondary DNS server (optional). (Do not 

configure Secondary DNS server only; if only one DNS IP address is being 

used, enter it in the Primary DNS Server field.)

MAC Address The Ethernet address assigned to the installed wireless adapter hardware.

Speed (Mbps) Actual network speed in Megabits per second.

Connected (min) The number of minutes the system has been connected to the network. 

Status Current network status. 

• Operational: Network adapter has been disabled, for example because of 

an address conflict.

• Unreachable: Network adapter that is not connected.

• Disconnected: For LAN adapters: network cable disconnected. For WLAN 

adapters: no carrier.

• Connecting: Network adapter that is in the process of connecting.

• Connected: Network adapter that is connected to a remote peer.

Table 10-85:  Wired Connection (Continued)

Preset Parameter Description
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Device

The LOGIQ Fortis Ultrasound System’s internal firewall will have 
exemptions for ports used by the defined DICOM dataflows in 
the system. Defining a new DICOM dataflow, or changing an 
existing one will cause the internal firewall configuration to 
change automatically. This will ensure that only ports configured 
for a dataflow will have an exemption in the internal firewall.

Allow Trusted 
Devices Only

The LOGIQ Fortis is set by default to only connect to trusted 
devices via Utility-> Connectivity-> Device-> Allow Trusted 
(Configured) Devices Only. 

Figure 10-21. Connect LOGIQ Fortis to Trusted Devices Only

To add a new device: 

1. Press Add. 

2. Type the device name in the Name field. 

3. Type the device’s IP address in the IP Address field. 

DICOM Verbose 
Logging

You can set the LOGIQ Fortis to enable logging of DICOM traffic 
messages to protected logs by enabling DICOM Verbose 
Logging. The default time limit is set for 5 minutes. DICOM 
protected logs are collected via [Alt+D]. After the configured 
time, DICOM Verbose Logging is automatically disabled. 
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Device  (continued)

DICOM TLS If you select DICOM TLS, the LOGIQ Fortis communicates 
securely with all the configured services for that device with 
secure communication by encrypting the DICOM objects during 
transfer, via TLS1.2 protocol. You can import/delete certificates, 
use the selected certificate, and verify the certificate during 
association negotiation. 

Click on “Certificate” to view, import, verify, or delete certificates. 

Figure 10-22. Certificate Manager

To import a Certificate, press “Import Certificates”: 

Figure 10-23. Import Certificate Pop-up
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Device  (continued)

To ping a device, 

1. Select the device. 

2. Press Ping. If the smiley face smiles, then the connection 
has been confirmed. If the smiley face frowns, then the 
connection has not been made. Check the device name and 
IP address. 

Table 10-87:  Device

Preset Parameter Description

Allow Trusted (Configured) 

Devices Only

Checked by default. Uncheck to allow non-trusted or unconfigured devices.

Ping Press Ping to confirm that a device is connected. 

Add/Remove Press Add to add a new device; press Remove to delete a device. 

Properties: Name Type the name of the device. 

Properties: IP Address Type the device’s IP address. 

Properties: AE Title AE Title of the LOGIQ Fortis. NOTE: Only available for MyComputer.

Properties: Port Number IP Port Number Used for DICOM, set by default to 104. NOTE: Only available 

for MyComputer.

Table 10-88:  DICOM TLS

Preset Parameter Description

Use DICOM TLS 

Encrypted Connection

Check box to use a DICOM TLS encrypted connection.

Table 10-89:  DICOM Verbose Logging

Preset Parameter Description

Enable DICOM Verbose 

Logging

Check to enable DICOM verbose logging. Select number of minutes from 

dropdown menu: 5, 10, 15 or 30 minutes.
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Service

For each Device that you added to the system, you need to set 
up the service(s) that device supports (you must be an 
administrator to update these screens). 

The Services screen has the following sections of information:

1. Destination Device - lists information about destination 
devices. You can select from a list of currently existing 
devices.

2. Service Type to Add - lists information about services for 
the destination device. You can add services, select from a 
list of currently existing services, and remove services.

3. Service Properties - lists properties for the service 
currently selected in the Services section. The name and 
properties in this section change, depending on what 
service is currently selected.
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Adding a service to a destination device

1. Select the service from the pull-down menu. Press Add. 

2. Specify the properties for this service. Press Save. 

3. Verify the service by selecting the Verify button (“Smiley 
Face”). The Verify button checks the connection status with 
the server and the compatiblity with the PACS device.     

If the connection status and compatibility with the PACS 
device are successful, the Verify button exhibits a smile and 
the Test Results area displays the compatible settings, 
along with Print button details (if Use Button Settings is 
enabled). (See Figure 10-24.)

If the connection status and compatibility results are 
unsuccessful, the Verify button exhibits a frown and the Test 
Results area displays the error with recommended actions. 
Examples of unsuccessful verify results are:    

• Connection to the server not established

• PACS device refuses service

• DICOM objects are not supported

• Configured compression is not supported

 Figure 10-24. Service Verify Button (1), Properties (2) and Test Results (3)
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Removing a service

1. Select the service. Press Remove. 

2. Press Save. 

Changing parameters for a service

There are certain parameters that may need to be set up for 
each service (see Figure 10-24 on page 10-70): 

Table 10-90:  Service Properties: Common Service Parameters

Preset Parameter Description

Name Free text: give a descriptive name to the device.

AE Title The Application Entity Title for the service.

Port Number The port number of the service.

Maximum Retries Max # – the maximum number of times to try establishing a connection to the 

service.

Retry Interval (sec) Specify how often (in seconds) the system should try to establish a 

connection to the service. 

Timeout The amount of time after which the system will stop trying to establish a 

connection to the service.

Enable Encryption Select to enable Patient Data Encryption. 

CAUTION DO NOT use the following Ports: 

• Port 22 (SSH, SFTP)

• Port 53 (DNS-Domain Name Service)

• Ports 67, 68 (DHCP-Dynamic Host Configuration Protocol)

• Port 80, 443 (Web Traffic)

• Port 123 (NTP-Network Time Protocol)

• Port 445 (Microsoft File Sharing)

• Port 546, 547 (DHCPv6)

• Port 5900 (Tight VNC Server)

• Port 8100 (Node-HTTP)
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Changing parameters for a service  (continued)

Many service parameters are specific to each type of service. 
The parameters are described on the following pages:

• Standard Print

• Video Capture

• Save As

• USB Quick Save

Standard Print

Video Capture

Save As

Table 10-91:  Standard Print

Preset Parameter Description

Printer Select the printer. 

Rows Specify 1-5. 

Columns Specify 1-5. 

Orientation Specify Landscape/Portrait

Top Margin (mm) Specify the top margin (0-51mm)

Bottom Margin (mm) Specify the bottom margin (0-51mm)

Left Margin Specify the left margin (0-51mm)

Right Margin Specify the right margin (0-51mm)

Table 10-92:  Video Capture

Preset Parameter Description

Type Specify Color, BW, or DVR Record/Pause. 

Table 10-93:  Save As

Preset Parameter Description

Destination Specify destination device, Hard Drive, USB Flash Drive. 
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Setting up a Printer

There are two service types that pertain to printers: Standard 
Print and Video Capture Device. 

Standard Print. Use Standard Print for digital peripherals. These 
are printers with either a USB interface or Ethernet interface 
(Sony UP-D898DC, for example). 

Video Capture Device. Use Video Capture Device for devices 
that are triggered by a contact closure, typically analog devices 
(color printer, black/white printer and DVR Record/Pause, for 
example). 

On the Utility --> Connectivity --> Button page, select the Print 
key in the upper, left-hand corner of the display. In the middle 
portion of the page, under Available Input/Outputs, select the 
printer you want to configure. Next, press the two right arrows 
(>>) in the upper, right-hand corner of the page to move this 
printer into the Printflow View. 

You can also configure the Standard Print button that appears 
on the New Patient Active Images screen. 

Example: For instance a video capture device, on the Utility --> 
Connectivity --> Service page, in the Service Type to Add box, 
and press Add. In the properties box on the upper, right-hand 
side, select the type of device and in the Properties box in the 
lower, left-hand side, type in a unique descriptive name for this 
device. 

USB Quick Save

See ‘USB Quick Save’ on page 9-52 for more information. 



Customizing Your System

10-74 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Structured Reporting

DICOM Structured Reporting provides the results of a procedure 
as structured data elements (well-defined fields) as opposed to 
unstructured data (large amounts of text undifferentiated by 
individual fields). This greatly improves query capability. DICOM 
Structured Reporting creates coded clinical data that can be 
used for clinical research, outcomes analysis, and disease 
management.

DICOM Structured Reporting is a standardized format for 
medical results. LOGIQ Fortis supports the following templates:

• OB-GYN Report Templates

• Vascular Ultrasound Report Templates

• Cardiac Report Templates

• Abdomen Report Templates

• Breast Report Templates

• Thyroid Report Templates

These templates do not support all M&A results for the LOGIQ 
Fortis.

Supported Parameters

The DICOM supported parameters are listed in the DICOM 
Conformance Statement at the following website under DICOM - 
Ultrasound:

https://www.gehealthcare.com/products/interoperability/dicom/
ultrasound-dicom-conformance-statements
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DICOM SR Storage

DICOM SR Storage enables the system to send or receive 
ultrasound structured reports in a format that can be interpreted 
by PACS.

To configure this service, navigate to Utility -> Connectivity -> 
Service and select DICOM SR Storage from the Destination 
Device drop-down menu.

DICOM Image Storage

DICOM Image Storage enables the system to send or receive 
ultrasound images in a format that can be interpreted by PACS.

Figure 10-25. DICOM Image Storage

Table 10-94:  DICOM Image Storage

Preset Parameter Description

Allow Clips Select to allow cine loop storage. Deselect to send only Stills to PACS.

Allow Enhanced DICOM 

Objects

Select to allow enhanced DICOM objects. 

Allow Raw Data Select to save data in both TruAccess (raw data) and DICOM format. Clear to 

save in DICOM format only.

Color Support Select: Mixed or Color. Best performance when set to Color.

Use Button Settings If “Use Button Settings” is checked, the system will use the default system 

image storage and compression presets. 

If “Use Button Settings” is unchecked, the Properties menu expands and the 

user can define the image storage and compression presets as desired. 

Still Image Compression Select the compression type: None, Rle, Jpeg, or Jpeg2000. Copy the 

compression settings from the local file for best performance. 
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DICOM Performed Procedure

DICOM Performed Procedure provides an acknowledgement 
that a study has been performed.

DICOM Print

DICOM Print provides the ability to send or receive ultrasound 
image data to DICOM printers.

Clip Compression None, RLE, JPEG, JPEG2000

Clip Quality Lossless, 50-95. 85 is the recommended quality setting. 

Use RGB color format for 

JPEG2000

Select to use RGB color format for JPEG2000 compressed images. (This 

option is visible only if Still, Clip or Volume compression is set to JPEG2000.) 

Max Framerate Select the maximum frame rate: Full, 25, 30, 60 or 80.

Reopen per image When selected, the storage protocol uses a new association for each image 

sent. 

Enable Structured 

Reporting

Select for Structured Reporting. 

Apply Display Precision to 

Measurements

When Enable Structured Reporting is selected, Apply Display Precision to 

Measurements is available; select to apply the same precision for a 

Structured Report that is used on the scanner display.  (Apply Display 

Precision to Measurements is always available for a DICOM SR Storage 

service.)  

Key Image Notes Image deletion notification. ONLY available for the Direct Store Workflow and 

ONLY generated when there are images deleted during the exam. Selecting 

this lets the reader at the PACS system know which images have been 

deleted. An indicator is placed on deleted images with a reason, “Rejected for 

Quality Reasons,” for example. 

Table 10-94:  DICOM Image Storage (Continued)

Preset Parameter Description

Table 10-95:  Properties 

Preset Parameter Description

Vendor Specify PACS Vendor. This enables annotation on patient information since 

by definition patient information is missing on the title bar. 

Format Indicates how many prints to print per page, for example, 1,1, 1,2, 1,3, up to 

7,5. Partial prints are displayed as one print job.

Priority Specify the print job priority: High, Medium, or Low.

Medium Select the print medium: Clear Film, Paper, or Blue Film.

Copies Enter the number of copies. 
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Orientation Specify whether to print the image Portrait (vertically) or Landscape 

(horizontally).

Film Size Specify the dimensions of the film size.

Film Destination Specify the film destination for the exposed film

• Magazine – Store in a film magazine

• Processor – Develop in a film processor

Magnification Specify how the printer magnifies the image to fit it onto the film. 

• Replicate – Interpolated pixel are copies of the adjacent pixels 

• Bilinear – Interpolated pixels are created by bilinear interpolations between 

the adjacent pixels

• Cubic – Interpolated pixels are created by cubic interpolations between the 

adjacent pixels

• None – No interpolation

Smoothing Type Specify the printer’s magnification interpolation for the output.

Trim Specify whether you want a trim box to be printed around each image on the 

film: Yes or No.

Min Density Enter a number indicating the minimum density level of the film.

Max Density Enter a number indicating the maximum density level of the film.

Border Select to have the border area surrounding and between the images of the 

film: Black or White.

Empty Image Select to have a Black or White empty image.

Color Select whether to have the image Color or Grey.

Configuration Information Enter vendor-specific image quality settings.

Film Session Label Type a name for the group of film labels associated with the print job.

Table 10-96:  Annotation 

Preset Parameter Description

Enable Lets you annotate the image. 

Table 10-95:  Properties  (Continued)

Preset Parameter Description
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DICOM Query/Retrieve

DICOM Query/Retrieve provides a list of patients sorted by 
query parameters. 

NOTE: Some PACS vendors only offer Query/Retrieve as an option. 
Please confirm that this service is available. 

Verify Before 

Query

Box Checked. The system DOES CHECK the DICOM 
connection status PRIOR to issuing the Query/Retrieve request. 
This way, the system ensures that the PACS server is ’alive’ 
before performing the actual query. If the server is down, the 
scanner will not issue the query request and the system is 
accessible to the user within the configured “Verify Timeout 
(sec)” preset value which is ~10 seconds by default.

Box unchecked. The system DOES NOT CHECK the DICOM 
connection status PRIOR to issuing the Query/Retrieve request 
to the PACS server. If the server is down, the scanner is 
accessible only AFTER configured “Connection Timeout(sec)” 
value which is ~20 seconds by default. 

Table 10-97:  DICOM Query/Retrieve

Preset Parameter Description

Maximum Results Specify the maximum number of patient records you want the system to 

retrieve when searching the patient database, up to 300, with the default set at 

100.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 

for the system to use when searching the patient database.
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DICOM Query/Retrieve  (continued)

NOTE: If you are experiencing problems with slow responses from 
DICOM servers, increase the time-out in the DICOM server 
properties dialog. (Utility -> Connectivity -> Service -> Properties 
-> Maximum Retries and Timeout). Problems with slow 
responses may result in images being re-sent automatically and 
low transfer rates. The retry settings can be used to make jobs 
retry on bad networks. When portable (off-line), use minimum 
time-out and no retries or it will affect shutdown speed.

Query/Retrieve Per Series

You can also display/retrieve multiple series by patient on the 
Patient--> Data Transfer--> Q/R page. 

DICOM Storage Commitment

DICOM Storage Commitment provides acknowledgement from 
PACS that the study has been accepted into archive.

Table 10-98:  DICOM Query/Retrieve Search Criteria 

Preset Parameter Description

Select Search Criteria to 

Add

Select the type of information that you want to define for search parameters. 

The following searches are allowed: Patient Name, Patient ID, Modality, 

Scheduled Procedure Start Date, Start Time, and End Time. 

Tags (at least one) The name of a tag selected to use for search criteria.

Value Type the value of the Selected Tag item. For example, if you select Referring 

Physician’s Name in the Select Tag field, you can enter the name of the 

physician in the Value field. 

Don’t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 

query, select Don’t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 

Table 10-99:  DICOM Storage Commitment

Preset Parameter Description

Associated Storage This selection is based on the services entered by the user. 
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DICOM Worklist

DICOM Worklist provides a list of patients sorted by query 
parameters.

Figure 10-26. DICOM Worklist Service

Verify Before 

Query

Box Checked. The system DOES CHECK the DICOM 
connection status PRIOR to issuing the Worklist Query request. 
This way, the system ensures that the HIS/RIS server is ’alive’ 
before performing the actual query. If the server is down, the 
scanner will not issue the query request and the system is 
accessible to the user within the configured “Verify Timeout 
(sec)” preset value which is ~10 seconds by default.

Box unchecked. The system DOES NOT CHECK the DICOM 
connection status PRIOR to issuing the Worklist Query request 
to the HIS/RIS server.  If the server is down, the scanner is 
accessible only AFTER configured connection timeout value 
with configured number of retries, which is ~45 seconds. 
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DICOM Worklist  (continued)

Table 10-100:  DICOM Worklist

Preset Parameter Description

Max. Result Specify the maximum number of patient records you want the system to 

retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 

for the system to use when searching the patient database.

Table 10-101:  DICOM Worklist Search Criteria 

Preset Parameter Description

Select Search Criteria to 

Add

Select the type of information that you want to define for search parameters. 

The following searches are allowed: Patient Name, Patient ID, Modality, 

Scheduled Procedure Start Date, Start Time, and End Time. 

Tags (at least one) The name of a tag selected to use for search criteria.

Value Type the value of the Selected Tag item. For example, if you select Referring 

Physician’s Name in the Select Tag field, you can enter the name of the 

physician in the Value field. 

Don’t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 

query, select Don’t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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DICOM Export

DICOM Export allows you to export DICOM content. 

Figure 10-27. DICOM Export Service

Table 10-102:  DICOM Export

Preset Parameter Description

Convert Clips Select to convert raw clips to DICOM multi-frame clips. 

Convert Volumes Select to convert raw volume files to Enhanced DICOM format (DICOM 3D 

files).

Use Button Settings If “Use Button Settings” is checked, the system will use the default system 

image storage and compression presets. 

If “Use Button Settings” is unchecked, the Properties menu expands and the 

user can define the image storage and compression presets as desired. 

Allow Raw Data Select to save data in both TruAccess (raw data) and DICOM format. Clear to 

save in DICOM format only.

Still Image Compression Select the compression type: None, Rle, Jpeg, or Jpeg2000. Copy the 

compression settings from the local file for best performance. 

Clip Compression None, RLE, JPEG, JPEG2000

Clip Quality Lossless, 50-95. 85 is the recommended quality setting. 

Enhanced DICOM 

Compression

None, RLE, JPEG Lossless, JPEG2000 Lossless
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EZBackup

EZBackup allows you to manage hard disk space while 
maintaining the patient database on the scanner, as well as to 
back up the patient database and images, by copying the data 
from the local drive to removable media.

Figure 10-28. EZ Backup Service

Table 10-103:  EZBackup

Preset Parameter Description

Convert Clips Select to convert clips for EZBackup. 

Convert Volumes Select to convert volumes for EZBackup. 

Use Button Settings If “Use Button Settings” is checked, the system will use the default system 

image storage and compression presets. 

If “Use Button Settings” is unchecked, the Properties menu expands and the 

user can define the image storage and compression presets as desired. 

Allow Raw Data Select to save data in both TruAccess (raw data) and DICOM format. Clear to 

save in DICOM format only.

Still Image Compression Select the compression type: None, Rle, Jpeg, or Jpeg2000. Copy the 

compression settings from the local file for best performance. 

Clip Compression None, RLE, JPEG, JPEG2000

Clip Quality Lossless, 50-95. 85 is the recommended quality setting. 

Enhanced DICOM 

Compression

None, RLE, JPEG Lossless, JPEG2000 Lossless
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Dataflow

A dataflow is a set of pre-configured services. When you select 
a dataflow, the ultrasound system automatically works according 
to the services associated with the dataflow. The Dataflow tab 
allows you to select and review information about dataflows. You 
can also create, change, and remove dataflows.

Set up dataflows for the services. 

NOTE: You must be logged on as Administrator to use the Dataflow tab.

Figure 10-29. Dataflow Preset Menu

Key Object 

Selection: Image 

Deletion 

Notification

Image Deletion Notification is available ONLY for the Direct 
Store Workflow and only generated when there are images 
deleted during the exam. This lets the reader at the PACS 
system know which images have been deleted. An indicator is 
placed on deleted images with a reason, “Rejected for Quality 
Reasons,” for example.

Table 10-104:  Dataflow Properties 

Preset Parameter Description

Name Select the dataflow from the list.

Direct Store Select to store data directly to archive (no buffer storage).

Hidden Select so that this dataflow does not appear as a Dataflow on the Patient 

menu. 

Default Dataflow Select to use this dataflow as the default dataflow when you start the system.
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Button

You can assign print buttons via the Utility --> Connectivity --> 
Button page. 

Assigning print buttons. First select the print button to configure 
on the upper, left corner of the page. Then select the device you 
want to add in the middle part of the page, under Available Input/
Outputs. Then click on the right arrow in the top right corner of 
the page. 

NOTE: You can configure each print key to multiple output devices/
dataflows. 

NOTE: Only attach one DICOM service per print key (e.g., PACS and 
DICOM printer). Multiple DICOM devices should be configured 
via a dataflow.

NOTE: When using a print key to send an image directly to a DICOM 
device, this causes a single DICOM association per image. Most 
devices (all known printers) work fine with this. However, some 
storage devices, such as ALI, Kodak Access, and Cemax, 
assume that the end of each association is the end of the exam 
and can result in a new folder for each image. In the Utility 
menu, select a single association or open PR for the desired 
DICOM storage device. 

Table 10-105:  Print Button 

Parameter Description

Physical Print Buttons

• Print 1-4

• PrintAutoSweep

M&A only (no images) Configures the system to send a DICOM structured report only; no image is 

generated or sent. 

Still Images • Format: Ultrasound Image, Secondary Capture (Image, Video, Screen) 

• Compression: None, Rle, Jpeg, Jpeg2000

Clips • Clips: Add Multiframe Data: Checkbox

• Compression: None, Rle, Jpeg, Jpeg2000

• Quality: Lossless, 99, 98, 97, ... 50

Volume Volume File Format*: 1-Standard DICOM (Default), 2-Standard DICOM with 

Raw Data; 3-Enhanced DICOM, 2&3 (2 files)

Note: The default Compression for Clips/Volumes is JPEG85. It is strongly recommended to keep the 

Compression set to JPEG85. 
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Advanced • VNav Data: V Nav View (Default), Ultrasound Only, or VNav & Ultrasound (2 

files)

• Compare Assistant: Comparison view (Default), New image, Both 

Comparison & New (2 files)

• Scan Assistant Advance: On, Off, Use program (system uses setting from 

the Scan Assistant program which allows a user to configure two print keys 

identically except that one advances Scan Assistant and the other does 

not.) On =advances to the next step when that print key is pressed 

independently of the program setting. Off = does not advance to the next 

step when the print key is pressed independently of the program setting.

Press “Application/Print Controls/Live Store” to hyperlink to the Application 

Print Controls utility page. 

Active Images Page: Standard Print

Table 10-105:  Print Button  (Continued)

Parameter Description
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Removable Media

The Removable Media tab allows you to:

• Verify the DICOM directory on removable media.

• Verify the free space of the media.

NOTE: Currently, the DVD-R Capacity displays the wrong value of 
650 MB. 

• Verify that the media is finalized or unfinalized.

• Verify that the media is formatted or unformatted.

• Format removable media (rewritable CD/DVD or USB 
device).

Figure 10-30. Removable Media Preset Menu

The bottom of the screen lists properties of the selected media.

Table 10-106:  Tools 

Preset Parameter Description

Removable Media Select the removable media to format or verify.

Label Type a label for a new removable media (free text).

Verify • Select to verify DICOM directory on removable DICOM disk.

• Verify the free space of the media.

• Verify that the media is finalized or unfinalized.

• Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the 

media is formatted with a full format. New media should always be formatted 

with a full format. 
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Formatting removable media

1. Select the removable media from the Media list.

2. Type a name for the removable media in the Label field.

NOTE: Do not use the following characters for labelling:

\ / : ; . , * < > | + = [ ] &

3. Select Format. Confirm OK or Cancel. 

4. An information window confirms when the format has been 
completed. Select OK to exit. 

NOTE: Select Full Format (do not check Quick Format box) when 
formatting a new MOD for the first time. 

Verifying removable media

1. Select the removable media from the Media list.

2. Select Verify.
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Miscellaneous

The Miscellaneous tab allows you to configure tools related to 
patient management and print and store options. You can 
specify default system functionality, such as whether patient ID 
is required when you archive data, or if you want the system to 
automatically search the archive for a patient when you enter 
patient data.

Table 10-107:  Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the birth 

date:When selected, enter birth date, then the age is calculated.When 

cleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window:When selected, the system 

automatically searches through the selected patient archive, while the user 

enters patient information.When cleared, the automatic search tool is turned 

off. If you are trying to keep the past patient data confidential, DO NOT use 

this feature. 

Automatic generation of 

patient ID

In the Search/Create Patient window:When selected, the Patient ID is not 

required when entering a new patient in the archive. The system 

automatically generates an ID number.When cleared, the Patient ID is 

required when entering a new patient in the archive.

Auto Archiving patient data Archives patient data automatically. 

After [End Current Patient], 

go to: 

Select Worklist screen or Patient screen. 

Keep Search String Search string is kept rather than cleared. 

Worklist Auto Query Automatically queries the worklist server. 

Validate Incoming 

Worklists

Confirm incoming Worklists are valid. 

Link Measurements to 

Images

Check to link measurements to images when sent to PACS. 

Verify all Measurements 

have Image References

Check to verify that all measurements have image references when sent to 

PACS. 

Show BBT Show BBT field on the OB patient screen to input the basal body 

temperature.

Double Click on Patient 

List to Start

Select Review or New Exam to display each time you double click on the 

patient name in the patient list on the Patient menu.

Detail Mode Select to display Detail Mode, rather than Exam View, when you select the 

patient name in the patient list on the Patient menu. You can also type 

comments while in Detail Mode.



Customizing Your System

10-90 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Automatic Disable Patient 

Data

Select to automatically disable patient data. 

If selected, locks the patient name, date of birth and gender (like Patient ID). 

The Factory Default for this preset is unchecked.

Remember Cursor Position 

on the Transfer Screen

To set a default cursor location on the Data Transfer screen: 

1. Select the “Remember cursor position in the Transfer screen” preset and 

press Save. 

2. On the Data Transfer screen, move the cursor to the desired field. 

3. Exit out of the Data Transfer screen. When returning to the Data Transfer 

screen, the cursor location is in the position your selected. 

Quick New Patient Entry Select to store new patient automatically by pressing the Patient key.

Table 10-108:  Patient/Exam Message Options 

Preset Parameter Description

Request acknowledge of 

End Exam action

When selected, the user is asked to confirm action when ending an 

examination.

Warn Image Store without 

Patient

Select to receive a warning when you press the Print key without an active 

patient.

Warn Register to No 

Archive

Select to receive a warning when you register a patient to the “No Archive” 

data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read 

Only dataflow

The system posts a warning message if you attempt to store images to a 

read-only Dataflow. 

Warn video titles exist in 

the internal storage

The system posts a warning if the video titles exist on the internal DVR flash 

memory. 

Table 10-109:  Columns in examination listing

Preset Parameter Description

Columns in examination 

listing

Create new columns, remove columns, and select the information to display 

in a column.

1. Move the Trackball to highlight a column.

2. Press Set.

3. Use the arrows (<< or >>) to reposition column headings. 

Table 10-110:  Print and Store Options 

Preset Parameter Description

P[1-4] Key Sound Select None, Click, Chimes, Ding, Ding-Dong, or Whoosh. 

Enable Smart Capture 

Area

Check box to select. 

Store 2D Loop with 

Timeline Data

Check box to select. 

Table 10-107:  Patient/Exam Menu Options (Continued)

Preset Parameter Description
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Patient List Print-Font Size Select font size. 

Add Titlebar Information to 

Multiframe Loops

Adds a title bar to the DICOM image. 

Add Scan Parameter 

Information to Multiframe 

Loops

Adds scan parameter(s) to the DICOM image. 

Send Images via Wireless When connected to the network via Wireless LAN and this box is checked, 

images will be sent to the DICOM device over the Wireless LAN. If not 

checked, images spooled in the Spooler will be sent when the system is 

connected to the wired network. 

Receive Images via 

Wireless

When connected to the network via Wireless LAN and this box is checked, 

images will be received from the DICOM device over the Wireless LAN. If not 

checked, images will be received when the system is connected to the wired 

network. 

Store DICOM MultiFrame 

When Collecting RF Data

Select to store DICOM MultiFrame images when collecting RF Data

Store DICOM MultiFrame 

in QAnalysis packages

Select to store DICOM MultiFrame images in Quantitative Analysis mode. 

(Selected by default.)

Allow press and hold print 

key to replace an image

Select to enable pressing and holding print key to replace an image. 

Send To: Default Service Select default Send To service from dropdown list.

Table 10-111:  Other ID Options

Preset Parameter Description

Enable Other ID Not selected is the Default.

If selected, allow entering Other ID, such as Citizen Service Number, Burger 

Service Number (BSN), National Health System (NHS) number, along with 

patient ID information on the Patient Screen.

Validation Format If the Enable Other ID preset is selected, the system validates the format of 

“Other ID” when an ID is entered. Choose: NHS Number *** ** *****, Letters 

and Numbers, Numbers, or Any (no restriction)

Table 10-112:  Image Numbering

Preset Parameter Description

Use Scan Assistant image 

reordering/numbering

Select to use Scan Assistant image reordering/renumbering.

Show image number on 

Active Images screen

Select to show image number on Active Images screen.

Table 10-110:  Print and Store Options  (Continued)

Preset Parameter Description
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Table 10-113:  LOGIQ Apps

Preset Parameter Description

Unpair Bluetooth Devices Select to unpair the LOGIQ Apps device. 

Table 10-114:  Imaging Insights

Preset Parameter Description

Store incremental analytic 

data in each image

Select to store incremental data in each image.

Send consolidated analytic 

data to server

Select to send consolidated analytic data to server.

Trigger interval outside an 

exam (hours)

Off, 1, 2, 3, 5

Server Select server from dropdown list.
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Tricefy Activation

Tricefy is a cloud-based image viewer and a platform to archive, 
collaborate, and share. The corresponding DICOM destinations 
can be used via the Print keys. An internet connection is 
necessary for uploading data to Tricefy. 

As soon as the Tricefy option is enabled, relevant Tricefy items 
are displayed. 

Figure 10-31. Tricefy Preset Menu

Table 10-115:  Configuration

Preset Parameter Description

Account Status Active/Inactive

Account Name Name for the account. 

Customer Name Customer’s name. 

Uplink ID Uplink ID. 

Table 10-116:  Activation

Preset Parameter Description

Account E-mail Account mail

Activate Press to activate the Tricefy option. 
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Device Mgmt Configuration

Device Mgmt is a remote device management tool that enables 
bi-directional management capabilities on the device. See 
‘Device Mgmt’ on page 13-498 for more information.

Cloud Sign-Up

Before Device Mgmt can be activated, the Device Owner must 
register a valid e-mail address on the Cloud at: 

http://AVURI.gehealthcare.com/signup

Activate Device Mgmt

 Figure 10-32. Device Mgmt Connectivity Page

To activate Device Mgmt:

1. Go to Utility > Connectivity > Device Mgmt.

2. Under Configuration, set the configuration parameters (see 
Table 10-117 on page 10-95).

3. Select Save at the bottom of the screen to save 
configuration parameter changes.

4. Select Activate.

The activation result is displayed.

NOTE: For more information on configuring Device Mgmt for activation, 
refer to the LOGIQ Fortis Basic Service Manual.
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Activate Device Mgmt  (continued)

Table 10-117:  Configuration Parameters

Parameter Description

Account E-mail E-mail address of the Device Owner used for registration on Cloud. The 

email address MUST be the same, valid email address registered during 

Cloud Sign-up.

Registration Key Product specific key strings, pre-populated by the device (can be 

overwritten if necessary).

Server URL URL of registration server strings, pre-populated by the device (can be 

overwritten if necessary).

Proxy Server (Optional) Proxy server address of the facility.

Proxy Port (Optional) Port number of the Proxy server.

Proxy User Name (Optional) Account user name of the Proxy server.

Proxy Password (Optional) Account password of the Proxy server.

Upload/Download  

Timeout(sec)

Upload is used during Auto Backup, Manual Backup and Upload for Fleet.  

Download is used during install.

The timeout pulldown is displayed only when Device Mgmt is Active.

Query Timeout(sec) Query runs when user starts New Patient, End Current Patient, Log off, 

Log on, or Unlock lock screen.

The timeout pulldown is displayed only when Device Mgmt is Active.
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Device Mgmt Group Rights

Device Mgmt activation requires the following Device Mgmt 
Group Rights.

Device Mgmt Administration Group Rights

• Activate

• Upload for Fleet

Advanced Configuration Group Rights

• Manual Backup/Backup Automatically

• Receive Installation Notification

• Install from Cloud

NOTE: For more information on configuring Device Mgmt for activation, 
refer to the LOGIQ Fortis Basic Service Manual.
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Update Connection Configuration

Proxy information and the Registration Key can be updated after 
Activation.

1. Go to Utility > Connectivity > Device Mgmt.

2. Edit the Server URL, Proxy Server, Port, User Name, 
Password, Upload/Download Timeout and Query Timeout 
fields, as needed.

NOTE: Account Email may not be modified.

3. Select Save at the bottom of the screen to save 
configuration parameter changes.

4. Select Update Connection Configuration.

 Figure 10-33. Update Connection Configuration
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Update Account Email

To update the account email from the system:

1. Go to Utility > Connectivity > Device Mgmt.

2. Select Deactivate to deactivate the configuration.

3. Under Configuration, set the configuration parameters (see 
Table 10-117 on page 10-95).

4. Select Save at the bottom of the screen to save 
configuration parameter changes.

5. Select Activate.

The activation result is displayed.
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Koios DS Configuration (not available in all countries)

Koios DS is a Breast and Thyroid Analysis Option. Koios DS is 
integrated with the LOGIQ Fortis via DICOM and is configured 
similar to a DICOM Service. The user can accept/dismiss 
analysis results. If accepted, these results are included in the 
DICOM Structured Report. 

Activate Koios DS

1. Access the Utility--> Connectivity--> Koios Configuration 
page.

NOTE: The Koios DS Configuration page will only appear if the 
option activation code is present. If there is no option 
activation code, the Koios tab will not display.

2. Type in the IP address of the Koios DS Server. 

3. Select Activate 

Figure 10-34. Activate Koios DS

4. You will receive notification upon successfully connecting to 
the Koios DS Server (The activation was successful. Your 
system is connected to Koios DS). Confirm (Save 
Changes? --> Ok) that you want to save the changes on this 
Configuration page. 

5. Confirm that the connection was successful by pinging the 
Koios DS Server via the Utility--> Connectivity--> Device 
page. 

Figure 10-35. Ping the Koios DS Server
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Activate Koios DS  (continued)

6. Confirm that the Koios DS Assessment service is running by 
pinging the “Koios Assessment” service via the Utility--> 
Connectivity--> Service page. 

Figure 10-36. Ping the Koios DS Assessment Service

Deactivate Koios DS

1. Access the Utility--> Connectivity--> Koios Configuration 
page. 

2. Select Deactivate.

Configuration

Table 10-118:  Koios DS Breast

Parameter Description

Lesion Classification 

System

Select BI-RADS or U1-U5.

Include Result in DICOM 

SR

Select to save Koios Breast results to Structured Reporting.

Table 10-119:  Koios DS Breast - Results Dialog

Parameter Description

Show Classification Name Select to show classification name.

Show Banner in Color Select to show banner in color.
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Table 10-120:  Koios DS Breast - Assessment Menu

Parameter Description

Show Classification Name Select to show classification name.

Show Banner in Color Select to show banner in color.

Table 10-121:  Koios DS Breast - Summary

Parameter Description

Show Classification Name Select to show classification name.

Show Banner in Color Select to show banner in color.

Table 10-122:  Koios DS Thyroid - Results Dialog

Parameter Description

Show Classification Name Select to show classification name.

Show Banner in Color Select to show banner in color.

Show Recommendation Select to show recommendation.

Table 10-123:  Accept Key

Parameter Description

Display Key Select to display this key in the Results dialog.

Save Image for Off 

Scanner Koios Analysis 

Select to save the image sent to Koios in the exam for off scanner analysis. 

Save Descriptors to Exam Select to save Descriptors from Koios Analysis to the exam.

Save Koios Analysis to 

Exam 

Select to save Koios Analysis result to the exam.

Table 10-124:  Review Key

Parameter Description

Display Key Select to display this key in the Results dialog.

Save Image for Off 

Scanner Koios Analysis 

Select to save the image sent to Koios in the exam for off scanner analysis. 

Save Descriptors to Exam Select to save Descriptors from Koios Analysis to the exam.

Save Koios Analysis to 

Exam 

Select to save Koios Analysis result to the exam.
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Measure

Please refer to Chapter 7, General Measurements and 
Calculations for more information on setting up Measurement 
and Analysis Presets. 
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Reports

Refer to Chapter 13 for more information. 
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System Administration

Overview

The Admin screen has the following sections:

• System Administration – lists all the options implemented 
in the system.

• Users – allows you to define user IDs, specify operator’s 
registration, operator’s rights, registration of staff related to 
an examination (for example, referral doctors and 
sonographers) and password update requirements.

• Logon – defines logon procedures, allows the System 
Administrator to set password policies, and LDAP 
Configuration.

• Groups – The System Administrator can set up user groups 
on this page. 

• System Password – Password for the Application Windows 
Logon Account.  

• Disk Encryption -– The System Administrator can encrypt 
the disk for highest system security, if required. 

• Audit Report – Generates an audit report. 

• Vulnerability Scan Mode – Part of the Advanced Security 
Option. Vulnerability Scan Mode configures the system so 
that an external scanner can analyze the LOGIQ Fortis. 

NOTE: Only the System Administrator can access the pages.
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Administrator Tasks

Here are the tasks typically performed by the LOGIQ Fortis 
System Administrator. Instructions for each of these tasks can 
be found in this chapter.  

• Privacy and Security Configuration options

• Define connection options for LDAP Directory Server

• Control encryption of the Patient Data drive

• Create Users/Groups

• Change rights for Users/Groups

• Change Encryption status for the system

• Change/Add Encryption Passwords

• Save/Print Recovery keys for encrypted drives

• Configure Password Policies

• Configure Session Policies

• Vulnerability Scan Mode

• Generate Audit Reports

• Configure Remote Logging Servers

Privacy and Security

Privacy protects both personal and private interests and 
information of persons. Security protects both system and 
information from risks to confidentiality, integrity, and availability. 
The LOGIQ Fortis Privacy and Security capabilities are 
discussed in Chapter 12; Privacy and Security configuration is 
discussed below, followed by a description of each system 
administrative page. 
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Creating Password Policies and User Groups

The foundation of setting up effective privacy and security is 
controlling user groups, users, and their system permissions. 

Enabling Password Policies

Check the “Enable Password Policies” box on the Utility-> 
Admin-> LOGON page. 

In addition, set the password policy for each selection. These 
policies should be set BEFORE creating new users. Save the 
changes and reboot the system. This applies rules for the 
passwords. 

Figure 10-37. Enable Password Policies

HINTS Ensure the ADM password is known BEFORE rebooting the 
system. 
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Groups

You define Group access rights via the Utility-> Admin-> Groups 
page. When each user logs in, they will have access to the 
system according to the rights assigned to their group(s). 
Default system groups are preset with pre-determined access 
rights. To view these access rights, highlight a group name in the 
Group List column on the left, then look in the Groups Rights 
column to see the permissions by group. 

 Figure 10-38. Groups Page

HINTS Admin has full access rights. 
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Adding users

You define Group access rights via the Utility-> Admin-> Users 
page. 

Figure 10-39. Page to Add Users

Creating a user

1. Press Add.

2. Type the user ID.  

3. Type the user’s information in the Identity section, ensuring 
that you are using the defined policies. User IDs are 
enforced as all uppercase letters for local users. 

NOTE: If a password is created, the user will be required to enter 
the password when logging on, even if Password Policies is 
not enabled. Remember, passwords are case-sensitive. 

4. Select the user’s group(s). Multiple groups can be selected, 
if needed. 

HINTS ENSURE that you DO NOT include the following characters in 
a user’s ID: slash (/), dash (-), asterisk (*), question mark (?), 
an underscore (_), ampersand (&), or blank spaces. 
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Creating a user  (continued)

5. If the user needs full configuration and advanced operations 
access, select Admin.

6. Press Save. 

NOTE: DO NOT add users with the same User ID. The system allows 
you to do this; however, the first user is erased and only the 
second user remains.

NOTE: When adding a new user, press Add first. Then edit the ID from 
the default of “NewUser” and edit the other fields. DO NOT 
press Add again unless you actually want to create another 
user. Press Save after adding one or more users. The user 
listed as NewUser on the list will be updated with the edited ID 
when you re-enter this screen.

User Login

After the system administrator adds a new user, the new user 
should login with their new user name and password. If 
designated by the system administrator, they may be required to 
change their password. 

The user will be prompted for their password when logging into 
the system or when selecting their user name from the Patient 
menu as well. 

After logging in, the user will have access according to the rights 
available to them within their assigned group(s). 

Changing a user configuration

The system administrator can update a user. The system 
administrator can also specify whether the user’s account is 
“Active,” “Blocked,” or requires a password change. If needed, 
select the check box, “User must change password.” Then the 
user will be prompted to change their password the next time 
they log into the LOGIQ Fortis. 

1. Move the Trackball to a user ID in the User List.

2. Make the desired changes.
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Deleting a user

The system administrator can delete a user. 

1. Move the Trackball to a user ID in the User List.

2. Select Remove. This marks the account as inactive. 

The user is removed from the User List.

3. Select Remove again. 

NOTE: Accounts are not removed immediately because User data is 
retained for auditing purposes. This can be useful because their 
name will still appear in audit reports. Also, they can be 
reactivated. 

If you permanently remove the user, by selecting "Remove" on 
an inactive user, this traceability will be lost.  

User Accounts and Password Policies Frequently Asked Questions

Here are answers to some frequently-asked questions: 

Q I lost or forgot my password. 
A System Admin can change your password. 

Q I entered the wrong password multiple times and now the 
system says I am locked out. 
A Wait until you are unlocked, enter the correct password. If you 
have forgotten your password, the System Admin can access 
the system and user details. Utility>Admin>Users 

Q I am locked out after multiple attempts to remember my 
password, does the System Admin have to wait until my account 
is unlocked before accessing the system?
A The System Admin can logon with their own logon information 
before the users blocked time is over. The box “Block user 
account” Utility>Admin>User, should be unchecked to allow the 
user to logon.   

Q I have created a list of users on one u/s system, I have three 
more in the department, can I do a backup to disk and restore 
the user list onto the other systems? 
A Yes, you can copy both User and Password. 
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User Accounts and Password Policies Frequently Asked Questions  

(continued)

Q I have a sonographer who left the facility, how do I delete this 
user? 
A The System Admin can deactivate or delete a user. 
Utility>Admin>Logon. Select the user and press “remove”

Q I have a sonographer who is on medical leave for a few 
weeks. I do not want to remove their user logon but I want to 
make sure they cannot access the system while not working. 
A The System Admin can block a user account. 
Utility>Admin>Logon, select the user and check “Block user 
account,” or deselect "active user account." 

Q We have information that a weekend users password may 
have been compromised, I need to ask the user to change their 
password the next time they logon.
A The System Admin can require the user to change their 
password. Utility>Admin>Logon, select the user and check 
“Require password change”

Q I have created a new user for a new sonographer, how do I 
assign the correct group?
A When a new user is added to the list, the groups list is located 
on the right column of the screen. Assign the user to a group or 
multiple groups with the appropriate access rights.    

Q Can I change the access rights for a pre-defined group?
A Currently this is not supported. You can select multiple groups 
from the factory default list for any user that needs additional 
access but not full admin rights; or create your own groups with 
desired rights. 

Q The default “ADM” user account does not have a password, 
can I create a password for this account?
A Yes, you can create a password for the default ADM. Be sure 
to write this down for anyone who will need access to the 
system, such as GE Service. 
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User Accounts and Password Policies Frequently Asked Questions  

(continued)

Q I was the last user on the system, the screen has gone black, 
do I need to logon again?
A Yes, once the Screen Lock time has been reached touch any 
button or the trackball on the operator panel to display the logon 
screen. Logon with your current credentials.   

Q Can I use the Auto Logon feature? 
A Yes, the Auto logon if checked will logon with the last user if 
the “Use password policies” is unchecked and the user has 
blank password. If the user is not assigned a password they will 
be logged on with no other entry required. If the user is assigned 
a password the logon window will pop-up requiring the password 
to be entered. 

Locking the Screen and Logon

You define Automatically Lock Screen via the Utility-> Admin-> 
Logon page by checking the Enable Session Timeout (Lock 
Screen) box. Then go to the bottom of the column to designate 
after how many minutes the screen should be locked (Session 
Lock Screen Timeout (min)). 

Figure 10-40. Enable Lock Screen

The screen will lock after the designated time. During this time, 
the system will be completely black. To reactivate the system, 
the user will need to logon again. 

NOTE: If “use password policies” is unchecked and no password is set 
to the user, and when Auto Logon is checked, the system will 
start by using the ID of the last operator. If Admin is used as the 
operator, assure that all characters are removed from the 
password field. 

To lock the screen, 

• Type [Alt+L]. 
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System Admin

The System Admin screen has information about any options 
implemented for the system.

Figure 10-41. Administrative System Admin Preset Menu 

Table 10-125:  Product

Preset Parameter Description

Product The name of the product.

HW Number The hardware number of the product.

Table 10-126:  Software Option Key

Preset Parameter Description

Enter New Option Key Type the key for the option you wish to add and press Add. 

Note: The Option Key may contain alphanumeric characters (2-9, A-H, J-N, 

P-Z) and special characters ("?", "%" and "&"). 

Installed Option Keys Lists the key for the installed options. 

Add Press to add a software option key. 

Remove To remove a software option key, select the key in the SW Option Key list, 

and then select Remove.

Import Used to import option strings stored on media (USB or DVD) or in the system 

(OptionKeys.txt may be stored at d:\service).  When you press Import, a 

dialog box comes up that allows you to select from the following locations: 

USB drive, DVD drive, and d:\service.  
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If your site decides to deactivate the InSite ExC Agent, then 
Remote Connectivity is no longer available on the LOGIQ Fortis. 
This also means that Remote Service can no longer connect to 
the LOGIQ Fortis via Disruptive Mode to diagnose system 
issues.  and the “Service” section will be removed from this 
Utility page. In addition, you will not be able to initiate a Request 
for Service or Clinical Support Request via the “GE InSite ExC” 
icon control located at the bottom of the Monitor Display.

 Figure 10-42. Remote Connectivity Deactivated; Service Fields Removed

Table 10-127:  Service

Preset Parameter Description

Enable Automatic Request 

for Service

Check this box to enable the system to send system-generated requests for 

service, without your intervention. 

Transfer Machine Logs to 

GE

Allows transfer of monitoring errors and status logs to GE back office for data 

analytics.

Transfer Operator 

Information to GE

Allows transfer of operator information to GE back office for usage analytics. 

Enable Automatic Probe 

Diagnostics

Enable Automatic Probe Diagnostics to run and save data to log file for 

transfer to GE backoffice for analysis.

Transfer Images (captured 

without patient information) 

to GE

Allows transfer of images for analysis. 

Include Annotation with 

Image transfer to GE

Usage Analysis: Allows transfer of operator information to GE back office for 

usage analytics. 
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Table 10-128:  Protecting Health Information (PHI)

Preset Parameter Description

Prevent Writing to 

Removable Media CD/

DVD/USB (requires 

reboot)

Check this box to prevent users from copying/saving information to 

removable media. 

Table 10-129:  USB External Media

Preset Parameter Description

USB External Media 

disabled (requires reboot)

By Checking this box you 

will disconnect all external 

USB Mass Storage 

devices

Select to disable any USB media from connecting to the LOGIQ Fortis. 

Please remember to enable this feature to reload software or to install 

the eIFU USB Media. 

Table 10-130:  Rights

Preset Parameter Description

Require Admin Operator 

Rights to Save Imaging 

Settings

Check this box to require the User to have Administrative rights in order to 

save image settings.  

Table 10-131:  Option Status

Preset Parameter Description

Options A list of the option name and status.

Status Lists each option’s effectivity. 
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Users

The Users screen allows you to define user IDs. It also allows 
you to specify operators registration, operator’s rights setting, 
and registration of staff related to an examination (for example, 
referring and interpreting physicians).

Figure 10-43. Users Preset Menu

Table 10-132:  User List 

Preset Parameter Description

User List Lists the user ID for all system users. 

Identity Type the operator’s user ID, Password, Prefix, Last Name, First Name, Middle 

Name, Suffix, Phone Number. 

User Controls The System Administrator can specify whether a user’s account is active, 

blocked, or requires a password update.  

Group Membership Select the user’s group: Operator (sonographers, doctors, or any person using 

the ultrasound system); Ref.Phys. (referring physician can be associated to the 

patient examination in the extended Patient information window); Perf.Phys. – 

physician performing the exam can be associated to the patient examination in 

the extended Patient information window. 

Note, other groups may exist as set up by the System Administrator. 
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Logon

The Logon section defines log on procedures.

Figure 10-44. Administrative Logon Preset Menu

Table 10-133:  Logon 

Preset Parameter Description

Auto Logon Specifies logon procedures:

• Use Auto Logon

• When selected, the system is started automatically, using the last user 

logon.

• When blank, the user must select a user ID and enter a password when 

logging on.

Note: Auto LOGON only works when password policies are disabled and if 

there is no password assigned to the user. 

• Allow Auto Logon for Admin users: The system is started automatically 

when logging in as an ADM user. 

• Allow Emergency User: The system will allow the EUSR user for emergency 

use. 

Common Network Login Specifies the user ID and password used to access the network.

• User – User ID for network access

• Password – Password for network access

Connectivity Maintenance Reset to factory default.  

LDAP Configuration Refer to the next section for LDAP instructions. 
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Security Baseline Choose Security Baseline. Select a baseline set of security policies for 

password and session management. For example: 

Lowest (default): 

Autologon available. No password complexity rules. 

Medium: 

Autologon unavailable. Passwords must meet the following criteria: 

• Minimum password length of 8. 

• Minimum of 2 character sets. 

• Password should not contain username. 

• Password should not be any of the last 10 passwords. 

High:

Autologon unavailable. Passwords must meet the following criteria: 

• Minimum password length of 10. 

• Minimum of 4 character sets. 

• Minimum of 1 lower case characters. 

• Minimum of 1 upper case characters. 

• Minimum of 1 special characters. 

• Minimum of 1 digits. 

• Password should not contain username. 

• Password should not be any of the last 15 passwords. 

Highest: 

Autologon unavailable. Passwords must meet the following criteria: 

• Minimum password length of 14. 

• Minimum of 4 character sets. 

• Minimum of 1 lower case characters. 

• Minimum of 1 upper case characters. 

• Minimum of 1 special characters. 

• Minimum of 1 digits. 

• Password should not contain username. 

• Password should not be any of the last 25 passwords. 

Reset Security Baseline: Clears the stored value for customer-selected 

security baseline. This forces the dialog which allows you to choose a 

baseline to be presented at the next Admin logon. 

Table 10-134:  Policies 

Preset Parameter Description

Enable Password Policies Specify whether to enable establishing policies for acceptable passwords, 

This specifies Password requirements such as # of letters, numbers, 

symbols, etc. 

Enable Session Timeout 

(Lock Screen)

2-step logout: 

1. System will display a lock screen after a set amount of time (configurable 

below under “session Lock Screen Timeout”). 

2. System attempts to logout the user if "Automatic Logoff" is enabled and 

the timeout for it is reached or another user logs in instead.  

Enable Session Timeout 

(Automatic Logoff)

This logs out a user automatically after a set amount of time. 

Require Logon At Startup Select to require logon with password at startup.

Table 10-133:  Logon  (Continued)

Preset Parameter Description
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Table 10-135:  User Name Policies

Preset Parameter Description

Display Login User List Check this box to display a list of Users. 

Table 10-136:  Password Policies

Preset Parameter Description

Password cannot contain 

username

Password policy stating that the password cannot contain the user's name. 

Minimum Password Length Password policy for password minimum length.

Minimum Number of 

Character Sets

Password policy for minimum number of characters types (Upper-Case, 

Lower-Case, Digits, Symbols). 

Minimum Number of Upper 

Case Letters

Password policy for minimum number of upper-case letters allowed (A, B, C, 

etc.)

Minimum Number of Lower 

Case Letters

Password policy for minimum allowed for number of lower-case letters (a, b, 

c, etc.)

Minimum Number of Digits Password policy for minimum number of numbers (1, 2, 3, etc). 

Minimum Number of 

Symbols (~#$% etc.)

Password policy for minimum number of symbols allowed (#, @, etc.).

Minimum Password Age 

(hours)

Password policy for the minimum age for a password, in hours. 

Maximum Password Age 

(days)

Password policy for the maximum age for a password, in days.

Minimum Changes 

Between Passwords

Password policy for the minimum number of changes between passwords. 

Maximum Number Of 

Repeated Characters

Password policy for the maximum number of repeated password characters. 

Maximum Number Of 

Sequential Characters

Password policy for the maximum number of sequential password 

characters.

Password Reuse History 

Count

Password policy -- users can't reuse old password -- # of old passwords it 

stores so you can't reuse it

Failed Logins Before 

Account Blocked

Password policy for the number of failed attempts to login that are allowed. 

Do Not Allow Common 

Passwords

Select to disallow commonly used passwords. 

Account Block Time (min) There's a policy which will block an account for a certain amount of time after 

a certain number of failed logins -- you can set how long that time is

Session Lock Screen 

Timeout (min)

Password policy for the time, in minutes, before the system will lock the 

screen. 
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Logon Banner

The Power On Logon Banner displays the text at power-on and 
requires user confirmation to complete booting the system. This 
is user-configurable.

Updating the Logon Banner Page

You can change the text that displays when the user logs onto 
the LOGIQ Fortis via the Utility-> Admin-> Login screen. 

There are three login screens that can be used: 

• GE Default Login Screen

• Department of Defense (DoD) Default Login Screen

• User-customized Login Screen

Figure 10-45. GE Default Login Window

Session Auto Logoff 

Timeout (min)

Password policy for the time, in minutes, before the system will automatically 

log a user off the system. 

Table 10-136:  Password Policies

Preset Parameter Description
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Updating the Logon Banner Page  (continued)

To configure a customer-specific Login Banner page, 

1. Access the Utility-> Admin-> Login screen. 

Update the Logon Banner portion of this screen: 

2. Type the Title into Logon Title Text. 

3. Type the text into Logon Disclaimer Text. 

4. Press Save. 
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Updating the Logon Banner Page  (continued)

To set the GE Default as the Login window, press Load GE 
Default. Then press OK-> Save. 

Figure 10-46. Default GE Logon Banner

To set the DoD Default as the Login window, press Load DoD 
Default. Then press OK-> Save.

Figure 10-47. Department of Defense Logon Banner
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Enabling the Power On Logon Banner

To ensure the Power On Logon Banner displays and requires 
user confirmation to complete booting the system,

Figure 10-48. Power On Logon Banner

1. Access the Utility-> Admin-> Login screen.

2. Checkmark Enable Power On Logon Banner. 

3. Press Save and Exit.
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Adding a Logon Logo

The system default logo on the LOGIQ Fortis is the GE Logo. To 
add your own Logo,

1. Insert the USB Flash Drive with the Logo into a USB port on 
the LOGIQ Fortis.

Specifications: The ‘Logo’ image should be a bitmap image 
(.BMP) format ONLY, with a size of 128x128.

2. Navigate to the Utility-> Admin-> Login screen. 

3. Select Browse Logo. A pop-up window appears for you to 
navigate to the USB Flash Drive and Logo you want to add. 

4. Select the Logo. Select OK. Then Save. 

Adding a “Lock Screen” Image

You can add a custom lock-screen image. 

Specifications: The ‘Lock Screen’ image should be a bitmap 
image (.BMP) format ONLY, with a size of 1920x1080.

NOTE: Please select a screen that does not have high contrast or bright 
colors. 

To add a ‘Lock Screen’ image, 

1. Insert the USB Flash Drive with the image into a USB port 
on the LOGIQ Fortis. 

2. Navigate to the Utility-> Admin-> Login screen. 

3. Select Lock Screen Image. A pop-up window appears for 
you to navigate to the USB Flash Drive and image you want 
to add. 

4. Select the image. Select OK. Then Save. 
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LDAP Configuration

To enable LDAP authentication, check the “Enable LDAP 
authentication” box at the top of the LDAP Configuration page. 

Figure 10-49. LDAP Configuration

Table 10-137:  Connection Configuration

Preset Parameter Description

Enable LDAP 

authentication

The administrator can select to enable system credentials using LDAP

Connection Configuration: 

Directory Server URL for the Directory Server

Port Port for the Directory Server

SSL SSL (Secure Sockets Layer) -- Select to enable LDAPs (LDAP over SSL).

Lookup... Button that opens up a Query pop-up for groups, domain, LDAP server, etc. 

Domain Domain name for LDAP server (if needed). 

Connect... Select to connect to server as...

DN for users Distinguished Name for users. 

The LDAP API references an LDAP object by its distinguished name (DN). A 

DN is a sequence of relative distinguished names (RDN) connected by 

commas.

... Select to open a list of DNs supported by the server. 

User caching: 

Enable caching The administrator can select to allow the user to cache their password 

credentials. 
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Lookup LDAP Servers

To look up LDAP Servers, select “Lookup” from the LDAP 
Configuration menu. Select the Domain from the pull-down 
menu, then select the LDAP Server from the list and press OK. 

Logging on to the LDAP Server

To logon to the LDAP server, type your User Name and 
Password, then press OK. 

Cleaning Up the Cache of Credentials

To clean up (empty) the cache of credentials, type your User 
Name and Password, then press OK. 

Remember user ____ days This field specifies the number of days to remember the user for caching 

purposes. 

Cleanup cache The user can cache credentials. When they select this, it clears out the cache 

of credentials. 

Field mapping: 

Field mapping The mapping between attributes on the Ultrasound system and LDAP 

attributes. This allows you (for instance) to select which of several phone 

numbers that may be stored in your AD server are mapped to the Phone 

Number field of a user on the system or to refrain from mapping any AD 

element to that field.  

Group mapping: 

Group mapping Maps an LDAP group to a local group on the machine. 

Selection buttons on bottom of screen: 

Reset field mapping Resets field mapping to the factory defaults

Advanced config... Entries in this menu should only be changed by experienced network 

administrators. 

Certificates... Server Certificate

Reload settings Reloads LDAP settings. 

Return to Admin Press to go back to the Utility--> Admin configuration screens. 

Table 10-137:  Connection Configuration (Continued)

Preset Parameter Description
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Certificate Management

The Certificate Manager displays the system’s Intermediate and 
Trusted Root Certification Authorities, as noted on the 
Certificate Manager’s Tabs (Intermediate Certification 
Authorities and Trusted Root Certification Authorities). You can 
import or remove certificates.  

Figure 10-50. Certificate manager

Select the appropriate Certification Authority, then press “Import” 
to import Certificates or press “Remove” to remove Certificates. 

Figure 10-51. Certificate Import Dialog
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Advanced LDAP Configuration

Advanced LDAP Configuration Settings can be set on the 
Advanced LDAP Configuration menu. 

Figure 10-52. Advanced LDAP Configuration

Table 10-138:  Advanced LDAP Configuration

Preset Parameter Description

Default naming context 

attribute

Attribute name for the naming context.  

User search filter Search for the user using a keyword

Account name attribute Attribute name for LDAP Attribute to be used as Account/User Name 

Group search filter Search for the group using a keyword

Group name attribute Attribute name for the LDAP group. 

Member Of attribute Attribute name for the "Member Of". 

Search timeout(s) Limits the time to perform a search

Search page size (objects) Limits the number of search results

Two step authentication Under LDAP there's a option for a secondary authentication so you give it a 

user name and password to login to the LDAP server. (Advanced 

Configuration)

Enabled Check this box to enable two-step authentication. 

User distinguished name The user's distinguished name.  
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User password The user’s password. 

Load default settings The user can select to load system default settings.

Table 10-138:  Advanced LDAP Configuration (Continued)

Preset Parameter Description
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Groups

System rights are set by the Administrator. If you do not have 
rights to a feature/function, please contact the Administrator. If 
access is denied, a message in red will appear in the status line 
(such as “You do not have the required permission to perform...” 
or a dialog will be displayed with more information. In some 
cases, buttons or sections of the screen may simply be disabled 
if you do not have appropriate rights. 

 Figure 10-53. Groups Configuration

Table 10-139:  Group List 

Preset Parameter Description

Add This creates a new group. 

Default Groups BioMed, DiagPhys, Emergency User, Lead Sonographer, Operator, 

Physician, RefDoc, Sonographer, and SysAdmin. 

SysAdmin All Group Rights

BioMed All Group Rights, except Admin. Can edit Imaging/Connectivity Utility pages. 

Can change the system time and date. Can access the Service Desktop. 

Cannot edit Admin Utility pages. 

Lead Sonographer Login, Create/Update/Delete/Transfer/Export Patient Data, Basic/Imaging 

Configuration, Authorize Remote Service Access, and Capture Logs. Can 

edit Imaging Utility pages. Cannot edit Connectivity or Admin Utility pages 

and cannot change the system time and date. 

Sonographer Login, Create/Update/Transfer/Export Patient Data, Basic Configuration, 

Authorize Remote Service Access, and Capture Logs
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Physician Login, Create/Update/Delete/Transfer/Export Patient Data, Basic/Imaging 

Configuration, Authorize Remote Service Access, and Capture Logs

Emergency User Login, Create/Transfer Patient Data. Only access to the Utility System and 

Search Tabs. 

Table 10-140:  Name and Description

Preset Parameter Description

Id The Id, from the Group List. 

Description A description of the Group List Id. 

Table 10-141:  Group Rights

Preset Parameter Description

Rights assigned to each 

Group, by default

Login Allows users in this group to logon to the system.   

Admin Allows users in this group to have system administrator’s rights. Can add/

remove users and enable/disable encryption, etc.  

Create Patient Data Allows users in this group to create patient and exam data. This right is 

needed to register a patient and start an exam. Access to the following 

controls is prohibited without this right: New Patient, Register, and Save and 

Exit.   

Update Patient Data Allows users in this group to change patient and exam data. This right is 

needed to view patient and exam information stored in the patient database. 

Access to the following is prohibited without this right: Patient List, Exam List, 

Data Transfer screen, ability to delete images from the clipboard or active 

images screen, ability to delete reports from the Reports screen, ability to 

change to the USB/CD Read Only workflow, ability to see all the jobs (except 

one’s own) in the Spooler. 

Table 10-139:  Group List  (Continued)

Preset Parameter Description
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To set up a new group, 

1. Select the Group. 

2. Assign the Rights you wish this Group to have. 

Delete Patient Data Allows users in this group to delete patient and exam data. This right is 

needed to use the Delete button on the Patient List and Exam List. Access to 

the following is prohibited without this right: Patient delete via Patient 

Registration and Patient List. 

Transfer Patient Data Allows users to transfer patient and exam data over DICOM. This right is 

needed for DICOM transfers over the network configured for Print keys and 

with Workflows. Access to the following is prohibited without this right: 

DICOM Image Storage, DICOM SR Storage, DICOM MPPS, DICOM Storage 

Commitment, and DICOM Print; Print button and Workflow; Koios DS in TCS; 

and Sent To from Patient Registration and Active Image Patient screens. 

Export Patient Data Allows users to export patient and exam data to media. This right is needed 

to Export, Save As, USB quick Save to media and for print functionalities. 

Access to the following is prohibited without this right: Executing a Save As, 

USB Quick Store, or Video Capture via a configured Print key, EZBackup, 

Printing or Saving a Report As, Print the Patient List; in TCS Standard Print 

Button, and Save As Images controls, Data Transfer screen functionality to 

perform an Export or MPEGvue export. 

Import Patient Data Allows users to import patient and exam data from media. This right is 

needed to import from media, Worklist download, or to use the Query/

Retrieve feature. 

Basic Configuration Allows access to and modification of basic Utility pages, which everyone has 

access to, except members of the Emergency User’s Group. 

Imaging Configuration Allows modification of imaging preset Utility pages.

Note, If the “Require Admin Operator Rights to Save Imaging Settings” is 

checked on the Utility page, then the “Imaging Configuration” right can only 

be used by a SysAdmin.  

Advanced Configuration Allows access to and modification of advanced configuration pages. 

Device Mgmt Configuration Allows users in this group to activate and configure Device Mgmt Cloud 

configuration management tool. 

Authorize Remote Service 

Access

Allows users to authorize service engineers to connect to the system 

remotely and perform service tasks.   

Capture Logs Allows users in this group to capture and export a system log to monitor 

system performance.   

Capture Logs with PHI Allows users in this group to export log files with PHI included. 

Access Service Desktop Allows users in this group to access the Service Desktop. 

Software Management Allows users in this group to access Software Download. 

Table 10-141:  Group Rights (Continued)

Preset Parameter Description



System Administration

LOGIQ Fortis – Basic User Manual 10-133
5855997-1EN Rev. 3

System Password

The System Password is the Windows Password used by the 
LOGIQ Fortis to automatically log into Windows. Users of the 
system will never need to use this password. The only reason to 
change the password will be if the user, for security reasons, 
prefers to define their own password instead of using the 
factory-created default password. As with all passwords, this 
should be treated with care and archived appropriately so that it 
can be provided to service personnel if necessary. 

If you have changed the System Password, you must have the 
Current Password to change it. 

To change the System Password, 

1. Type your current password in the System Password field 

NOTE: There is no need to enter the “current password” to change 
the System Password if the System Password has not been 
previously changed from the factory default. The same is 
true for the Database Password. 

2. Type the new password in the New Password field. 

3. Type the new password again in the Confirm Password 
field. 

4. Press Save to save the new Password; then press Exit. 

NOTE: ‘Windows System password' is the password for the underlying 
Windows OS user running this application. Do not change this 
password unless you are the system administrator of the device. 
This password is not needed for users of the system. It will only 
be needed by GEHC service in special situations. If you change 
the password, be sure to keep the new password secured and 
available if needed by GEHC service. 



Customizing Your System

10-134 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Disk Encryption 

Disk Encryption is designed to protect data privacy and assist 
your organization with HIPAA/HITECH compliance. Safeguards 
include: 

• All patient data on the system’s patient archive drive can be 
encrypted to provide protection in the event of a stolen 
device or hard drive. 

WARNING If you’ve selected “Encryption ON. Key is stored on USB / 
password is entered manually” encryption and both password 
and recovery key are lost, you will not be able to access 
archived patient data (images and measurements included) nor 
store new patient data on this system.

The only way to recover the system to allow storing patient 
data is to reset the entire disk, which deletes all the archived 
patient data on the disk.

It is strongly recommended that all the patient data be stored in 
PACS or backed up to media prior to encrypting the disk.

In addition, it is recommended that the recovery key be stored 
on a USB storage device, printed, and kept in a secure 
location, ensuring that it will not be lost.

CAUTION Make sure the system power cable is plugged into external 
power. DO NOT attempt to perform the initial encryption 
function on battery power. 
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Disk Encryption  (continued)

The system encrypts patient data by default (Encryption On. 
Disks are unlocked automatically). 

1. If you wish to change the default encryption setting, select 
the desired Encryption Policy, then press Accept.  

Figure 10-54. Initialize System Encryption

NOTE: If you (or the Field Service Engineer) reloads system 
software, you will need to press “Initialize System 
Encryption” to encrypt the system and reset System 
Encryption password and preferences.
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Disk Encryption  (continued)

NOTE: If you choose to dismiss this dialog, you will be reminded to 
continue configuring encryption at each logon.   

Table 10-142:  Encryption Policy Selections 

Encryption Policy Description

Encryption OFF Patient Data will not be encrypted. Selecting “OFF” will unencrypt the drive. 

System drive and recovery partition will remain encrypted.  

Encryption ON. Disks are 

unlocked automatically

System Default. Patient data is encrypted and unlocked at system boot-up. 

Recovery Key and Password tied to the hard drive.  

Encryption On. Require 

Pre-Boot PIN/Password 

before unlocking system 

drives

The system will not boot until the Pre-Boot PIN or Password has been 

entered. Unlike other manual key entry configurations, no system 

functionality is available without the PIN/Password. This encryption policy 

is intended for high security environments or customers with specific 

needs.

Encryption ON. Key is stored 

on USB / password is entered 

manually

The system will request the encryption password or recovery key at system 

startup. The system is not accessible until this password or a disk recovery 

key is provided. Requiring a password to access the patient archive may 

prevent emergency usage of the system. 
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Disk Encryption  (continued)

2. You must set the Encryption Password and record the 
Recovery Key in order to ensure access to your institution’s 
patient data (required if replacing the system drive, ECB 
Board, or reformatting the C:\ Drive). 

a. To reset the Encryption Password, “Change password.” 

NOTE: Press NO if this question pop-up appears: "Password is 
already set on a disk. Do you want to reuse it? Press 
Yes to reuse existing password. Press No to delete 
existing password."

You can now update the encryption password, then 
press OK.  



Customizing Your System

10-138 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Disk Encryption  (continued)

3. Recovery Keys are not backed up by the system; you must 
record / archive the Recovery Key in order to retrieve patient 
data. 

You can Show or Hide the Encryption key. Store the 
Recovery Key in a secure location, accessible to the ADM 
user as necessary. 

a. Insert the USB flash drive into a USB port to save the 
recovery key.

NOTE: Use the USB flash drive as the repository only for the 
recovery key. DO NOT use it for data archiving or DVR 
recording.

Save recovery key to a USB Flash Drive by pressing 
Save recovery keys.

b. View the Recovery Key by pressing Show recovery 

key, then print it to a local printer or PACS. 

Press the Print key to print the recovery key on the 
local printer. 

c. Press Show recovery key to display the recovery key 
on the screen. 

Press Hide recovery key to hide the recovery key.

CAUTION Make sure to keep the password, recovery key, and any 
backup of these in a secure place, not accessible for any 
unintended audience.
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Change password

Press Change Password to change the password as 
necessary.

Change the recovery key

If you want to change the recovery key, select Change 

recovery key to generate a new key.

NOTE: Generating a new key causes the previous key to expire.

Disk Encryption Frequently Asked Questions

Here are answers to some frequently-asked questions: 

Q What type of encryption technology is used on my ultrasound 
system?
A The system uses Microsoft Bitlocker FDE configured to use 
FIPS-Compliant encryption protocols. 

Q The system was accidentally turned off or lost power during 
the disk encryption process.
A Restart the system, and then go to Utility>Admin>Disk 
Encryption, select “On”, …resume, the disk encryption will 
continue

Q The USB recovery key was accidentally formatted. How do I 
access the system? 
A If a password was created or the recovery key was written 
down, enter the information in the pop up window. Then go to 
Utility>Admin>Disc Encryption and Select Change recovery 

key. Be sure to print and save the new recovery key and store 
the USB in a secure location. 
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Disk Encryption Frequently Asked Questions  (continued)

Q Is it possible to stop encrypting the data?
A Utility>Admin>Disk encryption, select the “Off” radio button.  
The process to unencrypt may take up to 15 minutes.  

Q Is there a step I need to take every day to encrypt new data?
A No, the encryption will happen in the background without the 
need for any additional manual steps.  

Q The encryption was done it took nearly 90 minutes, is this 
going to happen every time the data is encrypted?
A No, after the initial encryption process is completed, new data 
will be encrypted automatically.

Q How does this protect the patient data? 
A The data is unreadable by anyone who attempts to use the 
system without entering the password or recovery key.  

Q I am using the system portable with Power Assistant, do I 
have to enter the password or recovery key after each exam?
A No, the password or recovery key will only need to be entered 
at each full boot up.  

Q I do not have Power Assistant but I take the system portable 
occasionally do I need to enter the recovery key or password 
each time?
A Yes, the recovery key or password must be entered each time 
the system is turned on. If the USB with Recovery key is 
connected with each start up you will not need to manually enter 
the password or recovery key.  
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Disk Encryption Frequently Asked Questions  (continued)

Q The USB recovery key has been lost, how do I unlock the 
system? 
A Manually enter the password or recovery key, then create a 
new USB key from the Disk Encryption page.  

Q The USB recovery key and the password has been lost how 
do I unlock the disk?
A Contact your service, the system will need a base image and 
application reload. Create a new encryption key. *Note the 
patient data on the system is not recoverable from this scenario.  
Always store patient data to a PACS or backup to external 
media. 

Q If it is not possible to unlock the data can I still scan and what 
cannot be used? 
A Yes: Unless the “Require Pre-Boot PIN/Password” Encryption 
policy option is selected, Live scan, measurement, “Save As” 
can be used to store on other media (USB, printer, etc). You can 
not access patient information, cannot access system Archive, 
cannot create an exam, cannot store to the hard drive, and 
DICOM Transfer is not possible. 
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Audit Report and System Log Server Configuration

Figure 10-55. Audit Report

Table 10-143:  Audit Report

Preset Parameter Description

Report Filter: Specify the following criteria. 

Search Type Select the type of search. 

Date Range Specify the “From” and “To” date range.  

Status Specify the status. 

Anonymize Indicate whether to anonymize the report (remote patient data). 

Generate Report Press to generate the report. 

Report Information: Generated report information. 

Report File Path The location where to place the generated report. 

Report Status Report status. 
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Audit Report and System Log Server Configuration  (continued)

The Audit Report System Log Server Configuration page allows 
you to customize where to draw information from for the Audit 
Report. 

You are also able to connect the LOGIQ Fortis to a centralized 
logging database at your institution to monitor for pattern 
analysis. This way, if your system is compromised, the data can 
be analyzed for incident response. 

This centralizes all the system’s data in the customer’s data 
center -- It’s like a DICOM connection page, but connects logs to 
a central location. 

Figure 10-56. System Log Server Configuration

Table 10-144:  System Log Server Configuration

Preset Parameter Description

Connection. 

IP Address of the Server The Server’s IP address

TCP Listener Port Transfer Control Protocol Listener Port. This is the port which we transfer 

logging data to use the syslog data protocol. It can be done by UDP or TCP, 

depending on the configuration of the customer logging server. 
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UDP Listener Port User Datagram Protocol Listener Port. This is the port which we transfer 

logging data to use the syslog data protocol. It can be done by UDP or TCP, 

depending on the configuration of the customer logging server.

Mode of Transfer Mode of transferring the data to the server (UDP, TCP, or TLS). 

Windows Event Log 

Type of Logs to transfer • Application Logs

• Security Logs

Source of application event 

log to transfer: (Add * for 

no filter)

• Add Source: The user needs to specify where to draw data from for the 

audit report. 

• Delete Source: Delete the event log source from the application. 

Transfer

Send Time Period (Sec): How often the system will attempt to contact the logging server to send logs.

Number of days of Historic 

data to send: 

If logging server connectivity has not been available, how many days of 

history should be sent when it is restored? 

EventLog Batch Send Size When sending historic data, how much to send in each transaction – this can 

help manage network traffic and server load, not typically necessary to 

change this. 

Table 10-144:  System Log Server Configuration

Preset Parameter Description
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Imaging Preset Manager

Overview

The Imaging Preset Manager allows you to: 

• Create and Edit User Presets

• Update User Presets

• Rename User Presets

• Delete User Presets

• Arrange presets on the Touch Panel

• Share User Presets across LOGIQ Fortis systems

• Export User Presets

• Import User Presets

• Configure MyPreset for probe

• Update MyPreset Config for each probe if desired. Need 
for each probe separately. See ‘Arranging MyPreset 
Tab’ on page 4-29 for more information. 

Creating a User-Defined Application Preset

To create a User-Defined Application Preset, 

1. From the Touch Panel, select the Probe icon at the top of 
the Touch Panel.  

2. Select the Application you want to use as a basis for the 
new Application Preset. 

You are now ready to create your own user preset. 
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Creating a User-Defined Application Preset  (continued)

3.  Press Save. A pop-up menu appears: The Create New 
Application menu appears.

Figure 10-57. Create New User Pop-up Menu

4. Select Create New. The Create New Application menu 
appears. 

NOTE: The new user application is based upon the current exam  
and application, plus any modifications you have made, 
including the comment library and M&A calcs. 

NOTE: The name of the new application cannot include spaces or 
symbols. However, the name can include numbers and 
letters. 

NOTE: There is no limit to the number of user-defined application 
presets you can create for each exam category; you do not 
need to map all created presets to the Touch Panel. 

After you select to create the new preset, the Imaging Preset 
Manager screen appears. The preset you just created now 
appears in the Available Imaging Presets column. You’ll notice 
that it has the name you assigned it (“GE”). 
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Arranging Presets on the Touch Panel

On this screen, you specify where you want the new user (and 
existing) presets to appear on the exam’s Touch Panel screen. 

 Figure 10-58. Steps to Add a User Preset

You can move the location of where the application appears on 
the Touch Panel via the Imaging Preset Manager (accessed 
from the Utility Touch Panel). 

To reposition an application on the Touch Panel grid,   

1. Select the Application to copy. Right click and select Create 
New. 

2. Provide the new name. 

3. The Imaging Preset Manager page appears (number not 
shown above). 

4. Position the new application to appear at the desired Touch 
Panel location. 

5. The new application appears on the Touch Panel. 
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Updating User Presets

You can edit, reset to factory default, or delete any user preset 
you create, as long as you have selected it in the “Available 
Imaging Presets” column on the left.

Editing Imaging Parameters

To view/edit the parameters for the user-defined preset,

1. Adjust the image while in the user preset you want to edit. 

2. Press the probe at the top of the Touch Panel screen. 

3. Press Save-->Overwrite [Preset Name]. 

4. From the Utility--> Imaging menus. 

To view/edit the parameters for the user defined preset

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to view/edit from Available Imaging Presets 
Column. 

2. Press Edit. The Imaging page appears. 

3. Edit the presets as necessary and press Save. 

or

1. Adjust the image while in the user preset you want to edit. 

2. Press the probe. 

3. Press Save-->Overwrite [Preset Name].

Renaming a User Preset

To rename a user preset, 

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to rename. 

2. Press Rename. The Rename Preset pop-up menu appears. 

3. Type the new name and press Rename. 
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Deleting a User Preset

To delete a user preset, 

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to delete. 

2. Press Delete. The Delete Preset pop-up menu appears. 

3. Confirm that you want to delete this user preset and press 
OK. 
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Sharing User Presets between LOGIQ Fortis Systems

You can share the user presets you have created between 
LOGIQ Fortis systems by exporting/importing the preset(s) you 
want to share.   

To move a user preset from one LOGIQ Fortis to another LOGIQ 
Fortis system (same software level), first export the user 
preset(s) you wish to share. 

Exporting User Presets

To export a user preset (or presets), 

1. Activate the Imaging Preset Manager from the Utility Touch 
Panel. 

2. Insert the media. 

3. Press Export (on the bottom). 

4. An Export Presets pop-up menu appears that indicates: 

a. destination location (USB Flash Drive/Hard Disk Drive 
drive location). 

b. preset directory where the preset should be saved 
(Preset Export). 

c. available presets on the scanner. 

Select the name for the Preset Directory from the Preset 
Directory pull-down. 

5. Select the User Defined Presets under Available presets on 
Scanner and press Export. 

6. Upon a successful Export, an informational message will 
pop-up indicating that “1 preset successfully exported.” 
Press Ok. Then press Exit to close the Export Presets 
pop-up menu. 

7. Press F3 to Eject the media. Take the media to the other 
LOGIQ Fortis and follow the Importing User Presets 
instructions below. 
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Importing User Presets

To import a User Preset, 

1. Activate the Imaging Preset Manager from the Utility Touch 
Panel. 

2. Insert the media (Flash Drive, USB Hard Drive). 

3. Press Import. The Import Presets pop-up appears and 
displays the Source Directory and Available Imaging 
Presets.    

4. Select the “User Defined Presets” under Available Imaging 
Presets and press Import. 

If these presets are already on this LOGIQ Fortis, you will be 
asked whether you want to: 

• Overwrite this preset (Yes, Yes to All, No, or No to All). 

• Rename this preset (Type the new name and press 
Rename). 

• Cancel

5. Upon a successful Import, an informational message will 
pop-up indicating that “1 preset successfully imported.” 
Press Ok. Then press Exit to close the Import Presets 
pop-up menu. 

6. Press F3 to Eject the media. 

Retain Field of View

Selecting Retain Field of View ensures that the Imaging 
Parameters shown in the table below stay constant over Probe 
and Preset changes.

Table 10-145:  Retain Field of View

Mode Probe Retain Field of View Imaging Parameters

B-Mode, Harmonics, 

Contrast and B-Flow

Convex and Sector Depth, Tilt, Zoom, Width

Linear Virtual Convex, Zoom, Depth, Steer

Color Flow Mode Convex and Sector ROI Size/Position

Linear ROI Size/Position, CF Virtual Convex, CF Steer

Doppler Mode Doppler Cursor Position



Customizing Your System

10-152 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Backup and Restore

Overview

The Backup/Restore function enables the user to copy and 
restore system presets, settings and service configurations, and 
enables the user to configure several units with identical 
configurations (providing the units have the same software 
version).

Depending on the system, you can use either a CD-R, DVD-R, 
USB Flash Drive, or USB Hard Disk for system backup/restore. 
For the sake of simplicity, we have used the CD-R in the 
following examples. 

NOTE: The system ONLY supports CD-R / DVD-R and DOES NOT 
support CD-RW / DVD+R. 

To minimize accidental loss of data, backup system presets, 
settings and service configurations, DAILY to formatted media 
and/or to the local hard drive (manually or automatically). 
Presets and service configurations can be restored to the local 
hard drive using the restore procedure.

NOTE: To perform backup and restore procedures, you must login with 
administrator privileges.
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Backup 

Media Backup

1. Insert media into the drive or USB device into a USB port.

2. On the Touch Panel, press Utility.

3. On the Utility Touch Panel, press System.

4. On the monitor display, select Backup/Restore.

The Backup/Restore screen is displayed.

 Figure 10-59. System/Backup/Restore Preset Menu

5. In the Backup field, select User Defined Configuration and/
or Service to copy system presets, settings and service 
configurations.

6. Select CD/DVD or USB Drive F to save data in the Backup 
To/Restore From field.
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Media Backup  (continued)

7. Select Backup.

The system performs the backup. As it proceeds, status 
information is displayed on the Backup/Restore screen.

8. At the end of the process, the Backup completed message 
is displayed on the monitor.

Press Eject (F3) to eject media/disconnect USB device.

9. Make sure to physically label the media. An identification of 
the system should also be noted on the media and a backup 
log should be kept.

Store the media in a safe place.

Local Backup

Select Backup Automatically under Local Backup to 
automatically backup User Defined configurations to the system 
hard drive when the configuration is changed and saved. 

Select Manual Backup to manually backup User Defined 
configurations to the system hard drive. 

Backup Automatically

1. Check Backup Automatically under Local and Cloud 
Backup.

2. Select Local Backup under Backup To/Restore From.

3. Press Save.

User Defined Configuration files are automatically backed 
up to Local Backup, when configuration is changed and then 
saved.

Manual Backup

1. Select Local Backup under Backup To/Restore From.

2. Press Backup under Backup.
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Restore from Media or Local Backup

1. On the Touch Panel, press Utility.

2. On the Utility Touch Panel, press System.

3. On the monitor display, select Backup/Restore.

The Backup/Restore screen displays. (See Figure 10-59 on 
page 10-153.)

4. In the Restore list, select User Defined Configuration and/or 
Service to restore system presets, settings and/or service 
configurations. 

5. If restoring from Media: Ensure the appropriate source 
device is selected in the Media field and select Restore 

from Media.   

If restoring from Local Backup: Select Restore from 

Local Backup. 

The system performs the restore. As it proceeds, status 
information displays on the Backup/Restore screen.

6. The LOGIQ Fortis restarts automatically when Restore is 
done. 

Preset Synchronization Using Media

The procedure for preset synchronization of several scanners 
using media is as follows:

1. Make a backup of the user-defined configurations on a 
removable media from a fully configured LOGIQ Fortis 
system.

2. Restore user-defined configurations from the removable 
media to another LOGIQ Fortis system (you can restore all 
the user-defined presets or select specific presets to restore 
via Detailed Restore).

NOTE: For information on Device Mgmt cloud-based system preset 
configuration management see ‘Device Mgmt’ on page 13-498.

WARNING The restore procedure overwrites the existing database on the 
local hard drive. Make sure to insert the correct media.You 
cannot restore system presets, settings and service 
configurations between systems with different software 
versions. To minimize accidental loss of data, perform backup 
of the patient archives stored on the local hard drive 
periodically. 
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Search

Utility Parameter Search

Opens up a search window to find a parameter on the utility 
pages. 

To search for a utility parameter, 

1. Press Search from the Utility Touch Panel or from another 
Utility page. 

2. Type in the search string. For instance, if you’re searching 
for Zoom you would just type ‘zoom’. 

3. A list of possible matches appears to the right. Select the 
correct match. 

NOTE: You cannot perform a search on the Measure, Reports, Imaging 
Preset Manager, Scan Assistant, or Service Utility pages. 
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Chapter 11

Probes and Biopsy

This chapter consists of the information of each probe 

and describes some special concerns, biopsy kits and 

accessories as well as basic procedures for attaching a 

biopsy guide to the different types of probes.  
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Probe Overview

Ergonomics

Probes have been ergonomically designed to:

• Handle and manipulate with ease

• Connect to the system with one hand

• Be lightweight and balanced

• Have rounded edges and smooth surfaces.

• Stand up to typical wear by cleaning and disinfectant 
agents, contact with approved gel, etc.

Cables have been designed to:

• Connect to system with appropriate cable length

Supported Probes

Introduction

The LOGIQ Fortis supports the following types of probes: 

• Matrix Array probes

• Convex Array probes

• Linear Array probes

• Micro Convex Array probes

• Sector Phased Array probes

• Split Crystal

• Volume Probes (4D)

CAUTION Probes for transvaginal and transrectal applications require 
special handling. Transvaginal/transrectal examinations and 
probe insertions should be performed only by personnel with 
adequate training. Refer to the user documentation enclosed 
with these probes.
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Probe Description

Table 11-1:  Probe Applications and Features  

Probe

Clinical 

Applications

Capabilities and 

Features Illustration

BE9CS-D • Urology • Easy3D/Avanced3D

• PDI

• M-Mode

• LOGIQView

• Contrast

• CrossXBeam

• Strain Elastography

• Biopsy

C1-6-D • Abdomen (incl. 

Pleural) 

• OB/GYN 

• Pediatric

• Peripheral Vascular

• General 

musculoskeletal

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• Contrast

• B-Flow/Hybrid B-Flow

• CrossXBeam

• Shear Wave and Strain 

Elastography

• UGAP

• MVI/Contrast MVI

• Biopsy

C1-6VN-D • Easy3D/Avanced3D

• Tru3D

• Volume Navigation

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• Contrast

• B-Flow/Hybrid B-Flow

• CrossXBeam

• Shear Wave and Strain 

Elastography

• UGAP

• MVI/Contrast MVI

• Biopsy
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C2-7-D • Abdomen

• Pediatric

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• CrossXBeam

• Contrast

• B-Flow

• Biopsy

C2-7VN-D • Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• CrossXBeam

• Contrast

• V-Nav

• Tru3D

• B-Flow

• Biopsy

C2-9-D • Abdomen

• OB/GYN

• Pediatric

• Peripheral Vascular

• Neonatal

• Neonatal transcranial

• General 

musculoskeletal

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• CrossXBeam

• Contrast

• B-Flow/Hybrid B-Flow

• Strain Elastography

• UGAP

• Biopsy

C2-9VN-D • Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• CrossXBeam

• Contrast

• B-Flow/Hybrid B-Flow

• V-Nav

• Tru3D

• Strain Elastography

• UGAP

• Biopsy

Table 11-1:  Probe Applications and Features (Continued) 

Probe

Clinical 

Applications

Capabilities and 

Features Illustration
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C3-10-D • Neonatal

• Pediatric

• Neonatal transcranial

• Peripheral Vascular

• Small Parts 

• Abdomen

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• CrossXBeam

• Contrast

• B-Flow

• V-Nav

• Tru3D

• Volume Navigation

IC5-9-D • OB/GYN

• Urology

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• Contrast

• Shear Wave and Strain 

Elastography (GYN and 

Urology only

• V-Nav

• Tru3D

• Biopsy

• Volume Navigation

L2-9-D • Peripheral Vascular

• Abdomen (incl. 

Pleural)

• OB/GYN

• Small Parts

• Pediatrics

• Neonatal

• Neonatal transcranial

• General 

musculoskeletal

• Superficial 

musculoskeletal

• Easy3D/Avanced3D

• PDI

• M-Mode

• LOGIQView

• Virtual Convex

• Contrast

• CrossXBeam

• B-Flow/Hybrid B-Flow

• MVI/Contrast MVI

• Shear Wave and Strain 

Elastography

• Biopsy

L2-9VN-D • Easy3D/Avanced3D

• PDI

• M-Mode

• LOGIQView

• Virtual Convex

• Contrast

• CrossXBeam

• B-Flow/Hybrid B-Flow

• MVI/Contrast MVI

• Shear Wave and Strain 

Elastography

• V-Nav

• Tru3D

• Biopsy

Table 11-1:  Probe Applications and Features (Continued) 

Probe

Clinical 

Applications

Capabilities and 

Features Illustration
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L8-18i-D • Small Parts

• Peripheral vascular

• Neonatal Abdomen

• Neonatal transcranial

• Musculoskeletal

• Intraoperative 

(Peripheral Vascular)

• Easy3D/Avanced3D

• PDI

• M-Mode

• LOGIQView

• Virtual Convex

• Contrast

• CrossXBeam

• B-Flow/Hybrid B-Flow

• MVI

• Shear Wave and Strain 

Elastography

• V-Nav

• Tru3D

• Volume Navigation

L6-24-D 

(May not be 

available in all 

countries.)

• Musculoskeletal

• Small Parts

• Neonatal Abdomen

• Neonatal 

Transcranial

• LOGIQView

• Virtual Convex

• CrossXBeam

• B-Flow/Hybrid B-Flow

• MVI

• PDI

L3-12-D • Vascular 

• Abdomen (incl. 

Pleural)

• OB

• Small Parts

• General 

musculoskeletal

• Superficial 

musculoskeletal

• Neonatal

• Neonatal transcranial

• Pediatrics

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• Virtual Convex

• Contrast

• CrossXBeam

• B-Flow/Hybrid B-Flow

• MVI/Contrast MVI

• Strain and Shear Wave 

Elastography

• Biopsy

Table 11-1:  Probe Applications and Features (Continued) 

Probe

Clinical 

Applications

Capabilities and 

Features Illustration
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ML6-15-D • Abdomen

• Small Parts

• Peripheral Vascular

• Pediatrics

• Neonatal

• Neonatal transcranial

• General 

musculoskeletal

• Superficial 

musculoskeletal

• Easy3D/Avanced3D

• PDI

• M-Mode

• LOGIQView

• Virtual Convex

• Contrast

• CrossXBeam

• B-Flow/Hybrid B-Flow

• MVI/Contrast MVI

• Shear Wave and Strain 

Elastography

• V-Nav

• Tru3D

• Biopsy

• Volume Navigation

M5Sc-D • Adult cardiac

• Pediatric cardiac

• Adult cephalic

• Abdomen (incl. 

Pleural)

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• Curved Anatomical 

M-Mode

• Color M

• LOGIQView

• Virtual Convex

• Contrast

• Anatomical M-Mode

• B-Flow

• CW

• TVI/TVD

• Volume Navigation

• Tru3D

• Biopsy

6S-D • Pediatric cardiac

• Pediatric abdomen 

(incl. Pleural) 

• Easy3D/Avanced3D

• PDI

• M-Mode

• Anatomical M-Mode

• Curved Anatomical 

M-Mode

• Color M

• PDI

• LOGIQView

• Virtual Convex

• Anatomical M-Mode

• CW

• TVI/TVD

Table 11-1:  Probe Applications and Features (Continued) 

Probe

Clinical 

Applications

Capabilities and 

Features Illustration
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RAB6-D • OB/GYN

• Abdomen

• Pediatric

• Neonatal

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• Contrast

• CrossXBeam

• Realtime 4D

• Static3D

• Biopsy

RIC5-9-D • OB/GYN

• Urology

• PDI

• M-Mode

• Anatomical M-Mode

• LOGIQView

• Contrast

• CrossXBeam

• Realtime 4D

• Static3D

• BetaView

• Biopsy

6Tc-RS • Adult cardiac • CW

• Virtual Convex

• PDI

• M-Mode

• Anatomical M-Mode

• Curved Anatomical 

M-Mode

• Color M

• TVI/TVD

6TC-RS 

Adapter

P2D • Adult cardiac

• Pediatric cardiac

• Peripheral vascular

• Adult cephalic

• CW

P6D • Adult cardiac

• Pediatric cardiac

• Peripheral vascular

• Adult cephalic

• CW

Table 11-1:  Probe Applications and Features (Continued) 

Probe

Clinical 

Applications

Capabilities and 

Features Illustration
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Beta View

Beta View enables you to steer the probe head in elevation 
direction without moving the probe. This feature is available on 
the 4D RIC5-9-D probe during live scanning and is especially 
useful during an endovaginal or neonatal head exams. 

The Beta View Touch Panel control appears on the B-Mode 
Touch Panel when you select either of these two probes. You 
can adjust the Beta View control Right/Left or Up/Down. When 
you press down on the Beta View control, the probe head 
re-centers itself. 

Beta View is not available while the image is Frozen, during an 
image Recall, during a Biopsy procedure, or during Volume 
Navigation. When these controls are selected, the Beta View 
Touch Panel control is hidden and unavailable. 
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Probe orientation

Each probe is provided with an orientation marking. This mark is 
used to identify the end of the probe corresponding to the side of 
the image having the orientation mark on the display. 

Figure 11-1. Orientation Marking on Probe (Example)

Figure 11-2. Probe orientation marker on the display

1. Orientation Mark

Probe Naming Conventions

Table 11-2:  Probe Naming Convention

Real Time 4D Type Application Frequency Connector Type

“R” C=Convex

L=Linear

M=Matrix

S=Sector

AB=Abdominal

IC=Intracavitary

“1-5” D=DLP

RS= RS Connector 

with RS-DLP Adapter

LC=Long Cord
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Probe Safety

Care and Handling

The following recommendations help to reduce preventable 
probe damage. 

WARNING Failure to follow the precautions listed in the Probe Care 
Recommendations table can result in serious injury and/or 
equipment damage. 

Table 11-3:  Probe Care Recommendations

Do: Don’t Do:

Handle all probes with extreme care. DO NOT drop or knock the probe or probe lens. 

Impacting the probe lens face can cause fractures of 

the crystal elements leading to failure. 

Ensure that connected probes are placed in the 

probe holder yoke when not in use. Be sure to utilize 

the endocavitary probe holder and the probe inserts 

for the 3D and small aperture probes that were 

provided at delivery.

DO NOT leave probes in places where they may be 

knocked over or dropped.  

Use wall-mounted probe holders with lens facing 

upward. 

Ultrasonic cleaning IS NOT approved for GE 

probes. 

Visually inspect probes and cables for damage prior 

to connecting them to the LOGIQ Fortis. If a probe 

appears to be damaged, discontinue use and notify 

your GE Customer Service Representative. 

Possible damage may include, but is not limited to: 

• Bent or broken probe pins

• Cable cuts or splitting

• Surface cracks

• Exposed wires or shielding

• Fluid leaks

DO NOT drop probes into holders or into 

disinfectant containers with the probe’s lens face 

down. Even a short drop can damage a probe. 

Disconnect probes from the system prior to cleaning 

or disinfecting the probe. 

DO NOT let probe cables dangle loosely from the 

LOGIQ Fortis where they might be caught in the 

wheels/casters while moving. 

Ensure you follow the chemical manufacturer 

recommendations regarding the use and handling of 

the chemical. 

DO NOT immerse probes deeper than permissible 

levels. NEVER immerse the connector or adapter 

into any liquid. 
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Handling precautions 

Transesophageal probe safety

Always use bite guards with Transesophageal (TEE) 

probes. 

DO NOT apply excessive bending or pulling force to 

the probe cable. 

Clean and disinfect all probes following the 

procedures contained in this manual. 

DO NOT kink, tightly coil, or apply excessive force 

on the probe cable or TEE shaft. Insulation failure 

may result. 

Table 11-3:  Probe Care Recommendations (Continued)

Do: Don’t Do:

DANGER
 

Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling. Use care 
when handling and protect from damage when not in use. DO 
NOT use a damaged or defective probe. Failure to follow these 
precautions can result in an increase probability of disease 
progression, injury and equipment damage.

CAUTION Transesophageal, endocavity and intraoperative probes 
require a special handling. Refer to the user documentation 
enclosed with these probes.

WARNING Never use excessive force when manipulating the 
transesophageal probe. The detailed operator manual 
enclosed with the transesophageal probe must be read 
carefully. Failure to follow these instructions could lead to 
patient injury and/or equipment damage.

CAUTION TEE probes should always be used with an appropriate Bite 
Guard in place.
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Electrical shock hazard 

Electrical
Hazard

The probe is driven with electrical energy that can injure the 
patient or user if live internal parts are contacted by conductive 
solution:

• DO NOT immerse the probe into any liquid beyond the 
level indicated by the immersion level diagram. Refer to the 
immersion illustration in the Probe Cleaning Process 
section. Never immerse the probe connector or probe 
adaptors into any liquid.

• DO NOT drop the probes or subject them to other types of 
mechanical shock or impact. Degraded performance or 
damage such as cracks or chips in the housing may result.

• Prior to each use, visually inspect the probe lens and case 
area for cracks, cuts, tears, and other signs of physical 
damage. DO NOT use a probe which appears to be 
damaged until you verify functional and safe performance. 
You must perform a more thorough inspection, including 
the cable, strain relief, and connector, each time you clean 
the probe. 

• Before inserting the connector into the probe port, inspect 
the probe connector pins. If a pin is bent, do not use the 
probe until it has been inspected and repaired/replaced by 
a GE Service Representative.

• DO NOT kink, tightly coil, or apply excessive force on the 
probe cable. Insulation failure may result.

• Electrical leakage checks should be performed on a routine 
basis by GE Service or qualified hospital personnel. Refer 
to the service manual for leakage check procedures.
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Special handling instructions

Using protective sheaths

Instructions.  Custom made sheaths are available for each 
probe.  Each probe sheath kit consists of a flexible sheath used 
to cover the probe and cable and elastic bands used to secure 
the sheath.

Sterile probe sheaths are supplied as part of biopsy kits for 
those probes intended for use in biopsy procedures.  In addition 
to the sheath and elastic bands, there are associated 
accessories for performing a biopsy procedure which are 
included in the kit.  Refer to the biopsy instructions for the 
specific probes in the Discussion section of this chapter for 
further information.

Reordering.  To reorder sheaths, please contact your local 
distributor or the appropriate support resource. 

WARNING Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is mandatory for intra-cavitary 
and intra-operative procedures. Failure to follow these 
instructions could lead to exposure to infectious agents. 

WARNING Devices containing latex may cause severe allergic reactions in 
latex sensitive individuals. Refer to FDA's March 29, 1991 
Medical Alert on latex products.

WARNING DO NOT use an expired probe sheath. Before using probe 
sheaths, verify whether the term of validity has expired. Failure 
to follow these instructions could lead to exposure to infectious 
agents.

CAUTION Do not use pre-lubricated condoms as a sheath. In some 
cases, they may damage the probe. Lubricants in these 
condoms may not be compatible with probe construction.
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Endocavitary Probe Handling Precautions

If the disinfectant solution comes out of the endocavitary probe, 
please follow the cautions below.

NOTE: Sporadically, silicone grease can leak in small amounts from the 
probes’ cable bushing. This leakage is not a failure and is not 
harmful to the human body. Silicone grease does not contain 
any hazardous substances and is only use to seal the cable 
bushing. In the case of a leakage, wipe the grease with a cloth.

WARNING Sterile/sanitary sheaths are to be used on the probe during its 
actual use with patients. Wearing gloves protects the patient 
and operator. Failure to follow these instructions could lead to 
exposure to infectious agents.

WARNING Disinfectant Exposure to Patient (e.g., Cidex)—Contact with 
a disinfectant to the patient’s skin or mucous membrane may 
cause an inflammation. If this happens, refer to the 
disinfectant’s instruction manual.

Disinfectant Exposure from Probe Handle to Patient (e.g., 

Cidex)—DO NOT allow the disinfectant to contact the patient. 
Only immerse the probe to its specified level. Ensure that no 
solution has entered the probe’s handle before scanning the 
patient. If disinfectant comes into contact with the patient, refer 
to the disinfectant’s instruction manual.

Disinfectant Exposure from Probe Connector to Patient 

(e.g., Cidex)—DO NOT allow the disinfectant to contact the 
patient. Only immerse the probe to its specified level. Ensure 
that no solution has entered the probe’s connector before 
scanning the patient. If disinfectant comes into contact with the 
patient, refer to the disinfectant’s instruction manual.

Endocavitary Probe Point of Contact—Refer to the 
disinfectant’s instruction manual.

Failure to follow these instructions could lead to inflammation of 
skin or mucous membrane. 
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Probe handling and infection control

This information is intended to increase user awareness of the 
risks of disease transmission associated with using this 
equipment and provide guidance in making decisions directly 
affecting the safety of the patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that 
must be coupled to the patient by direct physical contact.  
Depending on the type of examination, this contact occurs with a 
variety of tissues ranging from intact skin in a routine exam to 
recirculating blood in a surgical procedure. The level of risk of 
infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between 
patients is with single use or disposable devices. However, 
ultrasound transducers are complex and expensive devices that 
must be reused between patients. It is very important, therefore, 
to minimize the risk of disease transmission by using barriers 
and through proper processing between patients. 

WARNING ALWAYS clean and disinfect the probe according to the probe 
specific instructions, including probe compatible chemicals 
between patients to the level appropriate for the type of 
examination and use FDA-cleared probe sheaths where 
appropriate. Failure to follow these instructions could lead to 
exposure to infectious agents.  

WARNING Adequate cleaning and disinfection are necessary to prevent 
disease transmission. It is the responsibility of the equipment 
user to verify and maintain the effectiveness of the infection 
control procedures in use. Always use sterile, legally marketed 
probe sheaths for intra-cavitary and intra-operative procedures.

WARNING To minimize the risk of infection from blood-borne pathogens, 
you must handle the probe and all disposables which have 
contacted blood, other potentially infectious materials, mucous 
membranes, and non-intact skin in accordance with infection 
control procedures. You must wear protective gloves when 
handling potentially infectious material. Use a face shield and 
gown if there is a risk of splashing or splatter.
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Care and Maintenance

Inspecting probes

Figure 11-3. Probe parts

Perform After Each Use

Inspect the probe's lens, cable, casing, and connector. Look for 
any damage that would allow liquid to enter the probe.  

NOTE: Keep a log of all probe maintenance, along with a picture of any 
probe malfunction.

WARNING If any damage is found, do not use the probe until it has been 
inspected and repaired/replaced by a GE Service 
Representative. Failure to follow these precautions can result 
in injury and equipment damage.

1. Casing

2. Strain relief

3. Seal

4. Lens



Probes and Biopsy

11-18 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Probe Reprocessing

Probe Care Cards

The Probe Care Card contains a list of chemicals that have been 
tested for compatibility with GE Ultrasound probes. The 
reprocessing instructions provided in this document have been 
validated with the chemicals specified in Table 11-6 on 
page 11-35. 

The Probe Care Card is supplied with every probe and may also 
be downloaded from: 

Adequate cleaning and disinfection between patient cases are 
necessary to prevent transmission of disease. All probes must 
be thoroughly cleaned prior to disinfection. The level of 
disinfection required is based on patient contact. 

• To verify probe chemical compatibility, a full list of chemicals 
tested is available at the GE Probe website Table 11-5 on 
page 11-18.

• Probes that contact mucosal or non-intact skin require 
cleaning followed by High-Level Disinfection either soaking 
or use of a trophon® EPR or trophon2. 

• Probes that contact intact skin require cleaning followed by 
Intermediate-Level Disinfection (wipe or spray). 

Table 11-4:  Documentation Web Site

Support Documentation Web Site

https://www.gehealthcare.com/support/documentation

Table 11-5:  Probe Web Site

Ultrasound Probe Web Site

https://www.gehealthcare.com/products/ultrasound/ultrasound-transducers

http://www.gehealthcare.com/transducers
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Probe Pre-Treatment at the Point of Use (Required for All Probes)

The pre-treatment step is for removal of gel and gross 
contamination. 

1. After each use, remove protective sheath from the probe 
and remove the coupling gel by wiping from the strain relief 
to the lens with a soft, low-lint cloth.

2. Wipe the cable with one of the wipes listed in probe 
compatibility website from the strain relief to the connector. 
Wipe the cable with a low-lint cloth dampened with potable 
water to remove chemical residue. Dispose of the cloth, 
wipe and gloves in the clinical trash.

Figure 11-4. Cleaning the Probe Cable

NOTE: Use of wipes listed in the Ultrasound Probe website may 
result in discoloration of the cable.

CAUTION DO NOT use abrasive products or brushes when cleaning or 
wiping a GE Ultrasound probe. The use of abrasive wipes can 
damage the soft lens (acoustic window). To extend the life of 
the probe lens, pat dry only.
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Probe Pre-Treatment at the Point of Use (Required for All Probes)  

(continued)

3. After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter 
the probe.

 Figure 11-5. Inspect the Lens, Cable, and Probe House After Each Use

CAUTION Use caution when cleaning the connector. This cable 
connector should only be cleaned with a slightly dampened 
cloth or wipe. Exposure to excessive moisture will result in 
damage to the probe and possibly the ultrasound console. 
DO NOT wet the connector/console interface surface or 
labels.

DANGER
 

If the probe is damaged, do not place it into any liquid (e.g. 
for disinfection) and do not use it until it has been inspected 
and repaired/replaced by a GE Service Representative.

1. Cleaning only portion

2. Cleaning only or cleaning and disinfection portion

3. Cleaning followed by appropriate level of disinfection
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Probe Manual Cleaning Instructions

Manual cleaning is required to ensure the probes are 

cleaned to the extent necessary for further processing. 

Choose the most appropriate method, either the wipe or 

enzymatic soak.

Cleaning with Wipes

1. Hold the probe at the proximal end near the strain relief 
cable. DO NOT suspend or hold the probe by the cable as 
this may damage the probe. 

2. Dispense a cleaning wipe from the wipe canister. 

3. Gently wipe the probe with a cleaning wipe from the cable 
strain relief to the distal end. Gently wipe the probe’s lens. 

NOTE: Pay special attention to lens, edges, and groves. 

4. Turn the probe and continue wiping until the entire surface 
of the probe has been cleaned. As the wipe becomes visibly 
soiled, discard the wipe into clinical trash and dispense 
fresh wipes as needed. 

5. Wrap a clean wipe around a soft nylon bristle brush to 
access crevasses, such as biopsy notches, on the surface 
of the probe. 

6. Visually inspect the probe for any remaining soil and, if 
necessary, repeat steps 3 through 5 until the probe is visibly 
clean.
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Cleaning with Enzymatic Detergent 

1. Ensure the probe has been disconnected from the console. 
Replace gloves and fill a sink or basin with warm potable 
water (30 - 40°C) to a level allowing immersion of the probe 
up to the immersion line shown in Figure 11-12 on 
page 11-30. 

2. Prepare the cleaning solution in accordance with the 
detergent manufacturer’s instructions.

3. Immerse the probe in the prepared cleaning solution up to 
the immersion line and ensure no air bubbles are trapped on 
the surface. 

NOTE: For IC5-9-D, see Figure 11-13 on page 11-31 for special 
immersion instructions.

4. Brushing with a clean, soft, nylon bristle brush from the base 
of the cable strain relief to the distal tip is critical to ensure 
cleaning and disinfection efficacy.   

Figure 11-6. Cleaning the probe using a brush

CAUTION Do not submerge probe beyond the immersion line shown 
in Figure 11-12 on page 11-30.

CAUTION DO NOT use the brush on the probe lens. 
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Cleaning with Enzymatic Detergent  (continued)

Figure 11-7. Probe Lens Examples

5. Continue brushing the probe for not less than the minimum 
contact time listed on the detergent manufacturer’s label. 

6. Visually inspect the probe for soil. Repeat Steps 3 through 5 
until all visible soil has been removed from the surface of the 
probe.

7. Rinse the probe under running warm potable water (30 - 
40°C) for not less than 2 minutes. Scrub the surface of the 
probe with a clean, soft, nylon bristle brush from the base of 
the cable strain relief to the distal tip. 

8. Visually inspect the device in a well-lit area to ensure all 
surfaces are free from residual cleaning solution. Repeat 
Step 7 if visible cleaning solution is observed.

9. Thoroughly dry the probe using a clean, low-lint, soft cloth or 
wipe. Pat dry lens.

CAUTION Do not use the brush on the probe lens.

CAUTION DO NOT use a twisting motion or abrasive paper products 
when wiping the probe as this may damage the soft lens. To 
extend the life of the probe lens, pat dry only.
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Cable and Connector Manual Cleaning

1. The cable and connector surfaces can be cleaned with the 
cleaners or wipes listed in the Probe Care Card.

NOTE: Use of wipes listed in the Ultrasound Probe website may 
result in discoloration of the cable.

2. Wipe the cable with a low-lint cloth dampened with potable 
water to remove chemical residue.

Figure 11-8. Cleaning the Probe Cable

CAUTION Use caution when cleaning the connector. This cable connector 
should only be cleaned with a slightly dampened cloth or wipe. 
Exposure to excessive moisture will result in damage to the 
probe and possibly the ultrasound console. DO NOT wet the 
connector/console interface surface or labels.
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Probe Intermediate-Level Disinfection (ILD)

For Intermediate-Level Disinfection of intact skin contacting 

probes, choose either the spray or wipe method. 

NOTE: Probes that contact only intact skin may be disinfected in this 
manner. All probes that contact non-intact skin or mucous 
membranes (e.g., endocavitary, Transesophageal) require 
High-Level Disinfection. 

Probe ILD - Disinfectant Spray

1. Put on a new pair of gloves and spray enough disinfectant 
solution to saturate a new disposable low-lint wipe or cloth. 

2. Holding the probe near the strain relief, apply the dampened 
cloth to the patient contacting lens. Wipe the probe from the 
lens to the strain relief, slightly rotating the probe after each 
wiping pass.

3. After the probe has been completely wiped, dampen a 
second wipe with disinfectant and starting at the probe lens 
begin wiping the probe in a rotating motion moving down 
towards the strain relief. Spray disinfectant directly on the 
recessed areas and ridges to saturate.

DANGER
 

If the probe is damaged, DO NOT place it into any liquid (e.g. 
for disinfection) and DO NOT USE until the probe has been 
inspected and repaired/replaced by a GE Service 
Representative.

CAUTION After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter the 
probe.
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Probe ILD - Disinfectant Spray  (continued)

Figure 11-9. Disinfecting the Probe Moving from Lens to Strain 
Relief

4. Once the probe has been completely wiped, dampen a third 
wipe with disinfectant and continue wiping the probe as 
needed to ensure the surface remains wet for the required 
exposure time. Use as many wipes as needed and respray 
disinfectant on recessed areas and ridges, to ensure all 
surfaces remain wet for the minimum required contact time 
listed in the disinfectant manufacturer’s instructions for use.

5. Thoroughly dry all surfaces of the probe using a soft, low-lint 
wipe or cloth, changing wipes/cloths when necessary to 
ensure the probe is completely dry. Pat dry lens. Visually 
inspect the probe to ensure all surfaces are dry. Repeat 
drying steps if any moisture is visible.

6. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 
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Probe ILD - Disinfectant Wipe

1. Replace gloves. Holding the probe near the strain relief, 
apply the wipe to the patient contacting lens. Wipe the probe 
from the lens to the strain relief, slightly rotating the probe 
after each wiping pass.

2. After the probe has been completely wiped, use a second 
wipe and starting at the probe lens begin wiping the probe in 
a rotating motion moving down towards the strain relief. 
Wring the wipe above recessed areas, seams, and ridges to 
drip disinfectant directly onto these less accessible 
surfaces. 

Figure 11-10. Disinfecting the Probe Moving from Lens to 
Strain Relief

NOTE: Probes that contact only intact skin may be disinfected in 
this manner. All probes that contact mucous membranes 
(e.g., endocavitary, Transesophageal) require High-Level 
Disinfection. 
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Probe ILD - Disinfectant Wipe  (continued)

3. Once the probe has been completely wiped, use a third 
wipe and continue wiping the probe as needed to ensure the 
surface remains wet for the required exposure time. Use as 
many wipes as needed and drip additional disinfectant on 
recessed areas and ridges, to ensure all surfaces remain 
wet for the minimum required contact time listed in the 
disinfectant manufacturer’s instructions for use. 

Figure 11-11. Disinfecting the Probe

4. Thoroughly dry all surfaces of the probe using a soft, low-lint 
wipe or cloth, changing wipes/cloths when necessary to 
ensure the probe is completely dry. Pat dry lens. Visually 
inspect the probe to ensure all surfaces are dry. Repeat 
drying steps if any moisture is visible.

5. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 



Care and Maintenance

LOGIQ Fortis – Basic User Manual 11-29
5855997-1EN Rev. 3

Probe High-Level Disinfection (HLD)

High-Level Disinfection is required for devices that contact 

intact mucous membranes or non-intact skin. High Level 

Disinfection can be performed using either a disinfectant 

soaking method or an automated system such as trophon® 

EPR or trophon2. 

NOTE: All semi-critical probes* that contact mucous membranes 
require High-Level Disinfection. 

*Semi-critical probes are probes that contact mucous 
membranes or non-intact skin. 

NOTE: Handles of semi-critical probes that are not submerged during 
High-Level Disinfection require Low or Intermediate-Level 
Disinfection to avoid cross contamination. 

Probe HLD - Soak

1. Ensure the probe has been disconnected from the console. 
Replace gloves and fill a sink or basin with High-Level 
Disinfectant diluted in accordance with the disinfectant 
manufacturers instructions to a level allowing immersion of 
the probe up to immersion line shown in Figure 11-12 on 
page 11-30.  

DANGER
 

If the probe is damaged, DO NOT place it into any liquid (e.g. 
for disinfection) and DO NOT USE until the probe has been 
inspected and repaired/replaced by a GE Service 
Representative.

CAUTION After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter the 
probe.

CAUTION Ensure no liquid comes into contact with the probe connector 
pins or labels.
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Probe HLD - Soak  (continued)

2. Immerse probe in the disinfectant up to the immersion line 
and ensure no air bubbles are trapped. Ensure the probe 
remains in the disinfectant for at least the minimum contact 
time listed in the disinfectant manufacturer’s instructions for 
use. 

 Figure 11-12. Probe Immersion Levels, 1 = Fluid Level

For IC5-9-D probe with serial numbers listed below or 
greater, refer to Figure 11-13 on page 11-31 for the soaking 
level: 

• IC5-9-D: 780333WX1 or greater (example 780334WX1, 
780335WX1)

The prefix number, i.e. 780333 for 780333WX1, 
indicates serial number sequence.
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Probe HLD - Soak  (continued)

Figure 11-13. Probe Immersion Level for IC5-9-D

NOTE: Over-exposing ultrasound probes to high-level disinfectants 
may damage the ultrasound probe. NEVER exceed the 
disinfectant manufacturer’s maximum exposure time. 

Figure 11-14. Probe suspended in disinfectant basin

3. Thoroughly rinse the probe by immersing it in a large 
volume of critical (purified) water for a minimum of 1 (one) 
minute. Remove the probe and discard the rinse water.

Do not reuse the water. Always use fresh volumes of water 
for each rinse. Repeat Step 3 two additional times, for a total 
of 3 (three) rinses.

1. Serial number location

CAUTION Ensure that the probe is suspended. The probe face should not 
be resting against the tank/basin surface and should be in full 
contact with the liquid. Carefully place the probe in the basin, 
taking care not to damage the transducer lens. 

CAUTION Failure to properly rinse probes with water following 
disinfection may cause skin irritation. Failure to follow these 
instructions could lead to inflammation to skin or mucosal 
membrane. 



Probes and Biopsy

11-32 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Probe HLD - Soak  (continued)

4. Thoroughly dry all surfaces of the probe using a soft, low-lint 
wipe or cloth, changing wipes’ cloths when necessary to 
ensure the probe is completely dry. Pat dry lens. Visually 
inspect the probe to ensure all surfaces are clean and dry. 
Repeat drying steps if any moisture is visible.

5. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 

The instructions provided above have been validated to properly 
prepare GE Ultrasound probes for re-use. It remains the 
responsibility of the processor to ensure that the processing is 
performed as specified in this document. This may require 
verification and routine monitoring of the process. 
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Probe HLD - trophon® EPR or trophon2

When performing High-Level Disinfection of GE ultrasound 
probes with the trophon® EPR or trophon2, it is not necessary to 
disconnect the probe from the ultrasound system. The probe 
must be inactive (not selected) during the disinfection cycle.

1. Upon completion of probe cleaning, ensure the probe has 
been thoroughly dried with a clean, low-lint soft cloth or 
wipe. Carefully dry the probe by wiping from the distal tip to 
the strain relief. 

2. Visually inspect the probe to ensure the probe is visibly 
clean. 

3. Follow the trophon instructions for probe placement and 
operation of the trophon system. Incorrect positioning of the 
probe may lead to High-Level Disinfection not being 
achieved. 

4. Once the trophon High-Level Disinfection cycle is complete, 
don a new set of gloves and promptly remove the probe 
from the trophon machine. DO NOT allow the probe to 
remain in the machine for extended periods of time. 

CAUTION DO NOT use abrasive products or brushes when cleaning or 
wiping a GE Ultrasound probe. The use of abrasive wipes can 
damage the soft lens (acoustic window). To extend the life of 
the probe lens, pat dry only. 

CAUTION Damage to the probe may occur if the probe is placed in 
contact with the trophon chamber wall. Curved probes must be 
correctly positioned in the chamber using the Curved Probe 
Positioner (CPP) supplied with the trophon system. 
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Probe HLD - trophon® EPR or trophon2  (continued)

5. Hold the probe at the proximal end near the strain relief 
cable. DO NOT suspend or hold the probe by the cable, as 
this may damage the probe. 

6. Wipe the probe from the distal end to the proximal end with 
a clean, low-lint soft cloth or wipe to remove any residual 
hydrogen peroxide from the probe surface.  

7. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 

CAUTION DO NOT use a twisting motion or abrasive paper products 
when wiping the probe. To extend the life of the probe lens, pat 
dry only.
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Chemicals Used for Efficacy Validation

The table below lists the products and intended use (clean, 
Intermediate-Level Disinfection, High-Level Disinfection) that 
were validated. 

A full list of chemicals tested for compatibility is available at the 
GE Probe Web Site: 

NOTE: The tables in this manual indicate the status when this manual 
was published. Please visit the website for the latest 
information.

Table 11-6:  Chemicals used for Efficacy Validation

Product Type Trade Name Manufacturer

Minimum 

Contact 

Time Active Ingredient

Cleaning (Wipe) Oxivir® Tb Diversey N/A Hydrogen Peroxide

Enzymatic Detergent 

(Soak)

Enzol®

 (Cidezyme®)

Advanced 

Sterilization 

Products® (J&J)

1-Minute 

Soak

Proteolytic Enzymes

MetriZyme™ Metrex™

Prolystica® 2X

Concentrate 

Presoak & Cleaner

Steris

Intermediate-level 

Disinfectant (wipe)

Oxivir® Tb Diversey 10-Minute 

Exposure

Hydrogen Peroxide

High-level 

Disinfectant (Soak)

Cidex® OPA Advanced 

Sterilization 

Products (J&J)

10-Minute 

Soak

Ortho-phthalaldehyde

McKessen OPA/28 McKesson

Table 11-7:  Probe Web Site

Ultrasound Probe Web Site

http://www.gehealthcare.com/transducers

http://www.gehealthcare.com/transducers
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Covering the Transducer using a Sterile, Protective Sheath

1. Place an appropriate amount of gel inside the protective 
sheath and/or on the transducer face.

NOTE: Failure to use imaging gel may result in poor image quality.

2. Insert transducer into sheath, making sure to use proper 
sterile technique. Pull cover tightly over transducer face to 
remove wrinkles and air bubbles, taking care to avoid 
puncturing the sheath.

Figure 11-15. Applying the Sheath

NOTE: No gel was applied to the probe in this photo. 

3. Secure the sheath in place.

NOTE: Failure to use a sheath that fully covers the transducer to 
the cable strain relief may lead to cross-contamination of the 
transducer.

4. Inspect the sheath to ensure there are no holes or tears. If 
the sheath becomes compromised, stop the procedure and 
replace immediately. 

CAUTION Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is mandatory for intra-cavitary 
and intra operative procedures.

1. Secure the Sheath with a rubber 

band.  

2. The probe sheath should extend 

past the end of the probe to the 

probe’s cable. 
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Probe Cleaning and Disinfecting Notes

DANGER
 

Ultrasound transducers can easily be damaged by improper 
handling and by contact with certain chemicals.  Failure to 
follow these precautions can result in serious injury and 
equipment damage.

• Do not immerse the probe into any liquid beyond the level 
specified for that probe.  Never immerse the transducer 
connector or probe adapters into any liquid. 

• Avoid mechanical shock or impact to the transducer and do 
not apply excessive bending or pulling force to the cable.

• Transducer damage can result from contact with 
inappropriate coupling or cleaning agents:

• Do not soak or saturate transducers with solutions 
containing alcohol, bleach, ammonium chloride 
compounds or hydrogen peroxide (except in the case 
of using trophon’s hydrogen peroxide).

• Avoid contact with solutions or coupling gels containing 
mineral oil or lanolin

• Avoid temperatures above 60°C (except with trophon 
for approved probes).

• Inspect the probe prior to use for damage or degeneration 
to the housing, strain relief, lens and seal.  Do not use a 
damaged or defective probe.

• Use only the products that are listed on the Transducer 
website or on the Probe Care Card enclosed with the 
probe. In addition, refer to the local/national regulations.

WARNING Do not steam, heat autoclave on general surface probes.
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Probe Cleaning and Disinfecting Notes  (continued)

CAUTION CREUTZFELDT-JAKOB DISEASE

Neurological use on patients with this disease must be 
avoided.  If a probe becomes contaminated, there is no 
adequate disinfecting means.

Biological
Hazard

CAUTION DO NOT expose the system/probe connector to any moisture 
or liquids. 

CAUTION Take extra care when handling the lens face of the Ultrasound 
transducer. The lens face is especially sensitive and can easily 
be damaged by rough handling. NEVER use excessive force 
when cleaning the lens face.

CAUTION In order for liquid chemical disinfectants to be effective, all 
visible residue must be removed during the cleaning process. 
Thoroughly clean the probe, as described earlier before 
attempting disinfection.

You MUST disconnect the probe from the LOGIQ Fortis prior to 
cleaning/disinfecting the probe. Failure to do so could damage 
the system.  

DO NOT soak probes in liquid chemical disinfectant for longer 
than is stated by the disinfectant instructions for use. Extended 
soaking may cause probe damage and early failure of the 
enclosure, resulting in possible electric shock hazard. 
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Probe Cleaning and Disinfecting Notes  (continued)

NOTE: Cleaning products should be as close to neutral PH as possible. 
Any gel, cleaning, or disinfectant products containing 
concentrations, surfactants, methanol, ethanol, benzyl or methyl 
alcohol, mineral oil, lubricant oil, oil-based lotions, acetone, 
ammonia, anhydrous ammonia, iodine, iodine compounds, 
acids with 5PH or greater may damage or discolor your probe. 
Ultrasounic cleaning is not approved for GE probes. 

NOTE: DO NOT re-use cloths or wipes. Soap, detergents, or enzymatic 
cleaners should be used in accordance with the manufacturer’s 
instructions. GE is not responsible for damage incurred during 
the cleaning process for products which no material 
compatibility evaluation has been conducted. 

CAUTION Avoid cross-contamination, follow all infection control policies 
established by your office, department or hospital as they apply 
to personnel and equipment.

CAUTION • Do not use paper products or products that are abrasive 
when cleaning the probe. They damage the soft lens of the 
probe.

• Before storing the probes, ensure that they are thoroughly 
dry. If it is necessary to dry the probe after cleaning, blot 
the probe with a soft cloth.

CAUTION Probes must be cleaned and disinfected before they are 
replaced or disposed of.
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Probe Disinfectants 

Choosing a Disinfectant

NOTE: For latest chemicals tested for compatibility, check the GE Probe 
Website at the link listed in Table 11-8.  

When choosing a disinfectant, determine the required level of 
disinfection. If the possibility of cross-contamination or exposure 
to unhealthy or non-intact skin exists, then high level disinfection 
should be performed. Good hand hygiene practice is highly 
recommended to help further reduce the risk of 
cross-contamination. 

NOTE: For additional information about cleaning and disinfection, refer 
to the recommendations of the Association for Professionals in 
Infection Control (APIC), the U.S. Food and Drug Administration 
(FDA), and the U.S. Centers for Disease Control (CDC). For 
country-specific disinfection regulations, check with your local 
regulatory infection control authorities. 

NOTE: GE publishes a list of material-compatible disinfectants (see 
below and also refer to the GE website at http://
www3.gehealthcare.com/en/Products/Categories/Ultrasound/
Ultrasound_Probes. DO NOT use non-GE-approved 
disinfectants or products that have not been evaluated by GE for 
material compatibility. Damages linked to the use of disapproved 
chemicals are not covered under product warranty or service 
contract. 

Table 11-8:  Probe Web Link

Ultrasound Probe Web Site

http://www.gehealthcare.com/transducers

CAUTION Disinfectant wipes and topical spray products are not FDA 
cleared high level disinfectants and do not provide adequate 
protection should the probe become cross contaminated or in 
contact with unhealthy or non-intact skin. Failure to 
appropriately disinfectant could lead to exposure to infectious 
agent(s). 

CAUTION Review the probe care card that is packed with each probe.

http://www.gehealthcare.com/transducers
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trophon EPR Probe High-Level Disinfection

 Figure 11-16. trophon EPR

1. Screen Display

2. Start Button

3. Soft key buttons

4. Chamber door handle

5. Probe cable clamp

6. Cartridge door

CAUTION Only those individuals previously trained on the trophon EPR or 
trophon2 unit may use the device. Refer to the trophon EPR or 
trophon2 user documentation for more information on 
disinfecting approved probes.
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trophon EPR Instructions for Use

Installing the 

disinfectant 

cartridge

1. The cartridge door automatically opens when a cartridge 
needs replacing.

2. Screen message: “Load Cartridge” or “Cartridge Empty, 
Replace Cartridge Now” displays.

3. Wear disposable gloves and chemical resistant goggles.  
These should be worn at all times while using the trophon 
EPR.

4. Press the soft key button under “Yes” to open the cartridge 
replacement door.

5. Remove the cartridge lid and insert the bottle on the side of 
the unit.

6. Rotate the cartridge until it drops into place and cannot 
rotate any further.

7. Close the cartridge door. Do not use excessive force to 
accomplish this. The door clicks into place and locks.

Disinfecting probe 

in trophon EPR

8. When the screen message reads “Load Probe”, open the 
chamber door.

9. Clean and rinse the probe. Dry the probe.

NOTE: The probe must be cleaned, per the manufacturer’s 
guidelines, and dried before disinfection. 

10. Place Chemical Indicator on the bottom of the device 
chamber.

11. While holding the probe handle, press the top of the probe 
into the chamber’s seal. Ensure the probe is straight and not 
touching either the walls or bottom of the chamber. Strain 
relief (interface between cable and probe body) must be 
positioned at the top of the chamber. The tip of the probe 
must be above the horizontal line marked in the chamber.

CAUTION Do NOT allow the probe surface or lens to touch the 
chamber’s wall during the disinfection process. This could 
cause permanent damage to the probe.
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trophon EPR Instructions for Use  (continued)

12. Press the probe’s electrical cable into the cable clamp, 
found at the top of the chamber.

13. Close the chamber door. It will automatically lock.

14. The screen message “Is the probe clean and dry?” appears, 
select Yes. 

15. Press “Start” to begin the disinfecting process.

16. Discard disposable gloves.

Removing the 

Probe after 

7-minute cycle 

time

1. Wear a new pair of disposable gloves.

2. When “Cycle complete” displays on the screen, open the 
chamber door.

3. Check the Chemical Indicator color change and refer to the 
Chemical Indicator on the box.

4. Remove the Chemical Indicator from device and discard.

5. Remove the probe from the trophon EPR.

6. Wipe the probe prior to use with an absorbent, single-use, 
dry, low-lint cloth.

7. Remove and discard the disposable gloves.
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Coupling Gels

CAUTION Do not use unrecommended gels (lubricants).  They may 
damage the probe and void the warranty.

Table 11-9:  Probe Gels

Gel L
2

-9
-D

/L
2

-9
V

N
-D

L
3
-1

2
-D

L
6
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4
-D

M
L

6
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5
-D

M
5
S

c
-D

6
S

-D

L
8
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8
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9
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S
-D
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1
-6

-D
/C

1
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-D

C
2
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2
-7

V
N

-D

C
2
-9

-D
/C

2
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V
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C
3
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0
-D

IC
5

-9
-D

R
A

B
6

-D

R
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5
-9

-D

P
2
D

P
6
D

Aquasonic 100 X X X X X X X X X X X X X X X X X

Clear Image X X X X X X X X X X X

EcoGel 200 Ultrasound Gel X X X X X X X X X X X X X

EcoVue Ultrasound Gel X X X X X X X X X X X X

Haiyin X X X X X X X X X

Kendall Life Trace Ultrasound 

Gel

X X X X X X X X X X X X X

Konix Ultrasound Gel X X X X X X X X X X X X X

MediChoice Standard 

Ultrasound Gel

X X X X X X X X X X X X X

Medline Ultrasound Gel/

Ultrasound Transmission Gel

X X X X X X X X X X X X X

Natural Image X X

Scan X X X X X X X X X X X X X

Sonogel X X X X X X X X X X X X X

Wavelength Multi-Purpose 

Ultrasound Gel

X X X X X X X X X X X X X



Care and Maintenance

LOGIQ Fortis – Basic User Manual 11-45
5855997-1EN Rev. 3

Coupling Gels  (continued)

Applying In order to assure optimal transmission of energy between the 
patient and probe, a conductive gel or couplant must be applied 
liberally to the patient where scanning will be performed.

NOTE: Gel is not applied to the 6Tc-RS Transesophageal probe prior to 
use. 

Precautions Coupling gels should not contain the following ingredients as 
they are known to cause probe damage:

• Methanol, ethanol, isopropanol, or any other alcohol-based 
product

• Mineral oil

• Iodine

• Lotions

• Lanolin

• Aloe Vera

• Olive Oil

• Methyl or Ethyl Parabens (para hydroxybenzoic acid)

• Dimethylsilicone

• Polyether glycol based

• Petroleum

Sterile Ultrasound Procedures

ONLY ultrasound gel that is labeled as sterile, is sterile. 

Ensure you always use sterile ultrasound gel for those 
procedures that require sterile ultrasound gel.

Once a container of sterile ultrasound gel is opened, it is no 
longer sterile and contamination during subsequent use is 
possible.

CAUTION Do not allow gel contact with eyes. If there is gel contact with 
the eye, flush eye thoroughly with water.
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V Nav Cleaning Requirements

Cleaning and Disinfecting V Nav Probe Brackets

The probe bracket SHOULD NOT be autoclaved or gas 
sterilized. The bracket can be sterilized with Cidex. Details are in 
the CIVCO reference guide that is included with the bracket kit. 

Cleaning and Disinfecting Cables, and Transmitter

Periodically clean the equipment (transmitter, sensor, and 
cables) by wiping them down with a cloth dampened in a 
cleaning solution such as mild soap and water, isopropyl 
alcohol, or a similar acceptable cleaning solution. If the tracker’s 
components come in contact with biological fluid or tissue, be 
sure to follow your organization’s procedures for proper cleaning 
and disinfection. The transmitters and sensors are not designed 
to withstand autoclaving or gamma radiation. Sensors are 
ETO-compatible. DO NOT immerse the transmitter, sensor, or 
cables in liquids. Components are not waterproof.

Disinfecting and Sterilizing General Purpose Sensor  

High-level disinfect general purpose sensor using CIDEX OPA® 
ortho-Phthalaldehyde Solution (Johnson & Johnson) or 
equivalent .55% ortho-phthalaldehyde-based solution. Follow 
manufacturer’s instructions and recommendations for 
concentration, time of contact and postprocess procedure.

High-level disinfect or sterilize general purpose sensor using 
CIDEX® Activated Dialdehyde Solution (Johnson & Johnson) or 
equivalent 2% glutaraldehyde-based solution, CIDEX Plus® 
(Johnson & Johnson) or equivalent 3.4% glutaraldehyde-based 
solution, or a hydrogen peroxide-based solution. Follow 
manufacturer’s instructions and recommendations for 
concentration, time of contact and post-process procedure.

DO NOT gas sterilize or autoclave general purpose sensor.

Covers

Covers can be used to go over the probe, bracket, sensors, and 
transmitter. 
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Planned Maintenance

The following maintenance schedule is suggested for the 
system and probes to ensure optimum operation and safety.

Automatic Probe Diagnostics

Automatic Probe Diagnostics uses automated lens echo 
acquisition and advanced processing to provide real-time probe 
health information.

Enable Automatic Probe Diagnostics by selecting "Enable 
Automatic Probe Diagnostics" on the Utility>Admin page.

Figure 11-17. Enable Automatic Probe Diagnostics

Automatic Probe Diagnostics will execute once at each system 
startup (on only the first supported probe connected from the left 
to right) and generate a dump file in the “D:\log\diags\VITA” 
directory. The dump file will be transferred to the Back Office 
together with other files under D:\log directory every day.

Automatic Probe Diagnostics supports the following probes at 
this time:  C1-6, IC5-9-D, M5sc-D, ML6-15 and RiC5-9-D.

DANGER
 

Improper handling can lead to early probe failure and electric 
shock hazards.

Failure to do so will void probe warranty.

DO follow the specific cleaning and disinfection procedures 
provided in this chapter and the disinfectant manufacturer’s 
instructions.

Table 11-10:  Planned Maintenance Program

Do the Following Daily After Each Use As Necessary

Inspect the Probes X X X

Clean the Probes X X

Disinfect Probes X X
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Probe Care Cards

Perform After 

Each Use

Ultrasound probes can be disinfected using liquid chemical 
disinfectants. The level of disinfection is directly related to the 
duration of contact with the disinfectant. Increased contact time 
produces a higher level of disinfection. Refer to the Probe Care 
Card that was shipped with each LOGIQ Fortis probe.

Table 11-11:  Description of Pictogram on Probe Care Cards

Pictogram Description

“ATTENTION” - Consult accompanying documents” is intended to alert the 

user to refer to the operator manual or other instructions when complete 

information cannot be provided on the label.

“CAUTION” - Dangerous voltage (the lightning flash with arrowhead) is used to 

indicate electric shock hazards.

Biohazard - Patient/user infection due to contaminated equipment.

Usage

• Cleaning and care instructions

• Sheath and glove guidelines

Ultrasound probes are highly sensitive medical instruments that can easily be 

damaged by improper handling. Use care when handling and protect from 

damage when not in use. 

Do not immerse the probe into any liquid beyond the level specified for that 

probe. Refer to the user manual of the ultrasound system.

Since there is a possibility of having negative effects on the probe, observe the 

specified immersing time by the disinfectant manufacturer strictly. Do not 

immerse the probe in liquid chemical disinfectants more than the time 

prescribed in the care card.

“Consult accompany document” - Refer to the ultrasound system user manual 

for important probe care and cleaning instruction.
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Returning/Shipping Probes and Repair Parts

US Department of Transportation and GE policy requires that 
equipment returned for service MUST be clean and free of blood 
and other infectious substances.

When you return a probe or part for service (Field Engineer or 
customer), you need to clean and disinfect the probe or part 
prior to packing and shipping the equipment.

Ensure that you follow probe cleaning and disinfection 
instructions provided in the Basic User Manual.

This ensures that employees in the transportation industry as 
well as the people who receive the package are protected from 
any risk.
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Biopsy Special Concerns

Precautions Concerning the Use of Biopsy Procedures

WARNING Do not freeze the image during a biopsy procedure.  The image 
must be live to avoid a positioning error.

Biopsy guide zones are intended to assist the user in 
determining optimal probe placement and approximate the 
needle path.  However, actual needle movement is likely to 
deviate from the guideline. Always monitor the relative 
positions of the biopsy needle and the target mass during the 
procedure, otherwise it could result in repeated biopsies or 
patient injury.

WARNING NEVER reuse the TR5° disposable biopsy guide attachment, 
disposable sterile Ultra-Pro II needle guide kits or Verza Needle 
guide kits. Failure to follow the manufacturer’s instructions 
could lead to potential exposure to infectious disease.

WARNING The use of biopsy devices with accessories that have not been 
evaluated for use with this equipment may not be compatible 
and could result in injury. Failure to follow these instruction 
could result in repeated biopsies or patient injury.
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Precautions Concerning the Use of Biopsy Procedures  (continued)

WARNING The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission.  Equipment must be cleaned as appropriate for 
the procedure prior to use.

• Follow the probe cleaning and disinfection procedures and 
precautions to properly prepare the probe.

• Follow the manufacturer's instructions for the cleaning of 
biopsy devices and accessories.

• Use protective barriers such as gloves and probe sheaths.

• After use, follow proper procedures for decontamination, 
cleaning, and waste disposal.

Failure to follow these instructions could lead to exposure 
to infectious agents.

CAUTION Improper cleaning methods and the use of certain cleaning and 
disinfecting agents can cause damage to the plastic 
components that will degrade imaging performance or increase 
the risk of electric shock. 

See ‘Probe Safety’ on page 11-11 for more information.

WARNING Consult the biopsy needle manufacturer’s instructions for 
acceptable reprocessing of biopsy needles. Failure to follow 
the manufacturer's instructions could lead to exposure to 
infectious agents. 
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Biopsy Guide Sterilization

Sterilization with autoclave is possible for the reusable stainless 
steel Biopsy Guides for the following probes:

• IC5-9-D

• RIC5-9-D

• RAB6-D

See ‘Probe Biopsy Reprocessing’ on page 11-81 for more 
information.
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Performing a Biopsy

Displaying the Guidezone

Activate the Biopsy Kit by selecting it from the B-Mode Touch 
Panel.

Figure 11-18. B-Mode Touch Panel Menu

The available biopsy options appear when Biopsy Kit is 
selected. There are fixed and adjustable angle biopsy kits and 
plastic/disposable and reusable biopsy guides available with the 
LOGIQ Fortis depending on the probe. Select the desired biopsy 
kit. 

NOTE: You can display the biopsy guideline on the CFM image in 
simultaneous mode. Enabling Color Flow allows for visualization 
of the vascular structure around the area to be biopsied. Select 
the Show Biopsy Mark on CFM simultaneous Mode preset in the 
Utility -> System -> System Image -> Biopsy Guide screen.

CAUTION Some angles (for example, if outside of the Field of View) may 
not be supported on all probes.
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Displaying the Guidezone  (continued)

NOTE: Be sure to match the angle setting on the bracket to the Biopsy 
Kit setting on the system.

Figure 11-19. Biopsy Guidezones for the M5Sc Probe

The biopsy guidezone represents the path of the needle. The 
dots which make up the guidezone represent the depth readout, 
where: 

• Yellow represents 1 cm increments. 

• Red represents 5 cm increments.

The display should be carefully monitored during a biopsy for 
any needle deviation from the center line or guidezone. 

Before scanning, verify the needle can be visualized within the 
imaging plane. Use appropriate needle length to reach target 
area. Adjust the guide settings on the system and confirm they 
pass through the target, then match the setting on the system to 
the pin settings on the guide. 

1. Biopsy Kit Name and Biopsy Needle Angle

2. 1 cm increments

3. 5 cm increments
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Displaying the Guidezone  (continued)

NOTE: Biopsy Needle Angle is defined with respect to the horizontal 
axis. This is equivalent to (90 deg) – (angle specified by 
CIVCO). Displayed angle may be slightly different from CIVCO’s 
specifications due to part variability. 

The Biopsy Guidezone adjusts along with image adjustments, 
such as image inversion/rotations, zoom and depth changes.

The needle may vary from the center line or guidezone for 
various reasons:

• Needle barrel to needle clearance or strength.

• Bracket manufacturing tolerance.

• Needle deflection due to tissue resistance.

• Needle size chosen. Thinner needles may deflect more.

WARNING Failure to match the guidezone displayed to the guide may 
cause the needle to track a path outside the zone.

It is extremely important that when using the adjustable angle 
biopsy guides, the angle displayed on the screen matches the 
angle set on the guide, otherwise the needle will not follow the 
displayed guidezone which could result in repeated biopsies or 
patient injury.
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Guide circle on the biopsy line

You can use a guide circle on the biopsy line.

Mode: B/CF/PDI/Elastography/Contrast/Volume Navigation

Display format: Single/Dual

Figure 11-20. Guide circle

• Guide circle

• Biopsy line

• The system displays current size of Target diameter (inside 
circle) and margin distance in the status area.
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Preset for guide circle

Check “Show Biopsy Circle” in Utility ->  System -> System 
Imaging to display a guide circle control on the monitor display 
and the trackball key.

Biopsy circle control

Figure 11-21. Biopsy circle control

1. Target diameter

2. Margin distance

3. Guide circle display On/Off

4. Circle position (move Trackball Up/Down)
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Preparing the Biopsy Guide Attachment

Convex, Sector and Linear probes have optional biopsy guide 
attachments for each probe.  The guide consists of a 
non-disposable bracket to attach to the probe, disposable 
needle clip to attach to the bracket, sheath, gel (sterile gel if 
necessary) and disposable needle barrels.

The disposable needle barrels are available for a variety of 
needle sizes.

The bracket is packaged non-sterile and is reusable. To avoid 
possible patient contamination, ensure bracket is properly 
cleaned, sterilized or disinfected before each use.

Disposable components are packaged sterile and are single-use 
only. Do not use if integrity of packing is violated or if expiration 
date has passed.

CAUTION DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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Fixed Needle Biopsy Guide Assembly

1. Identify the appropriate biopsy guide bracket by matching 
the label on the bracket with the probe to be used.

2. Orient the bracket so that the needle clip attachment will be 
on the same side as the probe orientation mark (ridge).

Figure 11-22. Probe/Bracket Alignment

a. Probe Orientation Mark

b. Bracket

3. Attach the biopsy bracket to the probe by sliding the bracket 
over the end of the probe until it clicks or locks in place.

4. Place an adequate amount of coupling gel on the face of the 
probe.

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood. Failure to follow these instructions 
could result in repeated biopsies or patient injury.

a

b
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Fixed Needle Biopsy Guide Assembly  (continued)

5. Using a sterile technique, place the proper sanitary sheath 
over the probe and biopsy bracket. Use the rubber bands 
supplied to hold the sheath in place.

Figure 11-23. Applying Sanitary Sheath

6. Snap the fixed or adjustable needle clip onto the biopsy 
guide bracket.

Figure 11-24. Fixed Needle Clip Attachment

a. Sheath

a
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Fixed Needle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure 
the lock. Make sure the needle guide is firmly attached to 
the bracket.

Figure 11-25. Locking the Needle Clip

NOTE: If using an in-plane needle guide, the needle clip appears as 
shown here. Be sure to choose an in-plane guide that 
matches the gauge of the needle being used. The in-plane 
guide does not support any on-screen graphics. This is 
because the guide allows variable angles. For in-plane 
needle guides, steps 8 and 9 are not applicable. 

Figure 11-26. Example of In-Plane Needle Guide
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Fixed Needle Biopsy Guide Assembly  (continued)

8. Choose the desired gauge (size) needle barrel. Twist it back 
and forth to remove it from the plastic tree.

Figure 11-27. Needle Barrel Selection

9. Place the needle barrel into the needle clip with the desired 
gauge facing the needle clip and snap into place.

Figure 11-28. Needle Barrel Installation

WARNING Ensure that all guide parts are seated properly prior to 
performing a biopsy. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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Multi Angle Biopsy Guide Assembly

1. Scan the patient and identify the target for biopsy. Move the 
probe to locate the target to the center of the image. Enable 
the system biopsy guidezone and try guidezone angles 
MBX1 to MBX3 to decide the best angle setting for needle 
path.

Figure 11-29. Example

2. Pull up on the pin (Figure 11-30 a) to freely move the needle 
guide attachment. Align the pin with the selected position of 
the needle guide attachment.

Push the pin down (Figure 11-30 b) into the desired slot to 
secure the angle position of the needle guide attachment.

Figure 11-30. Pull up and push down the pin

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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Multi Angle Biopsy Guide Assembly  (continued)

3. Fit a convex piece of the biopsy bracket (a) into the concave 
position of the probe (b).

Figure 11-31. Probe/Bracket Alignment

Hold the side (a) and tuck down the needle guide side (b) 
until it clicks or locks in place. 

Figure 11-32. Probe/Multi-angle Bracket Alignment 2

4. Place an adequate amount of coupling gel on the face of the 
probe.
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Multi Angle Biopsy Guide Assembly  (continued)

5. Place the proper sanitary sheath tightly over the probe and 
biopsy bracket. Use the rubber bands supplied to hold the 
sheath in place.

Figure 11-33. Applying Sanitary Sheath

6. Snap the needle guide onto the biopsy guide bracket.

Figure 11-34. Snap the needle guide
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Multi Angle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure 
the lock (a). Make sure the needle guide is firmly attached to 
the bracket.

Figure 11-35. Lock the Needle guide

8. Choose the desired gauge (size) needle barrel. Twist it back 
and forth to remove it from the plastic tree.

Figure 11-36. Needle Barrel

9. Place the needle barrel into the needle clip with the desired 
gauge facing the needle clip and snap into place.

Figure 11-37. Needle Barrel Installation
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Multi Angle Biopsy Guide Assembly  (continued)

Remove the biopsy guide

1. Hold the other side and push out the needle clip attachment 
side. See Figure 11-38.

Figure 11-38. Remove the biopsy guide

CAUTION Prevent damage to the probe lens with finger nails. 
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Releasing the needle

According to the following procedure, you remove the needle  
from a probe and an assembly without moving the needle.

Figure 11-39. Release the needle from assembly

a. Push the knob portion of a sleeve in the direction of the 
arrow.

b. The needle is released from the assembly.

c. Push the probe and the assembly in the direction of the 
larger arrow to remove the needle.
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Endocavitary Probe Biopsy Guide Assembly - Representative Example

Preparation

To prepare the endocavitary probe for use:

1. Remove the probe from the box and carefully examine it for 
any damage.

2. If the biopsy guide is to be attached, use the filling removal 
tool to clean out the attachment area on the probe head.

Figure 11-40. Attachment Filling Removal

a. Probe Head

b. Attachment

c. Filling Removal Tool

3. Clean, then disinfect the probe.

NOTE: Ensure that protective gloves are worn.

WARNING DO NOT use the needle with the catheter (soft tube). There is a 
possibility of breaking the catheter in the body.

WARNING Before inserting the needle, scan the patient to determine the 
correct puncture depth and site. Only the sterile/sanitary 
sheath and rubber band are on the probe during the pre-needle 
placement scanning. Failure to follow these instructions could 
result in repeated biopsies or patient injury.

a

b
c
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Installing the sheath

To install the sheath:

1. Remove the sheath from its package. Do not unroll the 
sheath.

NOTE: Remember to rinse all sanitary probe sheaths of powder 
before placing on the probe. Powder can degrade the 
displayed image.

2. Place an adequate amount of ultrasound gel inside the 
sheath tip (the gel is between the sheath inner surface and 
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this 
purpose.

3. Place the sheath tip over the probe aperture and then pull 
the sheath end toward the probe handle.

4. Inspect the sheath for nicks, cuts or tears.

Figure 11-41. Endocavitary Probe with Sheath

5. Rub a finger over the tip of the probe to ensure all air 
bubbles have been removed.

1. Secure the Sheath with a rubber 

band.  

2. The probe sheath should extend 

past the end of the probe to the 

probe’s cable. 
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Endocavitary Probe Biopsy Guide Preparation

1. If a biopsy is to be performed, snap the metal or plastic 
biopsy guide on to the probe over the sheath.

2. Fix with a screw

NOTE: For the RIC5-9-D and IC5-9-D probes, use the TR5 
guidelines for the plastic (disposable-only) biopsy guides; 
use the RU guidelines with the stainless steel reusable 
biopsy guides.

3. Place an adequate amount of ultrasound gel on the gel-filled 
sheath tip’s outer surface.

4. Ensure the guide is properly seated and secure by pushing 
forward on the needle insertion end of the guide until the 
attachment node is firmly in place in it’s hole.

WARNING Ensure that all guide parts are seated properly prior to 
performing a biopsy. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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4D Biopsy Guide Assembly - Representative Example

4D Probe

1. Place the needle guide onto the probe.

2. Push the needle forward until the bracket catches in the 
support on the housing of the probe (a).

Figure 11-42. Support on the housing

Figure 11-43. Biopsy Needle Guide

3. Fix the biopsy guide by locking the frame on the opposite 
side (b).

Figure 11-44. Mounting the Biopsy Needle Guide to the 4D 
Probe

NOTE: Needle guide sterilization with autoclave possible.
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4D Endocavitary Probe

1. Place an adequate amount of ultrasound gel inside the 
sheath tip (the gel is between the sheath inner surface and 
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this 
purpose.

2. Place the sheath tip over the probe aperture and then pull 
the sheath end toward the probe handle.

3. Inspect the sheath for nicks, cuts or tears.

4. Rub a finger over the tip of the probe to ensure all air 
bubbles have been removed.

5. Position the small swelling of the needle guide on the notch 
at the probe tip. Snap the needle guide.

Figure 11-45. Installation (without probe sheath)

NOTE: Material: Stainless Steel

NOTE: Needle guide sterilization with autoclave possible.
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Verza Biopsy Needle Guide

The Versa Biopsy Needle Guide is available for the C1-6-D, 
C1-6VN-D, L2-9-D, L2-9VN-D probes.

Activate the Biopsy Kit by selecting it from the B-Mode Touch 
Panel.

Figure 11-46. B-Mode Touch Panel Menu

The available biopsy options appear when Biopsy Kit is 
selected. Select the desired biopsy kit. 

CAUTION Be sure to match the ‘pin’ setting on the bracket to the pin 
setting on the system.
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Verza Needle Guide Attachment Procedure

NOTE: The following procedure is shown with a C1-6-D probe. 

Table 11-12:  Verza Biopsy Guide Attachment Procedure

Step Instructions Illustration

1.  Attach the Biopsy Guide Bracket to the probe. 

a. Match the indentations on the Biopsy 

Guide Bracket and the probe. 

2. Tightly secure the Biopsy Guide Bracket to the 

probe.

NOTE: Be sure you are using the correct 

bracket for the probe.  The bracket and probe 

are clearly marked. 

3. Attach the probe sheath. 

a. Apply gel. 

b. Cover the probe. 

c. Attach the rubber band. 
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4. Tightly secure the Needle Guide to the Biopsy 

Guide Bracket through the sheath. 

5. Unlock angle lock to adjust the needle guide 

angle; then re-lock. 

Locked  Unlocked

Adjust Needle Guide Angle Re-lock

Table 11-12:  Verza Biopsy Guide Attachment Procedure (Continued)

Step Instructions Illustration
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6. Insert correct Needle Gauge Holder.   

7. Push the Quick Tab Release, insert the biopsy 

needle into the needle guide. Close the Quick 

Tab Release.

Table 11-12:  Verza Biopsy Guide Attachment Procedure (Continued)

Step Instructions Illustration
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4D Probe Biopsy Needle Path Selection

To select the needle path and verify that the path of the needle is 
accurately indicated within the guidezone on the system 
monitor, perform the following before use:

1. Properly install the bracket and biopsy guide.

2. Scan in a container filler with water (47° C). 

3. Select Biopsy kit. The available biopsy options from the 
Touch Panel.

Select the biopsy guidezone where the needle echo passes 
through the center of the guidezone. Use the selected 
biopsy guidezone when performing the biopsy.

Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within 
the guidezone on the system monitor, perform the following:

• Properly install the bracket and biopsy guide.

• Scan in a container filled with water (47° C).

• Display the biopsy guidezone on the monitor.

• Ensure that the needle echo falls within the guidezone 
markers.
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The Biopsy Procedure

1. Place coupling gel on the scanning surface of the probe/
sheath/biopsy guide assembly.

2. Activate the biopsy guidezone on the system through the 
B-Mode Touch Panel.  When using multi-angle guides, 
ensure that the proper guidezone angle is displayed.

3. Scan to locate the target.  Center the target in the electronic 
guidezone path.

NOTE: Enabling color flow would allow for visualization of the 
vascular structure around the area to be biopsied.

4. Place the needle in the guide between the needle barrel and 
needle clip.  Direct it into the area of interest for specimen 
retrieval.

WARNING Biopsy procedures must only be performed on live images. 
Failure to follow these instructions could result in repeated 
biopsies or patient injury.

WARNING Ensure that all guide parts are seated properly prior to 
performing a biopsy. Failure to follow these instructions could 
result in repeated biopsies or patient injury.
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Post Biopsy

When the biopsy is complete, remove the needle barrel, needle 
clip and probe sheath.  Properly dispose of these items in 
accordance with current facility guidelines.

Clean and disinfect the probe. See ‘Probe Reprocessing’ on 
page 11-18 for more information.

The biopsy bracket can be cleaned and disinfected in a 
recommended disinfecting agent and reused.

WARNING When the biopsy needle guide kit is opened, all parts must be 
discarded after the procedure whether they have been used or 
not. Failure to follow these instructions could result in repeated 
biopsies or patient injury.
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Probe Biopsy Reprocessing

Manual Cleaning

NOTE: Efficacy of this manual cleaning process has been shown using 
ENZOL Enzymatic Detergent.

1. Remove the biopsy guide and protective sheath(s) from the 
probe.

2. Whenever possible the biopsy guide should be rinsed 
immediately after use. If the biopsy guide cannot be cleaned 
immediately after use, maintain moisture by placing them in 
a clean container. Cover the container with a towel 
dampened with purified water. Devices may remain in this 
condition for a maximum of 4 hours.

3. Remove all visible soil. Flush the biopsy guide using potable 
water (30 - 40°C) for not less than 2 minutes.

4. Prepare an enzymatic detergent safe for use with metal 
instruments according to the manufacturer’s 
recommendations, using potable water.

5. Submerge the biopsy guide in the prepared solution and 
soak for no less than 2 minutes.

6. After the 2-minute soak, while the biopsy guide is 
submerged in the detergent water, vigorously scrub the 
device with a soft nylon bristle brush.

7. Use a round nylon cleaning brush to clean the biopsy lumen. 
Use a syringe to flush detergent water through the lumen. 
Scrub the device for a minimum of 2 minutes.

8. Remove the device from the detergent water and rinse 
thoroughly in running potable water (30 - 40°C) taking care 
to remove any visible detergent. Rinse the device for a 
minimum of 1 minute. 

9. Visually inspect the device for any residual soil or detergent. 
Repeat steps 6 through 8 until the device is visibly clean.



Probes and Biopsy

11-82 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

High-Level Disinfection

NOTE: High-Level disinfection efficacy of this manual process has been 
shown using Cidex OPA.

1. Fill a sink or basin with high-level disinfectant prepared in 
accordance with the disinfectant manufacturer’s instructions 
to a level allowing immersion of the biopsy guide.

2. Immerse the devices in the disinfectant solution and agitate 
to ensure all air bubbles are removed from the surface of the 
device.

3. Allow the devices to soak in the disinfectant solutions for 
least the minimum contact time listed in the disinfectant 
manufacturer’s instructions for use.

4. Thoroughly rinse the device by immersing in a large volume 
of critical (purified) water for a minimum of 1 minute. 

5. Repeat Step 4 two additional times, for a total of 3 (three) 
rinses using fresh volumes of water for each rinse.

6. Thoroughly dry the biopsy guide using a sterile, lint-free 
wipe. Visually inspect the biopsy guide to ensure all 
surfaces are clean and dry.

Autoclave Sterilization

NOTE: Sterilization efficacy testing was performed using worst-case 
parameters for time, temperature and load density. Parameters 
listed in the tables are the minimum required to ensure a Sterility 
Assurance Level (SAL) of 10-6 or better.

1. Place the cleaned and disinfected biopsy guide in an 
approved autoclave pouch.

2. Autoclave using the following parameters: 

Table 11-13:  Autoclave parameters

Parameter Cycle Type 1 Cycle Type 2

Sterilizer Pre-vacuum Pre-vacuum

Preconditioning Pulses 3 3

Temperature (Minimum) 132 degrees C 121 degrees C

Exposure Time (Minimum) 3 Minutes 20 Minutes

Drying Time (Minimum) 15 Minutes 15 Minutes

Package Configuration Tyvek Pouch (14 x 25 cm) Tyvek Pouch (14 x 25 cm)
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Surgery/Intra-operative Use

Preparing for Surgery/Intra-operative Procedures

Preparing the transducer for intra-operative use follows the 
same sterile procedure as for biopsy use except that no biopsy 
attachments are used. See ‘Preparing the Biopsy Guide 
Attachment’ on page 11-58 for more information. Sterile gel is 
applied to the transducer face and a sterile sheath completely 
covers the transducer and cable which has first undergone a 
thorough cleaning and high-level disinfection.

The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission.  Equipment must be cleaned as appropriate for 
the procedure prior to use.

CAUTION For surgery/intra-operative procedures, a sterile environment is 
required. Therefore, both the operator and probe sheath needs 
to be sterile.
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Preparing for Surgery/Intra-operative Procedures  (continued)

To ensure a sterile environment during the procedure, it is 
recommended that this be a two-person job. 

1. Perform a high level disinfection of the probe. 

2. The scanner (surgeon, sonographer, etc.) should be sterile 
and gloved.

3. Place an adequate amount of sterile coupling gel on the 
face of the probe.

4. Place the proper sterile sheath over the probe and cord.

Figure 11-47. Applying Sterile Sheath

5. Depending on the type of procedure, use either sterile water 
or sterile gel on the sheath cover.

NOTE: Follow your institutions guidelines on post surgery/
intra-operative procedures for probe cleaning and disinfection.
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Chapter 12

User Maintenance

This chapter supplies system data, assistance 

information, and system care and maintenance 

instructions. 
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System Data

Features/Specifications
Table 12-1:  Physical Attributes

Dimensions and Weight (for Transport)

• Height: 1250 - 1800 mm, 49 - 71 in (HDU display), 

1210 - 1760 mm, 48 - 69 in (LCD display)

• Width: 530mm, 20.9 inch (Caster), 545mm, 21.5 

inch (LCD display), 565mm, 22.2 inch (HDU 

display)

• Depth: 885mm, 34.8 inch 

• Weight: 85 kg (187.4 lb.)

User interface

• Operating keyboard adjustable in height and 

rotation 

• Ergonomic hard key layout

• Interactive Back-Lighting

• Integrated recording keys for remote control of up 

to 4 peripheral or DICOM devices

• Integrated Gel Warmer (Option) 

Electrical Power

• Voltage:100 - 240 Vac

• Frequency: 50/60 Hz

• Power consumption maximum of 0.9 KVA with 

peripherals.

Touch Screen 

• 12.1 in High Resolution, Color, Touch, Display 

screen

• Interactive, dynamic software menu

• Brightness adjustment

• User-configurable layout

Console Design

• 4 Active Probe Ports, 1 Inactive Probe Storage 

Port

• Integrated SSD (1TB)

• Integrated DVD-R Multi Drive

• On-board storage for peripherals: Thermal printer. 

• Integrated speakers

• Integrated locking mechanism that provides rolling 

lock and caster swivel lock 

• Integrated cable management

• Front and Rear handles

• Easily-removable air filters

HDU Display

• 23.8” Wide screen High-Resolution HDU Display

• Monitor translation: 350mm, 13.7 in. horizontal; 

120mm, 4.7 in. vertical; 90 degree swivel 

• Fold-down and Lock Mechanism for transport

• Brightness & contrast adjustment

• Resolution 1920 x 1080

• Anti Glare

• Viewing Angle 89/89/89/89 degrees

LCD Display

• 23.8” Wide screen High-Resolution LCD Display

• Monitor translation: 350mm, 13.7 in. horizontal; 

120mm, 4.7 in. vertical; 90 degree swivel 

• Fold-down and Lock Mechanism for transport

• Brightness & contrast adjustment

• Resolution 1920 x 1080

• Anti Glare

• Viewing Angle 89/89/89/89 degrees
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Table 12-2:  System Overview

Applications

• Abdominal

• Obstetrical

• Gynecological

• Breast

• Small parts

• Peripheral Vascular

• Transcranial (Adult and neonatal)

• Pediatric and neonatal

• Musculoskeletal (general and superficial)

• Urological

• Cardiac (adult and pediatric)

Operating modes

• B-Mode

• M-Mode

• Color Flow Mode (CFM)

• B-FLow (Option)

• Extended field of view (LOGIQView)

• Power Doppler Imaging (PDI)

• PW Doppler

• CW Doppler (Option)

• Volume Mode (3D/4D) (Option)

• 3D Static

• 4D Real Time

• Anatomical M-Mode

• Coded Contrast Imaging (Option)

• Strain Elastography

• Shear Wave Elastography (Option)

• UGAP (Option)

Scanning methods

• Electric sector

• Electric convex

• Electric linear

• mechanical volume sweep

Transducer Types

• Sector Phased Array

• Convex Array

• Micro convex Array

• Linear Array

• Matrix Array

• Volume probe (4D)

• Split Crystal

Standard Features

• Advanced user interface with high resolution 12.1 

inch touch screen

• Automatic Optimization 

• CrossXBeam

• Advanced Speckle Reduction Imaging 

• Fine Angle Steer 

• Coded Harmonic Imaging

• Virtual Convex

• Patient information database

• Image Archive on integrated CD/DVD and Hard 

Drive

• Advanced 3D

• Raw Data Analysis

• Real-time Automatic Doppler Calculations

• OB Measurements/Calculations

• Fetal Trending

• Multigestational Calculations

• Hip Dysplasia Calculations

• Gynecological Calculations

• Vascular Calculations

• Urological Calculations

• Renal Calculations

• Cardiac Calculations

• InSite Capability

• On-board electronic documentation

• Auto Doppler Assist

• Privacy and Security, including user and rights 

management

• LOGIQView

• Breast Productivity Package

• Thyroid Productivity Package

• External USB Printer connection 

• Network Printer Support 

• HDMI output available for compatible devices
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Options

• Tricefy

• DICOM

• B-Flow

• Auto IMT

• Compare Assistant

• Scan Assistant

• OB Measure Assistant

• Color Quantification

• Strain Elastography

• Advanced Privacy & Security (Vulnerability Scan)

• Power Assistant and Scan on Battery

• Storage Bins

• SonoNT/SonoIT

• Advanced SRI-HD Type 2

Peripheral Options

• Integrated Options

• Digital B&W thermal printer

• DVD vide recorder

• Digital color thermal printer

• Digital A6 color thermal printer

• Foot switch, with programmable functionality

• Console protective cover

• LOGIQ smart device apps

• Photo Assistant

• Remote Control

• Card Reader (Japan only): Magstripe Card Reader 

for Patient Screen, Worklist and Image Display.

Display Modes

• Live and Stored Display Format: Full and Split 

Screen -- both with thumbnails for Still and CINE

• Review Image Format: 4x4 and Thumbnails for 

Still and CINE

• Time line Display [Independent Dual B or 

CrossXBeam/PW Display; CW; Display Formats; 

Top/Bottom or Side/Side selectable Format; 2 

Timeline Methods: Scrolling or Moving Bar

• Virtual Convex

• Simultaneous Capability [B or CrossXBeam/PW, B 

or CrossXBeam/CW (Option), B or CrossXBeam/

CFM or PDI, B/M, B/CrossXBeam, Realtime 

Triplex Mode [B/CrossXBeam + CFM/PDI + PW]

• Selectable alternating Modes [B or CrossXBeam/

PW; B or CrossXBeam + CFM (PDI)/PW; B/CW 

(option)]

• Multi Image Split/Quad Screen [Live and/or 

Frozen, B or CrossXBeam+B or CrossXBeam/

CFM or PDI, PW/M, Independent Cine playback] 

Table 12-2:  System Overview (Continued)
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Table 12-3:  System Parameters

Controls Available on Freeze or Recall

• Automatic Optimization

• SRI-HD

• CrossXBeam (display non-compounded and 

compounded image simultaneously in split screen)

• 3D Reconstruction from a stored CINE loop

• B/M/CrossXBeam Mode (Gray Map Optimization; 

TGC, Colorized B and M; Frame Average [Loops 

only]; Dynamic Range)

• Anatomical M-Mode

• Magnification Zoom

• Pan Zoom

• Baseline Shift

• Sweep speed

• PW-Mode (Gray Map; Post Gain; Baseline Shift; 

Sweep Speed; Invert Spectral Waveform; 

Compression; Rejection, Colorized Spectrum; 

Display Format; Angle Correct; Quick Angle 

Correct, Auto Angle Correct, Doppler Audio)

• Color Flow (Overall Gain [Loops and Stills]; Color 

Map; Transparency Map; Frame Averaging [Loops 

only]; Flash Suppression, CFM Display Threshold; 

Spectral Invert for Color/Doppler)

• Anatomical M-Mode on CINE Loop

• 4D (Gray Map, Colorize; Post Gain; Change 

display between single or rendered)

Controls Available While “Live”

• Magnification Zoom: Magnifies the entire image on 

the screen without zoom ROI

• Pan Zoom: Magnifies the display of the data within 

the ROI

• HD Zoom: Magnifies the image within the zoom 

ROI, with higher spatial resolution than original 

images

• B/M/CrossXBeam-Mode (Gain; TGC; Dynamic 

Range; Acoustic Output; Frame Rate Control, 

Sweep Speed for M-Mode; # of Angles for 

CrossXBeam)

• PW-Mode (Gain; Dynamic Range; Acoustic 

Output; Transmission Frequency; PRF; Wall Filter; 

Spectral Averaging; Sample Volume Gate for 

PW-Mode Length and Depth; Velocity Scale)

• Color Flow (CFM Gain; CFM Velocity Range; 

Acoustic Output; Wall Echo Filter; Frame Rate 

Control; CFM Spatial Filter; CFM Frame 

Averaging; CFM Line Resolution; Frequency/

Velocity Baseline Shift) 

Connectivity 

• Ethernet network connection

• Wireless LAN 802.11ac/a/b/g/n (option)

• DICOM 3.0 (option) with Verify, Print, Store, 

Modality Worklist, Storage Commitment, Modality 

Performed Procedure Step [MPPS], Media 

Exchange, Off network/mobile storage queue, 

Query/Retrieve)

• Public SR Template

• Structured Reporting - compatible with Vascular, 

OB, Cardiac, and Breast standard

• InSite capability

• Advanced privacy and security (Option)

Scanning Parameters

• Displayed Imaging Depth: 0-50cm [Minimum: 0-2 

cm (Zoom); Maximum: 0-50 cm] (Probe 

dependent)

• Continuous Dynamic Receive Focus/Continuous 

Dynamic Receive Aperture

• Adjustable Dynamic Range

• Adjustable Field of View (FOV)

• Image Reverse: Right/ Left

• Image Rotation: 0, 90, 180, 270 degrees

Image Storage 

• On-board database of patient information from 

past exams

• Storage Format: DICOM (compressed/

uncompressed, single/multiframe, enhanced [3D/

4D], with/without Raw Data), Export JPEG, and 

WMV (MPEG4)

• Storage Devices: USB Memory Stick (64MB to 

64GB, for exporting individual images/clips); CD-R 

Storage (700MB); DVD-R Storage (4.7GB); Hard 

Drive Image Storage (~730GB)

• Compare previous exam images with current 

exam

• Reload of archived data sets

CINE Memory/Image Memory 

• 1 GB of CINE Memory

• Selectable CINE Sequence for CINE Review

• Prospective CINE Mark

• Measurements/Calculations & Annotations on 

CINE Playback 

• Scrolling timeline memory

• Dual Image CINE Display

• Quad Image CINE Display

• CINE Gauge and CINE Image Number Display

• CINE Review Loop

• CINE Review Speed
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Table 12-4:  Measurements and Calculations

B-Mode

• Depth and Distance

• Circumference and Area (Ellipse/Trace)

• Volume (Ellipsoid)

• Angle between 2 Lines

• % Stenosis (Area or Diameter)

• Dual B-Mode capability

M-Mode

• M Depth and Distance

• Time 

• Slope

• Heart Rate

Doppler Measurements/Calculations

• Velocity

• Time

• Peak Systole

• End Diastole

• Acceleration

• Acceleration Time

• Ratios

• A/B Ratio (Velocities/Frequency Ratio)

• Peak Systole/End Diastole (PS/ED Ratio)

• End Diastole/Peak Systole (ED/PS Ratio)

• Heart Rate

• TAMAX (Time Averaged Maximum Velocity) 

• Volume Flow [TAMEAN and Vessel Area]

• PI (Pulsatility Index)

• RI (Resistivity Index)

Shear Wave Measurements/Calculations

• Stiffness

• Velocity

Vascular Measurements/Calculations

• Carotid, Vertebral, Subclavian Measurements, 

Auto IMT

• Summary Worksheet

• Summary Report

Small Part Measurement Analysis

• Koios DS Breast Lesion Decision Support

• Koios DS Thyroid Lesion Decision Support

Obstetrics Measurements/Calculations

• Gestational Age Calculation

• Calculations and Ratios

• EFW Calculation

• Growth Percentiles

• Multi-Gestational Calculation

• Fetal Qualitative Description (Anatomical Survey)

• Fetal Environmental Description (Biophysical 

profile)

• Programmable OB Tables

• Fetal Graphical Trending

• Measurements / Calculations by: ASUM, ASUM 

2001, Alexander, Bahlmann, Baschat, Berkowitz, 

Bertagnoli, Brenner, Campbell, CFEF, Chervenak, 

Chitty, Doubilet, Ebbing, Eik-Nes, Ericksen, 

Goldstein, Hadlock, Hansmann, Hellman, Hill, 

Hohler, Jeanty, JSUM, Kurmanavicius, Kurtz, Mari, 

Mayden, Mercer, Merz, Moore, Nelson, Osaka 

University, Paris, Pexsters, Rempen, Robinson, 

Shepard, Shepard/Warsoff, Sonek, Tokyo 

University, Tokyo/Shinozuka, WHO, Yarkoni

• Over 20 selectable OB Calcs

• Summary Worksheet

• Summary Report

Gynecology Measurements/Calculations

• Ovarian, Uterine, Pelvic Floor, Endometrium, 

Follicular Measurements, Cervix

• Summary Worksheet

• Summary Report

• Qualitative Description (Anatomical Survey)

Urology Measurements/Calculation

• Bladder, Prostate, Renal, Generic, Post-Void 

Bladder Volume Measurements

• Summary Worksheet

• Summary Report

Cardiology Measurements/Calculations

• Cardiology Measurements and Calculations

• Summary Worksheet

• Summary Report

Table 12-5:  Biopsy Guides

• Single-Angle, disposable with a reusable bracket

• Multi-Angle, disposable with a reusable bracket

• Single-Angle, disposable with a disposable bracket

Table 12-6:  Inputs and Outputs Signal

• HDMI (with stereo audio)

• S-Video 

• Ethernet

• Multiple USB 3.0 ports
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Clinical Measurement Accuracy

Basic Measurements

The following information is intended to provide guidance to the 
user in determining the amount of variation or measurement 
error that should be considered when performing clinical 
measurements with this equipment.  Error can be contributed by 
equipment limitations and improper user technique.  Be sure to 
follow all measurement instructions and develop uniform 
measurement techniques among all users to minimize the 
potential operator error.  Also, in order to detect possible 
equipment malfunctions that could affect measurement 
accuracy, a quality assurance (QA) plan should be established 
for the equipment that includes routine accuracy checks with 
tissue mimicking phantoms.

Please be advised that all distance and Doppler related 
measurements through tissue are dependent upon the 
propagation velocity of sound within the tissue.  The propagation 
velocity usually varies with the type of tissue, but an average 
velocity for soft tissue is assumed.  This equipment is designed 
for, and the accuracy statements listed on are based on, an 
assumed average velocity of 1540 m/s.  The percent accuracy 
when stated applies to the measurement obtained (not the full 
scale range).  Where the accuracy is stated as a percent with a 
fixed value, the expected inaccuracy is the greater of the two.
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Basic Measurements  (continued)

Table 12-7:  System Measurements and Accuracies

Measurement Units Useful Range Accuracy

Limitations or 

Conditions

Depth mm Full Screen ±20%

Distance:

Axial (Equal to 

1540m/s)

mm Full Screen ±3% or ±1mm, 

whichever is greater

Lateral (Equal to 

1540m/s)

mm Full Screen ±5% or ±1mm, 

whichever is greater

Linear Probes

Lateral (Equal to 

1540m/s)

mm Full Screen ±6.5% or ±3.5mm, 

whichever is greater

Convex Probes

Lateral (Equal to 

1540m/s)

mm Full Screen ±5% or ±1mm, 

whichever is greater

Sector Probes

Axial/Lateral  (Not 

Equal to 1540m/s)

mm Full Screen ±7.5% or ±5.0mm, 

whichever is greater 

All probes Not 

Equal To 1540m/s

Circumference:

Trace (Equal to 

1540m/s)

mm Full Screen ±5% or ±1mm, 

whichever is greater

Ellipse (Equal to 

1540m/s)

mm Full Screen ±5% or ±1mm, 

whichever is greater

Trace  (Not Equal 

to 1540m/s)

mm Full Screen ±7.5% or ±5mm, 

whichever is greater

All probes Not 

Equal To 1540m/s

Ellipse  (Not Equal 

to 1540m/s)

mm Full Screen ±7.5% or ±5mm, 

whichever is greater

All probes Not 

Equal To 1540m/s

Area:

Trace (Equal to 

1540m/s)
mm2 Full Screen ±10% or ±5mm2, 

whichever is greater

Ellipse (Equal to 

1540m/s)
mm2 Full Screen ±10%, or ±5mm2, 

whichever is greater

Trace (Not Equal 

to 1540m/s)
mm2 Full Screen ±20% or ±20mm2, 

whichever is greater

All probes Not 

Equal To 1540m/s

Ellipse (Not Equal 

to 1540m/s)
mm2 Full Screen ±20% or ±20mm2, 

whichever is greater

All probes Not 

Equal To 1540m/s

Time s Timeline Display ±5%, not to exceed 

10ms

M or Doppler 

Mode

Slope mm/s Timeline Display ±5%, not to exceed 

1mm/s

M-Mode Only
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Doppler Sample 

Volume Depth (SVD)

mm Full Screen 2mm (0.2cm) in any 

direction

When SVD is at 

least half the 

depth of the image

Velocity cm/s Full Range 10% PW and CW 

Doppler Mode

Doppler Angle 

Correction

degrees From 0-59°

From 60-90°

±1%

±2%

Shear Wave Elastography Velocity/Stiffness Measurements 

Velocity m/s Shear wave ROI ±10%, or 0.5 m/s, for 

the 9L-D and ±15%, 

or 0.5 m/s, for the 

C1-6-D, C1-6VN-D, 

L2-9-D and 

L2-9VN-D, whichever 

is greater over the 

range of depths for 

which measurements 

can be made, limited 

by shear wave 

penetration. 

SD less than or 

equal to 5% for 

multiple repeated 

measurements 

over the range of 

depths for which 

measurements 

can be made, 

limited by shear 

wave penetration. 

Stiffness kPa Shear wave ROI ±20%, or 0.75 kPa, 

for the 9L-D and 30%, 

or 0.75 kPa, for the 

C1-6-D, C1-6VN-D, 

L2-9-D and 

L2-9VN-D, whichever 

is greater over the 

range of depths for 

which measurements 

can be made, limited 

by shear wave 

penetration. 

SD less than or 

equal to 10% for 

multiple repeated 

measurements 

over the range of 

depths for which 

measurements 

can be made, 

limited by shear 

wave penetration. 

The formula for Stiffness: E = 3 * rho * c2 

Where E = Young’s modulus of tissue

rho = density of tissue (assumed to be 1 g/cc)

c = shear wave speed in m/s

Note: The conversion from shear wave speed (m/s) to Young’s modulus is done under the assumption that 

the underlying material in which the shear wave propagates is linear, isotropic, incompressible, and 

homogenous. 

Table 12-7:  System Measurements and Accuracies (Continued)

Measurement Units Useful Range Accuracy

Limitations or 

Conditions
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Clinical Calculation Accuracy

Estimate the overall inaccuracy of a combined measurement 
and calculation by including the stated inaccuracy from the basic 
measurement accuracy statements.

Calculation formulas and databases are provided as a tool to 
assist the user, but should not be considered an undisputed 
database, in making a clinical diagnosis.  The user is 
encouraged to research the literature and judge the equipment 
capabilities on an ongoing basis in order to assess its utility as a 
clinical tool.
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V Nav Magnetic Field Data

For the Patient

Electromagnetic Field Strength is measured in units called 
Tesla, or for smaller fields, milliTesla (mT). According to this 
article from the World Health Organization (WHO), https://
www.who.int/peh-emf/publications/facts/fs299/en/, people with 
pacemakers should avoid fields that exceed 0.5 mT. 

The electromagnetic field created by the transmitter in our 
Volume Navigation offering is 0.5 mT once you are 7.5cm away 
from the transmitter face and goes down quickly after that (0.1 
mT at 18cm away, e.g.). Nevertheless, we recommend not using 
V Nav on patients relying on a pacemaker or defibrillator. 

DANGER
 

DO NOT use the Volume Navigation feature on any patient 
relying on life-sustaining electronic equipment, such as a 
pacemaker or defibrillator. Failure to follow this instruction 
could lead to interference with patient electronic device(s).

WARNING The Tracker’s magnetic fields may possibly interfere with 
nearby electrical systems, e.g., an EKG. It is the users’s 
responsibility to identify nearby devices to ensure their 
performance is not degraded when you are simultaneously 
using Volume Navigation. 
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V Nav Magnetic Field Data  (continued)

For the Operator

The World Health Organization website addresses many items 
regarding exposure to electro-magnetic (EM) fields at http://
www.who.int/peh-emf/about/WhatisEMF/en/index.html (see 
extract below). 

Extracted from 

World Health 

Organization: 

“Many people are surprised when they become aware of the 
variety of magnetic field levels found near various appliances. 
The field strength does not depend on how large, complex, 
powerful or noisy the device is. Furthermore, even between 
apparently similar devices, the strength of the magnetic field 
may vary a lot. For example, while some hair dryers are 
surrounded by a very strong field, others hardly produce any 
magnetic field at all. These differences in magnetic field strength 
are related to product design. The following table shows typical 
values for a number of electrical devices commonly found in 
homes and workplaces. The measurements were taken in 
Germany and all of the appliances operate on electricity at a 
frequency of 50 Hz. It should be noted that the actual exposure 
levels vary considerably depending on the model of appliance 
and distance from it.”   

In the context of this, the VNav transmitter has the following EM 
field strengths at various distances from the transmitter face: 

• 928µT at 5.1cm (2 inches) distance

• 287µT at 10.2cm (4 inches) distance

• 64µT at 20.3cm (8 inches) distance

• 11µT at 40.6cm (16 inches) distance

• 2.4µT at 71cm (28 inches) distance

NOTE: Note that the field is only active when the green light on the 
position sensing electronics unit is on. This is the same unit that 
the transmitter plugs into.
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V Nav Magnetic Field Data  (continued)

Typical Magnetic Field Strength Data

Typical magnetic field strength commonly found in your home 
are shown below:  

Table 12-8:  Typical magnetic field strength of household appliances at various 
distances

Electric Appliance

3 cm   Distance

( µT )

30 cm Distance

( µT )

1 m Distance

( µT )

Hair Dryer 6 – 2000 0.01 – 7 0.01 – 0.03

Vacuum Cleaner 200 – 800 2 – 20 0.13 – 2

Portable Radio 16 - 56 1 < 0.01

Microwave Oven 73 - 200 4 - 8 0.25 - 0.6

Fluorescent Light 40 – 400 0.5 - 2 0.02 - 0.25

Electric Oven 1 - 50 0.15 - 0.5 0.01 - 0.04



User Maintenance

12-14 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Privacy and Security

Introduction

Privacy & Security considerations, capabilities and configuration 
of the LOGIQ Fortis Ultrasound System are described in the 
LOGIQ Fortis Privacy and Security Manual, available in the GE 
Healthcare Product Security Portal at the GE Documentation 
Library website at: 

https://www.gehealthcare.com/support/documentation

Privacy & Security Environment

The GE Healthcare LOGIQ Fortis Ultrasound System has been 
designed for an intended use with the following expectations of 
Privacy & Security protections included in the environment 
where this product will be used:

• The system should be connected to a secured LAN or 
VLAN, configured and segmented according to appropriate 
networking best practices, not open to unintended users or 
generally connected to a WAN.

• The LOGIQ Fortis Ultrasound System should be physically 
secured in such a way that it is not accessible to unintended 
users.

• Default application users and passwords should be replaced 
with customized users and passwords.

• External media containing images, patient data, reports and 
logs should be secured. When no longer used, the data 
should be securely erased and/or the media should be 
securely deleted.

• The monitors of the LOGIQ Fortis Ultrasound System 
should be placed in a way limiting the visibility of the screen 
content to the user only.
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Identity Provisioning

The provisioning of user accounts includes the steps of account 
creation, maintenance, and suspension of the account when it is 
no longer needed. A user account is created for the use by a 
specific individual. It is associated with access rights.

Management of user accounts

User accounts are created, maintained and suspended by users 
with administrator privileges. When received from factory the 
system has three predefined user accounts:

• “ADM”: an administrative user account 

• “USR”: a normal user account template without 
administrative privileges

• “EUSR” : an emergency user account template with limited 
privileges

When receiving the LOGIQ Fortis Ultrasound System, it is 
recommended to do the following steps to ensure control of the 
user accounts on the system:

• Change the password of the “ADM” account.

• Change the password of the “USR” user account.

• Create groups for local or LDAP users and set their rights/
privileges appropriately for your workflows and operating 
environment.

• Create user accounts for each individual user of the system:

• Give each user the needed group memberships / 
privileges.

• Make sure to give administrative privileges only to users 
intended to perform administrative tasks on the system, 
like configuring dataflows, managing users on the 
system, inspecting audit logs etc. As administrative 
privileges may give the user access to privacy and 
security related configurations on the system, there 
should be a limited number of users with these 
privileges.

• It is recommended to create individual users for each 
user of the system. This is particularly relevant for the 
audit logging, to associate actions performed on the 
system with individual persons. 
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Identity Provisioning  (continued)

Maintenance of user accounts

It is recommended to establish administrative routines for 
removing user accounts no longer being used.

User information stored on the system

The following information can be entered for a user defined on 
the system:

• User ID / User name (Required)

• Display ID (Optional)

• Last name (Required)

• First name (Optional)

• Title (Optional)

• Phone number (Optional)

• E-mail address (Optional)

• Address (Optional)

The user password is encrypted and not accessible in the 
system.

User name and password restrictions

The restrictions for usernames and passwords are:

• User names can be 1 - 32 characters long.

• Password can be 0 - 256 characters long.

It is recommended to enable and configure username and 
password policies as described below.

Identity provisioning by use of Backup/Restore

Users defined on a system can be copied from one system to 
another by use of the system’s built-in Backup/Restore 
functionality.

Network Infrastructure

The infrastructure of the network where the LOGIQ Fortis 
Ultrasound System is connected must be configured to allow 
traffic. For information on inbound and outbound firewall 
configuration, refer to the LOGIQ Privacy and Security Manual,  
available in the GE Healthcare Product Security Portal at: 

https://www.gehealthcare.com/en-US/security
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Anti-Virus Software Note

LOGIQ Fortis Security

Since the LOGIQ systems are integrated into your IT-network, 
GE wants to make sure that you are aware of the proactive 
measures we are taking to secure the system. Below are 
measures we have implemented to secure the LOGIQ systems. 

• Use of Windows* Embedded Standard 10, a componentized 
version of Windows 10 specifically made for embedded 
systems. Only the components required are used for the 
LOGIQ scanners, thereby reducing the OS attack surface. 
Please note that Windows 10 ioT Enterprise is NOT the 
same operating system as Windows 10.

• Disabled the user’s ability to access the internet and 
Windows desktop.

• Disabled, or made inaccessible, functionality that is typically 
used as malware vectors for spreading viruses (e.g. email 
services, web browsers).

• Disabled AutoRun functionality on removable media.

• Closed network entry points that are not in use by the 
LOGIQ scanner software by strict firewall configuration and 
by disabling Services. The only Internet connection needed 
is on outbound port to GE’s remote service platform 
(Insite™  ExC), which is only opened on request by the user 
and through a secure HTTPS connection (port 443), and 
inbound and outbound connections through port 104 for 
DICOM connectivity.
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LOGIQ Fortis Security  (continued)

• System provides user access controls under customer 
management to control scanner access.

• Uses secure integration and communication between 
systems (Scanners, Workstations and Servers).

• Monitor public security bulletins from software vendors and 
news services, analyze for applicability to the LOGIQ 
scanner, and include third party software security patches 
as necessary within GE software.

• Release GEHC Ultrasound validated software or use other 
measures as necessary to resolve or mitigate product 
vulnerabilities.

• Assess potential vulnerabilities of our systems using 
up-to-date commercially available vulnerability scanning 
tools. Identified vulnerabilities are mitigated as appropriate 
based on risk assessment of the product.

GE believes that this Defense in Depth strategy using the 
combination of the security measures above and the security 
standards of Microsoft Windows 10 ioT Enterprise will provide 
security against malware, especially for a system used in a 
professional hospital grade networking environment that itself 
should provide a high level of security measures.

Finally, a few points as to why GE (as well as all other 
manufacturers of PC-based medical Ultrasound devices) do not 
use Anti-Virus software: Commercial Anti-Virus software is 
commonly used on general-purpose computers to detect the 
presence of malicious software (e.g. virus, Trojan horse, worm). 
Anti-Virus software is useful on general-purpose computers as 
they typically cannot be sufficiently hardened against the attack 
vectors used by malicious software.
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LOGIQ Fortis Security  (continued)

The LOGIQ ultrasound systems however are single purpose 
(dedicated) devices that have controlled intended use, and thus 
are well hardened. For the LOGIQ ultrasound systems, the 
potential patient safety and security risks introduced by using 
commercial Anti-virus software would outweigh the security 
benefits.  Such risks include:

• Real-time anti-virus scanning can affect ultrasound system 
performance.

• The effectiveness of Anti-Virus software depends on regular 
updates of the virus definitions files. This would typically 
require internet connectivity for the ultrasound system. 

• The Anti-Virus software itself is a popular attack vector.

• Disruptive nature of the support of the Anti-Virus software 
throughout the life cycle of the medical device. The 
operating system of a medical ultrasound system is part of a 
medical device that requires a special and controlled 
release process. Any update of the Anti-Virus software 
would require a change of the system software.

Due to the cited risks, the use of commercial anti-virus software 
is not part of the LOGIQ systems product security strategy.

*Microsoft and Windows are trademarks of Microsoft Corporation.
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Loading Windows Patches

Loading a Windows Patch

As part the product lifecycle management, GE regularly 
analyzes and integrates software updates from our third party 
vendors into our products. These are typically released as part 
of regular updates or software releases.

To load a Windows patch onto the LOGIQ Fortis:

1. Power down the LOGIQ Fortis and insert the Windows 
Patch USB Flash Drive into a rear USB port.

NOTE: Ensure that the system is USB Device Enabled (check 
setting on System Admin Utility page).

2. Power on the LOGIQ Fortis. Windows Patch files will be 
loaded onto the LOGIQ Fortis automatically, following 
several screen prompts:

a. Select Install SW... on the Start Application screen.

b. Select OK on the first StartLoader screen.

c. Select the package and then select Install on the 
second StartLoader screen; software patch installation 
will begin.

NOTE: The Patch package is installed at the root folder or 
under the SWLoad directory in the root folder of the 
USB.

Multiple screens appear during the software re-imaging 
installation process. DO NOT interrupt this process 
AND follow instructions as they appear on the display.

d. Once the installation is complete, a message displays 
saying that the “Software Installation completed 
successfully. System will reboot soon.” The LOGIQ 
Fortis restarts.

3. When the system starts up after the software installation has 
finished, the following dialog displays: the “New Software 
Verification” Checklist.
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Performing Software Patch Verification

The Software Patch Verification dialog is critical. You MUST 
perform software verification after downloading and installing a 
software update. 

a. If you are able to successfully perform each function, 
then Pass all of the items and type your name into the 
Signature box and press OK. Press the Question Mark if 
you have questions about how to perform this task.  

b. As you verify that each feature works correctly, select 
“Passed.” If all features work correctly and “Passed” is 
filled in for all features, then the signature field is 
enabled at the bottom of the New Software Verification 
Checklist. 

Type your signature (minimum of three characters) and 
press OK. The system is now ready for use.

CAUTION Perform a check for all the features listed. You MUST 
ensure that the entire system functions normally, as 
expected, in each of the categories listed on the New 
Software Verification checklist. 

These verification results are tracked for regulatory 
purposes, sent back to GE for tracking, and approved with 
your signature. 
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Performing Software Patch Verification  (continued)

The version of the installed Patch appears on the 
Utility--> System--> About page. 

c. If one of the steps fails, then Fail the item(s).  

d. Type your Signature, then press Reload. The previous 
version of software will be reloaded onto the system 
automatically.

CAUTION If any of the features DID NOT function as expected, you 
need to select “Failed” next to the feature that failed. Type 
your signature (minimum of three characters) and press 
Reload. 
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e. Load the latest system patch which should be stored 
with the software located under the LOGIQ Fortis 
covers.



User Maintenance

12-24 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Patch Installation Notes

If by accident you try to load a patch that is not compatible with 
the software on the LOGIQ Fortis, an error message will notify 
you of this incompatibility. 

If there is any issue with the media, an error message will 
indicate “The package cannot be installed. The package is not 
compatible or has been tampered. Please contact GE Service.” 

The system may reboot multiple times during patch/software 
update. 

If the software reload fails, an error message will indicate 
“Software Reload operation failed. Please contact GE Service.” 

Reloading Software

When reloading software, you will need to reload the latest 
system patches which should be stored with the software 
located under the LOGIQ Fortis covers. 
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Software Download

Overview

The LOGIQ Fortis is designed to download software updates 
when they are available. Software Download monitors, notifies, 
delivers and installs available system software updates. This 
feature requires active InSite ExC connectivity. 

When system software is available for download, a Software 
Download icon appears in the system status bar at the bottom of 
the monitor screen.

Table 12-9:  Software Download Icons

Software Download Available Icon

Software Download In Progress Icon

Software Download Paused Icon

Software Download Complete/Ready to Install Icon

Software Download Information Icon



User Maintenance

12-26 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Software Download Available

When the “Software Download Available” icon appears in the 
status bar, select the icon to bring up the following Software 
Download and Install menu. Choose the desired option.

Figure 12-1. Software Download and Install Menu

Start Software Download and Install

1. Select Start to begin the software download. The software 
download status displays in the menu and the Software 
Download in Progress icon appears in the system status bar 
at the bottom of the monitor.

Figure 12-2. Software Download in Progress

While the software is downloading, you can choose to 
pause the download, hide the Software Download and 
Install menu or stop the download. 

• Select Pause to temporarily pause the download. The 
Software Download Paused icon appears in the system 
status bar. Select the icon again to bring up the 
Software Download menu and press Resume to 
resume the download from the previous download point.
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Start Software Download and Install  (continued)

• Select Hide to hide the Software Download menu (the 
download continues in the background). The Software 
Download in Progress icon appears in the system status 
bar. Select the icon again to bring up the Software 
Download menu.

• Select Stop Download to discontinue the download 
process. The download progress is not saved, and the 
Software Download Available icon must be selected 
again to bring up the Software Download menu to 
restart the software download process.

2. When the download is complete the Software Download and 
Install menu informs you the software is ready to install.

Figure 12-3. Software Ready to Install Menu

Select Start to begin the installation. The installation begins 
and the software Installation in Progress status is displayed.     
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Start Software Download and Install  (continued)

3. New Software Verification - When the software package 
installation is complete, the system shuts down and restarts. 
When the system restarts, the New Software Verification 
checklist dialog displays. You MUST perform the new 
software verification.

Figure 12-4. New Software Verification Dialog

As you verify that each feature works correctly, select 
“Passed.” If all features work correctly and “Passed” is filled 
in for all features, then the signature field is enabled at the 
bottom of the New Software Verification Checklist. Type 
your signature (minimum of three characters) and press OK. 
The system is now ready for use.

If any of the features DID NOT function as expected, you 
need to select “Failed” next to the feature that failed. Type 
your signature (minimum of three characters) and press 
Reload.

Contact your GE Service Representative for assistance. 

CAUTION Perform a check for all the features listed. You MUST 
ensure that the entire system functions normally, as 
expected, in each of the categories listed on the New 
Software Verification checklist. 
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More Info

Select More Info from the Software Download and Install menu 
to see details about the available software download.

Figure 12-5. More Info

Remind Me Later

Select Remind Me Later to close the Software Download and 
Install Menu and download the software at a later time. The 
Software Download Available icon remains in the system status 
bar at the bottom of the monitor screen.

Decline

Select Decline to decline the software download package. A 
popup displays.    

Figure 12-6. Decline Software Download Package Popup

You can then select OK or Cancel.

• Select OK to decline the package. You must then enter a 
signature consisting of three or more characters.

OR

• Select Cancel to go back to the Software Download and 
Install menu.
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Base Image and Software Load

Base Image and Software Load Procedure

For the Base Image and Software Load procedure, refer to the 
LOGIQ Fortis Basic Service Manual.
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Copyrighted Material

Viewing Copyrighted Third Party Software License Information

The LOGIQ Fortis contains copyrighted material. For more 
information, you can view Copyrighted Third Party Open Source 
Software Licenses via the Utility-> System-> Licenses page. 

• Select Utility-> System-> Licenses

• Scroll to select the license you wish to view in the License 
Title section. Press Set. 

Figure 12-7. Third Party Software License Information

• The selected software license appears in the License 
window. Use the Set+Trackball to scroll through the license. 
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System Care and Maintenance

Overview

Refer to Section 10 of the LOGIQ Fortis Service Manual for any 
additional maintenance guidance.

The user must ensure that safety inspections are performed at 
least every 12 months according to the requirements of the 
patient safety standard IEC 60601-1. Refer to the Service 
manual, Chapter 10.

Only trained persons are allowed to perform the safety 
inspections mentioned above.

Technical descriptions are available on request.

To ensure that the unit constantly operates at maximum 
efficiency we recommend that the following procedures be 
observed as part of the customer’s internal routine maintenance 
program.

Contact the local Service Representative for parts or periodic 
maintenance inspections.

Expected Service Life Description

The expected service life for the LOGIQ Fortis system and 
probes is identified in this table: 

Table 12-10:  Expected Service Life

Equipment / Accessory Expected Service Life

LOGIQ Fortis system The expected service life for the LOGIQ Fortis is at least seven (7) 

years from the manufacturing date under the provision of regular 

maintenance by authorized service personnel.

LOGIQ Fortis Probes The expected service life for the LOGIQ Fortis probes meets or 

exceeds five (5) years from the date the probe is placed in service, 

under the provision that the customer follows the care instructions 

provided on the Probe Care Card / Accompanying LOGIQ Fortis 

Instructions for Use.
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Maintenance Schedule

Follow this Maintenance Schedule to maintain optimum system 
function and patient care: 

Table 12-11:  LOGIQ Fortis Maintenance Schedule

Monthly Weekly Daily After Each Patient

Inspect the following on 

a monthly basis: 

• Connectors on cables 

for any mechanical 

defects.

• Entire length of 

electrical and power 

cables for cuts or 

abrasions.

• Equipment for loose or 

missing hardware.

• Control panel and 

keyboard for defects.

• Casters for proper 

movement and locking 

operation. 

Clean the following on a 

weekly basis: 

• Console

• System Cabinet

• Removable 

Trackball/Trackball

• Air Filters (weekly, 

or as needed)

• Footswitch

• B/W Printer

• CD/DVD-R Multi 

Drive

• Monitor and Monitor 

Frame

• Operator Controls and 

Touch Panel

Clean and Disinfect the 

following areas where 

Cross Contamination 

can occur: 

• Operator  Panel and 

Touch Panel

• Monitor Frame

• Front and Rear 

Handles

Clean and Disinfect the 

following after each 

patient: 

• Probe

• Biopsy Bracket, as 

applicable

Additionally, Clean and 

Disinfect any area on 

the system that has 

visible contamination 

from the previous exam. 

Note: Biopsy 

Accessories must be 

cleaned and disinfected 

or disposed of after 

each patient. Refer to 

the Probes Chapter, for 

probe cleaning and 

disinfecting instructions.

DANGER
 

To avoid electrical shock hazard, do not remove panels or 
covers from console.  This servicing must be performed by 
qualified service personnel.  Failure to do so could cause 
serious injury.

If any defects are observed or malfunctions occur, do not 
operate the equipment but inform a qualified service person.  
Contact a Service Representative for information.
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Cleaning and Disinfecting the System

These cleaners/disinfectants can be used anywhere on the 
console (Operator Panel, Monitor, Probe Holders, etc.), except 
for the probes. Refer to ‘Probe Disinfectants’ on page 11-40  for 
probe disinfectant information and web links.  

Always consult the cleaner or disinfectant manufacturer’s 
instructions for proper use of their product. Wear appropriate 
PPE as indicated by the manufacturer. 

WARNING All cleaners and disinfectants NOT on this list are unapproved 
by GE. Failure to follow guidelines could result in damage to 
the device.  

CAUTION When reprocessing the operator control panel, make sure not 
to spill or spray any liquid on the controls, into the system 
cabinet, or in the probe connection receptacle.

CAUTION To avoid liquids entering the product, DO NOT spray any liquid 
directly onto the surfaces. ALWAYS use a cloth or wipe. 

CAUTION Avoid using ALCOHOL (ISOPROPANOL) 70% inside the 
trackball. ALCOHOL (ISOPROPANOL) 70% may also 
compromise the durability of the paint used on the console 
controls.

CAUTION Oxivir TB Wipes may compromise the durability of the paint 
used on the console handles and controls. Avoid the use of any 
Hydrogen Peroxide (H2O2) based disinfectants on the HDU 
monitor, as it may result in damage to screen.
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Cleaning and Disinfecting the System  (continued)

Appropriate cleaners/disinfectants for the console that have 
been validated for compatibility are shown below: 

Table 12-12:  Appropriate Cleaners/Disinfectants

Product

Manufacture

r Notes Chemistry Locale

Cleaner/

Disinfectan

t

Mild Soap Cleaner

Acryl-Des 

Wipes

Schülke & 

Mayr GmbH

Same as 

Mikrozid 

Sensitive Wipes 

also by Schulke 

Quat Europe Cleaner/

Disinfectant

Alcohol 

(Isopropanol) 

70%

Generic Alcohol Global Disinfectant

Cleanisept 

Wipes

Dr. 

Schumacher 

GMBH

Same as GE 

branded 

Septiwipe

Quat Europe Cleaner/

Disinfectant

Clinell Clorox 

Wipes

GAMA 

Healthcare

Same as Clorox 

Wipes sold in 

USA

Bleach Europe Cleaner/

Disinfectant

Clinell 

Universal 

Sanitizing 

Wipes

GAMA 

Healthcare

Quat+ 

Polyhexanide 

(PHMB)

Europe Cleaner/

Disinfectant

Clorox 

Healthcare 

Bleach 

Germicidal 

Wipes

Clorox 

Professional

Same formula as 

Clinell Clorox 

Wipes

Bleach US 

Canada 

Europe

Cleaner/

Disinfectant

Easy Screen 

Cleaning 

Wipes

Professional 

Disposables 

Inc. (PDI)

This product is 

70% IPA

Alcohol US Cleaner

Mikrobac 

Tissues

BODE Chemie 

GmbH

Quat Europe Cleaner/

Disinfectant

Mikrozid 

Sensitive 

Wipes

Schülke & 

Mayr GmbH

Same formula as 

Acryl-Des wipes

Quat Europe Cleaner/

Disinfectant

Oxivir TB 

Wipes

Sealed Air H2O2 US 

Canada

Cleaner/

Disinfectant

Protex Ultra 

Wipes

Parker 

Laboratories

Same formula as 

SONO Wipes 

Quat US Cleaner/

Disinfectant
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Sani-Cloth HB 

Germicidal 

Disposable 

Wipe

Professional 

Disposables 

Inc. (PDI)

Quat US Cleaner/

Disinfectant

Sani-Cloth Plus 

Germicidal 

Disposable 

Cloth

Professional 

Disposables 

Inc. (PDI)

Same Formula 

as Asepti Wipes 

II

Quat + Alcohol US Cleaner/

Disinfectant

Sani-Cloth 

Prime 

Germicidal 

Disposable 

Cloth

Professional 

Disposables 

Inc. (PDI)

Quat + Alcohol US Cleaner/

Disinfectant

Septiwipes EDM Medical 

Imaging

Same formula as 

Cleanisept Wipes 

Quat Europe Cleaner/

Disinfectant

Sodium 

Hypochlorite 

5.25% (Bleach) 

diluted 10:1

Generic Clorox 

Healthcare 

Bleach 

Germicidal 

Wipes

Bleach Worldwide Cleaner/

Disinfectant

SONO 

ULTRASOUND 

WIPES

Advanced 

Ultrasound 

Solutions, Inc.

Quat US Cleaner/

Disinfectant

Super 

Sani-Cloth 

Germicidal 

Disposable 

Wipes

Professional 

Disposables 

Inc. (PDI)

Quat + Alcohol US Cleaner/

Disinfectant

Tristel Distel Tristel Quat+PHMB Europe Cleaner/

Disinfectant

Trophon 

Companion 

Cleaning 

Wipes

Nanosonics Same formula as 

SONO Wipes 

Quat US Cleaner/

Disinfectant

Virox Accel TB 

wipes

Virox 

Technologies 

Inc. (owned by 

Sealed Air)

Same formula as 

Oxivir TB 

H202 CAN Cleaner/

Disinfectant

Table 12-12:  Appropriate Cleaners/Disinfectants (Continued)

Product

Manufacture

r Notes Chemistry Locale

Cleaner/

Disinfectan

t
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Console

Cleaning the LOGIQ Fortis Console 

The LOGIQ Fortis Console includes the System enclosure, 
Monitor, Monitor Frame, Operator Panel, Touch Panel, and 
Probe Holders. For Probes Reprocessing, see ‘Probe 
Reprocessing’ on page 11-18. 

Always clean visible soil from surfaces first before disinfecting 
the Console. 

Follow the cleaning/disinfecting frequency suggested in  
‘Maintenance Schedule’ on page 12-33. 

To clean the system, 

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution or 
approved cleaning/disinfecting agent.

NOTE: The cloth/wipe should be damp, not dripping wet and 
running. Moisture should not drip into the crevices anywhere 
on the console. 

NOTE: Refer to Table 12-12 on page 12-35 for a list of acceptable 
solutions to be used on the Console. 

2. Use a gentle wiping action to clean any surface on the 
console. 

3. Wipe off excess cleaning agents. 

NOTE: Do not spray any liquid directly into the unit.

NOTE: DO NOT scratch or press on the panel with any sharp objects, 
such as pencils or pens, as this may result in damage to the 
panel. 

HINTS A scrubbing action with the wipe may be necessary to help 
remove stubborn soil from the surfaces.  However be 
careful with this action over cervices and gaps in the 
surface to prevent liquid from being scraped off the wipe 
and entering the product. 
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Disinfecting the LOGIQ Fortis Console

For disinfectants to be effective, the surface must first be clean. 
Refer to ‘Cleaning the LOGIQ Fortis Console’ on page 12-37. 

ALWAYS follow the manufacturer’s instructions concerning the 
use of the disinfectant and follow the contact time to be sure the 
disinfectant’s kill claims are accomplished. 

Follow the cleaning/disinfecting frequency suggested in  
‘Maintenance Schedule’ on page 12-33. 

Disinfect the desired surfaces of the console. To prevent cross 
contamination, surfaces that are often touched during exams 
should be disinfected after every patient. To disinfect the 
system, 

1. Moisten a sterile cloth with a liquid disinfectant or remove 
pre-moistened disinfectant wipe from the container. 

2. Wet the surfaces by gently applying the cloth or wipe. Avoid 
high pressure or squeezing the wipe to avoid having the 
liquid enter the gaps and cervices of the Console. Scrubbing 
is not necessary in the disinfecting step; evenly applying the 
liquid is the goal.

3. Let the surface remain wet for the appropriate contact time. 

4. If the surface does not remain wet for the full contact time, 
apply an additional application of the disinfectant, as 
necessary, to extend the time. 

5. After the contact time has expired, remove excess liquid 
with a dry sterile cloth. 

6. To avoid disinfectant buildup, or to remove disinfectant 
residue which may cause skin irritation, perform a rinse step 
with a sterile damp cloth.

CAUTION If a cleaner/disinfectant wipe was used to clean off visible 
soil per the above section, a second, fresh cleaner/
disinfectant product should be used for the disinfectant 
step. 
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Probe Cleaning Notes

When cleaning/disinfecting probes, take care NOT to damage 
the Console with a solution that is approved for the probe but 
that IS NOT APPROVED for the Console. Refer to ‘Probe 
Disinfectants’ on page 11-40 for a list of acceptable solutions to 
be used on the Console. Refer to the Probes Chapter, for probe 
cleaning and disinfecting instructions. 

When cleaning/disinfecting probes using a spray cleaner/
disinfectant, DO NOT spray the probe while the probe is set in 
its probe holder on the Ultrasound system (1). Overspray can 
damage the TGC controls.

 Figure 12-8. DO NOT Spray a Probe While in its Holder

If you use a spray cleaner, spray AWAY from the Ultrasound 
system (2). 

If you are cleaning/disinfecting probes while they are on the 
Ultrasound system, use a wipe cleaner/disinfectant instead (3). 

CAUTION NEVER use any cleaner or disinfectant containing alcohol.
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Monitor and Monitor Frame

Monitor

To clean the Monitor:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

2. Wipe down the top, front, back, and both sides of the 
monitor. 

3. Wipe off excess cleaning agents. 

NOTE: Never use thinner, benzene, alcohol (ethanol, methanol, or 
isopropyl alcohol), abrasive cleaners, or other strong solvents, 
as these may cause damage to the monitor.

Monitor Frame

To clean the monitor frame:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

2. Wipe down the top, front, back, and both sides of the 
monitor frame. 

3. Wipe off excess cleaning agents. 

Other acceptable cleaning agents are: 

• Ammonia

• Bleach (10 to 1 ratio of water to 5% home bleach)

• Hydrogen Peroxide / Hydrogen Peroxide Wipes

NOTE: DO NOT scratch or press on the panel with any sharp objects, 
such as pencils or pens, as this may result in damage to the 
panel.
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Operator Controls and Touch Panel 

ONLY USE the following cleaners on the LOGIQ Fortis Operator 
Panel: 

• Palmolive Dishwashing Liquid (manufactured by 
Colgate-Palmolive, www.colgatepalmolive.com)

• Sani-Cloth® HB, green cap (manufactured by Professional 
Disposables International, www.wearepdi.com). NOTE: May 
cause yellowing to the operator panel and probe cabling.

• Super Sani-Cloth®, purple cap (manufactured by 
Professional Disposables International, www.wearepdi.com)

• Sani-Cloth® Prime, plum cap (manufactured by 
Professional Disposables International, www.wearepdi.com)

• Sono® Ultrasound Wipes (manufactured by Advanced 
Ultrasound Solutions, Inc, www.UltrasoundWipes.com)

• Bleach (10 to 1 ratio of water to 5% home bleach)

• Hydrogen Peroxide / Hydrogen Peroxide Wipes

DO NOT USE: 

• Cleaners or Disinfectants NOT listed above
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Cleaning the Trackball

To clean the Trackball,

1. Twist and remove the Trackball prior to cleaning both the 
Trackball and Trackball housing (1 - 3). 

2. Clean the Trackball and Trackball Housing with dry, soft 
cloth (4 - 6). 

3. After cleaning the Trackball, replace and twist the Trackball 
into the Trackball housing (7-8). 
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Other Maintenance

Cleaning the air filter

Clean the system's air filters to ensure that a clogged filter does 
not cause the system to overheat and reduce system 
performance and reliability. It is recommended the filters be 
cleaned every two weeks, but the requirements will vary due to 
your system use.

Cleaning

1. Pull the front cover of cabinet.

Figure 12-9. Remove the front cover

CAUTION Be sure to lock the wheels before cleaning the air filters to 
avoid injury by any unexpected movement of the system.

DO NOT operate the unit without the air filters in place.

Allow the air filters to dry thoroughly before re-installing them 
on the unit.
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Cleaning  (continued)

2. Pull out the air filter with the frame.

 Figure 12-10. Remove the air filter

3. Dust the filter with a vacuum cleaner and/or wash it with a 
mild soapy solution.

If washed, rinse and dry the filter before re-installation.

4. Put back the air filter with both hands and the front cover.

 Figure 12-11. Put back the air filter
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Cleaning Straoge Tray and TVTR holder

Storage Tray

1. Loosen a screw ((1) in Figure 12-12) to remove the tray 
from the console.

2. Wash the tray with mild detergent.

3. Thoroughly dry the tray using a clean, low-lint, soft cloth or 
wipe.

4. Attach the tray to the system. Screw tightly. 

Figure 12-12. Screw of the storage tray
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Cleaning Straoge Tray and TVTR holder  (continued)

TVTR Probe Holder

1. Pull the claw (Refer to Figure 3-5) to remove the probe 
holder from the console.

Figure 12-13. Pull the claw to remove

2. Wash the probe holder with mild detergent.

3. Thoroughly dry the probe holder using a clean, low-lint, soft 
cloth or wipe.

4. Put the probe holder to the original position. 
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Replacing key caps

Contact a local Service Representative when a key cap needs to 
be replaced.

For Feature Keys, the user can rearrange these keys if desired. 
Please see ‘System/User Configurable Key’ on page 10-25 for 
more information on how to remove and replace these Feature 
keycaps. 

Footswitch

To clean the footswitch:

1. Disconnect the footswitch from the LOGIQ Fortis.

2. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

3. Wipe the external surfaces of the unit then dry with a soft, 
clean, cloth.
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CD/DVD Discs

To clean medical grade CD/DVD discs:

• If the disc is dirty, you can clean it with a commercially 
available dust removal spray. Be careful not to scratch the 
disc when wiping it off.

NOTE: CD type cleaner cannot be used.

HINTS Keeping your media disc in an original media case or caddy all 
the time will prevent it from becoming dirty or damaged.
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Quality Assurance

Introduction

A good Quality Assurance Evaluation program consists of 
periodic systematic actions that provide the user with adequate 
confidence that their diagnostic ultrasound system will produce 
consistently high quality images and quantitative information.

Therefore, it is in the best interests of every ultrasound user to 
routinely monitor equipment performance.

The frequency of Quality Assurance evaluations should be 
based on user's specific needs and clinical practice.

Periodic monitoring is essential in order to detect the 
performance changes that occur through normal aging of 
system components. Routine equipment evaluations may also 
reduce the duration of exams, number of repeat exams, and 
maintenance time required.

NOTE: For information on setting up the Image Quality Check, refer to 
Image Quality Check .  

For details on system and peripheral routine preventive 
maintenance instructions, See ‘System Care and Maintenance’ 
on page 12-32 for more information.



User Maintenance

12-50 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Typical Tests to Perform

Quality assurance measurements provide results relating to 
system performance. Typically these are:

• Axial Measurement Accuracy

• Lateral Measurement Accuracy

• Axial and Lateral Resolution

• Penetration

• Functional & Contrast Resolution

• Gray Scale Photography.

With these tests, a performance baseline can be set at 
installation with the phantom in your department. Future test 
results can be compared to the baseline in order to maintain a 
record of system performance trends. 

The phantom shown is shown as a representative example of a 
phantom. You can select from any number of phantoms 
available on the market. 

Frequency of tests

Quality assurance tests are used to determine whether a 
scanner is providing the same level of performance from day to 
day.

The frequency of testing varies with the amount of system usage 
and modes to be tested. It is recommended that the user 
perform quality assurance tests at least every three months or 
every 400 patient studies. Tests should also be performed when 
a question about system performance exists.

A mobile system may require more frequent tests.

Image quality should also be tested immediately after the 
following events:

• Service calls

• System upgrades/modifications

• Dropped probe, power surge, etc. 
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Phantoms

Quality Assurance Evaluations may be done with phantoms and 
test objects that are applicable to the parameters being 
evaluated or to the user's clinical practice.

Typical phantoms are composed of material that acoustically 
mimic human tissue. Pins, anechoic and echogenic targets are 
physically positioned to provide information for a variety of tests.

The RMI 403GS phantom is shown in the illustration below as a 
representative example of a phantom. 

 Figure 12-14. Representative Phantom Example

1. Penetration

2. Axial Distance Measurement

3. Functional Resolution

4. Lateral Resolution

5. Lateral Distance Measurement

6. Axial Resolution

7. Contrast Resolution and Gray Scale Photography

8. Gray Scale Plane Targets
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Baselines

An absolute necessity for a quality assurance program is 
establishing baselines for each test or check. Baselines are 
established after the system has been verified to be working 
properly at installation or after a repair. If a probe or major 
assembly is replaced, new baselines should be generated.

Baselines can be made by adjusting system parameters to 
prescribed levels or to the best possible image. The key factor to 
remember is reproducibility. The same conditions must be 
reproduced for each periodic check.

All system parameters not displayed on the monitor should be 
recorded for the permanent record.

Periodic Checks

Periodic checks should be performed in accordance with your 
facility’s quality assurance requirements. For the data to be 
valid, periodic checks should mimic the baseline setup 
parameters.

The resulting image, when scanning the phantom exactly as 
before, should be recorded and compared to the baseline. 
When a matching image is obtained, it can be assumed that the 
system performance has not degraded from the baseline.

If a significant difference between the baseline and periodic 
check is noted, double check the system setup and repeat the 
test. If the difference between the baseline and periodic check 
persists, contact a local Service Representative.

Failing to reproduce the control settings as in the baselines will 
introduce errors in the data and potentially invalidate the results.
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Results

Lack of standardization among test instruments, the wide range 
of acceptance criteria, and incomplete knowledge regarding the 
significance of certain performance parameters prohibit the 
establishment of absolute performance criteria for these tests.

Quality Assurance Evaluation results should be compared to 
previously-recorded results. 

Performance trends can then be detected. Unacceptable 
performance or diminishing trends should be identified for 
maintenance or repair before a malfunction or inappropriate 
diagnosis occurs. 

The user should determine the best method for recording and 
archiving the baseline and periodic checks. In most cases the 
choice is hard copy.

It is important to maintain good consistent records for 
inspections that may arise, as well as to detect system 
performance trends.

System Setup

The user should tailor the tests to their particular needs. It is 
certainly not necessary to make all checks with all probes. A 
representative example, with the probes used most often by the 
customer, should be adequate in judging system performance 
trends.

Use a gray scale phantom as the scan object for the tests. 
Commercial phantoms are supplied with its own operator 
manual. Be familiar with proper phantom operating procedures 
prior to use for quality assurance evaluations.

1. Adjust image monitor. Brightness and contrast should be set 
to the normal viewing of a good gray scale image.

2. Check all recording devices for proper duplication of image 
monitor. Ensure that what is seen is what is recorded. 

3. Annotate non-displayed image processing controls. 

4. Set TGC slide pots to center (detent) position. 

5. Place focal zone marker(s) in area of interest for an 
optimum image.
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Test Procedures

The following are recommended Quality Assurance tests. A brief 
description of the test, the benefit it provides and steps to 
accomplish the test are supplied.

The importance of recording scan parameters and consistent 
record keeping cannot be stressed enough. Reproducibility to 
monitor system trends is the key to quality assurance 
evaluations.

Using the system's dual image display format is often very 
convenient and saves recording media.
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Axial distance measurements

Description

Axial measurements are the distance measurements obtained 
along the sound beam. See Figure 12-14 for more information.

Benefit

The accurate measurement of the size, depth and volume of a 
structure is a critical factor in determining a proper diagnosis. 
Most imaging systems use depth markers and/or electronic 
calipers for this purpose.

Method

Axial distance should be measured in the near, mid and far fields 
as well as in zoom. If necessary, different depths or fields of 
view can be tested.

Procedure

To measure axial distance:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets to typical depths for the probe being 
used.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the vertical pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if vertical measurements differ by 
more than 1.50% of the actual distance.
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Lateral distance measurements

Description

Lateral measurements are distance measurements obtained 
perpendicular to the axis of the sound beam. See Figure 12-14 
for more information.

Benefit

The purpose is the same as vertical measurements. 
Precisely-spaced horizontal pin targets are scanned and results 
compared to the known distance in the phantom.

Method

Lateral distance should be measured in the near, mid and far 
fields as well as in zoom. If necessary, different depths of fields 
of view can be tested.

Procedure

To measure lateral distance:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets from side to side.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the horizontal pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if horizontal measurements differ by 
more than 3mm or 3% of that distance, whichever is greater.
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Axial resolution

Description

Axial resolution is the minimum reflector separation between two 
closely-spaced objects to produce discrete reflections along the 
axis of the sound beam. It can also be monitored by checking 
the vertical size of known pin targets. See Figure 12-14 for more 
information.

Axial resolution is affected by the transmitting section of the 
system and the probe.

Benefit

In clinical imaging, poor axial resolution displays small 
structures lying close together as a single dot. This may lead to 
improper interpretation of the ultrasound image.

Procedure

To measure Axial resolution:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. 

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets to typical depths for the probe being used.

3. Press Freeze to stop image acquisition.

4. Perform a standard distance measurement of the pin 
vertical thickness at different points in the image. Record all 
images for archiving.

5. Scan the vertical pins in zoom or at different depth/scale 
factors.

6. Press Freeze to stop image acquisition; repeat the vertical 
thickness measurements of the pins and record the images 
for archiving.

7. Document the measurements for reference and future 
comparison.

Axial resolution should remain stable over time. Contact a 
Service Engineer if any changes are observed.
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Lateral resolution

Description

Lateral resolution is the minimum reflector separation between 
two closely spaced objects to produce discrete reflections 
perpendicular to the axis of the sound beam. It can also be 
monitored by checking the horizontal size of known pin targets. 
See Figure 12-14 for more information.

Lateral resolution is dependent upon the beam width produced 
by the probe. The narrower the beam, the better the lateral 
resolution.

The beam width is affected by the frequency, degree of focusing, 
and distance of the object from the face of the probe.

Benefit

Clinically, poor lateral resolution will display small structures 
lying close together as a single dot. This may lead to improper 
interpretation of the ultrasound image.

Procedure

To measure lateral resolution:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets.

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets from side to side.

3. Press Freeze to stop image acquisition and perform a 
standard distance measurement of the horizontal thickness 
of a pin at different points in the image. Record all images 
for archiving.

4. Scan the horizontal pins in zoom or at different depth/scale 
factors.

5. Press Freeze to stop image acquisition; repeat the 
horizontal thickness measurements of the pins and record 
the images for archiving.

6. Document the measurements for reference and future 
comparison. 

Pin width should remain relatively constant over time ("1mm). 
Dramatic changes in pin width may indicate beamforming 
problems. Contact a Service Engineer if beam width changes 
consistently over 2 to 3 periodic tests. 
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Penetration

Description

Penetration is the ability of an imaging system to detect and 
display weak echoes from small objects at large depths. See 
Figure 12-14 for more information.

Penetration can be affected by the system's: 

• Transmitter/receiver

• Degree of probe focusing

• Attenuation of the medium

• Depth and shape of reflecting object

• Electromagnetic interference from local surroundings. 

Benefit

Weak reflecting echoes are commonly produced from the 
internal structure of organs. Definition of this tissue texture is 
important in the interpretation of the ultrasound findings.

Method

Scan a phantom to see how echoes begin to fade as depth is 
increased. The maximum depth of penetration is the point at 
which homogeneous material in the phantom begins to lose 
brightness.

Procedure

To measure penetration:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom along the vertical pin targets to typical 
depths for the probe being used.

4. Perform a standard distance measurement from the top of 
the image displayed to the point at which homogeneous 
material in the phantom begins to lose brightness.

5. Document the depth measurement for reference and future 
comparison. 

Contact a Service Engineer if the depth of penetration shifts 
more than one centimeter (1cm) when using the same probe 
and same system settings.
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Functional resolution

Description

Functional resolution is an imaging system's ability to detect and 
display the size, shape, and depth of an anechoic structure, as 
opposed to a pin target. See Figure 12-14 for more information.

The very best possible image is somewhat less important than 
reproducibility and stability over time. Routine tests at the same 
settings should produce the same results.

Benefit

The data obtained will give a relative indication of the smallest 
structure the system is capable of resolving at a given depth.

Procedure

To measure functional resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with a vertical row of anechoic cyst 
targets to typical depths for the probe being used.

4. Evaluate the cysts at various depths for a good (round) 
shape, well-defined borders and no fill in. Remember, TGC 
slide pots are centered and should remain fixed. This may 
NOT provide optimal cystic clearing.

5. Document all results for future reference and comparison.

Contact a Service Engineer if a greatly distorted image is 
obtained.
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Contrast resolution

Description

Contrast resolution is the ability of an imaging system to detect 
and display the shape and echogenic characteristics of a 
structure. See Figure 12-14 for more information.

Specific values measured are less important than stability over 
time. Routine tests at the same settings should produce the 
same results.

Benefit

A correct diagnosis is dependent upon an imaging system's 
ability to differentiate between a cystic or solid structure versus 
echo patterns from normal surrounding tissue.

Method

A phantom with echogenic targets of different sizes and depths 
should be used.

Procedure

To measure contrast resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position. Set dynamic range to 54 db.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with echogenic targets at the depths 
available.

4. Evaluate the echogenic targets for contrast between each 
other and between the surrounding phantom material. 
Remember, TGC slide pots are centered and should remain 
fixed. This may NOT provide an optimal scan image.

5. Document all results for future reference and comparison.

Contact a Service Engineer if the echogenic characteristics or 
shapes of the targets appear distorted.
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Gray Scale photography

Description

Poor photography will cause loss of low level echoes and the 
lack of contrast between large amplitude echoes. See 
Figure 12-14 for more information.

Benefit

When photographic controls and film processors are properly 
adjusted, weak echoes, as well as strong echoes, are accurately 
recorded on film.

Procedure

1. Adjust the camera according to the manufacturer's 
instructions until the hard copy and video display are equal.

2. Scan the phantom and it's echogenic contrast targets.

3. Make a hard copy photograph of the display and compare it 
to the image on the video monitor for contrast and weak 
echo display.

4. Document all results for future reference and comparison.

Contact a Service Engineer if camera cannot duplicate what is 
on the image monitor.

NOTE: Optimization of brightness/contrast controls on the display 
monitor is imperative in order to make sure that the hardcopy 
and monitor look alike.

The display monitor is adjusted first. The hardcopy camera or 
printer is adjusted to match the display monitor.
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Setting up a Record Keeping System

Preparation

The following is needed: 

• Quality Assurance binder.

• Hard copy or electronic file of images.

• Quality Assurance Checklists. 

• Display the following information while testing quality 
assurance: 

• Acoustic Output

• Gain

• Depth

• Probe

• Dynamic Range

• Set up new patient to be the name of the test.

• Annotate the following: 

• Any control where its value is NOT displayed. 

• Significant phantom information.

Record Keeping

Complete the following: 

1. Fill out the Ultrasound Quality Assurance Checklist for each 
probe, as scheduled. 

2. Make a hard copy or archive the image. 

3. Compare images to baseline images and acceptable 
values. 

4. Evaluate trends over previous test periods. 

5. File hard copy or electronic file of images and checklist in 
Quality Assurance binder. 
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Ultrasound Quality Assurance Checklist 

Table 12-13:  Ultrasound Quality Assurance Checklist (Part 1)

Performed By Date

System Serial Number

Probe Type Probe Model Serial Number

Phantom Model Serial Number Room Temperature

Acoustic Output Gain Focal Zone

Gray Map TGC Depth

Monitor Setting

Peripheral Settings

Other Image Processing Control Settings

Table 12-14:  (Part 2)
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Image Quality Check

Image Quality Check (IQC)

Image Quality Check is intended to facilitate Image Quality 
checks during Quality Assurance Evaluations. Quality 
Assurance tests are used to determine whether a scanner is 
providing the same level of performance year after year. 

By using the same settings year after year, this ensures that the 
data collection is consistent, independently of who performs the 
test. 

This preset only includes fundamental settings for B-Mode. 
Processing modes like SRI, Harmonics, etc., are turned off. 

To do an Image Quality Check (IQC), 

1. Activate IQC via Utility--> Imaging Preset Manager--> 
Category (select the Category first). 

2. Click on the plus sign in front of IQC for Service and select 
IQC. 

3. Assign IQC to a Touch Panel key by using the right arrow 
key. 

4. Map the IQC to the location you want it to appear on the 
Touch Panel. 

5. Select Probe. Then select IQC. 
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Assistance

Supplies/Accessories

Not all features or products described in this document may be 
available or cleared for sale in all markets.

Contact the distributor, GE affiliate or sales representative for 
approved peripherals. For HCATs, contact your sales person. 
For field service replacement part numbers (FRUs), these are 
service replacement part numbers that may be either new or 
refurbished, please consult the Basic Service Manual. To order 
these, contact CARES in the US, or call service in Europe and 
Asia. 

The following supplies/accessories have been verified to be 
compatible with the system:
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Peripherals

Table 12-15:  Peripherals and Accessories

Accessory Illustration/Photo Part Number / HCAT

Onboard Printer installation kit 

(UP-D898DC)

H46612LF

Sony UP-D25M Color Printer H4911JT

HP 8210 Printer H4918RP

Footswitch, USB H46732LF

Powervar144k120v MG UPS 

UPS

N/A H4913UP

Barcode Reader USBee1000A N/A Z72692FB (Japan only)

Magstripe Card Reader Z72212FB3 (Japan only)
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Console

Table 12-16:  Console Accessories

Accessory Illustration/Photo Part Number / HCAT

English Keyboard Assembly H43342LR

Protective Cover H4918DC

Swedish Keyboard Assembly H43342LA

Norwegian Keyboard Assembly H43342LY

Greek Keyboard Assembly H43342LW

Russian Keyboard Assembly H43342LZ

German Keyboard Assembly H43342LS

French Keyboard Assembly H43342LT

Power Cord - North American H46712LW

Power Cord - Argentina H46712LP

Power Cord - Europe H46342LZ

Power Cord - UK-Ireland H46712LM

Power Cord - Switzerland H46712LS

Power Cord - Denmark H46712LT

Power Cord - Italy H46722LD

Power Cord - Israel H46712LR

Power Cord - Japan H46712LY

Power Cord - China H46722LA

Power Cord - Australia/New 

Zealand

H46712LZ
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Power Cord - India H46722LB

Power Cord - South Africa H46712LN

Power Cord - Brazil H46752LW

Power Cord - Taiwan H44512LY

High Cabinet installation kit H43342LL

Low Cabinet installation kit H43342LM

Side Cabinet Installation kit H43342LN

Option 5inch bay installation kit H43342LP

Small Probe Holder H43352LC

VERTICAL TV PROBE HOLDER H43352LD

TVTR Probe Holder Assembly H43352LE

Probe Cable Hanger H44412LA

Ethernet Protection cable H43272LJ

Option Tray H43352LF

Table 12-16:  Console Accessories (Continued)

Accessory Illustration/Photo Part Number / HCAT
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Volume Navigation

V Nav Shelf Load Description

Shelf load for the V Nav wire shelf on the V Nav Stand is 10 lbs. 

Table 12-17:  Volume Navigation

Accessory Part Number / HCAT

V Nav Active Tracker (Omni TRAX) Starter Kit H4913AT

V Nav Needle Tracking Storage Insert H4913NS

V Nav eTRAX 

• 18/20g Starter Kit

• 14g Starter Kit

• 12g Starter Kit

• H4913NT

• H4913NV

• H4913NU

V Nav Probe Sensor H4913PS

V Nav MR Active Tracker (Omni TRAX) H4915MT

Probe Holder Insert H4915P

Volume Navigation Stand H4908NS

V Nav Needle Tracker Starter Kit H4910NT

V Nav Needle Virtual Tracker Starter Kit (VirtuTRAX) H4910NY

Virtual Tracker Sensor H4911NG

Volume Navigation Bracket Starter Kit H4908NK

V Nav Upgrade to Needle Tracking Kit H4910NS
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Hardware options

ECG Accessories

Table 12-18:  Hardware options

Accessory Part Number / HCAT

CW Doppler Option Collector Swallow H43342LA

Realtime 4D H43342LB

ECG H43342LC

Scan on battery Option kit H43342LD

Power Assistant Option kit H43342LE

Volume Navigation H43342LF

Wireless H43342LG

S-Video H43342LH

Pencil CW Hardware Kit H43342LJ

Table 12-19:  ECG Accessories

Accessory Part Number / HCAT

ECG Cables, IEC, AHA Style for Americas H4910EC

ECG Cables, IEC Style H4911JC

ECG Cable Kit H45521AL
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Probes

Table 12-20:  Probes and Accessories

Probe

HCAT

Global P/N

Japan P/N Biopsy Guide

Biopsy 

Guide 

HCAT

V Nav 

Capable

V Nav 

Bracket 

HCAT

BE9CS-D H40482LE Multi-angle disposable 

with a reusable bracket

Multi-Angle Reusable 

Stainless Bracket

E8387M

E8387MA

No N/A

C1-6-D

Convex

H40472LT Verza starter Kit

Note: ONLY support 

Verza Starter Kit. 

H4917VB No N/A

C1-6VN-D

Convex

H40472LW Verza starter Kit

Note: ONLY support 

Verza Starter Kit. 

H4917VB Yes N/A (V Nav 

Inside)

C2-7-D

Convex

H46422LM Multi-angle disposable 

with a reusable bracket

Multi-Angle Reusable 

Stainless Bracket

H40482LK

H40482LL

No N/A

C2-7VN-D

Convex

H46422LN Multi-angle disposable 

with a reusable bracket

Multi-Angle Reusable 

Stainless Bracket

H40482LK

H40482LL

Yes N/A (V Nav 

Inside)

C2-9-D

Convex

H40462LN Starter Kit H4913BA No N/A

C2-9VN-D

Convex

H40472LY Starter Kit H4913BA Yes N/A (V Nav 

Inside)

C3-10-D

Convex

H40482LB N/A N/A Yes H40482LF

IC5-9-D

Micro Convex 

Intracavitary

H40442LK Single Angle

Disposable with a 

Plastic Bracket or 

Reusable with a 

Stainless Steel Bracket

H40412LN

IC59_TR5 

(E8387M)

IC59_RU

(E8387MB)

Yes H4908NF

L2-9-D

Linear

H44901AI Verza starter Kit

Note: ONLY support 

Verza Starter Kit. 

H44901AM No N/A

L2-9VN-D

Linear

H44901AJ Verza starter Kit

Note: ONLY support 

Verza Starter Kit. 

H44901AM Yes N/A (V Nav 

Inside)
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L3-12-D H48062AA Multi-angle H48302AA 

[Kit] OR  

H78652PA 

[Set]

No N/A

L8-18i-D

Linear

H40452LL N/A N/A Yes H4908NH

L6-24-D

Linear Array

H4920HF 

(May not be 

available in all 

countries.)

N/A N/A No N/A

M5Sc-D

XDclear Active 

Matrix Single 

Crystal 

Phased Array 

Transducer

H44901AE Multi-angle disposable 

with a reusable bracket

H45561FC5 Yes H4908NM

ML6-15-D

Matrix Array 

Linear

H40452LG N/A H40432LI Yes H40432LK 

(Tru3D 

Biopsy Kit)

RIC5-9-D

4D Convex 

Volume 

Intracavitary

H48651MS Single Angle, Reusable

Biopsy Kit for RAB 

Light

H46721R

H48621Y

N/A N/A

RAB6-D

4D Volume

H48681MG Starter Kit H46701ML N/A N/A

6S-D H45021RR N/A N/A No N/A

6Tc-RS + 

RS-DLP

Trans- 

esophageal

H46402LW N/A N/A N/A N/A

P2D

Pencil Probe

H4830JE N/A N/A N/A N/A

P6D

Pencil Probe

H4830JG N/A N/A N/A N/A

Table 12-20:  Probes and Accessories (Continued)

Probe

HCAT

Global P/N

Japan P/N Biopsy Guide

Biopsy 

Guide 

HCAT

V Nav 

Capable

V Nav 

Bracket 

HCAT
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Transesophageal Probe Options

• Bite Guard (KZ200687 - H45511EE)

• Bite Guard Opr. Clip On (KZ693 - H45521CB)

• TEE Scanhead. Protective Cover (KZ808 - H45521CK)

• Bite Guard AD.16”27MM (086A0016 - H45521JH)

• Bite Hole Inducator (KZ800 - H45531HS)

• Storage Rack (H4551NM)
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Options

NOTE: Not all options are available in all countries. 

Table 12-21:  Options

Option Part Number / HCAT

Advanced Security H46622LL

*Coded Contrast - AM H43332LA

*Parametric Imaging H43332LB

Cardiac Automated Functional Imaging (AFI) H46622LN

Report Writer H46622LR

Stress Echo H46622LS

Tricefy H46622LT

LOGIQ Apps H46622LW

KOIOS SW H46622LY

Thyroid Assistant, Powered by Koios DS H4920KT

Scan Assistant H46622LZ

Advanced Probes H46612LS

Auto IMT H46612LT

B-Steer+ H46612LW

B-Flow H46612LY

Compare Assistant H46612LZ

DICOM H46622LA

Flow Quantification (Q-Analysis) H46622LB

Breast Measure Assist H46622LC

OB Measure Assistant H46622LD

Elastography H43332LC

Elastography QA H43332LD

Shear Wave Elastography H46622LE

Ultrasound Guided Attenuation Parametre (UGAP) H46622LH

Hepatic Assistant H46622LE

SonoNT/SonoIT H46622LJ

DVR H4918DR
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SRI HD Type2 H4920SR

V-Nav Image-Based Registration H4920VR

OmniView H43332LF

STIC H43332LG

TUI H43332LH

VCI Static H43332LJ

VOCAL II H43332LK

Thyroid Productivity H43332LL

Breast Productivity H43332LM

VITA on Demand H43332LN

*The LOGIQ Fortis is designed for compatibility with commercially available Ultrasound contrast agents. 

Because the availability of these agents is subject to government regulation and approval, product features 

intended for use with these agents may not be commercially marketed nor made available before the 

contrast agent is cleared for use. Contrast-related product features are enabled only on systems for delivery 

to an authorized country or region of use. 

Table 12-21:  Options (Continued)

Option Part Number / HCAT
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Gel 

Disinfectant

Ultrasound Probe and Cord Sheath Sets

Table 12-22:  Gel — Refer to Accessories Catalog

Accessory Units

Thermasonic Gel Warmer Holds three plastic bottles 

(250ml or 8 oz)

Aquasonic 100 Scan Gel 5 liter jug

250 ml plastic bottles (12/case)

Scan Ultrasound Gel 8 oz plastic bottles (12/case)

1 gallon plastic jug

Four 1-gallon plastic jugs

Table 12-23:  Disinfectant — Refer to Accessories Catalog

Accessory Units

Cidex Activated Dialdehyde 16/1 quart bottles

4/1 gallon bottles

2/2.5 gallon bottles

Table 12-24:  Probe and Cord Sheath Sets — Refer to Accessories Catalog

Accessory Units

Sterile Ultrasound Probe Sheath Set 20 Per Set

Sterile Ultrasound Cord Sheath Set 20 Per Set

Sanitary Rectal/Vaginal Probe Cover 20 Per Set

Sterile Combination Probe and Cord Cover Set 12 Per Set

Sterile Ultrasound Probe Sheath Set for Wide (2.5 and 3.5) Aperture 

Sector Probes

20 Per Set
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Chapter 13

Advanced Features

Describes Advanced system features and options.
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List of Advanced Features

Table of Contents

‘Using 4D’ on page 13-4

‘Contrast Imaging’ on page 13-56

‘Strain Elastography’ on page 13-113

‘Elastography Analysis’ on page 13-119

‘Shear Wave Elastography’ on page 13-124

‘Ultrasound-Guided Attenuation Parameter (UGAP) Option’ on 
page 13-153

‘Continuous Wave Doppler (CWD)’ on page 13-159

‘Tissue Velocity Imaging (TVI)’ on page 13-161

‘Quantitative Analysis (QAnalysis)’ on page 13-164

‘Stress Echo’ on page 13-184

‘Cardiac Automated Functional Imaging (Cardiac Strain)’ on 
page 13-220

‘Auto EF’ on page 13-244

‘ECG’ on page 13-256

‘Volume Navigation’ on page 13-262

‘Breast Productivity Package’ on page 13-323

‘Thyroid Productivity Package’ on page 13-329

‘Start Assistant’ on page 13-336

‘Scan Assistant’ on page 13-341

‘Compare Assistant’ on page 13-379

‘OB Measure Assistant’ on page 13-390

‘Hepatic Assistant’ on page 13-392



List of Advanced Features

LOGIQ Fortis – Basic User Manual 13-3
5855997-1EN Rev. 3

Table of Contents  (continued)

‘EZ Imaging’ on page 13-399

‘Anonymize the patient’ on page 13-407

‘Report Writer’ on page 13-409

‘Configuring DICOM’ on page 13-466

‘Configuring the Wireless Network’ on page 13-480

‘Tricefy Uplink’ on page 13-492

‘Device Mgmt’ on page 13-498

‘Smart Device Apps’ on page 13-515

‘Digital Expert’ on page 13-525

‘Service and Applications Support’ on page 13-526

‘Service Desktop’ on page 13-535

‘Battery Power Mode’ on page 13-536

‘Magstripe Card Reader’ on page 13-549

‘Footswitch’ on page 13-550

‘DVR’ on page 13-551
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Using 4D

4D Introduction

4D provides continuous, high volume acquisition of 3D images. 
4D adds the dimension of “movement” to a 3D image by 
providing continuous, real-time displays. With 4D, you can apply 
rendering techniques to smooth out the appearance of an 
anatomical structure, for example, a baby’s spine.

You can perform the following types of volume acquisitions 
within the 4D feature:

Features supported with 4D

The following features are supported with 4D:

• Most B-Mode controls

• Annotations

• Measurements and Calculations

The following post-processing controls are available with 4D:

• CINE 

• Zoom

Table 13-1:  4D Package Options

4D Type Description

Acquisition 

Mode

4D Designed for continuous volume acquisition of a 3D image. B, 4D

Static 3D Designed for single volume acquisition of a 3D image. B, 3D
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4D Principles of Operation

The acquisition of volume starts with a 2D image using special 
probes designed for performing 3D sweeps and 4D scans. The 
volume box defines the region of interest to be used for the 
volume sweep.

Volume sweep refers to the range of the sweep of the 2D image 
to be transformed into a rendered, 3D or 4D image. Static 3D 
acquisition involves a single volume sweep. 4D involves 
multiple, continuous volume sweeps. 

Figure 13-1. Volume Sweep 

1. Central 2D scan

2. Start 2D scan

3. Range of VOI sweep

When you initiate a volume sweep, you can adjust the angle of 
the volume.

What is Interactive 3D Rendering? 

Interactive 3D rendering allows you to visualize certain 
structures and to view and analyze different sections of the 
volume. 
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Region of Interest (ROI) / Render Box

The Region of Interest (ROI) - also referred to as the Render 
Box in rendering  - contains the section of the volume you want 
to render. Therefore, objects that are not inside of the box are 
not included in the render process and are cut out (this is 
important in surface mode to allow a free line of sight). This may 
or might not be the entire Volume of Interest (VOI). 

You can adjust the view direction of the ROI.

Figure 13-2. Render View Directions

Render View 

In Render view, only the rendered image displays - no reference 
images. 

1. Up/Down

2. Left/Right

3. Front/Back

4. Down/Up

5. Right/Left

6. Back/Front
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Image Orientation

Orientation of Image in Sectional view

 Figure 13-3. Quad Render Visualization Mode

1. Longitudinal

2. Transverse

3. Coronal
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Principle of Sectional Planes

Sectional planes represent three different planes of the same 3D 
volume. There are three separate planes, A (Longitudinal), B, 
(Transverse) and C (Coronal). 

Figure 13-4. Illustration of Sectional Planes

The presentation of three orthogonal sectional planes is different 
from the conventional patient orientation in 2D sonography. 

NOTE: Whenever you select the usual, longitudinal section of the 
patient to display in field A, the conventional orientation for 
longitudinal and transverse sections is valid. 
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Reference Images

Reference images are the individual image displays within the 
corresponding sectional plane. Reference image A represents 
the longitudinal view; reference image B the transverse view, 
and reference image C represents the coronal view.

 Figure 13-5. Monitor Display of Reference Images in Sectional View

1. Reference Image A (Longitudinal)

2. Reference Image B (Transverse)

3. Reference Image C (Coronal)

Orientation Help. When you view a 4D image on the display, 
it’s sometimes difficult to recognize the orientation. To help, the 
system displays a three-dimensional drawing to illustrate the 
orientation. This drawing displays ONLY in sectional view. 
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Reference Images  (continued)

Figure 13-6. Reference Image A 

For Reference image A, the transducer plane migrates from the 
FRONT to the REAR through the volume body.

Figure 13-7. Reference Image B

For Reference image B, the transducer plane migrates from the 
LEFT to the RIGHT through the volume body.

Figure 13-8. Reference Image C

For Reference image C, the transducer plane migrates from the 
TOP to the BOTTOM through the volume body.
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-9. Abdominal Probe Orientation

1. Image Plane A

2. image Plane B

3. Image Plane C
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-10. Small Part Probe Orientation

1. Image Plane A

2. Image Plane B

3. Image Plane C
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-11. Endocavity Probe Orientation

1. Image Plane A

2. Image Plane B

3. Image Plane C

4. Groove
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4D Operational Controls

Control Panel Overview

When you enter 3D/4D mode, the behavior of some of the 
Control Panel buttons changes. For example, in 3D/4D mode, 
you use the PW-Mode, CF-Mode, M-Mode buttons (along with 
Depth) to manipulate the Volume of Interest (VOI).

 Figure 13-12. Control Panel Buttons

1. User-configurable controls. 

2. M key, M-Mode key used to rotate about the X axis.

3. PW key, PW-Mode key used to rotate about the Y axis.

4. CF Key, CF-Mode key used to rotate about the Z axis.

5. Depth key, used as a transverse translation through the 
image.

6. Width key, used to adjust the size and position of the VOI.

7. Trackball, used to move the VOI. Also, the 4 keys 
surrounding the Trackball map to additional functionality, as 
shown on the monitor display. 

8. L (left) key, used to begin a 4D acquisition.

9. Freeze or R (right) key, used to freeze a 4D image.
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4D Monitor Display

Imaging parameters are displayed in the upper right-hand 
portion of the display. The 4D specific parameters are Quality 
(Q), Volume Angle (A) and Volume Rate (VR). The Status Bar 
contains instructions on the tasks you can perform at each stage 
of the 4D imaging process. Remember to take a look at the 
Status Bar as needed.
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4D Touch Panel Overview

The following is the first Touch Panel that appears when you 
press 3D/4D. 

Common 4D Touch Panel Controls

Most 4D Touch Panel screens contain some similar controls. 
Refer to the table below for descriptions of these controls. 
Controls that are unique to or that contain slightly different 
functionality are described in their respective sections.

Table 13-2:  Common 4D Touch Panel Controls

Preset Parameter Description

Tile You can divide the display into 1, 2, or 4 windows for Render view (Render = 

On) and 1 or 4 windows for Sectional view (Render = Off). 

Reset Curve Resets the three-point curve to a straight line. 

Direction Adjusts the view direction of the ROI. 

Visualization Sectional, Render, VCI, or Tomographic Ultrasound Imaging (TUI). Render 

view displays one rendered image, or reference image(s) and rendered 

image. 

Focus Position Adjusts the focal position. 

Volume Angle Sets the range of the volume sweep. 

Quality Balances speed with line density. Max combines the highest density with the 

slowest speed; Low combines the lowest density with the highest speed. 
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4D Presets 

Real-Time 4D/Static 3D Presets

1. When you enter 3D/4D mode, press the Preset tab.

2. Select one of the preset settings for data acquisition and 
display. Presets are defined in the preset file and differ by 
application.

Static 3D Presets

1. When you enter 3D/4D mode, press Static 3D, then the 
Preset tab.

2. Select one of the preset settings for data acquisition and 
display. Presets are defined in the preset file and differ by 
application.

Table 13-3:  Common 4D Touch Panel Controls

Preset Parameter Description

Save Selections: Overwrite, Create New, Cancel. Overwrite. Overwrite the 

application preset file with the changes you just made. Create New.  Create 

a new user application preset file based upon the current exam category and 

application. Cancel. Cancel without saving preset parameters.   

Pre-defined Preset Reloads the presets for the selected application. 

User1, User2, User3, 

User4

Used to define new user presets for a given application. 
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Performing a 4D Scan

Visualizations

4D provides two types of views for displaying and working with 
images: Sectional, Render, and Tomographic Ultrasound 
Imaging (TUI).

Sectional View

Sectional view contains one display for each sectional plane. 

 Figure 13-13. Monitor Display in Sectional View

1. Sectional Image A

2. Sectional Image B

3. Sectional Image C
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Visualizations  (continued)

Render View

The LOGIQ Fortis continuously displays the 4D rendered image. 

NOTE: When the tile selection is single, only the rendered 4D image 
appears. When the tile selection is quad, the sectional images 
are located in 3 quadrants with the rendered 4D image in the 
fourth.

Figure 13-14. Quad Tile Render View
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Visualizations  (continued)

Orientation Help

When you view a 4D image on the display monitor, it’s 
sometimes difficult to recognize the orientation. To help, the 
system displays a three-dimensional drawing to illustrate the 
orientation. This drawing displays ONLY in sectional view.

Figure 13-15. Orientation Help Graphic
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Acquiring and Rendering a 4D VOI

Starting with a 2D Image

To create a 4D image, you start with an optimized 2D image. 
The 2D image serves as the mid-line for the resulting 4D image.

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

NOTE: If the appropriate 4D probe is not connected, the original 3D 
Touch Panel appears.

2. Obtain a 2D image. Optimize the image as usual.  

Entering 3D/4D Mode

In 3D/4D mode, you choose the type of scan you want to 
perform: 4D or Static 3D.

1. Press 3D/4D to enter 3D/4D mode. The first time you press 
3D/4D, the system is in B Pre mode.

NOTE: The location of the number of focal zones might change 
when you enter 3D/4D mode, since the number of zones is 
pre-determined by the default ROI.

The default acquisition mode varies by application. If you 
are in OB, the default acquisition mode is Real-Time 4D; for 
all other applications, Static 3D is the default acquisition 
mode. When you enter pre-mode, an ROI graphic may 
appear on the monitor display that defines the initial ROI 
(Region of Interest) of the volume.

Figure 13-16. ROI Graphic

2. Press the Preset tab. Select one of the preset settings for 
data acquisition and display. Presets are defined in the 
preset file and differ by application. 
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Quick Acquisition Steps

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

2. Select a 4D probe from the probe indicator.

3. Obtain a 2D image. Optimize the image as usual.

4. Press 3D/4D. An ROI graphic appears. 4D is selected.

5. Define the Volume of Interest (VOI) to be scanned. Use the 
Trackball to move the VOI and the Width button to re-size 
and re-position the VOI. Only the area defined within the 
VOI is rendered.

6. Adjust the volume angle and quality. This defines the range 
of the volume sweep. A small sweep angle results in a lower 
number of slices with a high volume rate.

7. To begin 4D acquisition, press the L key.

You DO NOT have to hold the probe steady during data 
acquisition.

During data acquisition, you can manipulate the VOI to see 
different views of the image. To rotate the VOI left or right, 
use the PW control. To rotate the VOI forward or backward, 
use the CF control. To rotate the VOI in a circular motion, 
use the M control.

To return to 3D/4D pre-mode, press L.

NOTE: If the volume size is too large, the message “Volume Size 
Too Big - Quality Degraded” displays in the status bar.  The 
system changes the quality automatically to below the upper 
limit and displays the proper Quality value in the information 
window. 

8. Set Render to On.

9. To complete the acquisition, press Freeze or R.

10. Store the image.
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4D

4D provides continuous, high volume acquisition of 3D images. 
You can apply rendering techniques to smooth out the 
appearance of an anatomical structure, for example, a baby 
face.

4D imaging contains two main viewing modes: Sectional, 
Render, and Tomographic Ultrasound Imaging (TUI). Sectional 
mode displays three separate representations of the image: 
Longitudinal (original 2D image), Transverse (elevational), and 
Coronal (horizontal). Render mode displays one rendered 4D 
image.

Acquiring a 4D Volume of Interest (VOI)

Once you have acquired an optimized 2D image, you can 
perform a 4D scan to acquire the 4D image.

During 4D image acquisition:

• Frame Averaging is disabled.

• You cannot change the transmit frequency.

To acquire a 4D VOI:

1. Press 4D.

2. Make sure the VOI is defined appropriately. If necessary, 
adjust the volume angle. This defines the range of the 
volume sweep. A small sweep angle results in a lower 
number of slices with a higher volume rate.

See Manipulating the Volume of Interest (VOI) for more 
information.

3. To begin 4D acquisition, press the L key. The system will 
perform continuous sweeps across the VOI. You do not 
have to hold the probe steady during a 4D scan.

To return to 4D pre-mode, press L.

4. Set the Render to On.
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Sectional VOI Acquisition

Sectional view provides three separate views of the same 
image: Longitudinal (original image), Transverse (elevational), 
and Coronal (horizontal).

1. In the 4D tab, Render defaults to On (Render mode). 
Change Render to Off for Sectional view.

2. To select a reference image, use the Ref Image control on 
the Touch Panel. The reference image selected contains the 
focus for control panel keys, allowing you to manipulate or 
optimize that image.

Table 13-4:  4D Data Acquisition Parameters

4D Parameter Description

Restore View Resets all parameters back to the original values or chosen presets.

Tile Selections:  Single, Quad. You can divide the display into 1 or 4 windows. 

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view 

displays one rendered image, or reference image(s) and rendered image. 

Ref Image Use to select the reference image that has focus for use with the control 

panel keys and Trackball. 

Orientation Help Displays a three-dimensional drawing to illustrate the orientation. Only 

displays in sectional view. 

Volume Angle Sets the range of the volume sweep. 

B Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line 

density. Max combines the highest density with the slowest speed. Low 

combines the lowest density with the highest speed. BQ displays on the 

display. 
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Render VOI Acquisition

Rendering allows you to distinguish subtle anatomical detail. 
You can render all areas of an VOI, or just certain regions of the 
VOI. The region you define for rendering is referred to as the 
Render Box.

1. Define the area you want to render. For example, if you 
have an image of an entire fetus, you might only want the 
fetal face to be rendered. Therefore, you would define the 
fetal face as the VOI.

2. Set Render to On.

Table 13-5:  4D Data Acquisition Parameters - Render Mode 

4D Parameter Description

Restore View Select to reset all parameters back to the original values or chosen presets.

Tile Selections:  Single, Dual, Quad. You can divide the display into 1, 2, or 4 

windows. 

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view 

displays one rendered image, or reference image(s) and rendered image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 

Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 

Ref Image Use to select the reference image that has focus for use with the control 

panel keys and Trackball. This control is enabled only if Tile is set to Quad.

Volume Angle Sets the range of the volume sweep. 

Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line 

density. Max combines the highest density with the slowest speed. Low 

combines the lowest density with the highest speed. 

Activate Curve Define a three-point curved surface for the render window using the 

Trackball. 

Reset Curve Reset the three-point curve to a straight line. 

Mix Selections: 0-100% in increments of 2. Allows you to mix a Rend Mode 1 

mode with a Rend Mode 2 mode. Always select two modes. 

Lower Threshold Selections: 0-255. Sets a lower threshold below which weaker echoes are 

removed. 
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Render VOI Acquisition  (continued)

1. Select the Render Setting tab.

The Render Setting tab allows you select and combine 
gray-scale and color rendering modes.

HINTS If you are using Surface modes, we recommend that you adjust 
the Lower Threshold to recognize border structures more 
clearly.

Table 13-6:  4D (Data Acquisition) Render Parameters

4D Parameter Description

Direction The ROI determines the region that is rendered during 4D acquisition. You 

can change the direction in which this ROI is viewed. Selections: Up/Down, 

Down Up, Left/Right, Right/Left, Front/Back, Back/Front.

Gray Map Displays the gray map selections on the display monitor. Select maps using 

the Trackball.

Colorize Displays the tint map selections on the display monitor. Select maps using 

the Trackball.

Render Mode Select Gray or Inversion. If you select Inversion, inverts the gray values of the 

rendered image (e.g., image information that was black becomes white and 

vice versa). 

Render 1 Allows you to combine render mode values from render mode 1. Select the 

render map combination from the upper-left portion of the monitor display. 

Select map combinations using the Trackball. 

Render Mode 1 Selections: Surface Smooth, Surface Texture, Transp Max, 

Transp X-ray, Transp Min, HDlive Texture. 

Surface Smooth - Surface displays in a smoothed texture mode, which 

means that the gray values of the surface are identical with the gray values of 

the original 2D scan.  Surface Texture - Surface displays in texture mode, 

which means that the gray values of the surface are identical with the gray 

values of the original 2D scan. Transp Max. - Displays the maximum 

intensity of gray values in the ROI. This is helpful for viewing bony structures. 

Transp X-Ray - Displays the mean value of all gray values in the ROI.  Trans 

Min. - Displays the minimum number of gray values in the ROI. This is helpful 

for viewing vessels and hollow structures. HDlive Texture - Uses an 

illumination source that can be positioned by the user around the rendered 

3D object on a spherical coordinate. By highlighting structures from the side, 

the three-dimensional impression can be improved considerably. 
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Render 2 Allows you to combine render mode values from render mode 2. 

Render Mode 2 Selections: Surface Smooth, Light, Gradient Light, Transp 

Max, Transp X-ray, Transp. Min., HDlive Smooth. 

Surface Smooth - Surface displays in a smoothed texture mode, which 

means that the gray values of the surface are identical with the gray values of 

the original 2D scan.  Light - Surface displays in light mode. Structures in the 

near field are brighter; structures in the far field are darker.  Gradient Light - 

Surface displays as if it is illuminated from a spot light source. This is helpful if 

the displayed surface is surrounded by hypoechoic structures (for example, 

liquids). Transp Max. - Displays the maximum intensity of gray values in the 

ROI. This is helpful for viewing bony structures. Transp X-ray - Displays the 

mean value of all gray values in the ROI.  Transp Min. - Displays the 

minimum number of gray values in the ROI. This is helpful for viewing vessels 

and hollo4w structures. HDlive Smooth - Smoothed HDlive texture mode.  

When Render 1 value is set to HDlive Texture, the only available mode for 

Render 2 is HDlive Smooth.Note:  HDlive rendering is not available if VCI is 

active. 

Edit Light Activates the light editor for the virtual light source in HDlive render mode. 

User can position the light source by moving the Trackball, A light icon on the 

main display  indicates the direction of the light. Note: The Edit Light 

parameter is only available for the HDlive rendering modes. 

Transparency Selections: 20 to 250. Sets the transparency of the image. The higher the 

number, the more transparent the gray scale information.

Table 13-6:  4D (Data Acquisition) Render Parameters (Continued)

4D Parameter Description
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Manipulating the Volume of Interest (VOI)

Imagine you are able to manipulate the 4D volume of interest 
(VOI) in your hand. The 3D/4D ROI is a tangible anatomical 
object that you can see and manipulate easily using the 
Trackball and other control panel keys.

If the monitor display is in Sectional view, select the desired 
reference image before you manipulate the image.

NOTE: The manipulation examples are with A set as the reference 
image.

Rotating the 4D 

VOI Left/Right or 

Forward/Backward

You can rotate the VOI around the X, Y, and Z axes. To rotate 
the VOI around the Z axis, turn the CF control left/right. 

Figure 13-17. Rotate about Z Axis with CF Control
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Manipulating the Volume of Interest (VOI)  (continued)

To rotate the VOI around the Y axis, turn the PW left/right. 

Figure 13-18. Rotate about Y Axis with PW Control

Rotating the 4D 

Image in a Circular 

Motion

To rotate the VOI around the X axis, turn the M control left/right. 

Figure 13-19. Rotate about X Axis with M Control

NOTE: To speed up the rotation, press the PW, CF, or M controls before 
you turn them. To slow down the rotation, press PW or CF again. 
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Manipulating the Volume of Interest (VOI)  (continued)

Moving through 

the VOI

To move through the image to view a particular slice, press 
Depth. 

This allows a displacement of the center of rotation along the 
intersection lines of the sectional planes A, B, and C. The 
displacement of the center of rotation leads to the display of 
parallel sectional images. See ‘Reference Images’ on page 13-9 
for more information. 

Zooming the 

Image

Rotate Zoom to zoom on the image.

Moving the VOI 

Position

To move the position of the VOI, move the Trackball left, right, 
up and down, as needed.

Resizing the VOI To re-size the VOI, use the Width control panel button. See the 
Width section in this chapter.

Stopping 4D Image Acquisition

To stop acquiring a 4D image, press Freeze or R if you are in 
Render view or just Freeze if you are in Sectional view.

4D VOI Post-Processing

When you press Freeze or R, one of the following Touch Panel 
displays, depending on whether you are in Render view or 
Sectional view.
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Volume CINE

The system constantly stores CINE images so you can play 
back and review those images. CINE is useful for focusing on 
images during the specific part of the heart cycle or to view short 
segments of a scan session.

To activate CINE in 4D:

1. Press Freeze.

2. Select the VolCine tab. 

3. If you were in Render visualization mode when you entered 
4D CINE mode; press L to return to Pre-Mode.

If you were in Sectional visualization mode when you 
entered 4D CINE mode; press L to return to Pre-Mode. 

4. To re-start real-time 4D acquisition, press Freeze.

Table 13-7:  4D Cine Parameters

Preset Parameter Description

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one 

loop sequence forward.  BiDirectional - plays the sequence forward and 

backward.

First Displays the first volume in the CINE loop. 

Last Displays the last volume in the CINE loop. 

Run/Stop Starts and stops the CINE loop.

Loop Speed Adjusts the CINE loop speed. 

Volume by Volume Used to select an individual volume in the CINE loop. 
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Static 3D

You can create a single sweep, single volume static 3D image.

Performing a Static 3D Scan

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

2. Select a 4D probe from the probe indicator.

3. Obtain a 2D image. Optimize the image as usual.

4. Press 3D/4D.

5. Press Static 3D. Set Visualization to Render. 

6. Set the Volume of Interest (VOI) to be rendered. Use the 
Trackball to move the VOI and Width to re-size the ROI. 

7. Adjust the volume angle. This defines the range of the 
volume sweep. A small sweep angle results in a lower 
number of slices with a high volume rate.

8. Set the probe down on the patient, making sure the probe is 
held steady. Press the L key to start acquisition.

NOTE: During 3D acquisition, no control panel keys are not 
available, except for ‘R.’ 

NOTE: When the 3D acquisition begins, the Touch Panel appears 
blank for a brief moment.

9. Hold the probe steady until the system stops automatically. 
You will know the acquisition has stopped when the Touch 

Panel changes to display the Render Setting, 3D Rotational 
Cine, and Scalpel tabs.

To stop the acquisition manually, press the R key. 

10. Save the image.

11. To further manipulate the 3D image, press Static 3D.

The Touch Panel that displays depends on the visualization 
mode selected prior to freeze, Sectional, Render, TUI or 
VCI.

Static 3D  Sectional View

Table 13-8:  3D After Acquisition Parameters - Sectional View

Preset Parameter Description

Orientation Help Displays a 3-dimensional drawing to illustrate the orientation. Only displays in 

sectional view.



Using 4D

LOGIQ Fortis – Basic User Manual 13-33
5855997-1EN Rev. 3

Static 3D Render View

VCI 

Introduction

VCI (Volume Contrast Imaging) allows you to sweep smaller 
slices of data with a higher volume rate. The resulting image 
shows an average, integrated gray value of the tissue contained 
within the ROI. VCI improves the contrast resolution and signal/
noise ratio. It also reduces image speckle. This may facilitate 
finding diffuse lesions in organs. 

Touch Panel

The data is represented as in Static 3D - Sectional Planes. 
However, the three planes are VCI renderings (tissue 
information of a thick slice) computed from the 3D dataset. 

Table 13-9:  3D After Acquisition Parameters - Render View - Page 1

Preset Parameter Description

Edit/Accept ROI Selections include Edit, Accept. Edit - Select to adjust the size of the Region 

of Interest (ROI). Accept - accepts the active 3D image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 

Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 

Table 13-10:  VCI View

Preset Parameter Description

Slice Thickness Select the slice thickness
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Static 3D Color

To view Static 3D Color, 

1. Acquire the anatomy you want to view in B-Mode. 

2. Activate Color Flow or PDI. 

3. Activate 3D/4D. The Pre-3D displays. Select the desired 
Visualization.  

NOTE: 4D cannot be selected from Pre-Mode with Color active.

4. Press ‘L’ to render the image. 

The color is rendered. You can adjust the Render Mode (default 
is Glass Body): 

• Gray. Gray, no color. 

Figure 13-20. 3D Color - Gray

• Inversion. Inverts the grayscale. 
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Static 3D Color  (continued)

• Color. Displays Color-Flow. 

Select the rendering method ([Rend Color1] (Surface only) 
or [Rend Color2]) and the mixing ratio.

Figure 13-21. 3D Color - Color

• Glass Body. Displays both Color-Flow and B-Mode. 

Select the rendering method ([Rend Gray] or [Rend Color]) 
and the mixing ratio.

Figure 13-22. 3D Color - Glass Body

To hide the color on the sectional planes, select Color Off from 
the Touch Panel. 

NOTE: If you scan in Render mode and select Tile as Quad, you can 
hide the color with the Color Off Touch Panel key.
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Volume Review

You can post process VOI (the entire volume of interest) and 
scroll through acquisition planes via Volume Review. This allows 
you to review all of the frames within this volume set.  

In Volume Review, start in Run/Stop so that every frame in the 
volume is displayed. 

NOTE: If you adjust the screen while in Volume Review, these changes 
ARE NOT reflected on the Static 3D volume. 

Scalpel

Scalpel allows you to edit/cut sections of a 3D image. Scalpel is 
available only on a rendered image.

1. Press Scalpel.

Table 13-11:  Scalpel Parameters

Preset Parameter Description

Cut Mode Selections: Inside Contour, Outside Contour, Inside Box, Outside Box, Eraser 

Big, Eraser Small. Inside Contour, Outside Contour - Allows you to trace 

the portion of the image you want to cut. Trace Outside removes all portions 

of the image that fall outside your traced region. Trace Inside removes all 

portions of the image that fall inside your traced region.  Inside Box, Outside 

Box - Displays a box you can use to define the portion of the image you want 

to cut. Outside Box removes all portions of the image that fall outside the box. 

Inside Box  removes all portions of the image that fall inside the box. Eraser 

Big, Eraser Small - Provides a big and small eraser tool you can use to 

define the portion of the image to cut by hand. Available only if Depth is Full.

Cut Depth Selections: Full, Define. Full -The entire depth of the selected region will be 

cut.   Define - Allows you to define the depth to cut using the Depth control 

panel knob.

Undo Last Undoes the last cut only.

Redo Select to redo scalpel.

Undo All Undoes all cuts since you entered Scalpel mode.

Done Applies to User Defined Cut Depth when complete. 
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Scalpel  (continued)

2. Select the cut mode.

3. Use the Trackball and Set key to define the portion of the 
image to cut. Press Set to start, move the Trackball to 
define the region, then press Set again to cut the image. 
The portion is removed.

To undo the last cut, select Undo Last.

To undo all cuts in the current session, select Undo All.

NOTE: With the cut image displayed, if you attempt to switch to the 
Static 3D tab to edit the ROI, the following warning message 
appears: Scalpel changes will be lost. Do you want to continue? 
[Yes/No]. 
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3D Rotation CINE

3D Rotation CINE allows you to view the 3D image from various 
angles.

To activate rotation CINE in 3D:

1. Press Freeze.

2. Select the 3DRot Cine tab. 

Table 13-12:  3D Rotation Cine Parameters 

Preset Parameter Description

Rotational Angle Sets the rotational angle of the 3D image over which the CINE loop is played. 

Typical values are 30, 45, 60, 90, 180 and 360 degrees.

Step Angle Sets the step angle between individual frames in the CINE loop. 

Rotation Axis Sets the axis about which the CINE loop is calculated. Selections X and Y.

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one 

loop sequence forward.  BiDirectional - plays the sequence forward and 

backward.

First Displays the first volume in the CINE. 

Last Displays the last volume in the CINE. 

Run/Stop Starts and stops the CINE sequence.

Start Angle Used to select the starting angle in the CINE loop range. The default Start 

Image is calculated from the rotational angle as:   -1 X Rotational angle / 2 If 

you adjust the Start Image, the Rotational Angle is re-set to be the value of 

the adjusted Start Image.

End Angle Used to select the ending angle in the CINE loop range. The default End 

Image is calculated from the rotational angle as:   Rotational angle / 2 If you 

adjust the End Image, the Rotational Angle is re-set to be the value of the 

adjusted End Image.

Image by Image Used to select an individual image in the CINE loop. 
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VOCAL

You use VOCAL (Virtual Organ Computer-aided Analysis) to 
visualize and calculate the volume of anatomical structures, 
such as a tumor lesion, cysts, and the prostate. VOCAL is 
available after a Static 3D or Real-Time 4D acquisition. 

1. Press Vocal. Specify the volume calculation method 
(Manual, Contour Detect, SemiAuto Detect, or Sphere). 
Select the reference image you want to use to perform the 
trace by selecting Ref Image A, B, or C. Press Start. 

2. Trace the anatomy using the Trackball. Press Set to start 
and end the trace. You must go across the dotted line for the 
trace to take effect (it turns yellow). The trace is performed 
on each image slice, separated by the rotational step angle. 
Rotate the Rot. Ref dial until you have completed the total 
of the required rotations (for example, if you’ve selected 30 
degrees, you need to complete six traces if you’ve selected 
Manual). After you’ve completed the trace target, the Calc 

Volume button is active for you to press. The calculated 
VOCAL image appears in the lower, right-hand corner of the 
display. You are now in the edit state. 

NOTE: Trace not used for Sphere. For Sphere, set the Poles. 

3. Edit as necessary. You can apply a shell, adjust its 
thickness, navigate through the reference angles, or restart 
the VOCAL. 

VOCAL Touch Panel states are described in the following tables. 

Table 13-13:  VOCAL Parameters on Setup Touch Panel

Parameter Description

Manual When you select the Manual method, you need to perform a manual trace on 

each of the rotation angles. 

Contour Detect When you select the Contour Detect method, you need to perform a manual 

trace on each of the rotation angles. 

SemiAuto Detect When you select the Semi Automatic Detect method, you need to perform a 

trace on only two rotation angles. The system applies an algorithm to define 

the traces. 

Structure Structure is only available with the SemiAuto Detect method. Select Hypo, 

Cystic, or Hyper/Iso. 

Sphere Calculates the volume based on the pole settings. 

Pole 1 Adjust the upper contour point  (green arrow) of the structure. 

Pole 2 Adjust the lower contour point (green arrow) of the structure.
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The Shell Modes allows you to construct a shell or contour 
“around” the structure of interest, which enables you to 
distinguish between the contour of the targeted structure and 
the contours the inside and outside of the structure.

Rotational Step Angle Specify the angular spacing between contour traces. Typical values are 6, 9, 

15, and 30 degrees. The number of planes varies by this formula: 180 

degrees / selected rotational step angle. 

Ref Image Use this to select the image you want to use to perform the trace. 

Start Press Start when you’re ready to perform the trace. 

Rot.Ref #/#    Back/Next Select Next/Back to move to the next image for contour definition in the 

rotation step. 

Table 13-14:  VOCAL Calculate Volume Touch Panel

Parameter Description

Calc Volume Press Calc Volume to initiate the VOCAL image calculation. 

Clear Press Clear to remove the trace from the image. 

Restart Vocal Press Restart Vocal to return to the initial VOCAL state. 

Table 13-13:  VOCAL Parameters on Setup Touch Panel (Continued)

Parameter Description

Table 13-15:  VOCAL Parameters on Edit Touch Panel

Parameter Description

Shell Off Select Shell Off if you do not want a shell around the VOCAL image. 

Inside Select Inside if you want a shell inside the volume. 

Outside Select Outside if you want a shell outside the volume. 

Symmetric Select Symmetric if you want half of the shell thickness inside and half 

outside the volume’s perimeter. 

Shell Thickness Adjust to vary the thickness of the shell. 
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Static 3D Render Setting

Static 3D Volume Review

You can post process VOI (the entire volume of interest) and 
scroll through acquisition planes via Volume Review. This allows 
you to review all of the frames within this volume set.  

In Volume Review, start in Run/Stop so that every frame in the 
volume is displayed. 

NOTE: If you adjust the screen while in Volume Review, these changes 
ARE NOT reflected on the Static 3D volume. 

Storing 4D Images

You store 4D images exactly as you would your 2D images. 
Because 4D images contain more data, they also require more 
space. Pay close attention to the size of the volumes.

• Still image: Store as Raw Data

• CINE: Store as Raw Data when “Enhanced DICOM” is 
selected for printing 4D. 

Table 13-16:  3D After Acquisition Parameters - Render View - Page 1

Preset Parameter Description

Edit/Accept ROI Selections include Edit, Accept. Edit - Select to adjust the size of the Region 

of Interest (ROI). Accept - accepts the active 3D image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 

Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 
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Tomographic Ultrasound Imaging (TUI) 

Tomographic Ultrasound Imaging (TUI) is a visualization mode 
which presents data as parallel slices (planes) through the 
dataset. This method of visualization is consistent with CT and 
MRI. The distance between the different planes can be adjusted.   

1. Select TUI as the Visualization mode. 

2. Press ‘L’ to start acquisition. 

3. If in 4D, press ‘R’ to end the acquisition. This step is not 
required in Static 3D.

The reference image + the number of specified slices 
appears. The reference image always displays and 
indicates which slices you are currently viewing as solid 
lines.  
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Tomographic Ultrasound Imaging (TUI)  (continued)

Figure 13-23. TUI 3x3 Example

a. The TUI reference image that shows the slice position. 
This image is orthogonal to the reference image.

b. The number and green asterisk shows the position of 
each slice. A green asterisk indicates the center image 
(A, B or C-plane).

c. Slice distance displays when the slices are in certain 
intervals.

d. A solid line indicates the slice appears on the monitor.

A dotted line indicates the slice did not appear on the 
monitor.

NOTE: TUI with Color is only available with Static 3D, not with 4D. 
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Tomographic Ultrasound Imaging (TUI)  (continued)

4. Adjust the number of slices and slice distance.

You can adjust the number of slices by using the Slices 
rotary. You can adjust the distance between the slices using 
the Slice Distance rotary. Max value is 40mm.

• Move forward/backward through the slices via Prev./

Next Slice.

• Change the center image via Ref. Image if needed 
(Reference image A, B or C).

• Select Display Format from 1X1, 1X2, 2X2 and 3X3.

• The following features are supported in TUI: Zoom, 
Rotation (X/Y/Z), Trackball (Move the position), 
Translation and Gain.

• To hide the color, select Color Off from the Touch 
Panel. 
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Tomographic Ultrasound Imaging (TUI)  (continued)

You can adjust each slice position with Adjust Slices.

1. Press Adjust Slices on the Touch Panel.

2. The pointer displays. Select a slice by using the Trackball.

Figure 13-24. Adjust Slice screen (example)

a. Selected slice displays with yellow border

b. Distance from the center image

• Adjust the slice distance from the reference image by 
using Slice Position. Slice Position only affects the 
selected slice. 

NOTE: If you place the pointer on the reference image and 
rotate Slice Position, the position of the reference 
image and all slices are moved.

• Adjust the number of right and left slices off the center 
image by using Left Slices or Right Slices.

3. After the adjustment is finished, press Set. The slice is 
marked with an “X”. To print this slice, press a print key. 
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SonoRenderlive

SonoRenderlive helps to find the render start position to easily 
separate solid tissue in front of the render object.

The SonoRenderlive algorithm “looks” for the transition from 
solid to liquid tissue and positions the “Render Start” into the 
liquid area visualized by the green render start line. The render 
start line is not a straight line but a “free” trace for optimal 
adaptation to the render object.

 Figure 13-25. Screen Display Off
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SonoRenderlive  (continued)

 Figure 13-26. Screen Display On

Using SonoRenderlive

1. Start the Render Visualization Mode.

2. Press the SonoRenderlive Rotary control.

3. To adjust the distance between the render start position and 
the render object, rotate the Sensitivity control below the 
Touch Panel. A high value indicates a smaller distance.

NOTE: If SonoRenderlive is not used, the Render Start line can also be 
modified manually. Press the trackball button Curve to activate 
Curved Render Start and move the trackball to modify the line.
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OmniView

OmniView provides an arbitrary cross-sectional plane, as 
opposed to a strict coronal plane. In VCI OmniView, the 
rendering box is very thin so you can visualize the tissue 
information of a thick slice. The resulting image shows the 
average (integrated) gray value of the tissue contained within 
the narrow box. 

VCI OmniView improves the contrast resolution and the signal/
noise ratio and therefore facilitates the detection of diffuse 
lesions in organs. The result is an image with no speckle pattern 
and a highly improved tissue contrast.

• 4D Real Time

• 3D Static

• STIC
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OmniView Workflow

1. Press 3D/4D.

2. Select OmniView.

3. Adjust Volume Angle and B Quality as necessary.

4. Press the right Set key to start acquisition.

The volume acquisition starts and the acquired images are 
displayed.

5. The cross cursor displays on the reference image. 

6. Select the appropriate trace mode to display the sectional 
plane. 

• Line: Select the sectional image by using straight line. 

• Curve: Select the sectional image by using curved line. 

Move the cursor to the start point and press Set. Move 
the cursor to the end point and press Set. Use the 
Trackball to make a curved line and press Set.

• Trace: Select the sectional image by using any arbitrary 
curve.

• Polyline: Select the sectional image by using a 
continuous line composed of one or more line 
segments. You can create a polyline by specifying the 
endpoints of each segment by press Set.
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OmniView Main Menu

Table 13-17:  OmniView Parameters on Edit Touch Panel

Parameter Description

View Icon Show or hide the OmniView Icon.

View Line Show or hide the OmniView Line.

VCI OmniView Switch to VCI Omniview.

Trace Mode Four tracking line methods are available.

Tile Select a display format (Single, Dual, Quad)

Clear All All existing lines are deleted and a new line entry is started.

Ref. OmniV To activate OmniView Ref. Line view.

Ref. Image Select the Reference image.

OmniV. Rot Rotates the OmniView line.

Undo To re-adjust the traced line.

Mix Selections: 0-100% in increments of 2. Allows you to mix a Rend Mode 1 

mode with a Rend Mode 2 mode. Always select two modes. 

Slice Thickness Select the slice thickness
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OmniView Control

Figure 13-27. OmniView Control

Table 13-18:  OmniView Parameters on Line Edit Mode: New

Parameter Description

Img. Activate the image.

Redo Restart the line.

OmniView Activate OmniView Line

View# Select the next OmniView image and line as 1, 2, or 3. 

Next Select to activate the next OmniView Ref. Line view.
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STIC (Spatio-Temporal Image Correlation) 

Overview

With this acquisition method the fetal heart or vascularity can be 
visualized. It is not a Real Time 4D technique, but a post 
processed 3D acquisition.

STIC is designed for beating (fetal heart) as well as blood 
perfused organs. Only STIC can synchronize structures that 
have a pulsation in Doppler mode, but no visible pulsation in 
B-Mode.

Data is acquired for a predefined period of time. The acquired 
images are post processed to calculate a Volume Cine 
sequence representing one complete heart cycle.

In order to achieve a good result, try to adjust the size of the 
volume box and the sweep angle to be as small as possible. The 
longer the acquisition time, the better the spatial resolution will 
be. The user must be sure that there is minimal movement of the 
participating persons (e.g., mother and fetus), and that the probe 
is held absolutely still throughout the acquisition period. 
Movement will cause a failure of the acquisition. If the user 
(trained operator) clearly recognizes a disturbance during the 
acquisition period, the acquisition has to be canceled.

A good STIC data set shows a regular and synchronous beating 
of the fetal heart or of an artery. Please make sure that the 
borders of the fetal heart or the artery are smooth and there are 
no sudden discontinuities. Always adopt a critical attitude to 
images created in STIC mode.

If the expected frame rate is too low (10Hz) for a good STIC 
quality, a warning is displayed in STIC mode.

After the STIC acquisition is finished the calculation process 
starts to calculate the volume cine sequence. If a result is 
detected by the system, the Volume cine sequence is shown in 
run mode and the STIC accept menu appears. As soon as the 
result is accepted the system releases the volume cine mode. If 
the result is not accepted but canceled, the system switches 
back to STIC pre mode.
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Overview  (continued)

One or more of the following artefacts in the data set indicate a 
disturbance during acquisition:

• Sudden discontinuities in the reference image B: These are 
due to the motion of the mother, the fetus or fetal arrhythmia 
during acquisition.

• Sudden discontinuities in the color display: Motion of the 
mother, the fetus or fetal arrhythmia affects the color flow in 
the same way it affects the gray image.

• Fetal heart rate far too low or far too high: After acquisition 
the estimated fetal heart rate is displayed. If the value does 
not correspond to the estimations based on other diagnostic 
methods at all, the acquisition failed and has to be repeated.

• Asynchronous movement in different parts of the image: 
e.g., the left part of the image is contracting and the right 
part is expanding at the same time.

• The color does not fit the structures displayed in gray mode: 
The color is displayed above or below the actual vessel.

• Color “moves” through the image in a certain direction: This 
artefact is caused by a failure in detecting the heart rate due 
to low acquisition frame rate. Use higher acquisition frame 
rate for better result.

NOTE: In all of the above cases the data set has to be discarded and 
the acquisition has to be repeated.

When is it not allowed to perform the STIC fetal cardio 
acquisition?

• Severe fetal arrhythmia

Following STIC acquisition modes are available:

• STIC

• STIC CFM

• STIC PDI
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Performing STIC Scan

NOTE: STIC can only be used in OB applications.

1. Select a 4D probe from the probe indicator.

2. After obtaining a feasible 2D image of the fetal heart or an 
artery, press 3D/4D to activate the Volume mode.

3. Select STIC.

4. Set the Volume of Interest (VOI) to be rendered. Use the 
Trackball to move and resize the VOI.

NOTE: Press top Trackball key to switch Pos and Size.

5. Adjust the Acquisition Time.

6. Set the volume sweep angle by using Volume Angle.

NOTE: In order to acquire a good result, try to adjust the ROI and 
the sweep angle to be as small as possible. The longer the 
acquisition time, the better the spatial resolution will be.

7. Hold the probe still and ask the patient not to move.

8. Press the right Set key to start the acquisition.

NOTE: When the STIC acquisition begins, the Stop Acquisition 
button appears. If the user recognizes a movement of the 
probe, fetus or the patient during the scan, press Stop 
acquisition to cancel the acquisition.

9. Hold the probe steady until the system stops automatically. 
Estimated Fetal Heart Rate and Accept/Cancel buttons 
appears on the Touch Panel.

10. Press Accept if the fetal heart rate displayed on the Touch 
Panel is accepted. STIC image is displayed.

If the result is not accepted, select Cancel. The system 
switches back to STIC-pre mode.

NOTE: If the user (trained operator) clearly recognizes a 
disturbance during the acquisition period, the acquisition 
has to be canceled.
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Screen Layout

The yellow caution icon and the calculated heart rate are 
displayed as well.

NOTE: Displayed Heart Rate indicates the heart rate [B/min] calculated 
from the delta time length per beat. A yellow caution icon 
indicates that the displayed heart rate is only an estimation. Do 
not diagnose based on this value.

 Figure 13-28. Screen Layout

STIC Controls

Touch Panel/All hard key and trackball controls are the same as 
in 4D/Static 3D mode. Therefore only the STIC relevant controls 
are described here:

Table 13-19:  STIC Pre-mode Touch Panel

Relevant controls Description

Acq. Time Only available in STIC. Acquisition time can be set.

Volume Angle Adjusts the volume angle.
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Contrast Imaging

Overview

NOTE: The LOGIQ Fortis is designed for compatibility with most 
commercially available Ultrasound contrast agents. Because the 
availability of these agents is subject to government regulation 
and approval, product features intended for use with these 
agents may not be commercially marketed nor made available 
before the contrast agent is cleared for use. Contrast-related 
product features are enabled only on systems for delivery to an 
authorized country or region of use. 

WARNING Misdiagnosis based on image artifacts

Misdiagnosis in ultrasound contrast images may be caused by 
several artifacts, most importantly:

Motion artifacts: Give rise to signals independent of contrast 
presence. This may be caused by patient movement (including 
respiration) or by probe movement influenced by the operator.

Regional drop outs: Caused by unintentional destruction of 
the contrast agent, too low concentration of contrast agent, 
poor acoustic penetration due to rib/lung shadows or the 
system failing to detect the contrast agent due to erroneous 
settings induced by the operator.

Tissue harmonics: Creates contrast-like signals 
independently of the presence of contrast agent.

CAUTION Cardiac rhythm disturbances during cardiac perfusion studies 
using gas ultrasound contrast agents have been observed in 
the diagnostic range of Mechanical Index (MI) values. See the 
specific package insert for the contrast agent being used for 
details.

CAUTION Read and follow contrast agent instructions provided by the 
manufacturer.
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Contrast Imaging Overview

By adjusting the acoustic output, you can enhance either 
contrast harmonics or stimulated acoustic emission (SAE).   

See Chapter 11 for probe availability. 

Coded Contrast Imaging utilizes three technologies: Amplitude 
Modulation (AM), Phase Inversion (PI), and Coded Harmonic 
Angio (CHA). 

• Contrast: Amplitude Modulation and Phase Inversion (AM 
and PI) is included in the Contrast option. 

Benefits The contract imaging technique, facilitated by the use of a 
contrast agent, detects non-linear signals while suppressing 
linear signals from surround tissue.  Blood containing the 
contrast agent stands out brightly against a dark background of 
normal tissue.

Clinical Use Possible clinical uses are to detect and characterize tumors of 
the liver, kidney, and pancreas and to enhance flow signals in 
the determination of stenosis or thrombus. 

Table 13-20:  Available Contrast Display Settings

 Label Description Clinical Use

Low MI B--Single Low MI B-Mode 

image display mode

Find the tumor before/after 

contrast agent injection

Tumor detection and 

characterization

Contrast Only—single contrast 

image display mode

Use contrast agent nonlinearity to 

detect contrast agent signal. 

Tumor detection and 

characterization

Single View--Single Contrast 

enhanced image display with low 

MI B-Mode image data 

acquisition mode

Use contrast agent nonlinearity to 

detect contrast agent signal. 

Tumor detection and 

characterization

Dual View—Real-time 

side-by-side dual image display 

with the right side contrast image 

and the left side B-Mode 

reference image

Use contrast agent nonlinearity to 

detect contrast agent signal. 

Tumor detection and 

characterization
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Contrast Imaging Overview  (continued)

Affect on other 

controls

The default acoustic output adjusts for contrast imaging and the 
Power Output key provides more subtle gradations for use while 
in contrast imaging. When you exit Contrast Imaging, the 
system returns the acoustic output to its original setting. When 
you reactivate Contrast Imaging, the system enters the default 
Contrast Mode. 

Most system controls are available (Depth, Zoom, Colorize, 
etc.). However, some controls are not available (Anatomical M 
Mode, Rejection, and Suppression). 

Controls adjusted while in Contrast Imaging retain these values 
when you exit Contrast Imaging (except for post-processing 
controls). 

Bioeffect Activating Contrast Imaging may change the TI and/or MI. 
Observe the output display for possible effects. 

The Power Output key has been enhanced to provide more 
subtle gradations for use while contrast imaging. The 
Mechanical Index displays values less than 0.1. These values 
are displayed on CINE Loops and on archived images. 

Feature 

Availability

3D and Volume Navigation are available; Multi Image and 
LOGIQView are not available. 

Technique 

Availability by 

Probe

Use the table in Chapter 11 to determine which contrast 
technique is available by probe. 



Contrast Imaging

LOGIQ Fortis – Basic User Manual 13-59
5855997-1EN Rev. 3

Mode

Reference Mode

Reference (Ref) Mode is to image the anatomical reference, not 
the contrast enhancement.

Contrast Mode

There are several contrast imaging techniques. Note that the 
appropriate imaging technique may vary by agent and 
application. In other words, the imaging technique is not 
dedicated for the agent and vice versa.

Contrast MVI Mode

Contrast MVI uses MVI (Micro Vascular Imaging) in Contrast 
mode. The characteristics of MVI's higher sensitivity and higher 
spatial resolution can be used in Contrast Imaging.

In addition to the MVI features, Flash, Flash + Capture, Max 
Enhance, and Contrast Clock can be used.

The choice of AM, PI, CHA mode in Contrast is not in Contrast 
MVI.

Support probes: C1-6-D, C1-6VN-D, L2-9-D, L2-9VN-D, 
L3-12-D and ML6-15-D.
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Contrast Presets

You access the Contrast Imaging Presets via Utility -> 
Imaging -> Ref or Con tabs. 

Acoustic Output 

Presets

To set the acoustic output value for Contrast Imaging, press the 
down arrow next to Acoustic Output (%)  on Con tab to select 
the value. 

To set the acoustic output value for the tissue image while in 
Single and Dual View mode, press the down arrow next to 
Acoustic Output for Single & Dual View (%) on Ref tab to set the 
value. 

To set the acoustic output value for the tissue image while in 
Low MI B-Mode, press the down arrow next to Acoustic Output 
(%) on the Ref tab to set the value. 

Time Delay To set the Trigger time delay, press the down arrow next to Time 
Delay. 

Dual View To set the default contrast mode, press the down arrow next to 
Default Mode on Con tab to select the mode.   

Additional Presets To adjust other Contrast Imaging presets (Map, Frame Average, 
etc.), press the down arrow to adjust the setting. See ‘Imaging 
Presets’ on page 10-29 for more information. 

Sonazoid™ Contrast Agent

Sonazoid™ is a contrast agent approved in some countries. 
Refer to local clearances and availability in your respective 
market(s).

Sonazoid is a different microbubble, compared to Sonovue. You 
can select the Sonazoid contrast agent via Utility--> Imaging--> 
CON. 
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Contrast Controls

Max (Maximum) Enhance

Description Sets the acoustic output to its maximum setting (100%)

Values On/Off. When you deactivate Max Enhance, the acoustic output 
is returned to its previous setting. Max Enhance is deactivated 
by the system when you turn it off, change probes, or change 
the contrast technique. 

Benefits This control provides quick transition to High MI imaging. This 
allows the user a quick one-button push to destroy the agent. 
Useful when the user is interested in the bubble wash-in 
characteristics of the anatomy being scanned. 
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Contrast Clock (Timer)

Description You can use the Contrast Clock by activating it at the time of 
injection and deactivating it at the end of the exam.

Two timers, Contrast Clock1 and Contrast Clock2 can be 
displayed on the bottom, left-hand corner in the image area and 
info area for several injections. 

NOTE: You can also configure the system to perform a countdown for 
the contrast injection with the Utility -> System -> System 
Imaging -> Countdown Time for Contrast preset.

Values On/Off. You deactivate the Contrast Clock via the Touch Panel 
control or by starting a new patient. 

Display There are two areas on the screen where the Contrast Clock 
displays: on the image and on the lower, left-hand portion of the 
display. The timer on the image freezes when you freeze the 
image (the timer updates when you unfreeze the image). 
However, the timer located on the lower, left-hand portion of the 
display continues to display over a freeze, probe change, mode 
change, multi image, and zoom. 

The timer also appears on CINE Loops and archived images. 

Benefits The Contrast Clock measures the time since injection. 

You can save the data of contrast clock to an external file by 
using Export Traces of TIC.

1. Press Freeze. Scroll with the Trackball to show Cine tab.

2. Press TIC Analysis on the Touch Panel to enter TIC 
application.

3. Put a ROI on the image.

4. Press Export Traces. Type the file name and store it to the 
storage device.
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Accumulation

Description Accumulation enhances the flow in an image. 

Values 8 settings: 0=Off, 0.2, 0.4, 0.6, 0.8, 1.6, 3.2, and Infinite. 

If Accumulation is turned off, then Frame Averaging is used; if 
Accumulation value is set, then Accumulation is used. 

Availability Available in Contrast, Color Flow, and PDI. 

Benefit Accumulation detects the maximum signal and holds it for the 
level specified (1-7). 

SRI Usage

Description You can use SRI-HD for the tissue image and the contrast 
image independently or together. 

Adjusting You can preset SRI Usage in Utility -> Imaging -> Ref tab. 

Visualization

Description Define the display technique. Only available for Single View or 
Dual View.

Values Contrast. Displays the contrast-enhanced image. 

Tissue. Displays the tissue image. 

Hybrid Contrast. Displays the contrast-enhanced image and 
the tissue image using Hybrid Map. 
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Hybrid Map

Description Select the hybrid map for the Hybrid Contrast visualization in the 
Dual/Hybrid Display.

Flash

Description This feature provides a way to expose the higher acoustic power 
for a specified time duration by pressing a control once. 

NOTE: Set the frame numbers to scanned with the higher acoustic 
power in Utility--> Imaging--> Con--> Flash Frames. The frame 
numbers defined by Flash Frames are applied to both the 
contrast imaging modes. 

• If you select Flash once in the Con menus, the system 
scans with 100% acoustic output burst pulses for the 
specified number of frames. The acoustic output then 
reverts to the original settings.

• When Max Enhance is ON for the contrast imaging modes, 
the system keeps Max Enhance = ON with no acoustic 
output change when Flash is selected in the Con menu.
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Relationship with other controls

• L + R Simultaneous Display (L: Tissue, R: Active 
Visualization)

• Accumulation/Cine Capture

- Applied on the right side image only.

- You cannot compare On and Off image using L + R.

• SRI-HD

- Applied on both side image.

• Frame Average

- Applied on both side image.

• TIC

• Measured on a recalled CINE, except “Hybrid Contrast”.

• “Hybrid Contrast” is disabled and measured on 
“Contrast” visualization.

• Easy 3D

• Build volume data from active visualization, except 
“Hybrid Contrast”.

• Hybrid map is disabled and forces “Contrast” 
visualization.

• Advanced 3D/Tru3D

• Build volume data from active visualization.

• For the Single/Dual View data set of contrast mode, 
both reference and contrast data are rendered in 
individual volume segments. Each volume data is 
manipulated using Active Data and Visual Data.

• 3D

• Hybrid Map is disabled and forces “Contrast” 
visualization.

• The Cine frames have “Contrast” data only.

• Archive

• The raw data size increases between two to three times 
the size compared to the previous raw data. It takes a 
longer period of time to save as Cine.
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Static 3D with Contrast 

Static 3D is available while in Contrast imaging mode while 
imaging with 4D probes.  

1. Activate Contrast imaging.  

2. Adjust the image, as necessary. 

3. Activate the Contrast Clock (if you want the acoustic output 
set at 100%). Or, you can activate these when you inject the 
contrast agent. 

NOTE: To restart the Contrast Clock, you need to turn it off, then 
back on. 

4. Activate 3D--> Static 3D. Specify the quality, angle, and 
render mode (Sectional, Render, and VCI Static are 
supported).  

Wait to inject the contrast agent until after you have set up 
your pre-mode data. Adjust the ROI and other parameters 
before injecting the agent. 

NOTE: Accumulation and Trigger turns off or resets to 0 when you 
activate Pre-mode.

5. Activate the Contrast Clock and inject the contrast agent, 
then press the Start Key to activate the Static 3D acquisition 
as soon as the contrast agent washes in. 

The system automatically ‘stores’ the sweep (to internal 
memory, not to the clipboard).  

NOTE: You may want to set up a Fast Key to automate these 
keystrokes. See Chapter 6 for more information. 
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Static 3D with Contrast  (continued)

6. To store this VOI, press a print key. All CINE and volume 
data loops are saved in 3D when you press P1. Store loops 
from Static 3D or from the Volume Review tab in order to 
store the complete volume. 

NOTE: You can also configure the system to perform a count down 
for the contrast injection via Utility-->System-->System  
Imaging. 

7. At the completion of the sweep, the Static 3D tab appears. 

NOTE: The Contrast Timer on the Volume Review images 
represents a timestamp of when the image was captured 
relative to when the timer was started. 

8. Press the Start key to acquire volume data. 
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Time Intensity Curve (TIC) Analysis

Overview

Time Intensity Curve (TIC) enables the user to perform the 
following analysis:

• Time-Intensity analysis allows instant time-intensity 
calculation from up to eight regions of interest.

• Curve fitting analysis for research studies of contrast agent 
concentration rates.

The basic TIC process works as follows:

1. Scan the patient after injecting the contrast agent.

2. Observe the agent flow through the anatomy of interest.

3. When the desired contrast effect has been visualized, 
freeze the image and select a range of images for analysis.

4. Position an ROI (region of interest) on one of those images 
where the contrast effect is visible.

5. The system then calculates the mean pixel intensity within 
that ROI for all frames in the user designated loop and plots 
the resulting data as a function of time.

You can also choose to fit this data to one of several 
mathematical functions. The fundamental idea is that the 
contrast effect flowing through the organ of interest can be 
modeled mathematically, and details of the wash in and washout 
of the agent can be gleaned by analyzing the numerical 
parameters of the mathematical model.
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Activating TIC

Starting TIC in cine loop

1. Open an examination and select a contrast cineloop.

2. Select TIC Analysis on the Touch Panel.

Starting TIC in live mode

1. Scan and freeze the patient in Contrast live mode.

2. Move the trackball to activate Cine.

3. Select TIC Analysis on the Touch Panel..

Exiting TIC Analysis

There are several methods to exit TIC Analysis.

• Select Exit TIC Analysis on the TIC Touch Panel.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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TIC Analysis Screen Description

 Figure 13-29. TIC Analysis Screen - Graph with dual image layout (example) 

1. Contrast cineloop window

2. B-Mode cineloop window

3. Analysis window

4. Sample area

5. Time and velocity at cursor position

6. Sample area tools

7. Layout icons

8. Frame marker

Table 13-21:  Cineloop windows 

 Graphic Description

Displays Contrast image data

Sample area:

Indicates sampling position of the intensity trace. The sample 

area is color-coded: the first sample area is yellow, the 

second blue...etc.
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Displays B-Mode data

Sample area:

Indicates sampling position of the intensity trace. The sample 

area is color-coded: the first sample area is yellow, the 

second blue...etc.

NOTE: B-Mode image is not displayed when cine clip stored 

in contrast only mode.

System menu on Sample Area

This menu is displayed by pressing the left Set key when the 

cursor is placed over a sample area in one of the Cineloop 

windows.

Note: The system menu is dependent on mode.

• Set As Default ROI Size: Displays on elliptical ROI.

• Label Sample Area: Sets a descriptive name to the sample 

area. The label is useful for identification of the sample area 

when exporting data.

• Delete Anchor (On ROI setting as anchor point only)

• Copy Sample Area

• Copy & Move

• Copy & Move (Same Depth)

• Move (Same Depth)

• Set Start Frame: Set start frame for current ROI to calculate 

the TIC parameters and fitting curves.

• Set End Frame: Set end frame for current ROI to calculate 

the TIC parameters and fitting curves.

• Cancel: exits the System menu.

System menu on Image when copy sample area is selected. 

• Paste Sample Area

Displays time-intensity curve.

• Y axis: Intensity scale (logarithmic) (db) or linear acoustic 

units (AU).

• X axis: Time(s) or Dt(s), elapsed time from previous frame. 

• ECG (where available -- not shown): displays ECG trace 

(where available).

• Frame Marker: the current frame marker and the start and 

stop markers for the cineloop.

• Time at cursor position and velocity at cursor position.

• Intensity (dB or AU) at cursor position.

• Intensity (dB or AU) at frame marker position (color coded)

Table 13-21:  Cineloop windows  (Continued)

 Graphic Description
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System menu of the analysis window

This menu is displayed by pressing left Set key when the 

cursor is in the Analysis window.

Note: The system menu is dependent on mode.

• Vertical Auto-Scaling: selects between full unit range or a 

range according to the maximum and minimum values of 

the displayed trace(s). Delayed, On, Off.

• Vertical Unit: toggles between logarithmic (dB) and linear 

acoustical units (AU). Vertical unit of previous analysis is 

retained. 

• Horizontal scale: Only on a loop including different frame 

rate.

• Line Style: selects between solid line only or solid line with 

square markers at each data point.

• TIC Parameters:  The TIC parameters dialog appears.

• Curve Fitting Parameters: toggles between Wash-in, 

Wash-out, Gamma Variate and off.

• Gradient: On or Off.

• Gradient Plot: Gradient, Gradient Derivative, All or Off  (On 

Graph with Dual Image Layout and Small Data Layout only).

• ECG Triggering: Only on a loop including the ECG cycle.

• Cancel: exits the System menu.

Table 13-22:  Analysis windows 

 Graphic Description

Displays time-intensity curve.

• Y axis: Intensity scale (logarithmic) (db) or linear acoustic 

units (AU).

• X axis: Time(s) or Dt(s) [Diastolic time in seconds], elapsed 

time from previous frame. 

• ECG (where available -- not shown): displays ECG trace 

(where available).

• Frame Marker: the current frame marker and the start and 

stop markers for the cineloop.

• Time at cursor position and velocity at cursor position.

• Intensity (dB or AU) at cursor position.

• Intensity (dB or AU) at frame marker position (color coded)

Table 13-21:  Cineloop windows  (Continued)

 Graphic Description
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System menu of the analysis window

This menu is displayed by pressing left Set key when the 

cursor is in the Analysis window.

Note: The system menu is dependent on mode.

• Vertical Auto-Scaling: selects between full unit range or a 

range according to the maximum and minimum values of 

the displayed trace(s). Delayed, On, Off.

• Vertical Unit: toggles between logarithmic (dB) and linear 

acoustical units (AU). Vertical unit of previous analysis is 

retained. 

• Horizontal scale: Only on a loop including different frame 

rate.

• Line Style: selects between solid line only or solid line with 

square markers at each data point.

• TIC Parameters:  The TIC parameters dialog appears.

• Curve Fitting Parameters: toggles between Wash-in, 

Wash-out, Gamma Variate and off.

• Gradient: On or Off.

• Gradient Plot: Gradient, Gradient Derivative, All or Off (On 

Graph with Dual Image Layout and Small Data Layout only).

• ECG Triggering: Only on a loop including the ECG cycle.

• Cancel: exits the System menu.

Table 13-23:  Layout icon 

 Graphic Description

You can select layout from following.

• Graph with Dual Image Layout

• Small Data Layout

• Large Data Layout

• Everything Layout

• Single Image Layout

• Dual Image Layout

Indicates an analysis graph.

Indicates an image

One icon means Contrast image. Two icons mean Contrast 

and B-Mode.

Indicates parameters.

10 dots means that all parameters display. 4 dots means that 

only displays high level parameters.

Table 13-22:  Analysis windows  (Continued)

 Graphic Description
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Table 13-24:  Sample area drawing tool 

 Graphic Description

Creates a sample are based on freehand drawing.

Creates a sample area with a pre-defined circular/elliptic 

shape.

Table 13-25:  Trackball Assignment 

 Graphic Description

Press the top Trackball key to toggle the trackball assignment 

between QA and Scroll.

• QA

Pointing tool in TIC mode.

• Scroll

When the cineloop is stopped, enables scrolling through the 

cineloop.

• Menu

Press left Set key to display System Menu.

• Set
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TIC Touch Panel

Table 13-26:  TIC Touch Panel Description

Parameter Description

Exit TIC Analysis Exit TIC. 

Motion Tracking Users use TIC to analyze tumor characteristics precisely, without distortion 

due to patient movement. Motion Tracker enables the system to 

automatically adjust the ROI’s placement across multiple frames in order to 

accommodate patient breathing or body movements.  

To activate, press Motion Tracking on the Touch Panel. This starts the 

calculation to adjust the all ROI positions for every image frame. After 

completion, the ROI graphic on each frame is changed to the ROI with the 

anchor. 

Accumulation Enhances the flow in an image. 

Enable All Frames Re-enables disabled frames. 

Curve Fitting Toggles between Wash-In, Wash-Out, Gamma Variable and Off. 

Smoothing Smooths the trace displayed by applying a filter over a defined time window. 

Both the filter type and time window are user-selectable. The type of filter 

available depends on the analysis signal displayed. 

Delete Sample Area Removes selected sample area from the CINE Loop window and 

accompanying trace in the Analysis window. The Trackball marker must be 

pointed at an anchored sample area. 

Auto Calc Range Auto Calc Range enables system to automatically estimate the ROI's start 

frame and end frame to calculate TIC parameters and fitting curves. The start 

and end frames for each ROIs are displayed by small squares on the graph. 

Toggles between Current Sample, All Samples and Reset All.

First Move to the first frame of cineloop.

Last Move to the last frame of cineloop.

Run/Stop Start/Stop the cineloop review.

Loop Speed Adjust the cine loop playback speed.

ROI width/height Move the rotary left/right or up/down to adjust ROI width/height.

ROI tilt angle Rotate the rotary to adjust ROI tilt angle.
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Start Frame Rotate the rotary to select the start frame and push to set the frame.

End Frame Rotate the rotary to select the end frame and push to set the frame..

Frame by Frame Rotate the rotary to review the CINE image frame by frame manually.

Disable frame Push the rotary to disable the selected frame.

Table 13-26:  TIC Touch Panel Description (Continued)

Parameter Description
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Generating a Trace

Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) 
before anchoring.

NOTE: The free sample area disappears when the QA cursor is 
moved over a static anchored frame.

• Static sample area: the free sample area is anchored by 
pressing Set.

• Dynamic anchored sample area: the sample area is 
anchored in two or more frames (see Manual tracking 
below). In these particular frames, the sample area is 
displayed with an anchor. The sample area moves smoothly 
between the anchored positions when playing/scrolling the 
cineloop.

Trace from a pre-defined sample area (Ellipse ROI)

1. Press the top Trackball key until the QA trackball 
assignment is selected.

2. If necessary, select the sample area Ellipse ROI button  
(shape icon on the monitor display).

3. Move the cursor to one of the Cineloop windows using the 
Trackball.

The cursor is changed to a sample area (white circle). A 
preview of the trace is displayed in the Analysis window.

4. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If 
the cineloop has more than one heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle.

The trace is updated accordingly in the Analysis window.
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Generating a Trace  (continued)

Trace from freehand sample area

1. Select the Freehand ROI button  (pencil icon on the monitor 
display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Trace the outline of the desired ROI by moving the caliper 
with the Trackball.

4. Press Set to anchor the sample area.

The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window.

Copy, move and paste a Sample Area

To copy and paste the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Copy sample area.

3. Move the cursor to the desired location for the copied ROI 
and press the left Set Key. The system menu displays. 

4. Select Paste sample area. 

To copy and move the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Copy & move. Or if you want to move to the same 
depth as the original ROI, select Copy & move (same 

depth).

3. Move the copied ROI using the Trackball. Press Set to fix 
the position.

To move the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Move (same depth).

3. Move the ROI using the Trackball. Press Set to fix the 
position.
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Manual tracking of the sample area (dynamic anchored sample area)

The sample area can be moved within the loop to ensure that 
data in the trace is generated from the same anatomical location 
during the cyclic motion of the heart.

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

NOTE: In the original frame and this particular frame the sample 
area is marked with an anchor.

7. Press the top Trackball key until the scroll trackball 
assignment is selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.



Advanced Features

13-80 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Moving a dynamic anchored sample area

1. Freeze the image.

2. Press top Trackball key until the scroll trackball assignment 
is selected.

3. Using the Trackball, browse through the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

4. Press top Trackball key until the QA trackball assignment is 
selected.

5. Move the cursor to the sample area using the Trackball.

6. Press Set. The sample area is unanchored.

7. Drag the sample area to a new location.

8. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 
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Zooming in the Analysis window

To zoom:

1. In the Analysis window, press and hold down the Set key 
while dragging the cursor to define the zooming area.

2. Release the Set key.

To unzoom:

1. Press the left Set key in the Analysis window. The system 
menu displays.

2. Select Unzoom.

NOTE: Shown only in zoom mode.

Delete a trace

The user can delete all traces at once or one at a time.

1. If necessary, press the top Trackball key until the QA 
trackball assignment is selected.

2. Move the cursor over one of the sample area. Confirm that 
cursor is changed to hand icon.

3. Press the Delete Sample Area on the touch panel.

4. Select Current Sample or Delete all as necessary.

NOTE: The corresponding traces for the deleted ROIs are erased from 
the plot.
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Disabling/Enabling the frame

Frame disabling excludes the actual frame from the cineloop 
display. Frame disabling is available only with contrast data.

Disabling the frame from the frame marker

To disable One Frame :

1. Use the Trackball to move the cursor to the frame on the 
Frame Marker which you want disable.

2. Press Set to disable the frame.

3. The frame marker is changed from green to red to indicate 
the frame has been disabled. 

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory.

Disabling multi-frames from the frame marker 

1. Use the Trackball to move the cursor to the first frame on 
the Frame Marker.

2. Press and hold down Set 

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.

Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in 
all heart cycles but a selected one. This function can be used for 
example to select a particular systolic frame for each heart 
cycle.

1. Scroll through the cineloop to identify the cardiac phase to 
analyze or identify the cardiac phase on the ECG trace 
(where available).

2. Position the cursor on the analysis window and press left 
Set key. The system menu displays.

3. Select ECG triggering (where available).

All frames in all heart cycles are disabled except for the 
selected and corresponding frames in the other heart 
cycles.
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Disabling/Enabling the frame  (continued)

To enable the frames

1. Select Enable all frames on the Touch Panel.

2. All disabled frames are re-enabled.

Figure 13-30. Frame markers

1. Analysis Window

2. Frame markers axis

3. Enabled frame (Green)

4. Disabled frame (Red)

5. ECG (where available)

6. Current frame
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Manipulating the Sample Area

Up to eight ROIs can be saved on the reference image, with the 
corresponding eight traces plotted simultaneously on the graph. 
Each ROI display has a different color, and its corresponding 
trace data is plotted using that same color.

Once eight ROIs have been saved, the system does not 
automatically generate an active ROI when the cursor is 
positioned over the displayed reference image.

The saved ROIs can be a mixture of elliptical and freehand 
ROIs.

When the user repositions an ROI, the old trace data is erased 
from the plot and the trace data for the new position replotted.

If the ROI position on the last frame of the selected image range 
is moved, the corresponding ROIs on all frames are 
repositioned to match the last frame.

The user shall also have the capability of setting separate ROI 
positions on different frames of the contrast images, and the 
system shall linearly interpolate the ROI positions for the frames 
in between the selected frames. 
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Manipulating the Sample Area  (continued)

Setting the default sample area shape

1. Place the cursor on the sample area.

2. Press left Set key. The system menu displays.

3. Select Set as Default ROI Size.

4. The current ROI size is set as the default for subsequent 
Ellipse ROIs.

Reshaping a Sample Area

To reshape the sample area:

Figure 13-31. ROI 

• Move the rotary up and down to change the height.

• Move the rotary left and right to change the width.

• Rotate the rotary to change the tilt angle.

Labeling a Sample Area

The sample area label is used to identify data associated with 
the sample area when exporting.

1. Position the cursor on the ROI to label and press the left Set 
key.

2. The ROI system menu displays. Select Label sample area. 
The Label Dialog box displays.

3. Enter a name for the sample area.

4. Select OK.
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TIC Plot Control

Vertical Unit

When analyzing the contrast data, the Y-axis can be set to 
display either logarithmic scale (dB) or linear, acoustic units (AU) 
for both tissue intensity (2D) or Angio intensity data.

To toggle between dB and acoustical display units for the Y-axis. 
The unit of previous analysis is retained. 

• dB—The traditional log compressed B-Mode data is used to 
calculate the time-intensity curve values.

• Acoustic—The system reverse the log compression 
function to provide un-log compressed data for the TIC 
analysis.

Vertical auto-scaling

The system can be configured to display the full unit range or a 
range according to the maximum and minimum values of the 
displayed trace(s) (auto-scaling function). In addition, the 
auto-scaling function can be set to be live update (updates while 
the sample area is moved) or delayed (updated when the 
sample area is anchored).

• Delayed—The system automatically rescale the vertical 
axis of the trace graph only when a new ROI is saved, to 
account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of 
the trace graph every time the currently selected (active) 
ROI is moved.

• Off—Disable any automatic scaling of the vertical axis. 
There is user-defined system defaults on the system preset 
page for the fixed vertical scale to be used for the plot.

Y-Scale

1. When you select “Off” for Vertical Auto-Scaling, Y-Scale 
dialog displays.

2. Enter maximum and minimum value for vertical scale on the 
graph.

3. Press OK. The vertical scale is updated. 
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TIC Plot Control  (continued)

Line Style

• Solid—Setting the results in a plotted trace that does not 
display small boxes at the data points

• Squares—Setting the results in a plot where small squares 
are displayed at each data point, and the squares are linked 
together by lines.

Horizontal Scale

Set the horizontal unit as time scaling (s) or time interval (dt) 
between frames.

NOTE: Only on a loop including different frame rate.

Smoothing

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing on the Touch Panel.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays.  Select the appropriate 
parameter.

NOTE: When smoothing is turned on, it applies to all traces in the plot 
window.
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Trace Measurement

Gradient

Gradient is displayed on the screen instead of Intensity (db or 
AU). The gradient calculates from 7 points (includes previous 
and next frames). 

Figure 13-32. Gradient
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Trace Measurement  (continued)

TIC Parameters

Following parameters are automatically calculated and 
displayed with the graph. 

 Figure 13-33. TIC Parameters

Table 13-27:  TIC Parameters

MGrad Maximum Gradient

MGT Max Gradient Time

Grad. Mean Gradient for the peak intensity.

ArT Arrival Time

TtoP Time to Peak

PI Peak Intensity

TWH Time Width at Half maximum intensity

TWR Time Width Ratio for wash-in and wash-out

AUC Area Under the Curve

WiAUC Wash-in Area Under the Curve

WoAUC Wash-out Area Under the Curve

A, B, C, k and MSE The coefficients and the mean square error for fitting curve equation. These 

parameters are displayed only on Large Data Layout with curve fitting.
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Trace Measurement  (continued)

Show graph (Gradient plot)

1. Select Gradient Plot from the pull-down menu.

2. Select the parameter.

• Off: A graph plots TIC.

• Gradient: Two graphs plot TIC and TIC gradient.

- Unit of Y-axis is dB or AU in case of intensity.

- The unit is d(db)/dt or d(AU)/dt in case of the intensity 
gradient.

- Gradient values for the current frame are displayed in 
the upper right corner of the graph.

• Gradient Derivative: Two graphs plot TIC and TIC 
gradient derivative.

- The Y-axis units is d2(dB)/dt2 or d2(AU)/dts in case of 
the intensity gradient derivative.

- Gradient derivative values for the current frame are 
displayed in the upper right corner of the graph.

• All: Three graphs plot TIC, TIC gradient and TIC 
gradient derivative.
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Curve Fit

1. Select Curve Fitting on the Touch Panel.

2. The Curve Fit selection list displays.

Figure 13-34. Curve Fit Selection List

• Off—Remove the fitted curves from the plot and the fit 
parameters from the display.

• Wash-in—Used to find and estimate the local perfusion rate 
using the contrast agent. Exponential wash-in is described 
by the function:

Y(t) = A(1-exp(-kt))+B, where:

• A (dB or AU) is the intensity from the contrast agent.

• B (dB or AU) is the intensity at time t=0 (defined as the 
time of the left marker). This corresponds to the tissue 
(baseline) signal if no contrast is present at the selected 
starting point.

NOTE: A + B = contrast + tissue = plateau level.

• k (1/s) is a time constant.

• Wash-out—Used to find and estimate a local wash-out rate. 
Expotential wash-out is described by the function:

Y(t) = Aexp(-kt)+B, where :

• A (dB or AU) is the intensity from the contrast agent.

• B (dB or AU) is the intensity from the tissue = baseline 
signal.

NOTE: A + B is the initial intensity level.

• k (1/s) is a time constant.

• Gamma variate

Y(t) = Atcexp(-kt)+B
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Parameters of Gamma curve fitting

Figure 13-35. Gamma Curve

• tc: Increasing function (C>0) for “Wash-in”. 

For larger C, the intensity increases quickly before the peak. 

• exp(-kt): Decreasing function (k>0) for “Wash-out”. 

For larger k, the intensity decreases quickly after the peak. 

• B: Intercept intensity at t=0. 

• The peak intensity of the curve is affected by all parameters. 

Larger A, larger B, larger C, and smaller k make larger peak. 
The peak time is calculated by C/k. 

• MSE: Mean Square Error

If the MSE is small, the difference of actual data and the 
fitted curve is small. 
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Set Start/End Frame for Curve Fit per ROI position

1. Generate TIC and perform a Curve Fit. In this state, the 
Curve Fit graph is drawn from Cine Start Frame to Cine End 
Frame for all the ROIs. 

2. Push Auto Calc Range on Touch Panel and select All 
Samples. Then the start and end frames for each ROI are 
automatically estimated.

If you need to optimize the start and/or end frames, 

1. Select the start frame as with Cine or move the cursor to the 
desired position on the graph and press the right Set key.  

2. Move the arrow pointer on the ROI (hand cursor appears) 
and press the left Set key. The system menu appears. 

3. Select Set Start Frame from the menu. 

4. Select the End Frame as with Cine or move the cursor to the 
desired position on the graph and select the right Set key. 

5. Move the arrow pointer on the ROI (hand cursor appears) 
and select the unmarked key (the left Set key). The system 
menu appears. 

6. Select Set End Frame from the menu. The ROI colored line 
displays. 

7. Repeat the above procedures as necessary. The system 
retains the start/end frame per ROI while TIC is active. Once 
the TIC menu is closed, the settings are lost.
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Display/Hide Calculation Values

You can select the TIC parameters for Small Data Layout and 
Everything Layout.

1. Place the cursor on the analysis graph and press left Set 
key. Select TIC Parameters from the pull-down menu. 

2. The TIC Parameters dialog appears. 

3. Select a maximum of 6 parameters to display for each TIC.

• Save As Default : saves as a system preset.

• Save : saves as temporary.

• Cancel

NOTE: If you select more than 6 parameters and select Save or 
Save as default, you will be prompted to select up to 6 
parameters.

4. The selected parameter displays for Small Data Layout and 
Everything Layout. Press the Large Data Layout button to 
display all parameters; or press the other Layout button to 
hide all parameters. 

Figure 13-36. Curve Fitting Parameters Dialog
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Raw Data store with TIC Setting

You can store the raw data with TIC setting.

1. Run TIC cineloop. 

2. During cine running mode, press appropriate print key.

When you recall the raw data clip with TIC data, you can add, 
delete or modify the analysis measurements on the recalled raw 
data in TIC mode.

Printing TIC Data

1. Press Run/Stop to freeze the image.

The still image can be get when cineloop is stopped by Run/
Stop button. 

2. The system captures a single still frame which consists of 
the plot, the reference image and user annotation.

Annotating the TIC Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.
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SaveAs (Save image file and export trace data)

You can save the image file and trace data.

1. Select SaveAs. 

2. The following dialog displays.

• Location: Select Location which to save.

• Filename: Enter the file name. (Only Text)

• Export Trace: If you check this box, LOGIQ Fortis 
exports trace data to csv file. 

Note: Name of exported file has same name as the 
image file saved at the same time.

3. Select OK to save the image and data and return to the TIC 
Analysis screen.

• All displayed ROI traces are saved in the exported file.

• The fit parameters are included in the trace file if the 
user has done a curve fit.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: Data for disabled frames are not included in the exported trace 
file.

NOTE: No trace results are saved in the standard image database.

NOTE: Trace results are not shown on the Worksheet.
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TIC cineloop store

When you transfer TIC cineloop to the external server, check 
“Add Multiframe Data” in Utility -> Connectivity -> Button and 
then store the cineloop to the system. 

Figure 13-37. Button page
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Parametric Imaging  

Overview

The Parametric Imaging is the application to mainly visualize the 
contrast agent "arrival time" in colors by processing cine loops 
with pre-defined threshold value for each pixel.

Parametric Imaging is available for cineloop of B-Mode (includes 
CHI mode), Contrast mode and B-Flow mode.

 Figure 13-38. Parametric Imaging - Example

NOTE: Parametric Imaging mode is available only if the LOGIQ Fortis 
has a valid option key.

Typical Workflow

Here is the typical workflow for Parametric Imaging:

1. Enter Contrast Mode.

2. Inject the contrast agent.

3. Store the Contrast images until the contrast agent reaches 
the anatomy of interest in a very early phase.

4. Activate Cine mode and select the start frame/end frame of 
calculation if needed.

5. Select background image type as needed.

6. Press Parametric Image on the CINE Touch Panel.
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Typical Workflow  (continued)

Calculate and color encode according to the arrival time to 
CINE image with motion correction.

Figure 13-39. Calculating

7. Cine playback stops automatically when the calculation is 
done. You can playback/stop using Run button as normal 
cineloop.

NOTE: You can cancel in the process of the calculation.

8. Measure the arrival time and time difference.

9. Save the data.

10. Unfreeze the image.
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Background selection

You can select background image depending on the display 
setting of the contrast image.

• Gray map, Tint map: Black/White Contrast image

• Hybrid visualization: Black/White Reference Image

Table 13-28:  Background selection - Gray map/Tint map

Gray map Tint map

Capture On Capture Off

Parametric Image Map

On

Parametric Image Map

Off

Background: Contrast image
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Background selection  (continued)

Table 13-29:  Background selection - Hybrid Visualization

Hybrid visualization

Capture On Capture Off

Parametric Image Map

On

Parametric Image Map

Off

Background: Reference Image
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Configuration parameters

You can adjust the following parameters. Press Parametric 

Property on the Cine Touch Panel.  

• Color bars

• Transparent

• Gradation

• Capture

• Threshold

• Motion correction method

• Preset Load/Save

Figure 13-40. Parametric Property widow
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Color bar

Select the colors for parametric imaging, the numbers of color 
and the timing for color change.

Figure 13-41. Color bar window

Adjustment and 

change color bar

Click on the color bar and select for

• Change color: Click Change Color. The color window 
displays. Select appropriate color and click OK.

• Change length of each color: Drag the right border line left 
or right to change the length.

• Entire length of color bar (length of most right color): Click 
let or right triangle icon under the color bar to change the 
length.

• Delete color: Click Delete.

Add color bar Click Add and select color.
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Save As

1. Click Save As. The Save As preset window displays.

2. Click on the color bar which you want save to select.

3. Press Save. You can save up to 8 color bars with:

• Color bars

• Transparent

• Gradation

• Capture

• Threshold level

• Motion correction method

Figure 13-42. Save As window
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Load the parameters

1. Click Load....

2. Select appropriate map and click Load on the Load preset 
window.

3. After you change map, you have to click Recalculate to 
recalculate the arrival time. 

NOTE: If you want reload factory default setting, click Reload Factory 

Defaults on the Load preset window.

Figure 13-43. Load Preset window
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Other parameters

Figure 13-44. Transparent, Gradation, Capture

Figure 13-45. Threshold, Transparent %, Motion Correction
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Other parameters  (continued)

Transparent Click the checkbox next to Transparent to bring out the contrast 
image behind the parametric image.

You can change the percentage of transparency.

1. Click More on the Parametric property window.

2. Type the percentage. The higher the number, the more 
transparent the background contrast image.

NOTE: You can adjust the percentage by CF Volume key.

Gradation Check the checkbox next to Gradation to smooth the color 
gradient of adjacent colors.

Capture Check the checkbox next to Capture to use the captured image 
of background image.

Threshold Type threshold level (0 - 100%) to decide the arrival time.

Motion correction Select Motion Correction On/Off and correction method.

• Off: No motion correction 

• On: Motion correction on

• With rotation: X-Y direction with rotation

• No rotation: X-Y direction without rotation

• X Only: X direction only
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Other parameters  (continued)

Table 13-30:  Transparent, Gradation, Capture

• Transparent On

• Gradient On

• Capture On

Transparent Off Gradient Off Capture Off

Table 13-31:  Background image

Capture On Capture Off
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Trackball key for Parametric Imaging

Press Upper Trackball key to select Parametric Imaging Control. 
Parametric Imaging controls are assigned to each Trackball key.

Figure 13-46. Trackball key map

Map On/Off

Display the Parametric Image On/Off. If you select Map Off,  the 
background image displays temporarily. 

 Figure 13-47. Map On/Off
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Trackball key for Parametric Imaging  (continued)

Adjust start

 Figure 13-48. Adjust start

Press Adjust Start to change zero point where you place the 
cursor.

NOTE: Points before new zero point, change the color same as zero 
point.

NOTE: The cursor displays on the reference image, too.

Reset start

Press Reset Start to reset zero point to the start frame of the 
cineloop.
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Measurement

Arrival time

1. Press Measure and move the cursor on the image. The 
pointer changes to green cross type.

2. The arrival time of the cursor position displays in the 
measurement result window.

 Figure 13-49. Measurement on the parametric image
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Arrival time and Standard deviation

You can calculate the average arrival time and standard 
deviation of the traced area.

Figure 13-50. Trace measurement

• Arrival time

2D point caliper

• Arrival time and Standard deviation

2D ellipse, 2D 3 point ellipse, 2D circle, 2D area trace, 2D 
spline trace

• Arrival time and Standard deviation for dual view

2D dual area trace, 2D dual ellipse, 2D dual spline trace, 2D 
dual circle

NOTE: You can create measurement preset (Dual trace, etc.) in Utility 
->  Measure -> M&A tab. See ‘Adding a Measurement’ on 
page 7-89 for more information.
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Strain Elastography

Description

Strain Elastography shows the spatial distribution of tissue 
elasticity properties in a region of interest by estimating the 
strain before and after tissue distortion caused by external or 
internal forces. The strain estimation is filtered and scaled to 
provide a smooth presentation when displayed. 

Below is an example of Strain Elastography. The image is 
displayed in dual mode with the color map/bar of the Strain 
Elastography on the left side and the imaging parameters on the 
right side of the display below E. 

You activate Elastography via the Elasto hard key on the Control 
Panel. 

 Figure 13-51. Strain Elastography Example
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Using Strain Elastography

The Strain Elastography image is achieved by pulsating the 
probe while you are scanning the anatomy of interest. Here are 
some criteria to use: 

Handheld elasticity imaging can be very dynamic as the size of 
distortion depends on the movement of the hand-held probe. To 
maintain stable and consistent displayed strains, pay attention 
to the Quality graph. Two forms of feedback are provided. In 
either form, an ideal manual compression is indicated by a high 
value feedback. In addition, apply the following post-processing 
controls: Smoothing, Window, Scaling, and Frame Averaging. 

Strain Elastography displays firmer tissue in blue and softer 
tissue in red. To enhance Blue, increase Hard Compress; to 
enhance Red, increase Soft Compress on the Touch Panel. To 
enhance strain elastography contrast, reselect the Color Map. 

If you need more resolution, reduce Smoothing, increase 
Frequency, or reduce Window.

If you need a smoother image, increase Window or Smoothing. 

If the images seem too flashy, decrease Frame Reject to 1.0 and 
Noise Reject to have consistent imaging throughout. 
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Using Strain Elastography  (continued)

Table 13-32:  Strain Elastography 

 Using Strain Elastography

Manual Compression:

1. Press “Elasto” button at the console to 

activate.

2. Select Strain on Touch Panel.

3. Adjust the position of the ROI to place the 

suspicious area at the center.

4. Adjust the size to include surrounding tissue 

(sample area size = x3 dimension of the lesion 

per axis).

Manual compression depends on the type of 

probe.

1. Linear probes: Perform slight compressions 

keeping transducer perpendicular to the skin. 

Duration: 5 sec or 10 compressions.

2. Convex probes: Turn the patient on his left side 

more than 90 deg. Pressing with the probe 

above the lesion, allowing the heart and lungs 

to create the compressions.

3. Endocavitary probes: Perform soft, angular 

movement in plane of the probe. Duration: 5 

sec or 10 compressions.

Note 1: Any very soft (vessel, cyst, air) or very stiff 

(bone) tissue above the lesion or the reference 

area may cause interference with the 

compressions. You may want to attempt from a 

different view.

Note 2: Keep the lesion within the image and watch 

the quality graph for consistent high nearly flat 

(plateau-like) peaks.

Select the frame to analyze

1. Press “Freeze.”

2. Using the trackball or “frame by frame” knob, 

select a frame on a plateau of the quality graph 

(Image 1, A) or when consistent frames with 

green bars are visualized (Image 1, B).

Image 1: Elastography image with quality graph (A), 

quality bar (C) and elasto color bar (B).

The relation between elastography colors and area’s 

stiffness is given at the elastography color bar (Image 

1, B).

Less Stiff

Stiffer
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Clinical Applications

Strain Elastography Controls

Table 13-33:  Clinical Applications 

Application Compare the suspicious lesion with: Probe

Breast A fatty area in the breast or the average rounding 

breast tissue.

• L2-9-D/L2-9VN-D

• ML6-15-D

• L3-12-D

Thyroid A normal area in the parenchyma of the gland. • L2-9-D/L2-9VN-D

• ML6-15-D

• L3-12-D

• L8-18i-D

MSK A normal area in the same part of the body. • L2-9-D/L2-9VN-D

• L8-18i-D

• L3-12-D

• L8-18i-D

Liver A normal area in the parenchyma of the liver. • C1-6-D/C1-6VN-D

• C2-9-D/C2-9VN-D

• L2-9-D/L2-9VN-D

Prostate A normal area in the parenchyma of the prostate. • IC5-9-D

• BE9CS-D

Uterus A normal area in the parenchyma of the uterus. • IC5-9-D

Table 13-34:  Strain Elastography Touch Panel Description

Parameter Description

Axial Smoothing Controls the smoothness of the strain elastography image in the axial 

direction. A higher value means a smoother image.

Lateral Smoothing Controls the smoothness of the strain elastography image in the lateral 

direction. A higher value means a smoother image.

Window Controls the RF data segment size for the motion tracking. A higher Window 

value gives a better signal to noise ratio (SNR) at the cost of axial resolution.

Map Controls the strain elastography maps. Seven different maps are available 

with various contrast and color schemes, including a grayscale map. 

Selections: E0-5, E-Gray, and S Map.

The E Map calculates the mean strain for the whole ROI and assigns this 

mean value to a green (center) color. This is best suited for imaging a 

localized mass compared to the surrounding tissue with external forces (the 

movement of the hand-held probe). 

The S Map is useful for imaging diffusely-distributed diseases and local 

strain changes brought about by internal forces such as the movement of a 

beating heart and moving vessels. The default strain sensitivity is unique by 

probe/application.  You can adjust the strain scale by adjusting the strain 

sensitivity tool. 
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Frame Average Controls the persistence of the strain elastography images. 

Frequency Controls the transmit frequency.

Strain Sensitivity If S0 Map (in live) is selected, the user can control Strain Sensitivity (SS). 

Soft Compress Individually controls the image enhancement for the softer than average 

tissues.

Hard Compress Individually controls the image enhancement for the harder than average 

tissues.

Scale Controls the time interval between consecutive firings. A lower value dictates 

a higher sensitivity to weak manual motion.

Transparency High values bring out the tissue behind the strain elastography data. You 

adjust via the Color Gain control; this imaging parameter appears as a “T” on 

the right-hand portion of the display. 

Biopsy Kit Biopsy Kit.

Frame Reject Controls how many frames get rejected due to low quality vertical motion. A 

higher value means more frames get rejected. A rejected frame has a 

completely transparent ROI with the B-Mode background showing through.

Noise Reject Controls how many frames get rejected due to lateral and elevational motion. 

A higher value means more frames get rejected. A rejected frame has a 

completely transparent ROI with the  B-Mode background showing through.

Line Density Optimizes B-Mode frame rate or spatial resolution for the best possible 

image. 

Table 13-34:  Strain Elastography Touch Panel Description (Continued)

Parameter Description
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Application Parameters

You can set the Quality Bar and Quality Graph on the Utility--> 
Application--> Settings --> Elasto page. 

For Quality Bar: 

• Check to display a Quality Bar for Elastography.

For Quality Graph: 

• Off (No elasto quality graph is displayed in the image)

• Small, Medium or Large for display size of Quality Graph.

General Imaging Parameters by Application/Probe/Feature

Select the Default Elasto Mode via Utility--> Imaging--> General. 

You can specify Strain to be the default setting by application 
and probe.

1. To specify a default probe per application, select Utility --> 
Imaging --> General.

2. Select the application. 

3. Select the default probe from the pull-down menu.

4. Specify the Default Elasto setting: 

• Strain

• Shear
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Elastography Analysis

Overview

The Elastography Mode detects strains by correlating the echo 
amplitudes of the tissue when compressed and uncompressed. 
Different displacement of echoes is an indicator for different 
stiffness (strain) of the tissue. High strain means that the tissue 
is softer, low strain means that it is stiffer. Zero is absolutely stiff 
without any elasticity. Elastography Analysis is a strain ratio 
comparative tool that enables users to compare the strain of one 
tissue to the surrounding tissue.

Using Elastography Analysis

1. If not yet in Elastography Mode press Elasto.

2. Perform the scan. Proper manual compression/
decompression is indicated by a fully green quality bar. 

3. Press Freeze and scroll the Trackball to bring up the CINE 
tab on the Touch Panel.

4. Press Analysis on the Touch Panel. The Elastography 
Analysis Touch Panel appears and the monitor screen 
shows the Elastography Analysis display. The valid 
Elastography frames are marked green. 

5. Adjust the start and end of the CINE Loop within the green 
frames using the rotary buttons below the Touch Panel 
(Start Frame/End Frame). Press Set to confirm. .

6. Activate the cursor and move it over the Elastography image 
on the top left side of the screen. A white sample area  
appears. By default this sample area is a circle. It will be the 
reference sample area and should be placed in the normal 
breast tissue.

7. Position this reference sample area and press Set. A yellow 
plot curve displays the strains over time on the right side of 
the monitor screen.

8. Move the Trackball again. A new sample area appears 
(sample area 1) which should be placed in the lesion.

9. Position the sample area and press Set. A second plot 
curve is displayed (blue curve).
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Using Elastography Analysis  (continued)

In total you can create 7 sample areas and 1 sample area. Each 
sample area can be edited, moved, copied, or deleted. A sample 
area can also be drawn manually.

1. To edit an existing sample area, move the cursor over the 
sample area then press the left Trackball control (Menu) to 
bring up the menu. Select “Set Sample Area Shape” to enter 
a dialogue window where Height and Width can be 
adjusted. You can also label, delete, copy, move the sample 
area by selecting corresponding options in the menu.  

2. To draw a sample area manually, select the pencil icon. 
Then the cursor becomes a cross inside the strain image. 
Start to draw the sample area by pressing “Set.” Press “Set” 
again to stop drawing.  

3. Both Stiffness and Ratio plots can be displayed: Switch to 
Ratio plots by pressing the Ratio control on the Touch Panel. 

4. Press Exit Analysis to return to Elastography Mode.
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Using Elastography Analysis  (continued)

NOTE: The maximum strain value in human tissue can be up to 2%.

NOTE: The ratio value indicates how many times the tissue of a sample 
area is harder or softer than the tissue of the Reference sample 
area.

HINTS Use the trackball to scroll the Cine Loop quickly.
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Elastography Analysis Display Description

Figure 13-52. Elastography Analysis Example

1. Reference sample area

2. Lesion

3. Harder compression

4. Lower compression

5. Strain plot

6. Ratio plot

7. Frame indicator lines: green lines indicate frames with color 
in the Elastography image, red lines indicate invalid frames 
without color.

8. Reference sample area is set to 1

9. Lesion is 0.8 times as rigid as the Reference sample area
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Additional Notes for Elastography Analysis

HINTS Limitations: 

• This is a relative quantification tool based on freehand 
manual palpation technology. It cannot show the stiffness 
by the kPa (kilopascal).

• There is no compatibility among manufacturers regarding 
the value. It depends on their strain imaging technology 
and definition of the value.

• Colors indicate degree of stiffness and do not directly 
correlate to a specific tissue type. Interpretation of what the 
tissues are and how to apply these ratios clinically is at the 
discretion of the user.

• Elastography physics dictates that cystic structures will be 
displayed with a three-layer pattern. This three-layer 
pattern will start with blue on the LOGIQ Fortis factory 
default map (which corresponds to hard), then progresses 
to green and then to red (which corresponds to soft). The 
posterior displacement of elastography patterns also may 
cause the B-Mode cyst to consist primarily of blue with the 
green to red being posterior to the B-Mode cyst. You need 
to be aware of the three-layer pattern of a cyst in 
elastography. Utilizing Elastography Analysis and setting 
the sample area in the blue portion of the three-layer 
pattern on the cyst and then setting the sample area in the 
“normal” tissue may cause you to misinterpret the 
Elastography Analysis ratio as the cyst to be hard as 
compared to the “normal” tissue. 
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Shear Wave Elastography

Overview

Shear wave elastography on the LOGIQ Fortis is an ultrasound 
imaging mode in which shear waves are generated in-vivo 
acoustically via the imaging ultrasound transducer. The motion 
of the shear waves is then tracked using ultrasound to 
determine their velocity of propagation, which is a quantifiable 
indicator of the mechanical properties of the tissue through 
which it traveled. The steps associated with performing this 
analysis on the LOGIQ Fortis include correctly placing a 
user-specific region of interest (ROI) over the anatomy of 
interest. Next, the user activates the shear wave analysis mode 
where the shear wave generation and tracking occurs. Up to 
four (4) sites may be analyzed. After acquiring the data, the user 
either stores the image or analyzes it via measurement tools 
which can produce shear wave velocity or stiffness statistics of 
areas within the ROI.  
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Overview  (continued)

Figure 13-53. Shear wave Probe Characteristics

1. Excitation and imaging transducer

2. Tissue

3. Propagating Wave

4. Focus



Advanced Features

13-126 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Intended Uses

Shear wave elastography Intended Uses are: 

• Abdomen

• Small Parts

• Musculoskeletal

• Gynecological

• Urological

Configuring Shear Wave

To configure Shear Wave parameters, you need to adjust the 
following Utility pages:

• ELASTO Imaging Parameters (Utility -> Imaging -> Elasto)

• General Imaging Parameters (Utility -> Imaging -> General)

• System Imaging Parameters (Utility -> System -> System 
Imaging) 

• Measurement Parameters (Utility -> Measure -> 
Advanced -> for both Abdomen and Small Parts Breast)

CAUTION Shear wave elastography IS NOT intended for use for 
Obstetrical exams. 



Shear Wave Elastography

LOGIQ Fortis – Basic User Manual 13-127
5855997-1EN Rev. 3

ELASTO Imaging Parameters

To configure Shear Wave Elastography settings, select Utility--> 
Imaging--> ELASTO. 

• Push Output (%) — The acoustic output of the shear wave 
push

• Track Output (%) — The acoustic output of the shear wave 
tracking pulse

• Transparency — The transparency of the shear wave image 
overlay

• Gain — Gain, as can be manipulated by the CF knob

• Width — ROI Width (values vary by probe)

• Vertical Size (cm) — ROI Vertical Height (values vary by 
probe)

• Center Depth (cm) — ROI Center Depth (values vary by 
probe)

• Color Map — Select shear wave Map 0 or shear wave 
Map 1 (SW0 or SW1) plus other ELASTO Maps (E1, E2, E3, 
E4, E-GRAY)

• Enter ELASTO DualView by Default — Check to select 
entering shear wave in DualView. 
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ELASTO Imaging Parameters  (continued)

Shear wave Color Bars:  

Figure 13-54. Shear wave Maps

The illustration shows the color maps for kiloPascals and 
velocity (meters per second). The images look the same, 
regardless of the unit (m/s or kPa). You can preset which color 
on the map represents stiffness (Red as Hard or Blue as Hard). 

General Imaging Parameters by Application/Probe/Feature

Select the Default Elasto Mode via Utility--> Imaging--> General. 

You can specify shear wave to be the default setting by 
application by probe.

1. To specify a default probe per application, select Utility --> 
Imaging --> General.

2. Select the application. 

3. Select the default probe from the pull-down menu.

4. Specify the Default Elasto setting: 

• Shear

• Strain
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System Imaging  Parameters

You can set the shear wave Display Units and specify which 
color on the shear wave map represents stiffness on the 
Utility--> System--> System Display--> Display page. 

Set the Shear Elasto Display Units to either of the following  
settings: 

• m/s (meters per second)

• kPa (kiloPascals)

Specify which color on the shear wave map represents stiffness: 

• Red as Hard

• Blue as Hard

Measurement Parameters

On the Utility--> Measure--> Advanced--> Abdominal page, set 
the following: 

• Shear Measure Size — Sets the Default Diameter size of 
the shear wave measurement circle

• Shear Measure Fixed Size — Sets to ON to move the shear 
wave measurement circle with keeping the fixed size.

• Shear Calculation Method — Specify Mean (Mean averages 
of all of the shear wave points within the measurement 
circle) or Median (Median sorts, then selects the middle 
point of all points within the measurement circle) 

• Shear Units Determine Folder — When On is specified, the 
unit specified pre-selects the measurement folder. If m/s is 
specified as the unit, then the Velocity folder is used; if kPa 
is specified as the unit, then the Stiffness folder is used
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Measurement Parameters  (continued)

On the Utility--> Measure--> Advanced--> Small Parts page, 
specify the Calculation Method (Mean/Median). 

• Shear Measure Size - Sets the Default Diameter size of the 
shear wave measurement circle.

• Shear Measure Fixed Size - Sets to ON to move the shear 
wave measurement circle with keeping the fixed size.

• Shear Calculation Method — Specify Mean (Mean averages 
all of the shear wave points within the measurement circle) 
or Median (Median sorts, then selects the middle point of all 
points within the measurement circle)

Activating Shear Wave

To activate shear wave, press ELASTO and Touch Panel Shear 
controls. (1) To position and size the shear wave ROI, or to Start 
or return to Pre-Mode shear wave, touch the right-most 
Trackball control. (2) To save the Shear Elasto image, activate 
the P1 control.  

Figure 13-55. Shear wave Operator Panel Controls

ELASTO -- When you activate ELASTO, the default Elasto 
Mode appears on the display and Touch Panel.  If shear wave is 
preset as the default Elastography Mode, then Shear Wave 
Elastography mode appears; if Strain Elastography is set, then 
Strain Elastrography mode appears. 
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Shear Wave Display

Shear wave displays as follows while performing a 
measurement: 

 Figure 13-56. Shear wave Display with Measurement

1. Measurement Window

2. Shear wave Map

3. Measurement(s)

4. Shear wave ROI

5. Trackball Controls

6. Imaging Parameters

• E = Elastography, Shear Wave

• Gn = Gain

• T = Transparency

• SVD = Sample Volume Depth

• PO% = Push Output Percentage

• TO% = Track Output Percentage

• f50-200Hz = Shear Wave Frequency range  

• Gen/Pen = General/Penetration.   

“Gen” appears when viewing an image where general 

settings were applied.

“Pen” appears when viewing an image optimized for 

penetration.  

“Clock” displays in Low Frame Rate Use cases. 

Note: The measurements’ Median and Inter-Quartile Range (IQR) are displayed by default in the 

Measurement Window and Worksheet. The Caliper Area, Depth of Caliper Center, and average Quality  

within the measurement area can also be displayed on the Worksheet, along with how many measurements 

used for the median calculation. 
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Selecting Measurements to Display

The following measurements are displayed by default, except 
those marked with an asterisk (*): 

• Shear Stiffness (kPa)

• Standard Deviation within the Shear Stiffness Measurement 
Area*

• Shear Velocity (m/s)

• Standard Deviation within the Shear Velocity Measurement 
Area*

• Measurement Area (cm2)*

• Depth of Caliper Center (cm)*

• Average Quality within the measurement area (%)*

*Items not displayed by default can be added via Utility--> 
Measure. See below. 

 Figure 13-57. Configure Shear Wave Measurements
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Selecting Measurements to Display  (continued)

Checkmark the Shear Wave measurements to be displayed on 
the monitor and on the Extended Worksheet.  

Figure 13-58. Selecting Default Shear Wave Measurements

Figure 13-59. Shear Wave Measurement Results Window

Figure 13-60. Shear Wave Extended Worksheet
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Shear Wave Quality Indicator

The Shear Wave Quality Indicator displays the reliability of the 
Shear Wave image. A Quality value is computed for every pixel 
of the Shear Wave image and displayed as an image in a 
color-coded ROI. Locations with higher quality values have 
more reliable Shear Wave data. 

To View the Shear Wave Quality Image

The Quality Image can only be displayed in Dual Mode. It can be 
turned on and off using the Quality button on the Shear Elasto 
page on the Touch Panel.

Figure 13-61. Quality Image Button

NOTE: You must be in Elasto Dual Mode to select the Quality button.
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To View the Shear Wave Quality Image  (continued)

When the Quality Image display is turned on, the Quality Image 
is displayed on the left and the Shear Elasto image on the right.

Figure 13-62. Shear Wave Display with Quality Image Enabled

The Color Bar on the left of the Quality Image shows the quality 
value corresponding to the colors in the Quality Image. Low 
quality is indicated by the colors at the bottom of the bar, and 
high quality by colors at the top.

Quality Map

There are two Quality Maps available to choose from on the 
Shear Elasto screen (under Quality Map), each with a specific 
color range:

• SWQ0 - Black/red/orange/yellow/white (low to high quality)

• SWQ1 - Red/orange/yellow/green (low to high quality)

1. Color Bar for Quality Image

2. Quality Image
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Elements of a good Shear Wave image

Elements of a good shear wave image contain the following: 

• Good contact

• ROI placed in the middle of image

• Gain at or near factory default

• Uniform color fill-in

• Homogeneous color pattern
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Shear Wave Touch Panel

Table 13-35:  Shear wave elastography Touch Panel Parameters

Preset Parameter Description

Strain or Shear Elasto Toggle touch key between Strain and shear wave elastography. 

Measurement Bias 

Information

Press to bring up measurement bias information. 

Quality Press the Quality button to open the Quality Indicator screen (while in Dual 

Mode). 

Phantom Press the phantom button to get good performance when measuring stiff, 

motion-free phantoms. The 049A phantom is recommended. For more 

information, refer to the CIRS website at http://www.cirsinc.com/products/all/

74/elasticity-qa-phantoms/?details=specs .

Penetration Press Penetration for instances measuring especially hard tissue (fibrotic or 

cirrhotic livers or technically difficult tissue in general).

Map Shear wave Color Map. 

Push Output The acoustic output of the shear wave push. 

Track Output The acoustic output of the shear wave tracking pulse. 

Range Min/Max Velocity, or Stiffness displayed. 

Transparency The transparency of the shear wave image overlay. 
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Measurement Bias Information Tables

The Measurement Bias Information tables display the bias and 
precision percentage at different spatial resolutions (Bias/
Precision vs Object Size, in millimeters) and at incremental 
depths (Bias/Precision vs Depth, in centimeters) for each shear 
wave probe. 

 Figure 13-63. C1-6-D/C1-6VN-D Measurement Bias Information (Velocity on the left 
and Stiffness on the right)

 Figure 13-64. L2-9-D/L2-9VN-D Measurement Bias Information (Velocity on the left 
and Stiffness on the right)
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Measurement Bias Information Tables  (continued)

 Figure 13-65. IC5-9-D Measurement Bias Information (Velocity on the left and Stiffness 
on the right)

 Figure 13-66. L8-18-D Measurement Bias Information (Velocity on the left and 
Stiffness on the right)
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Measurement Bias Information Tables  (continued)

 Figure 13-67. ML6-15-D Measurement Bias Information (Velocity on the left and 
Stiffness on the right)

 Figure 13-68. L3-12-D/L3-12VN-D Measurement Bias Information (Velocity on the left 
and Stiffness on the right)

Speed Ranges and Accuracy are shown at the top of the Bias/
Precision vs Object Size tables. 



Shear Wave Elastography

LOGIQ Fortis – Basic User Manual 13-141
5855997-1EN Rev. 3

Using Shear Wave (SW)

There are three shear wave states: 

• Pre-shear wave acquisition

Pre-shear wave acquisition is an intermediate mode 
between B-Mode and shear wave acquisition. During 
Pre-mode, the previous B-Mode imaging mode is still active. 

NOTE: You cannot store images in Pre-Mode. 

• Shear wave acquisition

Pressing the “Start" set key initiates SW acquisition.

• Post-shear wave acquisition (Freeze)

The system displays the acquired SW image and 
background B-Mode image. The User can cycle through the 
acquired frames, perform measurements, and annotate the 
image. 

SW images can be stored in both raw data and DICOM format. 

Table 13-36:  Using Shear wave

     Pre-Shear wave Mode Shear wave Acquisition Post-Shear wave Acquisition
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Typical Exam Protocol (Liver)

A recommended shear wave elastography protocol to scan the 
liver is, 

1. Image the right lobe of the liver intercostally in Pre-shear 
wave Mode. 

2. Position and size the ROI. 

3. Instruct the patient that during the exam they can mostly  
breathe normally. However, advise the patient that they will 
need to suspend their breathing mid breath so that you can 
obtain an optimum image while performing the scan. 

4. Adjust ROI as needed, avoiding vessels and fluid-filled 
structures. It is advisable to avoid rib shadows whenever 
possible. 

5. Start the shear wave acquisition. 

6. Freeze the image when desired frame is obtained. 

7. Perform the measurement. The system prompts you 
through the measurement.  

8. The system will auto sequence the measurements and walk 
you through all of the measurements (Abdominal 
Application Preset), if preset. 

NOTE: For Breast measurements, users typically take single 
measurements to measure the lesion once. Or, users can 
perform a ratio of two different tissues (one of the lesion and 
non-lesion tissue). 

9. Repeat steps 3 through 9 for the remaining samples. 

10. Typically, users obtain ten (10) samples. 

HINTS The smaller the ROI, the faster the Frame Rate. 
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Typical Exam Protocol (Liver)  (continued)

11. Once measurements are complete, you can elect to add 
another site to the exam. To add another site, press Add 

Site on the Touch Panel.  Select Enter Site Name to add 
the name for the new site.   

Figure 13-69. Add Additional Shear Wave Site and Enter Site 
Name

NOTE: If you no longer need the added site, you can select to 
delete the site via Delete Site on the Touch Panel. 

12. Once measurements for all sites are complete, select 
Summary on the Touch Panel to view saved measurements. 

CAUTION Excessive manual compression of the underlying tissue with 
the probe can lead to biased shear wave measurements. 
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Shear Wave Measurements

The higher the velocity, the stiffer the tissue. 

Types of Shear Wave MEeasurements

There are two types of measurement units for quantifying 
stiffness: 

• Velocity (meters per second)

• Stiffness (kiloPascals)

Measurement used to quantify stiffness: Shear wave imaging 
measures the velocity of shear waves generated by acoustic 
radiation force impulse in tissue. The velocity, in units of meters 
per second (m/s), can be converted to Young’s Modulus 
(stiffness), in units of kiloPascals (kPa), under simplifying 
assumptions. Velocity or stiffness can be used to quantify the 
local tissue elasticity.  

NOTE: Acoustic radiation force is generated by a transfer of momentum 
from an acoustic wave to the medium through which it is 
propagating, caused by absorption and scattering in soft tissue. 
Impulsive application of focused acoustic beams in tissue can 
generate shear waves which propagate away from the focal 
region of the beam.  

Measurement Analysis

To take shear wave measurements, typically users get ten (10) 
samples.  

1. After you have acquired the desired image, avoiding vessels 
and fluid-filled structures, press Freeze. 

2. Press Measure. Select the measurement (Stiffness or  
Velocity) unless preset to “Shear Units Determine Folder” is 
turned on.  

NOTE: This step only needs to be done in the Breast Small Parts 
Application Preset and is not needed in Abdomen. 

CAUTION Tissue inhomogeneities and other factors may bias shear wave 
measurements. 
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Measurement Analysis  (continued)

3. Perform the measurement. The system prompts you 
through the measurement.  

a. Position the first caliper at the desired location on the 
ROI. Place the first control point and press Set on the 
Trackball control. 

An ROI ellipse appears and a second caliper. 

b. Adjust the size of the ROI. Adjust ellipse and place the 
last control point. 

NOTE: This step only needs to be done in the Breast Small Parts 
Application Preset and is not needed in Abdomen. 

4. Repeat the scan and measurement. The system will auto 
sequence the measurements and walk you through all of the 
measurements, if preset. 

5. Measurements are transferred to the Worksheet. 

NOTE: The measurements’ Median and Inter-Quartile Range (IQR) 
are displayed by default in the Measurement Window and 
Worksheet. The Caliper Area, Depth of Caliper Center, and 
average Quality Percent within the caliper, and Standard 
Deviation within the caliper can also be displayed by going 
to Utility--> Measure, as shown in Figure 13-57 on 
page 13-132. 
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Shear Wave Worksheets

There are two types of Worksheets (Overall and Extended). 

Figure 13-70. Shear Wave Overall Worksheet

Figure 13-71. Shear Wave Extended Worksheet
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Deleting or Excluding Measurements from the Worksheet

Measurements can be deleted from the Extended 
Worksheet.Once a measurement has been deleted, it cannot be 
re-added. Deleted measurements show as a blank. 

NOTE: You can also choose to delete all Shear Wave measurements, 
without deleting non-Shear Wave measurements from the 
worksheet. 

Measurements can also be excluded from the Extended 
Worksheet -- and added back in at a later time. Excluded 
measurements show as a blank. 

To delete/exclude a measurement, 

1. Highlight the measurement you want to delete/exclude. 

2. Right click on the Extended Worksheet to bring up the 
Delete/Excluded pop-up menu. 

3. Select the appropriate action. 
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Deleting or Excluding Measurements from the Worksheet  (continued)

In the example below, measurements from line 4  with the blue 
rectangle have been excluded (and can be added back in); and 
measurements from line 2 have been deleted (and cannot be 
added back in). 

Figure 13-72. Example showing both deleted and excluded 
measurements
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Shear Wave Graph

The Shear Wave Graph displays an average of Shear Wave 
stiffness and velocity measurements for a patient over a period 
of time.  To see the Shear Wave Graph, select Worksheet and 
then Graph on the touch panel.

Figure 13-73. Shear Wave Graph
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Measurement Information 

Shear wave Measurements and Accuracies: 

The formula for Stiffness: E = 3 * rho * c2 

Where E = Young’s modulus of tissue

rho = density of tissue (assumed to be 1 g/cc)

c = shear wave speed in m/s

Note: The conversion from shear wave speed (m/s) to Young’s 
modulus is done under the assumption that the underlying 
material in which the shear wave propagates is linear, isotropic, 
incompressible, and homogenous. 

Table 13-37:  System Measurements and Accuracies

Measurement Units Useful Range Accuracy

Limitations or 

Conditions

Velocity m/s Shear wave ROI ±10%, or 0.5 m/s, for 

the 9L-D and ±15%, 

or 0.5 m/s, for the 

C1-6-D and 

C1-6VN-D, whichever 

is greater over the 

range of depths for 

which measurements 

can be made, limited 

by shear wave 

penetration. 

SD less than or 

equal to 5% for 

multiple repeated 

measurements 

over the range of 

depths for which 

measurements 

can be made, 

limited by shear 

wave penetration. 

Stiffness kPa Shear wave ROI ±20%, or 0.75 kPa, 

for the 9L-D and 30%, 

or 0.75 kPa, for the 

C1-6-D and 

C1-6VN-D, whichever 

is greater over the 

range of depths for 

which measurements 

can be made, limited 

by shear wave 

penetration. 

SD less than or 

equal to 10% for 

multiple repeated 

measurements 

over the range of 

depths for which 

measurements 

can be made, 

limited by shear 

wave penetration. 

CAUTION The values for shear wave speed and tissue modulus are 
relative indices intended only for the purpose of comparison 
with other measurements performed using the LOGIQ Fortis. 
Absolute values for these measurements may vary among 
different measurement devices. 
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Shear Wave Elastography Calculation

An Interquartile Range/Median (IQR/Median) Shear Wave 
Elastography ratio has been added. You can use this ratio to 
evaluate the reliability of Shear Wave measurements in the liver. 
This ratio is displayed as a percentage (%) on the worksheet 
(Display Accuracy to 1 decimal place). Values <30% are 
recommended for a reliable Shear Wave Liver exam. 

NOTE: The IQR/Median ratio is calculated automatically for both 
Velocity and Stiffness and displayed by default to the user. 
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Scanning Hints

HINTS You may find the following recommendations helpful when 
performing a Liver shear wave scan:  

• Locate right lobe of liver intercostally. 

• Place the ROI away from the capsule in an area free of 
vessels and fluid-filled structures.  

• Suspend Patient breathing in mid-breath during the scan

• Position the ROI between 2-5 cm deep for an optimal shear 
wave scan

You may find the following recommendations helpful when 
performing a Breast shear wave scan: 

• Locate lesion

• Place lesion in center of ROI, including a sufficient amount 
of the surrounding tissue

• Only compress slightly, if necessary (compression changes 
the elastic tissue properties). 

To increase frame rate: 

• Reduce ROI Width

• Turn off Penetration Mode

• Reduce Push Output

To increase penetration: 

• Turn on Penetration Mode

• Keep Push and Track Output at 100%

• Place ROI away from edges of image

To reduce artifacts: 

• Minimize motion during acquisition

• Ensure there are no vessels within the ROI or near the left 
or right edge of the ROI. It is advisable to avoid rib 
shadows whenever possible.  

• Keep ROI at least 1cm away from the liver capsule. 
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Ultrasound-Guided Attenuation

Parameter (UGAP) Option

Overview

Ultrasound-Guided Attenuation Parameter (UGAP) measures 
the attenuation value (i.e. attenuation coefficient [dB/cm/MHz] or 
attenuation rate [dB/m]) in the liver to evaluate diffuse liver 
disease. There are three visualizations: B Ref, Color Ref and 
Color Dual. All visualizations measure a representative 
attenuation value. Color Ref and Color Dual measure a 
representative attenuation value in 2D color map and dual 
display of B-Mode and 2D color map, respectively. 

UGAP is available on the C1-6-D, C1-6VN-D, C2-9-D and 
C2-9VN-D probes in the Abdomen (ABD) application. 
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Activation

To activate UGAP, select the appropriate probe Abdominal 
application, then press BT1 (configured as UGAP). UGAP 
parameters are displayed as “U” (Frequency and Acoustic 
Output Percent) in Simple Mode. Unit of attenuation coefficient 
values are displayed as dB/cm/MHz. 

 Figure 13-74. UGAP Display
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Measurement and Worksheet

Measure the Coefficient Value

1. Scan to get the appropriate view to measure. 

2. Press Start (right Set key).  

NOTE: The Measurement ROI can be moved using the Trackball; 
more than one ROI can be placed in one frame. Avoid 
structures such as vessels to obtain UGAP measurement. 

Figure 13-75. UGAP Study

Measurements can be performed afterwards using CINE or 
recalled data where multiple frames can be selected to measure 
attenuation coefficients. 
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Add a New Site

Once measurements are complete, you can elect to add another 
site to the exam. To add another site:   

1. Press the Measurement button on the console. 

2. Select Add Site on the Touch Panel.  

3. Select Enter Site Name to add the name for the new site.

Figure 13-76. Add Additional Shear Wave Site and Enter Site 
Name

NOTE: If you no longer need the added site, you can select to delete 
the site via Delete Site on the Touch Panel. 
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Summary and Overall Worksheets

Measurements are transferred to the Summary and Overall 
Worksheets. 

Figure 13-77. UGAP Summary Worksheet

Figure 13-78. UGAP Overall Worksheet

Attenuation Coefficients are displayed (C1, C2, C3), Median, 
IQR, IQR/Median, and number of measurements (N). 
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2D Color Map

2D color map is available on Color Ref, B/Color Dual and Qual./
Att. Dual. There are two 2D color maps: Attenuation Map and 
Quality Map. Attenuation Map provides the distribution of 
attenuation values. Quality Map provides the distribution of the 
signal quality to support ROI placement.

 Figure 13-79. Attenuation Map

 Figure 13-80. Quality Map
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Continuous Wave Doppler (CWD)

Overview

There are two CW Doppler operating modes: Steerable and 
Non-Imaging.

Allows examination of blood flow data all along the Doppler 
Mode cursor rather than from any specific depth. Gather 
samples along the entire Doppler beam for rapid scanning of the 
heart. Range gated CW allows information to be gathered at 
higher velocities.

Steerable

Allows viewing of the B-Mode image to position the Doppler 
cursor to the area of interest while viewing the Doppler spectrum 
(shown below in the B-Mode image) and listening to the Doppler 
Audio signal.

Non-Imaging

Provides only Doppler Spectrum and Audio for ascending/
descending aortic arch, other hard-to-get-to spaces or higher 
velocities.
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Activating CW Doppler

To activate CW Doppler Mode, press CW. 

The Steerable CW Doppler spectrum displays along with the 
B-Mode image. The cursor changes to a Doppler cursor. 

You can now position and size the sample volume gate to get a 
velocity. Use Doppler Audio to listen for when the sample 
volume gate is positioned over an area of flow. 

Update toggles between real time B-Mode with Doppler Mode 
and real time spectral display. 

Exiting CW Doppler

To exit CW Doppler Mode, press CW. 
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Tissue Velocity Imaging (TVI)

Intended Use

Tissue Velocity Imaging (TVI) calculates and color-codes the 
velocities in tissue. The tissue velocity information is acquired by 
sampling of tissue Doppler velocity values at discrete points.The 
information is stored in a combined format with gray scale 
imaging during one or several cardiac cycles with high temporal 
resolution.

Activating TVI

1. Select the desired probe.

2. While in B-Mode, press the TVI key located above the PDI 
control on the Touch Panel. The TVI image and Touch Panel 
display.

NOTE: To set up TVI on the Imaging Preset page, go to Utility--> 
Imaging--> TVI. 

CAUTION TVI can be activated on Cardiac Sector and TEE probes only.
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Optimizing TVI

The use of preset gives optimum performance with minimum 
adjustment. If necessary, the following controls can be adjusted 
to further optimize the TVI display:

• To reduce quantification noise (variance), the Nyquist limit 
should be as low as possible, without creating aliasing. To 
reduce the Nyquist limit: Reduce the Scale value.

NOTE: The Scale value also affects the frame rate. There is a trade 
off between the frame rate and quantification noise.

• TVI provides velocity information only in the beam direction. 
The apical view typically provides the best window since the 
beams are then approximately aligned to the longitudinal 
direction of the myocardium (except near the apex). To 
obtain radial or circumferential tissue velocities, a 
parasternal view must be used. However, from this window 
the beam cannot be aligned to the muscle for all the parts of 
the ventricle.
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TVI and TVD

TVI

You can preset all parameters in Utility -> Imaging ->TVI.

The TVI parameters function the same as those described in the 
Color Flow specific section. The only differences would be that it 
pertains to tissue velocity rather than the color flow image. In the 
table below any TVI parameter or parameter specifics are noted.

TVD 

While in TVI, press PW to activate Tissue Velocity Doppler.

You can preset all parameters in Utility -> Imaging ->TVD.

Table 13-38:  TVI Parameters

Control Details

Visible

Description

Adjusting

Values

In LIVE/Freeze/Archive, you can display TVI Color with TVI.

Select Visible on the Touch Panel.

On or Off.

Invert Color Invert

Baseline Adjusts the Baseline. 

Angle Steer Steers the angle

Line Density Optimizes B-Mode frame rate or spatial resolution for the best possible 

image.

Map Values: TV1 and TV2. 

Frame Average Averages color frames. 

Threshold High values display more color. Low values limit the color to lower tissue echo 

(Opposite of Threshold in Color Flow Mode). 

Transparency Map Values 0-5. 

Spatial Filter Values 0 and 1. 

Duplex Allows two modes to be active at the same time.

TVI Gain Control color transparency. High values display more color; low values 

display more tissue. This parameter is assigned to the Color Gain control.
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Quantitative Analysis (QAnalysis)

Overview

Quantitative Analysis is available for the following CINE loops 
obtained in the following modes: Tissue Velocity Imaging, Color 
Flow Mode, and Power Doppler Mode. All of the Quantitative 
Analysis modes operate similarly, with some variation.

The Touch Panel may be slightly different, for example; and the 
type of information you quantify varies by mode as well. Please 
see a summary of each mode below; followed by general 
instructions on how to perform Quantitative Analysis. 

Quantitative Flow Analysis

Provide tools for semi-quantitative assessment of inflammation 
in joints and vascularization in tumors.

NOTE: There is frame number limitation for color quantification as 400 
frames.
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Statistics

The LOGIQ Fortis extracts various statistics from the image data 
within each sample area. The statistics depends on the imaging 
mode in use.

Press Statistics to enable/disable display of statistics of the 
frame or loop. The statistics are shown only when the loop is 
stopped.

• Ratio: Ratio of Color (Power) Doppler pixels over total 
sample area area.

• Area (mm2): The size of sample area

• Max Ratio/Time of Max Ratio: Maximum Ratio of Color 
(Power) Doppler pixels in each sample area, and which 
frame that occurs in.

• Min Ratio/Time of Min Ratio: Minimum Ratio of Color 
(Power) Doppler pixels in each sample area, and which 
frame that occurs in.

Quantification supports two different statistical display formats: 
Short Form and Long Form.
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Statistics  (continued)

• Short Form: Ratio and Area. 

 Figure 13-81. Color Flow Mode Short Form - Example

• Long Form: Ratio, Area, Max Ratio/Time of Max Ratio, Min 
Ratio/Time of Min Ratio 

 Figure 13-82. Color Flow Mode Long Form - Example
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QAnalysis - Tissue Velocity Imaging 

Multiple Time -Motion trace display from selected points in the 
myocardium.

QAnalysis Screen Description

 Figure 13-83. Q-Analysis Screen

Table 13-39:  QAnalysis Screen Description

1. TVI Cineloop Window

Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 

sample area is yellow, the second green, etc.

2. B Cineloop Window

Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 

sample area is yellow, the second green, etc.

3. Analysis Window.

• Y axis: Velocity scale (cm/s)

• X axis: Time(s) 

• ECG

• Time at cursor position.

• Velocity at Cursor position.

• Velocity at frame marker position (Color coded)

4. Sample Area

5. Time at cursor position and velocity at cursor position. Position the pointer cursor over the analysis 

window. 

6. Sample Area Tools.

• Pencil Icon: Creates a sample area based on freehand drawing.

• Shape Icon: Creates a sample area with a pre-defined circular/ellipse shape.
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QAnalysis Plot Control

The following controls are user configurable presets which are 
configurable through the pull-down menu in QAnalysis mode. 
When using the pull-down menu:

1. Place the cursor over the analysis window and press the left 
Set key. The system menu displays at the cursor position.

2. Select the appropriate parameter.

To switch trace 

(Analysis signal)

Analysis Signal toggles the trace display between velocity, 
displacement or gray scale intensity curves.

1. Position the cursor over the plot window and select Analysis 
Signal from the pull-down menu.

2. Select Velocity, Displacement or Grayscale Intensity as 
necessary. 

Vertical Unit

NOTE: Vertical Unit is only available when Grayscale intensity is 
selected in Analysis Signal.

When analyzing the data, the Y-axis can be set to display either 
logarithmic scale (dB) or linear, acoustic units (AU).

To toggle between dB and acoustical display units for the Y-axis.

• dB—The traditional log compressed B-Mode data is used to 
calculate the time-intensity curve values.

• Acoustic—The system reverse the log compression 
function to provide un-log compressed data for the 
Qanalysis.

Drift Compensation

Drift Compensation compensates drifting of Tissue Tracking 
curves by either resetting the curve to zero at the tracking start 
point (cycle resetting) or by linear compensation throughout the 
cycle (linear compensation).

NOTE: When Displacement is chosen by AnalysisSignal, Drift 
Compensation is active.

NOTE: Drift Compensation is inactive if ECG data cannot be acquired.
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Trace Measurements

Gradient Select Gradient entry on the pull-down menu that is obtained 
when the cursor is placed over the plot.

Gradient is displayed on the screen instead of velocity. The 
gradient calculates from 7 points (includes previous and next 
frames).

Max Gradient Displays the time and gradient that becomes the maximum 
gradient between the CINE start and end frame. 

Figure 13-84. Max Gradient
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Selecting QAnalysis Image Range

A range of frames is selected for the QAnalysis in Cine mode 
(before accessing QAnalysis). Only the frames in this range are 
used for the QAnalysis.

If a range is not selected prior to accessing the QAnalysis, the 
system uses the default Cine start and end frames as the default  
start and stop frames.

1. The first frame in the analysis series is selected by adjusting 
the Start Frame control to the desired frame

OR

using the Trackball or the Frame by Frame control to 
select the desired first frame and then selecting the Start 

Frame control.

2. The last frame in the analysis series is selected by adjusting 
the CINE End Frame control to the desired frame

OR

using the Trackball or the Frame by Frame control to 
select the desired end frame and then selecting the End 

Frame control.

Activating QAnalysis

1. Scan and Freeze the patient in the desired live mode or 
recall a desired cine loop from the stored images.

NOTE: QAnalysis is only available when the system is in CINE 
mode.

NOTE: Images from the current scan session acquired in the 
desired analysis mode (already in CINE) or from a saved 
image loop can be used for QAnalysis.

2. QAnalysis displays on the Cine Touch Panel.

3. Select QAnalysis. The QAnalysis screen and Touch Panel 
displays. To toggle the trackball function between QA and 
Scroll, press the top Trackball key.



Quantitative Analysis (QAnalysis)

LOGIQ Fortis – Basic User Manual 13-171
5855997-1EN Rev. 3

Common QAnalysis Function

Display the System Menu

Place the cursor to the desired position and press the left Set 
key. The system menu displays at the cursor position.

The system menu is dependent on the area which you place the 
cursor.

Generating a Trace

Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) 
before anchoring.

NOTE: The free sample area disappears when the QA cursor is 
moved over a static anchored frame.

• Static sample area: the free sample area is anchored by 
pressing Set.

• Dynamic anchored sample area: the sample area is 
anchored in two or more frames (see Manual tracking 
below). In these particular frames, the sample area is 
displayed with an anchor. The sample area moves smoothly 
between the anchored positions when playing/scrolling the 
cineloop.

Trace from a pre-defined sample area

1. If the trackball assignment is not on QA, press the top 
Trackball key until QA highlights.

2. If necessary, select the sample area Ellipse sample area 
button (shape icon on the monitor display).

3. Move the cursor to one of the Cineloop windows using the 
Trackball.

4. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If 
the cineloop has more than one heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle.

The trace is updated accordingly in the Analysis window.
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Generating a Trace  (continued)

Trace from freehand sample area

1. Select the Freehand sample area button (pencil icon on the 
monitor display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Press and hold down the Set key while drawing a sample 
area using the Trackball.

4. Release the Set key.

The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window.

Manual tracking of the sample area (dynamic anchored sample area)

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

7. Press the top Trackball key until the scroll trackball 
assignment is selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.
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Generating a Trace  (continued)

Moving a dynamic anchored sample area

1. Press the top Trackball key until the scroll trackball 
assignment is selected.

2. Using the Trackball, browse through the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to a new location.

7. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 

Manipulating the Sample Area

Up to eight sample areas can be saved on the reference image, 
with the corresponding eight traces plotted simultaneously on 
the graph. Each sample area display has a different color, and 
its corresponding trace data is plotted using that same color.

Once eight sample areas have been saved, the system does not 
automatically generate an active sample area when the cursor is 
positioned over the displayed reference image.

The saved sample areas can be a mixture of elliptical and 
freehand sample areas.

When the user repositions a sample area, the old trace data is 
erased from the plot and the trace data for the new position 
replotted.

If the sample area position on the last frame of the selected 
image range is moved, the corresponding sample areas on all 
frames are repositioned to match the last frame.

The user shall also have the capability of setting separate 
sample area positions on different frames of the contrast 
images, and the system shall linearly interpolate the sample 
area positions for the frames in between the selected frames. 
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Setting the default sample area shape

1. Select Set sample area shape. The Information Box 
displays.

Figure 13-85. Sample Area Information Box

2. Select Height, Width and Tilt angle.

3. Select Set as default. The current sample area size is set 
as the default for subsequent Ellipse sample areas.
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Sample Area Shapes

There are two different methods for determining the shapes of 
the sample area.

Ellipse sample area

1. Select the ellipse icon (shape icon on the monitor display).

2. When the trackball positions the image display cursor over 
the reference image(s), an elliptical sample area is 
automatically generated and displays on the reference 
image(s). 

3. The average velocity value inside the ellipse is calculated 
for every image in the image analysis range and plotted in 
the image display area.

4. The last generated or selected ellipse is considered the 
active sample area, and its trace plot automatically updates 
as the user repositions it on the reference image. Old traces 
are erased.

5. When scanning with an elliptical sample area, press Set to 
fix the sample area position and freeze its corresponding 
trace on the plot. A new active sample area is generated 
whose position is manipulated by the trackball and whose 
velocity curve traces will be plotted as before, while the 
previous sample area and trace remain fixed at the points 
they were saved at.

NOTE: Elliptical sample areas can be positioned in any manner that 
keeps their center within the image boundaries. In the case that 
part of the sample area is outside the image boundary, only data 
from within the image boundary is used for calculating the mean 
velocity value.

NOTE: You can change the size of the Ellipse sample area by adjusting 
the Ellipse control. 

Freehand sample area

1. Select Freehand icon (pencil icon on the monitor display).

Use the Trackball to position the caliper on the reference 
image at the start point. Press Set to fix the start point.

2. While holding down the Set key, trace the outline of the 
desired sample area by moving the caliper with the 
Trackball.
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Reshaping a Sample Area

To reshape the sample area:

1. Position the cursor on the sample area to reshape and 
press the left Set key.

2. The sample area system menu displays. Select Set sample 

area shape.

Figure 13-86. Sample Area Information Box

3. Adjust Height, Width and Tilt angle.

4. Press OK. The selected sample area size changes.

Labeling a Sample Area

The sample area label is used to identify data associated with 
the sample area when exporting.

1. Position the cursor on the sample area to label and press 
the left Set key.

2. The sample area system menu displays. Select Label 

sample area. The Label Dialog box displays.

Figure 13-87. Label Dialog Box

3. Enter a name for the sample area.

4. Select OK.
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Copy, move, and paste a Sample Area

To copy and paste the sample area, 

1. Move the cursor over the sample area and press the left Set 
key. The system menu displays. 

2. Select Copy sample area.

3. Move the cursor to the desired location for the copied 
sample area and press the left Set Key. The system menu 
displays. 

4. Select Paste sample area. 

To copy and move the sample area, 

1. Move the cursor over the sample area and press the left Set 
key. The system menu displays. 

2. Select Copy & move. Or if you want to move to the same 
depth as the original sample area, select Copy & move 

(same depth).

3. Move the copied sample area using the Trackball. Press 
Set to fix the position.

Deleting a Sample Area

Sample sample areas and their corresponding traces can be 
deleted using Delete Sample Area. 

1. Select Delete Sample Area; a pull-down menu displays.

Figure 13-88. Delete Sample Area pull-down menu

2. Select Current sample to delete the currently active sample 
area.

Select Delete all to delete all currently set sample areas 
and all of their traces.

NOTE: The corresponding traces for the deleted sample areas are 
erased from the plot.

NOTE: Deleting a sample area causes the sample areas to be deleted 
from all frames in the analysis loop.
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QAnalysis Plot Control

NOTE: Plot Control is available only with TVI and Elastography modes.

The following controls are user configurable presets which are 
configurable through the pull-down menu in QAnalysis mode. 
When using the pull-down menu:

1. Place the cursor over the analysis window and press the left 
Set key. The system menu displays at the cursor position.

2. Select the appropriate parameter.

Vertical auto-scaling

The system can be configured to display the full unit range or a 
range according to the maximum and minimum values of the 
displayed trace(s) (auto-scaling function). In addition, the 
auto-scaling function can be set to be live update (updates while 
the sample area is moved) or delayed (updated when the 
sample area is anchored).

• Delayed—The system automatically rescale the vertical 
axis of the trace graph only when a new sample area is 
saved, to account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of 
the trace graph every time the currently selected (active) 
sample area is moved.

• Off—Disable any automatic scaling of the vertical axis. 
There is user-defined system defaults on the system preset 
page for the fixed vertical scale to be used for the plot.

Figure 13-89. Vertical Autoscale Pop-up menu
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Line Style

• Solid—Setting the results in a plotted trace that does not 
display small boxes at the data points

• Squares—Setting the results in a plot where small squares 
are displayed at each data point, and the squares are linked 
together by lines.

Figure 13-90. Line style Pop-up menu

Smoothing

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing.

OR

Position the cursor over the analysis window and press the 
left Set key. The System menu is displayed at the cursor 
position. Select Smoothing.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays.  Select the appropriate 
parameter.

Horizontal Sweep

Horizontal Sweep allows you to increase or decrease the time 
interval over which to plot the analysis curve. 

The default is the user selected image range. If the user has not 
yet selected a first and last frame, the first and last default 
frames from the displayed CINE loop are used.
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Zooming in the Analysis window

To zoom:

1. In the Analysis window, press and hold down the Set key 
while dragging the cursor to define the zooming area.

2. Release the Set key.

To unzoom:

1. Press the left Set key in the Analysis window. The system 
menu displays.

2. Select Unzoom.

Disabling/Enabling the frame

NOTE: Frame disable/enable is available only with Elastography, CF, 
and PDI modes.

Frame disabling excludes the actual frame from the cineloop 
display.

Disabling the frame from the frame marker

To disable One Frame:

1. Use the Trackball to move the cursor to the frame marker to 
disable.

2. Press Set to disable the frame.

3. The frame marker is changed from green to red to indicate 
the frame has been disabled. 

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory.

Disabling multi-frames from the frame marker 

1. Use the trackball to move the cursor to the first frame 
marker to disable.

2. Press and hold down Set 

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.
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Disabling a frame from the cineloop window

1. Use the trackball to move the cursor to the cineloop window.

2. Press the left Set key. The system menu displays.

3. Select Disable frame.

The current frame is disabled and the corresponding frame 
marker displays red.

Disabling Frames - Auto

When the user enters Elasto Quantification, the useless frames 
are disabled automatically. The LOGIQ Fortis uses Elastography 
Index value to find useless frame (low quality frames).

Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in 
all heart cycles but a selected one. This function can be used for 
example to select a particular systolic frame for each heart 
cycle.

1. Scroll through the cineloop to identify the cardiac phase to 
analyze or identify the cardiac phase on the ECG trace 
(where available).

2. Position the cursor on the ECG trace (where available) and 
press left Set key. The system menu displays.

3. Select ECG triggering (where available).

All frames in all heart cycles are disabled except for the 
selected and corresponding frames in the other heart 
cycles.
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Disabling/Enabling the frame  (continued)

To enable the frames

To re-enable all deleted frames:

1. Position the cursor on the Frame Marker line and press the 
left Set key. The system menu is displayed at the cursor 
position.

2. Select Enable all frames.

3. All disabled frames are re-enabled.

Figure 13-91. Frame Markers

1. Analysis Window

2. Frame markers axis

3. Enabled frame (Green)

4. Disabled frame (Red)

5. ECG (where available)

6. Current frame
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Exporting Traces (Saving the Trace Data)

You can save the trace data to an external file in ASCII format, 
readable in spreadsheet programs.

1. Select Export Traces to save the trace data.

2. Specify the following: 

• Location : Select Location which to save.

• Filename : Enter the filename. (Only Text)

3. Select OK to save the data and return to the QAnalysis 
screen.

• All displayed sample area traces are saved in the 
exported file.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: No trace results are saved in the standard image database.

Annotating the QAnalysis Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.

Printing QAnalysis Data

Press the appropriate print key in the desired analysis mode 
mode. 

The system captures a single still frame which consists of the 
plot, the reference image, and user annotation.

Exiting QAnalysis

There are several methods to exit QAnalysis.

• Toggling Exit QAnalysis on the QATouch Panel.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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Stress Echo

Introduction

The LOGIQ Fortis Ultrasound system provides an integrated 
stress echo package, with the ability to perform image 
acquisition, review, image optimization, and wall segment 
scoring and reporting for a complete, efficient stress echo 
examination.

The stress package provides a protocol template for the two 
types of stress exams (exercise and pharmacological stress). 

In addition to preset factory protocol templates, templates can 
be created or modified to suit your needs.

You can define various quad screen review groups, in any order 
and combination, that will suit your normal review protocol.

When reviewing stress examination images, the images are 
viewed at their original image quality, and different 
post-processing and zoom factors may be applied to the images 
under review for effective image optimization.

The protocol template may be configured for Continuous 
Capture.

A stress echo examination consists of three steps:

• Selection of a stress test protocol template

• Image acquisition

• Stress Analysis

NOTE: If WallMotion Segment Score is not displayed on the screen, 
select the “WallMotion” preset in the Utility -> Measure ->  M&A 
-> Plot -> Available Folders and Measurements. 
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Getting started with a stress study

1. After selecting the appropriate application and probe, press 
the Protocol tab on the Touch Panel. The protocol screen 
displays the layout of the default stress protocol for the 
current probe. This layout is also known as a template.

Table 13-40:  Protocol Tab

Parameter Description

Analyze Display the Analysis screen

Template Editor Display the template editor screen

Add Level Add Level to the template

Delete Images Delete the selected image

Move Image Move the selected image to the another cell

Sync. Select Synchronize the selected images.

End CC End Continuous Capture

Begin/Cont. Begin or continue the acquisition

Template Display the template list

T1 Display/Hide the timer T1

T2 Display/Hide the timer T2

Cancel Cancel Stress Echo
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Getting started with a stress study  (continued)

2. To use the current template, press Begin/Cont. to initiate 
scanning. 

To use another template, press Template. The template list 
displays.

Figure 13-92. Template List

3. Trackball to the desired template and press Set.
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Getting started with a stress study  (continued)

4. The selected template displays.

Figure 13-93. Template (Example)

a. Level

b. Projection

c. Current Acquisition (green)

5. Press Begin/Cont. to initiate scanning using the new 
template.
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Image acquisition

Images are acquired in a pre-defined order, according to the 
selected template. The highlighted (green) cell of the template 
matrix, displayed in the Clipboard window, indicates which view 
is currently being acquired.

The names of the view and levels for the current cell are 
displayed on the top left corner of the image area and under the 
template matrix.

Acquisition Screen

1. Current View Level

2. Timer

3. Template Matrix

4. Current View (Green cell)
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Starting acquisition

1. Select the template.

2. Press Begin/Cont.

3. Perform a scan that conforms with the view that is 
highlighted in the template matrix on the Clipboard window.

4. Press the P1 (Image Store) key.

• If the actual stress level is configured to preview the 
cine loop before storing, use the cine loop controls to 
select the most appropriate heart cycle and if desired 
adjust the loop markers. Press P1 again to save the 
selected cine loop.

or

If you do not want to store the cine loop, press Freeze to 
cancel. Return to the scan screen.

• If the actual stress level is not configured to preview the 
cine loop before storing, the system automatically 
stores the last heart cycle.

Stress levels can be configured for side-by-side display/
comparison of the reference loop from baseline or previous level 
and the loop to acquire.

5. After storing the cine loop, the system automatically 
highlights the next view in the matrix to be acquired.

6. Repeat previous steps until all required views are 
completed.

7. If you select Auto Start Analysis on the Template Editor for 
this template, a dialogue asking “Do you want to start 
protocol analysis now?” displays when the last acquisition is 
complete. If you select Yes, the Stress Echo Analysis screen 
is displayed.

The template used can be configured so that analysis 
automatically starts by displaying the first protocol group. The 
wall segment scoring diagrams for each view is displayed in the 
Parameter window on the left side of the screen.
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Starting acquisition  (continued)

If the Protocol tab is selected during acquisition, the following 
Touch Panel displays.

Table 13-41:  Protocol Tab during acquisition

Parameter Description

Stop Stop Stress Echo.

Pause Pause Stress Echo. The template matrix continues in display. Even if you 

press P1, the cine loop does not store to the matrix.

Select Cycles The Continuous Capture Selection screen is displayed (only available in 

Continuous Capture mode).

Analyze Enter Analysis screen.

Template Enter Template screen.

Add Level Add level to the template.

T2 Display (Start)/Hide Timer T2.
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Selecting a view during acquisition

A fixed protocol is provided for scanning, based on the selected 
template. The system automatically highlights the next view to 
be acquired in the template matrix, as images are stored. 
However, the order of scanning may be changed manually as 
follows:

Manual selection of a view during acquisition

1. Use the Trackball or the arrow keys on the alphanumeric 
keyboard to move the cursor to the cell that represents the 
view to be acquired.

The selected cell in the template matrix, highlighted in red, 
indicates the non-default position. When blinking, it contains 
a previously-stored acquisition.

2. Press Begin/Cont. to initiate scanning.

3. Scan and save the selected loop as explained in the 
previous section.

After storage, the system automatically highlights the next 
available view to be acquired.
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Moving an acquired image

An image can be moved from one cell to another during 
acquisition.

Procedure 1

1. When in the Protocol screen, press Move Image.

2. Use the Trackball to move the cursor to the desired image.

3. Press Set. 

4. Use the Trackball to move the cursor to the destination cell.

5. Press Set. The image is moved from the source cell to the 
destination cell.

Procedure 2

1. In the Protocol screen, use the Trackball to move the cursor 
to the cell containing the image to move (source cell).

2. Press and hold down Set.

3. With the Set key still depressed, move the Trackball to the 
desired cell.

4. Release the Set key. The image is moved from the source 
cell to the destination cell.

If the destination cell contains an image, the images from the 
source and destination cells is exchanged when moving an 
acquired image.
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Timers

Two timers can be displayed in the Stress mode acquisition 
screen, beside the template matrix.

Timers

• T1 displays the elapsed time from the start of stress 
examination.

• T2 starts when entering live scanning on the second stress 
level.

Both T1 and T2 timers can be manually stopped and restarted 
during the acquisition.

The display of T1 and T2 is user-configurable.

NOTE: If you activate the Timer in Stress Echo, the T1 timer is 
displayed in the lower left-hand corner of the image area after 
exiting Stress Echo. 
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Continuous Capture mode

Continuous Capture mode enables the user to perform 
acquisition continuously for all views at any level depending on 
the selected template configuration. Continuous Capture 
consists of temporary images and loops acquired during the 
session in a storage buffer in system memory. To enable best 
possible use of the limited storage buffer capacity, a Pause/
Capture mode is provided, as opposed to the normal Freeze/
Scan mode. The Pause mode enables scanning and live display 
on the screen, without any capture, thereby leaving the buffer 
available.

To run Continuous Capture, the user has to select a template 
where this feature is activated.

WARNING Leaving a Stress Echo exam PRIOR TO saving portions of the 
Continuous Capture through “select cycle” or triggering a 
“Store All” could result in the loss of Continuous Capture data. 

The continuous capture acquisition obtained using the P1 print 
key while in protocol is stored in temporary memory. Loss of 
power before properly ending the patient or before selecting 
cycles will result in the loss of this information in certain 
configurations. 

Upon completion of cycle selection or when ending current 
patient, the user will be prompted as to what they would like to 
do with this temporary buffer.  If they choose "store all," the 
information will then be placed in permanent memory on the 
system’s hard drive. 

WARNING DO NOT change modes or power off the system while in 
Continuous Capture Mode. Doing so causes images and data 
acquired during the session to be lost.   
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The buffer bar

When entering a level with Continuous Capture enabled, a 
buffer bar displays in the window.

The Buffer bar displays the following information:

• The scanning state

• Pause (live scanning without storing)

• Capture (live scanning with storing temporary images 
and loops to system memory buffer)

• The percentage of the buffer that is filled

• The buffer filling progression showed by a filling gage

• The capturing sessions, reflected by the red lines along the 
buffer bar

Figure 13-94. Buffer Bar



Advanced Features

13-196 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Controlling the capture process

When entering a stress level with Continuous Capture enabled, 
the system is automatically set in Pause mode.

1. Press P1 to start image capture.

“Capture” is displayed in the buffer bar, the gage starts filling 
and the percentage of filled memory buffer increases.

2. Press P1 again to stop capture.

“Pause” is displayed in the buffer bar.

When 90% of the memory buffer is filled up, the text display in 
the buffer bar turns red.

The system enters Freeze mode automatically once the buffer is 
full and the captured loops display in the Continuous Capture 
selection screen.

Activating Continuous Capture

1. Do all your pre-stress acquisitions in the Cardiac 
application.

2. Press the Protocol tab to enter the Stress Echo mode. The 
Protocol screen displays.

3. Press Template. The template list displays.

4. Select the template Exercise 2x4 from the list.

5. Press Begin/Cont..

6. Acquire the resting loops in all four views.

NOTE: Use the P1 key to store the images.

7. Once the fourth loop is acquired, the system enters into a 
waiting mode where Continuous Capture is in a pause state 
awaiting the patient to exercise.

8. When the patient is back on the bed, press P1. The 
Continuous Capture acquisition starts.

9. Acquire all your views.

The memory buffer gage increases. When memory exceeds 
90%, the percent number turns red.

10. Press Freeze to finish.
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Activating Continuous Capture  (continued)

11. Press Select Cycle.

The Continuous Capture selection screen displays.

Refer to the next section if additional image acquisitions are 
necessary after the buffer is full.

 Figure 13-95. Continuous Capture Selection Screen
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Activating Continuous Capture  (continued)

12. Assign the cine loops to the four views. 

 Figure 13-96. Drop-down Menu

1. Trackball to the desired loop.

2. Press Set. A drop-down menu appears with the available choices.

3. Trackball to the appropriate view.

4. Press Set.

5. Continue these steps until all views are selected.

NOTE’ To access additional cycles, use the arrow keys on the lower left 

portion of the select cycle screen.

6. Select Done when complete. A dialogue window displays, asking 

whether the entire Continuous Capture acquisition should be saved.
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Activating Continuous Capture  (continued)

Figure 13-97. Dialogue Window

13. Press Delete to discard the loop or press Store to keep the 
entire loop.

14. Perform Analysis and scoring.
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Continuous Capture with additional image acquisition

If the buffer is filled up before all the image acquisitions are 
done, additional loops can be stored in the clipboard before 
doing image assignment to the views.

1. Perform the Continuous Capture. See ‘Activating 
Continuous Capture’ on page 13-196 for more information. 
(Steps 1 to 11).

2. In the Continuous Capture selection screen, press Select 

Later.

The Continuous Capture screen displays.

3. Perform the additional acquisition.

4. In order to resume the stress echo exam and assign loops 
for the views from the Continuous Capture buffer, press 
Protocol. If not displayed, select the template Exercise 2x4 
from the template list.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view. See ‘Activating 
Continuous Capture’ on page 13-196 for more information. 
(Step 12 a - f).

7. Press Delete to discard the loop or press Store all to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.

8. Perform Analysis and Scoring.
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Postponed image assignment

The assignment of the cine loops to the view can be done on a 
later stage on a stored Continuous Capture acquisition.

1. Perform the Continuous Capture.  See ‘Activating 
Continuous Capture’ on page 13-196 for more information. 
(Steps 1 to 11).

2. Press Store all.

The entire Continuous Capture acquisition is stored. The 
examination can be ended and the image assignment, 
analysis and scoring can be done later.

3. Re-open the examination, if necessary.

4. Press Protocol. The Protocol screen displays.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view.  See ‘Activating 
Continuous Capture’ on page 13-196 for more information. 
(Step 12 a - f).

7. Select Done.

8. Perform analysis and scoring.

Restart capture from the Continuous Capture Selection

• Press Restart Capture.

The recording in memory is deleted and the Continuous 
Capture starts again.

Resume Continuous Capture

• Press Continue Capture.

Resumes Continuous Capture recording (only if the 
Continuous Capture buffer is not full).
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Assigning and storing the cine loop

The cine loops captured in the buffer are assigned to the stress 
protocol views and stored from the Continuous Capture 
selection screen.

 Figure 13-98. Continuous Capture Selection Screen

1. Highlighted loop

2. Cycle number and total number of cycles

3. Blue Gauge: Position of the highlighted loop within buffer area. 

4. Red bar: Pause session. 

5. Navigation Controls: << < > >> (back to first selection, back to previous selection, forward to next 

selection, and forward to final selection). 
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Assigning a cine loop to a view

1. Use the Trackball to move the cursor to the desired cine 
loop in order to assign it to a particular view of the stress 
template.

The frame of the loop is highlighted.

2. Press Set.

A pop-up menu displays with the view names of the 
template.

 Figure 13-99. Loop Assignment

1. Already assigned view

2. Views pop-up menu

NOTE: A checkmark appears on the Views pop-up after you have assigned a view to an image.
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Assigning a cine loop to a view  (continued)

3. Use the Trackball to select the required view name.

4. Press Set.

The name of the view displays above the timers in the 
window.

5. Repeat steps 1 through 4 to assign loops to the other views 
of the level.

6. Press Done when complete.

A dialogue window displays asking whether the entire 
Continuous Capture acquisition should be saved.

7. Press Delete to discard the loop or press Store all  to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.
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Post Acquisition Features

Post acquisition, you can utilize Raw Data to adjust the following 
in B-Mode: 

• Zoom

• SRI-HD

• Rejection

• Frame Average

• TGC

• Maps

• Dynamic Range

• Gain

• Rotation

You can also take measurements post Stress Echo acquisition. 
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Analysis

Analysis consists of viewing previously saved loops and 
assigning scores to each cardiac segment, in order to quantify 
the function of the muscle or wall segment.

Depending on the protocol configuration, the analysis stage can 
start manually or automatically after completion of the stress 
test. In this case, the usual procedure consists of sequentially 
opening all image groups (if defined) and performing scoring 
from image to image.

The quad screen is the standard display for comparing heart 
cycles. The heart cycle loops in the display are synchronized to 
enable comparison. Each loop in the quad screen can be 
magnified, using the zoom control.

Image Selection for Analysis

Images can be selected manually or from a pre-defined group in 
the Protocol screen.

Selection of Images from a group

If groups of images have been defined in the protocol template, 
you can select a group of images for analysis and sequentially 
analyze all images from all groups from within the Analysis 
screen.

1. In a stress examination, press Protocol. A preview of the 
acquisition displays.

2. Press Analysis. A pre-defined group appears in the display 
with a Wall Segment window on the left. 

3. To advance to other groups, use the Trackball to move the 
cursor to the arrows at the bottom of the Wall Segment 
window. Select an arrow to advance to another group. For 
further clarification, see callout E in Figure 13-100. 
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Manual selection of images from Analysis screen

1. When currently in the protocol analysis screen in the Stress 
analysis quad screen, hold down the SHIFT key while 
performing Steps 2 through 4.

2. Use the Trackball to move the cursor to the first image to 
select in the template matrix.

3. Press Set. The frame of the selected loop is in the Stress 
analysis screen and the next window in the quad screen is 
automatically selected.

4. Repeat step 2 and 3 to select other images.

5. Depress SHIFT .

Manual selection of images in the Protocol screen

1. In a stress examination, press Protocol. A preview of the 
acquisition displays.

2. Use the Trackball to move the cursor to the first image to 
select.

3. Press Set. The frame of the selected loop highlights.

4. Repeat Steps 2 and 3 to select other images.

5. Press Analyze to open images in the Analysis screen.
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Scoring acquired loops

1. After image selection, press Analyze.

The Stress Echo analyze screen displays.

 Figure 13-100. Analysis Screen

1. Wall segment diagram

2. Selected loop (Highlighted frame)

3. Displayed loops (Highlighted frames)

4. Exit Wall motion scoring

5. Change page or enter next image group
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Scoring acquired loops  (continued)

2. Use the Trackball to move the cursor to a score.

3. Press Set.

The score displays in the relevant segment area in the 
diagram.

NOTE: To edit a score, select it and choose a new score.

4. Repeat step 1 through 3 to score relevant segments.

5. Press the Change Page arrow to display the next group of 
images.

6. Repeat step 1 through 3 to score relevant segments on the 
new loops.

Figure 13-101. Segment Scoring

NOTE: Since Cine changes into sync mode, subsequent scans are also 
synchronized. Exit sync mode from the Cine menu.
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Editing/Creating template

The stress package provides protocol templates for exercise as 
well as pharmacological stress examinations.

The user can create new templates or modify existing templates 
to suit the individual needs. Up to ten projections and fourteen 
stress levels can be created in a template.

Templates created may be temporary, used only during the 
current examination, or saved as new templates, for future use 
and reference.

The editions that may be performed include:

• Adding/Deleting levels and projections.

• Assigning new labels to levels and projections.

• Defining level options.

• Defining new groups.

Templates are edited/created from the Template editor screen.

Entering the Template editor screen

1. Press Protocol to enter the stress echo mode.

2. Press Template.The template list displays.

3. Use the Trackball to select the Template Editor.

4. Press Set. The Template Editor screen displays.

OR

1. Press Protocol to enter the stress echo mode.

2. Press Template Editor on the Touch Panel. The Template 
Editor screen displays.



Stress Echo

LOGIQ Fortis – Basic User Manual 13-211
5855997-1EN Rev. 3

Template Editor screen overview

 Figure 13-102. Template Editor Screen

Table 13-42:  Template

Parameter Description

Template Select a pre-defined template from the pull-down menu. The protocol 

template preview updates accordingly.

Table 13-43:  Protocol Template Preview

Parameter Description

Protocol Template Preview • Displays an updated preview of the template accordingly to the settings 

applied.

• To change Projection and Stress level labels, select a pre-defined label from 

the pull-down menu or press Set in the actual label field and type a new 

name.



Advanced Features

13-212 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Table 13-44:  Template Settings

Parameter Description

Template Settings • Cycles: select the number of cine loop heart cycles to store for each level 

from the pull-down menu or enter the desired value manually.

• Continuous Capture: Checking this parameter enables continuous image 

acquisition throughout the level. The images acquired are temporarily 

stored in the system’s storage buffer.

• Preview of store: Checking this parameter enables review and 

adjustment of cine loops before store.

• Show reference: Checking this parameter displays a dual screen with the 

reference level (first or previous level) on the left and the live image on 

the right.

Table 13-45:  Scan Mode

Parameter Description

Scan Modes • 2D, Color, PW (Pulsed Wave Doppler), CW (Continuous Wave Doppler), 

MM (M-Mode), Color MM, Color PW, Color CW

Table 13-46:  Other options

Parameter Description

Other Options • Grid Size: Enter the number of levels and projections for the selected 

template.

• Timers: If you check this parameter, starts T1 and T2 timers 

automatically.

• Auto-start analysis: If you check this parameter, displays the Stress Echo 

Analysis when the last acquisition is performed.

• Show Systole in Analysis: When selected, the systolic part of the cardiac 

or ECG cycle is only displayed. The whole cycle is not displayed. 

• Smart Stress: Check Smart Stress to store and automatically reuse a 

subset of the image acquisition settings from a previous level in the 

corresponding views in the next level.  When smart stress is used  with 

"preview to store" function the timeline modes (PW, CW, M Mode, TDI) 

will only transfer image acquisition settings from baseline. 

• Reference image: When Show Reference is selected, selects either 

corresponding baseline loop or corresponding loop from the previous 

level to be displayed as reference image during acquisition.

Table 13-47:  Pre-defined groups

Parameter Description

Pre-defined groups • Shows the image groups created.

• New group: Creates a new image group. Select the desired images on 

the template preview.

• Update group: Edits a selected group after new loop selection on the 

template preview.

• Delete group: Deletes a selected group.
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Editing/Creating a template

Selecting a base template to edit

1. Select the base template from the template pull-down menu 
on the upper left corner.

2. Press Set.

The selected template displays in the protocol template 
preview field, showing the levels, projections and their 
labels.

Adding/Deleting levels and projections 

1. Enter the number of levels and projections in the Grid size 
field.

The new grid size displays in the protocol template preview 
field.

2. Press New Template to create a new template.

or

Press Save Template to update the base template.

Display timers

1. Check the box(es) to display timer(s) as specified.

NOTE: The timers can also be started or stopped at any time during 
stress examination by using the T1 and T2 Touch Panel key.

Start analysis automatically

1. Check Auto Start Analysis to display the Stress Echo 
Analysis screen when the last acquisition is performed.

Smart Stress

1. Check Smart Stress to store and automatically reuse a 
subset of the image acquisition settings from a previous 
level in the corresponding views in the next level.  When 
smart stress is used  with "preview to store" function the 
timeline modes (PW, CW, M Mode, TDI) will only transfer 
image acquisition settings from baseline.
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Editing/Creating a template  (continued)

Configuring levels

The following options can be set up for each level:

Number of cycles to be stored in the cine loop:

1. Enter the desired number (1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 15, 20) 
in the Cycles field.

Continuous Capture

1. Check Continuous Capture if continuous image acquisition 
throughout the level is desired.

When Continuous Capture is selected, preview of the cine 
loop and reference display during acquisition are not 
possible.

Preview of store

1. Check Preview of store if review and adjustment of cine 
loops before storage is desired.

Show reference

1. Check Show reference if the display of the corresponding 
reference loop is desired during acquisition (Dual screen 
mode).
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Editing/Creating a template  (continued)

Adding a group

1. In the Protocol template preview field, select the cells to be 
part of the group.

2. In the Pre-defined group field, press New group.

A dialogue box displays to ask the user to enter a name for 
the new group.

3. Enter the group name.

4. Press OK. The new group displays in the pre-defined group 
field.

Updating an existing group

1. In the Pre-defined group field, select the group to edit.

The selected cells are highlighted in the Protocol template 
preview field.

NOTE: A selected group is highlighted by a blue frame.

2. Either select a new cell(s) to add to the group or deselect an 
existing cell(s) to remove from the group.

3. Press Update group.

The display in the Protocol template preview field is updated 
accordingly.

Deleting a group

1. In the Pre-defined group field, select the group to delete. 

NOTE: The selected group is highlighted by a blue frame.

2. Press Delete group.

The group is removed from the list in the pre-defined group 
field.

Specifying Scan Mode for each Projection

1. Specify the Scan Mode for each Projection: 2D (B-Mode), 
Color Flow Mode, M-Mode, Color M-Mode, PW Mode, Color 
PW Mode, CW Mode, or Color CW Mode. 
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Editing/Creating a template  (continued)

Saving the Template

You can save the template using controls at the bottom of the 
Template Editor page, or use the controls on the Touch Panel. 

Table 13-48:  Template Editor Saving Options

Parameter Value

New Template Select this option to create an entirely new template. 

Save As Template If you would like to create a new template based on the existing template with 

your modifications, select to Save this Template As, and give it a name. 

Save Template Select this option to save the default template with your modifications. 

Delete Template Select this option to delete a template. 
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Wall Motion Segment Setup 

You can set up the following parameters for Wall Motion 
Segment in the Utility screen (Utility--> Measure--> Advanced--> 
Cardiac).

Utility Application Settings for Protocol

Table 13-49:  Wall Motion Segment Parameters

Parameter Value

WMS freeze loop at ES Specify to freeze the Loop at End Systole

WMS Segment Model Select 16 or 18 segments

WMS initial scoring Undefined or Normal

WMS scoring legend ASE, ASIA or European

Table 13-50:  Protocol Parameters

Parameter Description

Show Protocol Tab Show/Hide the Protocol tab for that preset (Bicycle Normal, Bicycle Sporty, 

Contrast Pharmacological, Pharmacological 4x4, Pharmacological 8x5, 

Exercise 2x4, Exercise 2x4 B, Pharmacological US 4x4, or User-configured).

Template Select the default template.
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Report

If you set up the Wall Motion Analysis field on the Report, you 
can insert the results. 

Select Report to view either the Bull’s Eye or Cut Plane Report. 

 Figure 13-103. Bull’s Eye Report Sample
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Report  (continued)

 Figure 13-104. Cut Planes Report Example

HINTS Select either Bull’s Eye or Cut Plane on the Reports--> Adult 
Template. 
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Cardiac Automated Functional

Imaging (Cardiac Strain)

Cardiac Strain

Cardiac Automated Functional Imaging (Cardiac Strain) is a 
decision support tool for regional assessment of the LV systolic 
function. Cardiac Strain is a tool derived from 2D Strain, which 
calculates the myocardial tissue deformation based on feature 
tracking on B-Mode grey scale loops.

Cardiac Strain is performed on apical views in the following 
order: apical long-axis, 4-chamber and 2-chamber view, 
following an on screen guided workflow. The apical views may 
be acquired sequentially in B-Mode.

Cardiac Strain is also available for standard apical views 
acquired with a TEE probe.

The result is presented as a Bull's eye display showing color 
coded and numerical values for peak systolic longitudinal strain.

All values are stored to the worksheet. In addition, Global Strain 
for each view, Average Global Strain for the whole LV and the 
Aortic Valve Closure time used in the analysis are stored to the 
worksheet.



Cardiac Automated Functional Imaging (Cardiac Strain)

LOGIQ Fortis – Basic User Manual 13-221
5855997-1EN Rev. 3

Table 13-51:  Cardiac Strain Workflow

1 2 3

StepAPLAX 4-CH 2-CH

1 Acquired views

2 Defining a ROI

3

• 

Tracking 

Validation

4 - - AVC Timing 

Adjustment

5 - Parametric 

image result
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6 - - Trace and 

Bull’s eye 

result

Table 13-51:  Cardiac Strain Workflow (Continued)

1 2 3

StepAPLAX 4-CH 2-CH
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Acquisition

1. Specify Cardiac Strain-specific values for certain parameters 
in M&A Advanced Preset if needed.

• Cardiac Strain/AutoEF auto processing

• Cardiac Strain/AutoEF ROI method

• Cardiac Strain/AutoEF YOYO

• Cardiac Strain Default Color Palette

• Cardiac Strain segment model

• Cardiac Strain PSS/PSI Mode

2. Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

3. Select CARD -> Adult from the Application Preset menus. 
Acquire a sequential acquisition.

Acquire B-Mode gray scale cineloops of an Apical long axis 
(APLAX) view.

NOTE: It is recommended to acquire all three apical views 
sequentially in order to get similar heart rate in all views.

• The frame rate should be between 37 and 80 frames 
per second. A higher frame rate is recommended for 
high heart rate.

• The system should be configured to store 100 ms 
before and after each heart cycle.

• If the acquisition has more than one heart cycle, the 
analysis will be done on the second to last heart cycle.

• The entire myocardium should be visible.

• A depth range that includes the entire left ventricle 
should be used.

4. Press Freeze. Run the cine and press P1 to store the cine 
into the clipboard.

5. Acquire and store B-Mode gray scale cineloops of an Apical 
4 chamber view and an Apical 2 chamber view as described 
above.

CAUTION Cardiac Strain is only recommended for adult cardiac images 
acquired with the M5Sc-D and 6Tc-RS.
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Starting Cardiac Strain

Starting Cardiac Strain from sequential acquisition.

1. Open an APLAX view and press Measure.

2. Select AFI on the Touch Panel.

3. Three apical view buttons appears on the left side menu. 

When performing Cardiac Strain on all three apical views, the 
user is asked to start with the APLAX view. This allows manual 
adjustment of the Aortic Valve Closure (AVC) event timing that is 
used in the calculation of the longitudinal systolic strain in all 
apical views.
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Cardiac Strain on the APLAX view

1. Select APLAX.

A ROI following the endocardium is created and the 
Tracking validation screen is displayed.

 Figure 13-105. Tracking Validation screen

1. Display Quick Tips on tracking quality assessment

2. The ROI divided in segments

3. The scoring table

• acceptable tracking

• not acceptable tracking

4. Bull’s eye icon

• Green sectors with yellow border: views being analyzed.

• Green sectors: views already analyzed.

• Black sectors: view not analyzed.
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Cardiac Strain on the APLAX view  (continued)

2. Pay attention on the left/right orientation of the image: 
compare the LV wall names with a visual inspection of the 
image.

If the image orientation is wrong, create a new ROI manually 
as described in the section ‘To create a new ROI’ on 
page 13-230. Make sure to place the basal points correctly 
relative to the image landmarks when defining the ROI.

NOTE: You may alternatively exit Cardiac Strain, invert the image 
and start Cardiac Strain again.

The ROI is divided into segments. The tracking quality for 
each segment is automatically evaluated and summarized 
in the Scoring table (see Figure 13-105 on page 13-225).

The tracking for each segment must be visually controlled 
and validated as described below.
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Tracking Validation

Poor tracking quality could result from a variety of causes. 
Select Quick tips (see Figure 13-105 on page 13-225) to get tips 
on the most common causes for bad tracking. The common 
causes for bad tracking are:

• Erroneous placement of the basal points when defining the 
ROI. If the basal points are placed too far from the annular 
region, the ROI segments at the annular base will not move 
together with the underlying 2Dimage throughout the entire 
heart beat (see example cineloops in the Quick tips).

• Erroneous placement of the apex point when defining the 
ROI. The point should be placed so that the resulting ROI 
covers mainly the myocardium. If the apex point is placed 
too high, the ROI will mainly cover the epicardium resulting 
in poor tracking (see example cineloops in the Quick tips).

• Too narrow ROI width. Narrowing the ROI too much will 
result in poor tracking due to lack of tissue data in the ROI 
(see example cineloops in the Quick tips).

• Too much clutter. Images with too much static clutter will 
result in poor tracking (see example cineloops in the Quick 
tips).

CAUTION Poor tracking quality may lead to incorrect measurement 
results. The tracking for each segment must be visually 
controlled and validated.
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Tracking Validation  (continued)

1. Inspect each segment and make sure that the center line is 
moving together with the underlying 2D image.

The tracking quality is automatically evaluated for each 
segment and displayed in the Scoring table.

The tracking in each segment is scored as either Acceptable 
(v) or Not acceptable (x).

If the tracking needs to be improved for some segments, the 
user can modify the ROI or create a new ROI as described 
in ‘ROI adjustment’ on page 13-229 or create a new ROI as 
described in ‘To create a new ROI’ on page 13-230.

The user may override the tracking quality evaluation done 
by the system by clicking on the evaluation result in the 
Scoring table.

2. Once the tracking quality has been controlled for all 
segments, press Approve in the Scoring table.

The user is asked to confirm or adjust the AVC timing setting 
(see Figure 13-108 on page 13-234).
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ROI adjustment

To adjust the ROI

1. Press Recalc.

2. The following adjustments can be done to the existing ROI:

• Adjust ROI Width.

• Adjust the shape of the existing ROI: move the cursor 
over the inner ROI border, select an anchor point and 
move it to a new location. The shape of the ROI is 
updated accordingly.

Figure 13-106. Selected anchor point on the inner ROI border

Data processing is started automatically if the cursor is not 
moved for a few seconds.

NOTE: If the ROI needs to be adjusted make sure to make the 
changes immediately after the ROI is displayed.

NOTE: The auto processing function is configurable (from Utility -> 
Measure -> Advanced -> AFI auto processing).

The Tracking validation screen is displayed.

3. Perform Tracking validation (see ‘Tracking Validation’ on 
page 13-227).
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To create a new ROI

1. Press Recalc.

2. Press 3 Points to re-define the ROI.

The system automatically displays a frame where the 
endocardial border is usually clearly visible.

3. To define a ROI, place three points at the endocardial 
border; two annular points and one at the apex (see 
Figure 13-107). Follow the indications displayed next to the 
pointer and on the Status bar when placing the three points.

NOTE: The Yo-yo function is turned on to help find correct location 
for the points.

Figure 13-107. Defining a ROI

After placing the apex point, the ROI is displayed.

NOTE: Correct ROI definition is important for an accurate strain 
measurement. The system has an adaptive ROI function: 
using the endocardial three points as a guide, the system 
will analyze the image and automatically adapt the ROI to 
an optimal position.

Data processing is started automatically if the cursor is not 
moved for a few seconds.

The Tracking validation screen is displayed.

4. Perform Tracking validation (see ‘Tracking Validation’ on 
page 13-227).
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Quick tips when re-creating the ROI

Correct ROI definition is crucial to get good tracking. Refer to 
the example displayed in the Tip window for correct point 
placements. To display additional guidelines, select Click for Tip. 
Make sure to follow the recommendations when placing the 
three points (see below).

Table 13-52:  Tips for re-creating the ROI

Tips Correct Incorrect

Base

1. Correct position of the base 

points.

2. The ROI extends into the 

aortic tract.

Apex

1. Correct position of the Apex 

points.

2. The apex point is placed too 

high. The ROI is extending 

beyond the epicardium.
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Apex

1. Correct position of the Apex 

points.

2. The apex point is too high; 

the ROI is extending beyond 

the epicardium. 

Bulges

1. Correct ROI.

2. ROI should not be bulging or 

follow the papillary muscle. 

To edit the ROI, see ‘ROI 

adjustment’ on page 13-229.

General

The left ventricle must be visible 

through the entire cycle.

1. End systole frame: the entire 

left ventricle is displayed..

2. End diastole frame: the 

annulus is not displayed.

Table 13-52:  Tips for re-creating the ROI (Continued)

Tips Correct Incorrect
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Timing Validation

Timing information may be crucial to accurate diagnosis. The 
most important event timing is the aortic valve closure (AVC), 
since it is part of the definition of the end systolic strain 
parameter.

Determination of the AVC timing by the system is as follows, 
depending on the situation:

• An automatic AVC estimate determined by the temporal 
contraction of all LV segments (Strain curves) is used.

• From the APLAX view, the user can adjust the estimated 
AVC timing. The adjusted AVC timing will then be used in 
the other apical views when running Cardiac Strain on these 
views.

This option is only available from the APLAX view.
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AVC Timing Adjustment

This procedure is available in the APLAX view only.

1. After validation of the tracking quality, the frame for the 
automatic AVC setting is displayed and highlighted on the 
ECG.

2. To keep the current AVC setting, press Set. To change the 
AVC setting, use the Trackball to display another frame and 
press Set.

If the AVC setting was changed, a Confirmation window is 
displayed. Select one of the following options:

• Manual to accept the manual AVC setting.

• Auto to discard the manual AVC setting and use the 
automatic AVC timing.

The parametric systolic strain APLAX view is displayed.

 Figure 13-108. Parametric systolic strain APLAX view
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AVC Timing Adjustment  (continued)

NOTE: The image will not be saved unless Print key is pressed.

To activate a quad display, press and hold down L.

• 2D image with the ROI

• 2D image with Peak systolic strain parametric data

• Segmental curves with peak marker

• M-Mode image with strain parametric data

 Figure 13-109. Quad screen for the APLAX view

NOTE: The Quad screen will not be saved unless Print key is 
pressed.
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Cardiac Strain on A4-Ch and A2-Ch views

The procedure for Cardiac Strain on Apical 4-chamber and 
2-chamber views is similar to the one used in the APLAX view.

For sequential acquisition,

1. Open the apical view from the clipboard.

2. Select the corresponding view in the View selection menu.

3. Validate tracking (see ‘Tracking Validation’ on page 13-227).

NOTE: The AVC timing setting defined in the APLAX view is used by 
the system when running Cardiac Strain on the other apical 
views.

Results

For the APLAX and apical 4-chamber views the following results 
are available:

• Single screen (see Figure 13-108 on page 13-234) 
displaying a 2D image with strain parametric data.

• Quad screen (see Figure 13-109 on page 13-235) 
displaying:

• 2D image with the ROI

• 2D image with Peak systolic strain parametric data

• M-Mode image with strain data

• Segmental curves

If Auto-AVC is used as AVC timing calculation method when 
running Cardiac Strain (see Figure 13-108 on page 13-234), the 
strain values displayed in the Quad screen for the APLAX and 4 
Chamber views may differ from the strain values obtained after 
the system has performed the final calculation from all three 
views. 

The reason for this is that the Auto-AVC calculation derived from 
all three views is most accurate and may be different from the 
intermediate AVC calculations used for each view. 
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Results  (continued)

The strain values displayed in the Quad screen on APLAX and 4 
Chamber views are therefore preliminary values (A warning text 
about this is displayed on the Quad screen). Only final strain 
values should be reported. 

NOTE: If you enter Quad screen again after all three loops have been 
processed, the strain values will be correct.

When performing Cardiac Strain on all three apical views the 
following results are also available:

• Bull's Eye and Traces screen displaying:

• Segmental curves for each three Apical views

• Bull's eye presentation with segmental Peak systolic 
strain color coding and segmental Peak systolic strain 
values.

Select BE+Trace to display.

 Figure 13-110. BE+Trace screen
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Results  (continued)

• Bull’s Eye and Review screen displaying:

• Bull’s Eye together with cine clips for all 3 views.

• Cine Stop or Cine Play (changed in toggle) on the Touch 
Panel controls the cine stop or play of the displayed 
image.

Select BE+Review to display.

 Figure 13-111. BE+Review screen
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Results  (continued)

• Bull's Eye Only screen displaying:

• Bull's eye presentation with segmental Peak systolic 
strain color coding and segmental Peak systolic strain 
values

NOTE: The Bull's eye can be configured to display either 18 or 
17 segments (from Utility/Measure/Advanced/AFI 
segment model).

NOTE: Press BE Maps to select another color map for the Bull's 
eye.

NOTE: The system can be configured so that the user can also 
choose to display Post systolic strain index (PSI) color 
coding and segmental PSI values in the Bull's eye (from 
Utility/Measure/Advanced/AFI PSS/PSI Mode). 

• Global Strain (GS) values for all three apical views.

In a given view the Global Strain (GS), also called 
Global Longitudinal Peak Strain (GLPS), is defined as 
the percentage of maximal contraction over the whole 
cardiac cycle of the entire myocardial wall relative to its 
end diastolic length.

• Averaged Global Strain value from all three apical view 
data.

• AVC measurement (either automatic or manual, see 
Figure 13-108 on page 13-234)
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Results  (continued)

Select BE+Only to display.

Figure 13-112. Bull’s Eye Only screen
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Getting the result

To save the results, exit Cardiac Strain and answer yes to the 
question "Do you want to store AFI Results?". Once the results 
are saved, the measurements are available in the worksheet 
and can be used in the report.

If the tracking quality of a segment was scored as Not 
acceptable (x), the colorimetric display on the Bull's eye is 
greyed.

Figure 13-113. Colorimetric display

1. Segment with tracking quality scored as Not acceptable (x).
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Peak detection

The peak systolic strain detection for each segment can be 
verified and eventually manually changed.

To adjust the peak detection:

1. Press BE+Traces.

The Bull's Eye and Traces screen is displayed showing:

• Trace plots for all three loops

• Bull's Eye with Peak systolic strain values

2. To change the peak marker position on a curve:

• Press Set on the peak marker (square point) on one of 
the curves, move the peak marker to a new position and 
press Set again to fix the point.

or

• Place the cursor on a segment in the Bull's Eye. The 
corresponding curve is highlighted.

Click on the segment to select the corresponding peak 
marker and move it to a new position. Press Set to fix 
the point.

NOTE: You can change Peak Maker only during Start point of Heart 
Cycle and AVC Time.

The position of the AVC marker can also be checked in the Bull's 
Eye and Traces screen. If needed, the APLAX view should be 
reprocessed to change the AVC time.
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About the results

Be aware of the following:

• Clinical assessments should be made based on both color 
and segmental Peak systolic strain values.

• The Save As function is intended for research purposes and 
should not be used to archive diagnostic data.

• To populate the worksheet and the report the Bull's Eye 
Only screen must be saved.

• All results shown (curves, colors and values) are based on 
drift compensated values. Any strain drifting is linearly 
compensated throughout the cycle. If the drift compensation 
in a given segment is too high, the tracking quality is 
automatically set to Not acceptable (X).

• If the tracking quality was scored as Not acceptable (X) in 
more than one segment, the Global Strain value is not 
calculated.
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Auto EF

Auto EF Measurements  

Automated Ejection Fraction (AutoEF) is a semi-automatic 
measurement tool used for measurement of the global EF 
(Ejection fraction). The AutoEF tool is used as an optional 
decision support tool.

The AutoEF tool tracks and calculates the myocardial tissue 
deformation based on feature tracking on B-Mode cine loops.

AutoEF is performed on either one or both apical 4-chamber or 
2-chamber views, in any order.

The result is presented as Ejection Fraction value for each view 
and average Ejection Fraction for the whole LV. All values are 
stored to the worksheet after the results are approved (see See 
‘Tracking Validation’ on page 13-252 for more information.).

NOTE: The AutoEF tool is intended for pediatric cardiology and is  
intended to be used in pediatric cardiology.
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Acquisition

NOTE: AutoEF is only available on the M5Sc-D and 6Tc-RS probes.

1. Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

2. Acquire B-Mode cineloops of an Apical 4 chamber view 
(4-ch) and an Apical 2 chamber view (2-ch).

• The frame rate should be between 37 and 80 frames 
per second. A higher frame rate is recommended for 
high heart rate.

• LOGIQ Fortis should be configured to store at least 100 
ms before and after each heart cycle.

• If the acquisition has more than one heart cycle, the 
analysis will be done on the second last heart cycle.

• The entire myocardium should be visible.

• A depth range that includes the entire left ventricle 
should be used

NOTE: The AutoEF processed image loop runs slower than the actual 
cardiac motion. To see the loop in correct playback speed, exit 
AutoEF.
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Starting AutoEF

1. Recall any one of the stored views and press Measure.

2. In the Touch Panel, select AutoEF.

The View selection menu is displayed.

3. Select the name of the current view: 4-ch or 2-ch. A ROI is 
defined and tracked through the entire heart cycle as 
detailed below.

Defining the endocardial border (EB)

When selecting a view to analyze, the system automatically 
displays a frame where the endocardial border is usually clearly 
visible. The system automatically displays the ROI for tracking 
on the screen and the tissue tracking starts. When the tracking 
is completed and displayed, you can either accept the results or 
recalculate/redraw the endocardial border (EB).

Selecting “Recalc”

When selecting Recalc, you have the option to correct the EB 
manually or to revert to the semi-automatic 3 Point EB definition 
mode. (To revert to semi-automatic mode, press Auto ROI.) If 
you adjust any point in the EB and wait a few seconds, the 
system automatically starts reprocessing.

You can also choose another frame to redefine the EB. To 
choose another frame, turn off the YOYO function, and adjust 
the Left/Right marker.

It is also possible to define an EB in semi-automatic 3 Point 
mode.
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Defining Endocardial Border (EB) in semi-automatic 3 Point mode

To define the endocardial border, place three points at the 
endocardial border; two annular points at the base and one at 
the apex. Follow the indications displayed on the screen when 
placing the three points.

After placing the third point on the Apex, an endocardial border 
will automatically be traced (Figure 13-114 on page 13-248).

After Selecting 3 Points, the old EB is cleared from the screen 
and you can redefine a new EB using the 3 Point EB Definition 
method as described above.

NOTE: Correct border tracing is important for an accurate EF 
measurement. The system has an adaptive border tracing 
function: using the endocardial three points as a guide, the 
system will analyze the image and automatically adapt the 
border tracing to an optimal position.

NOTE: The YOYO function is turned on to help finding the correct 
location for the points.
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Editing the endocardial border trace

1. If required, use the Edge Shift Left/Right controls to 
delineate separately the left or right portions of the 
endocardial border visually as best as possible.

2. If required, move the Trackball cursor over the border trace, 
select an anchor point (red circle), press SET and correct 
the trace by dragging the anchor point to a new location 
(Figure 13-115 on page 13-249). The shape of the border 
trace will update accordingly.

3. In case you wish to start over, press 3 Points and re-position 
the 3 points defining the basal and apex points.

Figure 13-114. Defining a ROI
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Editing the endocardial border trace  (continued)

4. Place the Trackball cursor over the desired point.

5. Selected Point is marked by a red circle.

6. Click over the red circle, it will turn to a square.

Figure 13-115. Selected anchor point on the inner border trace

7. Move the square to re-align the border trace.

8. Press the Process button when ready.

NOTE: Data processing is configured by default to start automatically if 
the cursor is not moved for a few seconds. If the trace needs to 
be adjusted, make sure to make the changes immediately after 
the ROI is displayed.
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EF results screen

When processing is complete the EF results screen is displayed 
(Figure 13-116 on page 13-251).

NOTE: The bi-plane results (BiP) will only appear on screen 
(Figure 13-116) after measuring both 2-Ch and 4-Ch views.

The AutoEF processed image runs slower than the original loop 
speed. In order to see the loop in correct playback speed exit 
AutoEF.

The running loop is shown on the left. A green dotted line marks 
the inner border of the chamber. In case of poor tracking, the 
system will automatically display parts of the border in red.

The system will automatically pick the frames with the maximal 
area (ED) and minimal area (ES) and place them on the right 
area of the display.

The End Diastolic volume (EDV) and end Systolic Volume (ESV) 
is calculated and shown above each frame.

The resulting EF calculation is displayed on the top of the 
screen.
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EF results screen  (continued)

Figure 13-116. AutoEF Result Multi Screen

Figure 13-117. AutoEF Results Dual Screen - Alternative 
screen mode
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Tracking Validation

The tracking must be visually controlled and validated. If the 
tracking results are visually correct press the red Approve 
button. The button turns green and is labeled Approved. The 
calculated values will be stored and appear in the worksheet.

The following can be done if tracking needs correction:

1. Press EF Dual to enlarge ES and ED frames and position 
them side-by-side (Figure 13-117 on page 13-251).

2. You may manually select a different ED frame or ES frame 
using the ED frame or ES frame rotary.

3. You may edit any misaligned point on either ED or ES 
frames. This is done by:

a. Placing the Trackball cursor over the desired point.

b. Clicking over the red circle, it will turn to a square.

c. Pressing Set and moving the square to re-align the 
border trace.

d. The ESV, EDV and EF will be recalculated accordingly.

Figure 13-118. Border trace edit
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Tracking Validation  (continued)

e. In case these results are incorrect, you may go back to 
the previous step by pressing the Recalc button and 
editing the endocardial border (‘Defining the endocardial 
border (EB)’ on page 13-246).

f. In case editing the endocardial border is too difficult, you 
may start all over again by pressing Auto ROI and 
retrace the border (‘Defining the endocardial border 
(EB)’ on page 13-246).

Possible causes of poor tracking

Poor tracking quality could result from a variety of causes. The 
common causes for bad tracking are:

• Erroneous placement of the basal points when defining the 
border. If the basal points are placed too far from the 
annular region, the border segments at the annular base will 
not move together with the underlying 2D image throughout 
the entire heart beat.

• Erroneous placement of the apex point when defining the 
border. The point should be placed so that the resulting 
border trace covers mainly the endocardium. If the apex 
point is placed too high, the border trace will mainly cover 
the epicardium resulting in poor tracking.

• Too much clutter. Images with too much static clutter will 
result in poor tracking.
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Results

For each of the views, a results screen containing the EF 
calculation, appears (Figure 13-116 on page 13-251) in a 
mini-report. The mini-report appears on the left side of the 
results window.

Figure 13-119. Mini Report

The results are summarized in the worksheet and in the report.

 Figure 13-120. Results on the Worksheet and Report Template
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Exit AutoEF

Press Exit to end AutoEF. Pressing Report, Patient or Scan also 
closes the AutoEF package.

NOTE: Do not disable any sub-measurement of AutoEF in Utility --> 
Measure, as this will disable the whole set of AutoEF 
measurements.

NOTE: For consistent results, do not delete individual AutoEF 
measurements from the worksheet. Always delete a full column.
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ECG

Overview

A physiological input panel is available for the LOGIQ Fortis.  
This panel has inputs for ECG, PCG and auxiliary signals.

The physiological module consists of three channels:  

1. ECG and Resp.

2. PCG

3. AUX

AUX is capable of handling external ECG signals from other 
diagnostic ECG devices.

The scanned image that is displayed is synchronized with the 
ECG and PCG traces. In Doppler or M-Mode, the traces are 
synchronized to that particular mode’s sweep.

Approved accessory cables provide the proper signals to the 
Physiological Panel.

To display the ECG Signal on the monitor, go to Utility--> 
Imaging--> General--> ECG Display. 

CAUTION There will be a slight time gap between the ECG signal and the 
Doppler waveform when the selected  PRF is low (less than 1.0 
kHz). 

CAUTION To avoid skin burns in surgical use, do not place ECG 
electrodes in current path between Electrosurgical Unit (ESU) 
active and dispersive electrodes. Keep ESU cables away from 
ECG leads.
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Overview  (continued)

Figure 13-121. Optional Physiological Input Panel

WARNING • Do not use with a defibrillator except with 
DEFIBRILLATION PROOF APPLIED PARTS.

Only the ECG connection port is a defibrillator proof 
applied part.

• DO NOT USE the physiological traces of the LOGIQ Fortis 
Ultrasound system for diagnosis and monitoring in lieu of 
ECG.

• Only approved and recommended peripherals and 
accessories should be used.

• After the defibrillator stimulates the patient, the ECG 
requires 4 to 5 seconds recovery time.
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ECG Cable/Respiration

The ECG Cable is a modular cable consisting of two different 
cable parts:

• Single cable with a system connection at one end and a 
cable splitter at the other.

• A triple color-coded electrode cable to be inserted into the 
splitter device. Each electrode cable hooks up to the 
appropriate stick-on electrode by a color-coded clip type 
connector.

The color-coding of the electrodes follows one of two standards 
that are common in different parts of the world. The cable splitter 
device has a drawing defining the color codes, names and body 
location for the two standard color codes. 

IEC (Europe, Asia, Rest of World)

1. R: Red

2. L: Yellow

3. F: Green

AHA (USA)

1. RA: White

2. LA: Black

3. LL: Red

Table 13-53:  ECG Color Code Cable

IEC 

(Europe, Asia, ROW)

AHA 

(USA)
Position of the 

human body surfaceElectrode Mark Color Code Electrode Mark Color Code

R Red RA White Right Arm

L Yellow LA Black Left Arm

F Green LL Red Left Leg
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Physiological Trace Monitor Display

The scanned image is synchronized with the ECG and PCG 
trace. In Doppler or M-Mode, the traces are synchronized with 
that particular mode’s sweep.

The user can control the gain, position and sweep speed of the 
traces using the Touch Panel controls.

Figure 13-122. Physiological Trace Monitor Display

1. PCG

2. AUX

3. ECG

4. Auto Heart Rate Display

5. Respiration
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ECG Touch Panel

The ECG Touch Panel provides for control of the physiological 
input signals.

Without the ECG option, the ECG Touch Panel is not displayed.

Table 13-54:  ECG parameters

Parameter Description

Sweep Speed Change the speed of the trace. The sweep speed of the physio signal on the 

B-Mode image can be set independent of the timeline (Doppler and 

M-Mode) sweep speed.

Value: 1 - 16.

ECG Lead ECG Lead Pattern: 1, 2, 3

1: RA (-) to LA (+) (Right, Left, or Lateral)

2: RA (-) to LF (+) (Superior Inferior)

3: LA (-) to LF (+) (Superior Inferior)

NOTE: RA=Right Arm; LA=Left Arm; LF=Left Foot

Timer Trigger Enables intermittent imaging based on a timer.

NOTE: If Timer Trigger is turned on, the ECG Trigger is set to None.

Value: On or Off.

ECG Trigger Enables intermittent imaging based on the ECG. The trigger location(s) 

relative to the R trigger are set with the Delay Time key.

Adjusting: Press ECG Trigger and select one of the options and adjust the 

delay time using the Delay Time key.

• ECG Trig 1 specifies the delay (ms) from R-wave to triggered frame.

• ECG Trig 2 specifies the delay from R-wave to second frame.

• Both activates ECG Trig 1 and ECG Trig 2 simultaneously. Trig 2 must be 

greater than Trig 1 for dual triggering (Both) to be active.

NOTE: If other than None is selected, Timer Trigger is turned off.

Value: None, Trig1, Trig2, and Both.

AUX Display Provides the ability to turn the AUX trace on for display on the monitor.

Adjusting: When the key is selected, the AUX trace toggles between on and 

off.

Value: On or Off

PCG Display Provides the ability to turn the PCG (phonocardiogram) trace on for display 

on the monitor.

Adjusting: When the key is selected, the PCG trace toggles between on and 

off.

Value: On or Off

ECG Display Provides the ability to turn on the ECG trace and Auto Heart Rate for display 

on the monitor.

Adjusting: When the key is selected, the ECG trace and Auto Heart Rate 

toggles between on and off.

Value: On or Off

Resp Display Provides the ability to turn on the respiration tracer.

Adjusting: When the key is selected, the respiration trace toggles between 

on and off.

Value: On or Off
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Resp Lead Respirometer Lead Pattern: 1, 2

1. RA (-) to LA (+) (Right, Left or Lateral)

2. RA (-) to LF (+) (Superior Inferior)

NOTE: RA = Right Arm, LA = Left Arm, LF = Left Foot

ECG Trigger Period The control specifies the number of heart cycles (R-waves) that are skipped 

between ECG triggers. 

The default is 1 or no skipping; 2= skip 1 cycle. 

Adjusting: Adjust the corresponding control.

Value: 1 - 30

Delay Time In ECG Trigger Mode: If only ECG Trig1 or ECG Trig2 is selected via the 

ECG Trigger key, the Delay Time key controls the R-Delay time of the active 

trigger. If both triggers are selected (Both), press this key to toggle ECG 

Trig1 and ECG Trig2 and rotate the key to change the delay time. Once the 

trigger is set, the snap shot image is displayed each time the update line 

passes the active trigger(s).

In Timer Trigger Mode: Rotating the knob changes the delay time between 

images.

NOTE: Delay time may be different for Trig1/2 (0-2 seconds) and Timer 

Trigger. 

Adjusting: Adjust the corresponding control.

Value: 0.10 - 10.00

AUX Gain/Position Allows for the amplitude control of the AUX trace or allows for the vertical 

positioning of the AUX trace on the image display.

Adjusting: Press the knob to toggle between Gain and Position. The default 

is Gain.

PCG Gain/Position Allows for the amplitude control of the PCG trace or allows for the vertical 

positioning of the PCG trace on the image display.

Adjusting: Press the knob to toggle between Gain and Position. The default 

is Gain.

ECG Gain/Position Allows for the amplitude control of the ECG trace or allows for the vertical 

positioning of the ECG trace on the image display.

Adjusting: Press the knob to toggle between Gain and Position. The default 

is Gain.

Resp Gain/Position Allows for the amplitude control of the respiration trace or allows for the 

vertical positioning of the respiration trace on the image display.

Adjusting: Press the knob to toggle between Gain and Position. The default 

is Gain.

Table 13-54:  ECG parameters (Continued)

Parameter Description
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Volume Navigation

Introduction

Using a position sensor attached to the probe, or using a probe 
with V Nav Inside, Volume Navigation Fusion (V Nav) lets you 
import a pre-acquired DICOM volume dataset, register the 
location of the live Ultrasound image with the 3D volume image, 
and then use the position sensing system to simultaneously 
show the live Ultrasound image side-by-side with the 
corresponding multi-planar reformatted (MPR) slice from the 
pre-acquired dataset. 

NOTE: DICOM datasets must have positional data to allow for V Nav to 
treat the datasets as a volume. Most CT, MR, and PET datasets 
have this information as do some X-Ray Angiography datasets. 

In addition, you can use V Nav as a type of “GPS” positioning 
marker to track an anatomy of interest. 

The V Nav Trackers allow you to use a V Nav sensor to track 
where the needle/needle tip is inside the body. 

V Nav is available in B-Mode, Color Flow, Elastography, PDI, 
and Contrast Modes; it is not available while in 3D/4D or when 
timeline modes are active. Biopsy capability is available while in 
V Nav. Dual Caliper is available while in V Nav.

You can load Auto Sweep data for V-Nav, after the data stored 
as volume data in Easy 3D/Advanced 3D.

DANGER
 

DO NOT use the Volume Navigation feature on any patient 
relying on life-sustaining electronic equipment, such as a 
pacemaker or defibrillator. Failure to follow this instruction 
could lead to interference with patient electronic device(s).

CAUTION When performing interventional procedures, remember that the 
pre-acquired dataset is not live and should not be used as sole 
guidance for interventional procedures. 
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Introduction  (continued)

V Nav displays in Split Screen, with the Ultrasound Image on the 
left side of the display and the 3D Dataset on the right side of the 
display. 

Figure 13-123. V Nav Example

V Nav-Specific Definitions

3D Datasets. Computed Tomography (CT)-, or Magnetic 
Resonance Imaging (MR), Positron Emission Tomography 
(PET), XA (X-Ray Angiography), hand held SPECT datasets 
(NM) and Invenia (US) series stored in DICOM format. 
Ultrasound datasets acquired using Tru3D and AutoSweep.  

Registration. Linking the 2D Ultrasound image to the 3D 
dataset. You can register the 3D dataset to the Ultrasound 
image via two techniques, Parallel Plane Registration or Point 
Registration.  

Auto Registration. Auto-registration is available when fusing to 
a Tru3D dataset. When entering V Nav directly from a Tru3D 
acquisition, the Tru3D volume is automatically loaded into V Nav 
and automatically registered. 

Parallel Plane Registration. This registration technique 
requires that the user mark a plane parallel to the 3D dataset 
slices and one common anatomical point, referred to as a 
Translation Point since it performs an x, y, and z correction at 
the point.  

Image-Based Registration. This registration technique is 
available that automatically aligns CT/MR volume with the 
Ultrasound live image.
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V Nav-Specific Definitions  (continued)

Point Registration. This registration technique requires that the 
user mark three or more anatomical point pairs. Performing a 
Plane Registration first may make the process of matching the 
anatomical point pairs easier. 

Anatomical Point Pair. Marking the same anatomical location 
in the 2D Ultrasound and the 3D dataset creates an anatomical 
point pair. 

Lock. After you have set the registrations between the 2D 
image and 3D dataset by either plane or point registration, you 
lock this registration in place. This means that the image content 
of the B-Mode image and the corresponding cut plane through 
the 3D dataset remains the same when you move the probe. 

Magnetic Distortion. A magnetic field is generated by the 
position sensing system. It can become distorted in the 
presence of ferrous or highly conductive metal.  

Environmental Quality. On-screen visual quality map that 
indicates distortion and proximity to the transmitter. Monitoring 
and controlling these two variables contribute to the highest 
quality environment. 

RMSD, Root Mean Square Deviation. Root Mean Square 
Deviation, which equals the 'goodness' of fit. After the user has 
completed a Point Registration, there's a numeric indicator to 
describe the goodness of fit. The lower the number, the better 
the fit. <1 to 10 would be good, 30-40 not so good.  

Window Levelling. Balances the brightness/contrast in the 3D 
Dataset. 

Position Sensing System. Consists of four components: 
Transmitter, Receiver (2), Probe Bracket, Probe/Receiver Cable 
Clips. 

GPS Marker. Used in GPS to track the position of an anatomical 
structure while scanning or while performing a biopsy. 

Virtual Tracker . The V Nav Virtual Tracker allows you to attach 
a sensor to the shaft of the needle (away from the tip). The 
position of the needle tip and the projected needle path are 
projected onto the 2D Ultrasound image. 
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V Nav-Specific Definitions  (continued)

Active Tracker. The Active Tracker is a device that consists of 
at least four markers that show up in a volume imaging dataset 
such as CT or MR. The markers are in known positions relative 
to each other such that the orientation of the Active Tracker can 
be uniquely determined based on the marker positions in the 
image. The device also holds a position sensor in a known 
position relative to the markers. Holes are provided in the Active 
Tracker so that its location can be marked on the body.

Needle Tip Tracker. The V Nav Needle Tip Tracker allows you 
to insert a V Nav tracker inside the Needle to  track the projected 
path and needle tip location inside the body. 

Clinical vs. Research. You can specify which V Nav controls 
you want to appear on the Touch Panel. You can set these via 
Utility -> Application -> Imaging Controls -> Clinical Controls V 
Nav. 

Environment Quality

In order to obtain best results when registering, setting GPS 
markers, it is important to have the highest quality environment 
(minimal distortion and proximity to the transmitter).

Figure 13-124. Environmental Indicator

An Environmental Quality reading for each sensor is provided 
via the Environmental Quality indicator (located in the upper, 
left-hand corner of the display).
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Environment Quality  (continued)

Each sensor has a quality reading from 1 (low quality) to 7 (high 
quality. In addition, the distance between the two probe sensors 
is used to adjust the environmental quality reading presented to 
the user.

If needle tracking is being used, an overall environmental quality 
reading is provided.

The Overall Environmental Quality reading is based on the 
environmental quality readings of the probe sensors and the 
needle sensor as well as the distance between the needle tip 
and the transducer face.

The environmental quality readings update in real time and are 
retained so that they can be displayed during cine scrolling.

Moving the cursor over the Environmental Quality indicator for 
each sensor provides the following information:

Sensor 1 displays a quality reading.

Sensor 2 displays a quality reading and a Distortion reading 
between the 2 probe sensors in [mm]. The magnetic distortion is 
represented as a measured distance between the two sensors 
relative to the expected distance between the two sensors. 

The Needle Sensor displays a quality reading.

The Overall indicator displays an overall Quality reading, and a 
Probe to Tip distance in cm.

Calibration

To calibrate V Nav, contact GE Service. 

Configuration

You can specify the maximum retrospective loop length to store 
via Utility -> Application -> Print controls -> Time span. 

Accuracy

Accuracy depends on precise registration, minimal distortion, 
and controlling the patient’s breathing during a scan. 
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Load the Volume Dataset

If you are using media to load the 3D dataset, you may want to 
store the CT,  MR, PET,  XA, DX, NM or Invenia Dataset on a 
USB flash drive, USB HDD or DVD so that you can clearly label 
the media in a way that identifies the patient information stored 
on the disk. 

We recommend that you load the 3D Dataset onto the 
Ultrasound system prior to starting the V Nav exam to ensure 
that it loads properly and to ensure that the quality is acceptable.  

Ultrasound volume datasets need to have been acquired using 
Tru3D, i.e., a volume dataset that was previously acquired using 
a position sensor. 
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Query/Retrieve

NOTE: For Query/Retrieve to find a patient, the patient MUST have a 
Patient ID. 

Query 

Figure 13-125. VNav Query

1. Press Patient and select Data Transfer. The Data Transfer 
screen displays.

2. Select Q/R.

3. Select the Query/Retrieve server from the Transfer From 
pull-down menu.

4. Type Patient name in the name field.

5. Press Query in the Transfer From section.

6. All studies for that patient and that modality will list.
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Retrieve

Figure 13-126. VNav Retrieve

7. Select the specific series or study which use in V-Nav exam.

8. Press Transfer.

NOTE: Transfer time will vary based on network and file size.
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Load DICOM  Volume Dataset

Load a pre-acquired 3D DICOM volume dataset, 

• Exit and re-enter V Nav and retain the 3D Dataset by 
pressing the V Nav control. 

OR, 

Discard the pre-acquired 3D Dataset, 

• Press Exit and Clear on the Touch Panel. 

From CD/USB 

 Figure 13-127. Loading Dataset From CD/USB

1. If applicable, insert the media containing the pre-acquired 
3D dataset. Volume  datasets  that  can  be  loaded  from  
disk  may  include  CT, MR, PET, XA, DX, CBCT, and GE 
ABUS (US).

2. Select VNav. Press Load and select From CD/USB. 

3. Double click on the DICOMDIR or database file (or single 
click and select the Open button). 
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From CD/USB  (continued)

4. Navigate to the location of the 3D dataset. A list of patients 
and a list of image series for each patient displays. Highlight 
the Series you want to import and select Import Series. 

5. The Check Patient Data screen appears. Confirm that the 
patient information matches the patient associated with the 
current exam. After verifying patient information, press 
Accept (or Reject). You can also specify to display Patient 
Data by checking the Display Patient Data box. 

If you turn on “Display Patient Data”, Patient name, ID and 
birth date are displayed on the Volume data. These remain 
on the live scanning image. 

NOTE: If Hide Patient Data preset or Hide Date Time preset 
(Utility->System->General) is set to "On Store", then the 
patient data is removed from the volume dataset prior to 
image storage and then redisplayed after image storage.

6. B-Mode image displays on the left side and the loaded 
volume data displays on the right side.
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From Database

NOTE: Volume datasets that can be loaded from the database: CT,  
MR, PET, XA, DX, CBCT, and GE ABUS (US).

1. Press Load and select from Database. 

2. Select the desired volume from the Image History screen 
and press Load.

3. The Check Patient Data screen appears. Confirm that the 
patient information matches the patient associated with the 
current exam. After verifying patient information, press 
Accept (or Reject). You can also specify to display Patient 
Data by checking the Display Patient Data box. 

If you turn on “Display Patient Data”, Patient name, ID and 
birth date are displayed on the Volume data. These are 
remained on the live scanning image. 

Figure 13-128.  Check Patient Data Dialog

NOTE: If Hide Patient Data preset or Hide Date Time preset 
(Utility->System->General) is set   to  "On Store", then the 
patient data is removed from the volume dataset prior to 
image storage and then redisplayed after image storage.

NOTE: If you load a Tru3D volume data, Check Patient Data is not 
displayed. 

NOTE: If you Load From Database and want to cancel out, use the 
Exit button on the Image History screen.

4. B-Mode image displays on the left side and the loaded 
volume data displays on the right side.
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Load Multi Volume Datasets

You can load multiple datasets (up to 10 datasets) of same study 
at the same time: 

When loading multiple volume data at the same time, they must 
all be configured in the same direction (eg, Axial plane).

Sometimes there are multiple acquisitions stored within a single 
series. When you select Load All, these are loaded as one 
dataset (if they are not overlapping) or as two datasets (if two or 
more datasets are overlapping). 

1. Load dataset From CD/USB, check data of the Select 
Series pop-up. 

Figure 13-129. Select Series pop-up

Load dataset from database, select one image from each 
exam and press Load in the Image History screen.

Figure 13-130. Image History screen
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Load Multi Volume Datasets  (continued)

2. V Nav screen and multiple dataset menu are displayed.

Table 13-55:  Multiple dataset menu

Item Description

1-5 Dataset List (CT and PT in this example)

1 Display Color

2 Active Dataset Indicator

3 Active Dataset

4 Name of dataset

5 Display Weighting

6-12 Control Area

6 Single Display

7 Multiple Overlapping Display

8 Volume-to-Volume Registration

9 Compare Volume

10 Color Control

11 Delete

12 Expand/Collapse Dataset list
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Load Multi Volume Datasets  (continued)

Using the Touch Panel control, you can adjust: 

NOTE: When you select Save Volume on the Touch Panel, all 
volumes are saved to a single file on the Clipboard, 
including GPS Markers. 

Load additional volume datasets

Whenever a dataset is loaded and you want to load another 
dataset From CD/USB, from clipboard or from a database or if 
you generate a Tru3D dataset and then switch then back to 
VNav, the system asks you if you want to add the dataset as an 
additional dataset or to replace the existing dataset(s).

If you choose to add the dataset, the necessary adaption of the 
datasets with regard to size and resolution will be performed 
automatically at the end of the load.

Easy Access to PACS

The LOGIQ Fortis is set up to easily receive exams from PACS. 

The system displays DICOM image transmission status at the 
bottom of the screen as:

• Incoming DICOM Images: In Progress.

• Incoming DICOM Images: Completed.

• Incoming DICOM Images: Failed - check spooler.

Refer to the Spooler to identify specific failed operations.  See 
‘DICOM Job Spooler’ on page 13-477 for more information.

User operation takes precedence and will cancel any ongoing 
image receive operation.  

Table 13-56:  Touch Panel Controls

Item Description

1 Dataset number and its Weight (%)

2 Toggle Up/Down: Select the dataset.

3 Push: Fix the selected dataset.

4 Rotate: Weight Dataset. You can weight the overlay 

amount of the volume dataset. 
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Setting Up V Nav sensors

Positioning Rules

The transmitter needs to be placed such that the face of the 
transmitter opposite of the cable (the field side) faces the 
working area

To avoid magnetic distortion, the following is recommended: 

• Remove all ferrous or highly conductive metal from the 
vicinity of the transmitter and the working area. 

• If the patient’s bed contains ferrous or highly conductive 
metal, place the transmitter 20cm or more above the bed so 
that the central portion of the magnetic field sits well above 
the bed. 

• To check for magnetic distortion, place a phantom that can 
be scanned from multiple directions in the planned working 
space. Using the 2D Marker on the GPS control on the 
Touch Panel, select Point. Scanning the phantom, place the 
Windows Pointer on a specific point in the phantom and 
then scan the same point from different directions. The 
distance between the graphical point (green cross) and 
actual structure is an indication of the amount of error. 
Larger than expected discrepancies could be the result of 
metal distortion or the transmitter field could be facing the 
wrong direction or be too far away from the working area. 

CAUTION When using fusion or GPS Markers, it is important to place the 
transmitter so that its location does not move relative to the 
working space. If you rearrange the working space (patient or 
transmitter location), you need to redo the registration or 
replace the GPS marker.  

CAUTION Place the transmitter such that the entire area of interest is in 
the front hemisphere of the transmitter. The front hemisphere 
generates the magnetic field used by the system. 
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Setting up the Position Sensing Apparatus

To set up the position sensing apparatus, 

1. Attach the receiver probe bracket to the probe (refer to ‘Multi 
Angle Biopsy Guide Assembly’ on page 11-63). Ensure that 
it is attached securely. 

2. Fix the position sensor to the bracket. 

 Figure 13-131. Set up the position sensor

CAUTION For accurate image registration, ensure that you connect the 
two probe position sensors to the probe as described in the 
instructions below. Match the numbers when you attach the 
sensors connectors to the sensor unit.  

1. Position the sensor’s nub to the bracket’s indentation. 

2. Push the sensor into the bracket. 

3. Tilt the sensor to position it in the bracket. 

4. Tilt the sensor until positioned firmly in the bracket.
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Setting up the Position Sensing Apparatus  (continued)

3. Connect the receiver cable from the Position Sensor to the 
front of the Ultrasound system.  

Figure 13-132. Volume Navigation Connections

4. Trace back each cable physically to insure the cable in 
position 1 on the probe is connected to position 1 on the 
console and that the cable in position 2 on the probe is 
connected to position 2 on the console. 

5. Use the probe/receiver cable clips to hold the receiver 
cables to the probe cable. 

6. Attach the transmitter cable to the front of the Ultrasound 
system where the transmitter label is shown. 

1. V Nav Receiver Connector (2 cables)

2. V Nav Needle Tip Tracker/Virtual Tracker Sensor Connector

3. V Nav Active Tracker Connector

4. V Nav Transmitter Indicator

5. V Nav Transmitter Connector 

CAUTION Place the transmitter such that the entire area of interest is 
in the front hemisphere of the transmitter (indicated by the 
‘1’ in the illustration above). The front hemisphere 
generates the magnetic field used by the system. 
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Setting up the Position Sensing Apparatus  (continued)

7. Now that all the cables are connected, press the V-Nav key. 
The light above the transmitter cable blinks until the position 
sensing system has been initialized by the system. Once 
initialization is complete, the light remains green.  

NOTE: Error message displays if the connection is incorrect.

8. Place electromagnetic transmitter next to patient with front 
toward scanning area of interest.

NOTE: Be sure patient and sensors are on the best position to start 
the exam.

NOTE: Patient must be in the same position as in the previous 
acquired exam.

V-Nav Inside Probe

V Nav Inside is a feature where the V Nav sensor is not external 
to the probe but is part of the probe. 

Probes with V Nav Inside transmit/receive automatically after 
you activate V Nav. 

CAUTION If you need to connect/disconnect sensors, first use the V Nav 
key to exit V Nav. If you need to connect/disconnect the 
transmitter, make sure the light on the V Nav position sensing 
system is off. If it is on, enter V Nav and use the Exit & Clear 
Touch Panel control to leave V Nav.  

HINTS For information on how to set up the V Nav Needle Tip Tracker, 
see ‘Setting up the V Nav Needle Tip Tracker’ on page 13-313. 

For information on how to set up the V Nav Virtual Tracker, see 
‘Setting up the V Nav Virtual Tracker’ on page 13-316. 
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Activate V-Nav

1. Begin an exam and optimize the image.

2. Press V Nav to activate Volume Navigation.

3. Perform Volume Navigation.

4. Press V Nav to exit V Nav. The following actions also exits V 
Nav: switching probes, recalling an image from the 
clipboard, starting a new patient, ending an exam, or 
selecting Exit and Clear from the Touch Panel. 

V Nav Controls

 Figure 13-133. V Nav Controls

1. V Nav On/Off

2. Touch Panel and Joystick Rotary Controls

3. 3D Dataset X Axis Rotation Control

4. 3D Dataset Y Axis Rotation Control

5. 3D Dataset Z Axis Rotation Control

6. Windows Pointer

7. Comment

8. Measure

9. Zoom and Depth

10. P1

11. Left Set

12. Right Set

13. Trackball

14. Bottom Trackball key locks the V Nav Plane

15. Left/Right Key: Switches Display Mode
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V Nav Touch Panel

V Nav Setup Touch Panel Menu

Prior to using V Nav, set up the following parameters:  

Table 13-57:  V Nav Volume Touch Panel descriptions 

VNav Parameter Description

Load Loads the 3D Dataset From CD/USB (CD, DVD, or USB storage device) or 

From Database. 

Save Volume Saves current volume, including any GPS markers shown in the volume. 

Image-Based Registration The system automatically aligns CT/MR volume with the real time ultrasound 

live image. 

Patient Data Check Confirms patient’s data

Reference Sensor Specify which sensor you are using. 

Orientation Select Axial, Sagittal, or Coronal

Orientation Markers Places orientation markers on the image. 

Display Mode Select Ultrasound only, 3D only, or Split Screen (both)

Clear/Reset Allows you to clear plane registration(s), point registration(s) or reset all, 

which clears all registrations and resets the 3D Dataset to its initial position. 

Exit and Clear Clears the current 3D Dataset and exits V Nav; the 3D dataset is no longer 

available. 

Virtual Tracker Setup and select the Virtual Tracker. [Appears when the Virtual Tracker is 

present.]  

Active Tracker Select the Active Tracker sensor. 

Window/Level (or Center/

Width) Rotary

Set the brightness/contrast for the 3D Dataset. To set the brightness, adjust 

the Level; to set the contrast, adjust the Window. 
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V Nav Touch Panel Menus

Table 13-58:  V Nav Touch Panel 1 Descriptions

V Nav Parameter Description

Scan Specifies which image is moving with probe motion:  Ultrasound (US), 3D, or 

Both

Registration Select the type of Registration, Plane, Point/All, Point/Best 3, or None. Auto 

Registration is an additional choice if a Tru3D Ultrasound dataset is loaded 

using auto registration.  

Save Current Registration Select to save the current registration

Control Priority Specifies the priority of shared image controls: Ultrasound image or 3D 

Dataset. 

Restore Registration Select to restore a stored registration. 

Display Mode Select Ultrasound only, 3D only, or Split Screen (both)

Clear/Reset Allows you to clear plane registration(s), point registration(s) or reset all, 

which clears all registrations and resets the 3D Dataset to its initial position. 

Overlay Displays the 3D dataset superimposed on top of the Ultrasound image. 

Overlay Brightness Adjusts the intensity level of the 3D Dataset.

Overlay Weight Adjusts the intensity level of the 3D Dataset.

Show Needle Tip Shows or hides the needle graphics. [Appears when the Needle Tracker is 

present.]
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V Nav Touch Panel Menus  (continued)

Table 13-59:  V Nav Touch Panel 2 Descriptions

V Nav Parameter Description

Save Volume Saves current volume, including any GPS markers shown in the volume. 

Measure Accuracy Press Measure Accuracy, then select a point on both the 2D Ultrasound 

image and on the 3D Dataset to tell you the distance as an indication of 

accuracy. 

Calibration Delete Used for calibration purposes, which is only available with a service key and 

performed by GE Service.

Store Registration to File Press to save the current registration to a file. This is useful when you want 

to load another dataset with the same geometry. For example, both a T1 and 

T2 weighted MR series may be available. 

Read Registration from File Press to read a stored registration from a file. 

Read Markers from File Press to recall saved GPS markers from a file.   

Show Scan Area Shows or hides the Ultrasound scan area on the 3D Dataset.  

Cut Mode Select the cut mode: Cubic Plane, the 3D dataset slice in reference to the 

whole volume of data; Overview, fixed orientation slice; or Detailed, a slice in 

the same orientation as the current Ultrasound image. 

Exit and Clear Clears the current 3D Dataset and exits V Nav; the 3D dataset is no longer 

available. 
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DICOM and Image Storage

Still Images

To store a still image, press Freeze, and then press P1. If you 
want to CINE back to find an image, you may need to set the 
Priority on the Touch Panel to Ultrasound. 

Loops

To store a loop after you have frozen the image, CINE back, 
change the Priority to Ultrasound (if necessary), indicate the 
start and end points, Run the CINE Loop, Press P1. 

Image-by-Image

To store individual images to a USB memory stick or external 
hard drive via the USB port, recall the image from the Clipboard, 
select Menu -> SaveAs. Type in the file name. We recommend 
that you select Image Only, Jpeg compression, Quality level 99. 
For CINE Loops, save as WMV. For stills, save as type Jpeg. 
Then press Save. Repeat for as many images as desired. When 
you take the USB device to another computer, the images are 
stored in the Export directory. 

Entire Exam

You can use MPEGvue to store images for the entire exam. 
Insert the media (CD, DVD, USB device). Select Patient -> Data 
Transfer -> MPEGvue -> To. Select the patients (multiple 
patients can be stored using the Ctrl+Shift keys). Then press 
Transfer. The still images are stored in Jpeg format and Loops 
are stored in MPEG format. Images are stored in the Images 
directory, unless you select RunMeToStart. Then the images are 
displayed in a special viewer. 
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Save Volume

The system can save the volume and associated GPS markers 
as an image file in the exam.

The Save Volume key on the Touch Panel stores using the 
settings of whichever print key has Copy to Dataflow associated 
with it.

A saved volume can be loaded from the database and used as 
the pre-acquired volume.

Measurements and Comments

You can measure distance, angle, circumference, or area on the 
3D Dataset. You can annotate and perform any system 
measurement on the Ultrasound image. 

HINTS The Volume is stored in Raw Data format. If you send the 
volume to PACS without the raw data, the volume will not be 
available if you later Query/Retrieve it from PACS. 
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Using V-Nav

Magnetic field range of V-Nav Transmitter

The position of the V-Nav sensor can be detected correctly 
within the range shown below. Make sure that the V-Nav sensor 
is within this range.

Check the Environmental Quality indicator on the monitor for the 
detection accuracy while scanning.

NOTE: Remove the metal product from the region of the magnetic field 
to increase accuracy of position detection.

Figure 13-134. Magnetic Field Range from the Transmitter

From the center of the transmitter,

1. 30cm above and below

2. 28cm left and right

3. 20 - 66cm forward
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Perform V-Nav Exam

In order to perform a V-Nav exam, you need to have acquired 
the 3D Dataset and set up the position sensing apparatus. 

The workflow for V-Nav is to: 

1. Import the dataset if using Query/Retrieve. 

See ‘Query/Retrieve’ on page 13-268 for more information.

2. Perform the Setup (attach the sensors) as needed. 

See ‘Setting Up V Nav sensors’ on page 13-276 for more 
information.

NOTE: Probes with V-Nav Inside transmit/receive automatically 
after you activate V-Nav. 

3. Begin an exam; optimize the image. 

4. Enter V-Nav. 

5. Load the dataset. 

6. Perform the registration.

NOTE: Confirm that the plane orientation of the ultrasound image is 
the same as that of the loaded volume data before starting 
registration.

7. Perform the exam.

8. Take measurements and store images via the Print key. 

Ending an Exam

Press V-Nav, select End Exam, select End Current Patient, 
then select Store all. The system is ready for the next patient.

HINTS Since Volume Navigation uses magnetic field to acquire probe 
position information, it may be affected by surrounding metal 
products.

If the image is flicked or misaligned, check the surroundings, 
such as the bed, the IV stand or the accessory, and move away 
those metal products from the magnetic field. If you use the 
bed with metal frame, it is desirable to be able to secure the 
distance from the metal frame using a thick mattress. 
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Perform the registration

Orient the Dataset and Pick a Slice

You can manipulate the 3D Dataset the same way you adjust 
any 3D volume. 

Manipulate the dataset to pick a slice that most closely matches 
the area where you will hold the probe initially.  

1. After the dataset has loaded, use the Zoom rotary to see the 
dataset in a larger size. 

2. Use the Orientation key to select Axial, Sagittal, or Coronal 
to easily view the Dataset from different orientations. 

You want the orientation that best matches the orientation of 
the patient. 

NOTE: If the data appears unacceptably blurred or smeared in one 
of these views, the dataset was not acquired with the 
appropriate settings for viewing the data in 3D. 

3. Pushing the X rotary rotates the dataset 90 degrees about 
the X-axis. Dialing the X rotary rotates the dataset about the 
X-axis in smaller increments. Same for Y and Z. 

Note which points are identifiable in both the live Ultrasound 
image and in the 3D dataset. Remember that a point needs to 
be identifiable in all three dimensions. A point along a surface is 
often difficult to identify in three dimensions; but intersections of 
vessels, calcifications, or centers of structures can often be 
identified clearly in three dimensions. 
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Registering, Locking, and Translating the Image with the 3D Dataset

After you’ve loaded the 3D Dataset, you need to link the 2D 
Ultrasound image to the 3D dataset via Registration. You can 
register the 3D dataset to the Ultrasound image by Parallel 
Plane Registration or Point Registration. 

Lock Plane: Align the section of displayed volume data with the 
vertical and horizontal orientations of the ultrasound scan plane. 
Match the state of inspiration and expiration with the loaded 
volume data and setting the probe orientation correctly to reduce 
the misalignment during the examination.

Lock Point: The position in the depth direction is adjusted at 
Lock Point. Synchronous display starts after setting Lock Plane. 
Set the reference point (Landmark) on the ultrasound and 
volume data. It can be set repeatedly.

NOTE: Confirm that the plane orientation of the ultrasound image is the 
same as that of the loaded volume data before starting 
registration.

NOTE: DO NOT move the patient once you have registered the image; 
if you move the patient, you lose registration. 

Select the type of registration on the Touch Panel. 

NOTE: When switching probes in V Nav, the registration is maintained. 
You can register with one probe, then scan with any probe. 
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Parallel Plane Registration

A plane registration constitutes a plane lock and a translation 
point. 

To perform a Parallel Plane Registration, 

1. Select Registration -> Plane from the Touch Panel. 

2. Hold the probe parallel to the acquired (imported) 3D 
dataset, being careful not to tilt, twist, or rotate the probe. 

3. Press the Lock Plane (bottom Trackball key) to lock the 
plane as parallel. 

4. Define a translation point, by marking a common point in 
each image (Ultrasound and 3D Dataset) using the 
Windows Pointer and Trackball key labelled Lock Point. 
This allows the system to do an x, y, and z correction at that 
point. 

5. Move the probe and ensure that this registration is correct. 

6. Press Save Current Registration on the Touch Panel to 
save this registration. You can save up to five (5) 
registrations. 

Adjusting the Registration

To adjust the registration, you could try several things. 

1. Save the registration. It’s always a good idea to save the 
registration first. 

2. Update the translation point in the area of interest. 

3. Turn on Overlay and use the Z Rotary to adjust the 3D 
overlay relative to the Ultrasound image. 

4. Holding the probe still during the following steps: move the 
windows pointer over the overlay image, select the Overlay 
XY Trackball control, move the overlay relative to the 
Ultrasound image, press the Overlay XY key to lock in the 
adjustment. 

5. Manually adjust the parallel plane lock. Use the scan key on 
the Touch Panel to select only the 2D Ultrasound or the 3D 
dataset. Adjust the probe to make the scanned image match 
the locked image and then press Lock Plane. 

6. Start over by using the Clear/Reset -> All control on the 
Touch Panel. 
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Point Registration

To perform a Point Registration, 

1. Select Registration -> Point from the Touch Panel. 

2. Find a common point on both the 3D Dataset and 
Ultrasound image. Use the Windows Pointer to select each 
point, then press Set Point each time. Do this 3 times. 

NOTE: You can select either a Point/Best 3 or Point/All. If you 
identify more than three point pairs, Point/Best 3 takes the 
best 3 point pairings. Point/All uses all point pairs that you 
identify when calculating the Point Registration. 

3. Move the probe and ensure that this registration is correct. 

4. Press Save Current Registration on the Touch Panel to 
save this registration. You can save up to five (5) 
registrations. 

NOTE: Point and Plane registrations are stored separately. 

To switch between Point and Plane Registration, change the 
registration via the Touch Panel. 

HINTS Performing a plane registration is not necessary to do a point 
registration, but is recommended because it simplifies the 
process as the probe can easily be used to search for the point 
pairs in both the Ultrasound image and in the 3D Dataset. 

HINTS When using a point pair to complete or update a registration, 
registration error is minimized at that point and will increase 
further away from that point. Therefore, registration accuracy 
near the anatomy of interest may be improved by marking the 
last point pair, or adding a point pair, in close proximity to the 
anatomy of interest.
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Auto Registration with Tru3D

Auto-registration is available when fusing to a Tru3D dataset.

When entering V Nav directly from a Tru3D acquisition, the 
Tru3D volume is automatically loaded into V Nav and 
automatically registered.

When a Tru3D data set from the current exam is loaded into V 
Nav from the clipboard or by loading from the database, the user 
shall be prompted to automatically register to the data set.

NOTE: Tru3D auto registration is possible if the magnet and patient 
have not been moved since the Tru3D data set was acquired. If 
the magnet or the patient have moved since the Tru3D dataset 
was acquired, you need to perform a parallel plane or point 
registration. 

Auto Registration appears as a choice on the Registration 
control only if auto registration was initially used. You can 
manually select a different registration method even if Auto 
registration was initially selected when the volume was loaded.
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Overlay

Use the Overlay control on the Touch Panel to overlay the 3D 
Dataset image onto the Ultrasound image. Use the Overlay 
Brightness and Overlay Weight joysticks to adjust the intensity 
level of the 3D Dataset. 

By pointing at the overlay (Overlay XY) with the Windows 
pointer and clicking on it with the Left Set Key, the overlay can 
be dragged via the Trackball in X and Y directions in an effort to 
achieve a better registration. To lock in the adjustment, press the  
Left Set Key again. 

By pointing at the overlay with the Windows Pointer and clicking 
on it with the Right Set Key (Overlay Z), the overlay can be 
dragged via the Trackball in the Z direction in an effort to 
achieve a better registration. To lock in the adjustment, press the 
Left Set Key again. 

One technique to improve registration is to adjust the overlay in 
X and Y as stated above and to also do any necessary Z axis 
rotation as well. Then, turn the probe 90 degrees and repeat 
these same adjustments. These steps can be repeated 
iteratively. 

HINTS In an area with bony structures that show up bright with the 3D 
Dataset, applying an overlay with a low percentage can be a 
nice way to show bone structure with an Ultrasound tissue 
image. 

HINTS When performing Overlay XY or Overlay Z adjustments, it is 
important to hold the probe still from the time the adjustment 
key is pressed until it is pressed a second time to lock in the 
change. 
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Volume to Volume Registration

Datasets can come from different exams, can be from different 
orientations, and can be from different imaging modalities. 
Because datasets are not registered to one another, the system 
allows auto or manual volume-to-volume registration

To register multiple volumes, 

1. Load multiple volumes (not restricted to one exam). 

2. Clicks on the “link” icon. The “Select volumes for 
registration’ pop-up window appears. 

3. Select the primary and secondary moving volumes. The 
primary volume is used for registration, the secondary 
volumes are transformed using the registration parameters 
of the primary volume. 

For example, If the user has a CT1 volume and a CT2 + 
PET volume loaded, they would select the CT1 as the fixed 
and the CT2 as primary, and the PET as the secondary 
moving volumes. After the registration they will have CT2 + 
PET registered to CT1. 

4. Specify if the result should be added as a new registered 
volume or overwrite the moving dataset. You can also or 
create the result as an additional volume (‘Add registered 
volume’ is not an option if 5 volumes already exist). 

A user can perform two types of manual registration: a 
registration based off of a single common point pair 
identified in each volume (Translation); or a registration 
based off of three or more common point pairs identified in 
each volume (Registration). 
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Volume to Volume Registration  (continued)

5. Choose Manual, Auto, Semi Auto or Indirect volume to 
volume registration. 

Figure 13-135. Select volumes for registration

NOTE: If you select Auto registration, also choose the type (bone, 
tissue or some combination). If you select Manual 
registration, identify three point pairs between the two 
volumes. Only one point pair is usually needed for datasets 
with different orientations from the same exam.

During manual volume to volume registration, the user is 
able to scroll through either the fixed volume (shown on the 
left) or the moving volume (shown on the right) by moving 
the Windows Pointer over the image, pressing the trackball 
key labeled Scroll Z and then using the trackball to perform 
the scrolling. 
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Volume to Volume Registration  (continued)

NOTE: During manual volume to volume registration, the user is 
able to move the volume up and down or left and right on 
the screen by moving the Windows pointer over the image, 
switching from Primary to Secondary with the top trackball 
key, pressing the trackball key labeled Move XY and then 
using the trackball to perform the XY movement.

When doing manual registration, the left volume is the fixed 
volume and the right volume is the moving volume. The right 
trackball key is used to scroll through the datasets and find 
anatomical points while the left trackball key is used to mark the 
points. Once a single point pair is marked, the bottom trackball 
key is labeled Apply Translation which is all that is needed to 
register the moving volume (oblique, e.g.) to the fixed volume 
(axial,  e.g.). 

NOTE: A single point pair is sufficient if the two datasets have the same 
orientation but are shifted with respect to each other. 

Once three point pairs are marked, the bottom trackball key is 
labeled Calculate Registration which then registers the moving 
volume to the fixed volume.

NOTE: Three point pairs or more are needed if the datasets do not have 
the same orientation or are at oblique angles with respect to 
each other. 

Figure 13-136. Volume to Volume Registration
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Volume to Volume Registration  (continued)

Once three point pairs are marked, the bottom trackball key is 
labeled Calculate Registration which then registers the moving 
volume to the fixed volume. 

Figure 13-137. Trackball key status

1. No point pairs identified

2. One point pairs identified

3. Three or more point pairs identified
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Image-Based Registration

NOTE: If you load the volumes beforehand, the calculation will start 
immediately when you press Image-Based Registration button.

NOTE: The liver vasculature must be included in both the 3D ultrasound 
and CT/MR volume in order for the registration to succeed.

1. Press VNav to enter Volume Navigation.

2. Press Image-Based Registration on the Touch Panel.

Select Acquire to acquire a new 3D ultrasound volume or 
Load to load an existing 3D ultrasound volume according to 
a navigate window.

NOTE: Need sensor information for 3D ultrasound volume.

 Figure 13-138. Navigate window for 3D US Volume 

3. After 3D ultrasound volume is loaded, 3D US loaded icon 
turns green. Press Next on IBR-Process window. 
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Image-Based Registration  (continued)

4. Load portal phase volume of CE-CT or hepatobiliary phase 
volume of EOB-MR from CD/USB or Database according to 
a navigate window.

 Figure 13-139. Navigate window for CT/MR volume

5. After CT/MR volume is loaded, CT or MR loaded icon turns 
green. Press Next.

6. If multiple volumes are loaded, select volumes as below. 
Press Auto to start the calculation.

 Figure 13-140. Select volumes
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Image-Based Registration  (continued)

7. When the calculation is done, LOGIQ Fortis displays the 
aligned ultrasound live image and CT/MR image. 

 Figure 13-141. Image-Based Registration
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Compare Volume

You can compare pre-registered volumes in a side by side 
display.

1. Press Volume Compare button in the multi volume menu.

2. The dialog for selecting left and right side volumes displays. 
Multiple selection is possible.

NOTE: Volumes need to be from the same group of pre-registered 
volumes.

Figure 13-142. Select volumes for comparison

3. The selected volumes is shown side by side and any 
interaction (scroll, zoom, rotation etc.) is applied to both 
sides simultaneously. 

Figure 13-143. Compare Volume
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Advanced GPS Markers

"GPS" -- Position Marking V Nav

Position markers can be ‘placed’ on a stationary anatomical 
structure within the body and then tracked with the existing 
position sensing system. The marker position is projected onto 
the current Ultrasound image in a graphical way that indicates 
the relative position of the point compared to the image. GPS 
markers track a particular point in space. 

Controls

Selecting the GPS tab switches trackball control to GPS 
markers with 2D Marker or 3D Marker activated.

Table 13-60:  GPS Controls 

Preset Parameter Description

2D Marker Allows the user to select between a Point Marker and a Target Marker.

3D Marker Allows the user to select between an Ellipsoid and Spherical Marker.

Show All Markers Shows all markers, independent of Active State.

Show Active Markers Shows/Hides all markers with Active State "On".

Active State An individual GPS marker can be shown/hidden using the Active State 

control (turn to select, push to toggle state).

Delete Rotate the control to select a specific GPS Marker to delete; then push the 

control to delete the marker.

Delete Markers Deletes all active GPS Markers following the user's confirmation.

Mark Needle Tip Mark Needle Tip allows a 2D or 3D GPS Marker (whichever is selected) to be 

put at the current tracked needle tip location. The marker is not attached to 

the needle and will not move as the needle moves.

Show Distance Toggles between showing and hiding all defined distances.

Attach to Needle If the 3D Marker key is selected and needle tracking is active, the "Attach To 

Needle" key initiates a 3D GPS Marker whose center (in the case of a 

sphere) or whose first long axis point (in the case of an ellipsoid) is placed at 

the needle tip.

3D Edit The 3D Edit key is available only if a 3D GPS Marker is currently selected via 

the Delete or Active State rotaries. Selecting the Edit key causes the Edit 

GPS Touch Panel menu to appear.
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2D GPS Markers

GPS Markers track a particular point in space. As you adjust the 
probe/image position, the point is projected onto the current 
image. If the point intersects the current image, it is displayed as 
a green cross. As the point gets further away from the current 
image, the cross turns into a bigger and bigger square. The 
color of the square indicates the direction; red represents one 
direction and blue represents the other direction. You can use 
’GPS’ to track an anatomical marker on the Ultrasound image or 
for biopsy needle guidance, for example. 

You can use GPS Markers with an imported dataset, or 
independently of an imported dataset. 

There are two types of GPS Markers: Point and Target. A Point 
Marker assigns a number. Each point marker you set has a 
unique number. A Target Marker only allows one target point. If 
you try to place another target marker, the target moves to the 
newly-indicated position. 

To place a Target or Point Marker, use GPS Marker to specify 
Target or Point. Place the Windows Pointer in the location where 
you want to set the marker, then press the Set GPS Key. 

Dist Start/Dist End/Clear Rotating the Distance Start and Distance End rotaries cycles through the list 

of GPS markers including the Needle Tip if needle tracking is active. When 

two different GPS markers are identified on the Distance Start and Distance 

End Rotaries, the Distance End rotary is labeled "Define" or "Clear". If the 

distance is not already defined, the label is "Define". If the user then pushes 

the rotary, the distance between the Start and End GPS Markers is defined, 

and the label to switches to "Clear".

The initial value of the Distance Start rotary is the first GPS marker. The initial 

value of the Distance End rotary is the needle tip if needle tracking is active or 

the 2nd GPS marker if not. In the case of a 3D GPS Marker, it's center point 

is used for all distance calculations.

Table 13-60:  GPS Controls  (Continued)

Preset Parameter Description
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3D GPS Markers

Figure 13-144. 3D GPS Marker example

NOTE: When using GPS Markers with a registered 3D dataset, a point 
marked in either image shows up in both images. GPS Markers 
are stored with the image. 

NOTE: All 3D GPS Markers are appended with the letter "V" (for 
volume). 

NOTE: The inner surface of the 3D GPS marker and margin contours 
can be colored using the colors of the marker/margin. This color 
is transparently overlaid on top of the US image below. 

Type of Markers

• Ellipsoid

The user places one GPS Marker (Set GPS on the right 
trackball key) at one end of the desired long axis. The point 
is marked with a marker named LA that behaves like a point 
marker. The distance between this first long axis point and 
the current cursor position is displayed in the status bar to 
allow the user to mark an ellipsoid with a defined long axis 
length. The user then places a second GPS Marker (Set 
GPS on the right trackball key) at the other end of the 
desired long axis. The ellipsoid will be drawn and the long 
axis endpoints will be marked with crosses that will be 
displayed only if they are hit by the plane.

• Spherical

The user places the GPS Marker (Set GPS key on right 
trackball key) at the center point of the anatomical structure 
of interest. The center of the sphere is marked with a cross, 
that is only displayed if the plane hits the center.
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Editing a 3D Marker

Upon creating a 3D GPS marker, the Edit GPS menu appears 
on the Touch Panel.

Table 13-61:  Edit GPS Marker - Sphere/Ellipsoid 

Preset Parameter Description

Done Return to main GPS Touch Panel.

Reposition Set Key on the image will reposition the sphere when Reposition key is on 

(otherwise Set Key creates a new sphere).

Select Select attributes that were previously saved.

Save As Save and name the current sphere attributes (size, margin, colors and 

transparency).

Color Change color (yellow, Red, orange, blue, purple, pink or white).

Margin Color Change margin color.

Margin Dist. Adjust margin size.

a. Diameter

b. Margin

Diameter Adjust sphere diameter.

Inner Alpha/Margin Alpha Adjust transparency of main area and margin in percent i.e. between 0 (= only 

ultrasound image) and 100 (= only marker/margin color).

Detach from Needle The Detach From Needle key is only available if the 3D GPS Marker being 

edited is attached to the needle. Pressing the key causes the 3D GPS Marker 

to be removed from the needle and placed at the current location of the 

tracked needle tip. It will no longer move with the needle tip.
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NOTE: Default of the parameters is configurable in Utility -> System -> 
System Imaging -> V Nav 3D Marker.

a. The length of the red ellipse is the long 

axis of the ellipsoid. 

b. The diameter of the blue circle is the short 

axis of the ellipsoid. 

Shift/Rotate (Ellipsoid) Shift along long axis or rotate about end of long axis.

Short Axis/Long Axis 

(Ellipsoid)

Adjust short and long axis lengths.

Show Ablation Needle 

Path

For ellipsoids, the user can display the needle path and tip position.

Table 13-61:  Edit GPS Marker - Sphere/Ellipsoid  (Continued)

Preset Parameter Description
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Editing a 3D Marker  (continued)

Move XY GPS allows the 3D Marker to be dragged to a new 
location in the current image plane.

Repos. GPS allows the 3D Marker to be recentered on the 
current image plane.

Figure 13-145. Trackball key for GPS Marker

NOTE: The initial attributes of a 3D GPS marker match the last 3D GPS 
marker that was created. 

NOTE: While on the Edit Menu, the 3D GPS marker being edited is 
shown in its normal color while all other 3D GPS markers are 
dimmed. After exiting the Edit Menu, all markers are returned to 
their normal color appearance. 
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Saving and Selecting a 3D GPS Marker

To save a 3D GPS Marker, 

1. For markers that are used often, such as kill zones 
associated with a particular ablation needle, select Save As 
from the Edit GPS Touch Panel. 

2. The Save 3D GPS Marker pop-up menu appears. Name the 
GPS Marker. 

Figure 13-146. Saving a 3D GPS Marker

To select a 3D GPS Marker, 

1. Select Select from the Edit GPS Touch Panel. The Select 
3D GPS Marker pop-up menu appears. 

Figure 13-147. Select 3D GPS Marker

2. Highlight the desired Sphere or Ellipsoid, then press Select.   
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Attach to Needle/Detach from Needle

The user attaches (and detach) 3D GPS markers to (from) a 
tracked needle tip and places a 2D GPS marker at the location 
of a tracked needle tip.

If the 3D Marker key is selected and needle tracking is active, 
the Attach To Needle key initiates a 3D GPS Marker whose 
center (in the case of a sphere) or whose first long axis point (in 
the case of an ellipsoid) is placed at the needle tip. 

In the case of an Ellipsoid, it's long axis is aligned with the 
needle direction, i.e. both long axis points are placed on the 
needle axis. The 3D GPS Marker is not in a fixed location, but is 
attached to the needle and therefore moves with the needle tip.

The key is only available if needle tracking is enabled and the 
3D Marker key is selected.

To detach the 3D Marker from the needle, the user can either 
press the Detach from Needle  button on the GPS Edit page or 
the Mark Needle Tip on the GPS page.

Mark Needle Tip

Mark Needle Tip allows a 2D or 3D GPS Marker (whichever is 
selected) to be put at the current tracked needle tip location. The 
marker is not attached to the needle and will not move as the 
needle moves. 

NOTE: You must use Tip Tracking or Virtual Tip Tracking. 

1. Place a needle.

2. Before extracting the needle, select Mark Needle Tip to get 
a 2D or 3D GPS marker at the needle tip.

Figure 13-148. Mark Needle Tip - Example
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GPS Distance

The user displays the distance between two GPS markers or a 
GPS marker and a tracked needle. 

• Between any two GPS markers (2D Point, 2D Target, 3D 
Sphere, 3D Ellipsoid)

• Between any GPS Marker and the tracked needle tip 
(Tip-Tracked, virtual tip-tracked)

Figure 13-149. GPS Distance - Example

Procedure

1. After marking GPS locations, rotate Dist. Start to select 1st 
marker.

NOTE: Cycle through the list of GPS markers including the Needle 
Tip if needle tracking is active. 

2. Rotate Dist. End to select 2nd Marker. Push Define to 
display the distance.

NOTE: If the distance is not already defined, the label is "Define". If 
the user then pushes the rotary and the distance between 
the Start and End GPS Markers is defined, the label 
switches to "Clear". 

In the case of a 3D GPS Marker, it's center point is used for all 
distance calculations. 

When distances are defined to be displayed, they are displayed 
in the same location as 3D measurement results. When regular 
3D measurements are displayed, the distance measurements 
are not shown. The label of a distance measurement is the 
numerically lowest GPS Marker followed by the numerically 
larger GPS Marker. If the needle tip is one of the markers, it is 
listed second. Some examples are "1-2V", "3X-Needle", and 
"5-7P".



Volume Navigation

LOGIQ Fortis – Basic User Manual 13-311
5855997-1EN Rev. 3

V Nav Trackers

V Nav supports the V Nav Needle Tip Tracker, the Virtual 
Tracker and Active Tracker. 

Figure 13-150. Volume Navigation Connections

NOTE: Pink probe brackets and sensors are necessary when using the 
Needle Tracker or Virtual Tracker

1. V Nav Receiver Connector (2 cables)

2. V Nav Needle Tip Tracker/Virtual Tracker Sensor Connector

3. V Nav Active Tracker Connector

4. V Nav Transmitter Indicator

5. V Nav Transmitter Connector 
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V Nav Trackers  (continued)

HINTS • Remember to exit V Nav with the V Nav control BEFORE 
disconnecting and connecting the V Nav Trackers. 

• With the V Nav Trackers attached, tracking can be turned 
on/off using the Show Needle Tip button. 

• When using V Nav Tracking, it is important to have high 
Environmental Quality readings. 

• When Needle Tracking is turned on, the Needle Tracking 
graphics show the: 

• Needle Tip and projected path on the live image

• The intersection point with the current image when not 
in plane

• Markers to assist with guiding the needle in plane with 
the current image

• The combination of Fusion and Needle Tracking is 
available once the volume dataset is registered. By 
selecting the Needle in Plane button, the volume dataset 
can show the needle in plane rather than the same plane 
as the live Ultrasound image. 

• You can push the Z-Rotation Rotary to rotate the needle 
path plane about the needle axis (coarse adjustments). 
Rotating the Z-Rotation Rotary can be used for fine 
adjustments. 
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Setting up the V Nav Needle Tip Tracker 

The V Nav Needle Tip Tracker allows you to insert a V Nav 
tracker inside the Needle to track where the needle tip is inside 
the body. The Needle Tip Tracker makes use of a needle 
assembly (combination of stylet and sheath) where the stylet 
has a hollow core in which a position sensor receiver may be 
placed, thereby placing the sensor near the tip of the stylet. The 
Needle Tip Tracker tip is annotated with an “N.” 

To set up the V Nav Needle Tip Tracker, you need the CIVCO 
eTRAX Needle System Starter Kit.  

1. The Kit includes the eTRAX Sensor as well as 5 sterile 
packages. Each sterile package contains a needle assembly 
(combination of stylet and sheath) and a cover for the 
sensor handle and cable. 

Figure 13-151. Needle Tip Sensor and Cable Close-up

2. The Needle Sensor fits inside the needle assembly. Prior to 
performing the procedure, you need to cover the sensor 
handle and cable.  

3. Advance the sensor all the way into the needle assembly.
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Setting up the V Nav Needle Tip Tracker  (continued)

4. The Needle assembly locks into place with the Sensor 
handle.

5. Using proper sterile technique, insert needle sensor through 
opening in cover, taking care to minimize bending of needle 
sensor. 

6. Extend cover over needle handle. 

7. Inspect cover to ensure there are no holes or tears. 

8. After you have the Needle Assembly placed at the desired 
anatomical location, you can unscrew the stylet from the 
sheath and remove the stylet (and sensor). The procedure 
needle can be placed in the sheath to perform the 
procedure.  

9. Remove the Sensor and Needle

10. The site is now ready for the procedure (core biopsy, 
ablation, etc.). 

CAUTION For illustration purposes only, the needle sensor is shown 
without a cover. Always place a cover over needle sensor to 
protect patients and users from cross-contamination. 



Volume Navigation

LOGIQ Fortis – Basic User Manual 13-315
5855997-1EN Rev. 3

Setting up the V Nav Needle Tip Tracker  (continued)

NOTE: Dispose of the needle assembly and sensor cover. The Needle 
sensor should not be disposed.  

NOTE: You DO NOT need to sterilize the Needle Sensor. Instead, clean 
and disinfect the needle sensor the same way you would a 
probe, taking care not to bend the sensor. 

NOTE: The Tracker must be used in conjunction with a probe that has a  
V Nav Bracket. You need three (3) sensors: two (2) sensors 
attached to the probe and one (1) Tracker sensor. However, if 
you are using a V Nav Inside probe, no sensors need to be 
attached to the probe and only the sensor for the tracker is 
needed. 

V Nav Virtual Tracker (Part of V Nav Option)

The V Nav Virtual Tracker allows you to attach a sensor to the 
shaft of the needle (away from the tip). The position of the 
needle tip and the projected needle path are projected onto the 
2D Ultrasound image. The virtual needle tip is annotated with a 
“V.”
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Setting up the V Nav Virtual Tracker

To set up the Virtual Tracker, you need the CIVCO VirtuTRAX 
Starter Kit.  

Figure 13-152. V Nav Virtual Tracker

1. The kit includes the VirtuTRAX Sensor as well as 5 sterile 
packages. Each sterile package contains a sensor bracket, 
a cover for the sensor, and rubber bands for the cover.

Insert sensor inside cover. Place covered sensor in sensor 
bracket. Push down on sensor. Push down until sensor 
snaps into place. 
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Setting up the V Nav Virtual Tracker  (continued)

2. Insert needle into insertion point of the bracket, making sure 
that the arrow on the side of the bracket points toward the 
needle tip. Rotate knob to tighten needle holder to adjust it 
to the needle’s gauge. 

3. Assembled V Nav Virtual Tracker

4. Attach Virtual Sensor to the system. Connect V Nav sensors 
to the system.

5. You are ready to calibrate the Virtual Tracker. See 
Calibrating the V Nav Virtual Tracker procedure below.

6. To track the needle, the system needs to know the distance 
from the sensor bracket to the needle tip.

7. To provide the distance, select the V Nav Virtual Tracker 
control. Details are provided below. 

8. On the display the virtual needle tracker appears like the 
needle tip tracker except that the needle tip is annotated 
with a “V.” 

NOTE: Dispose of the sensor bracket and sensor cover. The sensor 
should not be disposed.  

NOTE: You DO NOT need to sterilize the sensor. Instead, clean and 
disinfect the sensor the same way you would a probe. 

NOTE: The Tracker must be used in conjunction with a probe that has a 
V Nav Bracket. You need three (3) sensors: two (2) sensors 
attached to the probe and one (1) sensor attaching to the needle 
sensor bracket. 

CAUTION Because the sensor is away from the tip of the needle, the 
system cannot detect needle bending. When the needle bends, 
the projection of the needle trajectory and the representation of 
the needle tip will vary with respect to the actual needle 
trajectory and tip position. 
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Calibrating the V Nav Virtual Tracker

Method 1. You enter the needle length. 

1. Select Virtual Tracker.

2. Enter a device name and specify a length. Press OK  
(Length is measured from the tip of the needle inserted to 
the far surface of the sensor bracket, measured along the 
needle shaft). 

3. Check the length by placing the needle tip on the center of 
the probe face.

4. There should be a ‘V’ on the probe face in the image.

Method 2. You define the needle length via the image. 

1. Select Virtual Tracker. 

2. Enter a device name, and click on Define via Image. Press 
OK in the dialog.

3. Set the tip on the center of the probe face, move windows 
cursor to that point on the image and press Set.

4. The tip becomes marked with a ‘V’ on the image, initially on 
the probe face.

Existing Virtual Tracker devices can be selected and their 
calibrations modified if needed.
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Active Tracker

The Active Tracker is a device that consists of four markers that 
show up in a volume imaging dataset such as CT or MR. The 
markers are in known positions relative to each other such that 
the orientation of the Active Tracker can be uniquely determined 
based on the marker positions in the image. The device also 
holds a position sensor in a known position relative to the 
markers. Holes are provided in the Active Tracker so that its 
location can be marked on the body.

When the Active Tracker sensor is attached to the Active 
Tracker device, it can be used as a reference sensor. This 
means that all tracking is done in relationship to this sensor 
rather than in relationship to the transmitter. 

Figure 13-153. Left, Active Tracker - Right, CT of Active 
Tracker

 Figure 13-154. MR Active Tracker
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Active Tracker  (continued)

The Active Tracker adds sensor-based auto registration for CT/
MR. An Active Tracker device, which can hold a sensor, is 
placed on the patient during the CT/MR scan and then detected 
in the CT/MR images to facilitate an auto registration. CT/MR 
uses the same Active Tracker device as a Reference Sensor, 
meaning that tracking is done relative to the sensor attached to 
the Active Tracker. Provides some breathing compensation, and 
allows registration and GPS markers to be maintained in case 
the transmitter/patient moves. 

 Figure 13-155. Active Tracker Setup and Positioning

1. Connect the following sensors to the V Nav Module. V Nav 
Probe Connectors (into Slots 1 and 2). Active Tracker 
Connector. Transmitter Connector. 

2. Ensure that the probe has the V Nav attachment in place, 
along with the two V Nav Sensors.

3. Attach the CT/MR Active Tracker to the sensor.

4. Position the Active Tracker on the patient.
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Using the Active Tracker

Perform CT/MR exam. 

1. Apply sensor. 

For an MR Exam, avoid having the MR coil touch the MR 
Active Tracker. 

a. Place the MR Active Tracker where there is a gap in the 
coil. 

NOTE: The MR Active Tracker must be in the area being 
scanned during the MR. It is good to place the Active 
Tracker on a rigid area, such as the xyphoid, and good 
to place it in the vicinity of the intervention, but still out of 
the way. 

b. Use pads (available in the MR suite) to keep the coil 
from touching the MR Active Tracker. 

2. Perform CT/MR scan. 

Scanning the patient, 

1. Use the Active Tracker to hold the sensor. 

2. Tape the sensor to the body. First, clean the area, then peal 
and stick the sensor to the body. 

3. Choose the reference sensor on the Touch Panel. 

NOTE: If you choose the Active Tracker for Auto Registration, the 
sensor is automatically selected as the reference. 

4. Load MR/CT dataset. 
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With Sensor and Active Tracker 

In order to acquire an ultrasound volume and auto register live 
ultrasound to it at a future time, perform the following steps:

1. Use a probe with VNav position sensors attached to or built 
into the ultrasound probe. 

2. Attach the Active Tracker device to the patient and connect 
the active tracker sensor to the device. 

3. Using a body marking pen, mark the position of the Active 
Tracker on the body using a body marking pen and the four 
holes in the base of the Active Tracker. 

4. Enter Tru3D and select the acquisition as "With Sensor + 
Active Tracker"

5. Perform a Tru3D sweep as usual and store it as usual.

Entering VNav directly from Tru3D or entering VNav and then 
loading the saved Tru3D data set will allow automatic 
registration of the live ultrasound to the Tru3D data set. If you 
want to automatically register to the Tru3D data acquired with 
Active Tracker at a future time, perform the following steps:

1. Follow steps 1 and 2 above except when placing the Active 
Tracker device use the four body marks to recreate the 
same position as before. 

2. Enter VNav and load the Tru3D data set that was previously 
acquired with the active tracker attached. Perform 
sensor-based auto registration in the same way as for CT/
MR. 

3. Manually adjust the registration as needed. 
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Breast Productivity Package

Overview

There are three features in the Breast Productivity Package:

• Breast Lesion M&A — includes lesion measurement folders, 
show features, summary, etc.

• Breast Measure Assistant — contains the Auto Contour 
feature. It also has measurements related to Breast 
(distance to nipple, ratio).

• Breast Assistant, Powered by Koios DS — breast lesion 
analysis option. 

Breast Lesion M&A

Breast Lesion M&A allows you to document up to 30 breast 
lesions for each breast. Lesion Height/Width/Length, Distance to 
Nipple and A/B Ratio are available. Distance to Nipple allows 
you to enter the value (this is not a calculated measurement).

ACR BI-RADS® lesion classification can be notated via Show 
Features and Show Assessment. 

The Breast Measure Assistant (Auto Contour) feature can also 
be used to automatically detect and outline the breast lesion. 

Worksheet and Summary Worksheets show all the documented 
right/left breast lesions. 
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Breast Lesion M&A  (continued)

From the Small Parts Application Preset, select the Breast 
Application. Next, select the Right/Left Lesion (Select RtSide/
LtSide below the Touch Panel).  

Table 13-62:  Breast Lesion M&A Touch Panel Controls

Preset Parameter Description

Position Specify the position of the lesion: Clock position 1-12 O’Clock, Areolar, 

SubAreolar, Axillary, or “-” (default).

Segment Specify A, B, C, None, or “-” (default).

Show Features Press to activate the Show Features notations. To add notations for each 

feature, position the Trackball to the right of each feature and press Set. This 

brings up the available notations. Move the Trackball to highlight a notation 

and press Set to select a notation. The notation will then appear next to the 

feature. If a Feature has an asterisk next to it (*), then you can select multiple 

notations -- select all that apply and then select ‘Done.’ These features are 

displayed on the Trackball. Below is a list of each Feature with its possible 

notations: 

• Shape: Oval, Round, Irregular, None (-)

• Orientation: Parallel, Not Parallel, None (-)

• Margin: Circumscribed, Indistinct, Angular, Microlobulated, Spiculated, 

None (-)

• Echo Pattern: Anechoic, Hyperechoic, Complex, Hypoechoic, Isoechoic, 

Heterogeneous, None(-)

• Posterior Features: No posterior features, Enhancement, Shadowing, 

Combined Pattern, None(-)

• Associated features: Architectural distortion, Duct changes, Skin thickening, 

Skin retraction, Edema, Absent, Internal vascularity, Vessels in rim, Soft, 

Intermediate, Hard, None(-)

• Calcifications: Calcifications in a mass, Calcifications outside of mass, 

Intraductal calcifications, None(-)

• Special Cases:  Simple Cyst, Clustered microcysts, Complicated cysts, 

Mass in or on skin, Foreign body including implants, Lymph 

nodes-intramammary, Lymph nodes-axillary, Vascular abnormalities AVMs, 

Vascular abnormalities, Mondor disease, Postsurgical fluid collection, Fat 

Necrosis, None(-)

Show Assessment Specify the ACR BI-RADS Assessment: None (-), 0, 1, 2, 3, 4a, 4b, 4c, 5, 6. 

A comment field is available directly below the ACR BI-RADS Assessment. 

Return Press to return to the previous Touch Panel. 

Lesion # Indicates which lesion you are viewing (Lesion # of Total Number of Lesions). 

Press the left/right arrow to move from lesion to lesion. 

L Lesion Length

H Lesion Height

W Lesion Width

Distance to Nipple Used to manually enter the distance the lesion is from the nipple. 
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Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all 
documented Breast Lesions. 

 Figure 13-156. Breast Lesion Worksheet and Summary

To move to the next page, select the Page Change control 
beneath the Touch Panel. 

NOTE: Only defined features are displayed on the Summary. To display 
the undefined features, select “Show Undefined Features” at the 
bottom of the Summary Worksheet. 

Auto Contour (HxL) Press to activate the Auto Contour feature, using the height and length. 

Auto Contour (HxW) Press to activate the Auto Contour feature, using the height and width. 

Rt or Lt A/B Ratio Right or Left Lesion A/B Ratio, measured by Area or Diameter. 

Composition Specify the composition of the lesion: None (-), Homogeneous background 

echotexture-fat, Homogeneous background echotexture-fibroglandular, or 

Heterogenous background echotexture. 

Delete Lesion Press to delete this lesion. 

Table 13-62:  Breast Lesion M&A Touch Panel Controls (Continued)

Preset Parameter Description
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Breast Measure Assistant (Auto Contour) 

You can request that the system trace/outline the border of a  
breast lesion using Breast Measure Assistant (Auto Contour). 
You do this by setting the Region of Interest (ROI) around the 
lesion; the system can then measure the lesion by drawing the 
contour around it. 

To automatically detect the breast lesion on the display, 

1. Press Measure. 

2. Press Auto Contour (HxW) on the Touch Panel. 

3. Place the Cursor in the center of the lesion and press Set. 
Size the ROI around the lesion. Use the Trackball to resize 
the ROI.

• To increase the size of the circle, move the Trackball 
down and to the right. 

• To decrease the size of the circle, move the Trackball up 
and to the left. 

NOTE: Include the entire lesion, even if additional surrounding 
tissue is included. 

4. Press Set on the Trackball. A trace appears around the 
lesion. 

NOTE: Multiple breast lesion traces may be generated by the 
system. To cycle through the generated contours, use the 
Select Contours rotary on the Touch Panel. 

5. Inspect the generated contour for accuracy. If edits are 
necessary, execute steps 6-7 to edit the contour prior to 
accepting the measurement. Otherwise, skip to step 8.

6. To edit the selected contour, move the Trackball to 
appropriately size the edit region and then press Set on the 
Trackball. 

7. The blue portion of the contour can be edited by moving the 
Trackball to the portion of the contour you want to edit. 

NOTE: The Caliper closest to the cursor enables editing. 

NOTE: To limit the horizontal/vertical editing capabilities, you can 
set a preset via Utility--> Measure--> Advanced--> Small 
Parts--> Restrict Breast Contour Caliper Edit. 

8. After you have completed your edits, press Done on the 
bottom Set Key or press Print to accept the measurement. 
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Breast Assistant, Powered by Koios DS (not available in all 

countries)

Breast Assistant, Powered by Koios DS is a Breast Lesion 
Analysis Option. Koios DS is integrated with the LOGIQ Fortis 
via DICOM. Koios DS is configured similar to a DICOM Service. 
The user can accept/dismiss analysis results. If accepted, these 
results are included in the DICOM Structured Report.  

To perform Breast lesion analysis using Koios DS: 

1. In B-Mode in the Breast Application, select the Breast 
Productivity Package Lesion # then press Koios via the 
Touch Panel. 

Figure 13-157. B-Mode Touch Panel in Breast Application

NOTE: Koios DS analysis requires a frozen dual B-Mode image 
with a Length, Width, and Height measurement.

2. Measure the breast lesion (Length, Width, Height) over 2 
orthogonal scan planes; or measure the lesion using Auto 
Contour. 

3. Using the Trackball control, press Analyze. 
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Breast Assistant, Powered by Koios DS (not available in all 

countries)  (continued)

4. Koios DS analyzes the lesion (a pop-up appears, 
“Analyzing”).    

Figure 13-158. Koios DS Analysis

5. A pop-up appears with the result of the Koios DS risk 
assessment and its alignment to an ACR BI-RADS® or 
U1-U5 risk category. 

6. If the assessment is accepted, it becomes part of the exam 
including being displayed on the exam's Summary Report 
and included in the DICOM SR data associated with the 
exam. If the assessment is dismissed, the results are not 
stored as part of the exam.

NOTE: For additional details of the Koios DS assessment, refer to 
Koios Medical's Koios DS product documentation.
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Thyroid Productivity Package

Overview

A Thyroid Productivity Package is available. 

Table 13-63:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls

Preset Parameter Description

Side Specify the side: Right, Left, Isthmus. 

Worksheet/Summary Select to view the Worksheet/Summary Worksheet. 

Add#1, Add#2, etc. Cycles through the available lesions, or adds a new lesion/node/nodule, etc. 

Rt/Lt Thyroid

Rt/Lt Parathyroid

Rt/Lt/Isthmus Lymph Node

Rt/Lt/Isthmus Nodule

To initiate a Left/Right Thyroid/Parathyroid or Left/Right/Isthmus Lymph 

Node/Nodule, select the corresponding folder on the Touch Panel. 

Length, Height, and Width are available for all thyroid measurements. The 

Cortical Thickness measurement is available for the Lymph Node. Show 

Features is available for all thyroid measurements.  

Location Parathyroid: Specify Upper Gland or Lower Gland

Lymph Node: Supraclavicular fossa, Lower cervical, Middle cervical, Upper 

cervical, Parotid, Submandibular, Submental, Posterior triangle

Nodule:

• Location A: Upper, Lower, Mid, None

• Location B: Lateral, Medial, Midline, None

Show Features - Overall 

Thyroid

Press to activate the Show Features notations. To add notations for each 

feature, position the Trackball to the right of each feature and press Set. This 

brings up the available notations. Move the Trackball to highlight a notation 

and press Set to select a notation. The notation will then appear next to the 

feature and on the Summary Worksheet. 

Below is a list of each Feature with its possible notations by measurement 

type: 

• Overall Thyroid (Top Level Touch Panel)

• Resected: Totally, Partially, None (-)

• Appearance: Within normal limits, Abnormal, Symmetric, Asymmetric 

R>L, Asymmetric L>R, None (-)

• Comment
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Show Features - Lt/Rt 

Thyroid / Parathyroid and/ 

Lt/Rt/Isthmus Lymph Node 

/ Nodule

Press to activate the Show Features notations. To add notations for each 

feature, position the Trackball to the right of each feature and press Set. This 

brings up the available notations. Move the Trackball to highlight a notation 

and press Set to select a notation. The notation will then appear next to the 

feature and on the Summary Worksheet. 

Below is a list of each Feature with its possible notations by measurement 

type: 

• Lt/Rt Thyroid

• Resected: Totally, Partially, None (-)

• Echogenicity: Homogeneous; Coarse; Heterogeneous; Hashimoto, 

Classic; Hashimoto, Probable; None (-)

• Vascularity: Normal, Increased, Decreased, None (-)

• Size: Normal, Enlarged, Small, None (-)

• Comment

• Isthmus Comment

• Lt/Rt Parathyroid -- Upper/Lower Gland

• Visibility: Visualized, Not Visualized, None (-)

• Comment

• Lt/Rt/Isthmus Lymph Node

• Appearance: Within normal limits, Suspicious, Pathologic, None (-)

• Composition: Cystic, Complex, Solid, None (-)

• Vascularity: Normal, Increased hilar, Increased non-hilar, None (-)

• Comment

Table 13-63:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls 

Preset Parameter Description
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Show Features - Lt/Rt 

Thyroid / Parathyroid and/ 

Lt/Rt/Isthmus Lymph Node 

/ Nodule

• Lt/Rt/Isthmus Nodule 

The selections for each category/feature and associated points match the 

ACR® TI-RADS™ (Thyroid Imaging Reporting & Data System) 

risk-stratification system as published in 2017 by ACR*. Once one or more 

values are assigned for each feature, the points are summed and the 

corresponding ACR TI-RADS level is determined. Additional information 

including feature assignment guidelines and criteria for fine needle 

aspiration or follow up ultrasound can be found at the American College of 

Radiology website at: https://www.acr.org/-/media/ACR/Files/RADS/

TI-RADS/TI-RADS-chart.pdf?la=en

• Composition (choose one): Cystic (0 point), Spongiform (1 point), Mixed 

cystic and solid (1 point), Solid (2 points), -

• Echogenicity (choose one): Anechoic (0 point), Hyperechoic (1 point), 

Isoechoic (1 point), Hypoechoic (2 points), Very hypoechoic (3 points), -

• Shape (choose one): Wider-than-tall (0 point), Taller-than-wide (3 

points), -

• Margin (if more than one type, choose the most suspicious one): 

Smooth (0 point), Ill-defined (0 point), Lobulated (2 points), Irregular (2 

points), Extra-thyroidal extension (3 points), -. Note: If more than one 

type, choose the most suspicious.

• Echogenic foci (choose all that apply): None (0 point), Comet (0 point), 

Macrocalcifications (1 point), Peripheral calcifications (2 points), 

Punctate echogenic foci (3 points), -

• Comment

• TI-RADS level: TR1, TR2, TR3, TR4, TR5

- TR1 - 0 points - Benign

- TR2 - 2 points - Not Suspicious

- TR3 - 3 points - Mildly Suspicious

- TR4 - 4-6 points - Moderately Suspicious

- TR5 - 7+ points - Highly Suspicious

NOTE: Although it is possible for a nodule to be awarded zero points 

and hence be characterized as TR1, all other nodules merit at least two 

points because a nodule that has a mixed cystic and solid composition 

(one point) will also gain at least one more point for the echogenicity of 

its solid component.

• Koios DS Assessment

* Tessler FN, Middleton WD, Grant EG, Hoang JK, Berland LL, Teefey 

SA, Cronan, JJ, Beland MD, Desser TS, Frates MC, Hammers LW, 

Hamper UM, Langer JE, Reading CC, Scoutt LM, Stavros AT. ACR 

Thyroid Imaging, Reporting and Data System(TI-RADS): White Paper 

of the ACR TI-RADS Committee. J Am Coll Radiol. 

2017May;14(5):587-595. doi: 10.1016/j.jacr.2017.01.046. Epub 2017 

Apr 2. PubMed PMID:28372962.

Return Press to return to the previous Touch Panel. 

H Height

W Width

L Length

Isthmus AP Used to measure the Isthmus anterior to posterior distance. 

Table 13-63:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls 

Preset Parameter Description
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Cortical Thickness Cortical thickness of the lymph node.  

Delete Press to delete this anatomy. 

Table 13-63:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls 

Preset Parameter Description



Thyroid Productivity Package

LOGIQ Fortis – Basic User Manual 13-333
5855997-1EN Rev. 3

Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all 
documented Thyroid anatomies. 

 Figure 13-159. Thyroid Worksheet

To move to the next page, select the Page Change control 
beneath the Touch Panel. 

NOTE: Only defined features are displayed on the Summary Report. To 
display the undefined features, select “Show Undefined 
Features” at the bottom of the Summary Worksheet. 

NOTE: To exit back to the previous measurement screen, press Set on 
exit. 

NOTE: To exit back to the scan screen, press Worksheet/Summary on 
the Touch Panel. 
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Thyroid Assistant, Powered by Koios DS (not available in all 

countries)

Thyroid Assistant, Powered by Koios DS is a Thyroid Nodule 
Analysis Option. Koios DS is integrated with the LOGIQ Fortis 
via DICOM. Koios DS is configured similar to a DICOM Service. 
The user can accept/dismiss analysis results. If accepted, these 
results are included in the DICOM Structured Report.  

To perform Thyroid nodule analysis using Koios DS: 

1. In B-Mode in the Thyroid Application, select the Thyroid 
Productivity Package Nodule # then press Koios via the 
Touch Panel. 

Figure 13-160. B-Mode Touch Panel in Thyroid Application

NOTE: Koios DS analysis requires a frozen dual B-Mode image 
with a Length, Width, and Height measurement.

2. Measure the thyroid nodule (Length, Width, Height) over 2 
orthogonal scan planes; or measure the nodule using Auto 
Contour. 

3. Using the Trackball control, press Analyze. 

4. Koios DS analyzes the nodule (a pop-up appears, 
“Analyzing”).    
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Thyroid Assistant, Powered by Koios DS (not available in all 

countries)  (continued)

Figure 13-161. Koios DS Analysis

5. A pop-up appears with the result of the Koios DS risk 
assessment and its alignment to an ACR TI-RADS® risk 
category. 

6. If the assessment is accepted, it becomes part of the exam 
including being displayed on the exam's Summary Report 
and included in the DICOM SR data associated with the 
exam. If the assessment is dismissed, the results are not 
stored as part of the exam.

NOTE: For additional details of the Koios DS assessment, refer to 
Koios Medical's Koios DS product documentation.
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Start Assistant

Introduction

Start Assistant automatically saves exam settings as Exam 
Mappings when the first image is acquired during an exam. 
Saved Exam Mappings are automatically recalled when a 
Worklist item is loaded, keying off the Worklist Exam 
Description.

Start Assistant has two functional modes:

• On: Use Exam Description (default mode)

• On: Use Scan Assistant only

Figure 13-162. Start Assistant Modes

NOTE: An Exam Description or Scan Assistant program entry must be 
present for Start Assistant to save the Mapping.
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On: Use Exam Description Mode

In On: Use Exam Description mode, Start Assistant saves and 
loads the following exam settings:

• Exam Description - Populated from the Worklist item, the 
Exam Description is the default key by which the exam 
Mapping is saved.

• Category

• Scan Assistant

• Preset

• Probe

If a new Patient is entered manually (without using a Worklist), 
and no Exam Description is entered, Scan Assistant will become 
the key by which the Mapping is saved. 

On: Use Scan Assistant only Mode

In On: Use Scan Assistant only mode, the exam description is 
ignored and the selection of the Preset and Probe is based on 
the Scan Assistant protocol only. The Exam Category and Scan 
Assistant program are not automatically selected and Start 
Assistant Editor does not show the Exam Description column. 
Manual entry of an Exam Description for table entry is 
prevented.

Saved Start Assistant Exam Mappings can also be added, 
edited or deleted with the Start Assistant Mapping Editor - See 
‘Start Assistant Mapping Editor’ on page 13-338 for more 
information.

NOTE: When using Start Assistant Mapping Editor in “On: Use Scan 
Assistant only” mode, the Exam Description field will not appear  
on the Start Assistant Mapping Editor, Add Start Assistant 
Mapping or Edit Start Assistant Mapping screens.
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Start Assistant Mapping Editor

The Start Assistant Mapping Editor can be accessed from the 
Utility->System->General screen by selecting “Create/Edit” 
under the Start Assistant section (see Figure 13-163).

Figure 13-163. Start Assistant Create/Edit

On the Start Assistant Mapping Editor screen you can Add, Edit 
or Remove a Start Assistant map (see Figure 13-164). 

Figure 13-164. Start Assistant Mapping Editor

NOTE: When using Start Assistant Mapping Editor in “On: Use Scan 
Assistant only” mode, the Exam Description field will not appear  
on the Start Assistant Mapping Editor, Add Start Assistant 
Mapping or Edit Start Assistant Mapping screens.
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Add a Start Assistant Mapping

Select Add from the Start Assistant Mapping Editor screen to 
add a new mapping (see Figure 13-165). 

Figure 13-165. Add Start Assistant Mapping

Edit a Start Assistant Mapping

Highlight an existing mapping on the Start Assistant Mapping 
Editor screen and select Edit or double-click the item to edit a 
mapping (see Figure 13-166).

Figure 13-166. Edit Start Assistant Mapping

Delete a Start Assistant Mapping

Highlight one or more existing mappings and select Delete to 
delete.
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Save and Exit Start Assistant Mapping Editor

Before exiting Start Assistant Mapping Editor, select Save to 
save any changes you have made. 

Select Exit to exit Start Assistant Mapping Editor.
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Scan Assistant

Introduction

Scan Assistant provides an automated exam script that moves 
you through an exam step-by-step. This allows you to focus on 
performing the exam rather than on controlling the system and 
can help you to increase consistency while reducing keystrokes. 
The system automatically invokes the correct mode and imaging 
parameters, advances to the next step in an exam, annotates 
the image, initiates measurements, and assigns the 
measurements to the worksheet/report. 

NOTE: Scan Assistant Creator (off-board) only supports 64-bit 
Windows. 

Availability

The following additional imaging parameters and preferences 
are available for use in a Scan Assistant program: Contrast, 
Contrast Clock, CW Doppler, Dual on Freeze, Depth, Color 
Scale, PW Doppler Scale, PW Sample Volume size, and Flow 
Model Selection.

You can initiate one or more manual Doppler measurements/
calculations. 

Body Patterns are available for use during a Scan Assistant 
program. You can turn a Body Pattern on/off, select a particular 
Body Pattern graphic, and specify the position of the probe mark 
on the Body Pattern graphic. 

The footswitch can be used with Scan Assistant.  You can map 
Pause/Resume, Previous Step, and Next Step to the footswitch.

The “Always Use Doppler Cursor” preset, available on the 
Utility --> System --> General page, allows all PW Doppler steps 
to start with full screen 2D image plus mode cursor. You can 
specify the Store Order in Scan Assistant to set the Reading 
Order for the radiologist. The Learn Probe attribute can be set to 
learn and change the probe for the user in the middle of the 
exam.
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Scan Assistant Definitions

Scan Assistant definitions: 

• Scan Assistant Manager. Available via the Utility -> Scan 
Assistant page to import/export Programs created via the 
Scan Assistant Creator and to assign Programs to a user/
exam category. 

• Import. Used to load Programs created via the Scan 
Assistant Creator on to the LOGIQ Fortis. 

• Export. Used to move Programs from one LOGIQ Fortis 
system to another LOGIQ Fortis. 

• Scan Assistant Creator. Used to create Scan Assistant 
Programs.
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Scan Assistant Description

Figure 13-167. Scan Assistant Display Description

1. Program name, completed steps/out of total number of steps, and step 

description area.  

2. Program step status (Complete/Incomplete), step number, step name. A 

checkmark indicates that this step has been completed. You can also 

manually check the box to bypass this step. 

3. This column indicates the mode or when a measurement needs to be 

made.  

4. This column indicates that the action moves the Program to the next 

step. 

5. Active step The box is green when the program is active or yellow when it 

is paused. 

6. Navigation: Stop, Pause, Pause/Resume. Edit (Pencil Icon). Also 

available via the left/right keyboard arrow keys. Stop also allows the 

program to be stopped, restarted, or a new program selected.  
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Setting up Scan Assistant

To set up Scan Assistant, 

1. Import the Scan Assistant Program created using the Scan 
Assistant Creator or exported from another LOGIQ Fortis 
program. 

a. Insert the media with the saved Program from the Scan 
Assistant Creator or exported program from another 
LOGIQ Fortis. 

b. Press Utility -> Scan Assistant. 

c. Select Import from the Scan Assistant Manager page. 

d. In the Source field at the top of the Import Programs 
pop-up, select the media that the Program is stored on. 

e. Highlight the Program(s) to be imported. If a folder is 
highlighted, all programs in the folder are selected.  

f. Select Import. The Program(s) you selected are stored 
to the LOGIQ Fortis. You can add it to the exam 
category and user. 

2. Assign the imported Program to the exam category and 
user. Under Program Selections on the right-hand side of 
the Scan Assistant Manager page, specify the Exam 
Category and User for this Program. You can select All 
Users, or a specific user. If you specify All Users, all users 
will have the ability to use this Program while in the specified 
exam category, unless the user has his/her own list defined. 

3. Select the imported Program from Available Programs -> 
Custom Programs on the left-hand side of the page. Then 
press the right arrow button to move the imported Program 
to the exam category and user selected above. 
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Setting up Scan Assistant  (continued)

4. The Program list you created in Utility ->Scan Assistant is  
visible in the Program field on the Patient menu. Pressing 
New Patient erases any patient data and Scan Assistant 
program you entered. First press New Patient and then set 
up patient data, Scan Assistant program, and finally, press 
Register Patient. 

You can access the Scan Assistant Creator to edit the exam’s 
program from the imaging display via the Creator Icon located at 
the bottom, left-hand corner of the Scan Assistant Program 
monitor on the display. You can activate the Scan Assistant 
Creator from the image screen, make edits, and then run Scan 
Assistant to test your changes. 

NOTE: If you edit the program after you have already stored several 
images, and your edits change the number of program steps, 
you are prompted to Restart or Continue the Scan Assistant 
program. 

NOTE: If you edit the program after you have already completed several 
steps, checkmarked steps remain checkmarked, even if you 
insert a new step between checkmarked steps. If this is not 
correct, you can edit the checkmarks or restart the program. 
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Using Scan Assistant

After you have set up Scan Assistant, the Program is active 
when you exit the Patient menu. The Program is located on the 
left-hand side of the display and as you can see in the example 
below, the annotation for the first step has been automatically 
noted on the image, ready for you to scan the specified 
anatomy. 

Figure 13-168. Scan Assistant Display

1. Follow the steps indicated in the Program: image/measure 
the appropriate anatomy. 

2. Perform the indicated trigger to move to the next step in the 
Program. 

NOTE: The footswitch can be used with Scan Assistant.  You can 
map Pause/Resume, Previous Step, and Next Step to the 
footswitch.

3. To pause or unpause Scan Assistant, press the pause 
button on the display or press the left/right arrow on the 
keyboard.  

4. To stop or restart a Program, press the Stop icon at the 
bottom of the Scan Assistant Program. A dialog pops up. 
This dialog lets you restart the current Program, start 
another Program, or stop Scan Assistant. 

5. To skip a step or move to a certain step, press the up/down 
arrows on the keyboard or select the step you want to move 
to using the Trackball and Set keys. 
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Reference Images

Overview

Reference images can be attached to a step of Scan Assistant 
protocol. The reference image is displayed in an extra window 
on the scan screen during scanning with the protocol. 

Any image (JPEG/DICOM) can be attached to (or removed 
from) a protocol with Scan Assistant Creator.

Using Reference Images

A reference image window appears when a protocol with a 
reference image attached is active. The window is positioned 
over the preview window and can be moved anywhere on the 
screen (the system will remember the last image position).

Figure 13-169. Reference Image Window

1. Minimize window by clicking minimize button in upper left 
window corner. 

2. Change window size by dragging window corners.

3. Drag to move window anywhere on screen.



Advanced Features

13-348 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Inserting a step

1. To insert a pre-defined step to the active Scan Assistant 
Program, press the Plus Sign (+) on the Scan Assistant 
Display. 

Figure 13-170. Insert Steps

The Insert Steps Pop-Up Menu appears. 

2. Select the steps to be inserted via the pull-down Scan 
Assistant menu.  

Figure 13-171. Select from pull-down menu

3. Press Insert. All the steps in the inserted program are added 
immediately after the active step in the current program. 

To undo inserted steps, use Edit button to edit the program 
and delete the recently inserted steps.

NOTE: After the exam is completed, the system removes the 
temporarily saved Scan Assistant program with inserted steps.

NOTE: The inserted steps is not adapt the annotation and body pattern 
from the active step.
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Breast Measurement Auto Insert Steps

To add a program to be inserted whenever the Add Lesion key is 
selected, 

1. Press the Plus Sign (+) on the Scan Assistant Display. 

Figure 13-172. Insert Steps

2. Select the "Add Lesion" tab.  

3. Identify a breast lesion while using a breast scan assistant 
program. Freeze on the lesion and press “Add Lesion” on 
the measurement menu.

4. Complete the length measurement of the lesion. Unfreeze 
the image.

5. Upon unfreeze, the predefined program is inserted into the 
existing program and the next step is started.

Figure 13-173. “BreastLesionAssess”

In this example, BreastLesionAssess contains four (4) 
steps, as indicated within the brackets on the figure above. 
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Exporting Scan Assistant Programs to Another LOGIQ Fortis 

Exporting Scan Assistant Programs allows them to be imported 
to another LOGIQ Fortis or to be edited offline with the Scan 
Assistant Creator tool. To export a Program, 

1. Insert the media to save the Program to.  

2. Press Utility -> Scan Assistant. 

3. Select Export from the Scan Assistant Manager page. 

4. In the Source field at the top of the Export Programs pop-up, 
select the media that the Program is to be stored on. 

5. Specify the Program Directory using the drop-down menu if 
the desired Program Directory already exists on the media. 
If not, or if you want to export the Program to a new Program 
Directory, type a new Program Directory name in the field. 

6. Highlight the Program(s) to be exported. If a folder is 
highlighted, all programs in the folder are selected. 

7. Select Export. The Program(s) you selected are stored to 
the media. You can now import it to a new LOGIQ Fortis. 
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Scan Assistant Creator

Overview

Scan Assistant Creator is used to build customized Programs 
that can be imported onto the LOGIQ Fortis. These Programs 
automate many of the steps normally performed manually by the 
user, thereby reducing the number of user actions and the 
amount of time to perform an exam.

The Scan Assistant Creator tool can be used both on the 
scanner and as an off scanner tool. 

 Figure 13-174. Tool Layout Overview

1. Menu

2. Toolbars

3. Steps

4. Step Attributes

5. Rule Checking
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Help

Help is available via the F1 key.

File Handling

When using Scan Assistant Creator off the scanner, it is very 
important to organize the programs in a way that will make it 
easy to import the programs onto the scanner. Each Program is 
a computer file. While these computer files can be copied, 
pasted and deleted like any other computer file, the Program 
files are only viewable using the Scan Assistant Creator.

File Extensions

Factory defined Programs have an .ep (exam Program) 
extension while user-defined Programs have an .uep (user 
exam Program) extension. Both factory and user-defined 
Programs can be read into the Scan Assistant Creator, but only 
user-defined Programs are created. If a factory Program is read 
into the Scan Assistant Creator and then edited, it is saved as a 
user-defined Program.

Off-Scanner Directory Structure

The Scan Assistant Creator organizes the Programs in a 
directory structure that allows easy importing into the LOGIQ 
Fortis. In order to be imported, all Programs must be stored in a 
LOGIQ_SCAN_ASSISTANT Programs Directory. Within this 
directory, one or more user-specified directories are created. 
Within each of these user-specified directories are the category 
directories (VAS, ABD, etc.) that hold the actual Programs.

The dialog in the figure below allows the user to specify the 
location of the LOGIQ_SCAN_ASSISTANT directory (root 
directory) and to either select an existing User Program 
Directory or create a new one.

Figure 13-175. Directory Structure
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Exporting Programs from LOGIQ Fortis

Factory or user-defined Programs on the LOGIQ Fortis are 
easily exported for editing with the Scan Assistant Creator.

On the LOGIQ Fortis:

1. Insert a USB storage device (or CD/DVD).

2. Select Utility -> Scan Assistant.

3. Select Export.

4. Select the media type and specify a directory. If a directory 
is specified that already exists, the Export adds the 
Programs along with any existing Programs. If the names of 
Programs are the same, use the resulting dialog to decide 
how to continue.

5. Select the Program to be exported and export them.

On the computer with the Scan Assistant Creator installed:

1. Insert the USB storage device (or CD/DVD) used above.

2. Copy the LOGIQ_SCAN_ASSISTANT directory from the 
USB storage device (or CD/DVD) to the hard drive. The 
hard drive directory that you copy to is the root directory. If 
you want to work with the Programs directly on the USB 
storage device, this step can be skipped.

3. Either open a Program by double-clicking it or selecting 
File ‘-> Open from the Scan Assistant Creator.
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Importing Programs to LOGIQ Fortis

Programs created with the Scan Assistant Creator are easily 
imported to the LOGIQ Fortis.

On the computer with the Scan Assistant Creator installed:

Copy the complete LOGIQ_SCAN_ASSISTANT directory from 
the computer hard drive to a USB device (or CD/DVD). The 
LOGIQ_SCAN_ASSISTANT directory needs to be at the top 
level (not in a subdirectory) on the USB device (or CD/DVD).

On the LOGIQ Fortis:

1. Insert the USB device (or CD/DVD).

2. Select Utility -> Scan Assistant.

3. Select Import.

4. Select the media type.

5. Select the Programs to be imported and import them. If you 
attempt to import Programs that already exist with the same 
name, use the resulting dialog to decide how to continue.

Table 13-64:  Directory Structure Example

LOGIQ_SCAN_ASSISTANT 

MyUserNameDirectory

ABD

CARD

GYN

OB

PED

SMP

UR

VAS
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Sharing Programs

To share a program with someone else, the file can be sent via 
e-mail as an attachment or copied onto a media. If the person 
receiving the program has the Scan Assistant Creator tool 
installed, open the file and use “Save As” to save it to an 
appropriate directory. 

If the person receiving the program does not have the Scan 
Assistant Creator tool installed, the program can still be loaded 
onto a scanner by creating the following structure at the top level 
directory on a media device, copying the file to one of the 
category directories and then importing the protocol onto the 
scanner.

To share an entire portfolio of programs with someone else, the 
entire user program directory can be zipped. Make sure to set 
the options to include subfolders and to include relative path 
information. On the receiving end, the user can unzip the 
directory into a LOGIQ_SCAN_ASSISTANT directory. 

Table 13-65:  Media Directory Structure

LOGIQ_SCAN_ASSISTANT 

User Program Directory (Any user name)

Category Directories (e.g. ABD, CARD)
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Exporting the Scan Assistant Creator to a PC

To export the Scan Assistant Creator to a PC, 

1. Insert a USB Flash Drive in a USB port on the Control 
Panel. 

2. Press Utility -> Scan Assistant.

3. Press Export. 

4. Place a checkmark in the Export Scan Assistant Creator 
Installation. 

5. Press Export. 
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Creating and Editing Programs

To access Scan Assistant Creator on the LOGIQ Fortis: 

1. Select Utility -> Scan Assistant. 

2. Select Creator on the Scan Assistant Manager tab on the 
monitor.

Creating New Programs

1. Select File -> New. 

2. Before creating a New Program, select Single Step or Multi 

Step in the Toolbar.

 Figure 13-176. File Toolbar

3. Proceed to add/update your settings for the Step: Step 
Name, Instructions, etc.

4. Once finished, highlight the finished Step.

5. Select Edit -> Copy

6. In the Toolbar along the left, select Insert Step Before 

Selected or Insert Step After Selected.

Figure 13-177. Insert Step

7. Highlight the copied step and proceed to edit accordingly.

8. Proceed to follow the same procedure to add more steps to 
your Program.
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Creating New Programs  (continued)

9. When done, select Check to verify your Steps.

Figure 13-178. Rule Check and results area

10. The results are listed as to whether the Scan Assistant Rule 
Check Passed or if any Issues were detected. Issues found 
when running the check do not mean the Program is 
unusable. 

NOTE: The rule check may report an unequal number of left and 
right steps. This may or may not be the expected result. If a 
change is made in response to the rule check results, a new 
rule check can be run to see if the issue has been resolved.
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Editing Programs

When editing Programs, changes can be made at both the step 
level and the step attribute level. Steps can be added, inserted, 
moved, deleted, copied and pasted. Step attributes can be 
modified for a given step or across multiple steps.

Editing Steps

The step toolbar allows steps to be inserted, moved up and 
down, and deleted. For steps to be moved, one or more 
consecutive steps must be selected.

When the last step in a Program is selected, the Enter key 
automatically appends a new step to the end of the Program 
and selects the new step. When the Enter key is pressed on any 
other step, the next step is activated. The up and down arrows 
can also be used to move between steps.

 Figure 13-179. Step Toolbar and Edit Toolbar and Menu

When selecting multiple steps for Cutting or Copying, the Shift + 
Left Mouse and Ctrl + Left Mouse key combinations can be 
used.

1. Insert Step above selected step (Ctrl+l)

2. Insert Step below selected step

3. Move selected step(s) up (Ctrl+Up Arrow)

4. Move selected step(s) down (Ctrl+Down Arrow)

5. Delete selected step(s)

6. Edit Toolbar  (Undo, Redo, Cut, Copy, Paste 

and Paste Special)

7. Edit Menu (same toolset as the Edit Toolbar)
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Editing Steps  (continued)

Paste Special The Paste Special control allows copied steps to be pasted with 
some modification. Select the desired Conversion and select 
Paste. An added feature to the Paste Special control is the 
Define Conversions function, which is used to define the text 
that is converted. An example is shown in the figure below. If an 
exact case match is found, it is used for the conversion. If there 
is a match, but with a different case, it is used only if there is not 
an exact case match.

There are 3 user-defined conversions that can be edited and 
named. These user-defined conversions can also be used to 
perform a find and replace capability.

Figure 13-180. Define Conversions Dialog
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Editing Step Attributes

To edit a step attribute, select the step attribute and edit it, such 
as picking from a drop down menu, checking or unchecking a 
box, or typing in text. To edit multiple steps in a Multi Step view, 
select the step attribute of choice and do the following actions:

• Set the value of the step attribute as desired.

• Left click (and release) in the square in the bottom 
right-hand corner of the attribute.                                                                       

• Drag to highlight the other steps to be changed in the same 
way.

• Left click (and release) again.

This will take the original step's content and copy it down the 
highlighted steps. This is also available when multiple attributes 
are selected within the same step.

To edit multiple steps in the single step view, highlight the 
multiple steps that you want to edit and then change the step 
attribute. If a step attribute is highlighted in green, this indicates 
that its current value varies across the selected steps.

If a step attribute is not editable, it may be because the attribute 
requires a different attribute to be set a particular way in order to 
become enabled. These dependencies are outlined below.

Table 13-66:  Step Attribute Dependencies

Step Attribute Dependency

PDI Color step attribute must be checked

Color / Dop Steer Color or PW step attribute must be checked

Measure 1 Measure Trigger must not be set to None

Measure 2 Measure 1 must be set

Measure 3 Measure 1 and Measure 2 must be set
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Editing the Current Program on the Scanner

If you are currently using a Scan Assistant program and choose 
to edit that program while using it (by selecting the pencil icon at 
the bottom of the Scan Assistant steps), the program will be 
reloaded when scanning is restarted. If the number of steps is 
changed, the checkmarks that were in place before editing are 
cleared.  If the number of steps in the program has not changed, 
the checkmarks that were in place before editing are 
maintained.

The current program can be restarted at any time by selecting 
the Stop button on the Scan Assistant navigation window and 
selecting restart.

Opening Existing Programs

Multiple Programs can be open at the same time by selecting 
File -> Open. Each Program will open within the primary Scan 
Assistant Creator window. Finding the Program file (.ep or .uep) 
and opening the file automatically opens the file in the Scan 
Assistant Creator. 

To switch between Programs, the title banner of the window is 
selected or the Program is selected from the Window Menu. An 
asterisk indicates that the Program has been edited but not 
saved.

With multiple Programs open, steps copied from one Program 
can be inserted into another Program via the paste or paste 
special features.

Saving Programs

Programs are saved via Save or Save As.

When Saving a Program, the Scan Assistant Creator provides 
an opportunity to run a rule check on the Program before saving.

NOTE: The name of a Program is appended with an asterisk (*) when 
the Program has been changed, but those changes have not yet 
been saved
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Views

A Program is made up of a series of steps. Each step is made 
up of various step attributes. The step and step attribute data 
can be viewed in many ways using the Scan Assistant Creator. 
The different ways to look at the data are called Views.

Single Step Views

There are two Single Step views: Basic and All. The Basic view 
shows the most common attributes of the selected step. The All 
view shows all of the attributes of a given step.

For both views, the step names are shown on the left with the 
active step highlighted. The step attributes appear on the right 
and are separated into four groupings:

• General attributes at the top

• Imaging and Comment attributes on the left

• Measure attributes on the right.

 Figure 13-181. Basic Single Step View

1. Steps 2. Step Attributes
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Multi Step Views

Multi Step views show certain step attributes for all the steps in a 
Program. There are six Multi Step views: General, Comment, 
Scan, Measure, Custom and All. 

 Figure 13-182. Multi Step Scan View

1. Steps 2. Step Attributes
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Customizing Multi Step Views and HTML Export

The contents of the Multi Step Views and the HTML Export is 
configurable via the Customize Menu or the small downward 
pointing arrow next to the word "Custom" on the View Toolbar 
Menu. 

Figure 13-183. Customize Menu

The Language selection allows the Scan Assistant Creator 
language to be configured. 

The column widths of the steps and step attributes are 
customizable. The desired width is set by selecting and dragging 
the line separating column headers. These adjustments are 
remembered for the next time the Scan Assistant Creator is 
used.

The locations of the toolbars are customizable. The location is 
set by selecting and dragging the toolbar gripper as shown in 
the figure below. The toolbars can be placed at the top, left, right 
or bottom of the Scan Assistant Creator.

 Figure 13-184. Gripper used for Toolbar placement

1. Toolbar Gripper
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Customizing Multi Step Views and HTML Export  (continued)

Multi Step View In the Customize Multi Step Views dialog, each tab represents a 
different Multi Step view. Within a tab, the checked boxes are the 
step attributes that are displayed in that Multi Step view. The 
views are independent of one another, so if a step attribute is 
desired in both views, it needs to be selected in both views.

 Figure 13-185. Customize Multi Step Views Dialog
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Customizing Multi Step Views and HTML Export  (continued)

HTML Export The HTML Export feature allows a Program to be stored in a file 
format (*.mht) that is compatible with Windows Internet Explorer. 
This file is useful for printing the Program or viewing the 
Program, but is not useful for editing the Program. HTML Export 
is available via the File Menu.

An example of how a Program looks in HTML format is shown 
below.

 Figure 13-186. HTML Export
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Keyboard Navigation

In addition to moving the windows pointer and selecting an item, 
there are several keyboard controls to help navigate through the 
Views.

Table 13-67:  Keyboard Program Navigation

Keyboard Entry Step Selected Step Attribute Selected

Enter Moves to next step. If on the last 

step, it creates a new step and 

selects it.

Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to same step 

attribute in the next step. If on the 

last step, it creates a new step and 

selects it.

Tab Single Step View: Moves to next 

step. On the last step it moves to the 

first step attribute.

Multi Step View: Moves to the first 

step attribute.

Moves to next step attribute. If last 

attribute for the step, moves to next 

step.

Alt+Tab Single Step View: Moves to previous 

step. On the first step it moves to the 

last step attribute.

Multi Step View: Moves to the last 

step attribute of the previous step.

Moves to next step attribute. If first 

attribute for the step, moves to 

previous step.

Up Arrow Moves to previous step Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to same step 

attribute in the previous step.

Down Arrow Moves to next step Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to same step 

attribute in the next step.

Left Arrow No action Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to the 

previous step attribute.

Right Arrow Single Step View: No action.

Multi Step View: Moves to the first 

step attribute.

Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to next step 

attribute.

Page Up Scrolls to previous page of steps Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to same step 

attribute in the previous step.

Page Down Scroll to next page of steps Single Step View: Varies based on 

the step attribute selected.

Multi Step View: Moves to same step 

attribute in the next step.
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Scan Assistant Features

Scan Assistant allows the user to program the steps in an exam 
and to program certain attributes for each step. The attributes 
are what give the Scan Assistant Program behavior.  The tables 
below provide the names of all attributes along with a 
description.

General Attributes

Table 13-68:  General Attributes

Attribute Name Description

Store Order Specify Used to enable the Store Order Definition dialog so that the Store Order can 

be set

Store Order Specifies the Store Order number associated with the Step

Step Number Number of the step that appears in the Scan Assistant Navigation menu

Step Name Name of the step that appears in the Scan Assistant Navigation menu

Advance On • Print: Advance to the next step and go live after Print / Image Store (e.g P1 

key). This can be a single image store or a loop store. 

• Print & Unfreeze: Advance to the next step after Print / Image Store (e.g. P1 

key) and unfreeze. This can be a single image store or a loop store.

• User Selection: Advance to next step only after next step is manually 

selected (e.g. down arrow)

Instructions User notes displayed in the Scan Assistant Navigation menu when the step is 

active

Optional Optional: An optional step is given a check mark during Program execution 

even if no image is acquired

Mandatory: A mandatory step is give a check mark only if an image is 

acquired for the step

Learn Probe On or Off.  Learn and change the probe for the user, when selected.
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Comment Attributes

Table 13-69:  Comment Attributes

Attribute Name Description

Comment 1, Comment 2 User annotation associated with the step. When editing in a Multi Step View, 

use Alt+Enter to create a new line.

Location 1, Location 2 Choose where the annotation is located on the image area for single or dual 

screens.

BP 1,2 Blank: Body Pattern not specified. 

Selected Body pattern graphic with or without probe position will be set, if 

selected

BP Specify Used to enable the Body Pattern Selection dialog so that the Body Pattern 

graphic can be selected and probe position can be set

BP Clear Clears BP 1, BP 2 defined for the step

BP Probe BP Probe mark set by Scan Assistant, when selected

BP X/Y/Rot Displays the X/Y/Rot information of the Probe mark set from Body Pattern 

Selection dialog
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Imaging Mode and Imaging Preference Attributes

The probe and application associated with a program is not 
configurable. Instead, the scanner remembers the last probe 
and application used for a given Scan Assistant program and 
automatically selects them the next time the program is started. 

 Figure 13-187. Imaging Mode and Imaging Preference Attributes

Table 13-70:  Imaging Mode Attributes

Attribute Name Description

Color, PDI, MVI, PW, CW, 

M Mode, B Flow, B FLow 

Color, 3D, LOGIQView, 

Contrast, Contrast Clock, 

Elasto (Strain 

Elastography) and SWE 

(Shear Wave Elastography)

• On - when selected, the mode is on.

• Off - when not selected, the mode is off. 

Dual • Off - Dual screen is not in use.

• Left Active - Dual screen is active and the left image is the active image.

• Right Active - Dual screen is active and the right image is the active image.

• DualView (simul) - DualView is active (both left and right images are live).
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Imaging Mode and Imaging Preference Attributes  (continued)

NOTE: B Flow Color is not supported by the LOGIQ Fortis. It still exists 
in Scan Assistant Creator because other products that offer B 
Flow Color use the Scan Assistant Creator program. 

Imaging Preferences work slightly different than other attributes. 
For example, if an abdomen Program has 20 steps and all steps 
have the Harmonics attribute set to Default, then Scan Assistant 
will not affect the harmonics setting. Now, assume that steps 
10-12 are gallbladder steps and that the harmonics attribute has 
been set to on for these steps. When transitioning into this group 
of steps (step 9 to step 10), harmonics will be turned on (or 
remain on if it was previously on). If harmonics is then manually 
turned off in step 10 then Scan Assistant will not turn it back on 
when advancing to step 11. In other words, a group of 
consecutive steps with the same Imaging Preference are treated 
as a group by Scan Assistant and not as individual steps.

Table 13-71:  Imaging Preference Attributes

Attribute Name Description

Harmonics • On - when selected

• Off - when unchecked

• Default - Not specified so Scan Assistant does not set this attribute.Virtual Convex

CrossXBeam

Color/Doppler  Steer • Left - Color/Doppler steered to the left

• Center - Color/Doppler not steered

• Right - Color/Doppler steered to the right

Flow Model • Specified Flow Model is selected - Aorta, Renal, Penetration, Slow Flow, 

Med Flow, Fast Flow 

• Default - Not specified so Scan Assistant does not set this attribute.

Depth • 2.0 to 36.0.

• Default - Not specified so Scan Assistant does not set this attribute.

Color Scale • 1 to 200.

• Default - Not specified so Scan Assistant does not set this attribute.
Doppler Scale

SV • 1 to 16.

• Default - Not specified so Scan Assistant does not set this attribute.

B-Flow Sensitivity • 1.0 to 50.

• Default - Not specified so Scan Assistant does not set this attribute.

B-Flow Color Scale • 0.02 to 1.5.

• Default - Not specified so Scan Assistant does not set this attribute.

Color Baseline • 0 to 100.

• Default - Not specified so Scan Assistant does not set this attribute.

Doppler Baseline • 5 to 95.

• Default - Not specified so Scan Assistant does not set this attribute.
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Measurement Attributes

Figure 13-188. Measurement Attributes

Table 13-72:  Measure Attributes

Attribute Name Description

Side When selected, the side measurement qualifier is set to:

• Rt - Right side of the body

• Lt - Left side of the body

• None - Not used (neither Right nor Left)

• Default - Side not specified so Scan Assistant does not set Side

Location When selected, the location measurement qualifier is set to:

• Prox - Proximal

• Mid - Middle

• Dist - Distal

• None - Not used

• Default - Location not specified. Scan Assistant does not set Location

Dop Vessel Assign Various Doppler measurement Vessel folders

Specifies the Vessel folder to assign auto calcs to. The assignment happens 

when the image is stored / printed (e.g. P1 key).

Auto Calcs When selected, the Auto Calcs state is set to:

• Frozen

• Live

• Off

• Default - Auto Calcs state not specified. Scan Assistant does not set Auto 

Calcs state.

Auto Calc Params • Various Auto Calc parameters - specifies the auto calc parameters to be 

used. 

• Default - Auto Calc parameters are not specified. Scan Assistant does not 

set the Auto Calc parameters.

Auto Calc Specify Used to enable the Auto Calcs Parameter Selection dialog so that the Auto 

Calc Params attribute can be set

Auto Calc Default Used to set the Auto Calcs Params attribute to Default.
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Fetus When selected, the fetus measurement qualifier is set to:

• A - Fetus A

• B - Fetus B

• C - Fetus C

• D - Fetus D

• Default - Fetus not specified so Scan Assistant does not set Fetus

B/M Measure Trigger When selected, the following action initiates the “Measure 1” attribute:

• Measure Key 

• Freeze Key 

• Image Store - when the Measure key is manually selected or the image is 

stored. This is used to store / print an image and then measure on it and 

then store it again. Therefore, the Advance On Print attribute is ignored on 

the first store / print when the Measure Trigger attribute is set to Image 

Store.

• None - Measurements are not triggered by Scan Assistant. The "Measure 

1" attribute is ignored.

B/M Measure 1 Various 2D or M-Mode measurements

Specifies the first 2D or M-Mode measurement to be initiated. The point at 

which the measurement is initiated is based upon the Measure Trigger 

attribute.

B/M Measure 2 Various 2D or M-Mode measurements

Specifies the second 2D or M-Mode measurement to be initiated after the 

measurement associated with the Measure 1 attribute is completed. 

B/M Measure 3 Various 2D or M-Mode measurements

Specifies the third 2D or M-Mode measurement to be initiated after the 

measurement associated with the Measure 2 attribute is completed.

Double Print - Meas • On - If an Image Store / Print (e.g. P1 key) is performed on an image with 

measurements, the image is stored / printed two times, once with the 

measurements and once without.

• Off - No special Store / Print behavior.

Double Print - Color • On - If an Image Store / Print (e.g. P1 key) is performed on an image with 

color, the image is stored / printed two times, once with color and once 

without. If double print on color and double print on measurements are both 

configured to be on, the image is stored / printed two times, once with the 

measurements and once without.

• Off - No special Store / Print behavior.

View Worksheet • On - The worksheet is turned on

• Off - The worksheet is not turned on

Table 13-72:  Measure Attributes (Continued)

Attribute Name Description
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Measurements

Because there are many measurements available on the LOGIQ 
Fortis and because the measurement package is highly 
customizable, there is some special handling for measurements. 
The Measurement attributes affected by this special handling 
are Measure 1-3 and Vessel.

Selecting a Measurement Package

The Measurement selection menu can be used to specify which 
measurement package is to be used for the Program. The 
Measurements packages are organized by category and 
subcategory. The choices for the Measure 1-3 and Vessel 
attributes are limited by the selection of category and 
subcategory. To select a subcategory, select a category, move to 
the subcategory list and select a subcategory. To select all 
subcategories for a given category, select the category and then 
reselect the Measurements menu item to remove the menu.

A single Program is not allowed to have measurements from 
multiple categories, but it may have measurements from 
multiple subcategories.

Figure 13-189. Measurements Menu
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User-Defined Measurements

User-defined subcategories and individual measurements can 
be used with the Scan Assistant feature. To do so, the Scan 
Assistant Creator needs to know about the user-defined 
measurements on the LOGIQ Fortis.

On the LOGIQ Fortis, use the Scan Assistant utility menu to 
Export Programs to a USB storage device (or CD/DVD). On the 
export menu, check the "Export user config data" checkbox to 
store the user-defined measurement information to the Program 
User Directory on the media. The name of the file is 
UserConfigSystemFile.res. When this file exists in the Program 
User Directory, then it is used. Otherwise, the default file 
installed with the Scan Assistant Creator is used.
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Rule Checking

Scan Assistant Creator allows Programs to be checked. During 
a rule check, Scan Assistant Creator applies a series of rules 
against the Program being checked and reports any 
inconsistencies between the rules and the Program. This rule 
check is intended to find potential issues in the Program before 
it is tested on a LOGIQ Fortis. Issues found when running the 
check do not mean the Program is unusable. It means that if 
there happens to be a problem with running the Program, the 
first place to look would be at the Issue noted when you ran the 
Check.

For example, if there is a step name Right Kidney and the 
Measurement Location is set to "Left", the rule check would 
report this inconsistency. 

Running a Rule Check

The "Check" button below the Program area is used to initiate a 
rule check. The results are displayed in the Rule Check Results 
window to the right of the button. A rule check is also initiated 
when attempting to save a Program that has not previously 
passed a rule check.

 Figure 13-190. Rule Check Button and Rule Check Results
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Rule Check Results

If the issue is specific to a particular step, double-clicking on the 
issue number in the Rule Check Results window selects the 
step associated with the issue. The results are intended to be 
potential issues and therefore may be ignored at the discretion 
of the user. For example, the rule check may report that there 
are an unequal number of left and right steps. For a particular 
Program, this may be the expected result. If a change is made in 
response to the rule check results, a new rule check can be run 
to see if the issue has been resolved.
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Compare Assistant

Overview

Compare Assistant allows you to perform serial scans on a 
patient when you can compare the images from a patient’s 
previous exam(s) to the patient’s current exam.

NOTE: In order to reload imaging parameters from a previous exam, the 
image must have been stored as raw data.

NOTE: Side-by-side scanning comparison is present whether or not you 
are able to import the scanning parameters.

In Comparison Mode the system can automatically reload  
scanning parameters from a previous exam performed on a 
LOGIQ Fortis archived as raw data and allow for side-by-side 
scanning for image comparison. This allows you to use 
consistent scanning parameters from exam to exam on the 
same patient and may assist in assessing the progress of the 
patient.

Compare Assistant is available in B-Mode, Harmonics, Contrast, 
and in Color Flow and Power Doppler Imaging Modes. 

In B-Mode the following parameters can be transferred from the 
Compared Image to the Active B-Mode Image: Gain, Depth, 
Frequency, CrossXBeam, Virtual Convex (linear probes), SRI, 
Frame Averaging, Map, Dynamic Range, Acoustic Output, 
Harmonic state, Focal Zone Number and Position, Width, and 
Line Density. 

In Color Flow/PDI Mode the following parameters can be 
transferred from the Compared Image to the Active Color Flow/
PDI Mode image: Gain, ROI Size/Position, Frequency, Frame 
Averaging, Packet Size, Flow Model, Scale (PRF), Wall Filter, 
Spatial Filter, Acoustic Output, Invert, Threshold, Sample 
Volume, Color Map, Virtual Convex (linear probes), and Line 
Density.  
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Overview  (continued)

Image parameter copy is supported for the following additional 
modes: Contrast (supports depth, focal zone position, acoustic 
output, and frequency), Elasto (supports ROI size, ROI position, 
frequency, and scale), and B-Flow (supports depth, frequency, 
focal zones, and sensitivity). 

Annotations and Body Patterns can also be transferred from a 
patient’s previous exam to the patient’s current active exam. 

Up to four (4) exams, three (3) other exams and the current 
active exam, can be compared. Each exam is displayed on the 
bottom of the display, with Tabs indicating each exam. Tabs are 
shown in chronological order with the most recent exam 
displayed on the left. 

Compare Assistant is not supported with V Nav, 3D/4D, 
Quantitative Analysis, Stress Echo, or LOGIQView. 

Only measurements taken during the active exam are 
transferred to the current exam’s Worksheet; previous exam 
measurement information is not included on active worksheets. 

In order to utilize the Compare Assistant tool, images should 
have RawDICOM data. The RawDICOM data is saved locally 
when available. Some scanning modes do not provide raw data. 
If the raw data associated with the comparison image cannot be 
displayed in dual image format, the DICOM image data is used 
to display the image. RawDICOM data is typically removed 
when images are sent to PACS; therefore, images that are 
loaded using Query/Retrieve will likely be standard DICOM only.  

NOTE: Images from some other ‘unsupported’ modes (PW Mode, CW 
Mode, and M-Mode) can be recalled in Compare Assistant, but 
the tool will not attempt to copy over imaging parameters unless 
it is one of the types listed above (it will still attempt annotation 
copy). Imaging parameter copy will also not be attempted unless 
the current probe is the same as the probe used to capture the 
original image and RawDICOM data for the original image is 
available.
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Workflow example

NOTE: If you use DICOM images for comparison, check the "Compare" 
checkbox on the DICOM Image folder and press Compare on 
the Image History page.

1. Place the cursor on the Compare Assistant icon and press 
Set to activate Compare Assistant.

2. Place the cursor on the date tab of the desired comparison 
exam and press Set.

3. Place the cursor on the desired comparison image and 
press Set.

4. Start scan and freeze the image at the same position to 
make a comparison.

Use Copy Setting Icon as necessary. Comparison Image 
parameters transfer to the Active Image based on your 
preset (automatic or manual)

5. Place the cursor on the Compare Assistant icon and press 
Set to deactivate Compare Assistant.

 Figure 13-191. Compare Assistant Screen (example)

1. Active Image

2. Comparison Image

3. Active Exam clipboard

4. Date tab of comparison exam

5. Comparison exam clipboard
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Setting Up Compare Assistant

Compare Assistant allows you to set the following parameters: 

• Side to place the compared image (left/right)

• Date settings for the compared image

• Imaging and Annotation parameters to be copied from the 
patient’s Compared to the Current image

• Clipboard, Active Image, and Image History Label Layout 
and Color

You can set these parameters on the System Imaging page via 
Utility--> System--> System Imaging. 

Figure 13-192. Setting Up Compare Assistant Parameters

Table 13-73:  Compare Assistant Parameters

Parameter Settings

Comparison Image Side • Left

• Right (Default)

Comparison Image Date • All Dates (Default): The date is always displayed on the comparison image. 

• Different Date: Date only displayed when the date of the comparison image 

is different than the active exam date. 

• None: No comparison image date is displayed. 
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To set Compare Assistant print parameters, select Utility--> 
Connectivity--> Button--> Advanced. You can set the system to 
print the Comparison image only, to store the New Image only; 
or to store both the Comparison and New Image. 

Copying Settings You can set the default Compare settings on the  System Imaging Utility page 

or you can select the Compare setting via the On-screen controls. 

Comparison Image parameters transfer to the Active Image based on your 

preset (automatic or manual). 

Automatic Settings are copied from the Comparison Image to the current 

image as soon as the comparison image is loaded. 

• Automatic: Imaging & Annotations (Default): Imaging Parameters, 

Annotations, and Body Patterns copied

• Automatic: Imaging Only:  Only Imaging Parameters copied

• Automatic: Annotation Only:  Only Annotations and Body Patterns copied

Manual Settings are copied from the Comparison Image to the current 

image when you manually select the control. 

• Manual: Imaging & Annotations: (Default) Imaging parameters, 

Annotations, and Body Patterns copied

• Manual: Imaging Only: Only Imaging Parameters copied

• Manual: Annotations Only: Only Annotations and Body Patterns copied

Off: No parameters copied. 

Note: Copy settings are restored to the default whenever Compare Assistant is turned on and the active 

exam or current patient has changed since the last time it was on.  

Image Label Layout: 

Clipboard

Active Images

Image History

• No Label

• 1-Line Label (Default)

• 2-Line Label

Image Label Color: 

Clipboard

Active Images

Image History

• Bright/Soft White

• Bright/Soft Yellow

• Bright/Soft Red

• Bright/Soft Orange

• Bright/Soft Blue

• Bright/Soft Purple

Table 13-73:  Compare Assistant Parameters

Parameter Settings
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Compare Assistant Controls

The following controls can be used while in Compare Assistant: 

Table 13-74:  Compare Assistant Controls

Control Description

1. Image Display Area Icon

2. Worksheet

3. Active Image Screen

4. Compare Assistant On/Off. Select the Compare Assistant Icon to activate 

Compare Assistant. 

5. Copying Settings

6. Save As Menu

7. Next/Previous Image, or Press [Ctrl]+[Next Image Arrow] to start a Slide 

Show. 

Keyboard Arrow Keys You can also use the Arrow Keys on the Keyboard to move to the next/

previous clipboard image. 

Operator Panel L/R Keys If comparison mode is on and the single image display is active, to enter dual 

comparison display press the L (Left) or R (Right) key. 

If dual comparison display is on and the dual comparison display is active, to 

enter single image display, press the L (Left) or R (Right) key. 

Freeze Key To deactivate Comparison Mode, select the comparison image side while in 

Dual Comparison Display and press Freeze. 

Print Key When you store an image while in Dual Comparison Display, the system 

automatically switches to the active exam side prior to storing the image. 
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Compare Assistant Controls  (continued)

NOTE: Compare Assistant icon is disabled when the system does not 
have Compare Assistant Option.

Table 13-75:  Compare Assistant icon and Copy Setting icon

Compare Assistant On. Copy to 

Right.

Compare Assistant On. Copy to 

Left.

Off Off

Automatic: Imaging and 

Annotations

Automatic: Imaging Only

Automatic: Annotation Only Manual: Imaging & Annotations

Manual: Imaging Only Manual: Annotations Only

Off. No parameters copied. Disabled.
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Comparison Clipboard

In Comparison Mode two (2) image clipboard areas display 
images from the active exam and the selected comparison 
exam. The Comparison Clipboard can display up to four (4) 
exams, including the active exam. Each exam has a tab that you 
click on to select the desired comparison or active exam. The 
active exam is always displayed (either on the Left or Right side, 
depending on your preset).

 Figure 13-193. Comparison Clipboard

The comparison exam(s) are identified by the date of the exam 
on the tab; the active exam is identified by the word, “Active” and 
by the asterisk (*). You can activate the Image History screen by 
clicking on the “...” tab.  

Each image clipboard has its own scroll bar that can be used to 
scroll through all the images. 

The highlighted image in the clipboard is the image that’s 
displayed along with the exam’s active image. 
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Query/Retrieve

You can use DICOM Query/Retrieve to search for a patient’s 
previous exams. When you select a patient on the Patient 
Screen, select the “Query” button. This automatically registers 
the patient (if needed) and initiates a query via the Data Transfer 
page. Select the exams you wish to be transferred and press the 
“Transfer” button.  

After the retrieve completes, the system automatically returns to 
the Patient Screen with the same patient and exam active as 
when you selected to Query this patient. 

Figure 13-194. Patient Exam View

You can also push the data from the PACS device to the system. 
See ‘Step 2 - Set up the PACS’ on page 13-468 for more 
information.
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Activating Compare Assistant

Compare Assistant displays an image associated with the active 
exam (live, frozen, or CINE) and the other side contains an 
image from the comparison exam. 

Comparison Image parameters transfer to the Active Image 
based on your preset (automatic or manual). You can also use 
the Display Copying control adjacent to the clipboard to copy 
settings from the comparison image to the active image. 

NOTE: If an imaging parameter is not available for the current probe, a 
message in the status bar indicates that this parameter is not 
available.

You activate Compare Assistant via the Comparison Mode Key 
adjacent to the Image Clipboard and On-screen Trackball 
Controls or you can activate Compare Assistant via the Patient 
Image History screen by selecting the image and pressing 
“Compare.”   

 Figure 13-195. Image History

At the start of an exam the system automatically checkmarks the 
three (3) most recent exams, excluding active exams and 
exams without any images as the comparison exams. You can 
adjust this by placing a checkmark next to the exam you wish to 
include in Compare Mode (the system automatically deselects 
the oldest checked exam). To activate Comparison Mode, select 
which specific image you would like to compare to the current 
image from the clipboard on the Image History screen. Select 
the image and press the “Compare” button. 
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Exiting Compare Assistant

To exit Compare Assistant Mode, select the Comparison Mode 
Key adjacent to the Image Clipboard, or change the exam 
Application Preset, change active exam, change patient, or 
recall an image from the active clipboard.  
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OB Measure Assistant

Overview

The user can request the system to trace/outline the borders of  
specified OB measurements using the OB Measure Assistant 
feature. You can auto-detect the Biparietal Diameter, Head 
Circumference, Abdominal Circumference, Femur Length and 
Humerus Length.  

To automatically trace the fetal anatomy on the display, 

1. Press Measure Assist Settings on the OB Touch Panel to 
set OB Measure Assistant parameters. 

2. Press the measurement (BPD, HC, AC, FL or HL). The 
trace is auto generated on the display. 

Table 13-76:  OB Measure Assistant Touch Panel

Touch Panel Settings Description

Default When you first activate the Measure Assistant Touch Panel, the following 

measurements are highlighted: BPD, HC, AC, and FL. This means that OB 

Measure Assistant is active for all these measurements. 

There are four (4) BPD Auto Custom Settings: 

1. BPD Highlighted BPD and HC OB Measure Assistant is generated one at a time. BPD is auto 

generated--> Edit/Set--> HC is auto generated--> Edit/Set--> Done

2. BPD + AutoSet BPD BPD and HC generated at the same time. BPD and HC are auto 

generated--> Edit/Set HC--> Edit/Set BPD--> Done.  

3. BPD + BPD Only Only the BPD is auto generated--> Edit/Set--> Done. 

4. No Highlight User must perform these measurements manually
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Overview  (continued)

3. To edit the selected measurement graphics: 

• Move the Trackball to appropriately size the edit region 
of interest 

• Edit the Calipers via Cursor Select. 

• Adjust the circumference using the Ellipse key. 

Press Set on the Trackball to complete the measurement. 

NOTE: Specify the mode to measure the BPD: Outer to Inner, or 
Outer to Outer via Utility--> Measure--> Advanced--> 
Obstetrics-->  Measure Assistant BPD Method. 

If the system was not able to detect the anatomy automatically, 
measurement calipers are displayed in the center of the screen 
in an editable state and a message is displayed on the status 
bar. 
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Hepatic Assistant

Overview

Hepatic Assistant is supported on C1-6-D and C1-6VN-D (Abd 
(Abdomen), AbdPen (Abdomen Penetration) and AbdDetail 
(Abdomen Detail)) to measure SWE and UGAP simultaneously.

See ‘Shear Wave Elastography’ on page 13-124 and 
‘Ultrasound-Guided Attenuation Parameter (UGAP) Option’ on 
page 13-153 for detailed workflows.
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Activate Hepatic Assistant

1. Configure presets for Hepatic Assistant in Utility -> Imaging 
-> UGAP -> Abdomen/Abdomen Pen/Abdomen Detail - 
C1-6 (Hepatid Assistant) if needed.

• Visualization: 

UGAP/SWE (A/E)

UGAP Q/SWE (A Qual./E)

B/SWE & UGAP/UGAP A (BE -> A/Att.)

SWE Q/SWE & UGAP Q/UGAP (E Qual./E -> A/Qual.)

SWE Q/SWE & UGAP Q/UGAP (Qual./E -> Qual./Att.)

• SWE Display Side: Right or Left.

• Frames to store: UGAP frames to store for Auto 
Measurement Multi can be configured in increments of 
10 from 0 to 300 (0, 10, 20, etc.).

• UGAP ROI Display in PreMode: On or Off.

Figure 13-196. Presets for Hepatic Assistant

2. Assign Hepatic Assistant to any User Defined key in Utility 
-> System -> User Configurable key. Press Save.

3. Select C16-D/C1-6-VN-D probe and Abd, AbdPen or 
AbdDetail for application. 
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Activate Hepatic Assistant  (continued)

4. Press assigned User Defined key. Pre Mode is displayed.

Figure 13-197. Pre Mode

5. Move SWE ROI to desired position, if needed.

6. Press Start to begin SWE and UGAP live data acquisition.

The UGAP measurement is activated when the SWE 
measurement is completed.

• The LOGIQ Fortis acquires one SWE frame data and 
one UGAP frame data for Auto Measurement Single.

• The LOGIQ Fortis acquires SWE frames data until the 
user presses Freeze, and the specified number of 
UGAP data frames for Auto Measurement Multi.

• The LOGIQ Fortis acquires SWE data frames until the 
user presses Freeze, and UGAP data frames until the 
user presses Store (when Auto Measurement is set to 
Off).

7. Press assigned User Defined Key to exit Hepatic Assistant.
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Visualization

The below Visualizations are selectable in Utility.

• Dual view of UGAP and SWE

Figure 13-198. Example - UGAP/SWE (A/E)

• Dual view of UGAP Quality Map and SWE

Figure 13-199. Example - UGAP Q/SWE (A Qual./E)
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Visualization  (continued)

• Dual view of B-Mode and SWE to UGAP and UGAP 
Attenuation Map

Figure 13-200. Example - B/SWE & UGAP/UGAP A (B/E ¨ A/
Att.)
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Visualization  (continued)

• Dual view of SWE Quality Map and SWE and dual view of 
UGAP Quality Map and UGAP 

Figure 13-201. Example - SWE Q/SWE & UGAP Q/UGAP (E 
Qual./E ¨ A/Qual.)
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Visualization  (continued)

Dual view of SWE Quality Map and SWE to UGAP Quality 
Map and UGAP Attenuation Map

Figure 13-202. Example - SWE Q/SWE & UGAP Q/UGAP  
(Qual./E -> Qual./Att.)
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EZ Imaging

Overview

EZ Imaging provides an efficient workflow to complete exams 
with minimal operator button input. EZ Touch Panel allows the 
operator quick access to change model, flow modes and 
Doppler modes without searching through multiple pages or 
many different parameters.

Quick Patient Change allows you to start a new exam without 
entering the patient page.

Activate EZ Touch Panel

1. Check EZ Touch Panel Page in Utility > System > System 
Imaging > EZ Settings. 

2. Select “By Probe” (Default) or “By Category” for MyPreset 
Shortcuts.

Figure 13-203. EZ Settings
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Activate EZ Touch Panel  (continued)

3. EZ Touch Panel appears on the first page of B, flow and 
Doppler mode tabs.

Figure 13-204. B-Mode - EZ Touch Panel (Example)

1. MyPreset Shortcuts

• Change model quickly on the Touch Panel.

2. Image Shortcut

• Change imaging frequency (Res > Gen > Pen). (Frequencies are not 

editable.)

3. Essential Control: Virtual Convex, Biopsy, Max Angle

4. MyPreset Shortcut: Last used or current model is displayed in the 4th 

position.

5. Essential Control: Configurable essential control is displayed in the 4th 

position. You can assign a desired control in the 4th position.
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Activate EZ Touch Panel  (continued)

Figure 13-205. Flow Mode - EZ Touch Panel (Example)

1. Flow mode buttons

• Change Flow Technology quickly on the Touch Panel.

2. Flow Shortcut

• CF/PDI: Displays available existing shortcuts.

• B-Flow/MVI: No shortcut.

3. Essential Control

CF/PDI/MVI: Virtual Convex, Invert, Simultaneous

B-Flow: Virtual Convex, Biopsy, Max Angle

4. Essential Control: Configurable essential control is displayed in the 4th 

position. You can assign a desired control in the 4th position.



Advanced Features

13-402 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Activate EZ Touch Panel  (continued)

Figure 13-206. Doppler Mode - EZ Touch Panel (Example)

1. Doppler mode buttons

• Change Doppler Technology quickly on the Touch Panel (if both PW 

and CW are supported).

2. Essential Control (Non-Configurable)

• Invert, Sweep Speed, SV Length (for PW)

• Wall Filter, Sweep Speed, Colorize (for CW)

3. Essential Control (Configurable)

Configurable essential control is displayed in the 4th position. You can 

assign a desired control in the 4th position.
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Activate EZ Touch Panel  (continued)

4. Switch to conventional Touch Panel by selecting to turn the 
Touch Panel page.

 Figure 13-207. Switch between EZ Touch Panel and Conventional Touch Panel
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MyPreset Shortcuts “By Probe”

 Figure 13-208. By Probe

• TOP 3 models on My Preset for the probe is displayed on the Touch Panel. 

•  * (Asterisk) indicates the preset appears on the MyPreset Shortcut.
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MyPreset Shortcuts “By Category”

 Figure 13-209. By Category

• TOP 3 models in same exam category on My Preset for the probe is displayed on the Touch Panel. 
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Quick Patient Change

1. Complete current patient exam.

2. Press the BT key assigned to Quick Patient Change.

3. All Patient data is stored for the current patient and the 
Patient ID for the next patient is generated automatically.

NOTE: If you turn off Auto Patient Archive, a Confirmation Dialog 
for Data Archive appears. Select Store All, Delete All, or 
Cancel.  

Figure 13-210. Confirmation Dialog for Data Archive

4. An information dialog displays to inform the user that the 
patient has been created.

Figure 13-211. Information Dialog

5. Start the exam for the new patient. The B-Mode screen 
displays with the default preset for the connected probe. 
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Anonymize the  patient

Overview

The LOGIQ Fortis offers an option to extract all measurements 
and DICOM tags from a selected patient in the Patient List when 
that patient is not active. This option makes the exam(s) 
anonymous and attaches this information to a newly created 
Anonymous Patient.

The LOGIQ Fortis warns the user on possible data loss, data 
mismatch and data that cannot be copied anonymously, 
including:

• Image data may have patient information burned into the 
pixel data.  This information wil not match the updated 
patient data in the DICOM tags.

• Patient identification on image pixel data which the user 
annotated. This information cannot be removed.

• Links to Reports will be lost.

• Non-ultrasound exams will not be anonymous.
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Anonymize the patient

1. Ensure that you are logged in as an Administrator on the 
system. 

2. Select the Local Archive dataflow. 

3. Select the patient from the Patient View list and left click to 
bring up the “Anonymize” pop-up menu.

4. A confirmation dialog displays. Select OK.

5. The “Anonymize Patient” dialog displays. All the fields 
inherit the values from the original patient’s exam, except for 
Patient ID.

Fill in the Patient information fields. 

Press OK to continue.

NOTE: If the newly entered Patient ID is not unique in the database, 
the Patient ID turns to red and an error message displays on 
the status bar.

• Empty Other DICOM Tags: Check to clear all DICOM 
Tags.

• Manage DICOM Tags: Manage DICOM tags dialog 
displays. Select DICOM tags individually.

 Figure 13-212. Manage DICOM Tags
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Report Writer

Introduction

The LOGIQ Fortis enables the generation of patient reports 
based on the examination performed and the analyses that were 
made during the exam. The reports are generated using the 
data stored in the system with pre-selected templates.

You may edit a report while performing the exam; customize, 
delete, or add measurements; and save changes until you use 
the Store command. Once Stored, the reports are read-only.

It is recommended that the data be saved often, and then 
carefully reviewed before the report is Stored. Use the 
worksheet to facilitate the review and adjust data before storing 
a report. The final report can be printed on a standard printer.
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Creating a report

Reports summarize the data obtained in the examination. They 
can contain data, images, and cine loops.

Once generated, the report can be viewed, images can be 
added, and the patient’s personal data can be modified. The 
examination data itself CANNOT be changed.

Figure 13-213. Report Example

Name : GE Test     Patient ID : 123-4567            Date : 07/09/2004

Comments

Test exam
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Activating the Report

1. Select Reports on the Touch Panel. 

2. The system displays the default report for the current 
application on the monitor. 

The information entered during the examination is 
automatically filled in the appropriate fields (e.g. 
demographic, diagnosis, comments).

The preview image appears when the cursor is over the 
clipboard image.

NOTE: The template is the skeleton of your report. It is composed 
of different objects that can be customized by the user.

3. Adjust the Page Change control to move down the page.

 Figure 13-214. Report Page Example
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Activating the Report  (continued)

Table 13-77:  Report Button Controls

Button Description

Print Prints out the report to the default printer.

Store Stores the report page into Archive as CHM* file.

Retrieve Retrieves the report page from Archive.

Stored Date/Time is appended to the name of stored report.

Template Selects template from the list of selected applications. 

Designer Accesses template editor screen.

Save As Exports the report page to storage media as CHM or PDF format. 

Delete Deletes the report page from Archive.

Worksheet Accesses Worksheet Page.

Graph Accesses OB Graph page (applies only to OB).

Anatomical Page Accesses Anatomical Survey page (applies only to OB).

*CHM is a compressed HTML help file.
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Selecting another template

You can select another template for the current patient:

1. Select TEMPLATE at the bottom of the monitor display or 
the Touch Panel.

2. A list of available templates and exam categories 
(Abdomen, Adult, Carotid, etc.) displays.

3. Select the desired template using the Trackball/Trackball 
and press Set.

The selected template displays on the monitor.

NOTE: If you select another exam category, the template list of the 
selected category displays. Select the desired template.

Figure 13-215. Available Template list

4. Select the desired template name and press Set.

5. The report changes to the selected template.
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Factory Templates

The system has factory templates for each application. You can 
modify these templates or create user-defined templates. You 
need to save revised/new templates with unique names. 

A template may include one or more of the following:

• Measurements

• Worksheet or Vessel Summary Images

• Anatomical Surveys or Biophysical Profiles

• Anatomical Graphics

• Graphs

• Images areas

• Score Boxes

NOTE: Additional factory templates can be added from the 
Utility-->Report menu (OB for multiple gestation, Renal, etc.). 
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Editing a Report

Entering the hospital address

When using a factory template, the area for the hospital 
information is usually placed in the upper portion of the report.

To make a new area, see ‘Fixed Text’ on page 13-453 for more 
information.

To modify the factory template:

1. Select Reports.

2. Select Designer.

3. Double-click on the area for the hospital information in the 
template. The Fixed Text dialogue box displays.

Figure 13-216. Fixed Text Dialogue Box

4. Make changes as necessary.

a. Enter the hospital address in the text area.

b. Modify Box Properties (box width, box border line width, 
text align, box height, box left margin, and font).

5. Select OK.
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Entering the hospital address  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
appends “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and appends “[user]”. 
For example, NewReport[user].

7. Exit the Report Designer. The report with the hospital 
address displays.



Report Writer

LOGIQ Fortis – Basic User Manual 13-417
5855997-1EN Rev. 3

Inserting the hospital logo

When using a factory template, the area for the logo is usually 
placed in the upper left portion of the report.

To make a new area, see ‘Fixed Text’ on page 13-453 for more 
information.

To modify the factory template:

1. Save the preferred hospital logo in either a jpeg or bmp 
format on a CD.

NOTE: Label the logo with a unique name (e.g. 
HospitalNameLogo.bmp).

2. Insert the CD into the CD/DVD drive.

3. Select Reports.

4. Select Designer.

5. Double-click the GE Logo so that the frame is highlighted. 
The logo box displays.

Figure 13-217. Logo Box
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Inserting the hospital logo  (continued)

6. Select Import Logo (1). Select the CD drive first and then 
the  hospital logo.

7. Select OK. The hospital logo displays in the logo list (2). 
Click the logo to select.

NOTE: Scroll the logo list using the left/right arrow key (3).

8. Modify Appearance (4).

9. Select OK.

10. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

11. Exit the Report Designer. The template with the hospital 
logo displays.

NOTE: If a different logo prints on the report, rename the logo image 
which you want on the report and insert it into the report 
template again.
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Changing the Archive Information

When using a factory template, the Archive Information is 
usually placed below the hospital name and logo. 

The contents of the Archive Information is inserted through the 
related page automatically. If you want to change the 
description, such as Information or Comments that was entered 
in the patient menu:

1. Select the yellow text to be changed, e.g. Information or 
Comments.

The area where the description was entered (e.g. Patient 
menu) displays.

2. Change the existing data as necessary.

3. Select Report to return to the report.

Figure 13-218. Patient Information Area (Example)
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Modifying the displayed objects of Archive Information

1. Select Designer.

2. Double click on the area for the Archive Information in the 
template. The Archive Information Box displays.

Figure 13-219. Archive Information Box

3. Click the checkboxes to select and deselect the objects. 

Objects with checkmarks will appear in the report template.

4. Select Box Properties to change the font, font size, font 
color, or box size, and select OK.

5. Select OK to return to the Report Designer.
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Modifying the displayed objects of Archive Information  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

7. Select File -> Exit to leave the Report Designer.

Entering free text

You can enter free text to the report using the alphanumeric 
keyboard.

The factory template terms their text area as “Summary or 
Comments”. 

1. Move the cursor to the text field and press Set.

NOTE: You can enter the text only to the field set as free text in the 
Report Designer.

NOTE: DO NOT enter “%s” in a free text field and then try to edit/
save the template in the Report Designer. 

2. Type the text.
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Inserting Text

1. Select Designer.

2. Move the cursor where the text is to be inserted and press 
Set.

3. Select the Text Field from the Insert menu. The Text Field 
dialog box displays.

Figure 13-220. Text Field Dialogue Box

4. Select the appropriate display items:

• Ref. Reasons: Retrieves this information from the Direct 
Report

• Comments: Retrieves this information from the 
Comment field of the patient screen and the Exam 
Comment field of the worksheet.

• Diagnosis: Retrieves this information from the Direct 
Report

• Free Text 1 - 8
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Inserting Text  (continued)

5. Type the heading Text.

6. Modify box properties, the heading text and font, and data.

7. Select OK or Cancel. 

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

Inserting an image to the report

Some factory templates include an image area. If you want to 
insert or modify the image area, see ‘Image Display Fields’ on 
page 13-445 for more information.

To insert images from clipboard into the image field of the report:

1. Move the cursor to the desired image on the clipboard.

NOTE: The preview image appears when the cursor is over a 
clipboard image.

2. Press and hold down the Set key and drag the selected 
image to the report by using the Trackball or double click 
the Set key on the desired image. 

3. To move images between image areas, press and hold 
down the Set key and using the Trackball, drag the 
selected image to the new location.

To remove an image from the report, press and hold down 
the Set key and using the Trackball, drag the select image 
back to the clipboard.
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Measurement result section

Measurement results for the current patient display 
automatically if you have the measurement section in the report 
template.

The factory template has an appropriate measurement result 
area. If you want to insert or modify the measurement area, see 
‘Measurements’ on page 13-451 for more information.

 Figure 13-221. Measurement section
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Inserting the worksheet

You can insert the worksheet (like you can insert an image) to 
the image display field.  To set an image display field in the 
report template, see ‘Image Display Fields’ on page 13-445 for 
more information.

1. Display the worksheet on the monitor display.

2. Save the worksheet using the Print key.

3. Press Report.

4. Drag the worksheet into the report.

a. Move the cursor to the desired worksheet on the 
clipboard.

b. Press and hold down the Set key. Use the Trackball to 
drag the selected worksheet into the Image Display 
Field.

c. Release Set.

NOTE: You can also move the cursor to the desired worksheet on 
the clipboard, double-click the worksheet, move the cursor 
to the Image Display Field, and select Set.

5. The worksheet displays on the report.

NOTE: You can double-click the worksheet in the report to change 
the background color to white to save ink during printing. 
Double-click the worksheet again to return the worksheet to 
the original color.
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Placing objects side-by-side

If you want to place images, the image and comment, 
anatomical graphic and comment, etc. side-by-side, you must 
first place a table, which has two (or more) columns, into the 
report template.

1. Select Report.

2. Select Designer to display the Report Designer.

3. Place the cursor where you want to insert the object.

4. Select Table from the Insert menu. Insert Table box 
displays.

Figure 13-222. Insert Table Box

5. Set the number of columns to 2 (or more, as required) and 
change the table parameters, if needed. Select OK.

NOTE: If you do not need a table border, set the Border to 0. Add 
additional rows if required.

6. Place the cursor in the column and select the desired items 
from the Insert menu (e.g. logo, image, free text). Specify 
those items.

7. Repeat step 6 for each column as required.

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 
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Placing objects side-by-side  (continued)

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

You can insert the images in the order preferred, by row or 
column, on the factory templates. See ‘Inserting the Table’ on 
page 13-437 for more information.



Advanced Features

13-428 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Accessing Worksheet, OB Graph and Anatomical Survey Pages

If the Worksheet, OB Graph, and/or Anatomical Survey pages 
have been saved for the current patient, you can access these 
pages from the report page.

NOTE: OB Graph and Anatomical Survey pages applies to OB, GYN 
and Abdomen.

1. Select either Worksheet, Graph or Anatomical Page on 
the Touch Panel.

NOTE: There is also Fixed Text set up as hyperlinks for these 
pages. Cursor to the fixed text and press Set.

2. The system displays the appropriate page (Worksheet, OB 
Graph or Anatomical Survey) with the corresponding Touch 
Panel.

3. Select Report to return to the Report page.

Storing the Report

1. Select Store.

The Report is saved as a CHM file to Archive. 

NOTE: The archived report cannot be edited; therefore, it is 
recommended that the data is carefully reviewed before the 
report is saved.

Retrieving an Archived Report 

1. Select Retrieve. The Retrieve menu displays.

Figure 13-223. Retrieve Menu (Prefix “User1\” may not 
appear)

2. Select the desired report and press Set.

NOTE: The retrieved report cannot be edited.
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Deleting a Report from Archive

1. Select Delete. The Retrieve menu appears on the screen.

Figure 13-224. Delete Reports Menu (Prefix “User1\” may not 
appear)

2. Select the report to delete and press Set.

Printing the Report

To preview the Print Layout before printing, see ‘Preview the 
Print Layout’ on page 13-435 for more information.

NOTE: Double-click the worksheet and/or image in the report to change 
the background color to white A white background will save ink 
during printing. Double-click the worksheet or image again to 
return to the original color.

1. Select Print to print out the report.

The Report is printed on the default printer.
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Exporting the Report to Media

1. Select More.

2. Select Save As.

The Save As dialog box appears on the screen.

3. Enter the Report title and select the file format.

4. Select the media to export the Report. The system supplies 
a name (numeric DICOM UID, unique identifier).  

Figure 13-225. Save as Dialog Box

5. Select Save.

Exiting the report

1. Select Store to save the report.

NOTE: If the user is working on a report and leaves the report 
screen for any reason, all information added to the report is 
automatically saved without loss of data.

2. Select another key to close the report page.
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Designing Your Own Template

Template Designer

You can design and create your own customized template from 
a blank template page, or you can use an existing template 
(factory or user-defined) and save the changes.

Display the desired template and select Designer to open the 
Template Designer page.

 Figure 13-226. Report Designer
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File Menu

Create a new  template

To design a new template without using a pre-existing factory 
template:

1. Select Designer to open the Report Designer.

2. Select New from the File menu, and press Set. 

The blank template displays.

3. Create the report template as needed.

4. Select Save from the File menu, and press Set.

The Save Template As dialogue box displays.

5. Enter a template name and click OK.

6. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

Table 13-78:  File Menu

Description

New Creates a new template. A blank template appears. 

Save Overwrites the existing template.

Save As Saves as a new name.

Page Setup Enters Print Layout screen.

Print Preview Executes print preview.

Exit Exits Report Designer page.
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Create a new template and save as a factory template name 

To design a new template by modifying an existing factory 
template and keeping the same name of the factory template:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. To save changes, select Save from the File menu, and 
press Set.

The Save Template dialog box displays.

• Yes: Saves changes.

• No: Does not save changes.

• Cancel: Returns to Report Designer.

NOTE: The template name displays in the template list, retains the 
same name, and adds “[user]”. For example, 
“OB23-Basic[user]”. You do not lose the original factory 
template.

5. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

HINTS Save changes frequently as you modify your template. Saving 
often reduces the risk of losing all your changes.
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Create a new template and save  with a new name

To design a new template by modifying or copying an existing 
factory template and saving it with a new name:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. Select Save as from File menu and press Set.

 The Save Template As dialog box displays.

5. Type the new template name and click OK.

6. Select Exit from the File menu and Set.

7. The Report Designer closes and returns to the Report Page.

NOTE: The template receives the new name and adds “[user]”. For 
example, NewReport[user].

Page Setup

1. Modify the factory template as necessary in Designer.

2. Select Page Setup from File menu and press Set.

3. Change the paper size or orientation to fit the print layout, as 
necessary.

To define the header and footer for the printed report, type 
text and enter the required variables listed in the table 
below. Select “Different for first page” and enter a specific 
header/footer for that page.

NOTE: Default is left aligned. Report will appear as black ink on 
white background.

Table 13-79:  Variable and Definition

Variable Definition Variable Definition

{pid} Patient ID {prt} Current time (printing time)

{pnm} Patient name {cp} Current page

{pbd} Patient date of birth {tp} Page count

{exd} Examination date {c} Subsequent text is centered

{prd} Current date (printing date) {r} Subsequent text is right aligned.

{inm} Institution name
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Page Setup  (continued)

4. Select OK or Cancel.

Figure 13-227. Page Setup with Header Example

Preview the Print Layout

1. Select Template to choose the Report Template.

2. The Print Preview screen displays.

If changes need to be made, select Close to exit the 
Preview page. Modify the template or return to the Report 
and modify the contents.

Edit Menu

Deleting a template object

1. Select the object to be deleted.

2. Select Delete from the Edit menu, and press Set. The 
object is deleted from the template.

Undoing the operation

1. Select Undo from the Edit menu, and press Set.

2. Repeat as required.

Table 13-80:  Edit Menu

Description

Delete Deletes the selected object from the report template.

Undo Restores the previous state(s) of the report template.
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Insert Menu

Inserting the Page Break

1. Place the cursor where the Page Break is to be inserted and 
press Set.

2. Select Page Break from the Insert menu and press Set. The 
page break line displays on the template.

NOTE: To edit the page break line, select the line and double click 
the Set key.

Table 13-81:  Insert Menu

Description

Page Break Inserts a Page Break.

Table Inserts a Table.

Logo Inserts a Logo Bitmap File.

Archive Info Inserts Archive Information.

Anatomical Graphics Selects anatomical graphics by category to be inserted into a field.

Anatomical Survey Selects OB, GYN or Abdomen.

Image Inserts the image display field to the template.

Wall Motion Analysis Selects Cut Planes, Bull’s Eye, or Score Table Box.

OB/GYN Selects OB Graph, Bar Graph or Anatomy.

Small Parts Selects Breast or Thyroid.

Measurements Inserts the measurement display field in the template.

Text Field Edits text field.

Fixed Text Enters any comments as Fixed Text.
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Inserting the Table

1. Place the cursor where the table is to be inserted and press 
Set.

2. Select Table from the Insert menu and press Set. The Insert 
Table dialog box displays.

Figure 13-228. Insert Table Dialog

3. Specify each parameter as required.

NOTE: To set the table border as not visible, set “Border” parameter 
to 0 (zero)

4. Select OK to insert the table or Cancel. 

NOTE: To insert/delete a row/column from the table or access table 
properties, double click the Set key in any empty area inside 
the table. A table menu appears with those options.
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Inserting Images in a Table

You can choose the order in which images are inserted into 
tables: by row (default) or by column.

Image Order by Row

The system default inserts images in the cells of the first row, 
then to the next row. 

Figure 13-229. Image Order—Row Preference 
(System Default)

1. Follow the instruction for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, insert an image box in each cell of 
the table.  

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the table.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed in the default order.
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Inserting Images in a Table  (continued)

Image Order by Column

If you prefer to have the image placement by column, images 
are inserted in each cell of the first column, then the next 
column.

Figure 13-230. Image Order—Column preference

In order to achieve the column preference, you need to create a 
table with 2 columns and 1 row. In each cell of this table, you 
need to insert another table.

1. Follow the instructions for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=1

2. After inserting the table, create a table inside each of the 
existing table’s cells.  

a. Move the cursor to the left column’s cell and press Set.

b. Select Table from the Insert menu and press Set.

c. When specifying parameters, specify:

No. of Columns=2; No. of Rows=1; Width=290 pixels.

Select OK. 

d. Repeat steps a-c for the next column.

3. Insert an image box to each table cell. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the 2  tables.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed with your column preference.
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Inserting Logos

1. Place the cursor where you want to insert the logo and 
press Set.

2. Select Logo from the Insert menu and press Set. The Logo 
Box displays.

Figure 13-231. Logo Box

3. Select a logo that you want to insert (1). or import a bmp or 
jpg file from the removable media (2). Scroll the images 
using the arrow key (3). Specify the appearance (4).

4. Select OK to insert the logo or Cancel.

Changing a logo:

1. Place the cursor on the logo to be changed and press Set 
twice. The Logo Box displays.

2. Select a different logo. If the desired logo is not shown, 
select Import Logo to import a different logo.

3. Specify the appearance.

4. Select OK or Cancel.
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Inserting Archive Information

Archive information contains all the objects from the different 
information menus (Patient, Exam, and Site Information). This 
box accumulates different information menu selections that can 
be grouped together and displayed in one table.

1. Place the cursor where you want to enter the archive 
information and press Set.

If you use a factory template, double click on the current 
archive information area to display the Archive Information 
Box.

2. Select Archive Info from the Insert menu and press Set. 
The Archive Info Box displays.

Figure 13-232. Archive Information Box

3. Type the Heading, select a heading link from the pull-down 
menu, and select the parameters you want to display in the 
report.
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Inserting Archive Information  (continued)

4. Select Box Properties to change the Font, Alignment, 
Appearance, etc.

NOTE: To set the same font to all fields, select Set All fields.  

Figure 13-233. Table Properties

5. Select OK or Cancel. The contents of the Archive 
Information is inserted to the related page automatically.

Figure 13-234. Patient (Archive) Information Example
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Inserting Archive Information  (continued)

Editing displayed Archive Information:

1. Select Designer.

2. Move the cursor to Archive Information field to be edited.

3. Press Set twice. The Archive Information Box displays.

4. Edit the heading, the Heading Link and Information 
parameters, as necessary.

5. Select OK to save or Cancel.
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Anatomical graphics

1. Place the cursor where you want to insert the Anatomical 
Graphics and press Set.

2. Select Anatomical Graphics from the Insert menu.

3. Select the desired category and press Set. The graphic box 
displays.

Figure 13-235. Anatomical Graphics Box Example

4. Select the graphic to be inserted to the template or import a 
bmp or jpg file from the removable media. Scroll the images 
using the arrow key. 

5. Select Appearance.

6. Select OK or Cancel.
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Image Display Fields

1. Place the cursor where you want to insert the image.

2. Select  image from the Insert menu and press Set. The 
Ultrasound Image Box displays.

Figure 13-236. Ultrasound Image Box

3. Type the Heading text, modify the box properties, and 
change the heading text font, as necessary.

NOTE: For no heading, type a Space in the Heading text.

To keep the monitor image appearance, the ratio of width to 
height (W:H) should be 4:3. So, basically 640:480 for large 
images and 300:225 for two side-by-side images.

4. Select OK or Cancel.

Cardiac Studies Wall Motion Analysis

1. Place the cursor where you want to insert the wall motion 
analysis and press Set.

2. Select Wall Motion Analysis from the Insert menu.
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Cardiac Studies Wall Motion Analysis  (continued)

3. Select and set up the desired parameter.

• Bull’s Eye

Figure 13-237. Bull’s Eye Dialog Box

 Figure 13-238. Bull’s Eye Report Example
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Cardiac Studies Wall Motion Analysis  (continued)

• Cut Planes

NOTE: The Cut Planes dialog box parameters are similar to the 
Bull’s Eye Dialog Box shown previously.

 Figure 13-239. Cut Planes Report Example

• Score Table Box

Figure 13-240. Score Table Box Dialog Box
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OB/GYN (OB and GYN Only)

The OB Graph, Bar Graph and Anatomy can be entered into the 
Report.

1. Place the cursor where you want to insert the graph or 
anatomy and press Set.

2. From the Insert menu, select OB/GYN. The selection menu 
displays.

3. Select the appropriate item as necessary. A dialog box 
displays.

• OB Graph

Figure 13-241. OB Graph Dialog Box

a. Select the Measurement and Fetus Number.

b. Check Fetus Trending and Fetus Compare, if 
appropriate.

c. Modify the Layout, if necessary.

d. Select OK
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OB/GYN (OB and GYN Only)  (continued)

• Bar Graph

Figure 13-242. Bar Graph Dialog Box

a. Select the exam and fetus number.

b. Modify the Layout, if necessary.

c. Select OK.

NOTE: The Bar Graph already contains default application 
measurements.
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OB/GYN (OB and GYN Only)  (continued)

• Anatomy

Figure 13-243. Anatomy Dialog Box

a. Type the Heading.

b. Select qualifiers from the pull-down menu.

c. Select “Add all” to copy all measurements to the right 
column

d. Check the box in front of the measurement you need in 
the left column and select “Add”. The select 
measurements copy to the right column.

e. To remove measurements you do not need, check the 
boxes in front of those measurements in the right 
column, and select “Remove” or “Remove all”.

f. If you want to modify the properties, select Box 
Properties and set required parameters.
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Measurements

Insert a field to display the measurements. The measured 
parameters displayed in the measurement display field are 
configured.

1. Place the cursor where you want to insert the measurement 
and press Set.

2. Select Measurements from the Insert menu and press Set. 
The Measurements Box displays.

Figure 13-244. Measurement Box

3. Type the Heading text, select the Filter Criteria and 
measurements from the tree, as necessary.

4. Select OK or Cancel.
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Text Fields

1. Place the cursor where you want to insert the text and press 
Set.

2. Select Text Field from the Insert menu and press Set. The 
Text Field dialog box displays.

Figure 13-245. Text Field Dialog Box

3. Type the Heading Text. If you do not need the heading, type 
a space.

4. Select Display item.

• Ref.Reason: Reason for Referral.

• Comments: Gets information from the Comment field of 
the Patient screen and the Exam Comment field of the 
Worksheet.

• Diagnosis.

• Free Text: 1 - 8

5. Specify the border of the Text Field and Font as necessary.

6. Select OK or Cancel. 

The text is saved automatically into the corresponding area 
selected on this dialog box.
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Text Fields  (continued)

Editing an existing text field:

1. Move the cursor to the Text Field to be edited.

2. Press Set twice. The Text Field dialog box displays.

3. Edit the heading, the settings, or font, as necessary.

4. Select OK or Cancel.

Fixed Text

1. Place the cursor where you want to insert the fixed text and 
press Set.

2. Select Text Field from the Customize menu and press Set. 
The Fixed Text dialog box displays.

Figure 13-246. Fixed Text Dialog Box

3. Type the text (e.g. hospital information, report title, or table 
title) and specify the border and font.

4. Select OK or Cancel.

Editing existing Fixed Text:

1. Move the cursor to the Fixed Text to be edited.

2. Press Set twice. The Fixed Text dialog box displays.

3. Edit the text, the border or font, as necessary.

4. Select OK or Cancel.
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Customize Menu

Page Color

1. To change the page color, select Page Color from the 
Customize Menu and press Set. The Color dialog box 
displays.

Figure 13-247. Color Dialog

2. Choose the desired color or create a new color.

3. Select OK or Cancel.

Table 13-82:  Customize Menu

Description

Page Color Changes the template color.

Preference The Preference menu for Archive Information field displays.
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Setting  Preferences

To set preferences for the Archive Information:

1. Select Preferences from the Customize menu and press 
Set. The Preference Box displays. 

Figure 13-248. Preferences Box

2. Select the information to be modified and set the desired 
preferences.

3. Select OK or Cancel.

4. Save the template.
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Direct Report

Direct Report

You can use Direct Report to enter Comments, Diagnosis, and 
Referral Reasons at any time during the examination that will be 
part of the final report. The comments are reflected on the 
Report if the Report is configured for those parameters. 

1. Select Direct Rep. on the measurement Summary window. 
The Direct Report displays on the left side of the monitor 
display.

Figure 13-249. Measurement Summary Window
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Direct Report  (continued)

2. The Direct Report displays on the left side of the screen.

Figure 13-250. Direct Report

1. Select the type of information

NOTE: Comments entered under Diagnosis appear in the Clinical 

Diagnosis section of the final report. Commentes entered under Referral 

Reasons appear in the Referral Diagnosi section of the final report.   

2. Create/insert pre-defined text

3. Text field

4. List of measurements completed 

The measurement results display on the Measurement Overview field.

Double Click: inserts value only for selected line, e.g. 5.98 cm

Shift + Double Click: inserts whole line for selected line, e.g. BPD 5.98 

cm 

5. Exits the Direct report
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Direct Report  (continued)

3. Select the appropriate parameter and type the free text with 
the alphanumeric keyboard or use Insert Text.

NOTE: You can configure the pre-defined text at the Utility Report 
screen.

a. Select Insert Text to display the Insert Text Window.

b. Use the Trackball to select the text to be inserted.

c. Press Set. The selected text displays on the Direct 
Report.

Figure 13-251. Full Insert Text Window

• New: Enters the new text

• Edit: Edits the existing text

• Delete: Deletes the existing text

• Close: Closes the insert text window

• More>>: Displays the Full Insert Text Window

• <<Less: Minimizes the insert text window

• Move up/Move down: Moves the text up or down

4. Move the cursor over the measurement result displayed in 
the overview window, and double click the Set key. 
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Direct Report  (continued)

5. Select Done at the bottom of Direct Report to exit.

If you configure the field of comment, diagnosis, referral 
reasons or Measurement on the Report, the text and/or 
measurement results entered in the Direct Report are 
automatically displayed on the Report.

 Figure 13-252. Direct Report and Report (Example)
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Report Presets

Utility Report Page

You can edit the report template, diagnosis code, and text on the 
Utility Report page.

Templates

Left Column: The list of all templates (Factory Default, User 
defined, etc) 

Right Column: The list of templates displayed on the template 
list.

Figure 13-253. Report Template Tab
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Templates  (continued)

• To insert the template on the template list:

a. Select the application which you want to insert into the 
template from the pull-down menu above the right 
column.

b. Select the category (categories) and/or the template(s) 
in the left column by the check the box.

c. Select the right arrow to copy the template to the right 
column.

• To remove the template from the template list but not from 
the system):

a. Select the template in the right column.

b. Use the left arrow to remove the template from the right 
column.

• To edit the template or to make a new template:

a. Enter Utility -> Report -> Template tab.

b. Select the appropriate template in the left column.

c. Select Edit Template. The Template Designer page 
displays.

d. Edit the template and save or save as with a new name.

If you use Save As with a new name, the new template 
is added to the left column. See ‘Designing Your Own 
Template’ on page 13-431 for more information.

• To delete the template:

a. Select the template to be deleted.

b. Press Delete.
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Templates  (continued)

• To export the template:

a. Insert the removable media in the drive.

b. Move the cursor to “Export Templates” and press Set.  
The available user-defined templates display in the 
Export Templates window.

Figure 13-254. Export Templates

c. Select the template(s) to be exported.

NOTE: To select multiple templates, use the Ctrl or Shift keys.

d. Select the desired removable media under the Select 
Target Device field.

e. Select OK.

f. Press F3 to eject the media.

HINTS Export templates to removable media (CDs, DVDs, USBs) so, 
at a later time, you can import those templates to a different 
system or a system with a different software version.   Export 
only works on templates, not data.
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Templates  (continued)

• To import the template:

a. Insert the removable media with the report template(s) 
to be imported.

b. Select Import Template. The Import Template window 
displays.

Figure 13-255. Import Templates

c. Select the Source Device from the pull-down menu. 
Select OK.

d. Press F3 to eject the media.

NOTE: Imported templates are stored in the User defined 
templates\General directory. 

• To move the template from the left column to the right, or 
from the right to the left:

a. Select the template to be moved.

b. Select the Right Arrow or Left Arrow button.

• To move the template up or down in the right column:

a. Select the template to be moved.

b. Press the Up Arrow or Down Arrow button.

HINTS Import templates from a different system or a system with a 
different software version.   Import only works on templates, not 
data.
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Comment Texts

You can edit the comment text on the Comment Texts tab.

 Figure 13-256. Comment Texts Tab

• New: Enters the new comment.

• Edit: Edits the existing comment.

• Delete: Deletes the existing comment.

• Move up/Move down: Moves the comment up or down.
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Backup/Restore Report Templates

Backup moves templates to removable media (CDs, DVDs, 
USBs).

Restore moves templates, that were backed up onto media, to a 
similar system or a system with the same software version. For 
example, it allows templates to move from one LOGIQ Fortis to 
another LOGIQ Fortis.

To backup the report template:

1. Select Utility.

2. Select System and select the Backup/Restore tab.

3. Select the media.

4. Check User Defined configuration box of the Backup field.

5. Select Backup.

6. Select Save and eject the media.

To restore the report template:

1. Insert the media.

2. Select Utility.

3. Select System and select Backup/Restore tab.

4. Check Report Template box of the Detailed Restore of User 
Defined.

5. Select Restore.

6. After the system reboot, select Utility and Report.

7. Select the Template tab.

8. Select the appropriate template (See ‘Templates’ on 
page 13-460 for more information.)
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Configuring DICOM

Overview

If you follow these instructions, you will be able to set up a 
DICOM PACS environment suitable for a typical daily routine in 
a typical Ultrasound clinical environment: 

In these instructions, you will ensure that your LOGIQ Fortis and 
DICOM PACS are connected to and communicating back and 
forth on the hospital/clinic’s network and between the devices. 
We will be setting up the most commonly used DICOM features 
typically used in a clinical setting. 

NOTE: For additional information on the DICOM parameters, detailed 
information is provided in Chapter 10, Customizing Your 
System. 
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Step 1 - Set up the Network Addresses for the  LOGIQ Fortis

Get the following information from your IT Team for the Utility > 
Connectivity > TCP/IP page: 

Figure 13-257. TCP/IP Wired and Wireless Connectivity Setup

For the Wired Connection, provide the following: 

• Enable DHCP

• IPv6

And, 

• IP-Address

• Subnet Mask

• Default Gateway

• Primary DNS Server (optional)

• Secondary DNS Server (optional)

• MAC Address

• Speed (Mbps)

• On the Device page, add AE Title and Port Number for 
MyComputer. 

NOTE: For more information on configuring the Wireless LAN, refer to 
‘Configuring the Wireless Network’ on page 13-480. 

After you’ve filled in this information, press Save, then reboot the 
system. 
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Step 2 - Set up the PACS

Set up the PACS Device on the Utility > Connectivity > Device 
page.  The “Allow Trusted (Configured) Devices Only” is 
checked by default.  

Figure 13-258. Add Device(s)

1. Select NewDevice and click Add to find the PACS device.

2. Under Properties, provide the following information: 

• PACS Name

• PACS IP Address

3. Press Save at the bottom of the screen.  Verify the 
connection by pressing the ping face icon.  If a smiley face 
appears, the system is communicating with the PACS 
device and setup is complete.

NOTE: Supports TLS Encrypted and non-TLS Encrypted connections.
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Step 3 - Set up the DICOM Services for the Device

Specify which DICOM Services will be performed using this 
Device for images/clips sent by the LOGIQ Fortis via the Utility > 
Connectivity > Service page.  For all Services, you will need to 
provide the following information: 

• Destination AE Title (Case Sensitive)

• Port Number to be used by the Device

• Save your selections and Verify the Service before adding 
the next Service.

• Be sure to send test images, pull from the Worklist, query/
retrieve a patient’s exam, etc.

NOTE: For more information on the Use Button Settings DICOM 
Service Settings, see Chapter 10. 

HINTS Ensure the system’s date and time are correct. This can affect 
the system’s ability to pull the Worklist. 

Table 13-83:  Adding DICOM Services to the PACS

Step Screen

If you are setting up a DICOM Image 

Storage service, also provide the 

following information: 

• Indicate whether you want Structured 

Reporting enabled for this DICOM 

Device.

• Keep Default Values for the 

remaining fields.

If you are setting up a DICOM SR 

Storage service, fill in the required 

information. 
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If you are setting up a DICOM Query/

Retrieve, also provide the following 

information: 

• Add Search Criteria you will use to 

query/retrieve patient exams

• Fill in “US” to narrow the query/

retrieve search to Ultrasound exams

Note: You can leave this “Blank”, or 

“US”, “CT”, “MR”, etc., depending on 

the PACS. Confirm with your PACS 

Administrator Service Class User/

Provider. 

If you are setting up a DICOM Print 

service, also provide the following 

information: 

• Vendor

• Confirm Default Values for the 

remaining fields. 

If you are setting up a DICOM Worklist 

service, fill in the required information. 

If you are setting up a DICOM 

Performed Procedure service, provide 

the following information: 

• PACS’s AE Title (Case Sensitive)

• Port Number to be used by the PACS

Table 13-83:  Adding DICOM Services to the PACS (Continued)

Step Screen
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If you are setting up a DICOM Storage 

Commitment service, also provide the 

following information: 

• Associated Storage

Table 13-83:  Adding DICOM Services to the PACS (Continued)

Step Screen



Advanced Features

13-472 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Step 4 - Set Up a Typical Dataflow

Set up a typical “Routine” Dataflow specifying where you want 
your images/clips to be sent by the LOGIQ Fortis via the Utility > 
Connectivity > Dataflow page.  

 Figure 13-259. Add a Typical, Routine Dataflow

Provide the following:

• Press Add to specify the Name of the Dataflow. 

• Set the Default Dataflow to the new Dataflow (“Routine”). 

• Select the Device and Service to be included in the 
Dataflow. Use the arrows to move the Device and Service to 
the Dataflow View. 

HINTS The example below is more complex that you will probably 
encounter in your day-to-day workflow. In general, DO NOT 
add a device to the Local Archive - Int. HD. Also, DO NOT 
select Direct Store, as images could get stored to multiple 
locations, and each image is always stored by pressing the 
print key.  



Configuring DICOM

LOGIQ Fortis – Basic User Manual 13-473
5855997-1EN Rev. 3

Step 4 - Set Up a Typical Dataflow  (continued)

• Press Save, then Verify the Service you have selected 
under the Dataflow view by selecting the Verify button 
(“Smiley Face”). The Verify button checks the connection 
status with the server and the compatiblity with the PACS 
device.

If the connection status and compatibility with the PACS 
device are successful, the Verify button exhibits a smile and 
the Test Results area displays the compatible settings, 
along with Print button details (if Use Button Settings is 
enabled). (See Figure 13-259 on page 13-472.) 

If the connection status and compatibility results are 
unsuccessful, the Verify button exhibits a frown and the Test 
Results area displays the error with recommended actions. 
Examples of unsuccessful verify results are:    

• Connection to the server not established

• PACS device refuses service

• DICOM objects are not supported

• Configured compression is not supported

• Be sure to test the Dataflow.

HINTS • DO NOT use the default, “Store to Hard Drive”.

• DO NOT select Direct Store. Rather, send images/clips at 
the end of the study.
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Step 5 - Set up the Print Keys

Assign Services to a Print key on LOGIQ Fortis via the Utility > 
Connectivity > Button page.  

HINTS • Print key behavior is also controlled under Utility > 
Application > Print Controls by Preset. 

• DO NOT also send to PACS because you have already 
configured this in the Default Dataflow (“Routine” in the 
example above). Also, it is not necessary to add a device 
to the button as it is already assigned to a dataflow. 

• The default setting for Clips is Raw Data with 
Compression. You can adjust this via the “Use Button 
Settings” selection. 

• Compression on the LOGIQ Fortis and the PACS should 
match, as this affects the size of the information stored on 
the LOGIQ Fortis. 

Table 13-84:  Configuring Print Keys

Print Key Configuration Example

The functionality of the buttons (P1, P2, P3, etc) can 

be defined under the Button Tab. The example to 

the right shows that when P1 is selected, any image 

information will be sent to the dataflow that is 

selected for that study. If the default dataflow is 

Routine, it will be stored to the hard drive and sent 

to the DICOM store device(s) defined by that 

dataflow. It will either go at the end of the exam or 

after the operator acquires the image, depending on 

whether it is defined as direct store or not. 

Typical P1 Selections: 

• Print 1 should go to Dataflow selected on the 

Patient information page. 

Note: The Printflow View box defines what each 

Print key will do. And below (still images, clips, 

volumes) defines the formatting.  

Note: P1 can be disabled to prevent accidental 

presses. 
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Typical P2 Selections: 

• This example to the right shows that P2 will be 

sent to the dataflow selected on the Patient 

information page and that still images will be 

formatted as secondary capture image of video 

area with no compression. The clips will be 

formatted as Raw Dicom with 85% JPEG 

compression and no multi-frame data added (this 

will be added upon export with the new Use File 

Settings). 

Typical P3 Selections: 

• The example to the right shows when the Print Key 

is not activated to do anything. 

Typical P4 Selections: 

• This print key is set to send to the dataflow 

selected on the Patient information page and also 

to send to whatever printer is set as default (BW 

printer or network printer). 

Table 13-84:  Configuring Print Keys (Continued)

Print Key Configuration Example
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Typical PrintScreen Selections: 

• You would not have to copy a Dataflow under the 

Printflow view, but rather, use a USB Flash Drive; 

you may need to use a format of Ultrasound image 

for Still Images. 

Table 13-84:  Configuring Print Keys (Continued)

Print Key Configuration Example
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DICOM Job Spooler

To check the status of each job, open the DICOM Job Spooler 
by pressing F4 (see Figure 13-260). 

 Figure 13-260. DICOM Job Spooler Active Jobs

The DICOM Job Spooler lists Pending, Active, Completed 
(identified as “Done”) and Failed jobs, with the status listed in 
the “Status” column on the far right. Select the desired job to see 
the job details in the Details Pane on the right side of the screen. 

Failed jobs will include an Error Description and 
Recommendations to correct the error in the Details Pane (see 
Figure 13-261 on page 13-477).

 Figure 13-261. DICOM Job Spooler Failed Job

NOTE: Deleting jobs from the spooler does not delete images from the 
hard drive. They can be re-sent via the “Send To” function on the 
Patient--> Patient View, Exam View, or Image Review.  
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Patient Menu DICOM Functionality

Additional DICOM functionality can be performed via the Patient 
Menu: 

Table 13-85:  Patient View Functions

You can also send studies to the DICOM destination 

by selecting Send To. :

And, access the Worklist or perform Query/Retrieve 

to/from the PACS via the Patient screen. To start 

Query/Retrieve  for a patient: Select the patient, 

select Query, the LOGIQ Fortis then displays a list 

of exams. Select the desired exam, then select 

Transfer. 

You can also specify which Dataflow to use on the 

Patient page. This is the dataflow that will be used 

for Copy to Dataflow on print keys.  
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Troubleshooting DICOM Connectivity Issues

• If you ping/verify the device and receive a frown, confirm 
with your IT Team that you are using the correct IP Address, 
AE Title, Port Number, etc. 

• If the image/clip is stuck in the Print Spooler, select the job 
and resend or send to an alternate device. 

For Detailed descriptions of every DICOM parameter, refer to 
Chapter 10 of the Basic User Manual’s (Configuration chapter). 
For more detailed instructions on setting up each DICOM page, 
refer to Chapter 3 of the Basic Service Manual (System Setup). 
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Configuring the Wireless Network

Wireless LAN (WLAN)

A Wireless Network (WLAN) is available on the LOGIQ Fortis. 
When the WLAN is active, an icon appears in the status bar to 
indicate whether the WLAN is installed or disconnected. See 
‘Network and Spooler Status Icons’ on page 13-484 for a 
description of the network icons.   
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Wireless LAN (WLAN) Specifications

The Wireless LAN (WLAN) supports the following network 
protocols: 

Supported Standards

• Conforms to IEEE 802.11 ac/a/b/g/n WiFi with Bluetooth 4.0 
Standard. 

• FCC Part 15 Class B

• Japan’s Radio Law

• R&TTE Directive

• Canada Requirements

Security Type (Encryption)

• None/Open

• WPA2-Enterprise

• WPA2-Personal

Encryption

• None

• WEP

• AES

Internet Protocol

• The LOGIQ Fortis supports IPv4 or IPv6. 

Intel declaration of conformity 

You can find the Intel Declaration of Conformity at this web link: 

https://www.intel.com/content/dam/support/us/en/documents/
network-and-i-o/wireless-networking/
9260NGW-EU-RED-DoC.pdf

https://www.intel.com/content/dam/support/us/en/documents/network-and-i-o/wireless-networking/9260NGW-EU-RED-DoC.pdf
https://www.intel.com/content/dam/support/us/en/documents/network-and-i-o/wireless-networking/9260NGW-EU-RED-DoC.pdf
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Wireless LAN (WLAN) Specifications  (continued)

Authentication

• None

• Microsoft PEAP using MSCHAP v2

• Cisco EAP/LEAP/PEAP

• Username/password

• Limited support for server certificate verification using 
pre-installed trusted root CAs

• Client certificates not supported

• User authentication/confirmation prompts not supported

Antenna

• 2 integrated internal wireless antennae

Radio Data Rate

• 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54, 08, 140, 246, and 
300 Mbps (Auto Rate Sensing)

Frequency

• 2.4 GHz to 2.5 GHz (CCK and OFDM Modulation)

• 4.9 GHz to 5.9 GHz (OFDM)

Country Compliance

The WLAN subsystem automatically detects location and 
adjusts the output to be compliant to country regulations.  The 
following is a partial list of countries that the product is compliant 
with:

• United States: FCC Part 15 Class B

• Canada: Industry Canada Radio Standards Specification 
(RSS) license-exempt

• European Union: Radio Equipment Directive (RED) 2014/
53/EU

• Japan: Japan Radio Law

• Brazil: National Telecommunications Agency (Anatel)

• Malaysia: Malaysian Communications and Multimedia 
Commission (MCMC)

• Singapore: Infocomm Development Authority of Singapore 
(IDA)
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Connecting to the WLAN 

To connect the LOGIQ Fortis to the WLAN,  

1. Press Utility --> Connectivity --> TCP/IP --> Wireless 
Network --> Configuration (located under Wireless 
Network). 

The Wireless Network Configuration tool appears. If 
enabled, Wireless Networks broadcasting in your area 
appear in the list.  

2. If necessary, check the box for “Enable Wireless 
Connection”.

3. Select the wireless network you want to use or set up. 

4. Press Connect from the bottom of the Configuration tool. If 
prompted, enter the correct settings for this wireless 
network.   

NOTE: If the WLAN fails to connect, review and/or recreate the 
Wireless connection on the Security Tab. 
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Network and Spooler Status Icons

The following icons identify network and spooler statuses: 

Table 13-86:  Network and Spooler Status Icons 

Network and Spooler Status Icons

Ethernet Active Ethernet Error Ethernet Active 

Spooler Active

Ethernet Active 

Spooler Error

Mobile

Mobile Error Mobile Bluetooth Mobile Wifi Spooler Active Spooler Active 

Error

Spooler Inactive Spooler Inactive 

Error

Wifi 1 Bar Wifi 2 Bars Wifi 3 Bars

Wifi 4 Bars Wifi Alert Wifi Spooler Active Wifi Spooler Error Wifi Error
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Adding a Wireless Network

To add a WLAN profile (even for a network which is not yet 
available), 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Security. The Wireless Network Configuration 
tool appears. Available Wireless Networks appear.  

2. Select the Security tab. 

3. Select Add...

4. Obtain and enter the correct information for each wireless 
network setting: 

a. Enter a Network Name (SSID), pre-select the security 
type, then press OK. 

A new window appears so you can enter the settings for 
this network. 

b. On the connection page, check the appropriate boxes 
based on how you want the LOGIQ Fortis to connect to 
this network. 

The LOGIQ Fortis attempts to connect to available 
wireless networks based on the options you enable. If 
multiple networks are available, connection attempts 
begin with the network appearing topmost on the list. 

c. Select the Security page. 

d. Select the Security Type from the available options. 

NOTE: Dialog boxes vary, depending on the Security Type 
selected. 

e. Select the Encryption Type from the available options. 

f. For Personal networks, enter the Network key. 
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Adding a Wireless Network  (continued)

g. For Enterprise networks, choose the network 
authentication method and press Settings. 

Detailed settings for Enterprise networks are complex 
and must be correct for the connection to succeed. 
Ensure you have all the required information/settings 
and work with your site’s IT Network Administrator as 
needed. 

NOTE: Credentials must be entered at this time. The LOGIQ 
Fortis does not support automatic prompting for user 
credentials. 

• For Microsoft PEAP networks, press Advanced and 
enter User authentication credentials (username and 
password). 

• For Cisco networks, enter user credentials in the PEAP 
Properties dialog after pressing the Settings button. 

NOTE: IMPORTANT: User credentials are not validated until 
you attempt to connect to the network. 

h. When you have correctly entered all required settings, 
press OK in the Wireless Network Properties dialog. 

Your settings will be validated and you may be 
prompted about certain settings which are not 
recommended or supported. 

Examples: “Automatic connection to unencrypted 
networks is not recommended. Reminder to enter user 
credentials for Enterprise networks.” 

i. If changes are necessary, press Customize. Make 
corrections, then press OK. Settings will be validated 
again. 

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel. 

Removing a WLAN

To remove a WLAN profile (even for a network which is not  
available), 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Security. The Wireless Network Configuration 
tool appears. Available Wireless Networks appear.  

2. Select the Security tab. 

3. Select Remove. 
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Customizing Wireless Network Settings

To customize an existing WLAN profile, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Security tab. 

3. Select Customize...

4. Obtain and enter the correct information for each wireless 
network setting: 

a. Enter a Network Name (SSID), then press OK. 

A new window appears so you can enter the settings for 
this network. 

b. On the connection page, check the appropriate boxes 
based on how you want the LOGIQ Fortis to connect to 
this network. 

The LOGIQ Fortis attempts to connect to available 
wireless networks based on the options you enable. If 
multiple networks are available, connection attempts 
begin with the network appearing topmost on the list. 

c. Select the Security page. 

d. Select the Security Type from the available options. 

NOTE: Dialog boxes vary, depending on the Security Type 
selected. 

e. Select the Encryption Type from the available options. 

f. For Personal networks, enter the Network key. 
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Customizing Wireless Network Settings  (continued)

g. For Enterprise networks, choose the network 
authentication method and press Settings. 

Detailed settings for Enterprise networks are complex 
and must be correct for the connection to succeed. 
Ensure you have all the required information/settings 
and work with your site’s IT Network Administrator as 
needed. 

NOTE: Credentials must be entered at this time. The LOGIQ 
Fortis does not support automatic prompting for user 
credentials. 

• For Microsoft PEAP networks, press Advanced and 
enter User authentication credentials (username and 
password). 

• For Cisco networks, enter user credentials in the PEAP 
Properties dialog after pressing the Settings button. 

NOTE: IMPORTANT: User credentials are not validated until 
you attempt to connect to the network. 

h. When you have correctly entered all required settings, 
press OK in the Wireless Network Properties dialog. 

Your settings will be validated and you may be 
prompted about certain settings which are not 
recommended or supported. 

Examples: “Automatic connection to unencrypted 
networks is not recommended. Reminder to enter user 
credentials for Enterprise networks.” 

i. If changes are necessary, press Customize. Make 
corrections, then press OK. Settings will be validated 
again. 

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel. 

Setting an IP Address

To set an IP Address (Static or Dynamic), select Utility--> 
Connectivity--> TCP/IP--> Properties. 
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Refreshing a WLAN

Refreshes the list of available Wireless Networks. To refresh the 
Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Press Refresh from the bottom of the Configuration tool. 

Managing Connectivity to a Wireless Network

You can control which wireless networks can be connected to 
and which networks are preferred over other networks. 

• Networks appearing on the Security page, Preferred 
Wireless Networks list are listed in decreasing preference. 

The network listed at the top of the list is the most preferred, 
and therefore the most likely to get connected. 

The network listed at the bottom of the list is the least 
preferred, and therefore the least likely to get connected. 

• Networks with the check box unchecked for automatic 
connection will never connect unless you manually press 
the Connect button.  

• Non-broadcasting networks will never connect unless the 
corresponding checkbox is checked; or, you manually press 
the Connect button.

• Once connected to a network, the system will not 
automatically switch over to a more preferred network 
unless the check box is checked. 

Monitoring the WLAN

If there are wireless network communication problems, you can 
monitor the wireless network events.

To monitor Wireless Networking events, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Monitor Tab.
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WLAN Diagnostics

If the wireless network is connected, you can run diagnostics to 
determine how well, or poorly, the network itself is working. The 
diagnostic information displayed can help pinpoint causes of 
networking problems. Tests which pass are shown in green; 
tests which fail are shown in red. 

To run diagnostics for the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Diagnostics Tab. 

3. Select Run Diagnostics. 

Repairing the WLAN

Occasionally you may need to repair a WLAN that has lost its 
connection to the LOGIQ Fortis. To repair the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Diagnostics Tab. 

3. Select Repair. 

NOTE: DO NOT cancel the Repair operation after you have 
selected to repair the Wireless LAN connection. 
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Available WLAN Channels

The available WLAN channels show availability of wireless 
connect points that the scanner can talk to. Each channel 
supports a finite number of users and has limited signal 
strength. This may effect the ability to connect, the throughput 
and the connection dropping out.

To check the available WLAN channels, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Properties Tab. 

3. Select Available Channels.... 

Disconnecting from the  WLAN

To disconnect from the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears.   

2. Select Disconnect. 
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Tricefy Uplink

Introduction

Tricefy is a cloud-based image viewer and a platform to archive, 
collaborate, and share. The Tricefy DICOM server may be used 
in the way any DICOM server on the product may be used, i.e., 
Print keys, Send To, etc. The corresponding DICOM 
destinations can be used via the Print keys. An internet 
connection is necessary for uploading data to Tricefy. 

NOTE: To engage in service offerings with Tricefy, confirm that your 
country has entered into an agreement with Tricefy. 

NOTE: Tricefy DOES NOT support IPV6 and cannot be used in 
conjunction with Tricefy. 

Figure 13-262. Tricefy Account
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Introduction  (continued)

The tab displays a general info area with a short description of 
Tricefy, an uplink ID, and an info badge for how to configure 
Print buttons on system setup (only available when an account 
is active). Furthermore the account area displays controls and 
information about the Tricefy account while the test connection 
area enables you to test a connection and gives detailed 
information about it.
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Uploading Exam Information to the Tricefy Cloud

Enabling Tricefy

1. To enable Tricefy, fill out the information on Utility --> 
Connectivity--> Tricefy. As soon as this option is enabled, 
relevant Tricefy items are displayed (e.g. email text field, 
Activate button,.... and options within the system setup to 
share or store data to Tricefy via the print key or status bar 
icons (described below). 

2. Enter your email address to register and click Activate 
account. (If you want to deactivate an active account, click 
Deactivate account.) 

3. Depending on the account status, different account 
information is displayed:

• green badge containing the account info, email address, 
account name, customer name and account status- 
account activated

• blue badge - information about a disconnected account

• orange badge - connection to Tricefy™ failed (due to 
timeout,...)

4. For testing the connection click Activate. Depending on the 
connection status, different information is displayed:

• green badge - connection ok

• blue badge - instruction for testing the connection (only 
displayed as long as Activate is not pressed)

• orange badge - connection failed

5. Upon success activation, you will receive an Uplink ID. 

NOTE: When tricefy is successfully activated an image storage and 
Query//Retrieve service will be created with port number 
8104. 
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Configuring Tricefy

1. Set up the Tricefy Service via Utility > Connectivity > 
Service. Set the DICOM Image Storage and Query/Retrieve 
ports to Port 8104. Refer to the DICOM sections in this 
chapter and in Chapter 10 for more information. Verify the 
service.

2. Set up a Dataflow for Tricefy. Refer to the DICOM sections 
in this chapter and in Chapter 10 for more information. Verify 
the Dataflow. 

3. Configure the Print buttons via Utility > Connectivity > 
button. Refer to the DICOM sections in this chapter and in 
Chapter 10 for more information. Verify the Print button(s). 
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Using Tricefy

You can send a patient’s exam to the Tricefy Image Storage 
service via the Exam Tab.

1. Select the patient’s exam and press the Send To button. 
Select the Tricefy Image Storage service. Press OK.  

You can check the job status by pressing F4 (DICOM Job 
Spooler).

You can confirm the exam is on the Tricefy Server via a web 
browser. Navigate to https://tricefy4.com. Log in with your 
account information. The patient and image(s) you sent are 
on the Tricefy cloud. 

2. To Query patient information on the Tricefy cloud, on the 
Patient page, go to the Data Transfer page. Select the Q/R 
radial button, then press Query. A list of patients on the 
Tricefy cloud is displayed. Select the patient you want to 
retrieve, then select Transfer. 
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Tricefy Icons

Tricefy icons are explained below. 

Tricefy Activation

Refer to Chapter 10 for more information. 

Table 13-87:  Tricefy Icons

Connection Icons Store Icons Share Icons

Connected to Tricefy. Ready to 

Store and Share

Upload Image to Tricefy Share Image with Patient via 

Tricefy. 

Disconnected from Tricefy. Upload CINE to Tricefy Share CINE with Patient via 

Tricefy. 

Registration incomplete. Upload 4D Image to Tricefy

Upload 3D Image to Tricefy
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Device Mgmt

Overview

Device Mgmt is a remote device management tool that enables 
bi-directional management capabilities on the device.

Device Mgmt allows Cloud management of system preset 
configurations to a fleet of systems on network, as well as one to 
one system preset configuration Cloud backup and restore. 

For Device Mgmt connectivity configuration and activation, see 
‘Device Mgmt Configuration’ on page 10-94.

NOTE: For Cloud operation please refer to Device Mgmt online user 
manual after sign-up at http://AVURI.gehealthcare.com/signup

Device Mgmt Fleet Management

Figure 13-263. Device Mgmt Fleet Management

An account on the Cloud with access to Device Mgmt is 
required.

1. Upload preset configurations for fleet of systems

2. On the Cloud, assign configuration to fleet of systems

3. Receive installation notification (on each system in the fleet)

4. Install preset configuration (on each system in the fleet)
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Device Mgmt Cloud Backup/Restore

Figure 13-264. Device Mgmt Cloud Backup/Restore

An account on the Cloud with access to Device Mgmt is 
required.

1. Backup to the Cloud

2. On the Cloud, assign configuration to restore to originating 
system

3. Receive restore notification

4. Restore on system

NOTE: Restoring to a system other than the originating system is 
not allowed.

NOTE: Cloud Backup jobs are queued and processed in the 
background and do not disturb user operation.
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Upload For Fleet and Manual Backup (Cloud Backup)

To upload preset information from the master system for the 
fleet:

1. Go to Utility > System > Backup/Restore.

2. Select Upload For Fleet.

3. Set Comment to identify configuration on the Cloud.

4. Press Upload.

5. The system displays the result in the status bar and the 
Notification dialog.

Figure 13-265. Upload For Fleet

NOTE: Upload For Fleet can share the preset configuration across 
Fleet, while Cloud Backup can restore only to the originating 
device.

NOTE: Upload For Fleet and Cloud Backup copies all “User Defined 
Configuration” to the Cloud.

NOTE: The user must have Device Mgmt Administration Group Rights 
to begin the Upload For Fleet.
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Backup Automatically (Local and Cloud Backup)

1. Check Backup Automatically under Local and Cloud 
Backup.

2. Press Save.

3. User Defined Configuration files are automatically backed 
up to Cloud when configuration is changed and then saved.

NOTE: Cloud Backup requires activation. Even if it is not activated, files 
will automatically copy to Local Backup.

NOTE: If the administrator (ADM) login password is reset and 
reconfigured, a manual backup should be created to save the 
ADM password change.

Manual Backup (Cloud Backup)

To backup user defined configuration for Cloud manually:

1. Go to Utility > System > Backup/Restore.

2. Select Cloud under Backup To/Restore From.

3. Check User Defined Configuration under Backup

4. Press Backup under Backup.

5. Set Comment to identify fleet configuration on the Cloud.

6. Press Backup.

7. The system displays the result in the status bar and 
Notification dialog.
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Assign Configuration to Fleet or to the Device (on Cloud)

Installation assignment for configuration files uploaded to the 
Cloud is performed on the Cloud (not on the device). 

• Upload For Fleet - Configuration files can be assigned to the 
Fleet (group of devices).

• Cloud Backup - Configuration files can be assigned only to 
the device where they were backed up from.

NOTE: Configuration files that have been uploaded to the Cloud with 
Upload For Fleet and Cloud Backup are displayed in different 
lists on the Cloud.
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Receive Installation Notification

When a configuration file is assigned for installation from the 
Cloud, the system displays a pop-up dialog notifying that a 
download is available by selecting the download icon in the 
status bar. The pop-up appears only at the following operation 
points, to avoid interrupting an exam:

• New Patient/End Current Patient

• Unlock Lock-screen

• Log off/Log on

The download icon also appears in the status bar.

Figure 13-266. Notification Dialog and Installation Icon

NOTE: The user must have Configuration Group Rights to begin the 
configuration download and installation. If the user does not 
have Configuration Group Rights, a Warning message is 
displayed (see Figure 13-269).
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Installation Dialog

Figure 13-267. Installation Icon

Selecting the Installation Icon in the status-bar initiates the 
Installation Dialog with three options:

• Install

• Delay Install Until Shutdown

• Download Only

• Discard

Figure 13-268. Installation Dialog

NOTE: Discard and Download Only are available only when the 
Installation is marked as optional on the Cloud. Otherwise, no 
Discard or Download Only buttons appear in the Installation 
Dialog.
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Installation Dialog  (continued)

NOTE: Installation requires Advanced Configuration Group Rights. If 
the user does not have Advanced Configuration Group Rights, 
selecting the Installation Icon displays a Warning.

Figure 13-269. Advanced Configuration Group Rights Warning
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Install

1. Select the Installation Icon in the status bar.

Figure 13-270. Installation Icon

2. Select Install.

Figure 13-271. Install

3. Select Continue to acknowledge. The configuration 
installation begins and the result is displayed.

Figure 13-272. Continue Install
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Install  (continued)

4. Select OK to restart.

Figure 13-273. Select to Restart System
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Delay Install Until Shutdown

1. Select the Installation Icon in the status bar.

Figure 13-274. Installation Icon

2. Select Delay Install Until Shutdown.

Figure 13-275. Select Delay Install Until Shutdown

3. Select Continue to acknowledge. Continue the exam.

Figure 13-276.  Continue Delay Install Until Shutdown

NOTE: Icon changes to “Delay Install Until Shutdown”.

Figure 13-277. Delay Install Until Shutdown Icon
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Delay Install Until Shutdown  (continued)

4. Press Power button to display Exit dialog.

5. Select Shutdown. Installation begins automatically and the 
result is displayed.

Figure 13-278. Shutdown to Begin Installation

6. When installation is complete the system will shutdown 
automatically. 

NOTE: If the installation fails for any reason, a notification will be 
displayed after the system restarts.
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Discard

1. Select the Installation Icon in the status bar.

Figure 13-279. Installation Icon

2. Select Discard.

NOTE: Discard is available only when the Installation is marked as 
optional on the Cloud. Otherwise, no Discard button 
appears in the Installation Dialog.

Figure 13-280. Select Discard

3. Select Continue to acknowledge.

Figure 13-281. Continue Discard



Device Mgmt

LOGIQ Fortis – Basic User Manual 13-511
5855997-1EN Rev. 3

Detailed Restore from Cloud

Download Only from Cloud

NOTE: Because Download from Cloud runs in the background, the 
download is already completed when selecting Install Icon.

1. Select the Install icon.

Figure 13-282. Install icon

2. Select Download Only which creates local backup of the 
preset.

Figure 13-283. Select Dowonload Only

NOTE: If installation of the preset is set as Mandatory, then the 
dialog enables only the Install or Delay Install until 
Shutdown.
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Download Only from Cloud  (continued)

3. Information displays when the download is completed.

Download completed. To install the downloaded 
configuration, go to Utility -> System -> Backup/Restore and 
select Cloud as the Location.

Figure 13-284. Download Completed

Detailed Restore From Cloud

1. Go to Utility > System > Backup/Restore.

2. Select Cloud as Location of Restore From

3. Select categories and press Detailed Restore under 
Detailed Restore of User Defined.

Restore from Cloud

1. Go to Utility > System > Backup/Restore.

2. Select Cloud as Location of Restore From

3. Select categories and press Restore under Restore.
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Cancel a Failed Job

1. Select Notification Icon.

Figure 13-285. Notification Icon

2. The notification dialog displays on the monitor. Select a 
failed job and press Cancel Selected Job. 

Figure 13-286. Select Failed Job

3. Select Continue on the dialog.

Figure 13-287. Warning Dialog

NOTE: Successful jobs are removed automatically after a period of 
time. Failed jobs are deleted automatically after 2 weeks.
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Icon and Notification

One of the following icons is displayed in the status bar:

When there is a notification, clicking on the icon displays a 
message (see Icon Message example below).

Figure 13-288. Icon Message

Table 13-88:  Device Mgmt Icons

Icon Description

Activated/Not Activated

Unread/Read Error message

Unread/Read Warning message

Unread/Read information
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Smart Device Apps

LOGIQ Apps

Smart Device LOGIQ Apps are available for Android devices 
(both a phone and tablet) via Bluetooth: LOGIQ Remote Control 
App and LOGIQ Photo/Barcode Reader App. 

Figure 13-289. Smart LOGIQ Apps Devices

NOTE: The communication between the LOGIQ Apps and the 
ultrasound system is Bluetooth which is a wireless, secure 
transmission. At no time is patient data stored on the device 
hosting the LOGIQ Apps. For the LOGIQ Photo App, photos are 
never written to a file, but rather directly transferred to the 
LOGIQ ultrasound system. Once on the ultrasound system they 
can be included with the diagnostic images sent to the 
reviewing/reading physician.
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LOGIQ Apps  (continued)

NOTE: DO NOT use the USB Ports on the LOGIQ Fortis to charge 
LOGIQ Apps devices as these devices are not approved 
devices to connect to a medical device. 

Connecting the Device

To link to the device: 

DANGER
 

DO NOT use the Smart Device Apps if the patient has a 
life-sustaining device, such as a pacemaker or defibrillator. 
Failure to follow this instruction could lead to interference with 
patient electronic device(s). 

Table 13-89:  Linking the Device to the LOGIQ Fortis 

Steps On LOGIQ Fortis On Device

1. Press the Mobile Icon on the 

LOGIQ Fortis that’s located 

on the display. 
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2. On the LOGIQ Fortis, the QR 

code appears on the display. 

3. On the device, press the 

LOGIQ Remote App. 

4. Follow the instructions on the 

device.  

a. Press “Connect.” 

b. Scan the QR Code with the 

device. 

Table 13-89:  Linking the Device to the LOGIQ Fortis  (Continued)

Steps On LOGIQ Fortis On Device
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5. Place the device in front of  

the LOGIQ Fortis as directed. 

“Scan QR code with your 

mobile application to pair and 

connect.” 

The LOGIQ Fortis and the device 

are now ready to pair. 

6. The device displays the 

Bluetooth pairing request, 

“Confirm passkey is ##### to 

pair with the LOGIQ Fortis.” 

Press OK.  

Table 13-89:  Linking the Device to the LOGIQ Fortis  (Continued)

Steps On LOGIQ Fortis On Device
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7. The Bluetooth icon on the 

LOGIQ Fortis is now paired to 

the device. 

8. The LOGIQ Remote 

application appears on the 

device. The Phone App and 

Tablet App displays are 

shown to the right. 

To switch to the LOGIQ Photo 

App, press the Camera icon 

located on the top of the remote 

device’s display. 

Note: The Camera Icon only 

appears if LOGIQ Photo App is 

already installed. 

Table 13-89:  Linking the Device to the LOGIQ Fortis  (Continued)

Steps On LOGIQ Fortis On Device
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To completely break the association between the LOGIQ Fortis 
and the device (unpair the device from the LOGIQ Fortis): 

1. Access the Utility-> Connectivity-> Miscellaneous screen. 

2. In the LOGIQApps section, select Unpair Bluetooth 

Devices. 

To disconnect the LOGIQ Fortis 

from the device, click on the 

“Bluetooth Connected to the 

Device” icon on the bottom of the 

display and select to disconnect.  

Or, 

You can press “Disconnect” on 

the Device. 

To Unpair a Device from the 

LOGIQ Fortis, press “Unpair 

Bluetooth Devices” via Utility> 

Connectivity> Miscellaneous> 

LOGIQ Apps. 

Table 13-89:  Linking the Device to the LOGIQ Fortis  (Continued)

Steps On LOGIQ Fortis On Device
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Assigning LOGIQ Apps to a User Defined Key

To assign LOGIQ Apps to a User Define key, select “LOGIQ 
Apps” to a User Defined key (restart needed)” via Utility> 
System> User Configurable Key.

Figure 13-290. Assign LOGIQ Apps to a User Defined Key

Using the Apps

Table 13-90:  Using Smart Device LOGIQ Apps 

Tablet/Phone Remote Control and Photo/Barcode reader Apps

1. LOGIQ Remote Control App

2. LOGIQ Photo/Barcode Reader App
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LOGIQ Remote Control App:  

Via the Tablet LOGIQ Remote Control App, you will 

be able to adjust the following controls: 

Depth, Gain (B-Mode, Color Flow Mode, PW 

Mode), Left/Right, Measure, Comment, Clear, 

Trackball, Freeze, Store, Color Flow Scale, and 

Cursor. 

Via the Phone LOGIQ Remote Control App, you will 

be able to adjust the following controls: 

Activate PW, CF, or B-Mode, adjust the Cursor, 

Freeze the image, and sent images to the P1 

control. 

Photo/Barcode Reader App 

You can use the LOGIQ Photo App to capture 

photos that will go to the patient’s exam and to use 

as a barcode reader to scan in patient exam 

information. 

Note: The photo does not go directly into the exam; 

instead the image must be stored from the LOGIQ 

Fortis. 

Note: The barcode scanner scans the barcode into 

the Patient ID field on the Patient menu. 

Table 13-90:  Using Smart Device LOGIQ Apps  (Continued)

Tablet/Phone Remote Control and Photo/Barcode reader Apps
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Barcode - Input Mode

Off

Enter the Patient ID using the keyboard.

Patient ID

Scan the barcode for the Patient ID or enter the Patient ID using 
the keyboard. 

Complexation

Patient demographics can be entered by scanning the barcode, 
or manually, using the keyboard.

To enter patient demographics manually with the keyboard 
(instead of the barcode), select Cancel.

1. Enter a string in the Input Data field by scanning from a 
barcode or typing with the keyboard.

2. Scan a sample barcode. The following items can be 
included in the barcode:

• Patient ID

• First Name, Last Name, Middle Name

• Birth Year, Month, Day

NOTE: The character length for Year is four characters, Month 
is two characters and Day is two characters. The Year, 
Month and Day should always be provided together.

• Gender
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Complexation  (continued)

3. Configure the Start and End position for each item.

NOTE: If the barcode does not contain information for an item, 
configure the Start and End position as “0.“

For example, if the scanned barcode is 
“000001LastNameFirstName191990101F,“ the 
configuration and results display as seen in Figure 13-291.

 Figure 13-291. Barcode Configuration Page Example
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Digital Expert

Digital Expert Remote Training

Digital Expert is a purchasable option which enables remote 
training between users and the GE Clinical Applications team, 
through scheduled and real-time sessions. Digital Expert is a 
self-contained, app-based companion solution, designed to pair 
with GE medical devices. Digtal Expert utilizes Intelehealth 
software for remote connectivity.

NOTE: This tool is not for clinical diagnostics purposes.

Digital expert also enables customer to customer Enterprise 
Collaboration, where users can connect with each other within 
their own network. This provides on-demand access for 
guidance and consultation for clinicians from in-house experts.

Refer to the user manual included with Digital Expert for 
information on setting up and using Digital Expert. 
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Service and Applications Support

GE Connect Guide

The GE Connect Guide helps the user follow the necessary 
steps to setup the InSite ExC connectivity. To use the GE 
Connect Guide to begin the GE Backoffice Connectivity 
Troubleshooting wizard: 

1. Select the Insite icon at the bottom of the display screen to 
open up the InSite ExC Icon Menu.

Figure 13-292. InSite ExC Icon Menu with Connection 
Unconfigured

2. Select GE Connect Guide from the menu to open the GE 
Backoffice Connectivity Troubleshooting wizard.
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GE Backoffice Connectivity Troubleshooting Wizard

Use the following GE Backoffice Connectivity Troubleshooting 
wizard screens to setup the GE Backoffice connection.

1. Agent Configuration - The Serial ID is displayed (not 
editable). Verify CRM ID; edit if necessary and save 
changes. Select Next.

Figure 13-293. Agent Configuration

2. Network Connection - Ensure you are connected to the 
Network with a wired or wireless connection. Select Next.

Figure 13-294. Network Connection

NOTE: If you are not connected to the network, see ‘TCP/IP’ on 
page 10-61.
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GE Backoffice Connectivity Troubleshooting Wizard  (continued)

3. Agent Proxy Configuration - Ensure proxy configuration 
details and credentials are accurate. Edit if necessary, save 
changes and select Next.

Figure 13-295. Agent Proxy Configuration

4. DNS Configuration - Ensure DNS is configured correctly for 
the system. Select Next.

Figure 13-296. DNS Configuration
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GE Backoffice Connectivity Troubleshooting Wizard  (continued)

5. Network Firewall - Ensure the network firewall in the facility 
is configured correctly to allow GE InSite communication. 
Select Next.

Figure 13-297. Network Firewall

6. Summary Page - The Summary page will check the agent 
configuration and connection status for all configuration 
steps. When the process completes (may take up to five 
minutes) the status for each step is listed as “OK” or “Not 
OK.” If any step is reported as “Not OK” select the step from 
the menu on the left and correct the information on that 
screen, then proceed to the Summary page again for a 
connection status update.

Figure 13-298. Summary Page
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Support Requests

InSite ExC

InSite ExC is your direct link with a GE Online Service Engineer 
or Applications Support Engineer by creating a Request for 
Service via the InSite ExC link at the bottom of the display 
screen.    

NOTE: The Insite connection must already be configured with the GE 
backoffice for the InSite ExC Menu to appear. See ‘GE Connect 
Guide’ on page 13-526 for more information. 

Figure 13-299. InSite ExC Menu

Types of InSite ExC Service

1. Contact GE - Opens a service dispatch with GE Service. 

2. Connect Clinical Lifeline - Sets the system in a state of 
readiness for Virtual Console Observation. 

3. Connect To GE - Initiates a connection to the GE 
Backoffice.
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Initiating a Request for Service (RFS)

To initiate an RFS: 

1. Position the Windows pointer on top of the GE InSite ExC 
icon at the bottom of the display. 

2. Press the Right Trackball Set Key. Select Contact GE. This 
opens the RFS screen which sends a service dispatch 
directly to the Remote Service or Applications Team after 
you fill in the following information: 

• Last Name, First Name, Phone Number

• Select correct Problem type

• Choose Problem area

• Type in Problem description

3. After you have completed filling in all of this information, 
press Send to initiate the Request for Service. 

You can confirm if your RFS has been sent as well as RFS’s 
automatically sent by the system. The LOGIQ Fortis can 
automatically submit a Request for Service. These are displayed 
on the Machine Queue. 

In addition, you can use the Users screen to identify your 
institution’s point of contact for service dispatches. 
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Initiating a Technical or Clinical Support Request

When the Remote Applications or Service person reaches you, 
they will ask you to you click on the InSite icon and choose 
either Connect to GE or Connect Clinical Lifeline, 

1. Position the Windows pointer on top of the GE InSite ExC 
icon at the bottom of the display. 

2. Press the Left Trackball Set Key. This opens the following 
pop-up:  

• Connect to GE,

• Connect Clinical Lifeline, or

• Cancel

3. Select the option the GE representative asks you to select.  

NOTE: SIelecting Connect to GE changes the polling time from 15 
minutes to 15 seconds so that your call can be answered as 
quickly as possible. Selecting Connect Clinical Lifeline also 
actives disruptive mode. 
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Initiating a Technical or Clinical Support Request  (continued)

InSite ExC icons appear differently, depending on their state: 

Table 13-91:  InSite Icons

GE InSite - Connected - Disruptive Mode - Enabled

GE InSite - Connected - Disruptive Mode - Disabled

GE InSite - Idle - Disruptive Mode - Enabled

GE InSite - Idle

GE InSIte - Not Configured

For more info on the configuring the connection to the GE 

Backoffice, see ‘GE Connect Guide’ on page 13-526. 
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InSite ExC Definitions

Here are definitions for the different InSite ExC states: 

Virtual Console Observation (VCO). Allows Technical Support 
to control LOGIQ Fortis functionality remotely. 

Disruptive. Allows GE’s Technical Support person to connect to 
your system via VCO, to run diagnostics directly on your LOGIQ 
Fortis system, and to collect system logs. When the system is in 
Disruptive Mode, the icons are red. There are two disruptive 
states. If you see a telephone with a clock, then the system is in 
Disruptive, Not Connected Mode. If you see a telephone with 
GE, then the system is in Disruptive, Connected Mode. 

Non-Disruptive. Allows GE’s Technical support person to look 
around on your system, but cannot perform any service-related 
functions, depending on whether InSite has connected or not 
connected. There are two Non-Disruptive states. If you see a 
black and white icon, InSite ExC is activated, but not open for 
Technical Support access. If you see a yellow icon, InSite ExC is 
activated and the Technical Support person can look around on 
your system, but cannot perform any service-related functions.  

Connected. InSite ExC is connected.   

Not Connected. InSite ExC is not connected. 

NOTE: When Disruptive mode has been activated or a diagnostic has 
been run, the message, “Service Mode is Activated. Reboot 
required before patient use” appears in red at the bottom of the 
display. It is recommended that you reboot the system before 
use. Make sure you disable disruptive mode before rebooting or 
the message will not be cleared.

Exiting InSite ExC

To exit InSite ExC: 

1. The GE Technical Support person will exit Disruptive Mode 
and VCO, then ask you to reboot your system. 

2. Reboot your LOGIQ Fortis system before patient use. 

For more information on InSite ExC refer to the LOGIQ Fortis 
Basic Service Manual.
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Service Desktop

Overview

The Administrator (and others granted the “Access Service 
Desktop” privilege) can access the Service Desktop to: 

• Access the Service Home Page. 

• Perform the following Utilities

• Change Password

• Data Transfer

• Delete Files

• SSA License

• Gather Logs

• View Third Party Licenses

• Disruptive Mode Utility

• View Installed Options

• InSite Agent Configuration

Figure 13-300. Service Desktop

For more information on Service Desktop, refer to the LOGIQ 
Fortis Basic Service Manual.

Accessing the Service Desktop

1. Select Utility and go to Page 2 of the Utility Menus. 

2. Select Service. 
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Battery Power Mode

Overview

The LOGIQ Fortis supports either the Power Assistant (PA) 
battery Option or the Scan on Battery option (ScoB). 

NOTE: Only GE Service personnel have access to the batteries. Please 
contact the technical service department or your local GE 
representative for replacement.
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Power Assistant Battery Option

Overview

With Power Assistant (PA), the system power is maintained by 
the batteries when AC power is lost or the power cable is 
unplugged. PA can reduce system startup time for portable 
exams. The system will be able to run for at least 20 minutes 
after AC power is disconnected. 

When the LOGIQ Fortis enters PA upon AC power loss, there is 
an initial temporary message stating that the system is “entering 
battery mode,” followed by a message that the system is 
“running on battery.”  

If an operation was interrupted by AC power loss, the system 
displays a notification letting you know which operations were 
not completed successfully. In this case, you will need to redo 
the operation that was interrupted, such as an Export, Import, 
Query Retrieve, etc. 

In PA mode, the following operations are allowed: 

• Media Format, Finalize, Verify

• DICOM Image Storage, Performed Procedure, Print, 
Storage Commitment, Query of Q/R, Worklist. 

Before starting Power Assistant Mode

NOTE: If the system is switched to Power Assistant Mode when any of 
the operations above are in progress, the system terminates the 
operation.

CAUTION The following operations must be completed before unplugging 
the AC cable. 

• Any access to the external media, such as CD, DVD, USB 
HDD via Export, Import, MPEGvue, Save As, EZBackup.

• DICOM Retrieve from Query/retrieve

• DVR recording should be stopped.

• Volume Navigation should be exited by Exit and Clear 
Control.

• System brightness and backlighting is also dimmed/
stopped. 

• Processing 3D/4D images in live.
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When in Power Assistant Mode

In Power Assistant Mode, most of the console devices, such as 
the keyboard and printers, are turned off to minimize battery 
usage.

NOTE: To shut down the system while in Power Assistant Mode, plug in 
the power cable, exit from Power Assistant Mode, and then 
perform regular shut down operations.

Recovering from Power Assistant mode

The system recovers from Power Assistant Mode when AC 
power is less than 10 seconds reconnected to the LOGIQ Fortis 
and the main breaker is on. The system returns to full 
functionality in 10 seconds.

CAUTION When in Power Assistant Mode, DO NOT perform the following 
operation:

• Connect and disconnect probes.

• Remove peripheral devices, such as the Volume 
Navigation unit.

• Eject or insert CD/DVD media and the external USB 
storage device.

Failure to follow these instructions could lead to exposure to 
unexpected acoustic energy or electrical interference/loss of 
patient data.
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Scan on Battery Option (ScoB)

Overview

Scan on Battery Option allows the user to scan using battery 
power (AC unplugged).

While running on the battery power, the LOGIQ Fortis can scan 
or perform post-processing and switch to Power Saving Mode.

With a fresh battery that is fully charged, the LOGIQ Fortis stays 
powered for approximately 50 minutes.

Before starting Scan on Battery

CAUTION The following operations must be completed before unplugging 
the AC cable. 

• Any access to CD/DVD.

• DVR recording to CD/DVD.

It is recommended to complete the following before unplugging 
the AC cable.

• Any access to the external media, such as USB HDD via 
Export, Import, MPEGvue, Save As, EZBackup.

• Any access to the Network device, such as DICOM 
transfer or Network Storage.

• Volume Navigation should be exited by Exit and Clear 
Control.

• Processing 3D/4D images in live mode.
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Before starting Scan on Battery  (continued)

Before starting Scan on Battery, go to Utility -> System > 
General page and select the appropriate value for “Auto Switch 
to Power Saving Mode” and “Freeze when AC is Unplugged” 
(Default: Off). 

Figure 13-301. Extended Battery for Scanning

Auto Switch to Power Saving Mode

• Select 15, 30 minutes or 1 hour to automatically switch to 
Power Saving Mode after the time specified on battery 
operation.

• Select “Never” to never switch to Power Saving Mode.

• Select “Always” to always switch to Power Saving Mode. 

Freeze when AC is Unplugged 

• On: When selected, the system goes into Freeze mode 
when the AC cable is unplugged. 
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Starting Scan on Battery

When the AC cable is unplugged from AC power, the system 
automatically transitions to Scan on Battery Mode.

NOTE: If the system does not transition to Scan on Battery Mode, 
contact the technical service department or your local GE 
representative.

 Figure 13-302. Warning message

Recommendation

Plug in AC power if possible, keep using the battery power can 
impact to the battery life.

When the battery capacity becomes low

The LOGIQ Fortis displays a dialog for the user to guide to 
switch to Power Saving Mode when the battery capacity 
becomes low. User can either keep scanning until the system 
shuts down or go to Power Saving Mode to extend time before 
shutdown.

WARNING Do not use Scan on Battery Mode when you need to 

handle (transfer/ export/ import) patient data. (Export/
Import/ Backup/ Burn Media, Dicom Transfer, etc.) The system 
can unexpectedly shutdown when the battery capacity is too 
low and result in patient data loss. Please note the message in 
the status bar when Scan on Battery is activated. It is strongly 
recommend to use AC power when transferring, importing or 
exporting patient data.
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Switch to Power Saving Mode

You can switch to Power Saving Mode by selecting “Switch to 
power-saving” in the battery status popup anytime you want.

Figure 13-303. Battery status pop-up

The LOGIQ Fortis allows going back to Scan on battery mode 
by pressing the Power button or Freeze button.

Figure 13-304. Dialog during Power Saving Mode

WARNING The system switches to Power Saving Mode automatically 
when the capacity is low.
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View current battery status

When the system is running under Power Assistant/Scan on 
Battery, battery icons appear in the title bar and on the status 
bar, indicating how much charge is left in the battery.

Battery Status Icon on the status bar

The system displays the battery’s current charge and posts a 
notification message on the display when battery power needs 
attention. 

Detailed battery information is available by clicking on the icon 
and display the popup, which includes the battery’s current 
capacity displaying.

Figure 13-305. Battery status pop-up

NOTE: When the Front Battery LED is blinking, the system is in standby 
mode and the batteries are charging. 

Table 13-92:  Battery status icons

Icon Description

No icon AC Plugged; no battery present

AC Unplugged; battery is fully charged (81 - 100%)

AC Unplugged; battery is partially charged (61 - 80%)

AC Unplugged; battery is partially charged (31 - 60%)

AC Unplugged; battery is partially charged (0 - 30%)
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AC Plugged; battery is fully charged (81 - 100%) and charging

AC Plugged; battery is partially charged (61 - 80%) and charging

AC Plugged; battery is partially charged (31 - 60%) and charging

AC Plugged; battery is partially charged (0 - 30%) and charging

Battery error icon

When an abnormal status of the battery is detected, the system displays the 

following icon:

• Battery Temperature error

• Communication error or battery charge error

NOTE: If this icon displays, do not initiate Power Assistant. Contact the 

technical service department or your local GE representative. 

Table 13-92:  Battery status icons (Continued)

Icon Description
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Battery status Icon in the title bar

Fuel Gauge icon appears in the title bar.

Figure 13-306. Fuel Gauge icon

NOTE: To avoid an unintended shutdown of the system, and to avoid 
risk of losing patient data, it is strongly recommended to connect 
to AC power when the fuel gauge icon is yellow or red.

Table 13-93:  Battery status icons (AC unplugged)

Icon Description Icon Description

91 - 100% 41 - 50%

81 - 90% 31 - 40%

71 - 80% 16 - 30%

61 - 70% 0 - 15%

51 - 60%
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Battery charging

NOTE: Whether the LOGIQ Fortis is on or off, the battery will charge as 
long as the system is connected to AC power via the power 
cable, and the break is on.

A fan will run while the battery is charging. The fan stops 
automatically when the battery is done charging.

While the battery is charging, the front battery LED will blink. 
When the battery is fully charged, the LED will stop blinking and 
remain on.

Figure 13-307. LED location of the battery

Approximate charging time (from empty to full)

• Power Assistant battery: About 2.5 hours

• Scan on Battery: About 2.5 hours
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Refreshing the battery

To maintain battery life and accuracy of the fuel gauge, and to 
avoid unexpected shutdowns, it is recommended to refresh the 
battery every 6 months with the following procedure:

1. Plug the AC cable to the wall outlet and turn on the circuit 
breaker.

2. Wait until the battery is fully charged. It takes about 2.5 
hours to fully charge the battery (depend on the remaining 
battery capacity).

3. Wait at least 1 hour.

4. Remove all probes.

5. Turn on the system.

6. Unplug the AC cable, letting the system run on battery until 
it automatically shuts down. It may take at least 30 minutes 
(Power Assistant Battery)/ 50 minutes (Scan on Battery) to 
complete shutdown.

7. Wait at least 5 hours.

8. Plug the AC cable to the wall outlet and turn on the circuit 
breaker.

9. Wait until the battery is fully charged. It takes about 2.5 
hours to fully charge the battery.
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Battery deterioration

When the system detects battery deterioration, the following 
dialog displays:

Figure 13-308. Battery life message

If this message appears, the LOGIQ Fortis disables both of 
Power Assistant and Scan on Battery. 

Contact the technical service department or your local GE 
representative.

Battery Disposal

Lithium Ion

Used batteries must be disposed of properly and as chemical 
waste. They cannot be treated as regular waste. Contact your 
building administration for proper disposal. 

NOTE: When removing a defective battery, ensure that it is disposed of 
in accordance with local regulations. Alternatively, provide it to 
GE for proper disposal.
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Magstripe Card Reader

Magstripe Magnetic Card Reader

The Magstripe Card Reader can be attached to the LOGIQ 
Fortis by connecting it to any LOGIQ Fortis USB port.

Figure 13-309. Magstripe Card Reader

The Magstripe Card Reader can be used in Patient screen, 
Worklist and Image Display.

• Patient screen: Patient ID, First Name, Last Name, Middle 
Name, Perf. Physician, Ref. Physician

• Worklist: Patient ID, Search String

• Image Display: Comments (Annotation)
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Footswitch

Wired Footswitch

You can attach this Footswitch to the system by connecting it to 
any USB port on the system. 

Figure 13-310. Footswitch and USB Cable

This is a 3-pedal Footswitch. You can configure its functionality 
via the Utility -> Applications -> Footswitch parameters. 

CAUTION When using the Footswitch, DO NOT hold down the footswitch 
pedal. Press and release the Footswitch pedal. Pushing and 
holding down the pedal behaves the same way as pushing and 
holding down a key on the keyboard. 
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DVR

Setting up the DVR

To set up the Digital Video Recorder (DVR), configure the 
LOGIQ Fortis PRIOR TO using the DVR since the system 
MUST BE restarted after updating these configuration 
parameters. 

1. Set up following parameters in Utility --> System --> 

Peripherals.  

• Media: DVD, USB

NOTE: Pre-format USB device as NTFS; pre-format DVD-R/
-RW/+RW as NTSC or Pal. 

• DVD Format: NTSC, PAL

NOTE: For DVD-RW, NTSC is preferred; for DVD+RW, Pal is 
preferred. 

• Picture Quality: HQ, SP, LP, EP

• Microphone Level: 1 to 5

• DVD Chapter Record Interval (sec.): 15, 30, 60, 120

• USB Playback Skip Interval (sec.): 15, 30, 60, 120

2. If needed, assign [DVR Record/Pause] to a Print key in 
following steps.

a.  Add [Video Capture] and select [DVR Record/Pause] 
as the Type, in Utility -> Connectivity -> Service.

b. Assign the [Video Capture] to the Print Button, in Utility 
-> Connectivity -> Button.

3. Restart the system. 

DVR functionality is now set to record the scan. 
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Using the DVR

1. Create a patient record or open an existing one.

2. Press the Video-assigned key.

3. Insert a DVD media or USB storage, which is selected as 
DVR media (Utility -> System -> Peripherals).

NOTE: There must be a formatted DVR-R disk installed in the 
system for Software DVR to record. 

NOTE: The DVD formatted using Utility > Connectivity > 
Removable Media is for data archiving; it cannot be used for  
DVR recording.

4. Press Record to start recording.

The status bar updates with the recording information. While 
recording, you can only pause or stop the recording and 
cannot perform any other DVR functionalities.

NOTE: Recording automatically pauses when you access the Utility 
screen.

NOTE: When more than one USB storage is connected, the DVR 
records to the first drive letter, in alphabetical order.

NOTE: The system does not start the recording while the following 
operation is in progress: Data Transfer, EZBackup, Utility 
screen.

5. Press Record or Pause to pause/resume recording.

6. Press Stop on the Touch Panel to stop recording.

When you stop recording, the DVR writes the title data. 
During this period of time, the busy state icon is displayed in 
the status bar (green arrow circling) and you cannot operate 
any DVR functionalities.

NOTE: It may take up to 2 minutes for the DVD-RW/DVD+RW to 
stop recording.

NOTE: The DVR automatically stops recording before the media 
fills up.

7. Press Eject on the Touch Panel or the F3 key to eject.

8. Press Scan tab to return to scanning.

WARNING Loss of patient data may occur during an AC failure. Ensure 
that you are not using Power Assistant and that you do not 
disconnect AC power while saving an exam to the DVR. 
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Recording Functionality - DVD Media

Support media

DVD-R, DVD+RW, DVD-RW

Support video format

NTSC or PAL

Support Picture Quality

• HQ (Record length: approx. 70 minutes)

• SP (Record length: approx. 90 minutes)

• LP (Record length: approx. 140 minutes)

• EP (Record length: approx. 280 minutes)

Number of Titles and Chapters

You can create up to 99 titles on a disk and 92 chapters in a title.

While recording to DVD, each chapter is automatically created 
at a specific interval that is configured (Utility -> System -> 
Peripherals).

When you stop recording, the DVR writes the title. When you 
end an exam (e.g. press New Patient, End Current Patient, ...), 
the DVR automatically stops recording and creates a title.

Volume label

The system automatically labels following string to DVD media: 
YYYYMMDD_XX

• YYYY - Year (4 digit)

• MM - Month (2 digit)

• DD - Day (2 digit)

• XX - Serial number of the day (2 digit)

NOTE: Volume label of DVD+RW/-RW can be edited via the Utility -> 
Connectivity -> Removable Media page.
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Recording Functionality - DVD Media  (continued)

Video title

The title name on the DVD is titled as follows: <Date>_< 
Time>_<Patient Last name>_<Patient First name>

NOTE: If the patient’s name is not provided, then a serial number is 
used as follows: <Date>_< Time>_<serial number>.

Compatibility

DVD media recorded on the LOGIQ Fortis is compatible with the 
following players:

• Player on LOGIQ Fortis

NOTE: DVD media recorded on previous versions of the LOGIQ 
Fortis is playable on the system.

• DVD video player on a PC

• Commercial DVD video player

Recording Functionality - USB Storage

Supported media

USB-HDD (NTFS only), USB Flash Device (NTFS only) 

NOTE: You cannot record or play FAT (exFAT, FAT32, etc) on a USB 
Device. Please format the USB device to the NTFS file system 
on a PC.

Supported format

MPEG video file

Recording to USB storage creates an mpeg video file (*.mpg) 
(\LOGIQ_Series_DVR\folder) for each title. The file size can be 
up to 2GB.

NOTE:  The mpeg video file does not have a chapter.

Support Picture Quality

• HQ (Record length: approx. 30 minutes)

• SP (Record length: approx. 40 minutes)

• LP (Record length: approx. 60 minutes)

• EP (Record length: approx. 130 minutes)

NOTE: The maximum size of each video file: 4GB.
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Video file name

The mpeg video file name is titled as follows: 
<Date>_<Time>_<Patient Last name>_<Patient First name>..

When the patient’s name is not provided, then the video file 
name is as follows, <Date>_<Time>_<serial number> where the 
serial number is the number of video files on the media plus one.

Recovery (DVD only)

While recording to DVD (DVD-R or DVD+RW/-RW), if a power 
failure occurs, the system will automatically start recovery of the 
media right after the system restarts.

NOTE: If the recording has not finished before the power failure, the last 
title may be unreadable. Recovery copies the last cached title to 
the media.

If the DVD media in the tray does not have sufficient free space, 
the following Recovery message appears (instead of the system 
starting auto recovery): 

“Last title was not burned to DVD. Free space on the media is 
too small. Insert blank DVD for the recovery. Do you want to 
start recovery?” Select “Yes,” “Remind me later,” or “Delete 
Data.” 

• Remind me later

If you select “Remind me later”, you can cancel the 
Recovery operation. But if you press the Record button, the 
recovery menu displays again and you cannot start to 
record.

Select “Yes” (Recover) or “Delete Data” to enable the 
recording.

• Yes (Recover)

If you select “Yes”, the following dialogue displays (“Insert 
blank DVD for the recovery.”). Insert the blank media and 
press “OK”.

During recovery, the message "Recovery of DVR media is in 
progress" displays in the status bar.

• Delete Data

If you select “Delete Data”, you get the following 
confirmation menu (“Are you sure you want to delete 
unburned DVR data”?).

OK: Deletes the unburned cached data.

Cancel: Goes back to the Recovery menu.



Advanced Features

13-556 LOGIQ Fortis – Basic User Manual
5855997-1EN Rev. 3

Video Touch Panel Menu

DVR Touch Panel menus:

 Figure 13-311. Video Touch Panel

Table 13-94:  Touch Panel Keys

Touch Panel Key Explanation

Skip (I<</>>l) DVD media: Skip to the previous/next chapter.

USB storage: Skip specific time to forward/backward.

4x Skip (4x I<</>>l 4x) DVD media: Skip four chapters forward/forward.

USB storage: Quad time interval skip to backward/forward.

Search Press Search to start the Search dialog. Select Title, adjust offset then press 

Search Counter to start the Search. 

The title name is as follows: <Date>_<Time>_<Patient’s Last 

name>_<Patient’s First name>

Record (Red circle with 

Media Inserted)

Start recording. 

Pause ( II ) Pauses and resume Recording and Playback.  

NOTE: The Freeze key works the same as the Pause button, when in 

Playback.

Open Media Drawer Press to open the Media Drawer.

Eject Eject the DVD media/USB storage device. Also you can eject media pressing 

the F3 key. 

Play ( > with Media 

Inserted)

Play a video from DVD or USB storage device.

Note: A DVD-R ONLY plays back AFTER the entire disc has been finalized. 

Note: A DVD-RW/+RW plays back after finalizing each session. 

Stop ( Box ) Stop playback or recording. 

Format (Media Inserted 

with Red X)

Reformats a DVD+RW/-RW.

NOTE: Format deletes all the content on the media.

Finalize (Media Inserted 

with Green Checkmark)

Finalize a DVD-R.

NOTE: DVD+RW/-RW is automatically finalized when you stop recording.
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DVR Display Icons

Displays the following icons in the status bar: 

Figure 13-312. DVR Disk Status

Table 13-95:  DVR icons

1. DVR status

Recording Stopping

Pause Recording Pause Playback

Playback Busy

No media

2. DVD Media status

Displays device availability and available free space.

DVD+RW/-RW is in the tray DVD-R is in the tray

3. USB storage status

Displays the device availability and the free space size.

USB Storage is attached

4. Current Title Number. Displays while recording

5. Time counter.
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Index

Symbols

% Stenosis

generic measurement, 7-20

Numerics

3D/4D imaging

introduction, 13-4

manipulating the volume of interest, 13-28

operational controls, 13-14

prinicples of operation, 13-5

3D/4D presets, changing, 10-54

Advanced, 10-58

Render Setting, 10-57

ROI (Region of Interest), 10-56

Scalpel, 10-57

3D/4D presets, overview, 10-54

A

A/B Ratio

Doppler generic measurement, 7-35

generic measurement, 7-27

M-Mode generic measurement, 7-29

Acceleration time (AT)

OB/GYN vessel measurement, 7-36

Acceleration, measuring, 7-36

accessories

ordering, 1-12

requesting a catalog, 1-12

accessory

connector panel, 3-12

Acclimation time, 3-88

Accumulation, B-Flow, 5-15

accuracy

clinical calculation, 12-10

clinical measurement, 12-7

acoustic output

default levels, 2-43

Activating Continous Capture, 13-196

Active Images, 9-11

active images, description, 4-3

Admin

overview of Utility screen, 10-104

Admin screen

Logon, 10-117

System Admin, 10-113

Users, 10-116

administrator

specifying system, 10-116

AFI

Acquisition, 13-223

AVC Timing Adjustment, 13-234

Peak detection, 13-242

Tracking Validation, 13-227

AFI on Apical 2-chamber, 13-236

AFI on Apical 4-chamber, 13-236

AFI on the APLAX view, 13-225

AFI, see Amniotic Fluid Index (AFI)

air filter

removing, 12-43

ALARA (as low as reasonably achievable), bioeffects, 

2-5

Alpha Hip, pediatric measurement, 8-84

Amniotic Fluid Index (AFI), measuring, 8-13

Analysis

Stress Echo, 13-206

Anatomical M-Mode

activating, 5-28

adjusting, 5-28

overview, 5-28

Angle, B-Mode generic measurement, 7-26

annotating an image

introduction, 6-23

text overlays, 6-26

using the annotation library, 6-28

using typed words, 6-33

Annotation mapping

Breast lesion, 10-38

Annotations Libraries Presets Menu, 10-32, 10-36

annotations, presets, 10-35

anonymize, 13-407

Anonymize Patient

patient data, 13-407

application presets

user-defined, 10-145

Applications

setting presets, 10-46

Applications Preset Menu, 10-44

area measurements

ellipse, 7-41

spline, 7-43

trace, 7-40, 7-42, 7-43

AUA

OB worksheet, 7-65
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audio, speakers, 3-10

Auto Calcs

modifying, 5-49

Auto Calcs, modifying, 5-49

Auto sequence

using, 7-85

Auto Vascular Calculation, see also Manual Vascular 

calculations

activating, 8-65

Auto Vascular Calculation, see also Manual Vasuclar 

calculations

setting up calculation parameters, 8-65

AutoEF

define the endocardial border, 13-246

Mini Report, 13-254

Results, 13-254

the endocardial border trace, 13-248

Tracking validation, 13-252

B

B Steer plus, adjusting, 5-20

Background, B-Flow, 5-15

backing up data

EZBackup/Move, see EZBackup/Move, using

Backup and Restore Preset Menu, 10-21, 10-152

Battery status, 13-543

Battery, refresh, 13-547

biological hazards, 2-12

Bladder volume, measuring, 8-75

B-Mode imaging

intended uses, 5-2

optimizing, 5-2

scanning hints, 5-3

typical exam protocol, 5-2

B-Mode measurements

Echo Level, 7-45

Gynecology exam, 8-42

B-Mode measurements, general, 7-38

B-Mode measurements, generic

% Stenosis, 7-20

A/B Ratio, 7-27

Angle, 7-26

Volume, 7-22

B-Mode measurements, mode

circumference and area (ellipse), 7-41

circumference and area (spline trace), 7-43

circumference and area (trace), 7-42

distance, 7-39

body pattern application libraries, selecting, 10-44

Body Patterns, 6-35

General tab, 10-43

Body Patterns Preset Menu, 10-43

Breast lesion

Annotation mapping, 10-38

Buttons screen

Connectivity, 10-85

C

calculations

OB worksheet, 7-66

selecting, 7-12

urology, 8-75

calipers, description, 7-14

Capture Recon., B-Flow, 6-11

Capture, B-Flow, 5-16

Care and maintenance

cleaning the system, 12-34

footswitch, 12-47

operator controls, 12-41

system cabinet, 12-37

Caution icon, defined, 2-4

Change the display format, 3-77

CINE capture, 6-10

Enhancement, 6-12

CINE loop

previewing only, 9-8

storing and previewing, 9-7

storing without previewing, 9-8

CINE mode

introduction, 6-3

synchronizing loops, 6-6

using, 6-5

circuit breaker

description, 3-21

circumference measurements

ellipse, 7-41

spline, 7-43

trace, 7-40, 7-42, 7-43

Clinical

calculation accuracy, 12-10

measurement accuracy, 12-7

Color Flow imaging

activating, 5-31

intended uses, 5-30

M-Mode, 5-42

optimizing, 5-30

Power Doppler, 5-38

comments, see annotating an image

Compare Assistant

Control, 13-384

Set up, 13-382

Workflow, 13-381

Connectivity

Buttons, 10-85

configuring, 10-59

overview of screens, 10-59

presets, 10-59

TCPIP, 10-61

console

moving, 3-83

transporting, 3-87

wheels, 3-84

contacts

clinical questions, 1-12
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Internet, 1-12

service questions, 1-12

Continuous Capture

Stress Echo, 13-194

contraindications, 1-11

Contrast Imaging

overview, 13-57

Control Panel

description, 3-50

Control panel

replacing key caps, 12-47

replacing key lamps, 12-47

controls

annotation function, 3-59

display function, 3-58

keyboard, 3-53

measurement function, 3-59

mode function, 3-58

operator, 3-50

print function, 3-58

Touch Panel, 3-56

CUA

OB worksheet, 7-65

Curved Anatomical M-Mode, 5-29

CW Doppler

activating, 13-160

exiting, 13-160

non-imaging, 13-159

overview, 13-159

steerable, 13-159

D

D/S ratio, 7-34

Danger icon, defined, 2-4

Data Transfer, description, 4-3

dD Ratio, pediatric measurement, 8-85

device labels, 2-47

devices

acceptable, 2-39

Digital Expert, 13-525

disinfecting probes, 11-40

disinfecting solutions, probes, 11-40

distance measurement

general, 7-39

Doppler Auto Calc Average Cycle, using, 7-49

Doppler measurements, generic

A/B Ratio, 7-35

D/S ratio, 7-34

Heart Rate, 7-34

Pulsatility Index (PI), 7-33

Resistive Index (RI), 7-33

Doppler measurements, mode

TAMAX and TAMEAN, 7-47

time interval, 7-46

velocity, 7-46

Doppler Mode

generic study, 7-32

Doppler Mode, general measurements, 7-45

Doppler Mode, PW

intended uses, 5-43

optimizing, 5-43

typical exam protocol, 5-44

dual image mode, see split-screen imaging

DVD Multi drive

location, 3-9

E

Echo level measurements, 7-45

editing

patient information, 4-24

user-defined calculations, 7-98

EFW growth percentile

OB worksheet, 7-66

electrical

configurations, 3-3

electrical hazard, 2-11

electromagnetic compatiblity (EMC), 2-19

ellipse measurement, general, 7-41

EMC (electromagnetic compatiblity), 2-19

End diastole (ED)

OB/GYN vessel measurement, 7-36

Endometrium thickness (Endo), GYN exam, 8-43

Enhancement, 6-12

environmental requirements, 3-4

equipment safety, 2-11

Erasing

measurements, 7-13

exam

definition of terms, 7-11

deleting, 4-25

OB, 4-7

workflow, 7-11

explosion hazard, 2-12

EZBackup/Move, using, 9-25

F

Fast Key, 6-44

Federal law (USA), requirements, 1-11

Fetal growth bar graph, 8-17, 8-25

Fetal growth curve graph, 8-17

description, 8-18

multiple fetus, 8-27

quad view, 8-20

selecting, 8-19

Fetal trending

fetal growth curve graph, 8-22

multiple fetuses, 8-28

Fetus

entering number of, 8-26

selecting on an OB worksheet, 7-65

Fetus Compare

multiple fetus, 8-27

Flow Volume, 7-52
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folders, measurement

adding, 7-87

Follicle measurements, GYN exam, 8-43

Footswitch, 13-550

freezing an image, 6-2

front panel, location, 3-16

FV, 7-52

G

Gels, coupling, 11-44

General imaging

changing presets, 10-30

generic studies and measurements, 7-18

Generic study

Doppler mode, 7-32

Gestational Sac (GS), 8-12

GYN exam

endometrium thickness, 8-43

follicle measurements, 8-43

ovaries measurements, 8-44

uterus measurements, 8-44

Gynecology exam, 8-42

B-Mode measurements, 8-42

H

hazards, 11-38

biological, 11-14

electrical, 11-13

hazards, safety symbols, 2-5

hazards, types

biological, 2-12

electrical, 2-9, 2-11

explosion, 2-12

mechanical, 2-9

Heart Rate

Doppler generic measurement, 7-34

M-Mode generic measurement, 7-31

Hip Dysplasia, pediatric measurement, 8-82

I

Image acquisition

Stress Echo, 13-188

Image History, description, 4-3

Image Zoom, 6-14

images

deleting, 4-25

recalling from clipboard, 9-18

reviewing, 9-11

Imaging presets, changing

General, 10-30

Imaging presets, overview, 10-29

information, requesting, 1-12

InSite, using, 13-530

Intravessel ratio, calculating, 8-70

K

keyboard

special keys, 3-53

L

labeling probes, 2-55

Libraries Preset Menu, 10-41

Lock the monitor, 3-63

log on procedures

defining, 10-117

LOGIQ system

contraindications, 1-11

LOGIQView, 5-18

Logon

Admin screen, 10-117

M

managing images

media handling tips, 9-4, 9-45

media requirements, 9-4

Manual Vascular Calculation, 8-69

Measurement

Tool

Copy, Past&Move, 7-15

Measurement & Analysis screen

accessing, 7-75, 8-28, 8-31

measurement controls, location, 7-6

Measurements

erasing, 7-13

general instructions, 7-13

OB

AFI, 8-13

measurements, general, 7-4

measurements, generic

overview, 7-18

measurements, types

amniotic fluid index (AFI), 8-13, 8-14

gestational sac, 8-12

measurements, using

adding, 7-87

automatically starting in workflow, 7-85

calipers, 7-14

changing, 7-86

deleting, 7-99

selecting in different category, 7-8

Minimum diastole (MD)

OB/GYN vessel measurement, 7-36

M-Mode

CAMM, 5-29

M-Mode imaging

color flow, activating, 5-42

intended uses, 5-26

optimizing, 5-26

typical exam protocol, 5-27

M-Mode measurements, generic
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% Stenosis, 7-29

A/B Ratio, 7-29

Heart Rate, 7-31

M-Mode measurements, mode

time interval, 7-57

tissue depth, 7-56

M-Mode, general measurements, 7-56

MO drive

location, 3-9

Mode Cursor, displaying

Doppler Mode, 5-49

monitor

speakers, 3-10

moving the system, 3-80

during transport, 3-87

precautions, 3-83

wheels, 3-84

Multiple fetuses, 8-26

fetal trending, 8-28

identifying, 8-27

on OB worksheet, 8-28

My Desktop

set up, 3-75

N

network status indicator,location, 3-16

new patient

scanning, 4-10

O

OB

graph, 8-17

identifying multiple fetuses, 8-27

Patient data, 4-9, 8-9

studies, 8-11

OB exam

preparing, 4-7

starting, 4-9, 8-8

OB graphs, 8-17

fetal growth bar graph, 8-25

patient data, 8-24

viewing, 8-17

OB measurements, types

amniotic fluid index, 8-14

amniotic fluid index (AFI), 8-13

gestational sac, 8-12

OB mulitgestational, 8-26

OB worksheet

AUA, 7-65

calculations, 7-66

CUA, 7-65

EFW growth percentile, 7-66

multiple fetuses, 8-28

patient data, 7-65

selecting ultrasound age, 7-65

OB/GYN vessel measurements, 7-36

acceleration, 7-36

acceleration time, 7-36

end diastole, 7-36

minimum diastole, 7-36

peak systole, 7-36

Operator controls, 12-41

optimizing images

B-Mode, 5-2

Color Flow, 5-30

Doppler, PW, 5-43

M-Mode, 5-26

options

system, 10-113

Orientation Help, 3D/4D imaging, 13-20

ovaries, measurement, 8-44

P

past exam

entering patient data, 8-23

Patient Cardiac and ECG Connections

location, 3-18

Patient data

deleting, 4-25

OB, 4-9, 8-9

OB graphs, 8-24

OB worksheet, 7-65

searching, 4-21

patient exam

reviewing, 9-10

patient safety, 2-7

Patient Screen

active images, 4-3

Data Transfer, 4-3

Image History, 4-3

Peak systole (PS)

OB/GYN vessel measurement, 7-36

Peak systole/end diastole ratio, Doppler generic 

measurements, 7-34

pediatric exam

calculations, 8-81

pediatric measurements, types

alpha HIP, 8-84

dD ratio, 8-85

hip dysplasia, 8-82

peripherals

connector panel, 3-12

peripherals, digital

setting up, 9-53

Phantoms, 12-51

Plot Both, fetal trending, 8-22

Plot Control

line style, 13-179

vertical auto scaling, 13-178

portable exam

performing, 9-65

Power, 3-19

circuit breaker, 3-21
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connection

USA, 3-19

Cord, 3-81

On/Off, 3-22

shut down, 3-37

switch, location, 3-22

power

power up sequence, 3-23

Power Assistant, 13-536

Power Doppler imaging, 5-38

prescription device, caution, 1-11

Preset Program menu

Acoustic Output

Fetal Exposure, 4-8

Prudent Use, 4-8

presets

organizing folders and measurements, 7-80

presets, changing

Anotations/Libraries, 10-32

Body Patterns, 10-41, 10-43, 10-44

Connectivity, 10-59

Imaging, 10-29

System, 10-6

presets, overview, 10-2

previous exam data

entering manually, 8-23

print keys

assigning to a device or dataflow, 10-85

Probe handling and infection control, 11-16

probe orientation, 3D.4D imaging

abdominal, 13-11

endocavity, 13-13

small parts, 13-12

probes

cable handling, 3-46

connecting, 3-43

coupling gels

coupling gels, probes, 11-44

deactivating, 3-48

disconnecting, 3-48

disinfecting, 11-40

ergonomics, 11-2

labeling, 2-55

planned maintenance, 11-47

probe orientation, 11-10

safety, 11-11

using protective sheaths, 11-14

storing, 3-49

Prostate volume, measuring, 8-76

prudent use, 2-4

PS/ED or ED/PS Ratio, measuring, 7-34

Pulsatility Index (PI), Doppler generic measurement, 

7-33

Q

QAnalysis, 13-119, 13-164

Drift Compensation, 13-168

Exit, 13-183

generating a trace, 13-171

manipulating the sample area, 13-173

Plot Control, 13-168, 13-178

Select Image Range, 13-170

smoothing, 13-179

QAPlot Control

horizontal sweep, 13-179

Quality Assurance, 12-49

baselines, 12-52

frequency of tests, 12-50

Introduction, 12-49

periodic checks, 12-52

phantoms, 12-51

record keeping, 12-63

system setup, 12-53

test descriptions, 12-54

typical tests, 12-50

R

real-time 4D imaging

acquiring data, 13-23

stopping acquisition, 13-30

Record keeping, 12-63

reference images, 3D/4D, 13-9

removable media

verifying, 10-88

Renal volume, measuring, 8-76

Render view, 3D/4D imaging, 13-19

Report

Wall Motion Analysis, 13-218

Report Writer report templates, customizing, 13-431

Report Writer reports

activating, 13-411

creating, 13-410

Direct Report, using, 13-456

editing, 13-415

factory templates, 13-414

inserting images, 13-423

Resistive Index (RI), Doppler generic measurement, 

7-33

Results window, 7-12

S

S/D Ratio, Doppler measurement, 7-34

safety

electromagnetic compatibility (EMC), 2-19

equipment, 2-11

hazards, 2-5, 2-11, 2-12, 2-43, 11-13, 11-14

biological, 11-38

smoke and fire, 2-12

labels, 2-47

patient, 2-7

acoustic output hazard

hazard, types

acoustic output, 2-10
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electrical hazards, 2-9

mechanical hazards, 2-9

patient identification, 2-7

patient training, ALARA, 2-10

personnel, 2-11

precaution icons, defined, 2-4

precaution levels, defined, 2-4

probes, 11-11

handling precautions, 11-16

Scalpel, 3D/4D imaging, 13-36

Scan Assistant

Availability, 13-338, 13-341

Definitions, 13-342

Description, 13-343

Exporting Programs, 13-350

Setting Up, 13-344

Using, 13-346

Scan Assistant Creator

Attributes, 13-369

Features, 13-369

File Handling, 13-352

Help, 13-352

Keyboard

Navigating, 13-368

Measurements, 13-375

Overview, 13-351

Programs

Editing, 13-359

Views, 13-363

Scoring

Stress Echo, 13-208

Sectional view, 3D/4D imaging, 13-18

Sensitivity/PRI, B-Flow, 5-16

service, requesting, 1-12

Shear wave imaging

Activating Shear wave, 13-130

Configuring Shear wave, 13-126

Intended Uses, 13-126

Measurement Bias Information Tables, 13-138

Overview, 13-124

Scanning Hints, 13-152

Shear wave Measurements, 13-144

Typical Exam Protocol (Liver), 13-142

Using Shear wave, 13-141

site requirements, before the system arrives, 3-3

small parts exam

thyroid measurements, 8-5

speakers, description, 3-10

Speckle Reduction Imaging-High Detection (SRI-HD) 

see SRI-HD, adjusting

Spectral Doppler, see Doppler Mode, PW

Speed of Sound, 5-23

Split Screen, 6-18

split-screen imaging, 3-58

SRI-HD, adjusting, 5-10

starting an OB exam, 4-9, 8-8

Static 3D imaging, 13-32

acquiring data, 13-32

storage area

location, 3-10

Strain Elastography, 13-113

Stress Echo

create a template, 13-210

studies

OB, 8-11

study

adding, 7-87

definition, 7-11

deleting, 7-99

generic, 7-18

organizing, 7-80

system

acclimation time, 3-88

electrical configurations, 3-3

environmental requirements, 3-4

options, 10-113

power down, 3-37

System Admin

Admin screen, 10-113

System cabinet, 12-37

System Imaging Preset Menu, 10-15

System Measure Preset menu, 10-18

System presets, changing

General, 10-8

System About, 10-28

System Imaging, 10-15

System Measure, 10-18

System Peripherals, 10-23

System/Backup and Restore, 10-21, 10-152

System presets, overview, 10-6

System/General Preset Menu, 10-8

T

TAMAX and TAMEAN, Doppler mode measurement

manual trace, 7-47

TCPIP

Connectivity, 10-61

Test Patterns

overview, 3-70

TGC, adjusting, 5-21

Thyroid measurements, 8-5

TIC analysis

activating, 13-69

curve fitting, 13-91

exiting, 13-69

generating a trace, 13-77

manipulating the sample area, 13-84

overview, 13-68

smoothing, 13-87

TIC Plot Control

horizontal scale, 13-87

line style, 13-87

overview, 13-86

vertical auto scaling, 13-86

Time Gain Compensation, see TGC, adjusting, 5-21
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Time interval

Doppler mode measurement, 7-46

M-Mode measurement, 7-57

Time-Based Store, 10-48

Timers

Stress Echo, 13-193

Tissue depth, M-Mode measurement, 7-56

Tissue Velocity Imaging, 13-161

Trace measurement, general, 7-40, 7-42, 7-43

TVD, 13-163

TVI, 13-163

U

Ultrasound age

selecting on OB worksheet, 7-65

Ultrasound-Guided Attenuation Parameter (UGAP) 

Option, 13-153

Unlock the monitor, 3-63

urology exam, preparing, 7-12, 8-2

urology measurements

bladder volume, 8-75

prostate volume, 8-76

renal volume, 8-76

USB Quick Save, 9-52

user IDs

defining, 10-116

User label

set up, 3-76

user-defined calculations, editing, 7-98

user-defined measurement, adding, 7-89

Users

Admin screen, 10-116

Uterine cavity, amniotic fluid index (AFI), 8-13

Uterus measurements, 8-44

Utility screens

Admin, 10-104

connectivity, 10-59

V

Vascular measurements, selecting, 8-69

Vascular worksheets

saving and printing, 7-64, 7-70

vessel summary, 7-68

Velocity, Doppler measurement, 7-46

verifying

removable media, 10-88

Vessel summary, vascular exam, 7-68

Volume measurement, B-Mode generic 

measurement, 7-22

Volume Navigation ConnectionssolIndicator

location, 3-18

W

Warning icon, defined, 2-4

wheels, console, 3-84

word wrap, annotation, 6-33

Worksheet

viewing, 7-58

Write Zoom, activating, 6-15

XYZ

zooming an image

bioeffects, 6-15
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